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Introduction To Pizzicato
• Versions of Pizzicato 
• The user manual of Pizzicato 
• Goals of Pizzicato 

Versions of Pizzicato

We thank you for buying Pizzicato and we wish you welcome in its new musical universe.

Pizzicato 3.6 is oriented around eleven versions. Pizzicato Professional contains every function you can find 
in this manual. The other 10 versions contain only a specific set of these functions, oriented around a more 
specific use of Pizzicato. Here is a short description of each version.

• Pizzicato Light 
It is a basic version making it possible to learn music, make exercises, write small scores (1 or 2 
pages) and use basic MIDI and audio recording features. You may also start to learn music 
composition and the musical keyboard.

• Pizzicato Beginner 

It is basically a general score editor, up to 16 staves (instruments). It comprises more 
functionalities than Pizzicato Light, like the fast encoding of lyrics and chords, MIDI functions, 
the global editing view,.... It also contains the music course.

• Pizzicato Professional 
Contains a multitude of additional functions and possibilities, compared to the Beginner version. 
Among others, it contains a whole set of innovative and intuitive tools to help compose your own 
music. It opens the door of music composition to everyone, even with little or no music 
knowledge. The tools and options of this version give you a very powerful score editor as well as 
many tools to refine the interpretation of a score in MIDI, as well as many tools to practise music 
composition.

• Pizzicato Notation 

This is the full featured music notation version. It contains all the tools of Pizzicato Professional 
oriented toward music notation.

• Pizzicato Composition Light 
This low cost version, as well as the next one, are designed specifically around music 
composition. Contains many tools to help the beginner to start composing his own music.

• Pizzicato Composition Pro 

Contains all the advanced intuitive composition tools of Pizzicato Professional. You can export 
your composition as a MIDI file, a musicXML file or audio file, to be used by any other music 
notation or sequencer program.

• Pizzicato Drums and Percussion 

This low cost version is designed specifically for music notation of drums and percussion 
instruments. Print and hear your drums and percussion scores.
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• Pizzicato Guitar 

This low cost version is designed specifically for music notation of guitar. Print and hear your 
guitar scores, including tablatures and guitar chords diagrams.

• Pizzicato Choir 

This low cost version is designed specifically for music notation for the choir. Print and hear 
your choir sheet music, including lyrics.

• Pizzicato Keyboard 

This low cost version is designed specifically for music notation for the keyboard. Print and hear 
your keyboard sheet music, including cross-staff beaming and many advanced keyboard notation 
features.

• Pizzicato Soloist 
This low cost version is designed specifically for music notation for one staff. Print and hear 
your solo sheet music, including lyrics and chords. Fits any solo instrument written on one staff.

These versions are used under license, when you buy one of these versions of Pizzicato. These versions also 
exist in evaluation and shareware and they may be used free of charge. Here are their limitations, compared 
to the licensed versions.

• Pizzicato Shareware version 

Free version of Pizzicato Light, during one month, starting with the installation of the program 
on a computer. This version has all the features of Pizzicato Light. It nevertheless prints the 
scores with a Pizzicato mosaic background. This version follows the guide lines of Shareware 
software and implies that if the user wants to continue using it after the first month, he must buy 
the user license. With this version, you may save audio files that are not longer than one minute. 
It does not contain the sound library.

• Pizzicato - Evaluation versions of the other 10 Pizzicato versions 

• Does not allow to save your work, nor to export it in MIDI, audio, graphic or musicXML 
• Does not allow to print 
• Does not contain the sound library 
• Does not permit chord finding for harmonization (if applicable). 

When you install Pizzicato on your computer, whether from a DVD or after downloading it from the 
Internet, all versions are installed at the same time. In other words, these multiple versions are in fact the 
same software. All free version may be used. You can switch from on version to the other through the 
Program version / Updates... item of the Options menu or directly through the Working mode menu of the 
Options menu.

This can help you to try out any of the version. You may buy multiple licenses (for instance, Pizzicato Guitar 
and Pizzicato Drums) and by registering these two licenses, you will then be able to work with these two 
licensed versions, as well as with the other 9 free evaluation versions.

By installing the evaluation version, you can use it also as a reader for Pizzicato documents. If someone 
sends you a Pizzicato file, you can download the evaluation version for free and if you do not modify the 
document, you can print it, export to MIDI, audio or musicXML.

The user manual of Pizzicato

The instruction manual is designed as a progressive approach of music, computers and Pizzicato. It is 
divided 
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into a series of lessons each one treating a particular subject. Most of these lessons are made of a succession 
of practical steps that you are asked to perform with Pizzicato. The attention is laid on a balance between 
practice and theory.

Each lesson covers music, computer or the use of Pizzicato. The tables of content contain the references of 
each lesson. These divisions of the manual enable you to easily adapt your reading to your knowledge level. 
The professional musician will skip the music lessons and the well-informed in computer will skip the pages 
related to the computer.

In a general way, the lessons follow a progressive order. If you want to have a total control of Pizzicato, we 
advise you to study them in the exact sequence. If you are initially only interested by certain subjects of 
Pizzicato (music learning, score editor, Midi sequencer, composing or accompaniment), you can skip the 
lessons specific to the other fields. The introduction of a lesson shows each time the subjects covered and 
helps you estimate if the lesson is interesting for you or not.

You will also find a glossary that includes most of the words relating to music, computer or Pizzicato. Use it 
each time you don't fully understand the meaning of a word. Continuing to study the course without 
understanding the words can only create problems. Therefore, use the glossary abundantly! In the text of the 
lessons, the new introduced words are directly related to the glossary by a link. When dragging the mouse 
over it, the cursor becomes a hand. Click it and you get access to the definition of the word in the glossary.

According to the Pizzicato version you bought, a paper manual contains the main lessons required to learn to 
used the program. The screen documentation nevertheless includes all the lessons for each version. 
According to the consulted manual, you only access the lessons concerning the version you have. Many 
lessons are common to all versions and some indicate differences between versions. You will find for 
instance, a list of the Pizzicato versions relevant to each main division of a lesson.

Goals of Pizzicato

The design and creation of Pizzicato began in 1992. With Pizzicato, our goal is to create a software to 
approach music and computer without any preliminary knowledge of these subjects, while offering a 
maximum number of musical features to the professional. The future releases of Pizzicato will continue in 
that direction.

In order to be informed on the evolution of Pizzicato and to be able to access our technical support, we 
kindly request you to register yourself as an official user of Pizzicato. You can do so by returning the 
registration card included in your software package or directly register on our Web site.

For any question regarding Pizzicato, you can contact our international technical support:

Arpege - Music
29, rue de l'Enseignement

4800 VERVIERS
Belgium

Tel ++32 87-55.23.60
Fax ++32 87-26.80.10

or consult us on the Internet. Our site is: www.arpegemusic.com Our E-mail address is 
support@arpegemusic.com 
Announce your license number to the support staff. If your question concerns an installation problem or is 
related to the use of the program, please be in front of your computer while calling. We will help you as best 
as we can. The best way is an e-mail with full description of the problem. We usually answer within 24 
hours in working days.

Do not hesitate to report to us in writing all the improvements and new functionalities you can think of. We 
will take your remarks into account for the development of future releases of Pizzicato. Our goal is to 
transform Pizzicato into your ideal work platform for computer-assisted music. To this end, your point of 
view is important to us.
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All this being said, you are now ready to get to the heart of the matter: music on your computer. We wish 
you much pleasure in your discovery of the musical and software universe of Pizzicato!

 

Dominique Vandenneucker

Designer of Pizzicato

The mouse
• What is the mouse? 
• Buttons of the mouse 
• Pointing 
• Clicking 
• Double-clicking 
• Clicking/dragging 

What is the mouse?

The mouse is a small object attached to your computer or your keyboard by a cable. Its structure is made to 
easily slide on a plane surface, next to your keyboard. In its lower part, it has a small ball which makes it 
possible to collect the changes of position. 

When you slide it from left to right or backwards and forwards, the ball collects your movements and 
transmits them to the computer through the connecting cable . The computer then interprets these 
movements to move a small picture on your screen. This picture is called the mouse cursor. Most of the 
time, it is represented by an arrow, but according to the context, it can have various appearances:

If you move the mouse to the right, the cursor follows your movement and moves to the right of the screen. 
The same principle applies for all directions. You need to hold the mouse in the correct direction, with the 
connection cable most distant from you.

Take care to have sufficient place beside your keyboard to handle the mouse. By moving it, you can bring 
the cursor to any place on the screen. If you are not yet accustomed to it, train yourself to move the cursor 
and to bring it to various precise locations on the screen. It is important to control the moving of the cursor 
well, because much of the operations will be carried out using the mouse. It is not difficult, it is a simple 
matter of habit.

Buttons of the mouse

On its upper part, the mouse has one or more buttons. When it has several buttons, it is usually the left 
button that is used by most programs. The right button, when present, is often used to reach a contextual 
menu, i.e. a list of actions related to the location where you clicked.

For the Mac version of Pizzicato, if the mouse only has one button, when you are asked to use the right 
button in the manual, you can use the single button of the Macintosh mouse while holding down the 
"Option" (or "ALT") key of the Macintosh keyboard. It is the key located on the two sides of the space bar, 
between the "Apple" key and the "CTRL" key.

By pushing or releasing the button, you can carry out the most various operations, according to the location 
of the cursor at that time. Four types of operations can be carried out with the mouse:

• point 

16



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

• click 
• double-click 
• click and drag 

Here is a description of each operation. Be certain to understand them well, because they will very often 
appear in the manual.

Pointing 

This operation simply consists of placing the mouse cursor at a precise location of the screen. It is important 
to know that the active area of the cursor is its point. If you are asked to point a small square, you should 
thus place the mouse in such a way that the point of the cursor is inside this square:

Correct                   Not correct
This operation of pointing is preliminary to the other operations. It is first necessary to place the cursor at the 
good location before starting another operation.

Clicking 

It is the most current operation. You press the button and release it immediately, without moving the mouse 
between the two.

When you are asked to click on (or in) an item, it means that you must first point this item with the cursor 
(by moving the mouse) and then push and release the mouse button.

The action to push and release the button is called a click. According to the type of the clicked item, the 
action will be different. It is often used to carry out a choice or to execute an action. We will later study the 
types of graphical items that you will run into.

Double-clicking 

As its name may indicate it, one executes two clicks one after the other, at the same location (without 
moving the mouse between the two) and without waiting between the two clicks. On average, this time 
between two clicks will not exceed half a second. If you wait too long between the two, your action will be 
interpreted as two simple clicks and not as a double-click.

The 4 actions must follow one another quickly:

• press the button, 
• release the button, 
• press the button, 
• release the button. 

The mouse should not be moved between these 4 operations otherwise the double-click will not be valid. 
When you are asked to double-click an item, it means that you must first point this item with the cursor (by 
moving the mouse) and then execute the 4 actions given above. When you execute a double-click that does 
not produce the expected effect, it means that you either execute these 4 operations not fast enough or you 
move the mouse during the operation. Train yourself!

This operation is called a double click. According to the type of the double-clicked item, the action will be 
different. It is often used to open a graphic element and to see its contents.

Clicking/dragging
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This operation makes it possible to move a graphic element on the screen. The principle is the same as 
moving an object on your desk: you seize it, move it to another location and put it down. With the mouse, 
the operations become:

• point the graphic object on the screen with the mouse, 
• push and hold down the mouse button (= seize the object), 
• drag the mouse to another location (= move the object), 
• release the mouse button (= release the object). 

The time that goes by between these operations is not important. You can take your time to move the mouse 
before releasing the button.

When you are asked to click and drag an item, it means the four operations given above. The word "click" 
can also be omitted and you will simply be asked to drag an item from one location to another.

This operation is used to move graphic objects on the screen, to change the size of a graphic object and to 
select a choice among several available actions or options.

Installing Pizzicato
• Installing Pizzicato 
• Starting Pizzicato 
• License registration 
• Exit Pizzicato 

Installing Pizzicato

The installation of Pizzicato consists of copying all necessary files onto the hard disk of your computer. This 
operation must be done before you can start using Pizzicato.

You need to follow the procedure explained in this lesson. If you cannot execute one or more steps, do not 
hesitate to contact our support department. Together, we will solve the problem.

The Pizzicato manual includes several lessons on computer basics. If computers are brand new to you, you 
can refer to these pages as a first approach. We also advise you to read the introduction manual of Windows 
or Macintosh. Also play the guided tour offered by Windows or Mac. It will teach you the essential data to 
handle your computer.

To install Pizzicato on Windows, execute the following steps (for Mac, see below): 

• Insert the Pizzicato DVD in your DVD drive or double-click the downloaded file if you possess 
the electronic version of Pizzicato. 

• If the installation program does not start by itself, do the following: 
1. Click the Start button in the Windows toolbar 
2. Click Execute... 
3. Type D:setup using the keyboard (D is the letter corresponding to your DVD drive) and 

click OK 
4. If you don't know the letter associated with your DVD drive, click the Browse... button 

and double-click the Working station on the Desk. Then double-click the icon 
representing the DVD drive and double-click the Setup file (or Setup.exe) 

• Follow the instructions that appear on the screen 

• Once the installation is finished, you can withdraw the Pizzicato DVD from the drive 
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To install Pizzicato on Macintosh, do the following steps:     

• Insert the Pizzicato DVD in your DVD drive or double-click the downloaded file if you possess 
the electronic version of Pizzicato. 

With the DVD, double-click the "Pizzicato 3.6 - EN.zip". This will create a folder "Pizzicato 
3.x" that will go by default into the downloaded file folder. You can drag it to the application 
folder of the Mac.

• Once the installation is done, you can remove the Pizzicato DVD from the drive. 

Starting Pizzicato

The launching of Pizzicato (or starting) is the operation which makes it possible for Pizzicato to take the 
control of the computer. From this moment, Pizzicato is active and you can use it as indicated in each lesson 
of this manual.

To start Pizzicato under Windows, click the Start button, click Programs then Pizzicato 3.x and again 
Pizzicato. To start Pizzicato on Mac OS X, open your Macintosh hard disk; in the Applications folder, you 
will find the Pizzicato 3.x folder. Inside this folder, double-click the "Pizzicato" file. The program starts.

The first time, on Mac or Windows, Pizzicato lets you choose the working version of Pizzicato and asks you 
to fill in your license and serial numbers. Let us see this in detail.

License registration

When starting Pizzicato for the first time, the following dialog box appears: 

If you bought Pizzicato, select Licence registration and fill in the three text boxes, respectively with:

• The license number : it is located on the Pizzicato DVD box or in the instruction e-mail and 
contains 5 digits 

• The serial number: also located on the DVD box or in the instruction e-mail, it contains 4 groups of 
4 digits separated by the minus sign "-". It is thus of the form: xxxx-xxxx-xxxx-xxxx. It is important 
to introduce these 19 characters (16 digits and three "-" signs) without intermediate spaces. 

• Your name: the name which will appear on the registration card (or Internet registration) 
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If you did not buy Pizzicato and got the program on a demo DVD, from Internet or through a friend, you can 
use the options in the right column, which do not require a license number:

• Shareware Version (free use of Pizzicato Light for one month starting with the installation) 
• The 10 other evaluation versions of Pizzicato (with save, print or export functions disabled) 

Click OK. If you do not have a licence (evaluation or shareware), Pizzicato starts. According to the version 
you have, a dialog box may appear, asking for a personal code. If it does not appear, the installation is 
finished. Otherwise, do the following.

Pizzicato is protected by a personal code system. This personal code can be calculated by us only after the 
installation of Pizzicato on your computer. This is why you will not find this code on the original DVD nor 
in the box of the software nor in the instruction e-mail of the electronic version.

So that we can communicate this personal code to you, please send us your license and identification 
numbers located on the top left corner of this dialog box.
If your computer is connected to the Internet, you will find in this dialog a button that will help you to send 
the request for a personal code. Fill in that dialog and validate. It is the easiest method as you will receive the 
personal code by e-mail usually within ten minutes.

You can use the software for 20 hours without the personal code. After that, it will run in Shareware mode 
(without license) or evaluation mode. 

To receive your personal code, you can also go on the registration page and fill in the registration 
form, it is the fastest way to receive it :

www.arpegemusic.com/clients2.htm 
You may also reach this page through the Help menu of Pizzicato, Online Registration...
As long as you do not introduce your personal code, this dialog box appears automatically when launching 
Pizzicato. When you receive your personal code, fill it into the text area of this dialog box and click OK. Use 
the copy/paste function to avoid any error. If the code is correct, this dialog will no more appear. Pizzicato is 
permanently installed on your computer.

Exit Pizzicato

To exit (quit) Pizzicato, you must click in the File menu (for Mac, in the Pizzicato menu) located in the 
menu bar, and then on the Exit item. Pizzicato terminates. You can obtain the same result by holding down 
the ALT key and pressing the F4 key on PC or "Apple" + "Q" on Mac.

If computers are very new for you, we advise you to read the lessons regarding computers, which follow this 
lesson. They explain to you the basics of computers and the various graphic elements which you will meet in 
your work with Pizzicato. If you are accustomed to computers, go directly to the Pizzicato manual and/or to 
the music course. Have a nice time!

The computer and its interface (1)
• What is a computer? 
• Communicating with a computer 
• The screen and windows 
• Menus 
• Dialog boxes 
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What is a computer?

A computer is a machine which can very quickly execute a series of instructions that somebody gave it. It 
does not think by itself. It is limited to apply reasoning that a person (the programmer) thought and 
developed for it.

A computer program, also called a software, is a series of instructions and reasoning prepared to provide a 
service in a specific field. Pizzicato is a software enabling you to compose, to play musical scores and to 
provide you with a whole series of services related to music.

To be used, a software must be introduced into the computer. By starting the software, its instructions take 
control of the computer. The user can then direct the software and work with it to obtain results from it in the 
related field.

Unlike a computer, a software is not a physical thing or an object. It is a series of reasoning, methods and 
directives which will control the computer. It is information. When you buy a software, it is provided to you 
on one or more diskettes or CDs which are used as a support. The data on the disks constitute the 
instructions of the software. The software installation procedure simply consists in copying these data into 
the computer so that the computer can use them.

The hard disk of a computer is a permanent data medium, i.e. when you switch off the computer, 
information written on the hard disk is preserved. It is on the hard disk that the software is copied during the 
installation, so that it is once and for all in the computer. The capacity of a hard disk is indicated in Mega 
Bytes (MB) or Giga Bytes (GB). 1 MB corresponds to one million text characters, which is equivalent to 
more than 200 pages of text with 60 lines of 80 characters on each page . 1 GB equals 1000 MB. The 
smallest hard disks currently make tens of GB and go up to several hundreds of GB. 1 TB (Tera byte) 
corresponds to 1000 GB.

The random access memory of the computer is a data medium used during the execution of a program. A 
program needs a certain amount of random access memory to work correctly. This memory is called "RAM" 
("Random Access Memory", which means that data can be reached at any time or place in the memory, 
randomly). The RAM of a computer is measured in MB. Its usual size goes from 1 GB to many GB. The 
random access memory is the working memory of the computer. When you switch off the computer, its 
content is lost. By creating a document of word processing, it is created in RAM. Before switching off the 
computer, the document must be written on the hard disk so that it is not lost. It happens this way for most 
software programs like word processing, drawing programs, etc.

Communicating with a computer

You need a way to give your instructions to the computer. Similarly, when the program wants to tell you 
something or to show you the result of its actions, you must be able to perceive it.

The keyboard and the mouse let you control the computer. Thanks to these two elements you will direct the 
computer actions.

The screen helps your computer to show you the results of your work. It is used together with the mouse and 
the keyboard to allow a fast and effective communication between the user and the software. The software 
will also use the printer to give you the results on paper. In Pizzicato, the computer can also control musical 
external instruments enabling you to hear the sound of your work.

The elements helping you to communicate with the computer are called the user interface.

The screen and windows

The screen of the computer is a working area. It is like a desk on which you can place documents that you 
can modify and classify.

As the screen is used to visualize your work, it is structured in distinct graphical elements that one can 
manipulate. Only a small number of these elements constitute the essence of the communication between the 
computer and the user. We thus propose you to study these elements in this lesson and the following.
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From one computer to another and one program to another, the graphical aspect of these elements will vary. 
The design, the color, the thickness of lines, the styles of characters… personalize programs and computers.

The screen of the computer comprises rectangular graphical areas which are called windows. You can 
compare them with paper sheets that you place on a desk. Here are the various parts under Windows and 
Mac respectively (Please note that the graphic aspect may vary from one version to another of Mac or 
Windows, but the main principles stay the same):

On Mac OS X, the three boxes (close, reduce and zoom) are in the upper left corner of the window. The 
other elements are very similar.

What you see here constitutes one window. It is a graphical unit of which you can change the size and 
position. Each program creates its own window at startup. Often, with the launching of a program, the size 
of the created window occupies the full screen. When you use the program, it will create other windows 
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according to what is needed. For example, if you open several documents in the same program, the 
following setup shows the two windows (representing the two documents), respectively on Windows and 
Mac:

On Windows, the two internal windows are called "child windows". They are always inside the main 
window (parent window). On Mac, each window appears independently. Note that the second window is 
located above the other. It is hiding a part of it. The analogy with paper sheets on a desk is still valid. When 
you place a paper on another paper, it is entirely visible and hiding part of the other.
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When clicking in a window which is below another, you can bring it to the front, like this (respectively on 
Windows and Mac):

Now let us examine the elements present in a window.

Borders of the window
They delimit the area of the window compared to the remainder of the screen. When you launch 
Pizzicato, the main window occupies the full screen and the borders are not visible. When 
clicking in the restore box,
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 or on Mac  (or a "+" sign on Mac OS X)

the window will have the aspect as above. On Windows, when placing the mouse on the borders, 
the cursor takes one of the following aspects:

While clicking and dragging on a border, you can increase or reduce the size of a window. The 
border follows the movements of the mouse until you release the mouse. When you execute this 
operation close to a corner, the corner moves while following the movements of the mouse and 
by moving with him the two borders. If you click in the middle of a border, halfway between two 
corners, only the border will move.

On Mac, the right bottom corner can be used in the same way to adjust the size of the window. 
Some windows can be moved by clicking and dragging the border.

Zoom boxes
To change the size of a window, you can also use the zoom boxes. There are three types of zoom 
boxes on PC (on Mac, two are represented by the same drawing).

 or on Mac  (or a "+" sign on Mac OS X)

Resize the window from its maximum size to its normal size or from its minimal size to its 
normal size.

 or on Mac  (or a "+" sign on Mac OS X)

Resize the window to its minimal size. Only a part of the title bar stays visible. On Mac OS X, 
the window disappear in the Dock (area below the screen).

 or on Mac 

Resize the window to its maximum size. If it is the main window of the program, it occupies the 
full screen. If it is a child window (on Windows only), it occupies the totality of the main parent 
window content.

Close box

The  box or  on Mac (a "x" sign on Mac OS X) makes it possible to close the 

window. On Windows, if it is the main window (in the first example, it is the higher box), the 
program quits. If it is an internal window, only this window is closed.

Title bar
The title bar is an area located just below the top border. You will find the title of the window in 
it. It often indicates the name of the document or the role of the window. When clicking and 
dragging the title bar, you move the window on the screen, without modifying its size. On 
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Windows, when double-clicking the title bar, you resize the window from the maximum size to 
the normal size and vice versa.

On Windows, when a child window has its maximum size, its title bar combines with the title bar 
of the main window of the program. The title of the child window is then added between square 
brackets[ ] next to the title of the main window. The zoom and close boxes appear right below 
the boxes of the main window.

System menu
It is a menu set up and maintained by Windows and which makes it possible to execute the 
operations of moving, zooming and closing via menus instead of using the corresponding boxes.

Menu bar 
Just below the title bar you will find the menu bar. It lets you execute actions related to the 
content of the window. We will see this below. On Mac, the menu bar is located in the higher 
part of the screen.

Tool bar
It is a graphic area giving quick access to current actions or options. The content vary from one 
program to another. A window may also exist without a tool bar.

Status bar
It is a graphic area with practical data, like the current page number, the cursor graphic position, 
help information,…

Contents of the window
Your document is displayed here (musical score, text of a letter, drawing, table…). It is the 
interaction area between the user and the contents of the document. The contents of a window 
vary from one program to another and Pizzicato has many different windows. We will have the 
occasion to explain them and to use them throughout this manual. For the moment, let us simply 
remember that a window visualizes an aspect of a document.

Scroll bars
As explained above, you can easily change the size of the window. What about its contents? The 
purpose of a window is to present the contents of a document to the user in a visual way. If the 
document is an enormous musical score, it will be impossible to see the full score inside the 
window. Thus we need a way to determine which part of the document will be visible on the 
screen. 

This role is given to the horizontal and vertical scroll bars. We will see how to use them in the 
remainder of this manual. By handling them, you will be able to decide which part of your 
document will be the visible in the window. It is like looking at a remote landscape with 
binoculars. It is impossible for you to see all the landscape all at once. By moving your 
binoculars, you can see to the right, left, top or bottom. At any moment, you only see one part of 
the landscape.

So we reviewed the various elements making up a window. All the elements are not necessarily present in 
each window. Windows can exist with only a border and contents.

Menus

The purpose of a menu is to let the user ask the program the execution of a task or an action. The higher part 
of the screen comprises a grayed bar with a series of written words on it. It is the main menu bar. In 
Pizzicato, it contains the following words:
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The words which are in the menu bar are the titles of the menus. By clicking on a word, a list appears:

This list shows all the actions that you can execute. Usually, a menu gathers a series of actions from the 
same category. Here, they are actions relating to the windows.

Each line of this list is called an menu item. By clicking on one of the items displayed, the menu disappears 
and the associated action is executed.

This is the way to select a menu item. It is not necessary to release the mouse button between the two 
actions. You can click on the title of the menu and drag downwards to select the item. At this time release 
the button and the action is executed. It is an application of the click/drag operation of the mouse. Train 
yourself with some items of the Tools menu. Each time, a small window appears to display symbols. Close it 
by clicking on its close box.

It happens that some menu items are not always available, because some operations cannot be executed in all 
cases. Imagine that a menu item lets you close a window. If no window is present on the screen, it is not 
possible to close a window. The corresponding menu item is then disabled. In this case, it is either absent or 
drawn in gray. When you drag the cursor on a disabled item, it does not get contrasted and it is impossible to 
select it.

To separate menu items into subcategories, a line is often used.
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It happens that a menu item contains several possible choices. In such a case, a small black arrow indicates 
on the right that it is a multiple choice item. By clicking this item, a secondary list appears that contains 
other items you can select. This makes it possible to build menus in tree structure, 

A last important point is the shortcut. By observing the above examples, you could notice that some items 
have the "Ctrl+" text on their right, followed by a letter or a symbol of the keyboard (on Mac, symbol of the 
"Apple" key). This is a keyboard shortcut that lets you activate a menu item without using the mouse. Once 
you know the program and its shortcuts, it is faster than using the mouse. To use a shortcut, hold down the 
Ctrl key of the keyboard ("Apple" key on Mac), and press the shortcut letter or symbol on the keyboard.

Dialog boxes

Dialog boxes are special windows. A dialog box lets the user define or select various options that influence 
the computer work. In a general way, it is an area of exclusive communication between the software and the 
user, hence its name, a dialog box.

It is an area of communication because it contains various elements which make it possible for the user to 
indicate his choice to the computer. In the other direction, the software can display useful information to the 
user through these elements. We will study these various elements of communication in the following 
lessons.

Most Pizzicato dialog boxes are exclusive, which means that when a dialog box is displayed on the screen, 
the user can do nothing else but using this dialog box. If other windows are located behind it, they are 
temporarily inaccessible, just as the menus are. To be able to use the remainder of the software again, the 
user must terminate this communication by closing the dialog box.

Most dialog boxes comprise 2 rectangular areas containing the words OK and Cancel. By clicking the OK 
area, the user can close the dialog box, validating the modifications and selected options. By clicking the 
Cancel area, the dialog box will also be closed, but the modifications made by the user in this dialog box will 
be cancelled, i.e. forgotten by the software.

Most dialog boxes can be moved like a window but their size cannot be modified. By clicking and dragging 
the title bar, you can move the dialog box. When a dialog box is displayed, if you try to click outside it, the 
computer will refuse your action because it is an exclusive dialog box and you do not have other choices 
than to terminate this dialog box before making something else.

In the Options menu, select the Transcription… item. The following dialog box appears (Windows & Mac):
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You can move it. Now try to click on another menu or on the window which is behind it. It does not work. 
The dialog box contains various elements that we will further discuss in details. In the bottom right corner of 
this dialog, you can notice the Cancel and OK areas. Click in Cancel and the dialog box disappears.

Most dialog boxes appear following a menu item selection or an action executed in the contents of a 
window. Most of the time, dialog boxes help you consult or supplement information that will influence the 
work of the software.

The computer and its interface (2)
• Buttons 
• Check boxes 
• Radio buttons 
• Popup menus 
• Scroll bars 
• Sliders 
• Lists 
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Buttons

We will review the various elements which can be found inside a dialog box. They are all represented by a 
graphic area inside the dialog box. Via the mouse, the user can handle these elements to make a selection or 
execute an action.

A button is a rectangular area containing one or more words. Here are examples:

   
The purpose of a button is to execute an action when you click inside it. The only handling one can make 
with a button is to place the mouse cursor inside it and click. When you press the mouse button, the drawing 
of the button gives you the impression of being pressed. It is maintained this way until you release the 
mouse.

If you release the mouse when the cursor is still inside the button, the button takes again its normal 
appearance and the action is executed. If you move the cursor outside the button before releasing it, the 
action is not executed. It is a manner of avoiding at the last second executing an action when you already 
pressed the button.

We had already seen the Cancel and OK buttons which let you close a dialog box. When a button is 
surrounded by a thicker black border, like the second example here above, it means that you can activate it 
with the Return or Enter key on the keyboard. The Return key is located on the right side of the main key 
block and also on the bottom right corner of the numeric keypad, at the extreme right side of your keyboard. 
This key acts like a shortcut key to activate the thick border button. There is only one button of this type in a 
dialog box.

When a Cancel button is present, it can be activated by the keyboard using the ESC or Escape key, which is 
very often at the top left corner of your keyboard or right beside the space bar of the small Mac keyboard.

These two shortcuts are practical, because they can be used in almost all Pizzicato dialog boxes.

Check boxes

A check box is represented by a small square followed by a text. The square can be empty or can be 
checked. Here are two examples:

The text on the right of the square indicates in a few words an option or a choice that the user can make. A 
check mark in the square shows that this option or this choice is selected. An empty square shows that the 
option or the choice is not selected.

When a dialog box displays a check box, the user can decide if it is necessary to select or unselect this option 
by checking it or by leaving it unchecked. To do that, you must simply click in the small square or on the 
associated text. If a check mark is already present, it is erased and if it is not present, it is added.

When you modify a check box and click the OK button of the dialog box, the option is memorized and the 
next time you call the same dialog box, the option is still visible the way you selected it.

Radio buttons

When a choice must be more explicit or when there is more than two possibilities, the check box is no more 
appropriate. Multiple choices are a series of round check boxes grouped under a label. Only one box of the 
group can be checked at the same time. When you click one of them, the others are automatically unchecked.

Here is an example of radio buttons with six choices, with the fifth choice selected:
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The label of the radio buttons indicates that it relates to the starting of Pizzicato and it gives 6 choices to the 
user. 

In radio buttons, there can be two or more choices available and the text depends entirely on the subject 
covered by the dialog box. It is a manner of letting the user make a choice.

Popup menus

This is another way of making a choice among several possibilities. A popup menu, also called drop-down 
list or combo box (in Windows), is represented as follows:

 or on Mac 

The visible text displays the selected choice. By clicking inside a popup menu (sometimes simply called 
menu) or on the black arrow which is on its line, the list of possible choices is displayed:

 or on Mac 

At this time, you can slide the mouse towards any choice of the list. By releasing the mouse on one item, the 
new choice is selected and displayed on the popup menu.

On Windows, when a menu contains too many choices (no space to display them all on the screen), a scroll 
bar appears to the right of the list. By clicking on the higher and lower arrows, the list starts scrolling to 
reach the higher or lower items. Here is an example:
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You can also click and drag the gray button located between the two arrows, to scroll the list of items. On 
Mac, sliding the mouse above or below the menu causes the scrolling of the invisible items.

Scroll bars

A scroll bar is a long and narrow rectangular area that comprises five parts. It can be horizontal or vertical. 
Here are examples:

 

They are mainly used to go up and down or left and right in the contents of a window or in a list of items.

The small gray square is called the scroll box. The scroll box indicates the position of the scroll bar. It can be 
moved throughout the light gray rectangle, between the two arrow buttons. According to the graphical 
model, this small square can take the aspect of a widening rectangle that you can move in the same way. The 
scroll box can take a number of intermediate positions according to the context in which it is used. 

When it is disabled, the scroll box is not drawn, which means for example that the image visualized in the 
contents of the window is entirely visible:

There are five ways to move the scroll box in the scroll bar:

• By clicking in the left (or top) arrow button, you move the scroll box one unit to the left (or top). If 
you hold down the button, it continues to move one step at a time. 

• By clicking in the right (or bottom) arrow button, you move the scroll box one unit to the right (or 
bottom). If you hold down the button, it continues to move one step at a time. 

• By clicking and dragging the scroll box itself, it follows your movement and you can move it directly 
to the position you want. 

• By clicking between the scroll box and the left (or top) arrow button, you move the scroll box to the 
left (or top) several units at a time. If you hold down the mouse, it continues to move quickly. 

• By clicking between the scroll box and the right (or bottom) arrow button, you move the scroll box to 
the right (or bottom) several units at a time. If you hold down the mouse, it continues to move 
quickly. 

Try to move the vertical scroll box located in the window containing what you read now, by using the five 
methods.
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Sliders

A slider is a simplified form of a scroll bar. It is used mainly to let the user determine or modify a number or 
a ratio. In the Pizzicato Options menu, select the Global options item. You will find two sliders:

They are used here to determine graphic parameters.

A slider consists of a bar on which a small cursor can slide. To move this cursor, you need to click inside it 
and drag it left or right (up or down for a vertical slider). When you release it, it maintains its position. For 
example, move the first slider so that it shows a value of 50.

To bring the cursor directly to a specific position, you can directly click at this position. The cursor is placed 
directly at the indicated position. For example, you will find sliders that will enable you to adjust the sound 
volume for each instrument, exactly like a sound mixing table. Now click the Cancel button.

Lists

A list is another form of a popup menu that offers more possibilities. It is represented by a rectangular area 
in which several lines of text display the various items making up the list. On the right side of the list, you 
will find a vertical scroll bar, enabled if the list is not high enough to display all the items it contains. Above 
the list you will find a title specifying the purpose of the list.

In the Options menu, select the Chord library... item. The dialog box which appears contains a list in its left 
part:

The first line is selected because it has a reversed contrast. Select the third line by clicking on it. The first 
line becomes normal again and the list shows a contrast on the third line.

The rectangular scroll box is drawn in the higher part of the scroll bar. That means that the first item of the 
list is visible but that there are items that follow the last line. By clicking and holding the mouse button in 
the lower arrow of the scroll bar, the list scrolls and display the hidden items.

When the scroll box is at the bottom, it means that you are at the end of the list and that there are no more 
items after the last visible one. This method gives access to very long lists that can be consulted by moving 
the scroll box by one of the 5 methods explained here above. By clicking on a line, you select your choice to 
the program. Now click the Cancel button. 
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The computer and its interface (3)
• Using the keyboard 
• Text boxes 

Using the keyboard

The keyboard of the computer lets you introduce characters, figures and symbols. It also has several keys 
with special functions.

It is divided at least in two parts. The main block of keys contains the letters. In the higher part of this block, 
you will find the figures from 0 to 9. The long key located in front of the keyboard is the space bar. It lets 
you introduce spaces between words. To the right of the keyboard, you will find a small block of keys called 
the numeric keypad. It contains figures from 0 to 9 as well as some other symbols.

When you press and release a key, the keyboard communicates it to the computer. The software takes 
consideration of the key and executes the necessary actions required by the user. If you press and hold down 
the key of a character, a figure or a symbol, after a certain time the keyboard will automatically repeat the 
action several times. Thus take care not to hold down your finger too long on a key, except if you really want 
to repeat it.

When you press a key with a letter, the lower case letter is activated. Several keys contain two or three 
symbols. By using the key alone, the lowest symbol is activated. If there are two symbols in the lower part of 
the key, it is the left one that is activated. 

To activate the upper case letters or the higher symbols, press and hold down the SHIFT key, press the key 
and then release the SHIFT key. The SHIFT key is located at the two sides of the main group the keys, at the 
two ends of the second line. It looks like: 

You can use the left or right SHIFT key. When you hold down this key, you have access to the higher 
symbols or the upper case letters for all the keys.

Above the left SHIFT key, another key lets you lock the upper case letters (Caps Lock). When you press this 
key, a small light shows it on the right part of the keyboard (except on the small Mac keyboards). To disable 
this light, press the same key again (on Mac) or press on the SHIFT key (on PC). When this key is activated, 
all letters are used in their upper case form. Unlike the SHIFT key, the symbols and figures are not modified.

The key located above the Caps Lock key (thus on the fourth line, on the left) is the tabulator key. We will 
often use it in dialog boxes. Its aspect on PC and MAC is respectively:

 
The erase key is located at the top right corner of the main block of keys. It lets you erase graphic characters 
and objects:

The Return key, also called Enter key, is located below the erase key and on the bottom right corner of the 
numeric keypad. It is used to validate something or to go to the next line in a text box. Its shape may vary 
according to the design of your keyboard. 

The Escape key (ESC) is the top left key of the keyboard. On small Mac keyboards (i.e. having only two 
groups of keys), it is located to the right of the space bar. It is used to cancel a dialog box.

On PC, the menu shortcuts are activated in combination with the Ctrl key, located on the left and right sides 
of the first line of keys. On Mac, the "Apple" key is used for the menu shortcuts.

The SHIFT and Ctrl keys will be very often used to modify the effect of a mouse click.
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On Mac for Pizzicato, the Option key (often named "alt", but not to be confused with the equivalent key on 
PC) is located between the "ctrl" and "Apple" keys, at the two sides of the space bar. It is used in Pizzicato to 
compensate the fact that the mouse of the Mac only has one button. When you click the mouse button of the 
Mac while holding down this key, you get the equivalent of a right click of a PC mouse.

Text boxes

A text box lets the user introduce information in alphanumeric form with the computer keyboard. They are 
used to introduce a name, a title, a number, a comment, etc.

A text box is represented by a rectangle with one or more lines of text. In the Windows menu of Pizzicato 
(when a musical document is open), select the Comments... item. The following dialog box appears:

The large rectangle indicates the limits of the text box. In its left corner, a small line flashes. It is the cursor 
of the text. When it is visible, it shows the position where the next character will be inserted. In the above 
example, the text box is empty. The next character will be placed in the top left corner of the rectangle.

Using the keyboard, type the word Hello. Each character appears in the text box and the caret moves to 
indicate the position of the next one. When the complete word is introduced, the higher part of the text box 
becomes:

To correct a character, you can use the erase key of the keyboard:

It is located at the top right corner of the main block of keys. Its effect is to erase the character just left to the 
caret. Use it to erase the letter O of Hello. Your text becomes:

When the text box is high enough, you can use the Enter key to go to the next line. Add a O letter and then 
use the return key. The caret goes to the next line and the text box becomes: 

Complete the text by typing the words my dear computer! They are displayed at the caret position, on the 
second line:
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You can move the caret by using the 4 arrow keys located on your keyboard:

By using 4 times the left arrow, the caret moves 4 characters to the left and arrives between U and T:

Note that a white space is considered as a character and corresponds to the long space bar located in front of 
the keyboard. The arrows let you move the caret only in the areas where text is present. Try to bring the caret 
down with the downwards arrow. It does not move, because there is no third line. Use the upwards arrow. 
The caret goes to the upper line, but it is placed just to the right of the word Hello, because there are no 
characters above the word computer. Now bring the caret right before the word computer:

Type the word "friendly" followed by a space. The new characters are inserted at the caret position and 
progressively move the remainder of the line to the right. The text box becomes:

To correct a spelling mistake, place the caret just to the right of the wrong character, use the erase key and 
insert the new character.

It is also possible to click directly where you want to set the caret. Click for instance just after the word my. 
The caret moves directly there. If you click where no text is present, the caret will be set at the nearest 
position where text is present.

Using the mouse, you can select a text section. Place the mouse just to the left of the word friendly. Click 
and drag slightly to the right. A coloured area follows your movement and covers the text. Drag to widen the 
area up to the left of the word computer and release the mouse button:

The word friendly and the space which follows are now selected. This text section is called the selection. 
You can now erase in one shot the selected text by using the erase key. Your text becomes again:

The selection disappeared. The caret blinks at the position of the previous selection. Select the word 
computer now. You get:

When part of the text is selected, you may cancel this selection by clicking anywhere in the text. The 
blinking caret comes back and the text takes again its normal color without being erase. Click before the 
word computer.
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When a selection is present, you can directly replace it with the next character you type in with the keyboard. 
Select the word Hello and type number "1". The text becomes:

We have seen how to select text by clicking and dragging. You can also do it in two operations. Click at the 
starting position of the area you want to select and put the caret there. Then, while holding down the SHIFT 
key, click at the end of the area you want to select. Try to select the word computer using this method.

When you use one of the 4 arrows whereas a selection is present, the text is normally redrawn and the 
blinking caret comes back.

Notice that the line return is considered as a character. Place the caret just before the word computer and use 
the Return key. The word computer is put on the next line:

You can select more than one line at a time. Let us select the words dear computer. The principle remains 
the same, you click just in front of the word "dear", you drag the mouse to bring it to the right of the word 
computer and you release:

Click in the text to cancel the selection. By using the same principle, here is how to remove a line, for 
instance the second line. Place the mouse to the left of the first word of the line to be removed. Click and 
drag to bring the mouse to the beginning of the following line, in front of the word computer and release the 
mouse. Your selection becomes:

The second line is now entirely selected. Use the erase key and the line disappears.

You can also select a word by double-clicking in this word.

Click the cancel button. In the Options menu, select the Graphic options... item. A dialog box appears and 
displays in its upper part several text boxes. The first text box is selected :

This text box lets the user introduce a figure. Its height makes it possible to introduce only one line of a few 
characters. These boxes are very common in the dialog boxes of Pizzicato. When you open a dialog box 
including one or more text boxes, the first is automatically selected. It is very practical because you can 
directly type in a new value with the keyboard. For example, type in the figure "5". As we explained, the 
character replaces the selected text.

When a dialog box includes several text boxes, the tabulator key lets you go from one box to the other 
without needing to click to set the caret. This key is located on the left border of the main block of keys:

 or 

Now press this key. The caret disappears from the first text box and the second text box is selected, ready to 
be modified if needed:
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The succession of the text boxes by the tabulator is usually left to right, top to bottom. When the last text box 
is reached, the first is selected again. You can also click directly in a text box to set the caret. 

Now click Cancel.
In Windows, the use of the tabulator in a dialog box also covers the check boxes, the lists, the popup menus, 
the buttons and the radio buttons. When one of these elements is selected by the tabulator, Windows displays 
a dotted rectangle around it, to show that it is selected. It can then be modified via the keys of the keyboard 
(space bar and the arrows keys). Here are some examples of elements selected by the tabulator:

Using help
• What is help? 
• The help menu 
• How to use help? 
• Reaching contextual help 

What is help?

Help is a way of quickly finding information or an explanation concerning an aspect of Pizzicato. Help is 
available on screen and contains much more than the printed manual. According to the Pizzicato version you 
have, the printed manual shows a compilation of the most essential pages. Nothing prevents you from 
printing help pages which are not in the manual or that you find important to have on paper.

The help is organized in various lessons.

The help menu

The Help menu of the main menu bar lets you reach this page as well as the content of the instruction 
manual.

How to use help?

By choosing for example an article of the help menu, Pizzicato displays the corresponding help page. At this 
time, Pizzicato continues to run and the help page is always displayed in front of Pizzicato (on Mac OS X, 
your Web browser opens and you may switch from Pizzicato to the browser back and forth). Here are basic 
explanations on how you can use this help window.

Browsing through help

• The words appearing in colour (mainly in blue, underlined or bold type, depending on your Internet 
navigator options) form what is called links. By sliding the mouse over a link, the cursor becomes a 
hand. By clicking on the link, you visualize for example complementary explanations, an additional 
subject or the definition of a word in the glossary. 

• At the beginning and end of each page, you will find a tool bar that will help you to go to the next or 
previous lesson as well as to the content page, according to the Pizzicato version you are learning. 
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Going through the help subjects already displayed

• In the help tool bar, click on Previous to display the last help subject you viewed. This lets you go 
back on your way and return to the last consulted help subject, which is often needed when learning a 
new subject. The navigator keeps your help history path in memory and lets you run it backwards. 
This is much easier than with a printed book. This method of navigation through various pages of 
explanations makes it possible to guide you in using Pizzicato. 

• In the help tool bar, click on Next to display the help page of a series of subjects you already 
displayed. 

Searching for a help subject
Three buttons give you access to (on Mac OS X, they are available in the table of contents):

1. The Table of Contents: this table lists each lesson. 
2. The Index: a list of words and expressions with links to each lesson giving more 

explanation on the word or expression. 
3. The glossary: a list of technical music and computer terms and their definitions. 

Getting help in a dialog box 

• Hit the F1 key. On Mac you can also use the Help key. 

Printing a help subject

• By right-clicking in the background of the help window (on Mac OS X, in the File, Print menu), a 
menu appears and lets you select the Print command. 

Size of the help window

• The help window is displayed in front of the software. You may change its size and position so that 
you can easily view help and the screen area of Pizzicato you are working with. You may also 
minimize it to hide it temporarily. 

Copying a help subject

• Simply select the text to copy and use the "Copy" item of the right-click menu (or the browser Edit 
menu). The text is then copied in the clipboard. 

• Open the document in which you want to copy the subject. 
• Click in the document where you want this information to appear. 
• In the Edit menu, select Paste. 

Reaching contextual help

Help is also available according to the context in which you are in Pizzicato. To reach the contextual help, 
set the mouse on the graphic element for which you want help, for example a window, a tool or a dialog box. 
Then use the F1 key. On Mac, with an extended keyboard, you can also reach it with the Help key.

If help is available for that element, it will appear in the form of a help window. If not, it is the main help 
index that will be displayed.

Direct yourself towards any subject you want and explore the contents of help until you are accustomed to it.

The concepts learned during these last lessons finally enable you to approach the practical use of Pizzicato. 
Be certain to understand them fully and do not hesitate to read these lessons again and again. They give you 
the basic tools to communicate with Pizzicato. Have a good journey!
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What's new in version 3.6
• Pizzicato Professional 3.6 
• 8 new Pizzicato versions in 3.6 

Pizzicato Professional 3.6

In comparison to Pizzicato Professional 3.5.0, Pizzicato Professional 3.6.0 has the following additional 
features:

• A repeat wizard helps you automatically calculate the passages according to the repeat bars and to 
various standard symbols found in the Graphic symbols tool palette. 

• It is now possible to select a part of a measure to copy, paste or apply various other operations. 

• A new automatic triplet encoding mode has been added. 

• A transposition wizard helps you to easily transpose a score from one instrument to another. 

• You can now directly export a score into a PDF file. 

• You can use the ASIO4ALL audio driver to reduce the latency of the audio card and get an instant 
playback. 

• A visual and easy to use wizard helps you to define a custom drum map. 

• The final version of the Music Typing Keyboard is now available and the real keyboard may be 
purchased on our site. 

• An audio to score conversion function helps you to transcribe a melody from an audio WAV file or 
directly from a microphone. 

In comparison to Pizzicato Professional 3.4, Pizzicato Professional 3.5 has the following additional 
features:

• The page layout function has been deeply improved and is much more efficient, mainly when you 
modify the page layout and when you add measures and staves. You can insert BMP images as well 
as personal drawings. Printer and page setups may be customized per page. You may define several 
printing areas to place measures, which means you can create page layout for booklets and many 
other custom formats. You can view many pages at once on the screen. 

• A document manager makes the handling of scores much easier. No need to use the Windows and 
Mac file opening and saving dialogs anymore. Your documents are automatically saved and visible 
on the left part of the screen, always available. Preview the content of a score by dragging the mouse 
over its icon in Pizzicato. This manager helps you to handle all the music composition resources 
(harmonic spaces, vectors, virtual instruments, libraries,...), whether in the conductor view as in the 
score or global view. Several custom areas may be defined, which helps you to handle the various 
composition resources more efficiently. 

• Several improvements have been made in the global view, to make it more user friendly to edit all 
aspects of a score in the same window. Markers have been added to locate passages more easily. You 
can select the family directly in that window. 

• A specific window displays a musical typesetting keyboard. A real physical keyboard of the same 
type will be developed in the future to be used with Pizzicato. The idea is to be able to enter music 
very fast. Presently, this window helps to understand how this future keyboard will be working to 
fasten the process of entering a music score into the computer. At this step, it is an experimental tool 
with high potential. 

In comparison to Pizzicato Professional 3.3, Pizzicato Professional 3.4 has the following additional 
features:
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• A modular software synthesizer is now included in Pizzicato. With it, you can create synthesized 
sounds, read samples and manipulate the sound material. You can create a sound from scratch or use 
the given examples. See the lesson on the modular synthesizer. 

• You can now directly import SoundFont sample files. Many such sounds can be found free of charge 
and free of rights by the thousands on the Internet. You can assign them to the staves of your score 
and use them in your composition. The final sound quality produced by Pizzicato becomes 
independent of the sound card and its synthesizer. See the lesson on virtual instruments. 

• Pizzicato includes a quality sound library to listen to your music scores. It is the Papelmedia library 
( http://www.papelmedia.de/english/index.htm ), which is now a standard part of Pizzicato. 

• You can create an audio WAV file from your score directly with Pizzicato, without the need to go 
through the complexities of sound cards and their sometimes bad quality synthesizers. The final 
audio file includes directly the high quality sounds from the Papelmedia library or from any 
SoundFond sample that you can find on the Internet. A global audio file may be created but you can 
also create a separate file for each staff, for instance if you want to work it in a studio, remix it or add 
effects. See the lesson on the creation of an audio file. 

• A new note entry mode has been added, to draw the duration of a note directly on the staff, modify its 
pitch, the stem direction,... All this only with the mouse, with no need of keyboard shortcut nor 
selecting tools on a palette. Another tool let you enter the notes of chords intuitively, based on 
existing chord symbols, for one or more staves. To delete a note or rest, you can now drag it outside 
the measure, which is sometimes quite handy to do. See the lesson on the graphic note entry mode. 

• A new music composition tool let you graphically draw melodies, move them, transform them, 
assigning rhythms to them, directly on the score. With it you can literaly draw your melody 
intuitively, based or not on existing chords and scales. Anybody can now express himself (herself) 
through music. The music notation just follows you hand and you can thereafter listen to the melody. 
See the lesson on graphic vectors. 

• The score view now has an additional display mode: the global view. You can select which staves to 
display, the effects to display, the graphic note editors, the audio instrument selection, the chords and 
scales,... all in a very intuitive way so as to have all needed information in the same window, without 
the need to open/close several windows to work some specific part of your composition. The idea is 
to assemble in one window all pertinent items. Moreover, you can memorize preset and call them 
back in one click. Imagine working the strings of an orchestra, then the volumes of instruments, 
tempo variations,... Then the percussion section, the brass, the audio instruments selection, the 
chords,... You can switch at once from one setup to the other, which speed up your work by placing 
all musical items at your fingertip. See the lesson on the global view. 

In comparison to Pizzicato Professional 3.2, Pizzicato Professional 3.3 has the following additional 
features:

• Pizzicato has been reorganized for a better compatibility with Windows Vista and Mac OS 10.5. On 
Mac, it is now available as a universal binary (PowerPC and Intel). It still works on Mac OS 10.3 and 
10.4 as well as with Windows 98, 2000 and XP. 

• Tools for the guitar have been developped. You can write on a guitar tablature. A few guitar 
templates have been added to the numerous templates available. The translation between a normal 
staff and a tablature can be done automatically. It is possible to select and display guitar chord 
diagrams above the staff. Tablatures and chords diagrams can be customized. A new palette is 
available with several symbols ready for use for the guitar notation. A guitar fretboard window helps 
you to view, play and write notes in a tablature, similarly to the use of the piano keyboard window. 
See the guitar tools. 

• Harmonic spaces have been improved and numerous harmonic spaces are now ready to be explored. 
A powerful harmonic progression generator has been designed. With a few specification that you 
decide, you can find all possible chords sequences that will satisfy them. You can then explore them 
intuitively. See the harmonic spaces. 
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• A tool helps you to manage custom chords and scales so as to determine how the score arranger will 
create the arrangements. You can define your own scales and chords based on intervals and drag 
them into the score to hear the influence they have on an arrangement. See the general scales and 
chords. 

• A new composition tool has been designed: the music vector. It is a melodic generator, based on 
several specifications that you decide. You can for instance draw a free graphic curve and see it 
become a melody when it is applied to existing scales and chords. Thousands of predefined music 
vectors are available in the library and can be dragged into the measures of the score to see the 
generated melodies. This applies as well for soloist melodies, multiple arpeggios and secondary 
voices for 1 to 5 instruments. They are very easy to use. Music vectors can also be created by you 
and form a powerful tool for music creation and experimentation. See the lesson on music vectors. 

• Pizzicato Professional can export and import scores in the MusicXML file format. This format is 
recognized by several music software. This helps you to exchange scores with friends working with 
other music software. You can also find MusicXML score on the Internet. See the MusicXML files. 

• An additional parameters determines if the metronome may or may not mark the intermediate beats 
in ternary (6/8, 9/16,...). See the metronome configuration. 

• Every note can have its custom color, through the note editor dialog box. A function helps you to 
assign colors according to the note name, frequency or guitar fingering. See the color assignment 
dialog box. 

• An easy function helps you to create upbeats and incomplete measures. 

• Additional note heads are available. 

• The measure parameters now let you block the automatic justification for one or more measures to 
avoid that a manually layed out measure be changed by Pizzicato. You can also define for each 
measure which lines of the staff are displayed, so that you can make contemporary scores where lines 
are for instance not always visible. 

In comparison to Pizzicato Professional 3.1, Pizzicato Professional 3.2 has the following additional 
features:

• A new view is used to edit the notes of a measure in a graphical way. It is the graphic editor. Each 
note is displayed as a small horizontal bar that may be moved, deleted or created. See the lesson on 
the graphic editor. 

• An additional graphic option is used to display the notes according to the chord symbols. The notes 
of the chord are displayed in green, the notes of the scale are displayed in orange and the other notes 
are displayed in red. Very practical to compose a melody on given chords. See graphic options. This 
option is also active in the graphic editor. 

• A new music composition tool has been designed: the harmonic space. It is a set of prepared chords 
in which you can navigate in an intuitive way to find a chord progression that fits your composition, 
with a real time arranger that can also be combined to music styles. See the lesson on the harmonic 
spaces. 

• The concept of drag/drop is generalized as an intuitive composition tool. Scores with notes rhythms, 
instruments, effects and chords may be dragged and dropped in your score to build it or complete it, 
like a construction set game very easy to use. See the lesson on dragging/dropping scores. 

• SO as to be able to use the drag/drop function, numerous composition libraires are found in Pizzicato: 
libraries with instruments, with individual instrument patterns, notes, rhythms, chords, chord 
progressions and other kind of musical objects. Also 35 ready to use styles as well as MIDI style 
importation functions that can import file styles of the Yamaha format ("*.sty" files), that you can 
find in quantity on the Internet. See the lessons on music libraries and the use of styles. 

• The music generators are musical objects that can create series of scores on the basis of elementary 
music elements (notes, rhythms, chords, instruments) and a set of combinatory rules. They are a 
considerable source of music material, starting with the imagination of the user. See the lesson on the 
music generators. 

42



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

• The score arranger contains a series of basic harmonisation and voice conduct rules. Starting from a 
chord sequence, Pizzicato helps you to arrange your score whether for two voices or for a full 
orchestral score. See the lesson on the score arranger. 

In comparison to Pizzicato Professional 3.0, Pizzicato Professional 3.1 has the following additional 
features:

• The possibility to use audio files together with your music scores. You may for instance add one or 
more voices or life instrument, recorded with a microphone. Audio WAVE files (".wav" extension) 
may be recorded, copied, pasted and edited with a powerful audio editor. You may also add audio 
files in your music score and determine the exact moment they will be played in relation to the score. 
See the lesson on audio tracks and on the audio editor. 

• You may export an audio file from your music score into a WAVE file, exactly as you would hear 
Pizzicato playing it. Once you have that audio file, you may use it with your CD burning software to 
create an audio CD that can be played on any CD player. See the lesson on the creation of an audio 
file. 

• A better handling of ties between notes, mainly when combined with repeat signs or when a score is 
played starting at a measure containing ties from a previous measure. 

• Concerning the lyrics, it is possible to add a lyric extension from inside the fast encoding window ( _ 
sign). You may also add a minus sign "-" inside one lyric, without cuting the word automatically. A 
function may add the note names (C, D, E,...) inside the lyrics. The lyrics may be placed above the 
notes. The font, size, style and color of the lyrics may be adjusted for each staff/voice of the main 
system. When entering the lyrics in linear view, the measures scroll automatically. See the lesson on 
lyrics. 

• The page setup may now use two braces or brackets for each staff, which may be needed for 
orchestral scores. See the lesson on the characteristics of staves. 

• Several additional options are available. You may specify the default directories as well as the 
backup directory. See the lessons on the global options and on automatic saving. 

• An option improves the page numbering feature. See the lesson on text blocks. 

• Practical contextual menus have been added for the score, the sequencer and the main view, notably a 
paste/transpose item. 

• An option has been added in the special paste function, so that merging staves may keep the voices 
separated. See the lesson on special paste. 

• An option has been added for the German notation of chords. See the lesson on the chord library. 

• The % and °//o symbols (repeat of one or two identical measures) are now really played by Pizzicato. 

• The piano roll view now follows the real time playing, like the other views. 

• When using different measures in the same system (for instance 3/4 for one instrument and 4/4 for 
another one), Pizzicato adjusts the tempo ratio for each instrument so that the durations of the 
measures become the same (in the preceding example, the 3/4 instrument will play in a faster tempo 
than the 4/4 instrument). 

In comparison to Pizzicato Professional 2, Pizzicato Professional 3.0 has the following additional features:

• Improvement the Tuplets function: style, placement and stability. Specifically, the placement of a 
Tuplet reserves space for the notes, so that you can avoid the problem that occurs when you try to 
place a tuplet on the last beat of a measure. See the lesson about tuplets. 

• Importation of NIFF files. This builds a bridge to music scanning and recognition softwares. Two 
scanning softwares are suggested to work with Pizzicato and directly import the scanning result. See 
the lesson on NIFF files and scanning. 

• The optimisation of systems has been enhanced. You can now specify for each system which staff is 
visible or hidden. See the lesson on page setup. 
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• A specific view has been designed to graphically display the various MIDI effects produced by 
symbols and by data modifications (through Edit, Data modification...). The playing of symbols may 
be selectively activated and the volume/velocity curves may be visualized as generated by a 
succession of nuances, crescendo,... or simply from the MIDI file import. An eraser, a pen and a 
straight line may be used to visually modify the curve. You may also modify the effect of a symbol 
or individual accent. This is available for all effects, for each staff and several effects views may be 
open at the same time. See the lesson on the musical effects view. 

• Repeats : by placing a negative number in a repeat box, the software stops playing after that measure 
(it lets you stop the score in the middle of a piece). See the lesson on repeats. 

• A specific tool has been designed to add grace notes. The note contextual menu lets you add a 
simple, double, triple or quadruple grace note. See the lesson on grace notes. 

• You may specify an octave sign to a clef so that there is an automatic transposition. See the lesson on 
clefs. 

• It is now possible to adjust lyrics globally. It is useful when lyrics has been individually moved 
around and if you want to readjust them all at once. See the lesson on lyrics. 

• Cross-staff beaming is now possible. Notes from a measure may be displayed into the upper or lower 
staff. See the lesson on cross-staff beaming. 

• Individual voices may be played separately. See the lesson on the instruments view. 

• The name of the Maj and min chords may be abbreviated to "M" and "m" to save place. See the 
lesson on chords library. 

• The starting repeat bar appears now correctly after the clef, key and time signatures. 

• There are new options for measure numbering. See the lesson on staff characteristics. 

• An automatic saving of files may be set as well as a backup manager to automatically keeps up to 5 
versions of the same document. See the lesson on saving and backups. 

• A special "paste" function selects the items to copy (notes, symbols, clefs,...) and filter the rhythmic 
voices of a measure. This function lets you also "merge" or "explode" music into or from several 
staves. See the lesson on the special paste function. 

• Measures may have several versions. You may add, remove and change versions of measures. See 
the lesson on the measure versions. 

• The MIDI management has been entirely renewed and may connect up to 16 MIDI inputs/16 MIDI 
outputs. It is automatically configured at startup with one MIDI port and may be asked to configure 
all ports on demand. See the lesson on MIDI setup. 

• A new set of tools have been designed to help you to compose music. The smart link tool lets you 
establish links between measures. It is a sort of intelligent paste and parametered transformation 
function. It is similar to a spreadsheet for music. See the lesson on the smart link. A new view has 
been designed: the conductor view. It is a musical desktop that lets you manage several scores, play 
them and create groups of scores to structure a music composition. See the lesson on the conductor 
view. An instrument becomes an object that can be used and managed on the conductor view. They 
offer you an easy way to handle, change and test the instruments of your composition. See the lessons 
on intruments. Virtual keyboards will transform your simple MIDI keyboard in a multiple keyboard 
that will greatly enhance your musical playing possibilities. See the lesson on virtual keyboards. 
Music libraries will help you start designing your own rhythmic patterns, like a structured building 
block construction set. You test, try and listen. No music knowledge required. See the lesson on 
music libraries. 
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8 new Pizzicato versions in 3.6

For Pizzicato Notation, Composition Pro, Composition Light, Keyboard, Choir, Guitar, Soloist and Drums, 
in comparison to Pizzicato 3.5.0, Pizzicato 3.6.0 has the following additional features:

• A repeat wizard helps you automatically calculate the passages according to the repeat bars and to 
various standard symbols found in the Graphic symbols tool palette. 

• It is now possible to select a part of a measure to copy, paste or apply various other operations. 

• A new automatic triplet encoding mode has been added. 

• A transposition wizard helps you to easily transpose a score from one instrument to another. 

• You can now directly export a score into a PDF file. 

• You can use the ASIO4ALL audio driver to reduce the latency of the audio card and get an instant 
playback. 

• The final version of the Music Typing Keyboard is now available and the real keyboard may be 
purchased on our site. 

• An audio to score conversion function helps you to transcribe a melody from an audio WAV file or 
directly from a microphone. 

For Pizzicato Notation, Composition Pro, Composition Light and Drums, in comparison to Pizzicato 3.5.0, 
Pizzicato 3.6.0 also has the following additional features:

• A visual and easy to use wizard helps you to define a custom drum map. 

Publication of Pizzicato 3.5
With the release of Pizzicato 3.5, eight new versions are available. They target specific users and 
offer a series of features extracted from Pizzicato Professional, at a very affordable price, for a 
specific usage.

If you have Pizzicato Professional, these versions are not useful to you, as Pizzicato Professional 
contains every feature found in each of these special versions.

We have published these versions because we know that there are potential users who would like 
to use a small part of the Pizzicato functions, for a cheaper price than the Professional version. 
These new versions are for them.

For instance, if you are interested by music notation in all of its aspects and if you do not need 
the composition tools, you can buy Pizzicato Notation, which has all notation features of 
Pizzicato Professional, without the composition tools and contains only the more basic MIDI 
functions.

If you already use a music notation software (Finale, Sibelius, Notion,...) and that you want to 
benefit from the advanced and intuitive tools to compose your own music, you can buy Pizzicato 
Composition Pro, which offers all the advanced composition features, MIDI arrangers, audio, in 
music notation but with no page layout. You can then export your composition as a musicXML 
and use it in your preferred music notation program.

If your needs are limited to a specific instrument or usage, 5 cheap versions of Pizzicato help you 
write your sheets of music for the Choir, the Guitar, Drums and Percussion, the Soloist or the 
Keyboard.

To discover the intuitive tools to compose your own music, Pizzicato Composition Light will 
help you to master music composition (chord selection, styles, intuitive tools, arranger,...).
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MIDI Setup
• What is MIDI? 
• MIDI configuration 
• Select a synthesizer 

What is MIDI?

MIDI stands for Musical Instrument Digital Interface. It is a language enabling synthesizers and computers 
to exchange musical information.

Thanks to this system, the computer can record the notes you play on your musical keyboard and take 
control of a musical synthesizer to play your scores and compositions.

Physically, this communication is established by one or two cables connected between the computer and 
your musical instrument. Note that low quality synthesizers do not always have a Midi interface, which 
makes them unable to communicate with a computer. To be certain of a MIDI compatibility, look at the back 
panel of the instrument. There must be at least one or two connectors of the following type :

with a label In, Out or Thru
A Macintosh or a PC does not natively contain a MIDI connector. This adaptation is done using a Midi 
interface.

On Macintosh, a Midi interface is a small external box. It comprises connectors necessary for Midi cables 
and it has a cable which can be connected on the back panel of the Macintosh (USB port).

On PC, the Midi interface is very often presented in the form of an electronic card installed inside the 
computer or also a little box connected to USB. An adapter is connected to the back and lets you connect the 
Midi cables to your musical instrument.

Midi devices have one or more Midi connectors. A Midi cable only allows a one way communication. If you 
have for example a Midi synthesizer with a keyboard, it must at least have 2 Midi connectors. The first will 
be labeled Midi In (Midi input) and enables the synthesizer to receive musical data from your computer. The 
second Midi connector will be labeled Midi Out (Midi output) and lets the synthesizer send the notes you 
play on the musical keyboard to the computer. A third Midi connector is often present, labeled Midi Thru. It 
is a Midi output sending a copy of the data coming from the Midi In connector of the instrument. It is a Midi 
echo which can be used to connect another Midi devices that needs to receive the same MIDI messages.

When you connect Midi devices together, it is necessary to keep that information in mind. A connector is 
either an input (Midi In) or an output (Midi Out or Midi Thru). A Midi cable must ALWAYS be connected 
between an output of a device and the input of another device. Any other combination will not work.

Here are diagrams of most current connection setups between a MIDI device and a computer.

• Synthesizer with a keyboard: 
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• Midi keyboard (without integrated synthesizer): 

• External sound module without a keyboard: 

• Midi keyboard (without integrated synthesizer) + external sound Module: 

• Synthesizer with external keyboard + sound Module: 

To install your Midi interface correctly, read its installation manual. Also take care to install the driver 
software of the interface (MIDI and sound card drivers for Windows). This installation should normally be 
explained in the MIDI interface user manual.

A Midi cable does not transport sounds but only information concerning the notes which are played on the 
keyboard as well as other information used to configure a synthesizer. The connections explained above 
relate only to the Midi aspect. If your synthesizer does not have an internal speaker, you need to connect its 
audio output to an amplification system connected to loudspeakers, such as a Hi-Fi system. If you have a 
sound card, its audio output must be connected either to an external loudspeaker provided with the card or to 
your Hi-Fi system. Consult your card or synthesizer manual.

The rest of this lesson will explain to you how to tell Pizzicato what is your musical material and your Midi 
interface. Before doing so, be sure that your Midi interface or sound card is correctly installed. Be certain 
that connections are correctly established, by looking at the above examples. Also check that your musical 
material is switched on.

An important remark applies if you have a MIDI cable for a sound card (Windows). On one side, it is a large 
plug adapted to a sound card connector, also called Joystick port (sometimes this cable has a similar female 
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domino plug, enabling the connection of a joystick at the same time). Two MIDI connectors can be found on 
the other side of this cable. One is called MIDI IN and the other MIDI OUT. These names correspond 
respectively to the MIDI input and the MIDI output from the computer viewpoint. Considering the 
preceding diagrams, it is thus necessary to connect the MIDI IN plug into the MIDI OUT connector of 
the synthesizer and vice versa. The inversion of this connection is a very frequent cause of MIDI failure. 
To connect it wrong fortunately does not destroy anything, but MIDI communication is not established.

At installation, Pizzicato selects itself a simple MIDI setup that should work in most cases without any 
further modification. In case of problems, or if you want to fully use all MIDI resources from your sound 
card, here is how to adatp MIDI setup. If you have problems with the MIDI setup, do not hesitate to contact 
our support department.

MIDI configuration

In the Options menu, select the MIDI setup... item. The following dialog appears:

Pizzicato communicates with a MIDI device through what is called a MIDI Port. Each Midi port is a bi-
directional terminal communication between Pizzicato and your musical instrument. When a Midi message 
is sent to your musical instrument, it goes through the Midi port. Similarly, when you play notes on your 
keyboard, this information is received by the Midi port and Pizzicato can process them.

The Midi configuration dialog box shows MIDI inputs on the left (in blue) and MIDI outputs on the right (in 
red). Most Pizzicato versions let you use one input and one output, and Pizzicato Professional or 
Composition Pro may use up to 16 inputs and 16 outputs. In most cases, one or two Midi port(s) will be 
enough.

After the first installation, Pizzicato selects an input port and an output port according to your computer 
configuration.

To test an output port, click the little white square just left to the port. A series of notes is sent to this MIDI 
port by Pizzicato. If you hear them, the port is well connected.

You may modify the input and output ports by double-clicking on one of them.

• Configuration of a MIDI output port 
Double-click on the output port. The following dialog appears:
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Here is a description of each field:

• Name: it is the title you give to the MIDI port. By default, it is the type of associated 
synthesizer (see below) followed by the original name of the MIDI port. You may 
personalize and/or simplify it, for instance as "Audigy card", "Yamaha Synth",... This 
name will be used whenever you will need to select an output port (in cas you have more 
than one) for the different staves of a score. 

• Associated driver: This menu contains all MIDI output drivers installed on your 
computer. Each one corresponds either to a MIDI synthesizer on your sound card or to a 
MIDI interface to which an external MIDI device may be connected. 

• Voices: When this box contains a number, it is the number of simultaneous voices that 
can be played. 

• Polyphony: When this box contains a number, it is the number of simultaneous notes that 
this output can play. According to the synthesizer model, one note may need more than 
one voice to be played. Most of the time, for a sound card, those two numbers are 
identical. 

• Available MIDI channels: specifies explicitly the MIDI channels that may be used by 
this output. Those three last boxes are displayed as information and may not be modified. 

• Associated synthesizer: For Pizzicato Professional and Composition Pro, this list 
contains almost 100 synthesizer models. This list does not mean you can play the sounds 
of each model. Those models only contain the list of sounds and the specifications of 
those models from the market so that when you need to select a sound to play, you may 
do it realistically for your synthesizer, choosing from the real list of sounds contained in 
the model. To hear the sounds, you need the real synthesizer, connected to the MIDI 
output. See the remark below on selecting a synthesizer.

The other versions of Pizzicato only contain the standard GM (General MIDI), GS 
(Roland), XG (Yamaha) or a list with numbers only (MODELE-1). 

• Configuration of a MIDI input port 
Double-click on the input port. The following dialog appears:

Here is a description of each field:

• Name: it is the title you give to the MIDI port. By default, it is the original name of the 
MIDI input port. You may personalize and/or simplify it, for instance as "My 
keyboard",... 

• Associated driver: This menu contains all MIDI input drivers installed on your 
computer. Each one corresponds to a MIDI interface to which an external MIDI device 
may be connected. 

• Echo to: You may specify here one of the output ports, so that each MIDI information 
received by the input port are sent in echo to the selected output port. If you have a 
synthesizer with a keyboard, you do not need to specify an echo because the notes you 
press are immediately played by the synthesizer. If your MIDI keyboard is separated 
from your synthesizer (keyboard + external sound module), you need to activate an echo 
so that you hear the notes played by your sound module. 

• Transposition value: all incoming notes will be transposed with this value. 
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• MIDI filter...: this button calls a dialog box to selectively filter MIDI events and MIDI 
channels that may get through this MIDI port : 

To add or delete a MIDI input or output port, right click with the mouse to get the contextual menu. One 
item lets you delete the clicked port and two others let you add an input or output port. With the same menu, 
you may ask Pizzicato to automatically configure MIDI. By doing so, the present MIDI setup is removed 
and Pizzicato creates a port for each input and output found existing in the computer. You may then 
personalize it as explained above.

According to the material you possess, here are the most common situations.

• You do not have a musical material nor a sound card : 
In this case, no Midi interface needs to be connected. On Mac, providing that the "QuickTime 
Synthesizer" extension is installed, you can select this choice on the MIDI output port. You can 
close this dialog by clicking on its close box.

• You have a Midi interface in your PC/Mac: 
Double-click the input port and select the Associated driver corresponding to the name of your 
interface, such as Mpu-401, MusicQuest, Midi Input, SB MIDI IN… and validate. Do the same 
for the output port. If no item is available in the Associated driver menu, it means that the Midi 
interface card was not installed properly. Re-examine the instruction manual of your card and 
take care to correctly install, otherwise Pizzicato will not have access to MIDI.

If your Midi interface has several inputs and outputs, they will be available in the Associated  
driver menus. With Pizzicato Professional, you may add input and/or output ports, as explained 
above, and configure them so they will answer to each MIDI interface available.

• You have a sound card (with or without a MIDI interface): 
The principles exposed in the previous step also apply. Use the Midi input port to select the 
Associated driver corresponding to the MIDI input of your card, such as Mpu-401, MusicQuest, 
Midi Input, SB MIDI IN… 

With regard to the output, this kind of card contains at least 2. If you use an external synthesizer 
connected in Midi, use the output MIDI port to select it (for example the item Mpu-401, 
MusicQuest, Midi Output, SB MIDI OUT…).

A sound card generally has an integrated synthesizer which can be selected in the Associated  
driver output menu. You may add another MIDI output port (Pizzicato Professional and 
Composition Pro only) to access it. According to the sound card you have, you will probably 
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find two possible choices others than the MIDI output. Modern sound cards often contain an FM 
synthesizer - FM Synthesis (Yamaha OPL3) - and another more sophisticated but whose name 
depends on the constructor of your card.

The order of the output and input ports is not very important. MIDI port 1 is selected by default 
for instruments in a new score, so preferably use Midi port 1 for the synthesizer you will use the 
most.

If you use a Midi keyboard without an integrated synthesizer, you will need to set the echo 
associated with the MIDI input to the MIDI output port associated to the synthesizer of the card. 
This will let you play on your keyboard and directly hear the notes executed by the sound card 
synthesizer.

Select a synthesizer

In Pizzicato Professional and Composition Pro, the synthesizer selection list contains almost one hundred 
synthesizer models. The other versions only contain the standard GM (General MIDI), GS (Roland), XG 
(Yamaha) lists, as well as a generic list by numbers (MODELE-1).

The synthesizer selection list enables you to specify the model of card or synthesizer you have. Pizzicato 
must be able to know the sounds available on the instruments, the MIDI channels that can be used, the 
special effects available (reverberation, chorus…) as well as various specific characteristics of your 
instrument.

The list of synthesizers contains several synthesizers and sound card on the market. If your synthesizer or 
sound card is not in the list, see the remark below. Most sound cards use the GM standard, GS (Roland) or 
XG (Yamaha). For GM, select the Gm-1 item in the list.

If necessary, you can connect several synthesizers on the same Midi interface. It is the case for the last 
connection example drawn at the beginning of this lesson (synthesizer with keyboard + sound module). You 
just need to configure two MIDI ports (only with Pizzicato Professional or Composition Pro) with the same 
interface and respectively associate them to the first and the second synthesizer names. It will be necessary 
to disable some MIDI channels of your synthesizers and to slightly reconfigure your synthesizer in order to 
avoid communication conflicts. For more details, see the lesson on the synthesizer configuration.

Remark
If you do not find your synthesizer or sound card in the prepared list, here is how to proceed.

1. Consult the manual of your synthesizer to see if it is compatible with GM standard 
(General Midi). This standard is more and more used . It standardizes the behavior of the 
synthesizers. If it is the case, select the Gm-1 line in the synthesizers list. Also see if it is 
compatible with GS standard (General System), a standard more specific to the Roland 
synthesizers. In this case, select line GS in the list. Try also the XG model (Yamaha). 
Check if the model of your synthesizer is very close to another model of the same brand 
and test it. 

2. If it is not the case, know that Pizzicato (Professional or Composition Pro) enables you to 
create and configure a new synthesizer which can be added to the provided list. This 
requires a good knowledge of synthesizers and MIDI technology. The instructions to be 
followed are explained in the lesson treating the configuration of synthesizers. In some 
cases, we may do the encoding ourselves for a specific synthesizer, but it depends on the 
model. Anyhow, you may always contact us for advices. 
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Introduction to the music course
• The purpose of this course 
• Material needed 
• How to use this course? 

The purpose of this course

Our music course is oriented around three specific objectives:

1. To give you a good understanding of the basics of music and the way it is written and communicated. 
2. To teach you to read simple musical scores and to play them on a keyboard. 
3. To teach you how to compose your first pieces of music. 

The prime objective is to understand what music is and how it can be communicated through a score. The 
majority of signs, symbols and conventions of musical notation will be explained. Pizzicato comprises tools 
to write a musical score. In correspondence with the description of each tool, you will find in this course the 
explanations of the musical concepts concerned with this tool.

Once you will have learned the first basics of music, the second part of the course will let you apply them to 
the reading of simple scores. You will learn how to locate the notes on a musical keyboard. A series of 
progressive exercises will enable you to improve your rhythmic ability. Finally, by combining these two 
aspects, you will learn how to play scores.

The third part of the course relates to the musical composition. Pizzicato professional has a unique system 
making it possible to learn how to compose by practice. It is about a musical building set. You have musical 
blocks of various forms and colors. By combining these blocks by a series of progressive exercises, you will 
learn how to guide yourself by your musical preferences. By going through the exercises, you will be able to 
create your own musical blocks and you will learn how to structure small musical sequences. This aspect of 
the course is also addressed to the professional musician. He will find a new approach of composition which 
he will be able to exploit thanks to the musical library system. If you did not buy the professional version, 
you will nevertheless be able to find some interesting elements of this part of the course. You will be able to 
execute some of the exercises by using the evaluation version of the professional version. This mode is 
accessible by the Program version/updates... item in the Pizzicato Options menu. By clicking Pizzicato  
Professional (evaluation version), you have access to most of the functions of the professional version, 
except that you can neither save nor print your work.

Material needed

On the level of the necessary material, the minimum is of course a Macintosh (system X) or IBM compatible 
PC (with Windows 2000, XP, Vista or Windows 7) computer. If you want to print your scores, a printer 
adapted to the computer will be necessary. If you want to connect a musical keyboard, you will need a MIDI 
interface or a sound card with the adequate cable. With a good quality sound card or an external synthesizer 
(Roland, Yamaha…), the sound result will reach a good quality level. Here are some examples of 
configurations with their advantages and disadvantages in the various parts of the music course.

Computer (Mac or PC with sound card ) or external sound module with MIDI interface.

According to the type and quality of the card or module, the universe of sounds 
opens up to you. The majority of cards and modules available are compatible with 
the General Midi format .This standard guarantees that you will be able to listen to 
each example and exercise of this course. You will be able to execute without 
problem the composition exercises. Without musical keyboard, you will be able to 
play simple scores on the computer keyboard, with the accompaniment generated by 
the sound card. The precision of the play on the computer keyboard will be a 
function of the speed of your computer.
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Same + musical keyboard and MIDI interface

In this case, there is no restriction anymore. You will be able to work all the training 
exercises and to execute everything in this course.

PC without sound card

The music course will be reduced to the theoretical aspect, because you will not hear 
any sound example. We advise you to acquire a sound card to be able to benefit from 
all the music course aspects.

Macintosh alone

It contains a synthesizer which makes it possible to listen to a score very correctly. 
You can also use its keyboard to play directly with this synthesizer. You will then be 
able to follow the full music course.

How to use this course?

No musical or software knowledge is necessary to start this course. You only need to be motivated by 
learning music. Study this course and make the practical exercises in the expected sequence. With 
perseverance, you will end up controlling the contents of this course.

The covered subjects are the basics of music and musical software. It is taught in a progressive way in order 
to make training easier for you. This does not mean that you will never encounter difficulties. Throughout 
the reading of this course, take care to respect the following points particularly:

1. Be sure to understand all the words you read in this course

If you hesitate over the meaning of a word, consult the glossary included in the 
documentation. The majority of words related to music, software or Pizzicato are 
there. In the screen documentation, new introduced words are frequently coloured 
and underlined. By clicking on these words, you directly reach the correct reference 
in the glossary. The words have sometimes several different meanings, be sure to 
take the definition which applies. We also advise you to sometimes read extracts of 
the glossary to test your good understanding of the main words.

2. Execute the exercises and the examples of each lesson

These exercises are there to balance theory and practice. They are designed so that 
you can apply the theory and in this way increase your understanding of the subject. 
Indeed, it is by applying that you can test and reinforce your understanding.

3. If you have difficulties, come back to previous lessons

Perhaps you did neglect words which you did not understand? Perhaps you were too 
fast? Perhaps you missed some steps? Go back to one or more lessons before, until 
you are certain to understand it well. Then continue. Some lessons are more difficult 
than others. When you find a lesson that seems more difficult to you, do not hesitate 
to read it several times to increase your understanding.

4. If despite all this you feel completely lost… 

Your case is not desperate! It is not always easy to locate difficulties in which you 
are. Contact us. We will help you to find a solution to your difficulties. Perhaps we 
will be able to help you by phone. Do not hesitate to contact us, our purpose is that 
all Pizzicato customers must be satisfied!
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Music notation
• What is music? 
• Characteristics of a sound 
• Music notation 
• The staff 
• The measure 
• Summary 

What is music?

Music is the art of organizing sounds to make them express a message, an impression, a state of heart, an 
atmosphere, an emotion, feelings… It is a communication which emanates from the composer or performer 
and goes to the auditor.

Music is primarily transmitted by sound. All sound characteristics can thus be exploited to enrich musical 
communication.

Sound is an air vibration perceived by the ear. When the pianist hits a piano key, the movement creates a 
shock between a small hammer and a metallic string. This string vibrates and resounds in the piano. While 
doing so, it carries the air with it and this vibration of the air propagates all around. When this vibration 
reaches your ear, you get the sound feeling that you know.

The propagation of the sound is similar to the undulations that you see on the surface of a calm water when 
you throw a stone in it.

Characteristics of a sound

A sound vibration has various characteristics we can perceive. The first characteristic is the sound pitch. On 
a physical viewpoint, it is the number of vibrations executed by the air in one second. The more vibrations 
there is, the more the sound appears high-pitched to you. Schematically, you can compare a low-pitched 
sound and a high-pitched sound in the following way:

Low-pitched sound:

High-pitched sound:

The second characteristic is the amplitude (loudness) or the force of the sound. The larger the vibration, the 
more a sound appears loud to you. Here is an illustration:

Weak sound:

Loud sound :
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A third characteristic of the sound is its duration. For how long does the air vibrate? This duration is 
measured in seconds.

The last characteristic is the timbre of the sound. It lets you distinguish the type of instrument playing. You 
can easily distinguish a melody played by a piano from a melody played by a flute. Even if the melody is the 
same in both cases, you can at once recognize the piano or the flute. Physically, this difference comes from 
the shape of the vibration. For example, here are two sounds having the same pitch and the same force but 
they are characterized by the timbre, i.e. the shape of the vibration:

When you will have learned how to open a document with Pizzicato, we will listen to examples of these four 
sound characteristics: pitch, duration, amplitude and timbre.

Music notation

Music being a sound, the most obvious way to transmit it is to listen to it. It is indeed the most satisfactory 
manner to communicate music.

The most direct communication would imply the simultaneous presence of the performer and the auditor, 
like in a concert. The atmosphere in a concert cannot indeed be compared with listening to a disc or radio 
transmission. There is in this case something more than simply the sound.

Techniques currently available make it possible to collect sounds and to store them in various forms like 
discs, cassettes and CDs. The advantage is to be able to reproduce the music at will, to distribute it and 
communicate it on a large scale. These techniques transmit the final sound result of the execution of a piece 
of music.

When you want to transmit a musical work to somebody so that he can perceive the musical message and 
appreciate its beauty, a cassette or a disc will be adequate. If you want to communicate to him the contents of 
a musical work so that he can play it himself, the sound support only is not very practical and becomes 
insufficient in most cases. If it is possible for a well trained person to listen to a melody and play it back by 
memory, this ability is not general and remains limited to relatively simple cases. It becomes very difficult to 
realize as soon as the work becomes a little complicated and when you think of a one hour piano concerto 
with orchestra, it becomes almost impossible.

Music notation offers a more practical solution to transmit music to somebody so that he can himself play it. 
Its purpose is to be able to represent the contents of a musical work in a written form. In this manner, you 
can communicate in a precise way anything that occurs during the execution of a piece of music.

This musical notation language evolved throughout history up to the present day. The modern system such 
as it currently exists is largely recognized on the international level and forms a universal language 
understood by most musicians worldwide. An immense repertoire is available in this form in musical 
bookshops. Learning this language thus opens communication with most of past and present musical works. 
It also lets you write your music so that others can play it. This music course will guide you and help you 
discover the main points of this musical notation language.

The word score defines one or more pages on which music is written.

The staff

Conventionally, music is written on a support made up of 5 horizontal lines. It is the staff. The lines are 

traced at equal distances one from the other. The exact distance is not fixed and can vary from one score to 
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another. It must be of a size adequate to the readability of the score. Here is an example:

The staff lines are numbered from 1 to 5 starting from the bottom line:

The space located between 2 lines is called space between lines. The four line spacing are also numbered 
upwards:

Each sound is written on the staff in the form of a note. A note is a round symbol placed either on a line or in 
a line spacing:

The note can be filled (coloured in black) or empty, as in the above example.

Each characteristic of the sound is written on the staff.

The pitch of the sound (high or low) is represented by the vertical position of the note on the staff. An high 
pitch note will be written higher on the staff than a low note:

The duration of the sounds is graphically represented by the shape of the note. Here are the main shapes 
available:

The written shape of the note is called the rhythm or the rhythmic value of the note. In the above example, 
the first rhythm represents a long duration. The next one lasts twice less than the first, and so on for the next 
ones. We will explain this further with examples. For the moment, the point is to show you how each 
characteristic of the sound is represented on the staff.

The measure

An important aspect of musical notation is the exact time sequence of notes. When will the performer play 
such and such note? When several performers play together, they must be able to start and play while staying 
synchronized one with each other. 

To this end, the staff is divided into several areas called measures. They are separated one from the other by 
a vertical bar on the full height of the staff. These vertical bars are called measures bars. Here is an example 
of a staff with 3 measures:
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In this way, the total duration of a piece of music is divided into smaller durations. A musical work thus 
consists of a specific number of measures played one after the other. Each measure can contain notes with 
rhythmic values.

The timbre of the sound depends obviously of the instrument playing the notes. Each instrument has a 
specific timbre. It is its sound colour. The name of the instrument is often written in front of the first 
measure of the staff:

When several instruments play together, a staff is allocated for each instrument. The notes played by an 
instrument are placed in the staff of this instrument. The staves are then displayed one below the other. To 
show that these staves must be played together, a vertical bar connects them all on the left of the staff, and 
also at each barline when the instruments concerned belong to the same group (e.g. several trumpets). Here 
is an example of 3 staves played together:

This example contains 3 measures. When a piece of music contains for example 250 measures, it will be 
impossible to place them one next to the other (you would need a 100 meters width score). When you write a 
letter and you come to the border of the paper, you continue writing lower, starting again from the left border 
of the paper. When the page is full, you simply continue on another page. It is exactly the same for music 
notation. Here is an example of a score which contains 7 measures played by 2 different instruments:

This example requires two remarks. First, when the staves are connected (and thus played at the same time), 
the staves barlines are placed at the same horizontal distance. Those barlines are sometimes connected 
together:
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The second remark is that the width of measures can vary. It depends on the contents of each measure. The 
width of the measure is adapted so that the contents are laid out in a readable way.

The last characteristic of the sound is the amplitude or its loudness. By hitting the keys softly or strongly, a 
pianist produces notes of various amplitudes. This aspect of playing is showed on the score by using 
symbols placed above or below the staff. Here are 3 examples:

The first symbol (P) shows that the notes must be played gently from there on. The second symbol (>) 
represents an accent, which means that the note must be played more loudly, but only that one. The third (F) 
indicates that it is necessary to play loudly from there on. We will further reconsider the exact significance 
of symbols than can be found in a score.

Summary

The basic of musical notation can be summarized like this:

The notes are placed on the staff. Their graphic shape and their position indicate the duration and the pitch of 
the sound. When several instruments play together, several staves are displayed one below the other and are 
connected by a vertical line on the left side. A musical work is made up of a succession of measures played 
one after the other. These measures are separated by vertical barlines in the staves. The notes played by an 
instrument are placed on the staff of this instrument. Various symbols can be added in the score to indicate 
how the notes must be played.

Handling documents and windows (1)
• What is a document? 
• The document manager 
• Opening and creation of a document 
• Opening several documents at the same time 

What is a document?

We will learn how to visualize and handle a musical document. This is the basis of every other manipulation 
that you will do with Pizzicato. It is thus essential to master these concepts very well.

A document is a set of musical information gathered under the same name.

Example: you want to write an arrangement for a jazz group. All measures, all notes that you write, the way 
you lay out the pages of the score, the tempo, the various instruments playing, the force with which each 
instrument plays… constitute a set of information related to this arrangement. They form a set of 
information. To easily find this arrangement, you will give it a name, for example "Jazz-1". You thus have a 
document called "Jazz-1" which contains all information relating to this arrangement.

In computer terminology, a document is a type of file, created or handled by the user.

If it is not already done, start Pizzicato. A template document is automatically open. It is like a sheet of 
paper, ready to receive your music (please note that the template depends on the Pizzicato version you have, 
so it may be different than this one):
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This window is the score view. It enables you to visualize or modify the contents of the score.

A scroll bar is visible on the right of the screen. It lets you reach the bottom of this page, whose content is 
currently not fully visible. If your screen is not large enough to visualize the width of this score, you will 
find in the lower right part an horizontal scroll bar allowing you to reach the right part of this page. When a 
score has several pages, a scroll bar is activated in the bottom left part of the screen and allows you to go 
from one page to the other.

We will see other types of windows (called views) allowing to work other aspects of a score, like the 
selection of instruments, the introduction of lyrics…

The document manager

In the left part of the main window, you can see the document manager:

This part of the window can be displayed or hidden, by using the small "D" checkbox that is visible in the 
tool bar of the window. It means "Document manager". Click on that checkbox. You can now only see the 
score. Click again on it and the document manager is shown again. By hidding the document manager, you 
can have more screen space to see the score you are working on.

The document manager is an important part of Pizzicato. With it, you can manage and organize your musical 
documents, without the need to use the standard Windows or Mac open and save dialogs.

The blue buttons shown on top of it are the various configurations. According to the Pizzicato version you 
have, there may be more than two configurations, but these two configurations are common to all versions.

Configuration "1" is the default document folder, named My scores. It contains all the documents you create.

When you start Pizzicato, a new document is created and is automatically named with the date and time. If 
you do not modify this document and exit Pizzicato, this document will be automatically deleted by 
Pizzicato, but if you modify the score, it will be saved and kept in the My scores folder.
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A Pizzicato document is represented by a green icon. The document contains by default one score, named 
Score 1.

You can rename the document as well as the score, by clicking on the icon with the right mouse button and 
selecting the menu entitled "Change name..." which brings a small dialog to fill in the new name you want to 
give it.

• Click now on the blue button of configuration "2". It contains 3 folders: 

• By clicking on a "+" icon, you can display what is in the folder. For instance, click on the "+" in front 
of the Examples folder. You see the list of all the examples that are used throughout the Pizzicato 
lessons: 

• To open an example, click on the "+" in front of it and it will show one or more score icon. Double 
click on that score icon name and the score will appear in the main part of the window. 

• When you right-click on a folder, for instance the Examples folder, you can ask Pizzicato to open all 
the documents of that folder and show their score icons, by selecting the menu entitled Open 
documents and folders: 

• If you now drag the mouse over the score icons (just drag, not click), you will see that Pizzicato 
displays the content of that score in a new, temporary window. You can browse many score just like 
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that and see what is in it. Moreover, if you click it and keep the mouse inside the icon, you can hear 
the score play. 

You can learn much more about this document manager, in the lesson dedicated to it. For instance, you can 
add other folders and organize them on your hard disk. See the lesson entitled The document manager.

You can of course still use the open dialogs of Windows and Mac. They are available in the File menu, 
Open... item.

• If you want to delete a Pizzicato document, right click on its green icon and select the Delete menu 
item. Pizzicato will ask to confirm and delete the file. 

Opening and creation of a document

To open a document so as to play it, print it and modify it, just double-click on the name of its score icon in 
the document. The score appears in the main part of the window. For instance, open the example 42. The 
score appears:

To listen to this score, there is a very practical shortcut. Hit the space bar of the computer keyboard. If your 
musical configuration or MIDI setup is correctly installed (see the lesson covering this subject), you will 
hear the sound of these 4 measures. While playing, Pizzicato shows you the current measure with a small 
triangle moving through the measures during the play. The notes are coloured in red when they are played. 
After 4 measures, it automatically stops. You can stop it before the end by using the space bar again.

Open now the Ex043 example in the same way:

With the space bar, listen to this score. Then open the Ex044 example:
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This arrangement of 4 measures, in a more modern style than the melody of the first two examples, is written 
for a synthesizer or a sound card compatible with the General Midi (GM) standard. It will not necessarily 
play correctly on other types of devices. Listen to it with the keyboard shortcut.

At any moment, you can create a new document to start writting a score. Select the New item in the File 
menu. An empty document appears, according to the Pizzicato version you have.

All Pizzicato versions also offer you a series of templates. They are available in the File menu, Open a 
template... item. You can explore them, just by selecting these menus. A new document is created, based on 
the template you selected. This is useful to start a new document with a prepared page layout.

• In all versions of Pizzicato, except the Light version, you will find the three following graphic objects 
in the left upper part of the score view: 

• They influence the zoom of the displayed score. By clicking on the + button you increase the size 
and on the - button you decrease it. The popup menu displays the zoom value (100 % by default). By 
clicking on this menu, the list of the possible values appears and lets you directly select one of them. 
In the following lessons, you can increase or decrease the size of your score, according to the work 
you do. If you adjust the page layout, it can be interesting to decrease the zoom in order to see the 
whole page as it will be printed. On the other hand, when adjusting the content of a measure or when 
entering notes, you can increase the zoom to improve the precision of your work. Note that this zoom 
value only influences the screen. The printed score is not affected by the screen zoom. 

Opening several documents at the same time

The more advanced versions of Pizzicato let you open and view more than one score at a time.

When you want to open another score and keep the curent score visible, you can double-click a score icon in 
the document manager, while holding down the CTRL key of the keyboard. Pizzicato opens the score in 
another window and rearrange the two score windows.

In these versions, when you create a new document (with the New... menu item or the Open template... menu 
item), Pizzicato automatically creates a new window. You can of course close the documents you do not 
want on the screen anymore.

Musical notation examples
• Note pitch - example 
• What is a clef? 
• Note duration - example 
• Instrument timbre - example 
• Note amplitude - example 

Note pitch - example

We will examine and listen to some examples of the notation of sound characteristics, so as to illustrate the 
theory learned in a previous lesson.

With Pizzicato, open the Ex001 file, located in the Examples folder. As explained in the previous lesson, to 
open an example, click on the blue "2" button located in the top left part of the main Pizzicato window. Open 
the Examples folder and go to the example you want to open. Open it to make the score icon appear and 
double-click that icon. The content of the score appears in the main part of the window.

The following score appears:
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It shows you a staff with 3 measures. The playing instrument is the piano. The sign located at the beginning 
of the staff is called a clef. We will explain this in the following paragraph. You can observe 9 notes 
distributed in the 3 measures. From left to right, these notes are placed more and more high on the staff, 
which corresponds to increasingly high pitch notes. Listen to the sound result by pressing the space bar. One 
after the other, the 9 notes are played by the computer. A small black triangle follows the play and the notes 
are coloured in red one after the other.

What is a clef?

The possible pitch range of notes largely exceeds the 9 notes played in the above example. In other words, it 
is possible to play notes much lower than the note placed on the first line of the staff or much higher than the 
note placed on the fifth line. As we will see further, it is possible to place additional lines on which to place 
higher or lower notes. Here are examples:

This technique is nevertheless limited to 3 or 4 additional lines below or above the staff, because using more 
lines makes the score difficult to read. By placing a clef at the beginning of the staff, the pitch of all notes 
can be changed. Let us see this in more detail.

We had seen that the sound consists of air vibrations. The higher the sound, the more vibrations there is and 
the higher the note is placed on the staff. 

To locate a note on the staff, it is not enough to say that it is lower or higher than another. It is necessary to 
establish a precise reference on which everyone can agree. This reference is established by placing a clef at 
the beginning of the staff. There are several reference systems for notes and each one is marked by a 
different clef.

The most current clef is the treble clef (or G clef). With this clef, a note placed in the second line spacing 
corresponds to a sound making the air vibrate 440 times a second:

The second most current clef is the bass clef (or F clef). This key is used for notes lower than the treble clef, 
i.e. notes which would require too many additional lines with a treble clef. Here are for example three notes 
with a bass clef:

You can notice that the same sound (440 vibrations a second) is represented at different places according to 
the clef. For this reason, a staff must always start by indicating the clef in which the notes will have to be 
located. The key is then valid for all following notes and does not have to be drawn again in each measure. It 
is also possible to change the clef in the middle of a staff. One draws the new clef starting from the place 
where it is valid.
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Open the Ex002 file, also located in the Examples folder:

This example starts with a bass clef and changes to the treble clef starting from the third measure. Five notes 
are placed at the same position for both clefs. Listen to the sound result with the space bar. The notes placed 
after the bass clef are much lower than those placed after the treble clef.

Further in the course, we will come back in more detail on the pitch of notes and the relation with the clefs. 
The purpose here is simply to show you how the use of clefs makes it possible to move the pitch of the notes 
lower or higher on the staff.

Note duration - example

Open the Ex003 file: 

This example illustrates the duration of the notes. From left to right, the durations of the notes decrease and 
one note follows the other more and more rapidly. Listen to the sound result.

Instrument timbre - example

Open the Ex004 file: 

This score has 6 measures and 6 staves. The name of the instruments is indicated in front of each staff. The 
instruments play one after the other a series of 5 notes. On measure 1, the piano is playing. During this time, 
the 5 other instruments do not play, because there is no note written on their staves. After that, on measure 2, 
the flute plays the same sequence while the others do not play, and so on. Listen to the sound result while 
following on the score. It is the same melody repeated 6 times. The perceived difference comes from the 
timbre of the sound, which is different for each instrument. You can hear the difference only if you have a 
sound card or a General MIDI (GM) compatible synthesizer or better.

Note amplitude - example

Open the Ex005 file:
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It shows examples of symbols that influence the amplitude or loudness of a sound. The first measure must be 
played gently. In the next measure, 2 notes are accentuated and thus played more loudly than the others. 
Finally the notes of the third measure must be played loudly. Listen to the result. Once again, you will only 
hear the difference with a GM musical material. 

Handling documents and windows (2)
• Handling musical documents 
• The various Pizzicato windows 
• The score view and the global view 
• The instruments view 
• The sequencer view 
• The piano roll view 
• The graphic view 
• The musical effects view 
• Association of a comment 
• The scrolling score view 
• The lyrics window 
• The chord progression window 
• The main view and the conductor view 
• The windows management modes 

Handling musical documents

We continue to explore the handling of documents and the various Pizzicato windows.

When you create a new Pizzicato document, it is placed by default into the My scores folder. Its name is 
made out of the date and time of the creation of the score.

When you close the document or exit Pizzicato, the files from that folder are automatically saved if you have 
modified them. Otherwise, they are deleted.

You can manage your documents inside this folder. Here are the main operations you can use to arrange 
your documents.

• If you want to give a custom name to a document (other than the date and time), right click on the 
document icon and select Change name... A dialog helps you to rename the document. 

• If you want to delete a document, right click on it and select Delete... You must then confirm. Note 
that you can not delete the document that is displayed on the right part of the screen. To delete that 
document, first select and double-click another document so that the document you want to delete is 
not displayed anymore. 

• You can create one or more sub-folders inside My scores. Right click on the folder and select New 
folder... A dialog asks you the name of the folder you want to create. By creating folders, you can 
sort your scores according to your own choices. You can delete a folder in the same way than for a 
document. 

• You can drag and drop a document or a folder into another folder. 
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• You can create a one measure document by right clicking on a folder and by selecting New 
document... A dialog asks you the name you want to give it. 

Except for Pizzicato Light, all other versions of Pizzicato will automatically save the document every 10 
minutes and make two backup copies of the document in case something goes wrong. You can always find 
the backup files in the Backups folder of the main Pizzicato folder (for Window, you will find it in My 
Documents and for Mac, in the Application folder). You can modify this default behaviour. See the lesson on 
Automatic saving and backup.

The various Pizzicato windows

Since the first release of Pizzicato, many different windows have been developed to help you display and/or 
modify music documents. They are all available from the Pizzicato Windows menu, but according to the 
version you have, some of them are not available.

In the most recent versions of Pizzicato, the purpose is to gather the most useful features of Pizzicato into a 
limited number of windows, so that you do not need to open and handle many windows for various aspects 
of your work. Accordingly, the most important windows are the score view, the global view and the 
conductor view. The score view is present in all versions of Pizzicato, but the other two are only available 
in the more advanced versions of Pizzicato.

Here is a short description of each windows, in relationship to the Pizzicato version you have. Please note 
that most of these windows can also be open if you right click on the icon of a score and select the window 
you want to open for that score.

The score view and the global view

The score view is the default view when you open a document. It displays the content of the score, in music 
notation.

There are three modes in which you can view the score in the score view. According to the version you have, 
you can select the mode in the menu appearing in the upper tool bar of that window. The three modes are 
Page, Linear and Global.
The Page mode displays the score as it will be printed on paper. It is very useful when you work on the page 
layout of the score. You will learn a lot about the page mode in the lesson covering the page layout.

The Linear mode displays the score with all the measures one after the other on a horinzontal line, as a large 
system of staves that contains all the measures. You can scroll from left to right to select which part of the 
measures are displayed. This mode is useful when you enter the music or compose a music. At this step, you 
often do not need to worry about how it will be laid out for printing.

The Global mode is similar to the linear view, but several other lanes may be displayed, to help you in many 
aspects of music composition, arranging and sound rendering. This mode is the subject of a specific lesson 
about the global view and is only available in the more advanced versions of Pizzicato.

The instruments view

Open the Ex044 example. To get the instruments view, select the Instruments item of the Windows menu :
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According to your MIDI configuration, the contents of some boxes may be slightly different but it does not 
matter now.

Each line represents the characteristics of a staff. It is here that you determine the name of the staff, the 
instruments used, as well as various other parameters which affect the way the piece will be played.

You can reach the other parameters by clicking on the  icon which reveals a popup menu with a list of 
the available configurations. Select for example the Volume+ effects item from this menu. The view offers 
you a mixing table determining volume, balance and two effects (here reverberation and chorus) for each 
instrument :

This view is a little different from the others, because it does not have a zoom box and its size is fixed. It can 
be moved but not resized. Close this view with the close box.

The sequencer view

The word sequencer usually means a program or a device used to record sequences of notes (played directly 
on a musical keyboard), to work on them in various forms and to play them back. Most sequencers you find 
on the market let you see the musical recorded measures as an array of small blocks.

Pizzicato has a view which lets you display the measures in the same way, hence the name given to this 
view, the sequencer view.

Open the Ex042.piz document in the Examples folder. In the Windows menu, select the Sequencer item. The 
sequencer view appears:

This view behaves exactly like the score view: you can move it, close it, resize it or change the zoom level.

Its contents displays 4 measures in the shape of 4 small blocks in which notes are represented by horizontal 
lines. The length of the lines represents the duration of the note and the vertical position of the line inside the 
block represents the pitch (the high pitch notes higher than the low pitch notes). The melody is thus 
presented in a visual way in the shape of a curve which follows the pitch of the note.

The higher part has four buttons, respectively named H- H+ V- and V+. These buttons let you increase or 
decrease both horizontal and vertical sizes of the measures. For example, the H+ button increases the 
horizontal size of the measures. By clicking twice on V+ and once on H+, the sequencer becomes:
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By clicking on the V- and H- buttons, the size decreases. These zoom functions thus let you adapt the 
sequencer view to the work you do. It is sometimes useful to look closer in some measures to follow a 
melody. On the other hand, to see the overall picture of an orchestra score, you can decrease the size of the 
blocks to the minimum in order to have the maximum number of measures visible on the screen.

Open the sequencer view of the Ex043 example. The 4 staves of 4 measures each are represented in the 
following way:

You can listen to the score with the space bar. A small cursor shows the current measure in progress, as for 
the score view. You may also use the buttons of the recorder, displayed to the left of the zoom buttons. 
Those buttons appear in almost each view and let you control the playing of the score:

• The blue square button stops playing 
• The yellow triangle button starts playing 
• The two little blue squares button pause the playing (the playing notes stay in suspension; by pushing 

this button again, the playing resumes from the exact moment of the pause) 
• The red circle button controls the recording. 

Just to the right, a text box displays the number of the playing measure. The "..." button give you access to 
various play parameters. We will explain them later.

The piano roll view

To open this view, select the piano roll item of the Windows menu. The following window appears:

Increase this window with the zoom box  (on Mac: "+" ). You will be able to observe all the notes of 

the 4 staves, placed in the same view:
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You will notice that each staff is represented by a different colour for the notes. If your screen is smaller, it 
can happen that some are not visible. The pitches of the notes are measured with a musical keyboard on the 
left and it can be used to locate them. The digits from 1 to 4 located in the higher part of the window are the 
measure numbers.

In the higher part of the window you can see the same H- H+ V- and V+ buttons which have the same 
function as in the sequencer view. They let you resize the display of measures and notes. Try the 4 buttons 
one after the other so you can see the effect they produce on the display. Note that you can use the same 
button several times. If you want to increase the thickness of the note lines, you can for example click three 
times on V+.

This window is only used to view many instruments together on the same piano roll. You can not modify the 
music with this window. Pizzicato has another similar window, the graphic window, which is a full piano 
roll editor where you can enter and modify the notes directly.

The graphic view

The graphic view helps you to enter music in the form of small graphic bars that you can add, move or 
delete. It looks like this :

You can open it from the Graphic editor... of the Windows menu. For more information, see the lesson on 
the graphic editor.

The musical effects view

You can open it from the Musical effects... item of the Windows menu. It is used to add musical effects to the 
content of the measures, for each staff. It looks like this:
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You can learn more about it in the lesson about the musical effects view.

Association of a comment

You can associate a comment to each musical score. Select the Comments item in the Windows menu. The 
following dialog box appears:

The text box lets you introduce personal notes, remarks or comments about the musical score. You can, for 
example, use it to specify the work that still needs to be done with the score or the explanations on its 
contents, etc.

These notes will be saved with the document and you can thus read or modify them again later. Close this 
dialog box by clicking OK.

The scrolling score view

Open the Ex045.piz document.

• Select the Scrolling score item in the Windows menu. The following view appears: 

• The purpose of this scrolling score view is to play or follow a score while it scrolls. At any moment, 
measures to be played are displayed in advance. When a view area has been played, it is 
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automatically replaced by the next measures of the score. When you arrive at the bottom, you just 
need to start reading again at the beginning of the screen, because the score was updated. Moreover, 
while reading you are never surprised by the score entirely disappearing before being redrawn. You 
keep your reference points. This method of score reading and follow-up can be used to learn how to 
read a score. A cursor follows the current measure. Let us see that in practice. Hit the space bar of the 
keyboard to listen to the score or use the recorder start button (yellow triangle). 

• Close this view. 

The lyrics window

This window is used as a fast method to enter the lyrics under the notes of a song or choir part. See the 
lesson on the lyrics for more information.

The chord progression window

This window is used to enter or modify a chord progression efficiently. See the lesson on the chord 
progression window.

The main view and the conductor view

The main view has been developed at the beginning of Pizzicato. You will still find some references of it in 
the course, but it has been presently replaced by the advantages of the conductor view and the new document 
manager. See for instance the lesson about working with the sequencer and the main view.

The conductor view is a musical desktop on which you can organize your scores and use the numerous tools 
to help the process of music composition. You will find a full description of it in the lesson about the 
conductor view and the following lessons.

The windows management modes

Pizzicato has three ways of handling the score and conductor views on the screen. The default mode is 
oriented around the score view.

You can select the windows management mode in the Windows menu, under the Windows management... 
item.

Here is the description of the three modes.

• In the default mode (based on the score view), Pizzicato will resize the score windows so as to fill the 
whole Pizzicato screen with it. 

 When you double click on a score icon in the document manager, that score will be 
displayed in the same window, thereby closing the previously displayed score. 

 If you double click on a score icon while holding down the CTRL key, Pizzicato will 
open a new score window and will resize all score windows so that you can see them all. 

 If you double click on a green document icon (except for Pizzicato Notation, that does 
not have that window), Pizzicato will open the conductor view for that document, in the 
lower 1/3 of the screen. Double-clicking a score in that conductor view will display it in 
the upper score view, but if you also hold down the CTRL key, it will open a new score 
window and resize all the score and conductor windows. 

• The mode based on the conductor view is more similar to the behaviour of version 3.4 and before, 
regarding the way the conductor view is handled. In this mode, the conductor view will always stay 
in the background and you can double click one or more score in it, that will be displayed above the 
conductor view. It may be more practical to use this mode when composing inside the conductor 
window and editing and moving many different scores. 
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• The last mode is Free, which means that Pizzicato will not automatically rearrange the score and 
conductor views. You are then responsible for managing the size and position of the score and 
conductor views. 

All other windows are not affected by this window management mode, but they may be covered by the other 
windows.

Measures and staves (1)
• The measures and staves tool 
• Adding and deleting measures and staves 
• The linear mode 
• Creating a score in linear mode 

The measures and staves tool

In this lesson, we will learn how to use the measures and staves tool. It lets you add or delete measures and 
staves in the score.

Start Pizzicato. In the Tools menu, select the Main palette item. A tool window appears:

It contains a whole series of icons representing working tools. According to your version of Pizzicato, some 
of these tools may be missing. To select one of them, click on it and the tool becomes selected (its contrast is 
reversed). Select the  tool by clicking on it. It is the measures and staves tool.

When starting, Pizzicato automatically opens a default score, according to the version you have and to the 
selection you can do from the template manager.

According to the work you want to do, this starting template is not necessarily appropriate. If you want to 
work with a small orchestra, you need to add other staves. According to the length of your score, you will 
need to add measures. The measures and staves tool lets you to do that. Let us see how.

Important remark:
In the following examples, we take the case of an existing piano score. According to your Pizzicato version, 
the starting template may be different. Simply use the template you see when you start Pizzicato. Most of 
them have at least one page, with one staff or more. Just adapt the example to what you see as the principles 
are the same. Notice thought, that Pizzicato Soloist only allows one staff, so in that case you will not be able 
to add more staves.

Pizzicato Composition does not handle Page layout, so you will only be able to work in linear view. The 
principles are the same, just adapt the example to the linear view.

Adding and deleting measures and staves

We will start by removing 16 measures of the score. Double-click the first measure of the second system, as 
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shown by the red circle:

The measures and staves dialog box appears:

For now, click Cancel. You can also reach this dialog box without using the tools palette, thanks to a 
shortcut key. Place the mouse cursor at the same position (red circle above), without clicking. Then type the 
lower case letter "m" on the keyboard. The dialog box appears. By using this shortcut, you do not need to 
open the tools palette to reach this dialog box: it is faster and you have more space on the screen.

The left part displays the type of operation for the measures. Check the Delete box. To the left, fill in "16" in 
the texte area. It is the number of measures to delete. The measure on which you clicked is contained in the 
measures that will be deleted.

Pizzicato will delete 16 measures starting with the measure you clicked on to call this dialog box.

Click OK. The score becomes:

All following measures have been removed.

We will now add a staff. Call the previous dialog box on the first measure of the lower staff (by double 
clicking or with the shortcut m as above). In the left part, for the measure, check Nothing and check Add for 
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the staves (by default it will be "1" staff). The staff will be added below the clicked staff, so in this case, 
below the lower staff. Click OK. The score becomes:

Remark: For Pizzicato Guitar, Drums, Choir, Keyboard, you can add one staff at a time and the text box is 
replaced by two menus that you can use to select the family and instrument you want to add.

Pizzicato adds a staff, by default named "3", with a treble clef and the same time signature than the two other 
staves (C is a conventional abbreviation of a 4/4 time signature).

Now let us add 8 measures to the score. Call the measures and staves dialog box on the fourth measure of the 
staff (staff 1, 2 or 3, it does not matter). Fill in the measures text box with 8. Click OK and the score 
becomes:

Pizzicato added 8 measures. When measures are added, the program automatically creates systems of staves 
to contain all the measures. Each staff is increased by the number of added measures. Here, the page was 
large enough to display the resulting score. You can use the "-" zoom button of the score view in order to see 
the full page, as above (zoom 67 % by clicking twice on the "-" button, according to the size of your screen):
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Notice that there are shortcuts for the zoom, valid in most windows. They are the CTRL key plus the arrow 
keys of the keyboard. The right and up arrows increase the zoom and the left and down arrows decrease the 
zoom.

Let us add 24 measures to the score. Notice that you are not forced to add them at the end. Here, as all 
measures are empty, you can insert them anywhere. When the measures are filled with notes, you may insert  
measures before or add measure after any existing measure. Call the measures and staves dialog box on the 
first measure of the score and fill in the measures text box with 24. Click OK. Apparently nothing changed, 
except the left lower side of the score view, which now displays (for instance):

Remark: this is not the case for the Composition Light and Composition Pro versions, which do not have the 
page mode.

P-1/3 means that the page currently displayed is page 1 and that there is a total of 3 pages. As the page was 
already filled with the first 12 measures, Pizzicato has added 24 measures by creating new pages. The above 
horizontal scroll bar lets you scroll through the pages. Click on its right-hand button and page 2 is displayed, 
showing now P-2/3.

As a last illustration, we will delete the third staff. Go back to page 1 and call the measures and staves dialog 
box on the third staff of the first system. Check Nothing for the measures and select Delete for the staves. 
Click OK and the score becomes:
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Notice that the number of systems per page is automatically adjusted by Pizzicato according to the number 
of systems which can hold on one page. The page indicator displays P-1/2 now. The resulting score has only 
two pages now, considering the deleted staff.

It is thus with the help of the measures and staves tool that you can adjust the structure of your score. You 
will use it very often.

A contextual menu helps you to easily add or remove one measure or staff. You can reach it with a right 
click on a measure. This menu gives you the Measures and staves... item that gives access to the following 
items:

• Add one measure after 
• Insert one measure before 
• Remove this measure 
• Add one staff below 
• Insert one staff above 
• Remove this staff 

The operation is executed automatically, based on the measure on which you clicked to reach that menu.

Call the above dialog again. You may observe two areas in the lower part of the dialog. For the versions of 
Pizzicato that contain the page mode, they let you define how Pizzicato will modify the page layout 
following the operation on measures and staves.

For the measures, Pizzicato may simply insert the added measures or shift the deleted measures, up to the 
end of the last page. Or it may limit the impact on the pages and leave the following pages untouched while 
inserting new pages if necessary.

Similarly for the staves, Pizzicato may shift the systems (which sizes increase if staves are added), may add 
the staves only to the current system, or may leave all the system untouched so that you can manage the 
systems on the page.

The linear mode

In the upper part of the score view, you can observe the following popup menu:

This menu has three choices, Linear, Page and Global. The global mode will be studied in another lesson 
(see the lesson entitled The global view), at least for the Pizzicato versions displaying the global view. Until 
now, we only used the page layout view. In this mode, the score is viewed as it will be printed. Measures go 
from left to right and when you get to the border of the page, you go to the next system, as for the 
handwritten writing. When the page is complete, you go to the next page.

The linear mode offers another way of viewing and editing a score, without being concerned with the way 
the score will be printed on paper. Imagine a paper strip of an infinite width, on which you can write from 
left to right without stopping or having to go back to the beginning of the next line. Imagine that this infinite 
paper strip is on a roller that you can scroll horizontally in order to view and edit any passage you want. It is 
the linear mode. Click on this menu and select the Linear item. The score view becomes:

According to the size of your screen, Pizzicato displays some of the measures which are on the infinite paper 
strip. The left lower display box which indicated the page now displays M-1/36 (1). It means that there are 
36 measures in the full score and that the first visible measure on the screen is measure 1. The 1 in brackets 
indicates the absolute measure number (if for example you start numbering measures with 15, see the lesson 
on the measures parameters). By default, this number is the same as the first number.
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This mode is sometimes more practical in the creation of a score, especially for the orchestra scores or the 
scores that contain measures with very different widths. The linear mode allows you to encode the contents 
of the measures without being worried on how much measures will hold on a page. When the score is 
encoded, you switch into the page layout view (see the lesson on page layout) and Pizzicato displays the 
measures in a balanced way according to the contents of each measure.

The large horizontal scroll bar located in the lower part of the score lets you move along all measures. This 
can be done in several ways:

• If you click on the arrow located at the extreme right-hand side of the scroll bar, Pizzicato displays 
M-2/36(2), and redraws the score starting from measure 2. In a similar way, by clicking on the arrow 
located at the extreme left, you move one measure towards the left.

• To move one measure at a time, you can also use the left and right arrow keys on the computer 
keyboard. 

• To reach a measure directly, for example the seventh, click on the scroll bar cursor, and while 
holding down the mouse button, gradually drag it to the right. Pizzicato progressively increases the 
measure number. When it indicates M-7/36(7), release the mouse button. The score is displayed 
starting from measure 7. 

• By clicking in the area located between the left arrow and the cursor of the scroll bar, you move to 
the left by about the width of the window. If 3 measures are visible on your screen, you should move 
3 measures to the left. The shortcut key is the left arrow key while holding down the SHIFT key. 

• In the same way, by clicking in the area located between the right-hand side arrow and the cursor of 
the scroll bar, you move to the right by about the width of the window. The shortcut key is the right 
arrow key while holding down the SHIFT key. 

You can go to a specific measure by clicking in the area that displays the current measure number (for 
instance M-2/36, in the bottom left corner). A dialog box will ask you the measure number you want to 
reach. This is also applicable in page mode or global mode.

Creating a score in linear mode

We will create score of 8 staves of 10 measures on the basis of a linear template of only one measure, with 
no page layout. You can use this method each time you want to create a personal score, not located in the 
templates of Pizzicato, or when you want to work in linear mode for one of the reasons explained above.

Go in the File menu and select Open template..., Templates, One linear measure. If your Pizzicato version 
does not have that option, go in the Open… item of the File menu, open the score named One linear  
measure.piz located in the Templates folder of the Templates folder itself inside the DataEN folder (but in 
that case, save your score by giving it a new name, so that you do not overwrite the original template). It 
contains one staff with only one measure in linear mode, without a prepared page layout. You can use this 
model to start a new score in linear mode. The score displays:

Place the mouse cursor on this measure and type "m" with the keyboard. You get the measures and staves 
dialog box.

We want to create a score of 10 measures and 8 staves. As there is already one staff of one measure, add "9" 
in the box of measures to add. In the same way, select the Add operation for the staves and type "7" for the 
number of staves to add. Click OK. The dialog box disappears and Pizzicato redraws the score with the 
expected measures and staves. According to the size of your screen, you will be able to see more or less 
measures and staves than below. The screen looks like:
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Notice the indication M-1/10 in the bottom left corner. It tells you that the first visible measure on the screen 
is measure 1 and that the score has 10 measures.

In a similar way as explained for the measures, the vertical scroll bar located to the right of the score lets you 
reach all the staves:

• The extreme arrows move the score slightly up or down. The shortcuts are the up and down arrow 
keys of the computer keyboard. 

• You can drag the scroll bar cursor to reach any staff. 

• Clicking in the intermediate areas between the cursor of the scroll bar and the extreme arrows moves 
of about the height of the window. The shortcuts are the up and down arrow keys of the keyboard, 
together with the SHIFT key. The previous and next page keys on the keyboard are also valid to 
move by full vertical heights. 

Exercise
In the last example score, move successively to the following positions:

• Measure 5, staff 1, with the help of the mouse. 
• Measure 3, staff 7, with the help of the mouse. 
• Measure 10, staff 5, with the help of the keyboard. 
• Measure 1 staff 1, with the help of the keyboard. 

Then close this document and start each time from the template One linear measure to do the following:

• Create a new document with 20 measures and 3 staves 
• Create a new document with 5 measures and 2 staves 
• Add 3 measures at the end of it 
• Open the score example Ex046.piz and insert 3 measures between measure 3 and measure 4. Be 

careful not to click on a note to call the staves and measures dialog box. Then insert a staff between 
the clarinet and the oboe. 

Measures and staves (2)
• How to move a staff? 
• How to modify the width of a measure? 
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How to move a staff?

In this lesson, we will learn how to modify the layout of measures and staves.

In order to work on a practical example, open the Ex046 example document. It is displayed as follows:

Remark: Pizzicato Soloist only enables one staff. The above example will be open in a demonstration mode 
to follow the example. You may come back to the Soloist mode in the Options menu, Working mode item.

Open the main palette and select the measures tool .

If you wish to have more space between both staves (to add lyrics for example), place the mouse cursor in 
the middle of a measure in the lower staff, click while keeping the mouse button down and go gradually 
downwards. A rectangle follows your movement. By releasing the mouse button, the lower staff is redrawn 
lower (the upper staff has not moved) :

Let us see now what happens if there is more than 2 staves. Double-click on measure 1 on the lower staff. 
Fill in the dialog box so as to add 0 measure and 2 staves and click OK. The result is now:

Now move the second staff upwards, so as to reduce the space which separates it from the first. Again, a 
rectangle follows your movement, but this time the rectangle includes the three lower staves. By releasing 
the mouse, you get the following result:
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The rule is that when you move a staff, you move all the lower staves at the same time .

Exercise yourself to handle staves:

• Add 2 staves below the clarinet. 
• Move all the staves so as to double the space between each staff. If your screen does not allow to see 

them all together, use the vertical scroll bar to move or zoom out to see all staves. 
• Again move all the staves, this time by moving them close together. 
• By calling the measures and staves dialog box on the second measure of the second staff, delete 3 

measures and 5 staves. 
• Come back in 100 % zoom value. 

How to modify the width of a measure?

By following the above example, the score is now displayed as follows:

Imagine that you wish to widen this measure. There is a very easy way to do it. Place the mouse cursor in the 
area located just before the end of the measure:

and click while keeping the mouse button down. Then drag the mouse to the right and a rectangle follows 
your movement. By releasing the mouse button, the measure is redrawn with the expected size:

To shorten a measure, do the same operation by dragging to the left. Shorten the measure to obtain:

Notice that Pizzicato has automatically moved the notes at equal distances in the measure. You can avoid 
that by executing the same operation while holding the Ctrl key down. You get for example:
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When you work in linear mode (this is also valid in global mode), there are three ways to adjust the width of 
several measures.

• Before releasing the mouse button, when you drag the right part of a measure to modify its width, 
hold down the CTRL key. When you release the mouse, all measures are resized with the same 
width. 

• Similarly, by using both CTRL and SHIFT, the current measure and the following measures are 
resized with the same width. The measures before are not modified. 

• When you use only the SHIFT key, all measures are resized in the same proportion as the current 
measure. This may be used to resize all the measures of a score in a similar way. 

Exercises
Close Pizzicato and restart it. Open the Ex046 example again. Decrease the width of measure 4 by half. 
Notice that the measure located below it also resizes. For an orchestra score with for example 16 
superimposed staves, all 16 staves are resized together.

Open the Ex047 example. By using what you learned here, correct the layout of measures and staves to get:

Notes and rests
• The name and position of notes 
• Rhythmic values of notes 
• Rests 
• Summary 

The name and position of notes

Exactly as the alphabet has 26 letters from A to Z, the musical alphabet includes 7 letters assigned to the 
notes: 

C, D, E, F, G, A, B
In this lesson and the next ones, we will work on the basis of the treble clef. Here is the position of these 7 
notes when a treble clef is placed at the beginning of the staff:
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The name of the treble clef (also called G clef) comes from the following fact : the loop in the middle of this 
clef is centered around the second line of the staff, which is the line on which the G note is located.

What about the names of the lower and higher notes? The same names are used again. Higher than B, there 
is again C, D,... Lower than C, the names are B, A,... Here is the result for the higher notes:

When going even higher, the same names are used again. On the other hand, here is the result for the lower 
notes:

Why do we give identical names to notes located at different pitches? The reason will be found in sound 
vibration theory. We had seen that each note pitch corresponds to a specific number of air vibrations per 
second.

When you play a note producing for example 440 vibrations per second and you add to it another note 
vibrating exactly two times faster (producing then 880 vibrations per second), your ear will notice a strong 
similarity between the two notes. They are very similar while having different pitches. They are both in 
harmony. It is an observation that you can make by listening.

With Pizzicato, open the Ex006 file, located in the Examples folder. The score contains 2 staves of 4 
measures:

During the first 2 measures, one of the flutes plays a little melody. In the last 2 measures, it plays it again but 
the upper flute plays at the same time the same melody with vibrations exactly the double of the other. 
Listen to the result. You will be able to hear that in the last 2 measures the melody keeps its original colour, 
while being reinforced by the other flute.

The same phenomenon is present when you play a note that vibrates two times slower (here with 220 
vibrations per second). This ratio from double to simple plays a significant role in music.

When two notes vibrate with a speed ratio of 2, they have the same name. In the preceding example, the 
melody always starts with the note A as well for flute 1 and flute 2. Here are for example 3 notes named A 
and the speed of their vibrations:
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The same principle is valid for the 6 other notes, the speeds being different from those indicated here but 
always in a ratio of 2.

Thus let us remember the basic rule: starting from C upwards, the following notes are named D, E, F, G, A 
and B, corresponding to increasingly fast vibrations. The next note corresponds to the double speed of the 
first C and is then called C again. The following note corresponds to the double speed of first D and is also 
called D, and so on. When going down below C, the speed of the next note is half of B and the note is called 
B again. Then it is A, and so on.

Rhythmic values of notes

To show how long a note must be played, a system of rhythmic values is used, each one represented with a 
particular drawing of the note.

Let us start with the quarter note. We will use it as the basic duration to define the other durations.

The quarter note is drawn by a full rounded shape, attached to a small vertical line. This line is called the 
stem of the note. Here are examples at various pitches:

By placing a series of quarter notes on a staff, it means that they must be played all with the same duration, 
but this duration is not determined, because they can be played quickly or slowly. The tempo must first be 
defined. The tempo indicates the speed at which the quarter notes will be played. The tempo will indicate for 
example the number of quarter notes played in one minute. A tempo of 60 quarter notes per minute means 
that 60 quarter notes will be played in one minute, i.e. one per second. The tempo is often displayed by the 
drawing of a quarter note equal to a figure, such as for example:

which means that 120 quarter notes are played in one minute, i.e. 2 per second. The tempo is often indicated 
at the beginning of the score and it remains valid until the end, unless otherwise specified. The tempo is 
given as an indication, because nobody will count your notes to know if you played 119 or 121 quarter notes 
in one minute.

A measure always contains a well defined quantity of rhythmic values. The content of a measure is specified 
by a special symbol at the beginning of the score (called the time signature), just after the clef on the staff. 
The most current time signature is 4/4 (four four) :

We will further see the meaning of these two figures. Let us now remember that a measure with a 4/4 time 
signature must always contain the equivalent of 4 quarter notes.

This measure is also said to contain 4 beats and each beat is equivalent to a quarter note. A beat is thus a 
subdivision of a measure, in this case four equal parts of a quarter note each. One speaks about the first, 
second, third or fourth beat of the measure to refer to the 4 subdivisions of the measure.
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The 4/4 time signature should only be displayed at the beginning of the score, on the first measure. It should 
not be placed again at each beginning of a staff, as opposed to the clef.

In the course and the rest of the manual, you will sometimes find examples where the time signature is not 
indicated. Without time signature indication, Pizzicato automatically considers that it is a 4/4 time signature. 
We will thus sometimes use this rule in the course. Know that this rule only applies in Pizzicato and that to 
be correct, a score must always indicate the time signature used.

Open the Ex007 file: 

The upper line is a staff with only one line on which a rhythm is written. It is used to show you the 4 beats of 
the measure. Each beat is marked by a quarter note. There are 4 beats per measure, because we are in 4/4.

The tempo is shown: 60 quarter notes per minute, therefore one quarter note per second. The first flute 
measure contains a small rectangle which indicates that nothing is played in this measure. We will examine 
it further. Then you find a melody of 8 quarter notes distributed in the last 2 measures. There is well 4 
quarter notes per measure, the total is correct.

Listen to the result. With a General MIDI (GM) system, you will be able to hear the upper line which marks 
the beginning of each beat with a percussion instrument. Listen to the regularity of these beats. The duration 
which separates them is each time one second (tempo of 60 quarter notes per minute).

Starting with the second measure, the flute notes are played at the same speed. The first quarter note starts on 
the first beat (together with the percussion sound) and stops just right before the second beat. Then the 
second quarter note starts on the second beat and so on up to the end. Listen several times to the example by 
reading again these paragraphs and be certain to understand exactly what happens in this example.

By having taken the quarter note as the base of a beat, we will now define the other rhythmic values based 
on it. Let us start with the longer values.

The half note is twice longer than the quarter note. Its duration is 2 beats. There can thus be 2 half notes in 
one 4/4 measure. The half note is displayed by a hollow rounded shape with a vertical line, the stem. Here is 
an example of a measure with 2 half notes:

The whole note is a rhythmic value equivalent to 4 quarter notes. It fills a full 4/4 measure all by itself. It is 
represented by a hollow rounded shape without a stem:

Open the Ex008 file: It contains 6 measures with whole notes, half notes and quarter notes:
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The upper line shows you the beginning of each beat with a percussion instrument. Listen to the sound 
result. For the half notes and whole notes, count the number of beats they last, on the basis of the percussion 
beats.

Check the contents of each measure, you will find for each a total of 4 beats. The fourth measure for 
example contains two quarter notes (2 x 1 beat) and one half note (2 beats), which add up to 4 beats.

The eighth note is a rhythmic value equivalent to half a quarter note duration. Two eighth notes are then 
played within the duration of a quarter note. It is represented by a full rounded shape, with a stem terminated 
by a hook:

As an eighth note is worth half a beat, you need 8 of them to fill a 4/4 measure (the total duration of which 
must contain 4 beats).

The sixteenth note is a rhythmic value equivalent to the quarter of a quarter note. Four sixteenth notes are 
thus played within a quarter note duration. It is represented by a full rounded shape with a stem terminated 
by a double hook:

As an eighth note is worth a quarter of a beat, you need 16 of them to fill a 4/4 measure.

Open the Ex009 file. It contains 3 measures with quarter notes, eighth notes and sixteenth notes:

The upper line separates measures into 4 beats. Check the contents of each measure of the flute. You will 
always find a total of 4 beats. Here is the calculation for the first measure: 1 quarter note (1 beat) + 2 eighth 
notes (2 x 1/2 beat = 1 beat) + 1 quarter note (1 beat) + 4 sixteenth notes (4 x 1/4 beat = 1 beat) = 4 beats. 
Make the exercise yourself for the other measures.

Notice that the upper line quarter notes are aligned with the notes of the flute starting on each beat. By 
writing several staves played together, the position of the notes played at the same time are always aligned 
vertically.

Listen several times to the sound result while visually following the notes played. Notice in particular the 
groups of eighth notes: two eighth notes are played within the duration of a quarter note. In the same way, 4 
sixteenth notes are played within the duration of a quarter note.

There is also rhythmic values faster than the eighth note. Here is for example the 32nd note, which is 
equivalent to the half duration of a sixteenth note:

It is written with 3 small hooks drawn on the stem. There are thus eight 32nd notes per beat and you need 32 
of them to fill a whole 4/4 measure.

There is also the 64th note, which is worth half a 32nd note:
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It is written with 4 small hooks drawn on the stem. There is thus 16 64th notes per beat and you need 64 of 
them to fill a whole 4/4 measure.

Finally, we have the 128th note, which is worth half a 64th note:

It is written with 5 small hooks drawn on the stem. There are thus 32 128th notes per beat and you need 128 
of them to fill a whole 4/4 measure.

The 64th note and 128th notes are rather rare.

Open the Ex010 file. It shows an example alternating fast and slow rhythmic values:

Listen to the sound result. It becomes more difficult to follow! By calculating the total of beats present in 
each measure, you will find a total of 4 beats in each one.

In the manual, you will also find the double whole note. Here are three examples:

This rhythmic value is rather rare. It is worth the double of the whole note, i.e. the equivalent of 8 quarter 
notes. It is thus not possible to use it in a 4/4 measure, because this one can only contain 4 beats. We will see 
further how measures with more than 4 beats can be defined, which enables the use of the double whole 
notes.

Rests

When an instrument plays a score, there are moments when it must not play. Music is a discourse of musical 
sentences interspersed with moments when the instrument does not say anything. These moments are called 
rests. Even if an instrument does not play, it must continue to count the beats of the measures to be able to 
start playing again at the same time than the other instruments of the orchestra, when rests are finished.

For each rhythmic value previously explained, there is a rest of equivalent duration. Each rest has a name 
and has a graphic symbol which represents it on the score. They are placed in the measure like the notes. The 
height where they are placed does not really matter, if it is not for an aesthetic aspect of the score. They are 
usually placed at middle height in the measure.

As a measure must always contain the equivalent of its total duration (4 beats in a 4/4 measure), if an 
instrument plays only during part of a measure, rests must be supplemented to complete the content of the 
measure.

The quarter rest is a rest which is worth the duration of a quarter note. Here is the symbol which represents it 
in a measure:
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When an instrument finds this symbol in a measure, it knows that it must not play during one beat. Open the 
Ex011 file. It displays 4 measures with quarter notes and quarter rests:

Listen to the sound result. While the upper beats continue, the flute stops playing during the rests.

The whole rest and the half rest are worth respectively 4 and 2 quarter notes. The whole rest is equivalent to 
the whole note and the half rest is equivalent to the half note. Here are the graphic symbols:

They are both represented by a small black rectangle. The whole note is hung just below a line and the half 
rest is written on a line.

The whole rest has a specific characteristic. By convention, it has the ability to fill a complete measure, even 
if the measure contain more or less than 4 beats. It is used to fill the measure of an instrument which does 
not play at all. We will see further how you can have a 3/4 time signatures (measure which contains only 3 
quarter notes). By convention, it is thus correct to place a whole rest to fill a 3 beats measure.

The eighth rest and the sixteenth rest correspond respectively to the eighth note and the sixteenth note. Their 
durations are respectively worth 1/2 and 1/4 of the duration of a quarter rest. Here are the graphic symbols 
representing them :

In the case of 4/4 measures, the contents of each measure must always add up the equivalent of 4 quarter, 
either in notes, or in rests, or in a mixture of both. Open the Ex012 file:

Listen how the computer plays these measures.

The 32nd rest, the 64th rest and the 128th rest correspond respectively to the 32nd note, the 64th note and 
the 128th note. Here are the symbols :
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As for the eighth rest and sixteenth rest, these symbols have the same number of hooks than the note of 
equivalent duration.

We had seen that the double whole note is a note which lasts 8 quarter notes. Its equivalent rest is the double 
whole rest. It is represented by a black square:

Like the double whole note, the double whole rest is rather rare.

Summary

Notes and rests are used to write on a staff what an instrument plays. The clef and the vertical position of 
notes on the staff indicate the pitch of the sounds to play. The measure, the rhythmic symbols and the rests 
describe exactly the time sequence used to play them.

The theoretical basis of musical notation are summarized in this lesson. To master the reading of a score, it is 
necessary to learn how to read the contents of a measure, without having to think about each note to know 
how long it should be played or to which instrument note it corresponds. It is a question of work and regular 
practice.

Introduction of notes and rests (1)
• How to introduce notes and rests? 
• How to delete a note or a rest? 
• How to move a note or a rest? 
• How to select tools with the keyboard? 
• Automatic justification 

How to introduce notes and rests?

In this lesson, we will start to place notes and rests on the staff.

If you are using Pizzicato Drums and Percussion, we suggest you to use a template with a normal staff. You 
will find some in the File menu, Open template item. For instance, select the xylophone.

A set of tools is available to encode the notes and rests. They are located on the palette titled Notes and rests, 
in the Tools menu. Start Pizzicato and select the Notes and rests item in the Tools menu. Each note and rest 
value can be found in it, as well as various other tools:

Except for Pizzicato Light, you can increase the value of the score zoom to facilitate this lesson and the following ones
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To place a note or a rest on the staff, you just need to select the corresponding tool and to click on the staff 
where you want to place the note or the rest. For example let us see in detail how to write the following 
measure:

Select the half note tool  in the notes and rests palette by clicking on it.

Place the arrow of the mouse cursor where the note must come, around the middle of the space between the 
second and third lines (starting from the bottom) of the measure:

Click and release the mouse. A half note A appears at the expected place. If you click too high or too low, 
the note will be a B or G note. We will see below how to erase or move a note. For the moment it does not 
matter.

Select the quarter note tool .

Place the arrow of the mouse cursor where the note must appear, on the second line (starting from the 
bottom) of the measure:

Click. The note appears.

Select the quarter rest tool .

Place the arrow of the mouse cursor as follows:

Click. The rest appears. Note that the vertical position of rests is automatically adjusted. By clicking a little 
higher or lower, the result would have been the same.

How to delete a note or a rest?

If you want to delete a note, the A for example, execute the following steps:

• Select any note or rest value on the palette : quarter note, eighth note, quarter rest, whole rest… it 
does not matter, so long as it is a note or rest. 

• Place the mouse cursor on the head of the note: 

• On the computer keyboard, hit the delete key. It is the key located at the top right corner of the main 
keys block, just above the "return" key: 

• The note disappears: 

89



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

Notice in this example that the note and the rest are shifted back to the beginning of the measure. It is the 
action of the automatic justification. Thanks to this function, Pizzicato automatically adjusts the contents of 
the measures so that notes and rests are distributed in a balanced way into the measure. The content of a 
measure, when incomplete, is adjusted starting from the beginning of the measure. By deleting a half note, 
Pizzicato thus recalculates the position of the two remaining items (the quarter note and the quarter rest).

Thus, if you place a note in an empty measure, even if in the middle of it, Pizzicato will automatically 
replace it at the beginning of the measure and will equalize the distances between the notes introduced 
thereafter. You can also place a new note to the left of the first note and Pizzicato will shift the existing notes 
to insert the new note.

To delete a rest, it is the same principle than for a note. Select a note or rest tool, place the arrow of the 
mouse cursor on the quarter rest of the score and use the delete key. The quarter rest disappears.

Another practical and easy way to delete a note or a rest is to drag it outside the measure, to the left or to the 
right.

How to move a note or a rest?

If you followed the example, your measure looks like this now:

Let us see how to move this note into a low C.

• Select a note or rest tool. 

• Place the arrow of the mouse cursor on the head of the note. Click by holding the mouse button down 
and drag it lower to the position of a C note. The note follows your movement. By releasing the 
mouse button, the note is stabilized. After this operation, you should have: 

• To move a quarter rest, it is the same operation. You can move it vertically. 

• Considering the automatic justification, the fact of moving a note or a rest horizontally will force 
Pizzicato to recalculate the spacing. If you move an item without changing the order of the items in 
the measure, Pizzicato will cancel this movement. On the other hand, if you move a note by dragging 
it in front of or behind another note or rest (i.e. by changing the order of notes and rests in the 
measure), Pizzicato will take your modification into account and will readjust consequently the 
spacing of the measure. 

By adding a note, it is also possible to move it directly:

• Select the  tool. 

• Place the arrow of the mouse cursor at the level of a G : 

• Click and hold down the mouse button and drag it lower, to the position of a C. Release the mouse 
button. The added note has followed your movement. 
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How to select tools with the keyboard?

The tools representing the values of notes can be directly selected from the computer keyboard, by using the 
0 to 8 keys on the numeric keypad located to the right of the keyboard. The equivalence is as follows:

 7  8  

 4  5  6

 1  2  3

 0  
By typing the "3" key for example, you select the quarter note tool. Notice that the notes and rests palette 
must not necessarily be open and visible on the screen. Once you know these shortcuts, you can work 
without the palette.

To add a rest, you can also reach it with the note tool of equivalent duration, by holding the SHIFT key and 
by clicking in the measure. Let us see how to place an eighth rest in this manner:

• Select the eighth note by typing the "4" key. The  tool is selected. 

• Place the mouse cursor to the right of the second C : 

• Press and hold down the SHIFT key on the keyboard. Most keyboards have two such keys, located 
on the left and on the right of the main keys block . While holding down the SHIFT key, click. An 
eighth rest appears : 

These shortcuts lets you work without the palette for the introduction of notes and rests. It is very practical, 
especially for small screens: the saved space lets you better see your score.

Automatic justification

For Pizzicato Light, the automatic justification is always active.

For all other Pizzicato versions, it is possible to disable the automatic justification. In the upper part of the 
score view, a check box entitled "J"  lets you deactivate or activate it. Its keyboard shortcut is the "j" 
lower case letter.

The justification of a measure is a method which enables to automatically adjust the position of the 
introduced notes to obtain a measure which is graphically balanced and pleasant to read. Pizzicato has an 
automatic justification function which enables to space the notes and the rests as soon as you place them. 
With the activated automatic justification, any modification executed in a measure will cause a new 
calculation of the spacings. Therefore, Pizzicato erases the content of the measure and entirely redraws it 
with new spacings.

As much other automatisms, this function sometimes limits the graphical possibilities of note layout. This is 
why you can disable it at any time. One of the limits is that when you move a note slightly, Pizzicato will 
automatically recalculate spacings, redraw the measure and of course redraw it as Pizzicato wants it, i.e. it 
will cancel your manual moving of the note. By disabling this option, you ask Pizzicato not to modify the 
graphical display. You can then arrange yourself the content of the measure, tighten notes… Usually, one 
can say that the more complex the measure is as regard to the various rhythmic voices (more than two 
voices), the least it is advised to use automatic justification. For simpler measures, the automatic justification 
will save you much time by adjusting the spacing for you.
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Exercises
By starting each time from a new document (New item in the File menu), create the following measures.

• By selecting the tools on the palette with the mouse: 

• By selecting the tools with the keyboard only, while keeping the tools palette visible: 

• By closing the tools palette and by using the computer keyboard shortcuts: 

Characteristics of music notation (1)
• Note stems 
• Beams 
• More than one rhythmic voice 

Note stems

We have seen that half notes, quarter notes and all shorter rhythmic values have a stem. This vertical line 
starts from the right side of the note head and moves upwards, at least in the examples seen so far. Its length 
does not influence the note and is purely a question of convention, readability and esthetics of the graphical 
layout.

According to the note head position on the staff, the stem can be oriented downwards. In this case, it starts 
from the left side of the note:

Generally, one acts so that the stem exceeds the staff the least possible while having on average the length 
given in this example. When the note is placed on the third line or lower, the stem is directed upwards. When 
the note is placed higher than the third line, the stem is directed downwards:

This is not a mandatory rule, because it does not at all influence the performance of the note. The same 
principle is valid for the eighth notes. When you draw rhythmic values with hooks, they also change 
orientation, but they stay on the right side of the stem. The hooks always point in the direction of the note. 
Here is an illustration:
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For reasons of clarity and readability of the score, this rule is sometimes broken. We will see examples of it 
further.

Beams

In order to make the score more readable and easier to sight-read, it is very common to connect together 
several notes having one or more hooks. To illustrate this, let us take for example the following measure:

It contains 4 beats. To facilitate the reading, we will gather the notes per beat. Here is the result:

In this way, you directly distinguish the 4 parts of the measure. The ends of the note stems are connected 
together with one or more lines that replace the hooks. It is necessary to have the same number of lines as 
there are hooks. These stem connection lines are called beams. Generally, the notes will be connected 
together inside each beat.

When several different notes are placed inside the same beat, the principle stays the same. Thus the 
following measure :

can be written like this:

All notes are connected by a line (called a beam) and additional lines are added for the notes having more 
than one hook. For each note, the number of lines attached to the stem must be the same as the number of 
hooks when the note is not attached to other notes. The angle of the beams does not really matter. It often 
follows the angle suggested by the note positions. Sometimes they are fixed horizontal. It is a question of 
graphical design.

More than one rhythmic voice

We have seen that in a 4/4 measure, the total duration of the notes and rests must always give the 
equivalence of 4 quarter notes. It happens that several melodies are written on the same staff, which slightly 
modifies this rule. Let us take the example of two flutes in an orchestra. They play for example the following 
melodies:
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For various reasons, the two staves are sometimes put together. It is often the case for the orchestral 
instruments, when the two parts are not too condensed.

For each measure, the two melodies have both 4 beats. One also speaks about a complete rhythmic voice. If 
we write these two voices on the same staff, we get:

By adding the note values, you find for each measure a total duration of 8 beats. Nevertheless, the way in 
which beats are laid out shows rather clearly that they are organized as two 4 beats melodies which must be 
played together. This is even more obvious if you compare it with the two separate staves.

Notice that to better differentiate the notes of the two rhythmic voices, the stems of the higher voice are 
oriented upwards and those of the lower voice downwards.

These two examples are located in the Ex013 and Ex014 files. Successively open them with Pizzicato and 
listen to the sound result. The notes starting at the same time stay aligned, even when they are on the same 
staff.

In the above example, the two melodies are played by two different instruments. With the piano or the organ, 
it happens that the same hand plays two melodies at the same time, which produces the same kind of 
notation. In more complex scores, it happens that you can find three (and sometimes more) rhythmic voices 
on the same staff. Here is an example:

One voice plays 2 half notes, the second voice plays 4 quarter notes while the third voice plays 8 eighth 
notes.

You always find a multiple of the measure total duration. Two rhythmic voices in 4/4 give a total of 8 
quarter notes. Three rhythmic voices will have the equivalent of 12 quarter notes, etc. What is important to 
understand is that these multiple rhythmic voices are played at the same time, they thus do not lengthen the 
measure, which keeps a total duration of 4 quarter notes. The layout of the rhythmic voices often clearly 
shows it, because beats are aligned together, as if they were placed in different staves.

Introduction of notes and rests (2)
• How to modify the stems orientation? 
• How to modify the beams? 

How to modify the stems orientation?

In this lesson, we will examine some characteristics regarding the introduction of notes and rests.

In the previous lesson, the few notes which you had introduced were all automatically introduced with the 
stems upwards. The reason is very simple: all the notes placed on the third line of the staff or lower have 
their stems automatically oriented upwards.

The notes placed higher have the stem directed downwards. Let us examine this with an example.

Start Pizzicato and select the  tool by typing the shortcut "3" on the keyboard. By clicking in the staff, 
introduce the following notes:
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Pizzicato automatically inverts the stems of the notes starting from the C note.

Let us see now how to arbitrarily modify the orientation of the stems. In the Tools menu, open the Main 
palette.

Select the  tool. It is the stem inversion tool. Place the arrow of the mouse cursor on the head of the third 
note (C) and click. The stem of the note changes its orientation. If you click again, it is again inverted. It is 
as simple as that. Use this tool to obtain the following:

There is a shortcut key to directly invert a note stem without having to open the main palette. It is the lower 
case letter "i". Let us see how to use it.

• Select the  tool with shortcut "3" 
• Place the mouse cursor on the head of the first note (F) 
• Type letter "i" with the computer keyboard. The stem is inverted. 

Notice that the  tool was not automatically selected with the shortcut. The  tool is still active. This 
characteristic lets you continue to introduce notes and rests without having to select another tool to invert the 
stems of one or more notes.

How to modify the beams?

Until now, the examples were selected in such a way that no beam was necessary. The justification function 
automatically manages the beams between the notes, as you introduce them.

• Close the previous document and create a new one. 
• Select the eighth note with the "4" shortcut and place a G note at the beginning of the measure: 

• The eighth note being alone, it is drawn with the usual hook. Add an A note just next to it: 

• The two eighth notes are automatically beamed by Pizzicato. Add four sixteenth notes; they also 
connect themselves together: 

The notes are automatically connected for each beat of the measure. It is possible to manually adjust the 
notes which will be connected or not. The tool lets you separate a note from the preceding one in the 
measure. Select this tool in the main palette and click on the second eighth note:
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The eighth notes separate. Do the same with the third sixteenth note:

The shortcut key of this tool is the division sign "/". It does not matter which tool is currently selected on the 
palettes, you can simply place the mouse cursor on the note and use this shortcut. 

To connect two separated notes, do the following:

• Select a note or rest on the notes and rests palette or use a shortcut key. 
• While holding down the Control key, click on a note you want connected to the preceding one. For 

example, click on the first sixteenth note while holding down the control key: 

The two notes are now connected, despite the fact that they do not belong to the same beat. Notice that when 
you place a new note, you can do it by holding down the control key, which automatically connects the note 
to the preceding one (unless it does not make sense to connect them, i.e. the two notes must be of a rhythmic 
value lower or equal to the eighth note, see the lesson on beams). This method and the preceding tool let you 
organize the note beams as you want them.

Exercises
Here are some exercises allowing you to put into practice the notions learned so far for the introduction of 
notes and rests. If you have difficulties to make them, re-examine this lesson and the preceding ones if 
necessary. Check if all the words used in the course are rather clear for you and if not find them in the 
glossary. It is important to fully master these notions before going to the next lessons.

To do the exercises, start each time with a new document. Memorize the shortcut keys and use them to the 
maximum because they will accelerate your work. Good luck!

Characteristics of music notation (2)
• Chords 
• Dotted notes and rests 
• Ties 
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Chords

When several notes are played together, these notes form what is called a chord. The notes can be played by 
different instruments or by the same instrument, like the piano, the guitar or the organ. The chords enrich 
music and let you express various impressions and atmospheres. They amplify the melodies and accompany 
the rhythmic patterns by giving them new sound colours.

When the notes of a chord are played with the same rhythmic value, these notes are attached on the same 
stem. Here are for example two chords of 3 notes each with a quarter note duration :

The total duration of the chord is a quarter note, because the 3 notes are played at the same time. With 
Pizzicato, open the Ex015 file located in the Examples folder. It contains examples of chords with various 
rhythmic values:

Listen to the result. In this example, all notes belonging to a chord start and finish together. With regard to 
the whole note (second measure), as they do not have a stem by definition, they are only superimposed to 
form the chord (this principle is also valid for the double whole note, which is an eight beats note and does 
not have a stem).

When a chord has a note placed between two lines and a note placed on one of these two lines, the 
convention is to place one of the two notes on the other side of the stem; this improves the score readability. 
Without that, the two notes would be partly one above the other. Here are some examples with one or more 
notes placed on the other side of the stem:

When the notes of the chord are played by different instruments, the idea is rather to write the notes in the 
form of different voices. Let us take for example the case of the following measure :

If the 2 notes of the chords are played by 2 flutes, the measure will preferably be written as follows:

In this case, the stress is laid on the separation of the two voices by placing the stems in opposite directions. 
It allows the two flutists reading the same score to easily find what each is playing. Regarding the playing of 
the notes, the two examples are strictly identical.
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Dotted notes and rests

We have seen that notes are written using a rhythmic value to show how long they should be played. The 
usual values are multiples of two from each other, as the whole note and the half note, the quarter note and 
the eighth note, etc.

It is sometimes necessary to write a note duration different from these standard values. For example, how 
would you write a note lasting 3 beats? It is shorter than the whole note and longer than the half note and 
there is no value in between.

Two ways exist to write notes having nonstandard duration. The first is the dot and the second is the tie, 
which will be seen further.

When you add a dot next to a note, its duration is multiplied by one and a half. It lengthens a note by half its 
duration. Here is for example a dotted half note:

The half note equals 2 quarter notes. By multiplying 2 by 1.5 you get a duration of 3 quarter notes. The 
dotted half note equals 3 quarter notes. The principle is valid for all the other notes. Here are some 
examples :

The dotted quarter note equals 1 beat and a half. The dotted eighth note equals 3/4 of a beat. You just need to 
add half the basic value to the note. To fill a measure, it is of course necessary to take the dots into account 
so that the total duration is always equal to 4 quarter notes (for a 4/4 measure).

Open the Ex016 file. It contains 4 measures with dotted notes examples:

The beats of the higher line let you locate the beats. Listen to the computer playing and observe that the 
dotted notes are held longer. Check that the sum of the beats is equal to 4 quarter notes in each measure.

Notice that the dot is always drawn in the space between the lines, even if the note is placed on a line. The 
dot is drawn on the right side of the note head. We will further see that a dot can also be drawn above or 
below a note but it has another meaning.

The dot can also be used next to a rest. It lengthens the duration of the rest by half of its value. Here are 
examples:

To be complete, let us say that several dots can be added to the same note or rest. You will rarely find more 
than 2. The calculation of the duration becomes a little bit complicated. The first dot adds half of the 
duration. The second dot adds a quarter of the duration. The third dot adds 1/8 of the duration and so on by a 
division of 2. A double dotted quarter note thus equals to:

1 beat + 1/2 beat + 1/4 beat = 1.75 beat

98



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________
Open the Ex017 file and listen to it; it gives you examples of dotted notes and rests as well as double dotted 
notes:

Ties

There is another way to write notes of nonstandard duration. The idea is to assemble several rhythmic values 
and connect them so that they form only one note. Here is for example how you could write a note lasting 3 
beats:

You write a half note (2 beats) and a quarter note (1 beat). You assemble them with a tie to show that the 
duration of the half note must be prolonged through the quarter note. A 3 beats note is thus obtained. This 
example is the same as a dotted half note, which also equals 3 beats. The two notations are equivalent.

This connection is called a tie, because it shows that the note must be held longer. It always connects two 
notes located at the same pitch. We will see further another type of tie, called a slur, which is drawn in the 
same way but which can assemble several notes of different pitches, but the meaning is not the same.

The principle of the note tie can be cumulated to build notes of any duration. You just need to place a series 
of notes with the same pitch and to connect them together. The total duration is the sum of each duration. 
Here is an example:

The total duration is 2 + 1 + 1/2 + 1/4 = 3.75 beats. If the connections had not been drawn, as in the 
following measure:

the instrument should have played the 4 notes, i.e. starting the half note, holding it for 2 beats then stopping 
it, then directly starting the quarter note, holding it for 1 beat, then stopping it,… The auditor hears 4 times 
the same note pitch. By connecting them together, the note is started only once and is hold for the total 
duration. The auditor only hears one note.

A current use of the note tie consists in connecting notes belonging to different measures. If a note starts for 
example on the fourth beat of a 4/4 measure and must last 2 beats, it would be impossible to write it without 
using the tie. Here is how to write it:

The second F note is simply held through the measure barline. Open the Ex018 file now and listen to the 
result. It illustrates the use of the note tie inside a measure and between two measures:
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Introduction of notes and rests (3)
• Introducing chords 
• Dotted notes and rests 
• Changing the note head - Reducing notes 

Introducing chords

In this lesson, we will continue to study various aspects of the encoding of notes and rests.

In music, a chord is simply a set of notes played at the same time. When using Pizzicato as well as many 
other musical softwares, the word chord is used in a more restrictive way:

A chord is a set of notes having the same rhythmic values attached to the same stem.

The notes of a chord are thus vertically superimposed and attached to the same vertical line (the stem of the 
chord). Here are some examples:

Let us see how to write this measure.

• Start Pizzicato and select the half note tool by typing "2" on the keyboard. 

• Click to place the low D note. 

• Open the Notes and rests palette. Select the  tool. It is the chord tool. 

• Place the cursor at the level of the A note, above the D note: 

• Click. An A note appears. Now place the cursor at the level of high D, above the A: 

Click. A D appears and is attached to the same stem. You have here a chord containing 3 notes. At this step, 
you could wonder why not simply use the half note tool and introduce the 3 notes in a superimposed way. 
By using the chord tool, Pizzicato attaches the notes and they will now behave as a unit.

• Select the half note again with the "2" shortcut. 
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• Move the low D slightly to the right: the full chord follows your movement. The notes are really 
attached together. It would not be the case if the notes were not introduced with the chord tool. 

Like most tools, the chord tool also has a keyboard shortcut. It is the lower case letter 'a'. Let us complete the 
measure.

• Place the following notes to the right of the chord: 

• Place the mouse at the level of high D, just below the F quarter note and type the shortcut 'a'. The 
chord is formed: 

• Do the same to fill in the following chords: 

To erase a chord note, it is the same as for a normal note. Select a note or rest tool and use the erase key with 
the cursor on the head of the note.

Two particular cases require some explanation.

First of all, the chord formed with whole notes. By convention, the whole note is a note having no stem. 
How can we then create a chord with whole notes? The principle remains nevertheless the same. Just place 
the first whole note with the whole note tool (shortcut '1') and place the others in superposition with the 
chord tool. There will be no stem connecting them but the notes will nevertheless move together. Do the 
experiment:

• Create a new document. 
• Select the whole note tool with shortcut '1'. 
• Place a C whole note. 
• Place the cursor above the whole note, on the level of E. 
• Type the letter 'a' with the keyboard. An E whole note appears. Complete the chord with a G note. 
• Move the C to the right: the other chord notes also move. The same principle is valid for the double 

whole note (note value equal to 8 quarter notes) which has no stem either. 

The second particular case is when the chord has two notes close together, for example G and F. If Pizzicato 
would draw the notes one exactly above the other you would get:

It is not very easy to read. The convention is to place one of the two notes on the other side of the stem.

On the second measure, place a G quarter note. Then put the cursor below the G, at the level of F and type 
the 'a' shortcut. An F appears but the G goes on the other side of the stem: 

Pizzicato correctly manages the layout of the chords in that case.
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Dotted notes and rests

Let us see now how to lengthen the duration of a note or a silence by adding a dot to it.

• Create a new document and fill in the following measures: 

• Open the Notes and rests palette. Select the  tool. 
• Click on the first F. A dot appears beside the note. 
• Click on the F of the chord. The dot is automatically placed on the other notes of the chord. 
• Click on the quarter rest. The dot is placed beside it. The measures become: 

The shortcut keyboard for this tool is either the dot (.) or the comma (,). The numeric keypad of a keyboard 
always has one or the other, which gives an easy access when you keep your hand close to the note 
shortcuts. To use it:

• Select another tool (for example the eighth note) and place the mouse cursor on the E note. 
• Type the comma or the dot with the keyboard. 
• Do the same for the sixteenth rest. The selected tool did not change. The measures become: 

• Put the cursor again on the first F. Type the dot or the comma, the quarter note is dotted twice: 

To erase a dot, here is the procedure:

• Place the mouse cursor on the head of the first F. 
• Click with the right button of the mouse. A popup menu appears. Select the Delete dot item. One dot 

disappears. By repeating that, the second dot disappears. The principle is the same for the rest, by 
placing the cursor on the rest. 

Exercises
Here are two measures to write, so you can put into practice what you have just learned. Start each time with 
a new document.
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Changing the note head - Reducing notes

When writing percussion instruments, it is common to modify the graphic aspect of the note head. A special 
tool enables you to do this.

• Close the document and create a new one. Introduce the following measure :

• Open the Main palette and select the  tool 

• Click on the head of the first note (E). The following dialog box appears: 

The shortcut keyboard is lower case letter 'z'. It lets you select a special shape for the note. The first multiple 
choice indicates if the note is normal (i.e. the note head is related to its rhythmic value) or special. In this last 
case, you can click in one of the 18 boxes of the main table to select the note head you want.

• Click in the box with a cross head (top right corner of the table). Notice that the special note selection 
is automatically activated. Click OK to validate your choice. The measure becomes: 

The choice of a shape for the head does not affect the performance of the note at all.

• Similarly, modify the next note with a hollow triangular head: 

If you want to introduce all the notes of a staff with the same special shape, open the dialog box for the first 
note and check the option Becomes the current note head. All the notes you will then add in the score will 
automatically take the selected shape when you place them.

It is sometimes useful to reduce one or more notes in a measure. The same dialog box can be used for this 
purpose. Click on the third note and check the Reduced note option. Click OK. The measure is redrawn with 
the third note reduced. Do the same with the next 2 quarter notes. You get:
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This notation can be used in particular to create grace notes or for a series of freely played notes, etc. This 
reduction does not affect the play of the note in Pizzicato.

It is also possible to select one or more measures and globally modify all the notes found in those measures. 
To select measures, see the lesson entitled Selecting measures. Then call the Edit, Change note heads...  
menu. The above dialog appears and lets you apply the modification to all selected measures.

Exercise
Here is another measure to write, for practice.

The scale and the accidentals
• The scale and the musical keyboard 
• Tones and half tones 
• The sharp and the flat 
• The natural 
• The double sharp and the double flat 

The scale and the musical keyboard

We have seen that there are 7 notes named C, D, E, F, G, A, B. The next note is again called C and the sound 
generated vibrates exactly two times faster than the sound generated by the first C. This interval from the 
first to the second C is called an octave. In a more general way, an octave is the interval separating a note 
from the next note bearing the same name, such as for example from G to the next G. Here is an example 
with C:

This series of notes from C to C is called the scale of C. As this diagram is repeated higher and lower, we 
will limit ourselves to explain the contents of the notes from C to C. The same explanation is valid between 
two successive C.

These notes correspond to the white keys of a piano or organ keyboard. You can easily locate them by 
observing that the black keys are laid out by groups of 2 and 3 between the white keys. The C are the keys 
which are just to the left of a 2 black keys group. Here is an illustration:
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The white keys located between the 2 C follow the same order as on the staff:

The black keys of the keyboard are also notes that can be played. They are located between specific white 
keys. With 7 white keys and 5 black keys, you thus get 12 different notes. The thirteenth note is again a C 
and the same diagram is repeated. 

Tones and half tones

The interval separating one of these 12 notes from the next note is called a half tone (or semitone). There is a 
half tone between C and the black key which is just next to its right. Between this note and D, there is also a 
half tone and so on. These 12 semitones divide the octave into 12 equal parts.

The intervals located between the white keys are not all the same. Some have 2 half tones (= 1 tone) and the 
others only one half tone. Here is a table. Compare it with the layout of the keyboard; each time there is a 
black key, the two white notes are separated by 1 tone and when there is none, there is only one half tone:

The sharp and the flat

As all the notes of the staff correspond to the white keys, how can we write the black key notes?

Two symbols are used for that: the sharp and the flat. They are placed right in front of a note. The sharp 
means that the note should be played one half tone higher than its normal pitch. The flat means that it should 
be played one half tone lower than its normal pitch. Here are graphic examples:

The name of the note is then followed by the terms sharp or flat. We have here an F sharp and a B flat. The F 
sharp is located one half tone higher than F. It is thus the black key located just to the right of F:
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B flat is located one half tone lower than B. It is the black key located just to the left of B. 

:

By this system, all the keys of the keyboard can be written on the staff. Because there is a symbol to go one 
half tone down and another to go one half tone up, there are two different ways to write each black key. The 
first black key can be written as a C sharp or a D flat. The second can be written as a D sharp or an E flat and 
so on.

Let us notice that there is no black key between E and F, neither between B and C. If you place a sharp in 
front of E, the note must be played one half tone higher. As there is no black key to its right, the following 
key is the F key. E sharp is thus equivalent to F, F flat equals E, B sharp is equivalent to C and the C flat 
equals B.

Here is a diagram showing the names of the 12 notes of the keyboard and their writing on the staff:

Open the Ex019 file. It contains examples of sharps and flats:
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These symbols are called accidentals, because they alter the pitch of the note. Listen to the sound result 
while following the score. Notice that the accidental notes have an intermediate pitch between two non 
accidental notes.

When you place an accidental in front of a note, it remains valid until the end of the measure. Let us take the 
following example:

The measure contains 3 F. The second F is modified by a sharp. The next F, located in the same measure, is 
automatically an F sharp. The symbol must not be written again. In other words, when a note is altered, it 
remains altered for the remainder of the measure, unless otherwise specified. In our example, if an F is 
placed in the following measure, it will not be affected by the sharp.

We will further see that you can place accidentals at the clef. They are accidentals drawn just to the right of 
the clef, at the beginning of each staff. They automatically influence all the concerned notes of the staff. 
Here is an example:

Two flats are drawn just to the right of the clef, with the pitch of B and E. It means that all B and E notes 
will automatically be B flat and E flat, for all measures.

In such a case, it must also be possible to play a natural (non altered) B. In our example with 3 F, what can 
we do if the third F must not be altered by the sharp?

The natural

There is a symbol which lets you cancel the effect of an accidental, it is the natural. By placing a natural sign 
in front of a note, it returns to its natural state, whatever are the previous accidentals near the clef or in the 
beginning of the measure. Thus, if we want that third F not altered, we place a natural sign right in front of 
it:

Notice that if a fourth F would follow in the same measure, it would automatically be a natural F. The 
natural sign can be used to cancel an accidental which is near the clef.

To find if a note is an accidental, here are the rules to follow:

1. If an accidental is drawn right in front of the note, this accidental has priority on the preceding 
accidentals or those located near the clef. 

2. If the note does not have an accidental drawn in front of it, the note automatically takes the accidental 
of the last note having the same name and preceding it in the same measure. 

3. If no note bearing the same name precedes it in the same measure, it possibly takes one of the 
accidentals near the clef. 

4. If not, then it is a natural note (not altered). 

The double sharp and the double flat

To be complete about accidentals, let us mention the double-sharp and the double flat. Respectively, these 
accidentals increase or decrease the note by two half tones. Here is an F double-sharp and a B double-flat:
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The symbol of the first is a cross placed right in front of the note and the second represents two flats one 
beside the other. They are less common than the sharp, the flat and the natural sign. If you observe the F note 
on the musical keyboard (diagrams of the beginning of this lesson), and if you go up by two half tones, you 
arrive on the following white key, which is a G. An F double-sharp equals to G. In the same way the B 
double-flat equals to A.

When the same sound can be written in several ways on the staff (F sharp = G flat, B flat = A sharp…) we 
speak about an enharmony. F double-sharp is the enharmony of G and vice versa, F sharp is the enharmony 
of G flat and vice versa, etc.

Two notes which are enharmony of each other will be equivalent to the ear, because they correspond to the 
same key on the keyboard.

Introduction of notes and rests (4)
• Placement of accidentals 
• Position of an accidental 
• Ties 
• Adjustment of the stem length 
• Rhythmic voices 

Placement of accidentals

Start Pizzicato and open the Notes and rests palette. You can observe the following tools in it: 

 The Sharp,

 The Flat,

 The Natural,

 The Double sharp,

 The Double flat,

 The accidentals eraser.

To place an accidental on a note, select the tool and click on the head of the note.

• Introduce the following notes in the second measure: 

• Select the Sharp and click on the F note (second note), then on the G note (third note). 
• Select the Flat and click on the E note (first note), then on the D note (last note). 
• Select the Natural sign and click on the second F (penultimate note). 

The measure now looks like this:
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The principle is the same for the double sharp and the double flat. To erase an accidental, the E flat for 
example:

• Select the accidentals eraser tool  
• Click on the head of the E (first note). The accidental disappears. 

Let us see the keyboard shortcuts:

• Select the eighth note (shortcut '4'), 
• Place the cursor on the E note. Type the minus sign (-) with the keyboard. A flat appears in front of 

the E. The eighth note is still selected. 
• Type again a minus sign (-) on the E flat note. The flat is transformed into a double flat. 
• Now type one plus sign (+) with the keyboard, with the cursor still placed on the E note. You get a 

simple flat again. 
• Once again type (+). The accidental disappears. 
• Once again type (+). A sharp appears. 
• By typing a plus again, you get a double sharp. 

The plus sign (+), when applied to a note increases this note by one half tone:

Double flat => Flat => No accidental => Sharp => Double sharp
The minus sign (-), when applied to a note decreases this note by one half tone:

Double sharp => Sharp => No accidental => Flat => Double flat
To erase an accidental, use the 'X' shortcut (capital letter) on the head of the note. To place a natural sign, the 
shortcut is the star (*) key.

Position of an accidental

The distance between an accidental and the note is fixed by Pizzicato at the time you add the accidental.

• Start with a new score and introduce the following chord: 

• Place a sharp on the D note and on the E note. Place a flat on the G note and on the B note. You 
obtain: 

Pizzicato has automatically moved the accidentals in such a way that they are not superimposed and remain 
readable. In the case of an accidental on a single note, the  tool lets you move the accidental. Add for 
example a quarter note in the measure. Add a sharp, select the  tool and move this sharp on the left, you 
get:

In the case of a chord with several accidentals, Pizzicato allows to disable this automatism for the chords and 
let the user adjust the accidentals position manually. In the Options menu, select the Automatisms item…:

The following dialog is not available in Pizzicato Light
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Remove the Accidentals option and click OK.

• Open the Main Palette and select the  tool. This tool lets you move any accidental. 
• Place the mouse cursor on the sharp attached to the D. Click and drag to the left. The sharp follows 

your movement. By releasing the mouse, the accidental stays there. Do the same with the sharp 
attached to the E, you get: 

You can also adjust the vertical position of an accidental. Hold down the CTRL key while you move the 
accidental and you can adjust it vertically also, for instance to place it above a note, in a very tight passage.

Ties

When 2 notes of the same pitch are connected by a curve, it means that the second note must not be played 
again, but simply maintained as the continuation of the first.

• In a new document, fill the measures to obtain: 

• In the Notes and rests palette, select the  tool. Click on the quarter G note of the first measure. A 
tie appears and joins the G note of the other measure. 

• Do the same with the first eighth B note of the first measure. Your measure becomes: 

• To reverse the direction of a tie, click again on the first note. Reverse in this manner the tie between 
the 2 B notes. 

• To remove a tie, click again on the first note. Click again on the first B. The tie disappears. 
• The keyboard shortcut of this tool is the equal sign (=). Select the eighth note and place the mouse 

cursor on the half C note of the second measure. Type (=). A tie appears. Do the same for the two 
other notes of the chord. The measure becomes: 
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Adjustment of the stem length

For a question of layout and readability, it is useful to be able to adjust the length of the notes stems as well 
as the beams angle.

• In the Main Palette, select the  tool. Place the mouse cursor on the stem end of the half note 
chord: 

• Click and drag upwards. The chord stem lengthens. If you go down, it is shortened. By releasing the 
mouse button, it keeps its length. 

• Do the same with the eighth G note (2nd note) of the first measure. As the beam is attached to the 
stem, the beam changes progressively with your movement. This lets you adjust the angle of the 
beam at will. Modify the measure to get: 

• Group the 4 eighth notes, select the  tool and place the cursor like this: 

• Click and drag upwards. The full beam follows. When you change the height of a note stem which is 
inside a group of notes, you modify all the stems heights of the group. By moving the note stem at a 
border of a group (first or last note of the group), the angle of the beam is adjusted. Your measure 
becomes for example: 

Rhythmic voices

Pizzicato allows you to encode up to eight rhythmic voices per measure. The encoding mode of the voices is 
visible in the top left corner of the score view. It shows by default 1-8: 

This default mode means that Pizzicato allows you to encode several voices without having to worry about 
the distribution of the notes into the voices. In a new document, introduce the following notes:
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These notes constitute what is called a rhythmic voice. The added durations of these notes fill a whole 
measure, here 4 beats. Pizzicato affected them by default to voice number 1. Now add another melody, as 
thought the measure was empty, to obtain:

Despite the fact that the measure was already complete, Pizzicato let you encode an additional voice. 
Moreover, the notes stems previously encoded are automatically adjusted so that the readability of the two 
voices remains clear. Pizzicato automatically assigned the additional notes to another voice. It is the 
automatic voice encoding mode, indicated by the choice 1-8.

In the popup menu of rhythmic voices, select item 1. The measure becomes:

Only the notes of rhythmic voice 1 are displayed in black. The other voices (here voice 2) are drawn in gray, 
to show you are working on voice 1. When you select a number from 1 to 8 in the rhythmic voice menu, the 
notes you add are placed specifically in that voice. Try for example to add a quarter note in the measure. 
Pizzicato refuses, because voice 1 is already complete for this measure (4 beats). On the other hand, when 
you select choice 1-8 (choice by default) in the rhythmic voices, Pizzicato automatically begins a new voice 
and decides the assignment of the voices to the added notes. In most cases, Pizzicato does that very correctly 
for measures with up to two rhythmic voices, according to the complexity of the measure contents. In the 
cases of a very intricate and complex measure regarding the organization of the voices, you can use this 
rhythmic voice menu to force Pizzicato to follow your directives. Enter the first voice completely, then 
change the rhythmic voices menu and encode the second voice… In this manner, Pizzicato splits the 
contents of the measure as you want in independent rhythmic voices.

When you introduce several rhythmic voices with option 1-8, it is strongly advised to introduce them one by 
one. If you begin for example the second voice whereas the first voice is not finished, Pizzicato may more 
easily confuse the voices and make the encoding operation more delicate.

Exercises
Here are some measures to encode to allow you re-examine the concepts learned up to now. Create each 
time a new document.
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Entering notes with a music keyboard
• The keyboard window 
• How you can introduce notes with the keyboard? 

The keyboard window

In this lesson, we will learn how to introduce notes using the MIDI keyboard and computer keyboard. It is a 
fast and precise method to enter the notes in a measure.

Pizzicato lets you introduce notes with a Midi keyboard connected to your computer. If you have a sound 
card but no Midi keyboard, Pizzicato offers you a keyboard drawn inside a window, whose keys can be 
activated either by the mouse or by specific computer keyboard shortcuts.

If you are a guitarist, you can use the Guitar Fretboard window (Windows menu) exactly as the piano 
keyboard window explained in this lesson.

• Start Pizzicato. In the Windows menu, select the Piano keyboard item. The following window 
appears, even if it does not have exactly the same size as bellow: 

It can be moved on your screen. You can change its size when you click and drag one of the borders. When 
you close this keyboard window with the closing box, its size and position are memorized and when you 
open it again, it takes again its last size and position.

• Click on one of the keys of this keyboard. When the mouse button is pushed, the corresponding 
sound is heard. A small square also appears on the key to show that it is playing: 

You can slide the mouse by holding the button down. The notes on which you slide will be played.

When you open a musical document and ask Pizzicato to play it, the keyboard window will at every moment 
show the notes playing in the score. We will use this didactic aspect to learn the musical keyboard.

The two lines of keys located above the keyboard space bar of the computer are used as shortcuts to activate 
the notes of the keyboard window. Here is the table showing the equivalence. The white keys are represented 
in the first line of keys, between the two SHIFT keys. The black keys are represented by the second line of 
keys, when there is one black key on the musical keyboard. Here is a comparative drawing:
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It is the position of the keys on your computer keyboard that is important. According to the country, your 
keyboard may be different. Some computer keyboard keys are used at the same time as a shortcut for the 
musical keyboard and also for a tool located in a palette. It is for example the case of the lower case letter 'c'. 
It acts to activate the F key and also to change a clef on a staff. One thus needs some way to differentiate the 
use of these keys with double function. The basic rule is as follows:

When the cursor of the mouse is located inside the keyboard window, all shortcuts are used 
by the musical keyboard.

In the case of a double keyboard shortcut, you can thus select between the keyboard and the tool by placing 
the mouse inside the keyboard window or outside it.

Try now these shortcuts to understand the equivalence between the two keyboards. Depending on the 
keyboard manufacturer, you can simultaneously press several keys. Each time a key is activated, it is 
indicated by the small coloured square. 

If you press at the same time one of the SHIFT keys, all the notes will be played an octave higher on the 
keyboard, letting you cover about two octaves and a half with the keyboard shortcuts.

• In the Options menu, select the Keyboard item…The following dialog box appears: 

The menu located right to the word Octave lets you to determine the first keyboard C pitch. The first menu 
lets you assign another note than a C as the first note. If you change it, it will not affect the graphic aspect of 
the keyboard, but the keyboard will be transposed, because the first key (normally C) will correspond to 
another note.

By checking the option Fixed width of the keys, the keyboard keys will always have the width indicated in 
the following text box. If it is not checked, the width of the keys will be adapted to the size of the window so 
as to keep the usual proportions found on a musical keyboard.

The next menu lets you select the type of computer keyboard you have. From one country to another, the 
keys are laid out differently and the shortcuts are thus also different. If your shortcuts do not function as 
indicated above, test another choice in this menu. The last two choices of this menu lets you create personal 
configurations. You can program them yourself. If your computer keyboard does not exactly correspond to 
the progression of the keys or if you want to assign other keyboard shortcuts to the notes, here is the 
procedure to program your shortcuts:

• On the computer keyboard, press the CTRL and SHIFT keys and by using the mouse, click on the 
key of the keyboard window you want to assign a shortcut to. Then release the keys of the computer 
keyboard. A small square starts to blink on the key. It shows you that Pizzicato is waiting for the 
keyboard shortcut of this key. 
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• Press the computer key (possibly with SHIFT) you want to correspond with the blinking note. At this 
time the key stops blinking. It will answer to this new shortcut from now on. If you want to un-
program a key so that it does not answer to a shorcut anymore, do the preceding steps and when the 
key blink, use the ESC key of the keyboard. 

• Do the preceding steps with all the keys you want to program. 

How you can introduce notes with the keyboard?

It is thanks to the Midi cursor that you will be able to directly combine the keyboard shortcuts and the notes 
played on the musical keyboard.

For the rest of this lesson, we will consider that the musical keyboard is a real musical keyboard, connected 
by a MIDI cable to your computer. Most of what follows also applies if you simply use the keyboard 
window with its shortcuts.

In the Main palette, select the  tool. It is the Midi cursor tool. As soon as it is selected, a cursor blinks in 
the first measure at the beginning of the score:

It shows the location where notes and rests will be placed. The keyboard shortcut of this tool is the lower 
case letter 'r'. It is one of the rare tools that is not exclusive, it can stay selected whereas you select another 
tool. To disable the Midi cursor, you just need to use the same shortcut 'r' again or to click on its icon.

When you use the Esc shortcut to select the cursor (the arrow  ), the Midi cursor tool is automatically 
disabled.

Be sure that automatic justification is activated (it is always the case with Pizzicato Light). It is essential if 
you want to fully use the Midi cursor. As notes and rests will be placed without the mouse, it is necessary 
that Pizzicato correctly places them with the justification, so that the measure have a nice layout. You can 
also modify the rhythmic voices popup menu to introduce several voices.

Two methods are possible to introduce the notes on the staff. Let us initially see the most complete one.

To use this method, the cursor tool (the arrow) must be selected on the main palette, together with the Midi 
cursor.

The principle is to use the Midi keyboard to introduce the pitches of the notes and the numeric keypad of the 
computer keyboard to introduce the rhythmic values. Remember the shortcuts for the rhythmic values, '3' for 
the quarter note, '4' for the eighth note, etc. The Midi cursor tool uses the same shortcuts.

• Press and hold down the C key on your Midi keyboard. Type a '3' on the numeric keypad and then 
release the C note. The C note appears in the measure and the cursor moves to the right: 

If you did not use the correct C of the keyboard, it may appear one octave higher or lower. It is not important 
for the example. If you use the keyboard window, you must press the key using the shortcut. By clicking 
with the mouse on the keyboard window, it will not work.

• Press and hold down the D key of the keyboard and type twice the '4' shortcut (eighth note). The 
notes appear in the measure. They are automatically beamed and the cursor moves to the right: 
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• Press and hold down the E key and type '2' (half note). The note appears in the measure. The measure 
is now complete, this is why the cursor automatically went to the beginning of the next measure: 

• Press and hold down at the same time the three C, E and G keys of the keyboard. Type '3' (quarter 
note). A chord containing the three notes is added to the measure: 

The principle is thus very simple. You press and hold down the notes on the keyboard and you type the 
rhythmic value on the numeric keypad. You do not need the mouse. One hand is located on the musical 
keyboard and the other on the numeric keypad. The Midi cursor automatically advances.

• To introduce a rest, you just need to type the rhythmic value without pressing a key on the keyboard. 
Type '3'. A quarter rest appears in the measure and the cursor moves to the next position: 

• To move the Midi cursor, you can use the left and right arrows on the keyboard. They let you go 
from one element to the next one. Press 6 times the left arrow. Your Midi cursor gradually moves and 
comes just to the right of the first note: 

• The right arrow acts in the other direction. Bring the cursor to the right of the half note by typing 3 
times on the right arrow. 

• Use the down arrow. The Midi cursor goes down on the staff just below it. By using the up arrow, 
you go one staff up. 

• The tabulator key lets you go to the beginning of the next measure, without going through each 
element of the measure. By maintaining the SHIFT key and using the tabulator, you place the Midi 
cursor at the beginning of the previous measure. 

• You can also use the mouse to place the Midi cursor. You just need to click in a measure, where you 
want to place it. Click right to the half note, in the first measure. 

• To erase a note, a chord or a rest, place the Midi cursor just to the right of it and use the erase (back) 
key of the keyboard. Erase the half note. Replace it by two quarter E and F notes, using the musical 
keyboard and the '3' key: 

• Move the Midi cursor back one step to place it in the previous measure, to the right of F note. Use the 
lower case letter 'i'. The stem of the note preceding the cursor is reversed: 
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You can thus correct the layout of the stems progressively with the introduction of the notes, by using the 
stem inversion shortcut tool 'i'.

• Place the Midi cursor to the right of the quarter rest of measure 2. Press the E key and type the '3' key 
to get a quarter note. Type then a dot or a comma with the keyboard. A dot is added to the quarter 
note to prolong its duration: 

A remark is essential if you use the keyboard window, because the dot and the comma are also shortcuts to 
activate keys of that window. The following rule applies to indicate the use of the dot, the comma, as well as 
the '/' and '=' signs which will be used below. If the mouse cursor is inside the keyboard window and that this 
one is above the score window, the sign will be taken into account to activate the key of the musical 
keyboard. If not, it will be used as a shortcut for the score view.

• Complete the measure with a D eighth note. Type the '=' sign on the keyboard. A tie appears, starting 
from D: 

• Fill the next measure with 6 eighth notes: 

• The "/" sign (division bar) lets you beam or un-beam the two notes preceding the cursor. Type the '/' 
sign once. The two eights notes separate. Move the Midi cursor back one note and type the '/' sign 
again. The note beams itself with the preceding note: 

This lets you modify the way in which beams are arranged.

You can also use the '9' shortcut to change the last note entry to its enharmonic. This is useful when 
Pizzicato writes for instance an F# and you want a Gb.

There is another method to use the Midi cursor. For that, select a rhythmic value on the notes and rests 
palette by using the mouse, the eighth note for example (or using the shortcuts, provided that the Midi cursor 
tool is not selected yet, otherwise a rest will appear on the score) and then select the Midi cursor. Place it at 
the beginning of the next measure.

From then on, all the keys you press on the musical keyboard will be placed on the score as soon as you 
release them. Press and release successively the keys from C to the next C and you will get the following 
result:

As the eighth note was selected, all the notes are eighths notes. By now using a shortcut from 0 to 8, you can 
change the selected rhythmic value. Select the quarter note and press some notes on the keyboard. They are 
written as quarter notes.
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You can add a rest if you press a key of the music keyboard while holding down the SHIFT key of the 
computer keyboard.

This second method differentiates the choice of the rhythmic values and the choice of the pitches. You 
initially select a rhythmic value and then you introduce the notes with the keyboard, one at a time or as a 
chord. It is more adapted to a score containing many notes of the same rhythmic values following each other. 
You can of course use shortcuts i, /, = as well as the dot or comma, as in the first method. The moving modes 
of the cursor are also the same as well as the effect of the erase key.

Notice that if the Midi cursor is activated and visible on the screen, it determines the first measure that will 
be played when you use the space bar to listen to the score.

The music typing keyboard
• Entering music faster 
• Notes and rhythm 
• Other aspects of entering music 
• Additional functions 

Entering music faster

The music typing keyboard is a hardware keyboard specifically designed to enter music. It is a way to enter 

music faster and more efficiently than ever. You can test the idea for yourself by using the window that 
represents the keyboard.

The real keyboard is available from now on, with the release of Pizzicato 3.6. You can buy it directly on our 
Arpege Music site or through our authorized resellers and distributors.

It connects to the PC through a USB cable and directly activates the keys that you can see in the music 
typing keyboard window.

Please note that at this point (November 2011, publication of Pizzicato 3.6), the real keyboard does not yet  
work on MAC computers. We hope to make it soon available on Mac too.

You can open the window representing this keyboard, in the Windows, Music typing keyboard menu item:

As you can see, the layout and the shape of the keys are somewhat different than a normal computer 
keyboard. The above yellow keys are used in combination with the orange keys to enter the pitch and the 
duration of notes. Several other keys help you modify or fill in many other aspects of music notation. 

The real hardware keyboard is shown here:
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Notes and rhythm

The main idea of this keyboard is oriented around the central set of keys, colored in yellow.

The selection of pitch is horizontal, similarly to a piano keyboard (higher pitch to the right, lower pitch to the 
left). By default, you see that the note name is displayed in the upper left corner of these keys. Each line has 
the same notes: C, D, E, F, G, A, B. You will notice that between E and F, a key is used as a rest.

The three lines of yellow keys are the same regarding the pitch, but offer different durations. By default, the 
central line corresponds to the quarter note (or rest). The upper line is twice the duration of the central line, 
by default the half note (or rest) and the lower line is half the duration of the central line, by default the 
eighth note (or rest). The rhythmic value is shown on the lower right part of each key.

This keyboard is used in Pizzicato as a specialized application of the MIDI cursor tool (see the previous 
lesson).

When you buy the keyboard, you receive a guide explaining how each key works for entering music. Each 
key of the real keyboard corresponds to a key of the screen keyboard. To use the screen keyboard, you must 
click on the keys with the mouse. This can help you understand how the keyboard works, but obviously only 
the real keyboard can help you to reach a faster speed to enter music, as you can use your ten fingers to be 
more efficient.

When you connect the USB keyboard to the computer, start Pizzicato and go in the Options, Connecting a 
music typing keyboard... menu item. A dialog box appears. Check the box to activate the use of the 
keyboard. Then type several keys of the real keyboard so that Pizzicato can locate its keyboard identifier. 
Then click OK. If you do not have the real keyboard, it is better to keep it disabled in that dialog box.

After activating the keyboard as described above, when you next open a document or restart Pizzicato, you 
will see the following additional icon in the tool bar of the score window:

By clicking on this icon, you activate the note entry mode through the music typing keyboard. Notice that 
the window keyboard will not automatically be open. Indeed, this window is not usefull when you have the 
real keyboard, as you have it in front of your eyes and in contact with your fingers, so the score can occupy 
the whole window. However (mostly at the beginning), you may display the window also, with the 
Windows, Music typing keyboard menu item.

• Once this mode is entered, the MIDI cursor appears, but it takes another form than explained in the 
lesson about the MIDI cursor: 

• This little blinking line shows approximately the octave of pitches you can currently enter with the 
keyboard. Click on the first yellow key of the central line (or directly on your music typing 
keyboard): the C note appears on the staff: 
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• A number is shown just below the note names on the yellow keys, in the keyboard window. It shows 
the current octave of the notes. 

• There is an automatic progressive octave change, as you type in the notes. For instance, you will 
notice that after typing the C3 key, the keyboard now displays the last two notes (A and B) in dark 
yellow and their octave number have changed to 2 instead of 3. The other 5 notes stay the same, with 
octave 3. This means that you can now enter a C, D, E, F or G note and that it will be in the same 
octave than the last C note you entered. But if you use the A or B keys, the octave will be just below 
the last C. 

• This automatic octave shift is based on the last note you entered and is adapted so that most of the 
time you have the correct octave for the notes you need. Enter the following notes on the central line: 
G, A and B, each time watching how the dark yellow keys display octave changes, as well as the 
vertical position of the blinking rectangle. Then start again on the left part, with the C, D and E notes. 
You get the following: 

• By using the upper or lower line of keys, the pitches are the same, but you get another rhythmic value 
(half note or eighth note). 

• To enter a rest, use the fourth yellow key on each line. 

• By default, the rhythmic values are (from top to bottom line) the half note, the quarter note and the 
eighth note. You can shift these values permanently by using the two orange keys below the yellow 
keys. These two keys display at any moment the ryhthmic values that they will force on the three 
main lines of keys. Click for instance on the left one, then on the right one. You can see that the 
rhythmic values displayed in the central keys are updated accordingly. Notice that the blinking cursor 
takes each time a specific form, so that you can easily see what is the current central line duration. 

• If you only need one isolated different rhythmic value, you may use the SHIFT 1 and SHIFT 2 keys 
to modify the current rhythmic value. These two keys are available to the left and right of the main 
set of keys and they display respectively one and two large up arrows. Click on one of them and you 
will see the the upper and lower rhythmic values are temporarily changed while you hold that key 
down. The SHIFT 1 key multiplies the duration ratio by 2 and the SHIFT 2 multiplies that ratio by 4. 
While holding down both SHIFT keys, the ratio is multiplied by 8. The SHIFT keys are not useable 
without the real keyboard, as with the mouse you can only click one key at a time on the screen.. 

• If you want to force the pitch octave, you can do so by using the two orange keys just to the left and 
right of the main yellow keys. The left key displays a staff with a down arrow, as well as the octave 
number that will be used if you press it. Similarly, the right key displays a staff with an up arrow and 
the octave number that will be used. Click on both of these keys to see how the octave numbers are 
changed on the yellow keys. 

These are the basic functions for entering notes and rhythms. We suggest you to explore these various keys 
and enter a few measures of notes and rests, with different rhythms and octaves.

Using this keyboard window with the mouse of course does not give you a fast method to enter music. You 
must however imagine that with a real, physical keyboard showing these keys, all your fingers can be used 
to enter notes. After some training period, you will reach an efficient and fast method to enter music on a 
computer.

A series of exercices are available in configuration 2 of the document manager (blue buttons above the left 
part of the window, showing the documents), in the folder entitled Music Typing Keyboard. The exercises 
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are progressive. There are existing melodies and an empty staff so you can enter the notes in it as an exercise 
with the keyboard. You will find some fingering advices in them.

Other aspects of entering music

Here is the description of several other keys related to entering the notes.

• The accidental (flat, natural and sharp) keys just above the yellow keys are used as follows. When 
you click on one of them, it displays itself in yellow, which means that the next note will have this 
accidental. When you click a note, the accidental is applied to it and the accidental key is displayed 
again in white, to say that it is no more active. When you use the flat or sharp key twice, you get the 
double flat and double sharp accidentals. A third press on that key cancels the accidental. 

• The chord tool (left to the flat key) is used to add more than one note to a stem. To enter a chord, 
enable this key, then enter the notes of the chord. You will notice that the blinking cursor stays in 
front of the front, until you release the chord mode. If you need to enter several chords in sequence, 
you can use the ENTER key to switch to the next chord. 

• To the right of the sharp key, you will find the tie tool, that is applied to the last note entered, or to 
the note just next to the cursor. If you apply it again, it changes the tie orientation. If you apply it 
again, it removes the tie. 

• The next key is used to flip the stem up or down. It is applied to the last note entered or to the note 
just next to the cursor. 

• The next key lets you split apart or attach together eighth, 16th,... note stems. 

• The next key is used to enter triplets. Press this key then enter for instance 3 eighth notes. They are 
added automatically as triplets. Then disable this key. 

• The voice key "V 1-8" is used to shift between rhythmic voices. For instance, you can first enter 4 
quarter notes in a measure. Then, switch to voice 2 using this key and you can enter a second voice 
for instance with 4 other quarter notes. It controls in fact the voice menu that you can find in the 
score window menu bar, on the left. 

• The backspace key  can be used to delete the last entry. Combined with the SHIFT 1 key, all 

notes before the cursor (in that measure) are deleted. Then, if used again, the previous measure is 
deleted. 

• The DEL key is used to delete the note right next to the cursor. Combined with the SHIFT 1 key, the 
whole measure is deleted. 

• The 4 arrow keys below the numeric keypad can be used to move the blinking cursor back or 
forward, as you edit the content of measures. The up and down key are used to go from one staff to 
another, if the score has more than one instrument playing together. When the left or right arrow keys 
are combined with SHIFT 1, the cursor moves to the previous or next measure. Combined with 
SHIFT 2, the cursor goes respectively to the first and last measure of the score. The up and down 
arrows are used to go from one staff to another, when the score has more than one instruments 
playing. 

• On the bottom left part of the keyboard, you will find three symbols that can be attached to a note: 
Staccato, Accent and Tenuto. They can be applied to the last note you entered or to the note next to 
the cursor. Using the same key again removes that symbol. 

• To the right of the two keys used to change the rhythmic values, you have the dotted note/rest key. 
When you hit that key, the last rhythmic value entered will be modified with a dot attached to it. You 
can also use it to add a dot to the note/rest next to the cursor. 

• The LOCK key is used to automatically add the above symbols or a dotted value, to each note you 
add. When you press that key, the following dialog box appears: 
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You can use the function keys or the mouse to enable/disable these symbols. You can use the 
ENTER key to validate or F8 to cancel. If you keep at least one these symbols active, then the 
active symbols will be automatically applied to each new note. press the LOCK key again to 
cancel this automatic feature.

• The "p f" key is used to add a nuance. When you press that key, the following dialog box appears: 

You can then select one of the nuances with the arrow keys, the function keys or the mouse. 
Once added, the symbol can be moved simply with the mouse.

• The "n" key is used to enter irregular groups (tuplets in Pizzicato). When you press this key, a dialog 
box asks you to specify the tuplet: 

From there on, the notes you enter are tuplets as defined above. By pressing the key once more, 
you disable the tuplet mode. If you use it with the SHIFT 1 key, Pizzicato opens the full 
specification dialog box for a tuplet.

• The next key (with two small 16th notes) is used to enable/disable the grace note mode. All notes you 
enter are then grace notes. 

• The next key is used to enter slurs. Two methods are possible. If you enter the notes and slurs 
together, press this key after adding the first note of the slur. Then enter the notes and the slur will 
follow the current note. Press the key again to stop the slur. A rest will automatically stop the slur.

You can also first enter the notes, then place the cursor at the beginning of the slur and press the key. 
You can then move the cursor to the last note. The ENTER key may be used to stop the slur and start 
a new one. 

• The key with the slashed grace note calls the following dialog box, which provides various grace 
notes that you can add to the current note or the note just next to the cursor: 

Use the ENTER key to validate or F12 to cancel, or one of the function keys or the left/right 
arrow keys to select a grace note.

• The key next to the right is used similarly to select a trill or mordent: 
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Similarly to the nuances, you can adjust the graphic position of these symbols by dragging them 
with the mouse.

• The following key is used to enter a tremolo. Start with a note, then use this key and then the second 
note. The tremolo sign is then automatically adjusted. If you want the lines of the tremolo sign to 
touch the note stems, combine the key with SHIFT 1. 

• The next two keys are used to enter the octava signs (8a and 8b). 

• The next key adds an arpeggio sign to the current chord or to the chord just next to the cursor. 

Additional functions

The following functions are also available through the typewriting keyboard.

• When pressing the clef key, the following dialog box is used to select a clef (according to the 
Pizzicato license you have, some keys may be missing): 

To select the clef, you can use the function keys, the mouse of the left/right arrow keys.

If you press this key while holding down SHIFT 1, then the Pizzicato standard clef dialog box 
appears.

• When clicking on the key signature key (with 3 flats or 3 sharps), the following dialog box is used to 
select a key signature: 

To select the key signature, you can use the function keys, the mouse or the left/right arrow keys.

If you press this key while holding down SHIFT 1, then the Pizzicato standard key signature 
dialog box appears.

• When clicking on the time signature key (3/4), the following dialog box is used to select a time 
signature: 
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To select the time signature, you can use the function keys, the mouse or the left/right arrow 
keys.

If you press this key while holding down SHIFT 1, then the Pizzicato standard time signature 
dialog box appears.

• The ENTER key can be used to add one measure next to the current measure. Combined with SHIFT 
1, two measures are added. Combined with SHIFT 2, 4 measures are added. Combined with SHIFT 1 
and SHIFT 2, 8 measures are added. Notice that for this last combination, you need to press the 
SHIFT 1 and SHIFT 2 to the left of the keyboard, otherwise the electronic part of the keyboard 
prevents that key combination. 

Twelve function keys are also provided and they correspond to practical shortcuts of Pizzicato features.

• F1 - Cancels the last operation; combined with SHIFT 1, redo the last operation that was cancelled. 

• F2 - Disables/Enables the use of the music typing keyboard inside Pizzicato. When the keyboard is 
disabled, this is the only key that may still have an effect, as it enters the music typing keyboard 
mode again. 

• F3 - Start/Stop : plays the score starting at the current measure, or stops the score if it is already 
playing. 

• F4 - Increases the zoom value on the screen. Combined with SHIFT 1, decreases the zoom value. 

• F5 - Duplicates the content of the current measure into the next measure. If the current measure is 
empty, the content of the previous measure is duplicated into the current measure. 

• F6 - Starts selecting content of the measure. Two modes are available. The first is used by pressing 
F6 and then continuing to enter notes and rests. The content is selected as the cursor moves forward. 
The next mode is to set the cursor at some position, press F6 and then move the cursor to the end of 
the selection. The selected part is displayed on a light red background. 

• F7 - Copies the selected content into the internal clipboard of Pizzicato. 

• F8 - Pastes the content of the internal Pizzicato clipboard into the current position of the cursor. The 
F6-F7-F8 keys are commonly used in that order: F6 to select, F7 to copy and F8 to paste. 

• F9 - Switches between Linear/Page/Global view mode (according to the Pizzicato license you have, 
some versions do not have all these modes). 

• F10 - Decreases the number of measures in the current system, by shifting one measure down 
through the other systems up to the end of the score. Combined with SHIFT 1, increases the number 
of measures in the current system. 

• F11 - Decreases the number of systems in the current page, by shifting one system down through the 
other pages up to the end of the score. Combined with SHIFT 1, increases the number of systems in 
the current page. 

• F12 - Adds a new instrument (a new staff) below the current staff. This is applied to the whole score. 
With SHIFT 1, deletes the current staff in all systems for the whole document. 
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Tuplets
• Triplets 
• Other tuplets 

Triplets

Despite the various rhythmic values explained and the possibility to lengthen them with a dot or a tie, some 
rhythmic values are still impossible to write. For instance, how could you write notes during one third of a 
quarter note? Impossible, because all rhythmic values are based on multiples of two.

The irregular groups, also called tuplets, are groups of notes not being a multiple of a standard rhythmic 
value. Let us start with the simplest, the triplet.

The triplet is a group of 3 identical rhythmic values that must be played within the duration of 2 rhythmic 
values. Let us take an example with eighth notes. An eighth note has a duration of half a beat. Three eighth 
notes have a duration of one and a half beat. An eighth note triplet is a group of 3 eighth notes accelerated to 
fit within the duration of 2 standard eighth notes, that is to say, one beat. Here is how it is represented:

The three eighth notes are grouped by a curve (or a hook) with figure "3". It means 3 instead of 2. The three 
notes are played more quickly than their normal duration. The total duration of the three notes is equivalent 
to one quarter note. You can put four such groups in a 4/4 measure.

Here is an example with a quarter note triplet:

The three quarter notes must be played within the normal duration of 2 quarter notes. The group thus uses 2 
beats of the measure. Open the Ex020 file and listen to it. It contains examples of quarter note triplets and 
eighth notes triplets:

Triplets let you divide durations into three equal parts such as the eighth note triplet which divides the 
quarter note into three parts. Notice that you can place different rhythmic values in a triplet, as in the 
following examples:

In the first two cases, the quarter note replaces two eighth notes. So there is still 3 eighth notes instead of 2. 
In the third case, the half note represents two quarter notes and it is a quarter note triplet (3 quarter notes 
instead of 2).

125



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________
The sixteenth note triplet is constructed on the same principle. It is a group of 6 notes replacing a normal 
duration of 4 notes (it can also exist with only 3 sixteenth notes instead of 2). It is often used with sixteenth 
notes. Here an example:

Other tuplets

The basic idea of the triplet is to place 3 notes covering the normal duration of 2 notes. The duration of each 
note is thus reduced to 2/3 of its normal value.

This principle can be extended by using other numbers than 3 and 2. Let us take an example with 5 notes 
played within the duration of 4 notes. It is written as follows:

The five sixteenth notes are reduced to the duration of 4, i.e. the equivalent of a quarter note. The quarter 
note is thus divided into 5 equal parts. This would not have been possible with standard rhythmic values. 
The durations are multiplied by 4/5.

You can create groups with 7:4 (7 notes instead of 4), 15:12 (15 notes instead of 12),… Calculation becomes 
complicated and the performer has a hard time, but it is always possible to play it! In this case, the ratio used 
is explicitly written, such as 7:4. Open and listen to the Ex021 file as an example of the sound effect it 
creates. Listen to the upper regular sounds to locate the beats:

Introduction of notes and rests (5)
• Adding triplets and tuplets 
• The enharmonic tool 

Adding triplets and tuplets

The triplet means that 3 notes are played within the normal duration of two notes. Tuplet is a term used to 
indicate any irregular group of notes such as 5 notes instead of 4, 15 instead of 16, etc. Here are some 
examples:
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Let us see how to create these measures.

• Start Pizzicato. Add the notes using the tools learned in the previous lessons, to get: 

• Open the Main Palette and select the Tuplet tool . Place the mouse cursor arrow where the first 
triplet must start: 

• Click and drag to the right by holding down the mouse button. A triplet appears and extends to the 
right by following your movement. Stretch it to cover the first three notes, then release the mouse 
button to obtain: 

Without other specifications, the tuplet tool automatically draws a triplet with a hook and the digit "3". If 
you hold down the Control key when adding the tuplet, Pizzicato opens a dialog box that lets you select the 
characteristics of the tuplet.

• Place the cursor as follows: 

• While holding down the Control key, click and drag over the 6 sixteenth notes. Release the mouse 
button. The following dialog box appears on the screen: 

127



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

• The frame entitled Note playing lets you specify the ratio used to play the notes. For a triplet, we 
have 3 notes instead of 2. To create our example, we need 6 sixteenth notes instead of 4. Fill in 
figures "6" and "4" in the two text boxes. 

• The vertical slider lets you adjust the vertical position of the label containing the digit(s) as it will 
appear on the score. 

• The Position frame let you select the orientation of the tuplet. By default, Pizzicato places it on the 
correct side, but you may invert it as needed. 

• The Graphical type of curve frame lets you select a bracket, a curve or nothing to group the notes. In 
our example, select the curve. 

• The Label frame selects the tuplet digit style. Four styles are provided each one with or without 
graphical superposition of the curve, in order to adapt to the various needs of musical notation. To 
confirm modifications, click OK. The measure becomes: 

• Once placed, the tuplet can be adjusted by moving 3 points (the tuplet tool must be selected): 

• By clicking and dragging the left end, the left reference of the tuplet moves, 
• By clicking and dragging the left end while holding down the CTRL key, the tuplet moves in one 

block, 
• By clicking and dragging the digit, the digit moves vertically. The curve does not move. Slightly 

move digit "6" upwards, in our example. 
• By clicking and dragging the right end, the curve widens or narrows according to your movement. 

You can also go up or down to vary the angle of the curve. The left end does not move. The digit 
moves proportionally. 

• By double-clicking one of these areas, you can reach the definition dialog box. 

• Place the cursor as follows: 
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• Click and drag over the width of the 5 notes, going a little upwards to follow the angle of the notes. 
When you release you get a curve with a "6". The characteristics of the last tuplet was memorized 
and applied to the next tuplet. This is the action of the Becomes the current style check box of the 
above dialog. If you do not want the edited style to become the current style, uncheck that box before 
clicking on OK. As we want a "5", double-click the digit. The dialog box comes back. Fill it to have 5 
notes instead of 4. Adjust the position of the figure to finally get: 

• To complete the example, create a tuplet on the last 9 notes. As explained, use the key to directly 
reach the dialog box. Fill it to have 9 notes instead of 8. For the Label, select the third choice and 
check the Cut curve box. Click on OK and adjust the position of the tuplet including the digits 9:8. 
You have now the example of the beginning of the lesson: 

The tuplet tool has a shortcut key. It is lowercase letter "n". It does not act directly on the score but lets you 
select the tuplet tool without opening the palette.

Here is how to erase a tuplet:

• Be sure that the tuplet tool is selected and place the mouse cursor on one of the three access points 
(left end, right end or digit) 

• Use the erase key of the keyboard: the tuplet disappears. 

When you place a tuplet between two staves, Pizzicato associates it with the staff being the nearest to the 
location you clicked. Take this into account, because the tuplet will behave correctly only if it is attached to 
the correct staff.

If the automatic justification is active, Pizzicato calculates the contents of the measure and arranges the notes 
consequently. It is thus impossible to introduce a rhythmic voice having more beats than the total number of 
beats of the measure (here 4 beats). To introduce a tuplet, it happens that you must, for example, place 3 
eighth notes in a measure where only 2 will fit. Let us examine the following measure:

To encode this measure, you may not add the last 3 eigth notes and then the triplet, because Pizzicato will 
refuse the last eigth note, the measure being already full at that moment. To overcome this, place the first 
eigth note and then add the tuplet to get:

Pizzicato takes into account the fact that the triplet is not finished and reserves the place for the next notes. 
You may then add the last two eigth notes to complete the triplet:

129



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

It is also possible to globally modify the style of Tuplets for a section of the score. You must first select the 
concerned measures and staves (for that, see the lesson entitled Selecting measures). Then use the Edit,  
Modify Tuplets… menu. The above dialog appears, but with an additional frame on its right:

The five check boxes determine the aspects of the Tuplet style that will be applied to the selected measures. 
By checking for example Label and by setting the label to 3/2 in the left part of the dialog, all Tuplets 
located in the selected measures will adopt this style.

Since version 3.5.3, a new way to enter tuplets is available. This mode creates the tuplet automatically as 
you enter the notes. To enable this mode, double-click on the Tuplet tool  and check the Automatic while  
adding the notes choice in the Entering mode frame and validate. To add a tuplet, select a rhythm value (like 
the 8th note) and select the tuplet tool  as well. Each note that you add on the staff will be affected by the 
tuplet and Pizzicato will group them nicely together. You can define the type of Tuplet (triplet,...) as well as 
its style, by double-clicking the tuplet tool.

When the automatic mode is active and the arrow is selected (so there is no rhythmic value active), the tuplet 
tool can be used manually, by dragging the tuplet over existing notes. The 'n' shortcut activates the tuplet 
tool. In the automatic mode, the use of the 'N' shortcut ('n' + SHIFT) activates the tuplet tool and the arrow 
tool, so that you can place tuplets manually.

The enharmonic tool

Two notes are enharmonic to each other if they have a different name but correspond to the same sound and 
the same key on a musical keyboard. F sharp is an enharmonic of G flat.

The enharmonic tool is located in the Notes and rests palette : 

Create a new document and fill in the following measure:

Select the enharmonic tool  and click on the head of the first note (A #). The measure becomes:

Pizzicato replaced the note by its enharmonic note. Click again on this note, you get another enharmonic of 
A #, C double flat:

By clicking a third time, you get again A #.
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The shortcut key is figure "9". It acts directly on the score, without selecting the tool in the palette. Position 
the mouse cursor on the second note and type "9" on the keyboard. Do the same for the 2 other notes. You 
get:

This tool is useful to correct the notes introduced using a musical keyboard.

Using the arrow tool
• Using the arrow tool 
• Deleting with the arrow tool 
• Optimal use of tools 

Using the arrow tool

The arrow tool lets you save time in handling the contents of a measure. We will learn how to use it.

This tool is on the Main Palette: 

It is selected as soon as you start Pizzicato. With it you can modify or delete most of the elements studied 
before. It is a sort of global tool trying to guess the tool you need at the time you use it. For example, if you 
click on a note, the tool behaves as if you used the tool of a note.

Here is the order of the various tools simulated by it:

1. Notes, 
2. Rests, 
3. Tuplets , 
4. Moving accidentals , 
5. Height of the stems , 
6. Measures  (except for Pizzicato Light, which does not have this tool). 

In the next lessons, other functions will be added to the list, e.g. text blocks, chords, symbols…

The order given here means that when you click with the arrow tool inside a measure, Pizzicato first detects 
if you click on a note. If it is the case, the note tool is simulated. If it is not the case, it detects if you click on 
a rest. If so, the rest tool is simulated, if not it looks for a tuplet… At the end, if it does not find anything 
else, the measure tool is simulated. Let us see that with an example.

Start Pizzicato and fill in the following measure with the tools you know:

• Select the arrow tool either by clicking on it or with its shortcut key which is the Esc or Escape key, 
according to the keyboard model. This key is very often located on the left upper corner of the 
keyboard. Remember this shortcut key because it will be very often useful to you. 

• With the mouse, move the first note upwards (from A to D). Pizzicato detects that you clicked on a 
note and thus simulated the note tool. 

• Without changing the tool, move the quarter rest upwards. 
• Move the hook of the tuplet a little downwards. 
• Again with the arrow tool, move the sharp (#) slightly to the left. 
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• By clicking on the top of the F note stem (4th note), slightly move the beam upwards. 
• By clicking slightly to the left of the right measure bar, widen the measure (not possible with 

Pizzicato Light). Your measure should now look like this: 

Except for Pizzicato Light, if you click in the middle of the measure, by taking care to avoid notes, rests,… 
you can move the measure. By double-clicking in the middle of the measure, with the same precaution, you 
reach the dialog box to erase/add measures and staves.

Deleting with the arrow tool

It is the same principle to delete. Select the arrow tool, place the arrow of the mouse on the item to delete 
and use the delete key ("remove last character" key). This is only valid for the simulated tools having this 
delete option. For example it is not the case for the stem height adjustment tool nor for the accidentals 
moving tool.

• Place the arrow on the first note. Use the delete key. The note disappears. 
• Do the same with the quarter rest and the triplet. The measure becomes: 

Optimal use of tools

Here are some advices for the use of the various tools.

1. When you start Pizzicato, the arrow tool is selected. With it you can create and arrange the measures 
and staves of your score, because it simulates the measure tool (except for Pizzicato Light). 

2. When you introduce notes and rests, use the shortcuts from 0 to 8 to select the rhythmic values of the 
notes. Click while holding down the SHIFT key to get the equivalent rests on the staff. 

3. When you add accidentals, use the + and - keys. 
4. To reverse the stems, use the small letter i. 
5. To modify the beams of notes, use /. 
6. To add tuplets, select the tool with lower case letter n and add the tuplet on the measure. 
7. To add a chord note, use small letter a. 
8. To add a dot to a note or rest, use the dot or the comma key. 
9. To add, reverse or delete a tie, use =. 
10.When you simply want to modify the layout, use the Esc key to select the arrow tool. You can then 

use it as explained above. 

These shortcuts let you write your score without any tool palettes. If you do not know any more which tool is 
selected, type Esc and the arrow tool is automatically selected.

Graphic note entry tool on the staff
• Graphic note entry tool 
• Intuitive chords entry 
• Viewing note colors according to chords 
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Graphic note entry tool

You will find a tool with icon  in the Composition palette from the Tools menu. This is a special tool 
to enter music graphically on the staff. The idea is to combine several movements of the mouse to specify 
the note characteristics. It is designed to enter simple music, mainly with one voice per staff, but may be 
combined with all other Pizzicato tools. It only requires to use the mouse. If you copy an existing score, you 
can for instance keep one finger on the original score to follow where you are copying from, and use the 
other hand with the mouse to enter the music. Its main positive point is how rhythmic values are selected. 
We will explore this tool with several examples.

• Open a new document and also the Composition palette. Select the  tool. The score shows that 
we are in a special note entry mode by coloring the staff and by adding lines up and down each staff: 

• This note entry mode is much more precise if you increase the zoom value for instance to 150 % 
(except for Pizzicato Light, limited to a 100 % screen zoom). The first two measures then appears 
this way : 

You will notice that each vertical green line corresponds to a beat of the measure. The additional 
horizontal lines are displayed as a reference to add notes above or below the staff.

• Click at the level of C4 and hold down the mouse. You will see the following: 

The red line in fact shows how long the note will be. Release the mouse button now and the 
quarter note will be validated.

• Click another note to the right of the first note and hold down the mouse button. Until you release the 
mouse button, you can in fact move the mouse to the right or to the left (but at this point be careful to 
stay on the same horizontal level). This mouse movement will in fact lengthen or shorten the note 
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duration. This will be displayed by the red line length, but also by the note itself. Try to move slowly 
to the right, until the note has become a dotted half note (which is the maximal note duration that is 
still possible to enter in this measure): 

Watch the various transformations of that note. Now do the same to the left, until the note has 
become a 32nd note. Now elease the mouse button to have an 8th note.

With this tool, you can decide the duration of the note. You do not need to select each time a 
rhythmic value on a palette or with a keyboard shortcut.

• Now click several new notes to the right, without holding down the mouse key longer. They will all 
be 8th notes: 

When you click a new note, its rhythmic value is by default the same as the last rhythm you have 
entered. So when the music contains several notes with the same rhythm, you just have to adjust 
the first and the others will automatically be the same rhythm.

• Before releasing the mouse button, independently of the horizontal movement, you can also move the 
mouse slightly up or down. This will add an accidental to the note, according to the vertical 
movement you do. By moving it slightly up, you will add a sharp (but the exact accidental really 
depends on the key signature or the presence of another accidental already in the measure). A bit 
more up and you get a double sharp. Same principle when you move it down to get a flat or double 
flat. Try it now. 

• If you move the note too high or to low, it becomes a rest of the same rhythmic value. This is then the 
way to enter rests. 

• If you click on an existing note or rest, you can move it as previously explained with the standard 
Pizzicato arrow tool. But if you move it outside the current measure (to the right or to the left), the 
note or rest will be removed from the measure. This is an easy way to delete a note without the need 
of an additional tool. By the way, this works also without this special tool selected. You can do it 
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with the arrow tool. You can always delete a note or rest by dragging it outside the measure, left or 
right. Try this and remove a few notes. 

You will notice that the vertical lines change their position according to the measure content. 
Some notes are graphically small with a longer duration and for other notes it is the reverse. The 
vertical lines are adapted so as to always show where the beats are, related to the notes.

When you double-click and hold the mouse button down (which means: click, release fast, then click again 
fast, but do not release the mouse button after the second click), you can do three other things with it. Here 
they are.

• Double click an existing note and now move up or down. You will see that a new note will be 
created. You can set its position by moving up or down. When you release the mouse button, the new 
note will be attached to the same stem. This is the way to create a chord. 

• Double click an existing note and first move to the right. At this point, nothing happens. If you now 
move the mouse up, an upper tie is created. You can release the mouse and add another note (of the 
same pitch) and the two notes will be tied together. 

• Double click the note and move to the left. The stem direction is reversed. This is the way to change 
a stem direction without the need of another shortcut or tool selection. 

These new ways of entering music are experimental. You can always suggest us new ways to improve this 
function. The purpose is to enter music more intuitively and faster. To master this tool, you should work 
with it a few hours to enter music. Only then it should show its power. At any moment, you can still use the 
other shortcuts (accidental corrections, beaming,...) in combination with this special tool.

Intuitive chords entry

In the Composition tool palette, you will find the intuitive chord entry tool: . This tool is a new way to 
enter the notes of a series of chords. You should already have a series of chords symbol in the score and this 
tool will help you to set the exact notes on one or more staves, very easily and intuitively.

• With the File, Open... menu item, select in the Examples sub-folder of the DataEN folder, the Ex087 
document; you can also open it through the document manager, in configuration 2 (blue buttons, on 
the upper left part). Select the  tool. The score contains a series of chord symbols: 

• Click below the C chord symbol, around the level of the upper C in the first staff and keep the mouse 
button down. You will see and hear a chord like this: 

The red line below the chord has the same meaning as in the tool explained previously. If you 
move the mouse to the right or to the left, you can respectively lengthen or shorten the duration 
of the chord. When you release the mouse button, the chord duration is validated.
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• Before you release the mouse, you can also move the mouse up or down. This will transpose the 
chord position accordingly. You will see the chord notes displayed and you will hear the sound of the 
chord. Try for instance to move the mouse down at the level of the first E note (first line) as well as 
to the right, so that the duration becomes a half note. Pizzicato will display: 

The vertical mouse position specifies the upper note of the chord. Notice that if there is no chord 
symbol in the score, the chord displayed will always be C. Otherwise, as we will see in a 
moment, the notes are taken from the current chord displayed as a symbol.

• You can now release the mouse to validate the chord. Now, click to the right and select another chord 
position. Continue with this process to fill in the first 3 measures. You may vary the note duration 
and the chord positions. One possible result is: 

Of course, once you have validate a chord, you may still rearrange its notes just by moving them 
up or down, or by removing a note by dragging it outside the measure.

• This is the default method how Pizzicato will place the notes: starting from the mouse position and 
adding two other notes from the chord, downward, on the same staff. This may be customized. 
Double-click the  tool and the following dialog appears: 

You can specify here how the chords must be constructed. The following options are available:

• You can specify how much notes must be generated. If the chord contains less notes than 
you specify here, some notes will be doubled. 

• You can specify in which direction the notes are added: up or down. 

• You can specify how notes are adde: all notes on the same staff or each note on the next 
staff. In this case, each time Pizzicato adds a note, it adds it on the next staff (depending 
on the up or down direction, the next staff is either the upper staff or the lower staff). 
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• You can force the inversion of the chord (chord position). By default, it is set to 
Automatic, which means that the nearest chord note to the mouse position is used as the 
starting note. In all other case, the position of the chord is always respected. 

• You can also specify to skip one or more notes between each note of the chord. This will 
result in chords played in a wider pitch range, the interval between successive notes being 
larger. 

• In the above dialog, select Next staves and Skip 1 note, then click on OK. Try now to enter 4 half 
notes to fill in the last two measures. You will have for instance: 

As there are only two staves, Pizzicato has placed the two additional notes on the second staff.

One interesting application of this tool is for instance the harmonization of a string, brass or 
woodwind section. You can have for instance 4 staves and specify to skip one or two notes. By 
adding a note to the first instrument and moving it to hear how it sounds like, you can quickly fill 
in an orchestral set of measures for a given chord progression. Please note that this is not really 
harmonization according to the rules of harmony, as Pizzicato will only display the notes as a 
systematic application of the above explained rules, with no other consideration (parallel fifth or 
octaves, resolution of dissonnances,...). But it can help to quickly have some idea of how a 
passage may sound. You are free to move some notes here and there to improve the voice 
leading.

Viewing note colors according to chords

An addionnal tool in the Composition palette is the  icon. This tool is just a handy duplicate of the 
coloring function of notes according to the chords and scales present in the score. This option may also be 
found in the Options, menu, Graphic options item, in the Use of colors popup menu. When this tool is 
active, the note heads will be displayed in green if they are part of the current chord, in orange if they are 
part of the associated scale to the current chord, or in red if they are not part of either the scale or the chord. 
If you select it with the above score, you will get all notes in green, as by definition they are all part of the 
current chord. But if you move some notes of that chord, you will for instance have:

This coloring feature may be very useful, mostly to beginners, when harmonizing a section, as you can 
directly see the status of each note in the score. Of course you can at any time change the chord symbol and 
the colors will change accordingly.
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Using clefs
• Octaves numbering 
• Using the bass clef 
• The instrument range 
• Other clefs 
• Writing conventions 

Octaves numbering

As previously explained, a clef is used as a reference mark to write notes on the staff. Until now, we always 
used the treble clef to locate the notes:

The number to the right of each note name shows the number of the octave. Because there is only 7 different 
note names, octaves are numbered to differentiate amongst octaves. Remember that an octave is an interval 
between two notes having the same name and thus comprising 6 other notes between them.

The 8 notes here above cover the extent of an octave. This octave bears number 3. The next octave starts 
with the C located in the third line space and bears number 4. You can easily write the notes of octave 4 in 
treble clef (the last C already belongs to octave 5):

Using the bass clef

The bass clef lets you write lower notes covering octaves 1 and 2. Here is the bass clef and the notes of 
octaves 1 and 2:

With the bass clef and the treble clef, you can already write notes in a 4 octaves range. You may also use 
additional lines (called ledger lines) to write even lower or higher notes on the staff. Notice that the note 
order remains always the same, whatever clef is being used. 

Open and listen to the Ex022 file. It will give you an idea of the sound extension covered by these 4 octaves:
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By observing the staves above, we see that a note placed on a line bears a different name according to the 
clef at the beginning of the staff. A note placed on the third line is a B note in treble clef and an D note in 
bass clef. This unfortunately makes the training of note reading a little more difficult, because one needs to 
be able to read easily the notes in both systems.

The instrument range

The range of an instrument is the extent of notes it can play. The instruments use the clef which is closest to 
their range, so that the notes are found as much as possible inside the staff. The scores of a bass guitar or a 
double bass will be written with the bass clef, because the range of these instruments is mainly low. The 
higher pitch instruments (flute, trumpet…) will be written with the treble clef, which is better adapted to 
their range.

The keyboard instruments (piano, organ, synthesizer, harpsichord…) cover a rather vast extent and are 
written on two staves, with the bass and treble clefs. The two staves are connected with a brace indicating 
that they must be read by the same instrument. Here is an example:

Open the Ex041 file. It represents the same score as the previous example, but it is written using 2 staves:

Generally, notes written in the lower staff will be played by the left hand and notes written in the higher staff 
by the right hand. It is the most natural, because notes are increasingly high pitched by moving to the right of 
the keyboard.

Other clefs

When you add a note on a staff line, its name depends on the clef preceding it. We already learned two clefs. 
As there are 7 different names of notes, it is possible to read the notes on a staff in 7 different ways and there 
are thus 7 different clefs. Fortunately, the 5 other clefs are used only for specific instruments. By learning the 
musical keyboard, you will never need them. Here is a summary of the clefs, each with the position of the C 
3 note:

All these notes bear the same name and represent the same sound pitch.
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The first is the treble clef. It determines the position of the G note on the second line. It is sometimes called 
G clef second line, to avoid confusing it with the last clef which has the same symbol but which is placed on 
the first line.

The second clef is bass clef. The F note is placed on the fourth line of the staff, between the 2 dots of the 
symbol. It is also called F clef fourth line.

The next clef is the F clef third line. It is very rare. The F note is placed on the third line, between the two 
dots.

The four next clefs are the C clefs. For each one, the C note is placed on the central line of the clef symbol, 
between the two curves. These clefs are respectively called C clef first line, C clef second line, C clef third 
line and C clef fourth line, referring to the line of the staff where the C note is placed.

The last key is the G clef first line. It is very rare. The G note is located on the first line. Regarding the note 
names, it is the same as the F clef fourth line. The only difference is that the notes are placed two octaves 
higher. For the 7 other clefs, the note names are each time different for each line of the staff. Be aware that 
in music academies, the advanced students must learn to easily read notes in the 7 clefs!

As notes are always named in the same order and can be written only on a line or in a space between lines, 
you can deduce the names and pitches of all notes of all clefs starting from this example. On the basis of the 
C 3 note, here is for example the names and positions of notes written with the C clef third line:

Some percussion instruments do not need to specify the pitch of notes. It is for example the case for the 
drums.

Each part of the drum kit can be struck to produce a sound, but this sound always remains the same. In such 
a case, the use of a clef on the staff is not useful. In practice, no clef is drawn or a special symbol is drawn, 
like this:

The use of staff lines is quite free for the writing of percussion instruments. There are several different 
systems. Most of the time, you find at the beginning of the score an explanation of the convention used, such 
as for example:

Notice that different symbols may be used for the note heads, like here a cross representing the cymbal. The 

number of staff lines may also vary. For a single instrument (orchestra snare drum, bass drum, triangle…), 
you will often see a one line staff, representing the rhythmic values to play:

Writing conventions
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The clef being used must be written at each beginning of a new staff and for all instruments (except possibly 
the percussion). In the middle of a staff, the clef may change. In this case the new clef is drawn if possible 
right before a bar line, that is to say right in front of the first note which is affected by the clef. In both cases, 
it is drawn a little smaller than its normal size. Here is an example:

When a clef change occurs at the beginning of a staff, it is usual to draw the new clef right at the end of the 
previous staff, so that the performer is not surprised when jumping to the next staff:

Using clefs
• Changing the clef 
• Clef characteristics 

Changing the clef

We will learn how to use the clef tool to change, add and delete clefs in a score.

Start with a new document and open the Main Palette. Select the clef tool  and click on the first measure 
of the upper staff. The following dialog box appears:

According to the Pizzicato version you are using, it offers you a selection between 2 and 10 clefs. Here is the 
detail, from left to right:

• Treble clef (G clef second line), 
• Bass clef (F clef fourth line), 
• F clef third line, 
• C clef first line, 
• C clef second line, 
• C clef third line, 
• C clef fourth line, 
• G clef first line, 
• Percussion clef, 
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• Invisible clef. 

The most current clefs are the first two. Regarding the note pitches, the two last clefs are equivalent to the 
treble clef. They are simply two alternative graphic notations to the treble clef.

The dialog box selects by default the treble clef, because it is the first measure. In other cases, it selects the 
clef located in the preceding measure. To select another clef, click on its icon. 

• Select the bass clef (second icon) and click OK. The measure becomes: 

Notice that the clef position inside the measure is automatically managed by Pizzicato.

• Add the following notes in the measure: 

• Select the arrow tool with the ESC key. The shortcut for the clef tool is the lower case letter 'c'. Place 
the mouse cursor on the measure and type 'c' on the keyboard. The clef dialog box appears. This 
shortcut lets you avoid using the palette and it does not modify the selected tool (in this case, the 
arrow tool). 

• Notice that the Transpose box is checked. The notes are then automatically transposed when you 
change the clef. The treble clef is selected. Click OK. The measure becomes: 

The notes are transposed to keep the same sound effect. If you do not want to transpose the notes when 
changing the clef, disable the Transpose check box before you click OK.

Clef characteristics

The clefs used until now are fixed clefs, because their positions are automatically managed by Pizzicato. The 
user cannot move them in the measure. It sometimes happens that a clef change occurs in the middle of a 
measure. Let us see how to realize that.

• Place the mouse cursor like this: 

• Type 'c' on the keyboard. In the clef dialog box, select the bass clef. Click the Moveable clef in  
measure check box. Click OK. The measure becomes: 

The clef was placed at the cursor position and the notes located to the right were transposed according to the 
new clef. This clef is now moveable.

• To move this clef, click and drag it to the left or to the right with the arrow tool or the clef tool. The 
clef will follow the movement and will settle when you release it. Move the bass clef to the right to 
obtain: 
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Notice that in this case, the notes are not automatically transposed. If you wish to keep the same sound 
result, you need to move the note down manually to obtain:

• To delete a moveable clef, place the mouse on the clef and use the delete key. Delete the bass clef. 
Once again, the notes are not automatically transposed to the previous clef. The automatic 
transposition occurs only when adding a new clef, provided that the Transpose option is checked. 

• It often happens that clef changes in the middle of a measure are indicated by a reduced size clef. 
Move the last note to obtain again:

• Place the cursor in the measure, between D and E and type 'c'. In the clef dialog box, select the bass 
clef, check the Mobile clef in measure and Reduced clef options. Click OK. Your measure becomes: 

The clef is reduced. In the same way, you can announce a clef change happening at the end of a staff. For 
example, if this measure is the last of a staff and if the next measure continues with the treble clef, it is usual 
to announce it by a small treble clef at the end of the measure, so that the performer is not surprised by the 
clef change when looking at the beginning of the next measure. Place a reduced and moveable treble clef to 
obtain:

Finally, you may also select the octave of the clef, the default choice being the normal clef. For each clef, 
you may increase or decrease the pitch of the notes by one or two octaves compared to the normal clef. This 
affects the playing of the notes which are transposed accordingly. Graphically, an 8 or 15 label is displayed 
above or below the clef on the staff.

Exercises

Starting each time with a new document, work out the two following examples. The second example may 
only be written with some versions of Pizzicato; use the percussion and the invisible clefs.
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Characteristics of music notation (3)
• Braces and groups of staves 
• Measure numbering and rehearsal marks 
• Special staves 

Braces and groups of staves

We have seen that staves playing together are connected by a vertical line on the left border:

This set of staves played simultaneously is called a system.

It is also common to connect the bar lines belonging to the same instrument group, such as for example the 
woodwinds, the brasses or the strings of an orchestra. Here are for example some instruments of an 
orchestra. The bar lines are connected by instrument families:
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The groups of staves are delimited by a bracket including all the instruments of the same family. In this way, 
instruments are easier to locate, especially when the orchestra score has twenty-five or thirty instruments as 
it is sometimes the case.

Measure numbering and rehearsal marks

To easily locate an area of the score, measures of a piece of music are usually numbered. Most of the time 
the number is placed above the measure, close to the left bar line. Here is an example:

 
A system of rehearsal marks is sometimes used to locate the main areas of a score, such as for example the 
chorus, the verse, the beginning of a movement… Letters are often used as rehearsal marks. Here is an 
example:

This helps to easily locate an area of the score in a rehearsal. The conductor can say "Let's resume again at 
point B…" and all performers can locate where to start in the score.

Special staves

We already learned that percussion can be written on staves having more or less than 5 lines. It is also 

145



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________
frequent to see staves where lines are more distant, such as for example:

where each line corresponds to a different percussion instrument.

For guitar notation, you will also meet tablatures. It is a staff having 6 spaced lines. Each line represents one 
of the guitar strings. The notes are written in the form of numbers indicating the guitar fret, while also 
representing the rhythmic value:

These special staves are only used for certain specific instruments. It is interesting to know that they exist, 
because the evolution of music notation must progress together with the evolution of composers and 
instruments. In contemporary music, it is rather current to create new representation systems adapted to the 
needs of that music. This kind of music exploits new possibilities of sound expression which do not always 
find their equivalent in conventional music notation. Music notation as exposed in this course is thus not a 
never changing system. It evolves slowly, progressively with the needs of music notation.

Characteristics of staves
• Changing the staff names 
• Characteristics of staves 
• Braces and brackets 
• Measure numbers 
• Miscellaneous 
• Lines, size and drums map 

Changing the staff names

We will learn how to change the staff names and how to reach the staff characteristics dialog box.

When you create a new document and add staves to it, they are automatically named with the sequence 
number of the staff. The instrument view lets you modify this name.

• Start Pizzicato and open the Ex048 example located in the Examples directory. In the Windows menu, 
select the Instruments item. Each line of this view corresponds to a staff: 

The first column indicates the sequence number of the staff. The two following columns are text boxes. By 
clicking inside it, the text cursor will be activated. You can then modify the contents of these text boxes. The 
main name (Name column) is the name displayed in the score view in front of the staves, in linear mode. In 
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page view, only the first system of the first page displays the main name. The other systems will display the 
abbreviated name (Abbrev. column). The names of the sequencer view tracks are also the abbreviated names.

• For now, do not worry about the other columns. We will learn them in detail in another lesson. Fill in 
the names and the abbreviated names to get: 

Notice that you can use the tabulator key to go from a text box to the next. By using the return key, the 
blinking text cursor disappears and complete the encoding of the instrument name.

• Close the instruments view. The measures become: 

• By clicking and dragging a name in the score, you can adjust its position. The measures tool or the 
arrow tool must be active to do that. Move the Piano name vertically and slightly to the left to bring 
it between the two staves: 

Note that the other names follow the horizontal movement. By default the names are automatically justified 
to the right for all staves. The vertical position can be adjusted individually.
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Characteristics of staves

With the measure tool or the arrow tool, a dialog box can be called to consult or modify various 
characteristics of the staves.

Place the arrow of the mouse cursor to the left of the first measure of the first staff, in the area in 
continuation with the lines of the staff:

Double click. The staff characteristics dialog box appears:

This dialog box offers various options for each staff. In its upper part, an horizontal scroll bar selects the 
staff to modify. To its right, you can see the name of the staff of which the parameters are currently visible. 
As you called this dialog box from the first staff, this staff is selected by default.

The first check box is labeled Group this staff with the next. As you may have noticed, when you add staves, 
Pizzicato connects them all by an extension of the bar lines:
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The line connecting the first measure of a system is always visible. It shows that all connected staves belong 
to the same system and must be played all together.

On the other hand the lines which follow are not always drawn. They usually connect the groups of 
instruments in an orchestra score, such as for example all the brasses, the strings… In the case of a piano 
score written on two staves, the two staves are also connected. We will remove the bar lines connecting 
respectively staves 2 and 3, then 3 and 4.

Click one time in the right arrow of the scroll bar to display the second staff (which does not have a name). 
Uncheck the Group this staff to the next option. Click once more to display the drums staff and uncheck it 
also. Click OK and you get the following:

The first bar line remains but the next ones disappeared for the required staves. Thanks to this option, you 
can organize the instrument groups as you want.

Braces and brackets

It is common to connect with a brace (or a bracket) the staves played by the same instrument (here the 2 
piano staves) or all instruments of an orchestra group. We will connect the 2 piano staves and then the drums 
and the bass (rhythm section). 

Call the staff characteristics dialog box on the first staff. In the popup menu located under the text Start of a  
first bracket, select the "Piano braces" item. This indicates that this staff (the first) will be the beginning of a 
bracket. In the Number of included staves text box, fill in "2". The bracket will thus connect two staves 
starting from the first. The second text box shifts the bracket to the left and it is not necessary for the piano 
brace.

Now move the horizontal scroll bar to display the drum staff. Select the "Orchestral bracket", "2" staves 
included and an "Horizontal shift" of "3". Click OK. The score becomes :
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In the above dialog, the section entitled Start of a second bracket, is used in a full orchestra score, so as to 
associate staves inside the same instruments section, for instance the French horns within the brass section.

Measure numbers

It is possible to display measure numbers on one or more staves. Call once again the same dialog box. In the 
Measure numbers frame, for the first staff select the For each measure option. Go to the drum staff and 
select the Each system item in the same menu.

The option For each measure displays the measure numbers above each and every measure of the concerned 
staff. The option Each system displays it only at the beginning of a system. Another option lets you number 
only the measures multiple of a given number, 5 by default, which means to display the numbers on 
measures 5, 10, 15,...

A check box displays a rectangular frame around the measure numbers.

Click OK. The score becomes:

You can move the position of the measure numbers by clicking and dragging them vertically and 
horizontally. All numbers of the same staff move together. If you hold down the SHIFT key while dragging, 
all the score measure numbers move together. Move the drum staff number to the right so that it is no more 
on the bar line. Move slightly the piano staff numbers upwards. If you hold down the CTRL key while 
moving, only the clicked measure number will move.

If you check the Cancel individual displacements for one or more staves, the corresponding measure 
numbers will be moved back to their default positions.

Two other options of this dialog box are located in its lower part. They are global for all staves.

The first is labeled Instrument name position. A popup menu gives you 4 possible choices. The Manual  
choice lets you move each name horizontally as you want. The Right and Left choices justify the instrument 
names on one side and when you move one of them, the others follow the movement. The Center choice 
aligns the middle of the names and they also move together.

The second option is labeled First measure number and defines the offset number of the first measure so that 
you can start a score with measure 50 for example. It is useful when you encode several parts of a symphony 
in separate documents and you wish to keep the sequence of measure numbers. You can also place a 
negative number, for example -1. In this case, measures -1 and 0 will have no number and measure 1 will be 
in fact the third measure of the score.

Exercise
As an exercise, realize the following score starting with the Ex049 document and adding the necessary 
measures and staves with the adequate tool.
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Miscellaneous

The following options are valid on a per staff basis and are located in the Various properties frame. They 
were designed for use with the guitar tablature, but some of them may be useful in other cases.

• The Stem directions menu may be Automatic in which case the stems are oriented as determined by 
the justification of measures. You can also set it to Force up or Force down. The stem direction of 
notes will be forced accordingly. 

• You can hide the stems of the notes with the Hide stems check box. 
• You can hide the beams (grouping of two or more notes) with the Hide beams check box. 
• You can hide the time signatures of all measures of that staff by using the Hide time signature check 

box. 
• You can ask Pizzicato to display the guitar chords diagrams below the chords symbols. 

The Tablature frame is designed for the guitar only. See the lesson about the guitar tools

Lines, size and drums map

Some Pizzicato versions have one or two additional options in the staff characteristics dialog box:

The text box located to the right of the text label Staff size defines a ratio to increase or reduce the staff size. 
Call the staff characteristics dialog box and for the second staff select for example 50 %.

It is sometimes useful to modify the number and layout of staff lines, particularly for percussion instruments. 
Pizzicato offers a very powerful way to create a unconventional staff. For the drum staff, click the Number 
of staff lines popup menu. It lets you select the number of staff lines between 0 and 16 lines. They will be 
consecutive. In our case, we would like to realize a staff of 3 non consecutive lines. With that purpose, select 
the last item of this menu, labeled "***". The Staff lines definition dialog appears.

On the right, the check boxes represent the 16 possible lines of a staff. Only the checked lines will be 
displayed on the score, which lets you create very original and very practical staves for percussions. 
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Uncheck lines 8 and 10. Click OK and you go back to the previous dialog. Click OK once again and the 
staves become:

The Drums map... button calls a specific dialog box to assign percussion and drum instruments to the staff 
lines.

• Click on that button. By default, there is no instrument defined. Click on the "+" button to the right of 
the staff displayed. An instrument is added and you get: 
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• The upper staff displays the graphic aspect of the note and its position. 

• The frame entitled Instrument played is used to select the sound that will be played by this 
instrument. You can select it through a popup menu with the list of General Midi drums, or by 
clicking on the keyboard (you hear the corresponding instrument) or also with a slider selecting the 
MIDI note pitch. This value does not affect the note position on the staff. 

• The frame entitled Note on the staff is used to modify the graphic position of the note on the staff. 
You can select it through the keyboard or with the MIDI pitch slider. 

• The frame entitled Display lets you assign a custom color and shape to that note. These will be used 
automatically when you enter the notes on that staff. 

• The Use this drums map check box validates the use of the mapping on this staff. 

• The Staff lines... button simply calls the dialog box to select the lines of the staff that are displayed, as 
already explained above. 

• The Apply to existing notes... check box is used if you want Pizzicato to assign the colors and shapes 
of notes to the notes already present on that staff. 

• The "+" and "-" buttons next to the staff are used to add/remove note definitions. The note of which 
the characteristics are displayed in the dialog is highlighted in blue. You can click on a note to 
display and edit its characteristics. 

This dialog offers an intuitive way to create a custom drums map.

Notice that you can define several instruments with different note heads on the same staff line. When you 
enter a note on the staff, the first one will be used and you can use the sharp tool (or the "+" shortcut) to 
select the other instruments.

Exercise
As an exercise, realize the following score starting with the Ex049 document and adding the necessary 
measures and staves with the adequate tool.
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Cross staff beaming and grace notes
• Cross staff beaming 
• Grace notes 

 

Cross staff beaming

When you write piano scores, it is common to use the two staves (bass and treble clef) to write the playing of 
a musical phrase. On a more technical level, it means that the same rhythmic voice (which is up to now 
entirely on one staff) can be split into two staves. Here are examples:

In these measures, the fact of using the two staves facilitates the reading of the notes in the two clefs. The 
lower notes would not have been easily readable in the treble clef staff. But these measures only contain one 
rhythmic voice in the way Pizzicato defines it.

The principle you must understand to write this type of measure with Pizzicato is that the notes always 
belong to one of the two staves. Here we have chosen the upper staff for the notes, but you could have 
chosen the lower staff. It is better to select the staff containing most of the notes as the main one.

Once the note is written in a staff, it is easy to drag it into the other staff, but this dragging is only graphic: 
the note continues to belong to its original staff. This implies that the justification of the rhythmic voice 
remains related to the content of the original measure. Let us see how to write these two measures.

• With the tools previously explained, encode the following measure : 

Remember that to beam the fifth 16th note to the four others, you can use the CTRL key when 
placing it.

• While holding down the SHIFT key (used to get the uppercase letters and upper symbols of the 
keyboard), click the last note and drag it to the correct height into the lower staff. Then release the 
mouse. When you cross the limit between the staves, Pizzicato draws the ledger lines attached to the 
lower staff. The result is: 
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• To add the three other 16th notes, we will drag them into the lower staff while we add them. To do 
this, add the note in the upper staff but without releasing the mouse (and especially without the 
SHIFT key, because this key places a rest instead of a note). Then drag the note downwards by 
holding down the SHIFT key to allow the transfer to the other staff. Release the mouse button only 
when the note is at the correct position. Slightly adjust the angle of the beams connecting the 8 notes 
and you get: 

• To create the following chord on the two staves, first place the notes on the upper staff. The positions 
of the notes to be dragged are not important at this step: place as many notes as necessary, you will 
drag them to the bottom of the staff. Add for instance the following chord: 

• Drag the two lowest notes while holding down the SHIFT key. The first measure is finished. 

• To write the second measure, add the following measure with the tools already explained: 

• Drag the four low notes (C) into the lower staff, by using the SHIFT key. You get: 

• Reverse the stem of the first chord (to do this, place the cursor arrow on the D note of the first chord 
and use the shortcut "i"). You get: 
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• By adjusting the beam position of the last note, you get the expected result. 

This principle can be applied in a similar way to move notes to the upper staff. The SHIFT key used when 
moving a note forces it to go through the limit of the two staves and to draw itself in the other staff, while 
still belonging to its origin staff.

It is a characteristic of a note to be drawn on its origin staff, on the upper staff or on the lower staff. You can 
directly modify this characteristic with a right click on the note. A contextual menu appears and let you 
select the Edit note play menu, opening the following dialog box: :

The lower frame, entitled Draw the note on, lets you view or modify this note characteristic. For an 
explanation of the other elements of this dialog box, see the lesson about the contextual menu of a note.

Notice that it is not necessary to beam the notes before dragging them to another staff. However, if you don't 
beam them, be aware of what you are doing because when you drag a quarter note or a half note from one 
staff to another, nothing shows that these notes belong to their original measure. They should not be 
confused with notes belonging to the other staff, otherwise the behavior of the rhythmic voices could seem 
illogical.

Grace notes

This is a specific tool to add and manage grace notes. Since the first version of Pizzicato, the symbols palette 
contain some basic simple grace notes and played as grace notes, but their handling is complex and they do 
not provide multiple grace notes. To improve this, Pizzicato 3 introduces an additional characteristic of a 
note: the fact of being able to consider a note as a normal note or as a grace note.

The fact that a note can be seen as a grace note implies two things. First, its rhythmic duration should not be 
taken into account in the counting of rhythmic voice beats. In other words if you add 4 quarter notes in a 4 
beats measure, it must be possible to introduce an eighth grace note on each one of these quarter notes. The 
value of these 4 eighth notes should not be taken into account, otherwise we would have a 6 beats total (4 
quarter notes+ 4 eighth notes) in the measure. Second, the grace note must be a reduced size note and be 
justified (aligned) to the main note to which it belongs and be played as a grace note. The MIDI behavior 
differs from the other notes. Pizzicato 3 manages all this. Let us see how to add and modify grace notes.

• In a new document, fill in the score to have the following (use the screen zoom to encode more 
precisely): 
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• Click the first note with the right mouse button and select the Add a grace note...Single item. The 
grace note appears in front of the main note : 

• Except for the fact that this note is a grace note, it behaves as a normal note. You can move it to 
change its pitch, add an accidental, a symbol... Add now a double grace note on the second note, 
reverse the stems and adjust the notes and the beaming to get: 

• In a similar way, add a quadruple grace note and adjust it to get for instance: 

• Listen to the sound result. By default, the playing of grace notes starts at the main note normal start 
time and its duration is subtracted from the main note which then becomes shorter. Click on the first 
grace note (G) with the right mouse button and select the Edit note play... item. The following dialog 
box appears: 

The frame entitled Grace note lets you modify the characteristics of the note:

• A check box is used to have a slashed grace note 
• A check box forces the play of the grace note before the main note. This option can be 

used everywhere except in the first beat of the first measure to play, because Pizzicato 
can not go backward in time before the beginning of the play. In this precise case, the 
play would be executed as if this option was not checked. 
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• The duration can be determined by a text box. This number determines the duration of the 
grace note, in units. A quarter note contains 480 units in Pizzicato. The default value of 
60 corresponds to a 32nd note. 

• The Apply to group check box lets you apply these modifications to all grace notes of the 
group (if there is more than one grace note) 

• Check the Slashed check box and click on OK. The measure becomes: 

To encode other types of grace notes (containing more than 4 notes), you can first encode all grace notes as 
normal notes (by possibly switching off the automatic justification so that Pizzicato accepts all the notes) 
and then call the above dialog box for these notes by checking the grace note check box and validating. 
Beam them together and adjust them as needed and place the main note right after them; switch on the 
automatic justification and click a note to force the justification of the measure.

Notice that you can create a reduced note with the note head tool, but this does not make it a grace note with 
the characteristics explained here.

The document manager
• Configurations 
• Customizing the displayed folders 
• Files and folders operations 
• Adding configurations and areas 

Configurations

The document manager has been designed to help you create, modify and handle your musical documents 
within Pizzicato.

It is displayed in the left part of the score view. For the advanced versions of Pizzicato it is also in the 
conductor view. In both cases, you may choose to display it or to hide it, with the D check box just above it, 
in the tool bar of the window.

You can resize the part of the window dedicated to the document manager. Just click and move the resize bar 
that makes the limit between the score and the document manager.

All Pizzicato versions have at least two configurations, displayed at the top of the document manager. Two 
or more blue buttons are used to switch between configurations. Configuration number one has one default 
folder, My Scores, which contains the documents you create:

To reach configuration number two, just click on the "2" button:
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It contains three folders. In the first one, you will find all examples referred to in the music and Pizzicato 
course. The Music folder contains a few examples and documents used in the more advanced versions of 
Pizzicato. The last one, Backups contains all the backup versions of your documents. You can always open 
them to find an older version of a document, if a document can no more be opened or when it has been 
corrupted.

You should also read the two lessons about Handling documents and windows (1) and Handling documents  
and windows (2) as they explain the basic use of the document manager.

Customizing the displayed folders

Configuration one keeps track of the documents you create when you work with Pizzicato. The My Scores 
folder is in fact located in the My documents / Pizzicato 3.5 folder (Windows) or Applications / Pizzicato 3.5 
folder (Mac). The tree structure of that folder may be customized directly within Pizzicato. See the next 
section.

You can also add other folders in that area of the document manager. For instance, you may prefer to store 
your personal documents on another hard disk or in several different places on your computer. Here is how 
to add these folders so that they can also be reached and displayed through the document manager.

• Select configuration one and right click inside that configuration (but not on a document or folder), 
then select the contextual menu entitled Setup this area... The following dialog appears: 

The name of the full path displayed here will probably be different on your computer, that is normal. By 
default, only one path is defined, corresponding to the above explained My Scores default folder. A path is in 
fact the full name of a folder on your computer. It is the concatenation of the names of folders and sub 
folders that lead to a specific folder.

You can add a new path to an existing folder in the list with the Add... button. A dialog lets you specify the 
folder on your computer. You can delete a path from the list by using the Delete button. Only the reference 
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of that folder is removed. The folder on your computer is not deleted. You can organize the order of the list 
of folders by using the Up and Down buttons, that simply move the folders up and down in the list.

When you select a path in the list, the lower part of the dialog displays several options that you can modify 
for the files in that folder:

• Save files automatically - If this box is checked and you exit Pizzicato or close a document from this 
folder, Pizzicato will automatically save it, without asking you. 

• Do not modify files - The files of that folder will never be saved, even if you explicitely save them. 
This is useful for instance for the example directory, so that you can never overwrite an example. 
You can protect any folder against modification. 

• Template score folder - When this option is checked and you double-click a score from the 
documents of this folder, Pizzicato will take this score as a template, and create a new score based on 
that template, in the default folder. This can be used to store many templates in a folder and use it to 
start a new document with that template. The original template is not modified. 

• Display full path name of the folder - Pizzicato will display the full path name of the folder as the 
name of that folder. It is useful if you have several folders from various hard disks, so you know 
which folders is in which disk. 

• Default directory for new documents - Only one folder should have that option active. Pizzicato will 
use that folder to place any new document that you create. If more than one folder have this option, 
Pizzicato will use the first that it finds. 

• Reopen documents automatically - When this option is enabled, if you exit Pizzicato with some 
documents open from this folder, Pizzicato will automatically reopen them when you start Pizzicato 
again. This may help you to save time when you are working on a document that contains useful 
resources, but it will also slow down the starting of Pizzicato if you have too much documents open 
in that folder, as Pizzicato will take the time to load them all into memory. 

• The 6 other check boxes specify which types of file will be displayed in that folder. Some of these 
file types may only be used by more advanced versions of Pizzicato. 

The Select... button can be used to select another path (which is to say, another folder in which you can 
access files).

When you click OK, Pizzicato will update the area and display the folders and files you selected.

Files and folders operations

When you right click on the icons of the document manager tree, you can reach a series of actions you can 
do on each one of them. Here are the most common actions, for folders, documents and scores. Please 
remember that a Pizzicato document is in fact a file of the Windows or Mac operating system. They are here 
represented by green icons in the document manager. Folders that contain documents or other folders are in 
fact folders (also called directories) of the Windows or Mac operating system. 

One word of warning. The document manager is just another way to access these files and folders, from 
inside Pizzicato. If you move, create and delete files and folders in the document manager, they will be in 
fact moved, created and deleted on your hard disk. The Windows files Explorer or the Finder on Mac will 
display the same files and folders. But you should not keep Pizzicato running while you modify the files and 
folders with Windows Explorer or the Finder, as Pizzicato may loose track of which files have been moved 
or changed. You may modify the files and folders structure outside Pizzicato, but be sure to exit Pizzicato 
before doing so. When you start Pizzicato again, it will then analyse the new structure and display it 
correctly.

On a folder, you can do the following operations:

• Create a new folder 
• Create a new Pizzicato document (it will have one score with one measure) 
• Create a new audio wave file 
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• Delete a the folder and all the documents inside it. Please note that it will really delete the folder and 
files from your hard disk. This is not only hiding them from the display tree ! 

• Ask Pizzicato to open all folders and files inside that folder. It can be used if you want to explore the 
content of a folder rapidly. 

• According to the Pizzicato version you have, other options are available, like importing various types 
of file into Pizzicato. 

On a Pizzicato document, you can do the following operations:

• Change its name 
• Delete the document 
• Add a score (only for more advanced versions of Pizzicato) 
• For more advanced versions of Pizzicato, particularly for Pizzicato Pro and Composition, many other 

options are available there. They are explained in the lessons covering music composition tools. 

On a score, inside a Pizzicato document, you can do the following operations:

• Rename it 
• Delete it (but there must always be at least one score in a document, so the last one cannot be deleted) 
• Access the various views for that score (score, sequencer, instruments,...). These views can all be 

accessed by other ways explained in the manual, but they are also presented here, as it can sometimes 
be easier to open them from the document manager. 

You can also drag and drop a folder or a document to another folder. This will move the document or folder. 
If you CTRL drag and drop, Pizzicato will make a copy of the document or folder.

For the more advanced versions, you can also drag and drop a score from or to another document. This will 
copy the score into the document.

By double clicking a score, you display its content in the score editor and you can edit it. 

By double clicking a Pizzicato document, the advanced versions of Pizzicato will open the conductor view.

Adding configurations and areas

The more advanced versions of Pizzicato have other configurations. Most of them are related to the intuitive 
composition tools and the selection and use of instruments. They will be explored in the corresponding 
lessons.

In Pizzicato Pro and Composition, you can create custom configurations to make your work easier. The last 
button is a "+" button. When you click it, a new empty configuration is added. You can then edit it as 
explained above.

You can delete a configuration by clicking on its button while holding the CTRL key. Pizzicato asks for 
confirmation. In this case, only the display is modified and the files and folders from that configuration will 
not be deleted from the disk.

You will notice that in the advanced versions, some configurations may display several areas of the 
document manager. You can indeed add new areas to customize a configuration. To do that, right click the 
background of a display area and you can select to add an area to above or below, or even right or left, which 
will create another column of the document manager. This multiple area proposition is useful when you need 
to work and use music elements that are found in various folders. You can organize the screen so that you 
can see all needed folders and then you can drag and drop from them without the hassle of moving and 
changing the current folders for each operation. You can create custom configurations like this:
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Using templates
• What is a template? 
• Pizzicato Pro, Notation and Composition 

What is a template?

A template is a prepared music document you can use to start a score faster. If you often write jazz band 
scores, it is practical to have a template with all prepared staves for each instrument but which contents are 
empty. By opening the template, you must not create the various staves, indicate the instruments names, nor 
configure the synthesizer and sound volumes… All is ready in the template document of your jazz band. 
You can thus immediately begin the interesting work: what are the instruments going to play.

According to the version you have, Pizzicato offers a more or less sophisticated template management.

Pizzicato Pro, Notation and Composition

When Pizzicato is started, it automatically opens a score template. By default, it is one page of a piano score. 
The same happens when you select the New item of the File menu. This document is named Document - xx 
(xx is a sequence number incremented each time you create a new document). When you save this document 
for the first time, Pizzicato will automatically ask you to give it a name. In this way, the original template is 
preserved. No risk to select the Save item and forget to change the document name (this would otherwise 
destroy the original template, replacing it with your score).

To change this default template, select the Global options item in the Options menu. The following dialog 
box appears:
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With the first frame, labeled At Pizzicato startup, you can determine what Pizzicato will automatically do 
when you start it. You can select between:

• Do nothing : no document is open 
• Create an empty document: Pizzicato creates a document of one measure only 
• Open the default template: Pizzicato opens the template selected in the lower frame, labeled Default  

template. To choose it, click the Select button… and select a document among those located in the 
Templates directory (itself found inside the DataEN directory) or among your own documents. You 
can for example create a template with prepared options. If you want to remove automatic 
justification, personalize colours and fonts, graphic options,... you can create a prepared empty 
document like you want and then save it in the Templates directory. 

• Call the open document dialog: Pizzicato presents the open a document dialog box. 
• Call the creation assistant: Pizzicato opens the dialog box that lets you create a personalized score 
• Reopen the last document: Pizzicato automatically opens the last document used. 

Just below, the frame entitled New document lets you specify the action executed when you select the New 
item in the File menu. The three available choices are explained here above. Click OK.

In the File menu, the Open template item offers a hierarchy of template documents. It is a direct access to all 
templates located in the Templates directory (found inside the DataEN directory) and sub-directories. The 
selected document is then open as a template that you can work with and save under a personalized name.

Automatic saving and backup
• Automatic saving 
• Automatic backups 
• Restoring a backup 

Automatic saving

When you create a score in Pizzicato, you need to save it on the hard disk once it is finished or when you 
temporarily want to stop working. This saving is done via the File, Save menu or if your score did not 
receive a name yet, File, Save as... This last menu lets you specify the location and the name used to save the 
file.

It is also useful to save it regularly to avoid the loss of your work if the computer suddenly blocks, due to 
Pizzicato itself, to Windows or Mac, to a simple power break or due to a wrong manipulation you did.
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Pizzicato provides a regular autosaving in order to preserve your work. It is indeed very upsetting to work 
for hours on a document and then realize that it is lost. Some basic precautions let you avoid such a situation. 
Select the Options, Automatic save and security backups... menu. The following dialog box appears:

By default, the automatic saving is activated and occurs after 10 minutes of work on a document. You must 
have modified your document since its last saving for this to happen. At the first modification of a 
document, Pizzicato starts a timer and as soon as it comes to 10 minutes, it does an automatic saving. It is 
also necessary for the document to have been assigned a name, otherwise the saving will not be 
automatically executed. When you start a new score, give it a name and a location without waiting. Pizzicato 
will then be able to save it automatically every 10 minutes (or another duration if you modify its value in the 
above dialog box). Notice that the automatic saving will never be done when Pizzicato plays a score. 
Pizzicato will wait up to the end of the play to save the score.

The next check box requires Pizzicato to check the integrity of a file after it has been saved. It is checked by 
default. After saving a file, Pizzicato tries to read it again to make sure that the file is coherent and that it can 
be read back later without problems. In case of a reading error, Pizzicato warns you so that you can try to 
save it under another name if there is a problem.

We highly advise you to keep this automatic saving option on because it will avoid the loss of a document in 
most cases.

Notice that this automatic saving feature is different than the one you will find in the document manager, 
because in the case of the document manager, Pizzicato simply does not ask you to save a document when 
you close a document or exit Pizzicato, but it does not save it regularly.

Warning: the Pizzicato examples, libraries and template files are not automatically saved when modified. 
This is to avoid losing an original document simply because you opened it and modified it to make some 
tests. If needed, you must explicitly save them. It is the case for all documents included in the DataEN folder 
of the Pizzicato directory. It is also the case for security backups: they are not active in this folder.

Automatic backups

In addition of a regular saving, Pizzicato also provides safety backups. The principle is to keep several 
versions of a document in order to be able to go back to a previous version if necessary. If there is a serious 
problem, you will thus find an older copy and will not lose the full score.

Pizzicato may manage up to 5 safety copies of the same document. By default, two copies are active: one 
after 15 minutes of work and the other after one hour. The safety copies are done when the document is 
saved. For each activated copy, Pizzicato maintains a timer. Once the time limit is reached, Pizzicato saves 
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your document under a slightly modified name (it adds the suffix "- bck1", "bck2",... to the original 
document name). Here is what occurs:

• You start a new document and you directly give it a name and a location on the hard disk by selecting 
the File, Save as... menu. 

• You work with the document. 
• Regularly (by default every 10 minutes), Pizzicato saves your document under the given name. While 

working, the timers associated to the safety backups are increased and when a timer reaches its limit, 
Pizzicato creates a safety backup with the corresponding suffixand resets the timer to zero. 

Two safety copies are enough for little and medium works. If you work on a very large document (an 
orchestral score which will take weeks of work), we advise you to pass to 3, 4 even 5 copies. You can 
modify the suggested durations as you want. Practically, a safety backup is replaced by a more recent one as 
soon as the timer value is reached.

The backup copies are saved by default in the Pizzicato Backups subdirectory. You may change this 
directory by clicking on the Select... button. If you disable the Place the backup copies in the following  
directory check box, the copies will be saved in the same directory than the original document.

Restoring a backup

The automatic saving function and the safety backups are useful only to avoid a loss of document. It is like a 
fire insurance: in most cases it is useless. But when a problem occurs, to have it is much better! The purpose 
of this section is to answer to the question: what do you do if Pizzicato tells you he cannot open your so 
precious score or if the document has an abnormal behavior despite all the precautions taken.

If your document is already opened and has problems, you can use the File, Revert to... menu. The safety 
backups 1 to 5 (only if they exist) are available through this menu. A dialog box requires confirmation and 
the original document is then replaced by the selected safety backup.

If your document produces an error at the opening, try to open the ones having the same name with their 
safety suffix. Then we advise you to modify the name of this backup file by calling the File, Save as... menu 
and give it the name of the original document by removing the suffix. Everything is then as before.

In the File, Revert to menu, you will also find The last version saved. You can use it to reload the current 
document by ignoring the modifications done until the last save.

The time signature
• Using time signature 
• Composite time signature 
• Conventions and examples 

Using time signature

We have learned that the measure is a way to divide the duration of a musical work into smaller parts. We 
gave many examples, speaking about a 4/4 measure, without specifying what these two numbers mean.

Those numbers are called the time signature. They determine the total duration of the rhythms that can fit 
inside a measure. The first number (the numerator of the time signature) indicates the number of beats the 
measure is divided in. The second number (the denominator of the time signature) indicates the contents of 
each beat.

The beat is a division of the measure. In our preceding examples, we often spoke about a beat as being 
equivalent to the quarter note duration. This is only valid when the denominator of the time signature is 
equal to 4 (it is by the way the more common case).
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The possible values for the denominator are 1,2,4,8,16 or 32. This value determines the content of one beat 
in the measure. Here is the equivalence table:

1 Whole note
2 Half note
4 Quarter note
8 Eighth note
16 Sixteenth note
32 32nd note

The bold values are the most common. The numerator of the time signature determines how much of these 
beats will fit in one measure. In the examples of the preceding lessons, the 4/4 thus represents a measure 
made up of 4 quarter notes. In the same way, 6/8 is a measure made up of 6 eighth notes, 2/2 is a measure 
made up of 2 half notes, etc.

The time signature used is indicated in the first measure, in the middle of the staff, just after the clef and the 
possible key signature. This indication is valid for all following measures. It is possible to change the time 
signature in the middle of a music work or even each measure if needed. In this case, the new time signature 
is displayed and stays valid until the next change:

The first beat of a measure is a strong beat. It marks the beginning of the measure. Other beats are weak 
beats. Strong beats have a tendency to be more marked than the others. They contribute to establish time 
reference points in the course of music.

Composite time signature

The numerator of a time signature can be composed of several numbers separated by the "+" sign. Here is an 
example:

This composite measure thus comprises 3+2 = 5 quarter notes. The idea of a composite time signature 
modifies the distribution of weak beats and strong beats. If a 5/4 time signature had been written, the 
contents would have been the same, the first beat would have been strong and the others weak. By writing 
3+2/4, you indicate that a 3/4 measure alternates with a 2/4 measure. In this case, the first and the fourth time 
are strong beats while the others are weak. The performer reads and plays the notes as if the measure was 
made up of 2 measures:

He will slightly and in a natural way accentuate the first and the fourth beats, which are strong ones.

Conventions and examples

The 4/4 measure is often noted as a capital C meaning Common Time. The 2/2 measure is often noted as a 
crossed C meaning Cut Time. It is simply a notation convention. Here is an example:
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Open and listen to the Ex023 example: 

Remark: some versions of Pizzicato cannot display composite measures. This example may open in the 
professional evaluation mode. To go back in the license mode, use the Options, Working mode menu item.

The upper staff marks the division of the beats in the measure. Check the contents of each measure. Each 
time it fits the contents expected by the time signature. The tempo is fixed at 60 quarter notes per minute at 
the beginning of the first measure. It stays valid, whatever the time signature.

Notice that the eighth notes in the 6/8 measure were gathered by 3. It is very common for the 3/8, 6/8, 9/8 
and 12/8 time signatures. Such measures are often considered to be based on the dotted quarter note (3 
eighth notes). They respectively divide the measure into 1,2,3 and 4 dotted quarter notes. The eighth notes 
subdivide these dotted quarter notes into 3 parts.

Changing the time signature
• Changing the rhythmic content of a measure 
• Up beat and incomplete measures 

Changing the rhythmic content of a measure

Create a new document and open the Main Palette. Select the time signature tool 

Click on the first measure. The following dialog box appears:

This dialog box lets you specify the rhythmic content of a measure. The first text box indicates the 
numerator of the measure. It is the number of beats included in that measure. Except for Pizzicato Light, 
Beginner and Composition Light, this box may have a succession of numbers with the "+" sign between 
them to create composite measures (3+2 for example).

The following text box (denominator of the measure) indicates the duration of each beat. The most current 
value is "4" which means that each beat equals to a quarter note. "8" indicates that the beat is equal to an 
eighth note. "2" is for the half note and "1" is for the whole note. "16" is used for the sixteenth note, "32" for 
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the thirty-second note and "64" for the 64th note. The most common values will be 4, 8 and 2. Any other 
value will not be correctly interpreted by Pizzicato when playing the score.

• Fill a "3" in the first text box (numerator) and "8" in the second box (denominator). Click OK. The 
score becomes: 

Pizzicato automatically assigned the same time signature to both staves. It is indeed very rare to 
simultaneously have different time signature. When it is the case (experimental music for example), you can 
change the time signature of only one staff by checking the box Only this staff in the dialog box (this option 
is only available in Pizzicato Pro, Notation and Composition Pro). In such a case, Pizzicato will fit the 
content of the various measures so that each measure will be played with the same duration. This is the same 
as changing the tempo for each track so as to have the same total duration.

On the other hand, it is rather common to change the time signature during a piece of music. Let us see for 
example how to go to 4/4 in the second measure.

• Place the mouse cursor at the beginning of the second measure (staff 1). Type the upper case letter 
"T". It is the shortcut of the time signature tool. The dialog box appears. 

There are two very widespread conventions to represent (4/4) and (2/2) time signatures. The first is written 
with a "C" and the second with a crossed "C". By default, Pizzicato uses these conventions. To disable them, 
uncheck the corresponding checkbox in the dialog box.

• Fill in "4" in the Numerator and Denominator text boxes. Click OK. The score becomes: 

The 4/4 is represented with C for the 2 staves.

In the time signature dialog box, a multiple choice (radio buttons) specifies up to which measure the change 
must be done. The default choice is Up to the next change, which means that the new time signature is valid 
up to the next time signature introduced. The first choice fixes the new time signature up to the end of the 
score, while the second specifies it for a fixed number of measures that you can determine using the text box.

Exercises
Starting each time with a new document, realize the two following scores (the second one can not be created 
with all versions):

168



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

Up beat and incomplete measures

Often, the first measure of a score contains less beats than the others. The music starts for instance on the 
last beat of the first measure and this is called an Upbeat. This measure is usually written as such, without 
filling the measure with rests. A 4/4 measure that would only contain one quarter note should be played and 
displayed as a one beat measure. There are other cases, for instance when repeat signs are crossing a measure 
boundery, where a measure should be displayed and played with a different number of beats than the natural 
content of that measure.

Pizzicato Professional gives a full control over the measure parameters, but with Pizzicato Beginner and 
Professional, an easy function can be used to handle that situation. Here is how to create an incomplete 
measure:

• Fill in the notes or rests in the measure 
• With the right mouse button (ALT+click on Mac), select the Measures and staves menu item, then 

choose Incomplete measure or upbeat. 
This measure will then be played correctly.

If you go again in the above menu for that measure, you will see that the Incomplete measure or upbeat 
menu item is now checked, which means that this measure has an incomplete duration. To reset the measure 
to its real duration, just use that menu again.

Key signatures
• The major scale of C 
• Tonality 
• The major scales 
• The minor scales 
• Arbitrary key signatures 

The major scale of C

The notes series from C to C is called the major scale of C. Each note of the scale is called a degree of the 
scale. The degrees are numbered from 1 to 7 in Roman numerals (i.e. I to VII). The last note being the same 
as the first (C), it is also called "degree I". Here is the major scale of C with its degrees:

As we have seen, each one of these notes corresponds to a white key of the keyboard. When a black key 
separates two notes, there is one tone between these two notes and if there is no black key between them, 
there is one half tone. The following table shows the degrees of the scale with the tones and half tones which 
separate them:

This succession of values (1,1,1/2,1,1,1,1/2) characterizes the major scale. In this example, the first note is C 
and it is thus the major scale of C.
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Tonality

This scale defines a context of notes called the tonality of C major. A musical excerpt written in C major 
uses only the notes of the C major scale, i.e. the 7 notes here above, avoiding the black keys located between 
them.

The principle of tonality is thus to limit the usable notes at a given moment in the musical discourse and in 
the same time intensifying the influence of other notes. The most significant degree in a scale is the first 
degree. In our case, it is the C note. The musical discourse will use this note as a point of reference.

The most significant degrees in a tonality are degrees I, IV and V. The musical sentences will be built by 
taking these degrees as a foundation. They will often be found on the strong beats of the measures. The 
musical sentences will have a tendency to move towards the first degree of the scale.

We will see that 12 different tonalities can be defined and used. Tonal music is based on using a context of 
notes on which melodies and chords are built. During a piece of music, the context may change to another 
tonality. This transition from one tonality to another is called a modulation. 

In theory, in a tonal music work, it is possible to determine which tonality is present at any place of the 
score. Practically, this tonality system is a theoretical system used to explain how composers use the notes 
which are at their disposal to compose. This system is very helpful to orient a composer through his first 
steps, but it should not be regarded as a strict rule which one cannot transgress.

All the rules you will find in music are most of the time deduced from the observation of what sounds well 
in the musical works. The new composer will find in it a lot of interesting advices that can be used by him as 
a guide to develop his taste and musical inspiration. The error would then be to regard these rules as absolute 
laws and not as simple advices. When inspiration or taste indicates you another path to follow, skip the 
composition rules !

Let us go back to tonalities. The essence of classical music is based on the use of tonality. Most modern 
variety music (rock, jazz, disco, blues, funky…) are also based on tonality. Most music consumed by our 
modern society is thus tonal music.

There are of course music styles that completely escape from tonality and develop different composition 
systems. Contemporary music creates new approaches of music, of sound and of its notation. It is interesting 
to note that most contemporary music composers are people who have a good knowledge of the tonal 
system, its possibilities and limits. It could then be considered as an evolution of music towards other sound 
horizons. The point is to communicate this music in such a manner that it will be perceived and understood 
by most people. It will be the only success test of a music: does it communicate something which can be 
understood?

Let us see now how other scales and tonalities are defined.

The major scales

To define the C major scale, we took the C note as a starting point. It is possible to start from each keyboard 
note to define a major scale, as well white keys (7 different notes) as black keys (5 different notes), which 
makes up a total of 12 possible tonalities.

Let us start for example on the G note and consider this note as the first degree of the G major scale. By 
placing the notes starting from G to the next G, we obtain:

Let us remember that a half tone is the sound distance separating two consecutive keys on the musical 
keyboard, either black or white. The tone equals two half tones. Here is a diagram:
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By taking into account the tones and half tones of the scale starting with G, we have:

We have learned that a major scale is characterized by the (1,1,1/2,1,1,1,1/2) series. The last two intervals do 
not correspond with the above scheme. The F note is thus not correct for the G major scale. If the F note is 
transformed into an F sharp note, degrees VI and VII will be separated by two half tones and we will thus 
have the G major scale because the intervals now correspond to the major scale sequence:

In G major, all F notes will thus be altered with a sharp. Instead of confusing the score by drawing this sharp 
in front of each F, a sharp is drawn right beside the clef, at the beginning of each staff:

 
It is valid for all F notes of the staff, even for F notes located at a different octave (as the penultimate note of 
the example). The sharps or flats placed next to the clef form what is called the key signature. In G major, 
the key signature contains an F sharp. It is thus important to look at the key signature next to the clef, 
because it influences the interpretation of the score.

Starting from an F note, we can build the scale of F major. To maintain the interval sequence of a major 
scale, a B flat note should be used:

The key signature of major F contains a flat B:

We can similarly build a scale on the basis of any note, including the black keys of the keyboard. We thus 
have 12 different major scales. The major C scale is the only major scale having no sharp or flat in its key 
signature. All others have sharp(s) or flat(s) in order to correct the intervals between degrees and to fit the 
sequence of major scale intervals. Here is for example the E major scale, with 4 sharps (F, C, G and D):
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The 4 sharps of the E major scale are placed next to the clef:

Starting from a black key, the principle is the same. The scale bears the name of the altered note, such as for 
example the B flat major scale. The black key located between A and B can be called A sharp or B flat. The 
B flat major scale is therefore equivalent to the A sharp major scale, because the keys of these scales will be 
the same on the musical keyboard. Only the note names will be different.

By building a scale on each note and by taking care that the intervals between the degrees respect the major 
scale sequence, the following table can be deduced (the scales are classified according to the number of 
accidentals they have):

C Major        
        
G major F #       
D major F # C #      
A major F # C # G #     
E major F # C # G # D #    
B major F # C # G # D # A #   
F# major F # C # G # D # A # E #  
C# major F # C # G # D # A # E # B #
        
F major B b       
B b major B b E b      
E b major B b E b A b     
A b major B b E b A b D b    
D b major B b E b A b D b G b   
G b 
major B b E b A b D b G b C b  

C b major B b E b A b D b G b C b F b

Some are identical. There are only 12 different major scales. This presentation lets us highlight something. 
When sharps are added to form the scales, they are added in a quite precise order that is called the order of 
sharps:

F# C# G# D# A# E# B#
The flats are added in the order of flats, which is the reverse order of sharps:

Bb Eb Ab Db Gb Cb Fb
Each one of these scales form a note context in which the musical discourse can express itself. When the 
context is changed, a modulation occurs. This manner of creating a musical work is the guiding principle of 
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tonal music. The first degree of the scale plays the main role and the other degrees tend to move toward it, as 
directed by its force of attraction.

All half tones of a musical keyboard are equal, i.e. they all produce the same impression of sound interval to 
the ear. When you listen to a melody, it is characterized by the number of half tones that exist between each 
note of the melody and not by the name of the notes which form the melody. Open Ex024.piz and listen to 
this well-known melody:

It is written in C major. The piece starts and ends with a C note (it is very frequent but not mandatory). No 
accidental disturbs the C major scale.

This melody can be written in another tonality. To do this, start the melody with another note and add a key 
signature after the clef. To start the same melody with an E note, we use the E major scale and we place 4 
sharps after the clef. By copying the notes of the melody on the basis of E, we get:

Open Ex025.piz, corresponding to this example. Listen to the computer playing it. The melody is higher than 
the first one, but it keeps its original characteristic. It is the same melody written in another tonality.

Open Ex026.piz now. It contains the same series of notes, but without the key signature. Listen to the result:

The melody is similar to the previous melody, but it is not exactly the same any more because some intervals 
have been modified, altering the characteristics of the melody.

The minor scales

The (1,1,1/2,1,1,1,1/2) succession of tones and half tones between degrees is specific to the major scale.

There is another type of scale, the minor scale. It is characterized by another succession of tone and half 
tones between degrees: (1,1/2,1,1,1/2,1,1). The simplest minor scale is the A minor scale, because it does not 
have any accidentals. Its structure is the following:

The C major scale and the A minor scale have the same notes, but the degrees are placed differently. In the 
A minor scale, A is the first degree and it occupies the main place. In C major, the C note directs the musical 
discourse. The A minor scale is said to be the relative minor of the C major scale.

The A minor scale is built by taking the sixth degree of C major and by looking at it as the first degree of a 
new scale. Each major scale has a relative minor scale built on its sixth degree. By taking for example E 
major, of which the sixth degree is a C sharp, we get the C sharp minor scale. Its structure is:

The sound colour of a passage in major is different than a passage in minor. In a general way, the minor is 
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more inclined to express a dramatic atmosphere and the major is lighter and happier.

We thus have 12 major tonalities and 12 minor tonalities. A musical work will often use one of these 
tonalities as a base. It will start and finish in this tonality. The names of classical music works often indicate 
the tonality, such as for example Symphony number 9 in D minor.

The modulation (change of tonality during the course of a music piece) offers ways to enrich the musical 
discourse. Modulations can be very frequent and sometimes very short, such as for example 1 or 2 chords 
borrowed from a different tonality.

One speaks about adjacent tonalities when two tonalities have only one accidental differentiating them from 
the other. It is for example the case of C major and F major because the only difference is a B flat. A major 
and E major are adjacent because the only difference between their key signatures is a D sharp.

Arbitrary key signatures

A scale is a series of notes which can be used to express a melody and chords. The tonal system offers 24 
different scales. In each case, it is a notes context that can be used.

It is possible to imagine scales or notes contexts which do not fit the rules of the tonal system. Here is an 
example:

The key signature of such a scale, even if not conventional, may be written after the clef:

Using key signatures
• Selecting a key signature 
• Changing the key signature during a music work 
• Arbitrary key signatures 
• Exercises 

Selecting a key signature

In this lesson, we will learn how to add a key signature on the staff and how to change it during a music 
work.

Start with a new document and open the Main Palette.

• Select the key signature tool. . Click in the first measure. The following dialog box appears: 
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All the options of this dialog box let you select the key signature and the areas of the score which will be 
affected by it. Some options are present only in Pizzicato Professional, we will explain it later. Let us see 
how you can select the key signature.

By calling this dialog on the first measure, the key signature has neither flats nor sharps. Otherwise, the 
default key signature is the one present in the preceding measure. The vertical scroll bar located next to the 
right of the measure lets you add accidentals.

• The upper arrow adds sharps. Click this area. The dialog box measure becomes: 

• Now the key signature has one sharp. Each click in this upper area adds a sharp, up to a maximum of 
7 sharps. Click 6 more times in this area to get: 

• The bottom arrow removes a sharp and when no more sharps are present, a flat is added. Click 7 
times in the bottom arrow. All sharps disappear. Click once again. A flat appears in the key signature: 

• By clicking 6 more times, the unit will have 7 flats: 

To remove flats, click the upper arrow. A flat disappears each time you click. When there is no more flat, 
you get the starting situation again and another click adds a sharp. Notice that the small block located 
between the two extreme arrows moves to indicate the position. With 7 sharps, it is located at the top, with 7 
flats it is located at the bottom and the central position indicates that there is neither sharps nor flats.

• The right side area indicates the name of the scale corresponding to the number of flats or sharps. 
You can also directly select a scale in the scale popup menu and accidentals will be adjusted 
according to the scale. Select for example the A scale : 

• Click OK. The score becomes: 
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Notice that the two staves automatically take the same key signature. 

By default, Pizzicato changes the key signature for all staves at the same time. There are 2 cases where it is 
necessary to have a different key signature for each staff: for the transposing instruments in a score with 
several instruments and for more contemporary works, where different key signatures are sometimes used 
simultaneously to create musical effects. Only Pizzicato Professional lets you manage that, by the Only this  
staff option. By checking this option in the key signature dialog box, only the current staff changes. The 
choice of the scale also lets you select the Major, Minor or neutral mode. This choice will also influence the 
way Pizzicato will do a transcription of notes directly played using the musical keyboard.

• The Transpose notes check box is used to transpose the notes according to the new key signature, 
which is useful if you transpose the full score for instance. You change the key and the tonality of the 
score is adapted accordingly. 

• The Do not adapt the notes check box is used so that Pizzicato will not change or adapt the 
accidentals of the existing notes. If you check it, the score will sound differently after the key 
signature change, as the notes pitches may be different. 

Changing the key signature during a music work

It is rather frequent to change the key signature during a music work. To do this, call the key signature 
dialog box on the measure where the change must occur.

• Select the cursor tool by typing the ESC key. Place the mouse cursor on measure 2 of the first staff. 
With the keyboard, type upper case letter 'A'. It is the shortcut for the key signature tool. The key 
signature dialog box appears. 

In the lower part of it, a multiple choice offers you 3 options:

The first, Up to the end of the score, changes the key signature starting from the current measure 
up to the end of the score. If the score has other key signatures after this measure, they will be 
replaced by the new one.

The second option, During … measure(s), lets you introduce the number of measures in which 
the new key signature must be effective.

The third option, Up to the next change, is selected by default. It lets you add the new key 
signature up to the next change. If there is no other key signature in the following measures, the 
new one will be valid up to the end of the score.

You also have a multiple choice which lets you select the mode of the scale (major, minor or neutral). This 
choice influences the transcription of the accidentals. By default, the mode is neutral.

• Add 2 flats and click OK. Your score becomes: 
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Notice that Pizzicato automatically added 3 naturals in front of the 2 flats. It is a manner of indicating that 
the 3 sharps of the preceding key signature are cancelled. However, in the next system, only the two flats are 
displayed.

• Call the key signature dialog box on the fifth measure (first measure of the second system). Select 4 
flats. The score becomes: 

As the key signature change occurs in the first measure of a system, Pizzicato already displays the new key 
signature at the end of the previous system, so that the performer is not surprised while arriving at the 
following system. It is known as a courtesy key signature. It is automatically placed by Pizzicato, on an 
extension of the staff lines, beyond the last measure of this staff.

Arbitrary key signatures

In most cases, accidentals follow the order automatically managed by Pizzicato. In other words, when a key 
signature has only one sharp, it is always an F.

It can be useful to create a key signature which does not follow this order, for example to create more 
contemporary works, exploring sets of notes which exceed the usual framework of tonality.

Place the mouse cursor on measure 3. Type 'A' on the computer keyboard. In the right part of the dialog box, 
a multiple choice lets you select the type of key signature. By default, it is Standard, which corresponds to 
the automatic order of accidentals. Click now on the other choice : Free. The left part of the dialog box 
becomes:
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A palette with the 5 accidentals appears on the left of the measure. To add an accidental, select it on the 
palette and click in the measure, where you want to place it.

• Place two sharps to get: 

After adding an accidental, you can move it by clicking and dragging it. To erase it, select the X cross and 
click on the accidental.

• Click OK. The score becomes: 

When you create an arbitrary key signature very similar to a standard one, you can first place for example 4 
sharps with the upper arrow, then select the Free type. The 4 sharps remain and you can add the accidentals 
you want.

Exercises

Starting each time with a new document, create the following scores (the second is not possible with all 
versions of Pizzicato):

Selecting measures
• What is a selection? 
• Copy and paste 
• Selecting several measures 
• Partial selection of measures 
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What is a selection?

In this lesson, we will learn how to select measures in order to move them or duplicate them. These concepts 
will help you to save a lot of time.

In this context, a selection designates one or more measures highlighted in order to execute an operation on 
them. The selection operation is used to select the measures you want to work on.

• Start Pizzicato with a new document and fill in the first measure to obtain: 

• Open the Main Palette and click on the  tool. This tool is the selection tool. Click on the first 
measure. Its contrast is reversed, i.e. the black becomes white and vice versa: 

• This measure is now selected. If you click on the second measure, the preceding selection disappears, 
and the second measure is now selected: 

Copy and paste

We will copy the contents of the first measure and place it in the second measure.

• Select the first measure again. In the Edit menu, click the Copy item. Apparently nothing occurred. 
Pizzicato however has copied the contents of the selected measure (measure 1) in a temporary 
memory. This operation is called copy. 

• Select the second measure, by clicking on it. Select the Paste item in the Edit menu. The two 
measures become: 

The contents of the temporary memory was placed in the selected measure. The transfer was thus executed 
in 2 parts :

• Contents of the selected measure = > temporary memory 
• Temporary memory = > in another selected measure 

This double operation is called copy and paste. It will be used very often, because it is quite common to find 
measures repeated several times in the same music work. Think for example of a battery rhythmic or a theme 
appearing several times.

• When a measure is selected, it is possible to erase its contents very quickly. Select measure 2 and 
click the Delete item in the Edit menu. The measures becomes: 
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You may also use the delete key: .

Use the ESC key now. The arrow tool is now active and the selection tool is disabled.

We will learn an even easier way to copy and paste this measure.

• Type the lower case letter "s" on the keyboard. The selection tool is now active again, because this 
letter is its shortcut. Click on the first measure. It is selected. You will now click this measure again 
without releasing the button and drag it to the right, in such a way that the cursor comes inside the 
next measure. A rectangle follows your movement: 

When you release the mouse, the score becomes:

This operation is a form of shortcut to avoid using the Edit menu. It is recommended when the measures to 
be copied and pasted are both visible on the screen. If you want to copy a measure from the beginning to a 
measure at the end of the score and when it is not possible to see them at the same time on the screen, you 
will need to copy/paste with the menu.

Imagine you want to have the same measure repeated throughout a piece of 100 measures. You could of 
course write the measure once and then copy/paste it 99 times. Let us see how to do a multiple paste. Select 
measure one in the first staff. By holding the Control key, click and drag this measure on measure 3 in the 
first staff and release when the mouse cursor is inside this measure:

When you release, the following dialog box appears: 

Replace the "1" by "6" and click OK. The measure is copied six times at once and the score becomes:

Selecting several measures
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It is possible to work with more than one measure and one staff at the same time. Let us see how.

• In the Edit menu, click the Select all item. You obtain: 

• To erase the contents of all measures, use the erase key now. The measures are redrawn empty. The 
Select all item lets you select all measures and staves in the score, even if they are not all visible on 
the screen. 

• Select all measures again. When you want to cancel the contrast on the selected measures, you may 
either select another tool or click between 2 staves. The selection is cancelled. Fill in the score to 
have: 

• We will duplicate the contents of these measures and will copy it starting from measure 5. Select the 
first measure of staff one, by typing the "s" shortcut and by clicking on this measure. To extend the 
selection to several measures and staves, you must hold down the SHIFT key and to click on the 
other corner of the measures block you want to select. By holding down this key, click on the third 
measure of the second staff. Your selection becomes: 

• Click on the first measure of the first staff and drag it on measure 5 (second system) and release when 
the mouse cursor is inside it: 
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• To drag a block of several measures and staves, you need to click and drag the upper left measure of 
the selected block. The score becomes: 

The whole block was copied to the new location. Notice that the possible contents of the destination 
measures is automatically erased.

• To select all measures of one staff, click in front of the staff, left to the first measure. Click in front of 
staff 2 and you get: 

• Even the measures not displayed on the screen (when there are several pages for example) are 
selected. By clicking in front of another staff while holding down the SHIFT key, you can extend the 
selection. By holding down this key, click in front of staff 1. Staves 1 and 2 are now selected. In a 
similar way, you can select one or more measures on all staves. Click above measure 2 and you get: 
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• By holding down the SHIFT key, click above measure 3. The selection becomes: 

For Pizzicato Pro and Composition, when you select a block of measures and staves, it is possible to drag it 
into the main or director views. When you release the mouse, a new score appears in the main view. It 
contains only the selected measures and staves.

Exercise
Starting from a new document, realize the following score by fully using the copy/paste function.

Partial selection of measures

Starting with Pizzicato 3.5.4, it is possible to select parts of measures and to copy and paste them.

The selection mode of entire measures (as described above) works when the selection tool is activated. In 
that case, to be able to make partial selection of measures, you need to hold down the CTRL key (Control) 
when you do the selection.

It is possible to do the contrary, so that the partial selection mode is the default mode. In that case, the 
selection of entire measures can be achieved by using the CTRL key when making the selection.

You can choose which default mode you want by double clicking the selection tool on the palette, and a 
dialog box gives you the choice of the default mode (the other mode is then achieved by holding down the 
CTRL key). Select the mode you prefer to use.

The partial selection mode is used to select one or more notes or rests, whether in sequence or not, on the 
same staff or not. For the following example, we keep the default choice, i.e. using the CTRL key for partial 
selection. If you choose the other mode, then simply skip using the CTRL key.

• Enter the following notes in a new document: 
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• Select the selection tool on the palette. While holding down the CTRL key, click inside the staff, 
between the C and D notes, then drag to the right so as to cover also the F half note and release the 
mouse. The partial selection is displayed as you move the mouse: 

• Use the Edit menu, Copy item or its shortcut. Then, while holding down the CTRL key, click at the 
beginning of the following measure. A small red line appears to show the insertion point. Now use 
four times the Edit, Paste menu item. You get the following: 

• The selection has been copied four times, while being shifted in the measures. In particular, notice 
how the half note has been split into two quarter notes, as it was crossing a bar line. 

• You can select non consecutive parts of measures. To do that, do a first selection and then do it again 
while also holding down the SHIFT key, which lets you add another part to the first selection. You 
can for instance select the three following parts: 

• If you copy and paste this selection, Pizzicato will assemble these various parts and paste them into 
the destination measure. 

• When you display the reference marks (shortcut ":"), a small number is displayed next to each 
selection rectangle, which reminds you of the order in which the selections were done. 

• By this method, you need to start a selection by clicking inside a measure (between the border lines 
of the staff). Before you release the mouse, you can also go down one or more staves to select more 
than one staff, for instance like this: 

• Another method may be used, to select one or more free rectangles. This lets you select for instance 
only a part of a rhythmic voice, while leaving the others untouched. The first click you do to start 
such a selection must be outside of a staff. Click for instance to select the following rectangle: 
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• You may also extend the boundaries of an existing rectangle by clicking and dragging one of its 
borders. For selections done inside a measure, only the left and right borders may be moved that way. 
By moving the mouse over these borders, the mouse cursor changes to show you that you can move 
these borders. 

• When a selection is present, the main functions of the Edit menu may be applied to the selected 
notes. This can help you delete, copy/paste, transpose,... notes in the score. 

• If you enable a specific rhythmic voice through the "1-8" menu in the tool bar of the score window, 
the partial selection of notes will only affect that voice. In other words, if you have a staff with two 
independent voices, you can make a partial selection, enable voice 1 and then delete that voice while 
leaving voice 2 untouched. 

• You can use this type of selection to Drag and Drop it to another destination in the score. Simply 
click inside one of the selection rectangles (without the CTRL key) and move it to another place. A 
temporary mobile window will show you the exact destination position in the measure as the measure 
number, the beat and the units (480 units = 1 quarter note). By default, the precision is the beat 
(quarter note in 4/4), but when also holding down the SHIFT key while dragging, you can have a 
precision of a fourth of the beat (16th note in 4/4) to move the selection. 

• This partial selection mode helps you to rebeam the music. Copy for instance a set of measures 
written in 4/4 to measures written in 3/4 (or any other combination) and the conversion will be done 
automatically. 

Special paste function
• Specifying the items to paste 
• Merging staves 
• Split voices 

Specifying the items to paste

By using the copy/paste function explained previously, Pizzicato systematically paste all the elements of a 
measure, except for the key signature and the time signature. It can be useful to be able to select the elements 
you want to paste. Pizzicato allows this through the special paste function.

• Open the Ex078.piz example. The first staff appears: 

In this example, the colors of notes show the rhythmic voices. This is done via Options, Graphic  
options..., Use of colors, Voice color selection. Red is the first voice, blue the second... see also 
the lesson about rhythmic voices.
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• Select the three measures and use the Edit, Copy menu. The three measures are now in the temporary 
memory of Pizzicato. Select 3 measures of the staff just below and select Edit, Special paste... 
(shortcut : CTRL + H or apple+H on Mac). The following dialog box appears: 

• Within the lower frame, you can select the objects to paste in the target measure. Disable the symbols 
check box: we will only copy the notes, without the slurs and the nuance. The frame entitled Voices  
taken into account is used to select the voices to paste. Our measures contain two voices, we will 
only copy voice 1 (red). Disable voice 2 and click on OK. You get: 

The first voice has been copied, without the symbols.

Merging staves

The special paste function can also be used to merge the content of several staves to only one staff.

• The lower part of the Ex078 example displays: 
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• We will merge staves 6, 7 and 8 into staff 9. Select these 3 staves (6,7,8). Then select the Edit, Copy 
menu. Select the target staff (9) and select the Edit, Special paste... menu. In the dialog box, select 
the Merge staves item. You get: 

The three staves have been merged. The voices of the three staves have been placed in the form 
of multiple voices in the destination staff.

The "Keep voices apart" check box is used to keep the voices as they are in the original 
measures. If this check box is not checked, and if two or more voices to merge have the same 
rhythm, Pizzicato will assemble them into chords, as one rhythmic voice (and thus one stem).

• Let us notice that the original content of the destination measures are not taken into account and are 
thus deleted before the operation. Only the copied staves are merged. If you want to merge a staff 
into another, you must include the destination staff in the copied selection. For example, select staves 
7 and 8 and copy them. Then apply the merge function to staff 8. You get: 

Split voices

Pizzicato lets you also split the voices of a staff into several other staves, including the chords that are split 
into several voices.

• In the Ex078 example, select the first staff. Select the Edit, Copy menu. Then, select the empty staves 
3, 4 and 5. Select the Edit, Special paste... menu. In the dialog box, select the Split voices item and 
validate. You get: 
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The 3 voices have been separated into three different staves. The symbols not attached to a note 
(here the mp) have been copied for each voice whereas the slur has been left on the voice on 
which it was attached.

Working in the sequencer and main 
views

• Selecting measures 
• Adding/deleting measures and staves 
• Creating and handling scores 

Selecting measures

Like the score view, the sequencer view lets you select measures. As those are visualized as small blocks, 
this view is well adapted for a global handling of measures, because it is possible to display much more 
measures on the screen and thus get an overall picture of your work.

Starting with a new document, create the following score:

Select the Sequencer item in the Windows menu. Organize your screen in order to see both windows like 
this:
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• We are going to copy/paste the 4 measures melody. To select only one measure, click on it. Select the 
first measure, you get: 

• Cancel the selection by clicking in the rectangle on the left of sign R. To select 4 measures, click and 
drag starting from the first measure to the fourth and then release. The selection becomes: 

• You can now move the first selected block and drag it to the fifth measure: 

When you release, the melody is copied:
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Notice that the copied melody is also in the score view. These two views are different display of the same 
document. Any modification executed in one becomes visible in the other.

• Select the 8 measures and drag them to the second measure of the second staff. You obtain: 

• It is possible to select a whole staff by clicking in the left column, next to the staff. Select staff 2 by 
clicking like this: 

The same principle is valid to select the measures on all staves: click on its number, above it. By clicking 
and dragging on several numbers, you can select several measures. Similarly, you can click and drag in the 
left column to select several staves.

We have seen that a selection may be extended in the score view by clicking in another measure with the 
SHIFT key. This principle also applies in the sequencer view, for both measures and staves.

Adding/deleting measures and staves

The measures and staves dialog box is also available through the sequencer view. Locate the arrow of the 
mouse cursor inside the block representing the fourth measure of the first staff (in the sequencer view) and 
double-click it. The measures and staves dialog box appears. Add 2 measures and 1 staff and click OK. The 
two views are redrawn:
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Notice that the measures and staves tool must not necessarily be selected to be used in the sequencer view.

Creating and handling scores

• Close the last document. With a new document, select the Main view item in the Windows menu. The 
main view appears: 

When you create a new document, the main view contains one icon named Score 1. It is possible to add 
other scores in the main view. These icons represent different scores that belong to the same document.

• In the Edit menu, select the New element... item and click the New score item. A second icon named 
Score 2 appears to the right of the first score icon. To rename it, double-click on its name. A dialog 
box asks you to modify it. 

• Open this score with a double-click. This score has only one measure. It is really a new musical score 
associated and contained in the document. You can create as many scores as necessary. It may be 
useful to create for example a series of exercises, or rhythms containing only a few measures. You 
can create a rhythmic library you can use in other documents. 

For each score, you can open a view of each type:

• the score view, 
• the sequencer view, 
• the piano roll view, 
• the instruments view. 

For each view, the title bar shows the document name followed by the score name. When there are several 
opened documents, by selecting an item of the Windows menu to open a view, Pizzicato takes into account 
the active window (blue title bar in Windows) to select the score to be opened. From the main view, you can 
directly reach one of these four views with a double-click:

• the score view: double-click 
• the sequencer view: double-click while holding down the Control key 
• the piano roll view: double-click while holding down the Control and SHIFT keys. 
• the view instruments: double-click while holding down the SHIFT key. 

Since Pizzicato 3.1, a contextual menu may be called with a right-click (Alt-click on Mac). You may use it 
to open the various views as well as to rename or delete a score.

With Pizzicato Professional you can open several documents at the same time. For each opened document, 
there is a main view which contains the scores of the document.

It is possible to copy/paste or to drag measures from one view to another, as well between scores of the same 
document as between scores belonging to different documents.

• Fill in the following notes in the one measure score: 

• Adjust the two scores windows to display: 
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• Type "s" to activate the selection tool. Select the measure containing the notes. Then, drag it to the 
first measure of the other score. The measure is copied. This is also valid for blocks of several 
measures or staves. 

• Close score 2 and open the sequencer view of score 2 (hold down the Control key while double-
clicking its icon). 

• With a double-click on the small block representing the measure, add 2 measures and one staff. 
• In score view 1, complete the measures as follows and then select them, to obtain: 

• Now drag the first measure of the score view to the first small block of the sequencer view. A 
rectangle follows your movement. Release the mouse when the arrow of the cursor is inside the small 
block: 

The 6 measures are copied. If you open the corresponding score view, you will see the notes.

• Close these two views. Open the Ex045.piz document and select the Main view item in the Windows  
menu. Adjust your screen to have: 
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• It is possible to drag a score from one document to another document. Click and drag the Melodies  
score of the Ex045.piz document to the other document. Release the mouse to place the score to the 
right of the other two. The whole score is copied in the other document: 

You can also duplicate a score in the same document. By holding down the SHIFT and Control keys and by 
dragging the icon, the score is duplicated when you release it. Duplicate Melodies by dragging it to the right. 
You get:

The whole content is copied. You can now modify it without affecting the original.

• Close the score and the main view of the Ex045 document without saving the modifications. Open 
the Score 1 sequencer view. We will copy the content of score 2 to measure 5 of Score 1. Click on 
the Score 2 icon and drag it into the fifth measure of staff one (in the sequencer view). Release the 
mouse button when the arrow is located inside the measure. At this time, the sequencer view is 
redrawn : 

Measures 1, 2 and 3 of the staves now contain the notes of Score 2. This operation is a fast method to 
execute the following operations:

• Open score 2 and select its contents. 
• Select the copy item in the Edit menu. 
• Close score 2 and select the destination measure in score 1. 
• Select the Paste item in the Edit menu. 

It is also possible to drag a score onto another score. The staves are added below those of the destination 
score. Click on the Score 2 icon, drag it onto the Score 1 icon and release when the arrow of the mouse 
cursor is inside the Score 1 icon. The sequencer view becomes:

The staves were added to the other score. This method lets you combine several scores in one.

Exercise
Close this document, then do the following steps:

• Create a new document. Introduce 4 quarter notes in the score view. 
• In the sequencer view, add 3 measures. 
• Copy the first measure to the 3 following measures (multiple paste). 
• In the main view, create a new score and rename it Copy. 
• Add 3 measures to it. 
• Using the sequencer views, copy the contents of the first score and drag it into the new score. 
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Measure parameters
• Time and key signatures indication 
• Measures numbering 
• Multimeasure rests 
• Free measures 
• Justification and staff lines 

Time and key signatures indication

By default, Pizzicato handles the display of the time signature at the beginning of the score and when a 
change occurs. Similarly, the key signature is shown at the beginning of each staff as well as when a change 
occurs. It can be interesting to modify this automatic behaviour in order to force a time or key signature 
indication, or to hide one.

Open the Ex075 example. Select measure 5 on both staves:

In the Edit menu, select the Measure parameters... item. The following dialog appears: 

We want for example to hide the key signature displayed in this measure and to force the display of the time 
signature.

• Click the Time signature check box. The multiple choice is by default Automatic. It means that 
Pizzicato handles the time signature indication automatically. The second choice forces the indication 
and the third hides it. Select the second choice. 

• Click the Key signature check box. By default it is Automatic. To hide it, check the Hidden box. 
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• Click OK . The score becomes: 

Measures numbering

This dialog lets you modify the way in which measures are numbered. Before that, you need to enable 
measure numbers, because it is not automatically active. To do so, see the lesson entitled Characteristics of  
Staves.

Normally, Pizzicato numbers the measures by starting from the first. It can be interesting to modify this 
arrangement. A typical example is an incomplete measurement (for example with only one beat) to start a 
score. This measure is not counted by convention. 

• Select the first measure 
• Call the measure parameters dialog box 
• Check the Measure numbers check box 
• The first choice is Automatic and means that each measure is numbered. Check the second option and 

the measure will not be counted. The third choice lets you assign an arbitrary number to the measure. 
In this case, the following measures will be numbered according to this arbitrary number. 

• Click OK . The score becomes: 

Number 1 is assigned to the second measurement and the first one is not counted. If the first measure must 
only contain one beat, it should be specified to Pizzicato in the following way:

• Select the first measure 
• Call the measure parameters dialog box 
• Check the Measure duration box 
• Just below, check the Fixed item and fill in the text box with "1" 
• Click OK. 
• Add a quarter note in the measure and four quarter notes in the next measure, to get: 
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Listen to the score: Pizzicato plays the first measure as if it had only one beat. You may also reduce the size 
of the first measure.

Concerning the display of the measure numbers, the basic rule is determined by the characteristics of staves 
dialog box (no number, each measure, each system or every X measures). But with the present dialog box, 
you may override the rules for the selected measures. The dialog contains a frame entitled Number 
indication where you can choose the number display mode for the selected measures between Automatic 
(will follow the general rule), Forced (the measure number will be displayed) or Hidden (the number will 
not be displayed).

Multimeasure rests

When an instrument does not play during several measures, it is common to write only one measure, with a 
rest sign surmounted by a number of measures to count. Here is for example how to create a multimeasure 
rest of 10 measures to be counted starting from measure 2:

• Select measure 2 
• Call the measure parameters dialog box 
• Check the Measure duration box 
• Just below, check the Multiple measure choice and fill in the associated text box with "10" 
• Click OK 
• In the Graphic symbols tool palette, select the tool  
• Click on measure 2, first staff. The score becomes: 

The "10" number specifies the number of measures to be counted and the numbering goes from 2 to 12 
automatically.

Free measures

Pizzicato lets you create free measures, i.e. measures which do not contain a fixed duration. You can thus 
add notes freely and they will be equally distributed in the measure. When Pizzicato plays a free measure, it 
goes on to the following measure when all notes has been played. The time signature indication is thus no 
more necessary (you can hide it). Let us see how to transform measure 12 into a free measure.

• Select measure 12 
• Call the measure parameters dialog box 
• Check the Measure duration box 
• Just below, check the Free on the basis of a "Quarter note" box 
• Click OK 
• Fill in 7 quarter notes in measure 12, you get: 
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By listening to the score, Pizzicato plays the first 2 measures, waits during 10 measures and then plays the 7 
quarter notes before going to the next measure. Notice that when you use the measure parameters dialog box, 
it affects all selected measures. In all cases, it affects all the staves of the selected measures, because the 
various staves of the same measure must have the same duration and number.

Justification and staff lines

The Measure justification frame is used to enable (which is the case by default) or disable (choice Never) the 
automatic justification of measures. If some measures were adapted manually, this option ca certify that 
Pizzicato will never change the measure layout again, for instance after a page layout modification.

The Staff lines frame is used to change the visible lines of the staff in the selected measures. This is for 
instance used to create contemporary music notation where some measures have no lines at all.

MIDI
• The purpose of MIDI 
• MIDI messages 
• MIDI channels 

The purpose of MIDI

MIDI means Musical Instrument Digital Interface. Its purpose is to transmit the actions executed with a 
musical keyboard in a digital form.

It is a universally adopted language to exchange musical information between synthesizers and computers.

When you hit a note on a musical keyboard, the keyboard immediately sends a message to its MIDI output. 
This message communicates for example that the C-3 note has just been pressed. When you release the note, 
another message is instantaneously sent to express that the C-3 note is released.

If a pedal is connected to your synthesizer, the fact of pressing or releasing this pedal also sends a MIDI 
message expressing this action. Similarly, when you move a lever located on your keyboard, it also 
generates MIDI messages.

In other words, each action executed by the performer on his keyboard is translated and instantaneously sent 
as a MIDI message to the devices connected to it by a cable.

These standard MIDI messages only contain numbers which characterize the type and the content of the 
message. Those numbers are instructions which command a synthesizer what to play and how to play it. It is 
not a sound which goes through a MIDI cable, but only a set of instructions used to control a musical 
synthesizer.

When the computer wants to play a score on a synthesizer, it simply sends the necessary MIDI instructions 
to it, and the synthesizer produces the sounds, not the computer. The computer simply replaces the 
performer.

Therefore, the sound quality depends only of the synthesizer which executes the MIDI commands. MIDI 
does not have a "sound quality". A MIDI message simply gives the order "Play this note!" and the 
synthesizer executes it with its capabilities.

MIDI messages

The purpose here is not to explain the detailed structure of the MIDI language messages, but simply to 
understand the principles used to exchange musical information.

The most significant messages are those specifying when a note is pressed or released with the musical 
keyboard. When you press a key on your musical keyboard, 3 numbers are sent:
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(Note ON + channel) + (Key number) + (Velocity)

• Note ON simply means that the key has just been pressed and the channel is a sort of address (we 
will explain this further). 

• Key number specifies which key is being pressed. The keys has a standard number between 0 and 
127, the lower C of the treble clef being number 60. 

• Velocity is the force with which the key was hit. You may indeed press a key gently or very sharply. 
Many keyboards record this force and send it in MIDI. The synthesizer receiving this note plays it 
more or less loudly according to the value of the velocity (between 0 and 127, 64 being a value often 
sent by default when the keyboard is not sensitive to velocity). 

A similar message is sent when you release the key:

(Note OFF + channel) + (Key number) + (Velocity)

• Note OFF means that a key has been just released. 
• Key number specifies which key was released. 
• Velocity is seldom used or placed to 0. 

When you play on a musical keyboard, each note thus generates two MIDI messages. The first is sent when 
you press a key and the second when you release it. A piece of music generates a constant flow of MIDI 
messages.

Besides note messages, there is a whole series of various MIDI messages used to modify the characteristics 
of the performance. We will examine two types of messages here, the program changes and the MIDI 
controllers.

A program change is a MIDI message requiring the synthesizer to change its sound. It contains a number 
between 0 and 127, which specifies the number of the desired sonority. Each synthesizer has a numbered list 
of sounds it can generate. When it receives a program change, the synthesizer selects the sound 
corresponding to the given number.

If a synthesizer has a flute sound bearing number 21 and if you want to play flute with your keyboard, you 
need to send a program change with number 21. The notes you will then play will be heard with a flute 
sonority. You can find the list of sounds of your synthesizer in its instruction manual. These lists may be 
specific to each synthesizer.

A very widespread standard has been adopted by manufacturers as a compatible mode. It is the GM (General 
Midi) standard. It establishes a unique correspondence between the program change numbers and the 
sounds. Thus a piano sound bears number 1, the trumpet bears number 57, etc. When Pizzicato plays a score, 
it first sends a program change before starting to play the notes, so that the synthesizer knows with what 
sonority those notes must be played.

MIDI Controllers are messages used to change the way in which sounds are generated in the synthesizer. 
There are 128 different controllers, but only a small part of it is in common use.

The volume controller (number 7) for example, determines the output volume of the instrument sound. This 
message specifies to the synthesizer the volume the sound must have. When it receives a volume controller, 
the synthesizer uses it to fix the sound level of the instrument. The value can vary between 0 (the sound is 
not audible) and 127 (maximum level). It is used to regulate the general balance between instruments.

Other controllers allow to change the balance (stereophonic effect: instrument on the left or on the right), to 
add a vibrato in the notes, etc.

One of the controllers simulates the effect of the hold pedal (right side pedal of a piano). When it is 
activated, it holds the notes until the pedal is released.

MIDI channels

Until now we have considered that only one instrument was playing. How to play a score which contains 5 
different instruments?

A MIDI connection actually contains 16 independent MIDI channels. It is like a highway with 16 tracks, 
where MIDI messages may circulate on a track without affecting the messages of the other tracks.
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A multitimbral synthesizer is able to generate several different sonorities at the same time, like the piano, the 
guitar, the battery, etc. Most current synthesizers allow this.

The 16 MIDI channels connected to the synthesizer behave as if there were 16 different synthesizers at the 
end of the cable. Pizzicato can work with the various channels by assigning each instrument to a channel and 
by sending the notes on the corresponding channels.

When one of the above MIDI messages is sent, the channel is specified.

Let us take a simple example: a piano, bass and battery score. Pizzicato assigns channel 1 to the piano, 
channel 2 to the bass and channel 10 to the battery (most synthesizers reserve channel 10 for percussions). 
Before starting to play, Pizzicato sends the following program changes:

• Number of the piano sound ===> channel 1 
• Number of the bass sound ===> channel 2 
• Number of the battery sound ===> channel 10 

From this moment, all notes sent on channel 1 will be played with a piano sound. Similarly, notes sent on 
channel 2 will play the bass and notes sent on channel 10 will activate the battery.

When Pizzicato plays the score, it assigns itself the MIDI channels to use, according to the possibilities of 
your synthesizer. After having sent the program changes, the notes of the piano staff are sent on channel 1, 
the notes of the bass on channel 2 and the notes of the battery on channel 10.

When you change the volumes and the options of the instruments view, Pizzicato sends the messages 
corresponding to the channels assigned to each staff, for example to decrease the volume of the bass, or to 
add reverberation on the battery, etc.

A detailed and complete explanation of the MIDI language would be out of the scope of this manual. 
Nevertheless, you have here an outline of MIDI, well sufficient to use Pizzicato, because in most current 
functions, Pizzicato completely handles MIDI for you.

The instruments view
• The instruments view 
• Elements of the instruments view 
• Modifying the staves order 

The instruments view

The instruments view lets you specify the name and playing characteristics associated to each staff of the 
score. Most parameters will influence the way in which Pizzicato and your synthesizer will play the score. 
You can access it with the Instruments item in the windows menu.

• Start Pizzicato and open the instruments view. The following window appears: 
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It can be moved, but its size is fixed. It can be closed by the usual closing box. Below its title bar, you find 
the title of each column. The window has one line for each staff of the score. We will examine each column 
in detail. Because the starting score has two staves here, there are two lines in the instruments view. This 
window may display 10 lines at the same time. When the score has more than 10 staves simultaneously 
played, the vertical scroll bar located to the right of the window lets you go down to access the other lines. 
The first column numbers the staves starting with 1.

• In the upper left corner you have the  icon. Click on it and a configuration menu appears: 

Each item represents a configuration of the instruments view, enabling you to visualize the various playing 
parameters. The current configuration is checked right in front of the name, like here, Instruments.

The instruments view title has 3 parts: the name of the document, the name of the musical score and the 
name of the configuration.

• Each configuration contains different aspects. Select the Volume and effects item of the above menu. 
The window resizes and is redrawn to display four series of sliders: 

The third part of its title shows the name of the configuration : Volume and effects.

The elements of a line may be represented by a text box, a slider, a popup menu or a check box.

• Select the configurations one after the other in order to see what they contain. The first column 
always shows the sequence number of the staves and the second column indicates the abbreviated 
name, so as to easily locate an instrument. 

Elements of the instruments view

We now will examine the various elements composing the configurations, by explaining for each one the 
effect it produces on the playing score.

Open again the Instruments configuration:

• The first two columns display the staff name and the abbreviated name. As we have already seen it, 
you can modify this name by placing the text cursor in this area. When you add staves, the names and 
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the abbreviations are initialized with the sequence number of the staff. These names are written in 
front of the score view and the sequencer view staves. 

• The next column, called P for Play, shows if the corresponding staff must be played by Pizzicato. A 
check box lets you switch it on or off. By default a staff is played. If you want for example to listen 
to a score and play yourself the main melody, you can disable the staff which contains this melody so 
that Pizzicato will only play the other instruments. 

• The next column, called S for Soloist, put a staff in solo play. By default, no box of this column is 
checked and all staves play according to the P column. When at least a soloist box is checked, only 
the associated staves are played by Pizzicato. You can easily listen to a soloist instrument in an 
orchestra by checking its S box. This column is complementary to the previous one, because you can 
also disable all the other instruments of the orchestra to achieve the same result. 

• The three next columns are similar to column P, but they act on the individual rhythmic voices inside 
the staff. For instance, if you have two rhythmic voices inside the same staff, you may disable the V2 
(=voice 2) check box to only listen to voice 1. By default, all voices are active. 

• The two (three for the Professional and Composition Pro versions) next columns contain menus. 
They are used to select the instrument playing the notes of the staff on a synthesizer or sound card. 
Pizzicato Professional and Composition Pro first contain a menu used to select the MIDI output port 
where the notes will be sent. This menu contains the assigned name(s) of the MIDI ports installed in 
Pizzicato. Then (for all versions) a menu lets you select the instrument family. When this choice is 
made, the second menu lets you select among all the instruments belonging to this family. Families 
and instruments depend on your synthesizer or sound card. This method lets you quickly find a sound 
among all the sounds available in your synthesizer (sometimes several hundreds). If these menus are 
disabled, this means that the staff contains a virtual audio instrument, so the MIDI parameters to 
select the sound are no more active. See the lesson entitled "The virtual instruments". 

• The next column indicates MC for MIDI Channel. The notes of a staff must be sent on one of your 
synthesizer's 16 MIDI channels to be heard. The menu lets you select a channel between 1 and 16 for 
each staff. 

• The next column indicates AC for Automatic Channel. It is linked to the previous column. This box is 
checked by default. It specify that Pizzicato will handle the MIDI channel assignments. When this 
box is checked for all staves, you should not care about MIDI channels. Select the families and the 
instruments and Pizzicato will adapt the MIDI channels so that the notes are sent to the correct 
channels of your synthesizer. This assignment is not made when you change the instruments, but is 
automatically done just before playing. In some cases, it can be useful to select yourself the assigned 
MIDI channels. You then need to uncheck the AC column and Pizzicato will no more modify the 
MIDI channel of this staff. If you wish to manage MIDI channels yourself, be certain to understand 
the guiding principle of MIDI, otherwise you may obtain strange results. In most cases, an automatic 
management is the ideal solution. 

• The next column indicates Trans. for transposition. The associated menu lets you specify a value 
between -24 and +24 half tones. By default, it is set to 0, which means no transposition. By selecting 
a value different from 0, Pizzicato automatically transpose all notes of the concerned staff by adding 
to it the indicated number of half tones. You can thus raise the notes up to 2 octaves (+24 half tones) 
or lower them up to 2 octaves (-24 half tones). This menu is used in particular for the transposing 
instruments. 

Select now the Volume and effects item in the configurations menu (icon :  ):
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• The first column contains the abbreviation of the name in order to locate the instruments more easily. 

• The next column has a slider to adjust the sound volume of this staff. The current value is displayed 
just to the right of the slider. It can vary from 0 to 127 and its default value is 100. By changing these 
values, you can balance the volumes of the various instruments, as on a mixing table. When you ask 
Pizzicato to play the score, the volume values of each staff are sent to the MIDI channels of the 
synthesizer. 

• The next column is used to adjust the balance of instruments, i.e. the position of those instrument in 
the stereophonic space. By moving the slider to the left (the right), the sound will be more and more 
present in your left (right) loudspeaker and less and less present in your right (left) one. The central 
position is value 64, which is also the default value. You can this way simulate the distribution of a 
group or orchestra instruments on a scene. 

• The next column lets you adjust the level of reverberation for the staff. It is a sound effect which 
makes the sound resound, by giving the impression you play in a large room. Its value may vary 
between 0 and 127, 40 being its default value. Used with moderation, it makes synthetic sounds more 
natural. Most synthesizers offer this effect, but not all of them. Pizzicato does not create itself the 
reverberation, it does nothing but to give orders to the synthesizer to modify the reverberation. If the 
synthesizer does not provide reverberation, this slider will remain without effect. 

• The next column lets you adjust the level of chorus. It is a special effect which modifies the sound of 
the instrument by introducing vibrations in it. You can adjust it between 0 (default value) and 127. 

Select now the Various effects item in the configurations menu (icon  ):

• The Vel. column (Velocity) has a slider allowing you to specify the value of the velocity used to play 
the notes. Its default value is 64 and it can vary between 0 and 127. It is the hit force of the note on 
the keyboard. The notes introduced using the mouse are played with this velocity. On the other hand, 
when a note is recorded in MIDI, the original velocity is memorized with the note and this slider has 
no effect for them. 

• The next column indicates Start. It lets you time shift the attack of the notes by adding a fixed delay 
to it. This interval is determined by a menu with values from -480 to +480 units, which corresponds 
to the duration of a quarter note (in advance or late). Value 0 indicates that there is no shift. By 
slightly shifting some instruments, you can create a more realistic orchestral effect. The musicians of 
an orchestra never play with the exactitude of the computer and it is one of the reasons why a score 
encoded and played with the precision of a computer seems too monotonous and artificial. By adding 
slight shifts, you can improve this aspect. Use low values for the shift, otherwise the effect will be 
exaggerated. 

• The next column is called Dur. and represents the Duration of the notes expressed as a percentage. 
The default value is 100 %. Pizzicato thus plays the total duration of each note. A quarter note will 
last exactly the duration of a quarter note. You can adjust this value between 5 and 200 %. If you take 
for example 85 %, the duration of the quarter note will be shortened by 15 %. A value of 50 % will 
transform all quarter notes of this staff into eighth notes, the 50 % surplus being replaced by a rest. It 
does not modify the speed of the play. The value you select with this menu is used only when you 
listen to the score and will not affect the measures. 
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• The column PB lets you fix the value of the Pitch Bend. On most synthesizer keyboards, you will 
find a wheel or a lever allowing to modify the pitch of the sound during the play. This effect is called 
the Pitch Bend. The value you select using this menu simulates this effect. Its default position is 0. 
The menu offers you a scale varying between -64 and +63, and the corresponding pitch variation 
goes from -2 half tones to + 2 half tones. By shifting this value slightly, you can detune an instrument 
compared to the others and to increase again the realism of an orchestral unit. By strongly shifting an 
instrument compared to another, you can compose music which uses the quarter tone system or even 
other divisions of the sound pitches. Use for example 5 staves with the same instrument and place 5 
different values in the PB column. According to the staff where you write the notes, the notes will be 
played a fraction of a tone higher or lower. 

• The next column also corresponds to a wheel or lever located on the synthesizers. It activates the 
modulation, which very often corresponds to a vibrato, i.e. a note having its pitch slightly moving 
around its normal level. It adds naturalness to the performance. Its default value is 0 and it can go up 
to 127. 

• The VB column means Visible Bars. When you open the piano roll view, the notes are displayed in 
the shape of small coloured bars. Only the notes of the staves checked in this column will be visible 
in the piano roll view. 

• The next column lets you determine the colour of the bars for each staff in the piano roll view. They 
are red by default. By clicking in this coloured area, the colour selection dialog box appears and 
invites you to select one of the available colours. 

• The five next columns are the continuation of colums V1, V2 and V3, but for rhythmic voices 4 to 8 
of a staff. It is quite rare that a measure contains more than 2 or 3 rhythmic voices, but in this case, 
columns V4 to V8 may be used to disable them. 

Select now the MIDI Parameters item in the configurations menu (icon  ). The view displays the main 
MIDI specifications as well as some columns specific to advanced Pizzicato versions:

• The 2 columns following the abbreviated name duplicate the columns MC and AC already explained 
in the Instruments configuration. 

• The next column displays the selection of the MIDI output port and is only available in Pizzicato 
Professional and Composition Pro (since the other versions only have one MIDI port). It is the same 
as in the Instruments configuration. 

• The columns Bk (Bank) and Pg (Program) determine the sound to be played by the synthesizer. In 
most cases, you will not need to modify them, because Pizzicato calculates them according to the 
choice of the family, the instrument and the synthesizer. If you wish to modify them, you need to 
select the first line of the family menu (the line "------"). In this case Pizzicato will no more modify 
the Bk and Pg columns and you will be able to determine them yourself. This is only useful for very 
specialized applications because the system of families and instruments is a much more effective and 
user friendly method. 

• The next column indicates Ms for Messages (Pizzicato Pro and Composition Pro). It has an 
unchecked box by default and is used to ask Pizzicato to send special messages to your synthesizer 
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before starting to play. The type of messages that can be sent depends only of your synthesizer. By 
clicking on this box, you call the following dialog box: 

The list shows you the messages you send to your instrument. At first, none are present. Click 
the Add button. If your synthesizer has special messages, a line will appear in the list with the 
name of the message. The menu located just below the list is used to select the message to be 
sent. Here is the contents for the Roland Sc-55 synthesizer :

Four text boxes let you specify parameters for the message selected on the list. In the example 
above, the first parameter of the General Volume message lets you fix its value between 0 and 
127. These parameters depend both of the message and the synthesizer.

In this way, you can add several messages with their parameters. To erase one of the messages, 
select it on the list and click Clear.

The Export button asks you to save your messages list so that you can use it later in another 
document. By clicking this button, you will be able to specify a name under which these 
messages will be recorded. The Import button executes the reversed operation by asking you to 
load a series of messages which you had previously saved.

By clicking in Use it, you validate your messages and Pizzicato will send them to the synthesizer 
as soon as you ask it to play the score. By clicking in Do not use it, the messages will be 
memorized but will not be sent to the synthesizer. In both cases, you return to the instruments 
view. The corresponding box is checked if the messages are used.

The use of these special messages is especially intended for the MIDI professionals. We will 
further see that you can create your own MIDI messages and then use them in this dialog box. 
They let you modify the internal configuration and the sounds of your synthesizer, but they 
require a very good knowledge of the MIDI system.

• The next box is called Pr for Percussions (Pizzicato Pro, Notation, Composition and Drums). It is 
used to configure the musical keyboard on the staff. By clicking on this box, you get the following 
dialog box: 
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When a synthesizer has percussions (battery, bongos, triangle, various effects,…), these 
instruments are usually distributed on the musical keyboard, so that they can be played with the 
corresponding notes. The default correspondence is often not practical when writing these notes 
on a staff, because the score takes a very complicated aspect because accidentals needs to be 
added unnecessarily. The resulting score is not really readable.

The above dialog box allows you to assign each notes of the staff to a musical keyboard key. Its 
use is not limited to the percussions. You can for example use it to create original keyboards 
where the higher notes are located to the left and lower notes to the right. By listening to a music 
score, it can give funny results. Try it…

On the left of the dialog box, you find the name of the notes from C to B, with all half tones. The 
octave displayed is determined by the menu located in the upper left corner of the dialog box, 
right to the word Octave. The octaves are numbered from -2 up. The octave 3 note C corresponds 
to the following note:

Beside each note, you find 3 menus. The first two associate a note and its octave. The third lets 
you directly select the name of a percussion instrument on your synthesizer, and Pizzicato 
associates the correct note automatically.

Let us take a practical example. You wish to create a percussion staff with the snare drum on the 
third line. In C clef, the third line corresponds to the octave 3, C note. The dialog box shows you 
that C 3 currently corresponds to High Bongo, that C # 3 corresponds to Low Bongo,… By 
default, the standard distribution of your synthesizer is used. The first two columns thus indicate 
the same note, C3, C#3…

We wish to place the snare drum on the B 3 note. On the last line, click on the menu displaying 
Short High Whistle. It then displays your synthesizer percussion instruments list, of which here is 
an extract for the GM (general midi) synthesizers:
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By going up to the top of the list and scrolling the menu, you will find the Snare drum 1 
instrument. By selecting this line, the bottom of the dialog box will now display:

The first two columns indicate that the snare drum 1 actually corresponds to the D1 note for your 
synthesizer. The result of this is that all notes placed on the third line of this staff will 
automatically be transformed into D 1 that your synthesizer will play with a snare drum 1 sound.

You can in this manner build your percussion staff, so that its notation is readable and can be 
correctly played by the synthesizer. The synthesizers sometimes have several percussions 
models. The menu located at the upper right corner lets you change the current percussion model 
(Percussion model menu).

The Export button offers you to save your percussion configuration so as to be able to use it later 
in another document. The Import button does the reversed operation by asking you to load a 
percussion configuration previously saved.

By clicking on Use it, Pizzicato will use this percussion configuration for the notes of this staff. 
By clicking on Do not use it, the configuration will be memorized but will not be used in, 
playing. In both cases, you return to the instruments view. The corresponding box is checked if 
the percussion configuration is used.

As you will be able to see it in examples documents, in particular in the scores templates, 
Pizzicato offers you a whole of staves already prepared for most percussion instruments. The 
percussion reference card provided with Pizzicato gives you a precise description of it. We 
advise you to use them for your work and compositions.

• Column VM (Velocity Mode) has a 4 choices menu specifying how Pizzicato must use velocity. 
When you record a piece by playing it yourself on the keyboard, the hitting force of each key is 
memorized with each note, so as to be able to reproduce the performance accurately. In addition, the 
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Velocity column of the Various effects configuration also provides a velocity, which can be modified 
during the play by graphic and MIDI symbols placed on the score. We thus have two values of 
velocity for each note: the recorded value (if any) and the value coming from the symbols. 

• By taking the RV choice, Pizzicato will use the Recorded Velocity when it plays the 
notes. 

• The SV specifies the use of the Symbols Velocity. 
• The default choice, CV (Combined Velocity) takes the recorded velocity when available 

and when not, takes the symbols velocity. 
• AV (Average Velocity) makes an average between the two velocities. This last choice lets 

you keep your original performance and influence it by symbols added on the score. 

• The next two columns (Pizzicato Pro and Composition) are used with the arranger. They will be 
explained in the lesson on the score arranger. 

• The next two columns are used to specify the range of the instrument. This feature will be used in 
future versions of Pizzicato. Presently they are used only by the score arranger. 

• The column entitled Rtp means Real Time Play and is used to specify how the virtual audio 
instruments are played. See the lesson entitled The virtual instruments for a detailed explanation. 

In the configurations menu (icon :  ), you will also find a line entitled "Useful controllers" which 
contains items that have been described already and that are sometimes useful to have in one view to adjust 
the way the score will sound.

Important note
The configurations of the instruments view determine the value of the MIDI parameters at the 
beginning of the first measure and remain valid until a MIDI symbol appears in a measure. If 
you set for example the volume at 100, it means that the start of measure 1 will be done with a 
sound volume of 100. If you add a symbol decreasing the volume by 30 units in measure 3, 
starting from this measure the volume will thus be 70, up to the next change. This is valid for all 
MIDI effects influencing the performance.

Modifying the staves order

The instruments view also lets you restructure the staves of the score by modifying their order. To move a 
staff, click in the number of the corresponding line (first column) and drag it to its new position. We will 
bring staff 2 at the position of staff 1. Click on number 2, in the left column and drag gently the mouse 
upwards. A rectangle accompanies your movement. Drag to the top until the cursor is at the height of the 
first line. Release the mouse. The order is reversed. The first column always indicates of course the sequence 
number and did not change. In the same manner, you can move a staff downwards. By releasing the mouse, 
the other staves go up automatically to fill the vacuum and the staff will be in the required location.

The scrolling score view
• The scrolling score view 
• Control of the scrolling score view 
• How could you learn playing the keyboard ? 

The scrolling score view

In this lesson, we will see how to play a piece of music while visually following the score progressively. In 
this manner, it is possible to read the score by playing one of the staves oneself.
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The scrolling score view is a window used to display a part of the score. The notes cannot be modified by 
this view. When Pizzicato starts playing the score, the contents of the scrolling score view will automatically 
follow the measure playing. Let us see this in practice.

• Start Pizzicato and open the Ex045 example in the Examples file. In the Windows menu, select the 
Scrolling score item. The following window opens: 

According to the size of your screen, you will see more or less measures and staves. In our case, the window 
is subdivided in 3 horizontal areas. Each one of it displays 4 measures. A small red triangle indicates the 
current measure, which is currently measure 1. This measure is the first which will be heard if you start the 
score.

• With the space bar, start the score. Observe the triangle going from one measure to the other. 
Observe what occurs when the first staff is finished: the triangle goes to the next line, the first 
horizontal area is erased and Pizzicato draws another one. During this time, you can continue to 
follow the staff which is playing. When Pizzicato comes at the last horizontal area, it continues to the 
top of the page, because this staff was updated. 

This method lets you read a score without being disturbed by the erasing of already played measures and the 
drawing of the next measures. There is no more problem to turn a page (while turning a paper score page, 
there is always a moment when the performer does not see the playing measure any more and does not yet 
see the next measure of the score, which requires to memorize one measure and turning the page in 
advance). With Pizzicato, it is like somebody cutting out parts of the page while you play, so that the 
following page appears gradually. You then always keep the control of the location where you are looking 
at. Let Pizzicato go to the end of the score and follow visually.

Control of the scrolling score view

Several shortcuts let you move the red triangle from one measure to another: 

• The left, right, top and bottom arrows move it in the four directions. 
• The page down and page up keys go up or down a whole page. 
• The lower case letter "d" places the triangle at the beginning of the score, at measure 1. 
• The lower case letter "f" places it at the last measure of the score. 
• You can also directly click on one measure and the triangle appears in it. When you start playing, 

Pizzicato starts to play the measure shown by the triangle. Now test these shortcuts. 
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In our example, the score only has one staff. The window was high enough to display three lines at the same 
time. To correctly work, the scrolling score view requires at least two horizontal areas. If you decrease the 
size of this window below this minimal size, Pizzicato will display nothing. 

• Close the scrolling score view and the score view and open the Bach2-1.piz document located in the 
Music folder, itself found in the DataEN folder. Open the scrolling score view. This piece has two 
staves. Here is the aspect obtained with a small screen: 

If the size of the scrolling score view is too small to display two areas of 2 staves, Pizzicato will 
automatically remove the second staff. Listen now to this score while following it visually. 

When you open a score with a great number of staves (orchestra for example), Pizzicato will probably not 
display 2 areas with all staves. Let us see how to determine the staves to display. 

• With the right mouse button (Option-click on Mac), click inside the scrolling score view and select 
the Select visible staves... item. The following dialog appears: 
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The first list shows the invisible staves and the second the visible staves. By clicking on a stave, the <<< 
and >>> buttons let you move this stave from one list to the other. The All button places all staves in the list 
of visible staves and the None button moves them all in the invisible staves. Double-clicking a stave moves it 
in the other list. The bottom text box entitled Upper and lower edge (in staff line spacing) lets you widen or 
compress the space located above and below each system in the scrolling score view. Click OK.

The right click menu also lets you change the zoom of the score, similarly to the score view.

How could you learn playing the keyboard ?

In the instruments view, select the Instruments configuration. This configuration contains a P column 
showing the instruments played by Pizzicato. If you remove one of the staves, you will be able to play it 
yourself, while being accompanied by Pizzicato for the other staves. If you wish for example to learn the 
right hand of a piano score, you can uncheck the P box of the first staff. By starting the score, you will only 
hear the bottom staff and you will be able to follow the score and to play the right hand.

By combining these characteristics, the keyboard window and the recorder, you will be able to gradually 
learn the practice of the musical keyboard. With this in mind, a progressive series of exercises based on 
these principles are proposed in the keyboard training lesson.

Global options and graphic copy
• Advanced global options 
• Graphic copy 
• Additional options 

Advanced global options

In the Options menu, select the Global options…item. The following dialog box appears:

It lets you select a few options that are independent of the Pizzicato document. When you change these 
options, it is valid for all the documents you will open thereafter. Let us see these parameters in detail:

• The At Pizzicato startup frame lets you specify the action executed when starting Pizzicato. 
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• The New document frame lets you specify the action executed when you select the New item in the 
File menu. 

• The Activate Undo/Redo box validates the memorizing of a certain number of operations you execute 
on the score. When you select the Undo item in the Edit menu, Pizzicato goes back one step by 
"undoing" the last operation. You can activate up to 50 undo levels. This function is useful when you 
executed for example a wrong operation: you can bring the score back to the state where it was 
before the faulty operation. 

• The Scroll score window check box, when activated (by default), asks Pizzicato to automatically 
scroll the score when it is played. The menu right below lets you select the refresh frequency each 
measure, after two measures, three measures or by full screen (by default). 

• The Scroll sequencer view check box is similar, but it applies for the sequencer window. 
• The Scrolling of the conductor view check box determines how the conductor view will scroll 

(continuously or step by step). 
• For Pizzicato Pro and Notation, the Musical font frame lets you select the musical font used to 

display the notes, keys, accidentals… Only the Pizzicato musical font is delivered with the software. 
Three other musical font can be recognized and used, but only if they are already installed on your 
computer. One is the Fughetta musical font. It is sold by Mr Blake Hodgetts and a shareware version 
can be downloaded on the internet address: 

http://www.efn.org/~bch/AboutFonts.html

• The Follow score playing frame contains a menu specifying how the play cursor moves during the 
reading of a score. It will move Every measure, Every beat, Every half beat, Every quarter of a beat  
or Continuously. By checking the Vertical line box, a vertical line will follow the play on all staves of 
the score. By checking the Colour played notes box, Pizzicato will draw the notes in red when they 
are played. 

• The Default window frame specifies the view Pizzicato will open when you open a document. By 
checking the Maximum size box, the window will occupy the full screen (except if several documents 
are open at the same time). The instrument window being a fixed size window, it is not influenced by 
the Maximum size box. 

• The Play edited notes box lets you enable or disable the playing of a note when you place it on the 
score or when you move a note with the mouse. 

• The Default template frame has a text box and a button to select the default template used by 
Pizzicato. 

• The Curve factor for slurs is a graphic adjustment. Its default value is 30. It affects the drawing of 
slurs and ties in the score. By decreasing it, the slurs resemble more and more to a straight line and 
by increasing it they are more curved. 

• The Slur thickness determines the thickness at the middle point of slurs and ties. 

Graphic copy

It is possible to copy the contents of the score view so as to paste the picture in your word processor or 
drawing program. To do this, open a score window and in the Edit menu select the Copy image… item. The 
following dialog box appears:

• Graphic resolution determines the resolution of the copied picture. 75 corresponds to the screen 
resolution. If you want a good resolution, you can keep 300 or even increase it. It depends on what 
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you want to do with the image. If it must be printed, we advise you a minimum of 300 DPI (Dot Per 
Inch = Pixel per inch). You will probably have to reduce the image to 25 % when used in another 
program, but you will gain in smoothness at printing. If you use the pictures to build an Internet site 
about music, a value of 75 DPI will be appropriate. 

• By checking Draw a frame around the image, a black border is added around the picture. 
• On Windows, by checking Colour image, the memory used will be more important, but any colour 

present in the score will also be copied. Please note that some applications do not accept black and 
white bitmap images. In such a case, check this box and your application (Word, Open Office, 
Corel,...) will then accept to paste the image. On Mac, the colours are automatically copied. 

• The Save as... button allows you to save the picture as a graphic file that can be used by other 
programs (BMP - Bitmap - format for Windows and PICT format for Mac). 

• The Copy to clipboard button copies the picture so that you can paste it in any program accepting 
pictures. 

Notice that the copied picture is formed with the contents of the score window. Before copying, you can 
decrease the size of the window so that it includes exactly the area you want to copy. The value of the 
display zoom does not affect the copied picture.

Additional options

When selecting the Additional options... item from the Options menu, the following dialog appears:

The upper part is used to define the default directories proposed by Pizzicato when opening or saving a file. 
After installation, there are no default directory checked. If you enable one or more check boxes, you may 
then select your favorite default directory with the corresponding Select... button. Pizzicato will then propose 
you that directory as the first choice in an open/save dialog box.

In the lower part, six check boxes define the default behaviour of Pizzicato:

• The first check box forces Pizzicato to automatically transcribe an imported MIDI file so as to 
display its score content. 

• The second check box automatically opens the tool palettes that were opened the last time you closed 
Pizzicato. 

• The last check box forces Pizzicato to adapt the notes to the clef of the destination measures, when 
you copy/paste measures inside a document. The clefs are not pasted. 
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• The fourth check box enables the automatic adjustment of slurs, for slurs entered since version 3.6, 
which takes into account the start and stop note of a slur and adjust it automatically. 

• The fifth check box determines if Pizzicato will automatically separate the various percussion 
instruments when importing a MIDI file. 

• The sixth check box enable the font smoothing function while drawing the score. This gives a nicer 
aspect to the score, but if you experiment slow reactions of Pizzicato when manipulating the score, 
try to disable this option. 

Note : depending on the version you have, some of the above options are not applicable. For instance, as 
Pizzicato Light does not import MIDI files, the import MIDI options are irrelevant for Pizzicato Light.

Real time recording (1)
• Real time recording 
• The recorder and its options 
• Start recording from the musical keyboard 
• MIDI play options 

Real time recording

The real time expression means that the exact time sequence of musical events is taken into account. Up to 
now, the methods explained to introduce notes on the staff let you work without time constraint. The time 
factor appears only when Pizzicato plays the score.

If you can play a score on the musical keyboard (even slowly), it is interesting to ask the computer to record 
your performance. This is called real time recording, because the computer memorizes the precise sequence 
of notes coming from the keyboard and it can reproduce them exactly as you played them. Pizzicato 
becomes a MIDI recorder.

A MIDI track is associated to each staff of a score. It is a memory used to accumulate time sequences of 
MIDI information. The real time recording is the method used to fill a track with notes you play on the 
keyboard and then to transform them into music notation on the corresponding staff (automatically or not).

You can thus record one track at a time and listen to the result of all tracks together. Pizzicato acts as a MIDI 
sequencer, i.e. as a multi-track MIDI recorder. With only that, you can already build a whole piece of music. 
By working in the sequencer view, the notes appear as small horizontal bars. You can copy, paste and erase 
measures. You can record a track or a part of a track several times, until it is finalized. In the score view, 
Pizzicato analyzes the keys which you played and converts them in notes with rhythmic values. The result of 
your performance appears on the staff and you can print your score.

A corrective step can be introduced just after the play, it is called quantization. This operation tries to 
smooth your performance so that it is more precise. Use it with moderation because it may affect the final 
result too much.

In this lesson and the next, we will see how to use these concepts in practice and with examples. Let us start 
by analyzing the recording area, present in most views and also called the recorder.

The recorder and its options

The recorder determines the control of the MIDI playing and recording. It is present for instance in the score 
and sequencer views.

• Start Pizzicato and open the Ex045 document of the Examples folder. The score view shows the 
recorder: 
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The left part contains 4 traditional pictures found on a tape recorder.

• Click on the START key, represented by a yellow triangle 

• The score starts playing. We had already used its shortcut which is the space bar. Click on the STOP 
key to stop the score, represented by a blue square. 

• To the right of these keys and since release 3.2 of Pizzicato, you will find in almost all music views 
the presence of the following graphical area: 

With it, you can play some measures in a loop, starting at the first measure that is played. To do 
that, check the box and select the number of measures that will form the loop, with the - and + 
buttons.

When Pizzicato plays, the space bar is also used as a shortcut for the STOP.

• Click again on START. In the right part of the recorder, a text box displays the current playing 
measure. Click on the PAUSE button, represented by two little blue squares. The score stops 
instantaneously where it is, holding the possible playing notes. It is fixed at a precise time of the 
score. Click again on the PAUSE and it continues playing again from there. With it, you can listen to 
(or visualize using the keyboard window) the constitution of a chord. You just need to use the 
PAUSE during the chord. 

The recording button will be used further; it is represented by a red circle.

A button entitled "..." is used to reach the play options of the score. Click on this button and the following 
dialog box appears:

This dialog may stay open and do not impede working on the score. You may move it so as to ease the 
access to the score.

• The first two frames let you select the measures that will be played when using the START button. 
By default, the first visible measure will start playing and this up to the end of the score. But other 
choices can be made. 

• Just below, there is a tempo slider, used to determine the speed with which the score will be played. 
Press on START and while listening to the score, modify the tempo value by moving the slider to the 
left to slow down, then to the right to accelerate. It can vary between 1 and 500. The "-" and "+" 
buttons allow a precise adjustment of the tempo, one step at a time. 

• Just below is a check box entitled Loop on ... measures. Check this box and complete the text box 
value with "2" if it is not already done. Go to the first measure of the score and press START. The 
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score starts playing the first 2 measures and then plays the first again. It makes a continuous loop 
with the first 2 measures. Note that during this time, you can continue to work the score by erasing, 
moving or adding notes. Pizzicato continues its loop with the first two measures. By using the 
corresponding text box, you can modify the width of the loop. Click on STOP. 

• A check box lets you activate the metronome. In music, a metronome is a small device used to 
indicate a tempo using a regular movement and an audible "click". The performer uses these clicks as 
a time reference to play his score with an exact tempo and with a precise sequence of measure beats. 
The metronome is a reference mark to guide its performance. By checking this box, Pizzicato 
simulates the sound of a metronome by marking each measure beat and beginning. Check this box 
and press on START. If you have a synthesizer or a GM (general midi) sound card, the beats and the 
beginnings of measures are marked using percussion instruments. Note that the beginning of the 
measure is marked with a sound of different intensity. If your synthesizer is not GM compatible, the 
beats and measures will be marked with a short and high pitched sound. Press on STOP. 

• Check the Wait keyboard action box. This box is used to control the recorder with the musical 
keyboard (also from the keyboard window). Press on START. The button is activated, the triangular 
cursor shows the first measure on the score, but Pizzicato waits until you press a musical keyboard 
key to really start playing. When you need to record a passage in real time, you may prepare yourself 
to play on your keyboard before giving the OK to record. Press a musical key to start playing or on a 
window keyboard key if you do not have a MIDI keyboard. For the rest of this lesson, uncheck this 
option. 

• The Effects play... button is used to define the way in which MIDI and symbol musical effects will be 
played through the score: 

This dialog lets you disable/enable the musical effects generated by the MIDI tracks and/or the 
symbols placed on the score that influence the playing, like nuances, tempo symbols,... For more 
details about musical effects, see the lesson on musical effects.

• The Tuning button let you specify the exact frequency of each note. However, this function is only 
applicable to the playing of virtual audio instruments by Pizzicato and does not affect the tuning of 
MIDI notes. See the lesson entitled The virtual instruments for more details. 

• In the play option dialog, we find a frame entitled Special play parameters with the following 
options: 

• The rhythm division and multiplication factors let you divide/multiply the 
duration of all rhythmic values in the score. 
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• A text box determines how many times the score must be played. 
• A popup menu specifies which measure version is played as well as the order 

of playing if the score is played more than once. 

Those parameters are mainly used in the frame of the composition help and the 
conductor view, only available in the Professional version of Pizzicato. See the 
lesson on composition help and on the conductor view.

• The Audio playing mode menu specifies how the virtual audio instruments are played. See the lesson 
entitled The virtual instruments for more details. 

• In Pizzicato Professional and Composition, you will find several check boxes used mainly within the 
music composition tools of Pizzicato. They will be explained in the lessons that concern that subject. 

Start recording from the musical keyboard

• Open the Ex050 example. 

Before starting to record, you need to specify where recording will start and which track will be recorded. 
That can be done starting from the sequencer or the score view.

• Open the sequencer view: 

Just before the first measure, you can see a column entitled R for Record. On a recorder, this term is often 
used under the Rec abbreviation. All boxes of this column are blank right now, which means that no track is 
active to record. By clicking on the recording button (red circle) of the recorder, nothing happens.

• Click inside the R column, in front of staff (track) 1. The box is coloured to show that recording is 
activated for track 1. Only one track can be recorded at a time. 

• Click now in the column R in front of track 2. Track 2 is activated and the track 1 is disabled. To 
disable all tracks, click a second time in the active track box. 

The recording will start from the first measure played according to the playing mode selected in the recorder 
options.

• Activate track 1. Ensure that the metronome box is checked in the recorder options and that the loop 
is disabled. We will record our first notes in real time. If you do not have a MIDI keyboard, open the 
piano keyboard window. Click the record button or use its shortcut which is the Return or Enter key. 

• An empty measure is counted. After that, play some notes with the musical keyboard (or in the piano 
keyboard window, with the mouse or the shortcuts), and continue until the recording stops itself after 
measure 6. The sequencer view redraws itself and graphically displays the recorded notes as small 
horizontal lines in track 1: 
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Notice that the score located below has also transcribed the notes in musical notation.

• Press on START. Pizzicato plays the exact sequence of notes you played during the recording. You 
can modify the tempo to hear it more quickly. If you use the piano keyboard window, the played keys 
are progressively showed as the measures progress. 

• Open the piano roll view. By adjusting the position of the vertical scroll bar, you will get something 
like: 

You can start the record again. If you do it on the same track, the previous recording will be automatically 
erased and replaced by the new notes. If you work on another track, the two tracks will be heard at the same 
time.

MIDI play options

The Options, MIDI Play Options menu, gives you access to the following dialog:
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• The first menu, entitled Synthesizers reset, specifies the reset mode of synthesizers. When you stop 
playing a score, Pizzicato sends MIDI commands to stop any note in progress. There are several 
conventions to reset notes. In most cases, the Normal choice will be correct. If you hear notes 
remaining "stuck" when you stop a score, you will have to take the maximal option and things will be 
better. 

• The next two menus select the port and MIDI channel used to send the notes to the metronome. The 
By default button loads the optimal metronome for your synthesizer. 

• The next two menus and the slider select the pitch and velocity of the note used to mark the 
beginning of a measure. 

• The same setup is available just below to specify the note used to mark each beat of a measure. In the 
case of a 6/8 measure, this will mark every dotted quarter note. 

• The same setup is available just below to specify the note used to mark each subbeat of a measure. In 
the case of a 4/4 measure, this is not applicable. In the case of a 6/8 measure for instance, this will 
mark every eighth note. By clicking in the By default button, Pizzicato will load the values best 
adapted to your synthesizer and will display them. 

• When several musicians play together, the conductor of an orchestra or one of the performers first 
counts one measure without playing, in order to give the tempo and to allow everyone to start exactly 
together. The Metronome measure menu displays the Only while recording choice. It means that 
when you will record, Pizzicato will first play the metronome during a whole measure. During this 
measure, nothing will be recorded. It is only used to give you the reference tempo so that you can 
envisage the beginning of the next measure where the recording will really start. Two other choices 
are possible for this menu. The first is named Never and disables the measure count. The second, 
Before playing, allows to count one measure as well when recording as when Pizzicato plays the 
score. It is useful if you wish to play together with the computer, to keep one measure in order to 
perceive the tempo with the metronome. 

• The Synchronization input port allows to synchronize Pizzicato to an external MIDI device (rhythm 
generator,...). When you select a synchronization input port, Pizzicato does not use its own tempo any 
more to play the score, but it waits synchronization orders coming from the specified input. An 
external equipment may then control the tempo used by Pizzicato. If you do not have an external 
MIDI device used to control the playing of Pizzicato, it is essential to select "----". Otherwise, 
Pizzicato has no tempo at all, because its internal clock is disabled. 

• The Synchronization output port is used to synchronize an external equipment (rhythm generator, 
arranger…) to Pizzicato. When a MIDI port is selected, Pizzicato sends during the play through this 
port information used to transmit the time reference to another device so that it can follow the tempo 
imposed by Pizzicato. Similarly, when you use the START, STOP and PAUSE recorder buttons, 
Pizzicato sends these orders through the MIDI output, to control the external equipment. If you do 
not use an external MIDI device, select "------". 

• Since version 3.1, there is an additional slider in this dialog, labelled MIDI delay in milliseconds  
(correction for audio), as well as a text box to enter a precise value. Depending on the sound card 
you have, if you add audio tracks to a score, the audio tracks may be played slightly late in relation to 
the score. This delay may be compensated here by specifying a MIDI delay, so that audio and MIDI 
are heard together. The exact value to use should be set according to what you hear. Try several 
values and keep the one that plays the MIDI exactly with the audio. This value can be negative, in 
which case the audio tracks are delayed in reference to the MIDI playback. 

• The Enable audio/Midi synchronisation check box is active by default and this makes the internal 
MIDI clock of Pizzicato to synchronise on the audio samples played by the audio card. 

Click OK to close the dialog.
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Real time recording (2)
• Tracks and staves 
• Transcription 
• Quantization 
• Recording multiple voices - Correcting the notes 

Tracks and staves

When you place notes on the staff, they are associated to the measures and are memorized into these 
measures, in the form of a graphic data structure. In other words, Pizzicato memorizes the vertical and 
horizontal positions of notes and rests related to the beginning of the measure, it memorizes the widths of 
measures, the spacing between staves, etc. This set of digital information is used by Pizzicato to draw the 
score on the screen or printer. When Pizzicato plays the score, it computes the notes to be sent and their 
respective durations.

On the other hand, for each staff of the score, Pizzicato keeps a storage section called a MIDI track. A track 
can be viewed as a long band which unrolls into time and on which MIDI information is placed, representing 
a piece of music without musical notation. Let us take a very simple score which contains 2 music notes. 
This piece could be represented by the 4 following information:

• Press key number 60 of the musical keyboard with a force of 100 
• 1 second later, release key number 60 of the musical keyboard 
• 1 second later, press key number 65 of the musical keyboard with a force of 100 
• 2 seconds later, release key number 65 of the musical keyboard 

Each note of the musical keyboard is located with a number (central C of the keyboard is key number 60). 
Those four information are sufficient to represent this little two notes musical score. A whole symphony 
could be represented this way and would contain thousands of lines like those above. This format is not very 
practical for a performer, but the computer can easily treat this kind of information. In a MIDI track, a 
melody is stored in a similar way.

When you play notes on the keyboard and Pizzicato memorizes them, the notes are initially stored in the 
MIDI track of the concerned staff, under the above format. Then, starting from this table, Pizzicato 
calculates the musical notation. This operation is called the transcription and is done automatically. For the 
above example, the equivalent score would be:

The notes path is thus:

• They are played on the musical keyboard and are transmitted through MIDI to Pizzicato, 
• Pizzicato stores these notes in the MIDI track, as they reach the computer, 
• At the end of the play, Pizzicato takes all track notes and transcribes them in musical notation 
• The notes are erased from the track, but exist now in the form of musical notation. 

It is possible to avoid the last two steps, so as to keep the notes in the tracks without transforming them into 
musical notation. It lets you execute intermediate operations on these notes, before transcribing them. Now 
let us study the various aspects of the tracks transcription and contents.

Transcription

The tracks contents are visible in the sequencer view and in the piano roll view.
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• Open the Ex051 example. It is a prepared example which contains 3 staves whose tracks were 
recorded in real time, but without transcribing the notes in musical notation. The staves are thus 
empty but by opening the piano roll view, you can observe the notes located in the 3 tracks, 
represented by 3 different colours on the screen: 

• In the same way, by opening the sequencer view, you observe the tracks contents: 

The score has 4 measures. The operation which transforms the information contained in a track into musical 
notation is called transcription. To transcribe one or more measures, select them with the selection tool and 
choose the Transcribe item from the Edit menu. You can also execute this operation from the sequencer 
view.

In the score view, with the selection tool, select 4 measures of the bass staff:

• Select the Transcribe item from the Edit menu. The bass staff becomes: 

It now displays the content of the track in the form of notes. The track data were converted into musical 
notation.
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• Select the first two staves. There is another way to access transcription. Click in the score with the 
right mouse button. A menu appears. Select the Transcribe item. The score becomes: 

We used here the standard options of transcription. A dialog box is used to modify the way the transcription 
is done. In the Options menu, select the Transcription item… The following dialog box appears:

Let us go through the options.

• Automatically transcribe: this option is checked by default. Pizzicato will do the transcription as soon 
as you record one or more measures in real time. If you do not wish an automatic transcription of 
notes, uncheck this box. 

• Delete measure previous content: by default, when you record a track, Pizzicato first deletes the 
previous content of the measures and the track before adding the new recorded notes. By disabling 
this option, it is possible to cumulate several records on the same track. 

• Justify measures: this option specifies to Pizzicato that it must justify the transcribed measures. The 
beams, the stem direction and spacing are calculated automatically. 

• Automatic: when active, Pizzicato automatically adapts the transcription precision compared to the 
played measures. It will not use a value lower than the specified minimal value below. 

• Detect triplets: this option forces Pizzicato to try to detect if triplets are played. It must be activated if 
the musical passages you play contain triplets. If you have difficulties to play precisely, it is better to 
disable this option. 

• Minimal value: it determines the smallest possible rhythmic value that you will play. It is the 
precision limit with which Pizzicato will write your score. In the example, it is the 16th note that had 
been preselected. In a new document, it is usually the 16th note that is preselected, because it is a 
value which will give good results in general. If your play is not very precise and if you play eighth 
notes, it is better to take the eighth note as a basis. If you wish a very precise value, you can take the 
32nd or the 64th note. In this case, your performance must be very precise. The experiment will show 
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you that this value is a compromise depending on the musical contents played as well as on your 
performance precision. 

• Minimum rest: specifies the precision used to write the rests. The value specified will be the minimal 
value of a rest written after a note. For instance if you play a dotted 8th note with a 16th rest and if 
the8th rest is the minimal value, the rhythm will be written as a quarter note. 

• Upper split point: by checking this box, you can determine a note pitch limit above which the notes 
will be transcribed in the upper staff (if there is one available). This pitch can be specified using the 
slider or may be played on the keyboard after clicking on the Listen... button. 

• Lower split point: by checking this box, you can determine a note pitch limit below which the notes 
will be transcribed in the lower staff (if there is one available). You can specify it in the same way 
than the upper split point. This option is very useful to transcribe a piano score played with two 
hands. 

• Adapt clef: by activating this option, Pizzicato will select the key (treble or bass clef) which is the 
most adapted to the notes you play. 

• Accidentals context: this option determines the way Pizzicato will transcribe the accidentals. If you 
play the black key between C and D, this note can be C sharp or D flat and this option will help 
Pizzicato to select. The 5 multiple choices located below define the context of the accidentals for the 
C scale. They each correspond to a black key of the musical keyboard. Three contexts can be 
separately defined: Neutral, Major and Minor. We have seen in the key signature lesson that you can 
select a major, minor or neutral mode when you add a key signature in the score. This choice 
specifies to Pizzicato which one of the 3 contexts it must use to find the accidentals. By default, it 
uses the neutral mode if no key signature is specified. 

Click OK. Open the Ex052 document. The track associated with the first staff contains a recording done in 
real time for the two hands of the piano. Listen to this track with the space bar. We will transcribe it in 
musical notation.

• Call the transcription dialog box in the Options menu. Activate the Lower split point option and 
ensure that the note value is 60. This value corresponds to the low C in treble clef. The lower notes 
will be transcribed on the lower staff. Click OK. Select the measures of the first staff, by clicking in 
front of staff one with the selection tool and select the Transcribe item from the Edit menu. The first 
measures becomes: 

Add a key signature with 2 sharps. You get:

As we have seen, the transcription allows to calculate the musical notation starting from the information 
contained in the tracks. After this operation, the notes are erased from the tracks. The opposite operation is 
also possible. Select all measures and in the Edit menu, select the Score to track item. All notes disappear, 
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but if you make the score play, it is played as before. Pizzicato simply removed the musical notation and 
placed the notes in the associated MIDI track.

Close this document without saving.

Quantization

The quantization is an operation which consists in adjusting the position and the duration of notes played, in 
order to align them together and with the beats of the measure.

When you add 4 quarter notes in a 4/4 measure, Pizzicato will play them exactly. Each note start will be 
placed exactly on the beginning of the beat and each note duration will be exactly 1 beat of the measure. The 
graph in the piano view will looks like this:

Each line is precisely aligned with the beats. When a person plays this melody on a keyboard, the precision 
reached is never comparable with the above diagram, especially for a beginner, and the diagram will rather 
look like this:

Quantization lets you go from this diagram to the previous one. It corrects the spacing and brings the notes 
back to the beginning of the nearest beat.

It is a double-edged weapon and you must not misuse it. A musician who performs a musical work will 
voluntarily create light differences in his manner of playing the notes. It is one of his tools to personalize the 
performance and to express what he feels. If after recording his performance in real time you quantize the 
play, you will remove this expression and the piece will appear much more mechanical and artificial.

If you make your first steps on the musical keyboard and want to introduce melodies or battery rhythms in 
real time, the quantization will be useful because it lets you correct your precision errors.

The basic rule is thus to use the quantization to remove shiftings caused by errors. When the shifting belongs 
to the musical work, you must not touch them, otherwise you will remove a part of the score beauty.

When working with percussion rhythms, quantization will be very useful, because this kind of instrument 
must often have a rather important rhythmic precision.

Let us see now in practice how to use quantization.

• Open the Ex053 document. Open the piano roll view and move the vertical scroll bar to view the 
following area: 

• Activate the metronome. Listen to the first measures. You will notice that the notes do not always 
start exactly with the beats. The performance is relatively imprecise. In the score view, select all 
measures and select the Quantize item from the Edit menu. The following dialog box appears: 
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Three types of operations are possible. Here are their descriptions.

• Quantize note start 
This operation move the note start by bringing it to the nearest quantization value. The note total 
duration does not change. The end of the note is moved in the same manner as the note start. In 
the piano roll, it corresponds to a horizontal shift of a line.

The quantization value determines the precision used. If you use a quarter note value, each note 
will be moved to start exactly at the beginning of the nearest quarter note which can be placed in 
the measure. With a 4/4 measure, the notes will thus be brought back on the first, the second, the 
third or the fourth beat. By selecting an eighth note, the notes will be adjusted to the nearest half-
beat. There will thus be 8 possibilities, because a 4/4 measure contains 8 eighth notes. If you use 
a 16th note for the quantization value, you will have 16 possibilities, and so on.

We thus see that the influence of the quantization is weaker as its value gets lower. By selecting 
the 128th note as quantization value, the notes could be moved only from a half-128th note and 
the effect will be almost impossible to hear. If you place a whole note as quantization value, all 
notes will be brought back to the beginning of the current measure or the following one, and the 
effect will be terrible.

The Dotted box specifies a dotted value such as for example a dotted quarter note (useful in 6/8 
measures for example). By checking the 3 for 2 box, the rhythmic value is considered as a triplet.

• Quantize note duration 

Independently of the note start position, you may also quantize the note duration to bring them 
back to multiples of the quantization value. The principle is the same, but only the length of the 
line representing the note is modified. The start of the note is not affected.

• Delete notes with a duration less than: 
This operation corrects the unexpected notes. While playing on the keyboard, you accidentally 
slide on a note which was unexpected. These notes are often very short, because the reflexes of 
the performer will stop this note as soon as possible. By using this option, Pizzicato simply 
removes all notes having a duration lower than the specified duration.

The first operation is checked. Check also the second one and click on Quantize. Go back to the piano roll to 
visualize the effects of these operations. The measures are now displayed as follows:
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Compare this drawing with the one before quantization. The notes are now all aligned with quarters of beats 
because the value of the selected quantization was the 16th note. By going back in the score view, listen to 
the sound difference.

• Execute the operation again by selecting the eighth note as quantization value for both operations. 
Listen to the sound result. This time the piece is strongly modified. You must never use a 
quantization value higher than the smallest rhythmic value of the score, otherwise you completely 
modify the result. You can easily understand this by comparing the graph displayed with the eighth 
note quantization value: 

Recording multiple voices - Correcting the notes

You can also directly work in the score to record in real time. 

• Close the preceding document and create a new one. Select the Midi cursor tool . In the recorder, 
activate the metronome. 

• Place the Midi cursor on the first staff, first measure. The cursor blink: 

• Use the recording shortcut which is the Return key. The metronome counts one measure and the 
recording starts. Play for example only quarter notes (one note per beat). Pizzicato automatically 
stops at the end of the score or when you press on the space bar, and the musical notation 
transcription is automatically done, to get for example: 

• You can then start the operation again with the lower staff. Place the MIDI cursor in the first measure 
of the second staff and record quarter notes to obtain for example: 

It is possible to record several voices on the same staff. We will combine the rhythmic voices menu with the 
transcription options.

• In the Options menu, select the Transcription item. Disable the Delete previous measure content box, 
and click OK. 
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• In the rhythmic voices menu, located in the upper left corner of the score view, select item 2: 
 

• Place the MIDI cursor in the first staff, first measure and record quarter notes as above. By selecting 
again the 1-8 choice for the voices menu, you obtain for example: 

You can execute that with voices 1 to 8. In practice, beyond three voices, the notation becomes complex and 
more difficult to read. Notice that if you play chords, those are considered by Pizzicato as only one rhythmic 
voice if each note of the chord has the same duration.

When you play notes on the keyboard and when Pizzicato transcribes them in musical notation, it 
nevertheless memorizes the exact way in which you played them. In other words, your performance 
imprecision (desired or not) is associated to the notes, so that Pizzicato can play them again as you originally 
played them. You can reach these performance parameters and modify them.

• With the right button of the mouse (Option-click on Macintosh), click on one of the notes head. A 
menu appears. Select the Edit note play… item. The following dialog box appears: 

You can also reach it by clicking a note while holding down the SHIFT key. The values will not necessarily 
be the same on your screen, because they depend on how you played the note.

• MIDI Velocity: when this box is checked, it means that the note has a velocity associated with it. It is 
the case when you played it on the keyboard. With the slider located to the right, you can modify this 
velocity between 1 and 127, which respectively correspond to an almost inaudible note and to a note 
with maximum force. If you disable this box, the note loses its associated velocity and will be played 
with the velocity determined in the instrument view or according to MIDI symbols. 

• MIDI duration: when this box is checked, it means that the note has a personalized duration 
associated with it. You can modify this value, which is expressed as a percentage compared to its 
exact value. A note twice shorter than its normal value will thus have a 50 % value. 100 % 
correspond to the value of its musical notation. The slider lets you vary it from 10 to 200 %. 
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• MIDI Start: when this box is checked, it means that the note has a personalized start associated to it. 
You can modify this value, which is expressed as a percentage compared to its exact duration, 
between -50 and 50%. A 50 % value will correspond to a note which starts too late of a duration 
equal to its own half duration. A value of 0 % indicates that the note is played exactly compared to its 
musical notation in the measure. 

When you add a note with the mouse, these three boxes are disabled. You can then modify them to create 
performance effects. In addition, if you play notes on the keyboard, you can modify one or more notes using 
this dialog box to correct the performance, or simply to disable the three boxes to go back to a note such as it 
would be played with musical notation.

The Justification frame allows two things:

• Manual stem direction: when you use the stem tool to reverse a note stem, this action is memorized 
by Pizzicato as a characteristic of this note. The box is checked if the stem was manually modified. If 
you want Pizzicato to automatically manage this note stem, disable this box. 

• The multiple choice is by default Automatic beam. It means that Pizzicato manages itself the way in 
which notes are grouped with beams. The second choice prevents a beam with the preceding note and 
the third choice forces a beam with the previous note. When you modify the beams with tools, 
Pizzicato links this information to the note. This dialog box lets you use the automatic mode again. 

Other frames are present in this dialog according to the Pizzicato version you have. See the lesson on the 
contextual menu of a note. Click OK.

Transposition
• Transposition 
• Intervals 
• Diatonic and chromatic transposition 

Transposition

The idea is to modify a melody or a whole passage of a musical work in order to play it higher or lower in 
the sound scale. In the lesson on key signatures, we had listened to a melody starting with C and then to the 
same melody starting with E. It is an example of transposition. The melody was transposed two notes higher.

It is frequent to use transposition when composing a musical work. You can transpose a whole melody or 
some notes. It is a current composition tool because you can express several times the same thing while 
adding a change to it.

The simplest transposition is an octave change. For example, all notes are played one octave higher. They 
keep the same name. Open Ex027. The first two measures contain a small melody which is transposed one 
octave higher in the next two measures:

Listen to the sound difference. The second melody is easily recognized as being the same one as the first, but 
it is played higher.
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Intervals

To specify a transposition, intervals are defined. The example above is a transposition of one octave, because 
there are 8 notes on the patch from the original melody to the transposed melody (C, D, E, F, G, A, B, C). 
Here are the names of intervals with the number of notes contained in each:

Unison 1 note
Second 2 notes
Third 3 notes
Fourth 4 notes
Fifth 5 notes
Sixth 6 notes
Seventh 7 notes
Octave 8 notes
Ninth 9 notes
Tenth 10 notes
Eleventh 11 notes
… …

Speaking about a third for example, one counts the note names contained in the interval, without taking into 
account the number of half tones. C and E form a third, because there are three notes in the interval: C, D 
and E. By counting the black and white keys, there are 4 half tones:

Similarly, D and F form a third, but by counting the half tones on the keyboard, there are only three:

To qualify the exact content of an interval, an adjective is added to it. They are specific for each interval. 
Here is a table showing the interval names, the adjectives qualifying them and the half tones contained in 
them:

 Diminishe
d Minor Major Perfect Augmented

Second 0 1 2 - 3
Third 2 3 4 - 5
Fourth 4 - - 5 6
Fifth 6 - - 7 8
Sixth 7 8 9 - 10
Seventh 9 10 11 - 12
Octave 11 - - 12 13
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A minus sign "-" shows that the adjective is not used for this interval. The underlined numbers are the 
intervals separating the first degree of a major scale from each other degree. They are either major (as the 
scale) either perfect.

The interval separating C and E has 3 notes and contains 4 half tones, it is thus a major third. The interval 
separating D and F has 3 notes and contains 3 half tones, it is thus a minor third.

You can precisely name an interval starting from this table. What is the interval separating C sharp from B 
flat ? 

By counting the notes, C #, D, E, F, G, A, B flat, it is a seventh. On the keyboard, you will count 9 half 
tones. According to the table, it is thus a diminished seventh.

Diatonic and chromatic transposition

Chromatic transposition respects the exact number of half tones for each transposed note. The melody thus 
keeps its original colour. Accidentals must sometimes be added to notes so that the intervals of the melody 
remain the same.

To characterize a chromatic transposition, an interval must be given with its content as well as the direction 
of transposition (higher or lower). Open the Ex028 file. It contains a small melody on 2 measures which is 
transposed a major third higher in the next 2 measures:

Considering the first 2 notes of the melody (C and E), they are separated by an interval of 4 half tones. By 
going up a third, you obtain E and G but between these two notes there is only 3 half tones. A sharp is placed 
in front of G to correct the interval, adding the missing half tone.

Diatonic transposition only considers the number of the interval notes and not its real content. To specify it, 
the direction and the interval name are sufficient, no capacity adjective is needed. Open the Ex029 file which 
contains the same example as above, but transposed a third higher in a diatonic way:

It is even simpler to do, because the intervals do not need to be corrected. The two sharps were not added. 
Listen to this example. In the last two measures, the melody has a different colour. It is sadder and more 
resigned than the first.

Diatonic transposition modifies the melody colour. This aspect can be used to create for example a second 
voice which will accompany the main melody. Open the Ex030 file now and listen to the effect obtained. It 
gives you an example of this same melody which is accompanied by a second voice transposed a sixth 
higher in a diatonic way :

The diatonic transposition respects the original tonality. This melody written in C major remains in C major 
even when transposed, because no accidental is added. This was not the case with the chromatic 
transposition example.
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Transposing and justifying measures
• Transposing measures 
• Justifying measures 
• Justification options 

Transposing measures

It can be useful to transpose a melody, chords or a whole score, for example with a transposing instrument or 
simply to transpose a melody which appears several times in a piece.

• Start from a new document and fill in the first two measures to obtain: 

• Duplicate this melody with a copy/paste by dragging the first two measures to the third measure: 

• We will transpose the second melody. Therefore, we first need to select the two measures to 
transpose. Use the selection tool to obtain: 

• Now select the Transpose item from the Edit menu or from the contextual menu appearing when you 
click in the score with the right mouse button (or Option-click for Macintosh). The transposition 
dialog box appears: 
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The selection of the transposition interval may be defined in three different ways.

• The upper part of the dialog box is used to specify it in terms of transposing instruments. Select the 
instrument in which the score is now written and the instrument for which you want to transpose the 
score. Pizzicato will then display the correct interval in the second part of the dialog box. The Adjust  
MIDI playback for transposition check box will add a MIDI transposition to the staff, so that 
Pizzicato will play the transposing instrument correctly. 

The second part of this dialog box is used to specify the transposition interval directly.

• The Value of interval (from the unison to the octave) specifies the transposition interval with a menu. 
The unison corresponds to the distance separating a note from the same note, i.e. no transposition. 
The second is the distance separating two consecutive notes, a transposition of one note,… and the 
octave corresponds to a 7 notes displacement. Select the fourth which corresponds to a displacement 
of 3 notes. 

• The Type of interval more precisely characterizes the interval content used to transpose the melody. 
The diatonic choice simply moves the notes of the specified interval. No checking will be done to be 
sure that the sound effect remains the same. For example, if you transpose a C a second higher, you 
get a D note. If you transpose a B a second higher, you obtain a C. The interval is however not the 
same: it is a two half tones interval in the first case and a one half tone interval in the next case. If 
you want the transposed melody to keep the original sound effect despite the pitch change, take one 
of the other choices (Diminished, minor, perfect, major or augmented). Each one of these will give 
you a different pitch. Select Perfect. 

• The Direction specifies the transposition direction: Up (higher pitch) or Down (lower pitch). 

• The Octave transposition adds or subtracts one or more octaves to this interval. 

You can also define the interval as a number of half tones on a slider and Pizzicato will compute the 
corresponding definition of interval.

Three check boxes specify what must be transposed: notes, chord symbols and/or key signatures.

Click Transpose. The score becomes:

The melody was transposed a perfect fourth higher. Listen to the result with the space bar.

• Similarly, transpose the last two measures a diatonic fifth lower. You obtain: 

Listen to the result. The second melody resembles the first, but is slightly different.

• Now transpose the first two measures a minor second lower. Pizzicato corrected the intervals and 
added sharps so as to keep the same melody. You now have: 

Listen to the two melodies. They begin both with the same note, but the melody which was transposed in a 
diatonic way (the second) is no more the same than the original one.

Justifying measures

We have seen that when creating a new document, the automatic justification tool is activated. It helps you 
to distribute the contents of a measure in a balanced way. As soon as you add, erase or move an element of 
the measure, Pizzicato calculates the measure layout again to take the modification into account. If you 
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disable automatic justification, you are responsible for the graphic organization of the measure (only with 
Pizzicato Beginner and Professional).

Pizzicato also has a function used to justify a selected block of measures.

• Open the Ex054 example: 

The notes were written without justification, incorrectly distributed in the measures, with a didactic purpose. 
Select 2 measures of the first staff with the selection tool and choose the Justify item from the Edit menu. 
The first staff becomes:

The notes are distributed in a more balanced way inside the measures. As opposed to automatic justification, 
this function is a justification on request. It only acts on the selected measures.

• Select 2 measures of the 2nd staff only and justify them as above. You obtain: 

The notes were adjusted to be more regularly laid out in the measure.

Observe the contents of measure 1, on staves 1 and 2. Beats are not aligned together. For example the half 
note starting on the third beat is not aligned with the third quarter note of the upper measure. To read a score, 
it is much easier to align rhythms starting at the same time.

When we justified these measures, we did it separately, with the result that Pizzicato justified each measure 
without taking the other measures into account. To force Pizzicato to take into account the alignment of 
beats between various staves, you need to do the operation in one time. Select the 6 measures and justify 
them. The score becomes:

The notes played at the same time are now aligned together.
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Justification options

• In the Options menu, select the Justification item…The justification dialog box appears: 

• The first Adapt measure width box forces Pizzicato to adapt the width of measures with each 
automatic justification of their contents. Be careful, this option works only when the horizontal 
justification of systems is disabled in the page layout dialog box or when the page layout is not yet 
made (linear mode). The Only Local box forces Pizzicato to do a local justification, i.e. without 
examining the contents of the measures located below or above it. 

• The second Adapt measure width box, located below the Justification function title, lets Pizzicato 
modify the width of a measure when justification is done on request (not automatic). It calculates the 
optimal width so that its contents are balanced, then it multiplies this width by the Scale factor 
located in the bottom of the dialog box. Its default value is to 125 %. If you want more spaced 
measures, increase it. The preceding remark about page layout remains valid. 

• The Analysis of incomplete voices box is an indication for Pizzicato. It specifies the way to analyze a 
second rhythmic voice. 

Let us take the case of a rhythmic voice with 4 quarter notes:

If you add a quarter note, Pizzicato will automatically place it over the first beat of a second rhythmic voice, 
and you will get for example:

The place where you clicked does not matter, the quarter note is brought back to the beginning of the 
measure. If you check the Analysis of incomplete voices box, Pizzicato will place the quarter note at the 
nearest 

place to a note or a rest of the first voice. In other words, if you place a note below the 4th note, you will get:
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The second rhythmic voice is incomplete because the first 3 beats lack. Thanks to this option, Pizzicato 
analyzed it.

• The Automatic vertical adjustment of tuplets box: when checked, the beam (or the hook) of the 
irregular groups (Tuplets) will be vertically adjusted by Pizzicato. Disabled, this box allows a manual 
adjustment of irregular groups (default choice). 

• The Include rests in beams box is used to include rests between notes that should be attached by 
beams, for example: 

Disabled, this option would produce:

• The Beam creation box tells Pizzicato to create and adjust note beams during justification. The text 
box located to the right specifies how to establish them. The default choice is empty, which means 
that notes are beamed per beat in the current measure. By placing for example "2+1+1", you will 
obtain 3 connected note groups: the first 2 beats, the 3rd beat and the 4th beat. For a 6/8 measure, if 
you place "3" in this text box, the eighth notes will be beamed by 3. 

• The following menu specifies the way stems directions are set. The Do not modify choice does 
nothing. The Adapt to note height choice adjusts the direction to the note pitch (on the third line of 
the staff or lower, stems are directed upwards). The two following choices (Stems up and Stems 
down) fix all stems up or down. The last choice (Adapt for multiple voices) is selected by default. 
Pizzicato takes into account the note pitch when there is only one voice. If you add a second voice, 
stems are adapted for a correct layout of multiple voices in the measure. 

• The next text box adds a shift between 2 voices whose notes would otherwise be colliding. A value of 
8 will give for instance:

• The Do not justify chords horizontally check box is used to avoid that a manual adjustment of chord 
symbols gets cancelled by the justification of the measure. 

• The Accidentals slider specifies the influence of accidentals on notes spacing. A value of 0 % will not 
take them into account. By placing 100 %, a large space will be reserved in front of the note for the 
associated accidental. 

• Similarly, the Mobile clefs slider specifies the influence of mobile clefs. Pizzicato adjusts their 
position so that measure are well laid out. If this value is set to zero, Pizzicato will never move 
mobile clefs. 

• The Symbols and lyrics slider adjust the influence of some graphic symbols as well as songs lyrics 
added under the notes. If the symbol is placed in front of or behind a note, Pizzicato gives more space 
for this note, according to the value of this slider. 
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• The Distance/rhythm ratio slider adjusts the relationship between the distance allotted to two 
successive rhythmic values (quarter note and eighth note, eighth note and 16th note,…). A value of 
100 % allots the same space to each rhythmic value: 

All notes are then spaced in the same way. A value of 200 % doubles the space for 2 successive rhythmic 
values. The above measure would become:

• The Grace notes slider is only available in Pizzicato Professional and adjust the spacing of grace 
notes created with the grace note special tool. Pizzicato adjust their position so that the measure looks 
correctly. 

Exercise
Create the following score, starting from a new document, copying/pasting, then using the transposition tool. 
Finish it by justifying the whole score.

Page layout
• What is page layout? 
• Page setup structure in Pizzicato 
• Page layout dialog box 
• Page contextual menu 
• Modifying the layout of measures and systems 
• Printing the score 
• Show or hide the staves of a system 

What is page layout?

Page layout is the art to arrange measures and staves on pages so as to print them.

Two working methods are available to encode the notes: the linear mode and the page layout mode.

Most examples seen until now were in page layout mode. The measures are represented as they will appear 
on the printed page. In some cases, working in linear mode is more convenient. If you prepare for example a 
large orchestral score which and you don't know yet the final aspect of page layout, we advise you to start 
with one of the linear models and build your score progressively. The whole score behaves as a large roller 
where measures scroll thanks to the horizontal scroll bar. Similarly, when you create an arrangement only to 
hear it and not to print it, it is useless to work in page layout view.

When you need to print the score, this linear mode is no more appropriate, because it is then necessary to 
take the paper format into account. The operation which consists in laying out measures and staves to adapt 
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them to the paper format is called page layout. The constraint introduced in page layout is that Pizzicato 
must calculate the page layout each time you modify a measures width or you erase or add measures or 
staves. For a complex score, it is better to work in linear mode and to make the page layout when the score 
structure is finished.

Page setup structure in Pizzicato

In Pizzicato, the page layout is done with pages and areas.

A page corresponds to a sheet of paper. Its size is the size of the paper you put into your printer.

In most cases, a page has printer margins that limit printing close to the borders. These margins are defined 
by your printer and cannot be changed. Most printers have a limitation to how close it can print to the 
borders of the sheet of paper. Some inkjet printers may have zero margins and in that case you can print 
everywhere on the page. We can represent this as follows:

The sheet borders are shown in black and the printer margins are displayed in red. The area between the 
black and red rectangle cannot be printed.

In Pizzicato, an area (or printing area) is a precise zone inside a page, in which Pizzicato can print music 
systems. Here is an example, showing an area defined in green inside the page:

A system is a set of one or more measures from left to right, on one or more staves playing together. They 
form a graphic unit on an area. 

Here are three systems (1 measure of 1 staff , 4 measures of 2 staves and 3 measures of 4 staves):
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One area can include zero, one or more systems.
Here is one page, with two printing areas. Each one has four systems and everything is printed on one sheet 
of paper.

Page layout dialog box

We will see an example of score creation in linear mode and then how to do the page layout.

• In the document manager, click on the My scores folder with the right mouse button and select New 
document... and set its name to Page setup test. It shows up in the My scores folder. Open it with a 
click on the "+" icon in front of it. Double click on the score name Score 1. The score appears as 
follows: 

• Add 39 measures and one staff with the measures and staves tool. Place a bass clef on the second 
staff and decrease the distance between the two staves. Erase the names of the staves in the 
instruments view and add a piano brace to connect both staves. On the upper staff, add the measure 
numbers for each system. You should get: 

• Use now the shortcut allowing to go from the linear mode to the page layout mode and vice versa: it 
is the upper case letter "P". It is the same action as modifying the popup menu located at the top of 

the score view (  ). As the page layout calculation was not yet done in this score, 

Pizzicato shows you the page layout dialog box: 

237



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

This dialog may also be called from the File menu, Page setup item.

• As it is the first page layout, Pizzicato adapted the parameters of this dialog box to your default 
printer. You can also reach these parameters using the Printer Setup... button. A dialog box appears. 
It is different for each printer model. Usually, you can select the paper size (A4 format for example) 
as well as the paper orientation (portrait mode or landscape mode). When you click Apply then 
Cancel (or simply Print as the score will not be done at this point), you go back to the page layout 
dialog box and the paper dimensions as well as the external margins are adapted to the printer. 

Here is a description of the main elements of this dialog.

• In the Printer setup and zoom frame, except for Pizzicato Beginner, you can specify a printing zoom 
in percents, so that you can place more measures and staves on a page. By choosing a value lower 
than 100, the page on screen will look bigger, but will be reduced accordingly when printed. In 
Pizzicato Beginner, only two values may be used: 100 % or 85 %. 

• The Margins frame displays the printing margins. You can modify them if you want to. By clicking 
on the Minimal margins button, the values are reset to the default printer margins. 

The frame entitled Printing areas is used to define one or more printing areas on the page, where Pizzicato 
can place music systems. Here is the detail:

• The first two menus specify the number of printing areas vertically and horizontally. In a standard 
page layout, they are set to 1. To create a booklet, for instance in A4 format, folded, you can select 
the landscape paper orientation and define two areas horizontally, so as to divide the paper in two 
areas. 

• The two spacings (in mm) are used to separate two consecutive areas, vertically or horizontally. 

• The internal margins define a border inside the printing area where Pizzicato will not place any 
system. 

• When the Display borders check box is active, Pizzicato will draw the printing areas borders with a 
thin gray line so you can better see the structure of the page, for instance when you work on a 
complex page layout. 

• The next text box is used if you want to exclude one or more printing areas from measures and 
systems. You can fill it with a series of area numbers, separated by commas. If you do not want areas 
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1 and 3 to display any system, fill it with "1,3". You can use this to have a blank or title page with no 
music on it, or to insert pages with only text and no music. 

• The Page order frame specifies how to print the areas on the pages. By default, Standard means that 
the order will be 1, 2, 3, 4, ... The Booklet mode can be used to print two areas per page, both sides 
and folded so that you have a booklet. The page order will be 4, 1, 2 and 3. Pizzicato automatically 
computes this. For any other case, you may use the customized mode, where you can define the page 
order with a series of numbers separated by commas in the corresponding text box. 

The frame entitled Actions is used to specify the following parameters:

• The Apply the printer setup and the areas check box specifies that Pizzicato must create the areas and 
pages. If you disable it, the present page structure will not be modified. 

• The next text box specifies the first page on which the modifications will be applied. Previous pages 
will not be modified. 

• The checkbox entitled Do not move text blocks will keep the text blocks as they are. The new page 
layout will not affect the position of the text blocs associated to the pages. 

• The checkbox entitled Do not change the number of measures per system is used to keep the numbers 
of measures per system as they are., despite a new page layout. If you have customized these 
numbers individualy for each system, this option helps you to keep this customization even when you 
recompute a new page layout. 

• The checkbox entitled Reset the distances between staves to their default values will reset the 
distances that separate each staff from the other to their default values, which is the distances that are 
displayed in the linear mode (Linear/Page/Global menu). By default, it is not checked, which means 
that if you customized these distances, they will stay in the new page layout. If you want to reset 
them, check this box. 

The left frame specifies various options regarding the way Pizzicato will assemble systems and place them 
in the printing areas. Here is the detail.

• Set the number of measures per system to : when checked, the corresponding text box determines the 
number of measures in a system. If disabled, Pizzicato will estimate this number automatically, 
according to the width of the measures. 

• Set the number of systems per page to : when checked, the corresponding text box limits the number 
of systems per page. 

• In Pizzicato Professional and Notation, you can check the Optimize systems box. Pizzicato hides 
from the page layout all staves which do not contain any note or major indication. It is used for 
orchestral scores, where it frequently happens that instruments do not play anything during several 
measures. The staves are not drawn and it saves paper in the orchestral score. 

• The next text box specifies the distance between two consecutive systems. A value of 8 is usually 
appropriate. 

• The next check box, if checked, forces Pizzicato to adjust staves horizontally on the area margins, 
particularly when you adjust the size of measures or move systems around. 

• If you check the Distribute systems on the page box, Pizzicato will distribute systems in a balanced 
way on the page. This option has priority over the intersystem distance defined above. 

• A text box reserves some space (in mm) for the first page title. A value of 20 mm is usually 
appropriate. 

• The next two numbers are defined in %. When Pizzicato computes the width of systems according to 
the widths of measures, it must often reduce or enlarge individual measures to make them fit with the 
page and area margins. These two numbers specify the limit of how much Pizzicato can reduce and 
enlarge the measures. If you want a tight page layout, you can decrease them. If you prefer a page 
layout with more space, increase them. 
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The Background frame is used to determine the background of pages on the screen. You can have a white 
background (No background), a colored background (click on the color box beside it to select a color) or a 
bitmap pattern (24 bits BMP image). You can find a paper bitmap pattern in the following folder: 
Programs / Pizzicato 3.5 / Data / Bitmaps / Texture-2.bmp or Texture-3.bmp. On Mac, you find it in 
Applications / Pizzicato 3.5 / Data / Bitmaps. It only affects the screen display.

Two buttons may be used to validate this dialog. The first one is Compute and OK and Pizzicato will save 
the parameters and apply them for a new page setup. The other choice is OK - No compute and only saves 
the parameters without applying the parameters to a new page setup. Click Compute and OK. The score 
appears in page layout mode and displays the way in which Pizzicato laid out the measures and staves:

According to your printer, it may be slightly different.

 

On the main palette, activate the  tool. It is the reference marks tool. Its shortcut is the key with two 
superimposed dots ":". When it is active, margins are visible. To disable it, click it again. The complete page 
is presented as follows:
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The white background represents the paper physical dimensions. A red rectangle shows the printer margins. 
It delimits the paper area where your printer is able to print. Outside this red rectangle, nothing will be 
printed, even if by error you place text areas or symbols. The maximum size of this red rectangle is specific 
for each printer.

A green rectangle is located inside the red rectangle. It shows the margins defined for the printing area. It is 
inside this green rectangle that Pizzicato places measures and staves.

The measures are laid out starting at the top of the first area. When Pizzicato cannot add measures to the 
right, it continues below, going back to the left border of the area, as you do when writing text.

Page contextual menu

When you click with the right mouse button in the background of a page, a contextual menu is displayed.

The first item is Display and it has 6 subitems to select the way you want to display pages:

• One page - Display only one page at a time. You can use the page scroll at the left bottom of the 
window to move from one page to the other. 

• All pages horizontally - Pizzicato displays all pages side by side. You can scroll with the page scroll 
or with the horizontal scroll. You can also click in the background and move the score around. This is 
the default display mode. 

• All pages vertically - Pizzicato displays all pages in a vertical row. You can scroll with the page 
scroll or with the vertical scroll. 

• One area - In this case and the two next cases, Pizzicato only displays areas. Usually, there is one 
area per page and the area is a bit smaller than the page, as it does not have the printing margins. 
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When you have a page layout with more than one area per page, this display mode shows you only 
the individual areas. 

• All areas horizontally - All areas are displayed, side by side. 

• All areas vertically - All areas are displayed, on a vertical row. 

The next menu item is Insert. According to the Pizzicato version, it displays one or more items:

• A text block... - Adds a text block in the area where you clicked. See the lesson about text blocks. 

• An image... - You can choose an image file, that presently must be a 24 bit BMP image file. When 
the image appears on the page, you can move it, resize it by its bottom right corner (if you hold the 
CTRL key, it resizes proportionally). You can double click it to change its size or the image file. You 
can delete it with the delete or backspace key when the mouse is over it. 

• A graphic... - Pizzicato opens a graphic editor where you can create simple graphic objects to display 
in the score. See the graphic editor lesson. When the graphic appears on the page, you can move it, 
resize it by its bottom right corner (if you hold the CTRL key, it resizes proportionally). You can 
double click it to change its size or the edit the graphic. You can delete it with the delete or backspace 
key when the mouse is over it. 

The next items are related to the pages:

• Insert a page before this page - will add a new page just before the current page (the page you are 
clicking on). 

• Add a page after this page - will add a new page just after the current page. 

• Printer setup for this page - calls the following dialog: 

This dialog is used when you want some pages to have a different layout than other pages. You 
can select a printer setup (it can even be another printer, for instance if you want a cover sheet in 
color on a color printer and the other pages on a black and white printer), another print scaling 
factor and apply it to one or several pages.

• Delete this page - will simply remove the current page. 

The next items are related to the printing areas:

• Format of this area - If you click inside an area, this item calls the following dialog: 
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You can modify the size and position of that area inside the page and you can adjust the internal 
margins. You can apply these changes to this page, all similar pages or all pages.

• Delete this area... - will remove that area from the page. 

• Add an area - If you click outside of an area, but inside a page, you can add a new area, if there is 
enough space left free on that page. This menu is used mainly to construct a page freely. 

The last menu item is Page layout... and it simply calls the general page setup dialog that we explained 
above.

Modifying the layout of measures and systems

The calculation done by Pizzicato does not always correspond to the way you want to lay out the measures 
on the pages. The number of measures per system, the number of systems per page and the spacing of 
systems on the page can be modified thanks to the measure layout tool. Similarly, when you work with 
templates with a prepared page layout, it can be useful to modify the layout of measures and staves.

• Use the 67 or 50% zoom value in order to see the full page. 

• The measures layout tool  is located in the main palette. Its shortcut is the upper case letter "D", 
which acts directly on a measure without selecting the tool on the palette. Place the mouse cursor on 
the first measure of the first system of page 1 and type "D" with the keyboard. The following dialog 
box appears: 

You may also reach this dialog by clicking on a measure (without an active selection in the score) with the 
right mouse button (option click on Mac). A contextual menu appears and contains an item Measures and 
systems setup... which calls this dialog.

Three types of operations can be executed with this dialog box, simultaneously or not.

• The first consists of adapting the number of measures contained in a system. To activate it, check the 
box located in front of the Measure(s) per system text label and fill in the number of measures you 
want in a system. Just below it, a multiple choice determines if you want to modify this system only, 
the systems of this page or all following systems. 

Another set of choices specifies how Pizzicato will shift existing measures. This is used to limit 
the impact on an existing page layout. A check box is used to recompute the page layout for 
these pages automatically.

• The next possible operation, located in front of the System(s) per page text label, makes it possible to 
select the number of systems on a page. You can also specify if it is for the current page or for all 
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following pages. 

Another set of choices specifies how Pizzicato will shift existing systems. This is used to limit 
the impact on an existing page layout. A check box is used to recompute the page layout for 
these pages automatically.

• The third choice, Adjust systems and measures, is an operation which will smooth out the layout of 
systems and measures on the current page and possibly the following ones. 

We will examine an example for each of the three operations.

• Check the first box, in front of Measure(s) per system. A text box lets you specify the number of 
measures per system. When calling the dialog, it displays the number of measures contained in the 
system from where you called this dialog box. Change this number. Just below, keep the default 
choice, For this system only. Click OK. The score displays the number of measures on that system. 
Other measures have been shifted accordingly. 

• Call again the measure layout tool on the first staff, first measure. Select the System(s) per page 
operation. Change this number. The multiple choice located below specifies the scope of this 
operation. Keep the For this page only choice. Click OK. You will notice that the systems have been 
adapted. 

• Call again the measure layout tool on the first staff, first measure. Select the Adjust systems and 
measures operation. The first two boxes prevent Pizzicato from moving the first and/or the last 
system. If these boxes are not checked, Pizzicato readjusts these systems before aligning the others. It 
is useful when you place a title and you move the first system down to add space for it. You can then 
prevent Pizzicato from changing the position of the first system, while adjusting the others. Now 
check the For this page and the following option. Check the Distribute systems on page box. It 
equalizes the systems in the page. Click OK. Observe the systems of the first page. They are placed at 
equal distances on the page. 

You can of course adjust measures and systems manually with the measures and staves tool, as previously 
considered. But the horizontal modifications of the systems are cancelled if the automatic horizontal 
adjustment of systems option is checked in the page layout dialog box. If you need a free page layout, 
disable that option.

Since version 3.6, when you display the marks and margins, you will notice the presence of "+" and "-" blue 
buttons right to each system, as well as in the bottom of the page. The first may be used to add or remove 
one measure in the system (the others are shifted accordingly). The buttons below may be used to add or 
remove one system in the page (the other system are shifted accordingly). These shortcuts are useful to 
adjust the page layout visually and avoid to open and set parameters in the above dialog box.

One more word of caution. The above dialog moves and rearrange existing measures and staves. It will not 
create new ones. To create new ones, use the measure and staves tool.

Printing the score

After the first page layout is done, you can always calculate the page layout again by changing the values.

To print a score, select the Print item in the File menu. A printer dialog box appears. It is different for each 
printer model. Most printer lets you select the number of copies and the pages to be printed (All or From 
page… to ...). Some models also propose a choice of printing quality. In a general way, select a normal 
quality. If you find that the ties and the notes look irregular, increase the printing quality or the resolution (if 
your printer allows this). Click OK and the score will be printed.

Show or hide the staves of a system

In page mode, when you click on a measure with the right mouse button (without any selected measure in 
the score), a contextual menu presents an item named Visible staves... which calls the following dialog:
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The example displayed here is an orchestral score (you may open it through the menu File, Open a 
template..., Orchestra, Symphony number 2 - Beethoven - 1 page).

This dialog is used to individually determine for each system which staves are visible in a conductor score. 
We explained the page setup option handling this automatically according to the presence of notes or 
symbols in the measures. The above dialog provides a direct manual control on this. Here is how to use it:

• The list to the right contains all visible staves in the system and the list to the left contains the staves 
that are hidden (none here). 

• To hide a staff, double-click the corresponding line in the right list and it moves to the left. You may 
also use the "<<<" button which moves a line from left to right. 

• To display a hidden staff, double-click the corresponding line in the left list and it moves to the right. 
You may also use the ">>>" button which moves a line from right to left. 

• The buttons named All and None respectively moves all staves to the right and to the left. Warning: to 
validate with OK, there must be at least one visible staff in the system. 

• The modifications done may be applied to the current system (that is, the system that contains the 
measure on which you clicked to call the dialog) or also to the following systems. 

• The Optimize systems check box asks Pizzicato to calculate which staff to display according to the 
contents of the staves. 

• The last frame forces Pizzicato to reorganize pages according to the modifications of the systems. 
Pizzicato may or may not compute the pages up to the end or up to a specific page. 

You may then click on OK to apply the modification to the score.
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Creation assistant and parts extraction
• Creation assistant 
• Part extraction 

Creation assistant

The creation assistant allows you to define the main parameters of a new score. To reach it, select the 
Creation assistant item in the File menu. The following dialog box appears: 

To use it efficiently, follow the steps indicated here:

• Determine the total number of measures of your score. Fill this number in the text box entitled 
Number of measures. For example, fill in "32". 

• Determine the main tonality by clicking on the first Select button… The key signature dialog box 
appears. Select for example Major D (two sharps at the clef). 

• Select then the time signature by clicking on the second Select button… The time signature dialog 
box allows you to select for example 3/4. 

• The list contains by default a single instrument. You can modify its characteristics, displayed to the 
right of the list. Complete for example as follows:

 Full name: Clarinet 
 Short name: Cl. 
 Clef : Treble clef (by clicking on the clef, the clef dialog box appears) 
 Octave transposition: 0 (used to transpose the instrument by one or more octaves) 
 Check the Transposing instrument box and select the flat B note. 

• You can then add new instruments, by the Add button. For each one of them, specify the 
characteristics as above. Add for example the two following instruments:

 Organ - Org. - Treble clef - Transposition "0" - non transposing instrument 
 Double bass - Dbb - Bass clef - Transposition "-1" - non transposing instrument 

• The Down and Up buttons lets you modify the order of instruments. The Delete button eliminates an 
instrument. 

• By default, Pizzicato will propose you a page layout of the score. If you do not want it now, disable 
the Calculate page setup box. 

• Once your instrument list is established, click on the Create button. If you choose a page layout, the 
page layout dialog box appears : 
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• If needed, modify the parameters and click Compute and OK. In the previous example, the score 
appears: 

It has three pages. You can now encode the notes, modify the score and use all the tools you want. This 
dialog box is simply a fast start used to create a structure for your score.

Part extraction
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When you write a full orchestral score or a score with several instruments, it is often necessary to print the 
scores for each separate instrument. They are called a part. It is the score given to each member of the 
orchestra and which contains only what this member personally plays.

Open the Ex076.piz example. Its main view contains a score named My orchestra. Open it :

It contains 19 different staves. To obtain the oboe score, use the selection tool to select the oboe staff. Then, 
in the Edit menu, select the Extract parts item. The following dialog box appears: 

• The Group multimeasure rests box asks Pizzicato to combine consecutive rest measures. 
• The Justify measures box asks Pizzicato to justify measures once the part is extracted. 
• The following box automatically creates a page layout to prepare the printing. 
• The following menu specifies how measures are numbered in the parts. Select Each System. 
• Click OK. 
• In the page layout dialog box, disable the Set the number of measures per staff to option and click 

OK. The part score of the oboe appears: 

By calling the main view, you may observe that it contains a new score named Oboe: 

The extracted part score is now a score in itself, independent of the main score. You can modify its page 
layout if you want. All the extracted parts remain nevertheless associated to the main score and will be 
recorded together on the disk. Notice that you can select several staves to extract them together, as for piano 
and harp, both written on two staves. The two staves are then extracted and placed in a new score.
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Measures versions
• Measures versions 
• Duplicate / delete a version 

Measures versions

Pizzicato lets you to manage several versions of the same measure or of a whole section of your score. This 
possibility can be useful during the composition for example. The various versions of the measures are 
memorized with the document and can be selected for playing. If a measure has several versions, the current 
version is the one you see on the score and it is this version that will be played. Let us see that in practice.

• In a new document, fill in the following measures: 

• Select the last measure and click with the right mouse button (option-click on Mac). In the menu, 
select the Versions..., New version item. The content of the last measure seems to have disappeared. 
Use the reference marks tool (shortcut ":") and you will see: 

• The 2/2 indication in red shows that this measure contains two versions and that the viewed version is 
the second one. The first digit is the current version and the second is the total number of versions. 
Measures that contain only one version (i.e. all other measures) do not show this indication. Fill in 
this measure to get: 

• To get your first version back, select the measure, call the contextual menu (right click) to select the 
Versions..., Change version, Version 1 item. The score displays the first version of the measure: 
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• The 1/2 indication specifies that version 1 is visible and that this measure contains two versions. 
What we did here can be done with several selected measures and staves, or for the full score if 
needed. You can add as many versions as necessary to one or more measures. It is up to you to 
manage the versions and know what you do with them. 

 

Duplicate / delete a version

The version created herebefore was empty. You can also create a version based on the current version, with 
the purpose to slightly modify it.

• Select the first 3 measures of the score and with a right click, select the Versions..., Duplicate version 
item. You get: 

• Three measures were duplicated in a second version. By modifying these notes slightly, your score 
then contains two complete versions of these 4 measures. To go from one version to the other, select 
the measures and change the versions as previously explained. Select all measures and choose 
version 1. If you modified version 2, you get version 1 back: 

• To remove a version, select the measures and call the Versions... Delete version contextual menu. 
Select measure 4 and delete the version, you get: 

• The current version is deleted and Pizzicato displays the remaining version (we removed version 1; 
version 2 thus becomes version 1, because the versions are always numbered from 1 up to the 
number of versions). Notice that it is impossible to remove the single version of a measure because a 
measure has always at least one version. 

A remark must be done when using the copy/paste functions. When you copy/paste one or more measures, 
only the current version is affected by the operation. It is the same for all operations done with a measure 
(justification, transcription, MIDI data modification...).

The main symbols
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• Why add symbols? 
• Nuances 
• Tempo markings 
• Ornament 
• Other various symbols 

Why add symbols?

The note pitches and the rhythmic values placed in the measures indicate to the performer the note sequence 
he must play. A piece of music played exactly as written will seem mechanical, without life or expression.

When a composer creates a musical work, he writes of course notes and rhythms, but he will try to transcribe 
on the score the way notes must be played, with what expression, with what feeling the piece must be 
performed.

He will add various symbols on the score to describe and transmit as precisely as possible the sound effect 
he wants to achieve on the auditor.

When a musician will play this score, he will take all symbols into account to understand what the composer 
wanted to express so as to play the score in the correct state of mind.

There is a whole series of symbols influencing the way the performer will play a score. We will learn the 
most common symbols..

Nuances

Nuances specify the sound volume the performer must respect to play the notes. Here is the complete series, 
forming a progression of increasingly strong sound volumes:

The P comes from Italian Piano meaning softly. The F comes from Forte and means strongly and the M 
comes from Mezzo and means half or medium. 

Start Pizzicato and open the Ex031 example. It contains the following measures. Listen to them to 
understand the resulting sound effect :

Another symbol, called sforzando, needs to intensify the note on which it is attached:

Similarly, the accent requires to play the notes on which it is placed more loudly. Open the Ex032 example 
and listen to it:

The crescendo is a symbol requiring to increase the sound volume gradually. It is written either in letters or 
by two lines deviating one from the other:

The Diminuendo requires to decrease the sound volume gradually. It is written in a similar way:
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Open the Ex033 example and listen to the effect of these symbols on the sound volume of notes:

Tempo markings

They are written in letters on the score to specify the speed at which the piece must be played. Here are 4 of 
them, forming a progression between slow and lively:

In Pizzicato, these symbols correspond respectively to a tempo of 40, 80, 120 and 180 quarter notes per 
minute.

Two symbols modify the tempo gradually:

The first accelerates the tempo (Italian Accelerando) and the second slows it down (Ritenuto meaning 
retaining or Ritardando meaning delaying).

Open the Ex034 example and listen to the effect obtained:

Ornament

Ornaments are signs added to the notes to create a sound effect.

A trill is a fast alternation between two notes. It can be noted in various ways. Open the Ex035 example and 
listen to it:

Graces notes are signs adding notes to a main note, as a decoration. The Ex036 example contains 3 grace 
notes in the first measure. In the second measure, the first symbol is a Gruppetto and the last 3 symbols are 
Mordents. Listen to the effect obtained:

Other various symbols 

By adding a dot above or below a note, its duration is curtailed. The following measure:
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would be played in the same way as this one:

When all notes must be played like that, you may simply specify a Staccato symbol, which means detached. 
It avoids adding a dot to each note.

The Legato symbol means tying the notes together, i.e. playing them without leaving a rest between them. 
One can also use a slur to specify that a group of notes must be played Legato:

By adding a dash on a note, it means that this note must be slightly curtailed and accentuated, as in the 
following measure:

Open the Ex037 example and listen to the result:

The two following symbols specify that notes should be played respectively an octave higher or lower:

They are often accompanied by a dotted line enclosing the area where this octave transposition must occur. 
The Ex038 file contains an example. Listen to it:

The comma introduces a small rhythmic pause, a breathing in the rhythms succession. It is written as 
follows:

The pause requires to hold the note or the rest on which it is placed, and this for a while. It is written like 
this:

The following symbol applies to a chord:
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The effect produced is a slight delay to the higher notes of the chord. Instead of hearing all the notes 
together, the lower note is played first, then the following note, etc. in a rapid succession.

The Ex039.piz file contains examples of these symbols:

The sustain pedal of a piano (right side pedal) is used to hold the playing notes, even when they are released 
on the keyboard. It is often written with the following 2 symbols:

The first specifies when the pedal is pressed and the other when it is released. The pedal action is sometimes 
displayed using a hook embracing notes that must be held. The Ex040.piz file contains an example of the 
sound effect obtained:

Graphic and MIDI symbols
• Palettes, tools and symbols 
• Adding a symbol in the score 
• Erasing a symbol 
• Moving or resizing a symbol 

Palettes, tools and symbols

In this lesson, we will learn how to add symbols in the score. These symbols have a graphic aspect used to 
specify how the score must be played, such as for example nuances, tempo markings, accents… Moreover, 
most of these symbols directly influence your synthesizer or sound card, in order to produce the correct 
sound effect.

As you certainly noticed, the Tools menu contains many tools palettes. The first two contain tools to handle 
staves, measures, rests and notes, as well as tools intended to create or modify the characteristics of the 
score.

By selecting an item in this menu, the corresponding palette opens. You may then select a tool or a symbol 
in order to use it in the score.

The tool palettes starting from the third contain graphic and MIDI symbols. These symbols are formed by a 
picture or a text area that can be associated to a note, a rest or a measure. This is done in the score view. It is 
an indication for the performer on how he must play the score.

Most of these symbols directly operate on your synthesizer, as a performer would execute it. These 
influences are done via the MIDI connection. This is why they are called Graphic and MIDI symbols.

Graphic and MIDI symbols are gathered by families in the various palettes starting from the third. The way 
to add, move, modify or erase them is common to all of them. Their characteristics are different. We will see 
some examples. The explained principles are valid for the other symbols.

Adding a symbol in the score
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• Start from a new document and complete the score to obtain: 

• In the Tools menu, open the Main symbols palette: 

• Select the  tool. Click on the head of the G note in the second measure. The symbol is placed 
below the note: 

Listen to the score with the space bar. When coming to the G note, your synthesizer starts playing more 
loudly, as required by the double forte symbol. 

• In the same palette, select the  tool and place your cursor as follows: 

• Click and a symbol of crescendo appears: 

As you did not click on a note to add it, this symbol is associated with the measure and not to a note as for 
the previous symbol.

• Open the Main Palette. Click on the  tool. It is the reference marks tool. The score is redrawn and 
becomes: 

Both symbols are surrounded by a red rectangle which indicates the external outline of the symbol. It will 
help us to move the symbol. A small green line connects the FF symbol to the G note. It shows that this 
symbol is associated with this note, because to add it, you clicked on the note. The crescendo symbol does 
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not have this line, which shows that it is associated with the measure. Remember this difference because it 
will be very important so that the sound effects occur correctly.

These red and green reference marks will not appear at printing. On the screen, they are present only when 
the reference marks tool is activated. Notice that as opposed to most other tools, the reference marks tool can 
be activated independently of other tools. If you click again this tool, the score is redrawn without the 
reference marks. The shortcut of this tool is the ":" sign (two dots superimposed). By typing it on the 
keyboard, you activate the reference marks. By typing it again, you disable it.

In most cases, it is better to associate a symbol with a note or a rest than with a measure, at least regarding 
the sound effects produced with the synthesizer. Here are the differences between the two cases:

• When you move a note associated with a symbol, the symbol is moved with it and thus remains 
attached to the note. 

• When you erase a note, the symbols associated with it are also erased. 
• When the symbol is associated with a note, the exact start of the sound effect is the note start. 

Otherwise, according to the symbol, the start time is either the beginning of the measure, or a 
proportional estimation based on the position of the symbol in the measure. This last case is rather 
vague because it depends on the exact contents of the measure, with the result that the start time of 
the sound effect is not always as expected. The double forte of the example exactly starts at the 
beginning of the G note. The crescendo of the example, not being associated with a note, will start 
somewhere between the first two notes. 

• Some symbols are not, by nature, related to a specific note. It is the case of a tempo indication for 
example. In this case it is better to associate them with the measure. 

Erasing a symbol

To erase a symbol, one of the symbol tools or the arrow tool must be selected. Place the mouse arrow inside 
the crescendo symbol on the score:

Use the erase key of the keyboard. The symbol disappears.

Moving or resizing a symbol

One of the symbol tools or the arrow tool must be active.

• Click on the double forte and move it to the right and lower. The symbol follows your movement: 

By releasing it, the symbol is fixed.

• Select the  tool and click on the C note in the first measure. You get: 

• Move it a little lower so that it is not superimposed on the note. 
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When the reference marks are visible, some symbols, as this one, have a small red square in the right lower 
corner of the rectangle. This square is intended to resize the symbol. We will widen this symbol so that it 
occupies all the width of the measure.

• Click with the mouse arrow in this small square and drag it to the right. The symbol widens gradually 
by following your movement: 

By releasing it, the symbol keeps its size. This principle is also valid to modify the height of the symbol. 
You just need to drag downwards to increase it and upwards to decrease it.

Some symbols may also be shifted in oblique. It is the case of the crescendo and decrescendo symbols. To 
modify the orientation of the symbol, click while holding down the Control key and drag slightly 
downwards. The symbol is inclined by following your movement:

You can also go up so that the orientation is aligned with the notes:

Select the tool  and click on the second measure first B note:

Slurs form a special case. When the reference marks are visible, three small squares are located at the two 
ends and the center of the slur. When you drag the left end, the slur moves. When you move the right end 
corner, it follows your movements and changes the slur shape:

Drag it down to the low C. By dragging the central square, the two ends remain fixed and you can modify 
the curve aspect:
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By default, since version 3.6, when you click on the first note, the program asks you to click on the end note 
of the slur and the adjustment is made automatically, even if the end of the slur is on another system.

Select the tool  and click on the third measure first C note:

This symbol can be moved vertically but is horizontally fixed.

Examples
Listen to examples 55, 56 and 57. They use various symbols. Listen to the sound result while observing the 
graphic symbols. These sequences are intended for a synthesizer or a sound card with GM (general midi) 
standard.

The text tool
• Creation of a text block 
• Moving, modifying and erasing a text block 
• Adding a title / Page numbers 

Creation of a text block

It is often useful to add an indication in a measure, to specify the way to play or an action which must be 
done by the performer. When you do the page layout, you may add a title in the score and page numbers. All 
this can be done with the text tool.

• Open the Ex058 document. Open the Main Palette and select the  tool. It is the text tool. Place the 
mouse cursor below the first measure: 

• Click. The following dialog box appears: 
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This dialog box is used to introduce all characteristics of a new text block. Write the words Text example in 
the large blank area. It is the text that will appear on the score.

• Click on the Select colour... button. A dialog box gives you a choice of various colours. Click in the 
red box and then click OK. 

• Click now in the Select font... button. The font dialog box appears: 

The left list contains the various fonts among those available on your computer. It will not necessarily be the 
same list as above.

• Select the Times New Roman font. 

• Change the size, i.e. the height of the characters by replacing number "9" by "12" in the text area. 
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• In the list of the styles, select Bold Italic. Click OK and you go back to the previous dialog box. 
Notice that the text is not displayed yet with the selected font. On the other hand, in the lower part of 
the dialog box (right side on the Mac), a text sample shows the colour and graphic aspect. 

The little menu located next to the word Justify lets you select between 4 modes : justify the text on the right, 
on the left, in the center or left and right. This is used when you introduce several lines of text. Pizzicato will 
align them as required.

The top left multiple choice specifies how the text block is managed. Leave it now on On measure 1 of staff  
2. We will come back to this option further. Click OK. The first two measures become:

The text block was added with its top left corner where you clicked, with the requested font, colour and 
characteristics.

With the "+" and "-" buttons, you can zoom in and out in to edit the text more easily.

In the font selection box, you can also select the script, which means the set of characters used, for instance 
in Hebrew, Greek or Arabic.

Moving, modifying and erasing a text block

• Activate the reference marks tool by typing the sign (:) on the keyboard. The measures become: 

A rectangle shows the text block shape, exactly as it was the case for the symbols. Notice that you are not 
forced to activate these reference marks to modify, erase or move blocks of text or symbols. These reference 
marks are there only to help you locate the text block area or the symbol.

To move, modify or erase a text block, the text tool or the arrow tool must be activated. Move now this text 
area to the left, as you would have done for a symbol. The block follows your movement.

To modify the text contained in this block, double-click inside its borders. The text block dialog box comes 
back and allows you to modify it. Click OK.

• Place the cursor slightly below the second staff second measure and type lower case letter "t". It is 
the shortcut to create a new text block. The text block dialog box appears. Fill in the following text, 
by respecting the way lines are arranged (return key): 

This is a nice little text
intended to show what is
justification of a text block
in the Pizzicato program
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• Notice that the style and colour of characters are the same as the previous block. Select Left and right  
justification. Select the black colour and the Times New Roman, Normal font, size 9. Click OK. The 
measures become: 

• You can now increase the size of the text block by dragging the small red square in its bottom right 
corner, as for the symbols. Resize it to obtain the following result: 

As the text is justified on both sides, Pizzicato does not take into account the line breaks and organizes the 
text so that it is in the width of the block. You can test by yourself what the other justification modes give.

• To erase a text block, it is the same principle as for a symbol. Place the cursor arrow in the first text 
block area and use the erase key. The block disappears. 

Adding a title / Page numbers

The text blocks which we added were automatically associated with the nearest measure to the location 
where you clicked to add them. When you do a page layout or if you move measures around, these text 
blocks will move with measures and keep the same position compared to their reference measure. The 
multiple choice located in the upper part of the dialog box lets you associate a text block with a page, so as 
to create a title and a page number.

• Place the mouse cursor as follows: 

• Type the small letter "t". The upper part of the dialog box shows: 
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Pizzicato selected by default the second choice, showing that the text block belongs to the first staff second 
measure. For a title, this text block must be independent of any measure. Check the first choice On page 1. 
This block will thus be attached to page 1 and will not move with a page layout or any measures 
displacement. Notice that it will not be visible in linear mode.

The third choice is used to associate the text block to a range of pages. It is useful for example to number the 
pages or indicate a copyright notice.

In the case of a page text block, you can specify if the text is displayed on even pages and/or odd pages.

For a block associated with a page (first and third choices), you can specify the type of the block with a 
multiple choice:

• Normal block: the block can be moved all over the page 
• Header: the vertical position of the block is aligned on the upper internal margin 
• Footer: the vertical position of the block is aligned on the lower internal margin 

The Do not move option prevents from moving the text block, which is then fixed to the page.

The Center on page option fixes the horizontal position of the block at the horizontal center of the page.

Just below, it is possible to fix the space between lines for a block with several lines.

The Copy button memorizes the text block and its characteristics. After that, when creating a new text block, 
the Paste button lets you copy the same text and characteristics as the block previously copied.

Fill in "Score title" in the large text area. Select the Times New Roman font, size 16 and select the Bold style. 
Click OK. The score becomes:

We will now add a page number. Place the cursor as follows:

and type the shortcut "t" on the keyboard. Take the third choice, From page 1 to page X (last page). Select 
the Times New Roman font, size 10, normal, and check the Underlined option. In the main text area of the 
dialog box, fill in "- $1 -". The "$1" group specifies to Pizzicato that it must replace these 2 characters by the 
number of the current page. You could also indicate "Page $1" or any other text which contains the $1 
group. Each time Pizzicato finds this group in a text block, it replaces it to display the current page number. 
Click OK and disable the reference marks. The score becomes:
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The $ sign is used to add a parameter to the text block. There are presently 3 possible values:

• $1 is replaced by the current page number 
• $2 is replaced by the total number of pages of the score 
• $3=xx$ is an expression which will not be displayed but that will fix the number "xx" of the first 

page. For instance, if you need to number the pages starting from 11, insert the expression "$3=11$- 
$1 -" and Pizzicato will display "- 11 -" for the first page, "- 12 -" for the second page, etc. Please 
note that this expression must be inserted in the beginning of the text block, or at least before the use 
of the "$1" expression. 

Exercise
As an exercise, place your name below the title, slightly to the right. In the top left corner, write in very 
small characters: Printed with Pizzicato.

Bar lines and repeats
• The various bar lines 
• Repeats 
• Other repeat signs 

The various bar lines

The bar lines seen until now are vertical lines delimiting the measures on the staff.

To terminate a score, a thin bar followed by a thick one is placed on the last measure:

To separate several distinct parts of a score, a double thin bar may be used:

It is often used during a key signature change or between the various sections or movements of a score.

In some types of music (especially contemporary), one does not separate the staves in measures. The staff is 
seen as a support for notes, but the concept of time slicing in equal durations is no more used. Performance 
is often much freer or follows other criteria specified by the composer.

Repeats

It is common to play several times some sections of a music score, such as for example a chorus or a theme 
which is played twice. One could simply write the concerned measures twice, but it would be a loss of space 
and useless work.

Let us take the simplest case. A given number of measures must be played twice. To specify that, a special 
bar line is placed on the left of the first measure of the passage and on the right of the last measure of it. 
They are repeat bar lines. Here is a practical example:

The measures from 2 to 5 (i.e. the measures located between the two repeat markings) must be played twice. 
The musician who reads this score will thus play the measures in the following order:

1 - 2 - 3 - 4 - 5 - 2 - 3 - 4 - 5 - 6
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When you reach the repeat sign of the 5th measure, you simply returns to the previous and corresponding 
repeat sign (measure 2) and you play from there again. The second time, you continue playing through 
measure 6 without taking the sign into account.

There is another frequent case. Here is an example:

The measures numbers are placed higher to leave the space for the signs "1." and "2." located in measures 4 
and 5. The presence of these new signs modifies a little bit how the repeat must be played. The first time you 
start from the first measure up to the measure located under sign "1." and returns as previously to the 
previous repeat sign (measure 2). The second time, you skip the measure located under the "1." and directly 
play the measure located under the "2." and continue to play the following measures. The complete sequence 
thus becomes:

1 - 2 - 3 - 4 - 2 - 3 - 5 - 6
This form of repeat is often used and there can be several measures located under sign "1.". In this case, at 
the second passage these measures are not played and you skip directly to sign "2.".

Other repeat signs

The following sign is sometimes used:

often accompanied by the term Coda. It sends back to a passage which finishes the score. It is often used in 
combination with the signs:

 and 

The second sends back to where the first is located, as for a repeat. Here is a concrete example combining 
these signs:

The sequence of measures is then:

1 - 2 - 3 - 4 - 5 - 2 - 3 - 6
Let us notice that the this notation is here equivalent to:

When a measure is repeated for only one instrument in a score with several staves, it is common to fill the 
measure with the following symbol:

It means that the contents of the measure is the same as the previous measure. Thus, the 2 measures:
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may be written as follows:

The same principle is valid to show that two measures are repeated, by using the sign:

The two following examples are equivalent:

Bar lines and repeats
• Modifying bar lines 
• Simulation of repeats 

Modifying bar lines

• Start Pizzicato and open the Ex059 example. The score view contains the following measures:

• Open the Main Palette and select the bar lines tool . Click on measure 5. You get the following 
dialog box: 
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It is also possible to reach it without the tool palette. Place the mouse cursor on the measure and use the 
upper case letter "R" on the keyboard. This shortcut directly calls this dialog box, without activating the tool 
on the palette.

The upper part relates to the graphic aspect. Two menus let you select the left and right bar lines type. An 
example measure directly shows the graphic result. The available choices are:

They graphically correspond - for the right bar line - to the following:

  

  
The two text areas located on the right let you select several measures in which the modification will be 
done. You may for example hide all bar lines at once, by selecting Invisible for the 2 bar lines, from the first 
to the last measure of the score.

• Select Thin + thick bars for the right bar and click OK. 

• Now call this dialog box on measure 2. Select the Repeat item for the left bar line and click OK. Call 
this dialog box again on measure 3 and select the Repeat item for the right bar line. Click OK. The 
score becomes: 

Open the palette called Graphic symbols. It contains 5 symbols used to complete the graphic aspects of 
repeats in most current cases:

    
Select the fourth one and add it above the third measure. By clicking and dragging this symbol right bottom 
corner, widen it to cover the whole measure:

You may activate the reference marks tool to do so. Place the next symbol on measure 4 to finally get:

Simulation of repeats

Up to now those symbols only affect the graphic aspect of the score. If you listen to this score, you will 
simply hear 5 measures one after the other, without taking the repeats into account.

Call the repeats dialog box for measure 3. The 10 text areas located in the lower part let you fill in measure 
numbers. Each measure contains such a table. By default, the 10 numbers are "0". When Pizzicato plays the 
score and finds a measure where these digits are different from "0", it uses these numbers to skip to another 
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measure, which can be elsewhere in the score. If you set a value to -1, Pizzicato will stop playing after that 
measure, so it is possible to stop playing anywhere in the score, not necessarily at the last measure.

When Pizzicato plays a measure for the first time, it is the first number that is used to determine which is the 
next measure to play. In our example, at the first passage, after measure 3, it would be necessary to go back 
to measure 2 (repeat).

Thus fill in "2" in the text area entitled Passage 1 and click OK.

The complete sequence of the measures play must be as follows:

1 - 2 - 3 - 2 - 4 - 5

At the first passage for measure 2, you continue playing measure 3. When you play measure 2 again (second 
passage), you must go to measure 4. Call the bar lines dialog box for measure 2. Fill it to get:

Click OK and listen to the score. Pizzicato follows the sequence of measures as indicated above.

You can similarly build various repeats. Each text box specifies the number of the measure which must be 
played just after the current measure, according to the number of passages already executed on the 
concerned measure. As you may specify the first 9 passages (the tenth box is valid starting from the tenth 
passage and for the next ones), you can create very complex repeat structures. Therefore, you need to 
analyze for each concerned measures, the next measure to play for each passage and to fill these numbers in 
these measures repeats dialog boxes.

So as to be sure that this repeat system works correctly, disable the loop function in the playing options for 
that score ("..." button next to the Play/Record buttons), otherwise the loop will take priority and could 
interfere with the logic explained here.

Notice that the graphic aspect is completely independent of the Midi play aspect. You can thus combine both 
as you want. You can insert repeats which are not visualized on the score or to add repeat symbols which do 
not have an effect on the score playing. But you must know what you do and stay logical !

A repeat wizard helps you automatically calculate the passages according to the repeat bars and to various 
standard symbols found in the Graphic symbols tool palette (Tools menu), like D.C., Al Coda,... and this for 
the most conventional cases.

Click on the Wizard... button found in the Bar lines/repeats dialog and you will get te following:

267



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________
The central list displays one or more lines, with the measure sequences that will be played. In our example, 
we have three sequences 1-3, 2-2 and 4-5, which means that the full play of the score will be measure 1 to 3, 
then measure 2, then measures 4 to 5. Each line is a sequence of consecutive measures.

When you open this dialog, Pizzicato displays in it the sequences of measures resulting to all the passages 
defined in all the measures of the score. You can operate three actions with it:

• The first action is to compute the correct sequences of measures according to the repeat bar lines and 
to the various standard symbols found in the score. 

• The second action resets all passages to zero, for all the measures of the score. 

• The last action enables you to manually edit this list, so as to specify the order in which you want 
Pizzicato to play the measures. Each line must contain two numbers, separated by a dash. The first 
number specifies the first measure of a sequence and the second number specifies the last measure of 
that sequence. If only one measure must be played, the two numbers must be the same, as in our 
example "2-2". This action helps you specify any more specific way of playing the measures. There 
are indeed sometimes more than one way to interpret various nested repeat signs mixed with 
Coda/D.S./Fine/Al Coda,... 

Lyrics
• Introduction of lyrics in the score 
• Connecting or extending syllables 
• Adjusting the position of lyrics lines - Note names 
• The lyrics fast encoding window 

Introduction of lyrics in the score

When a melody is sung, each syllable is written under the corresponding note. We will learn how to 
introduce, modify, erase or adjust lyrics in the score.

Pizzicato lets you introduce lyrics under the notes of a melody. These lyrics are really attached to the note so 
as to follow the note displacements. It is possible to add 8 lines of text on each note (for the different verses).

• Open the Ex060 example and fill in the 2 following measures : 

• In the Main Palette, select the  tool. Its shortcut is the lower case letter "p". Click on the head of 
the first measure first note. A small cursor starts to blink just below the note: 

• You can directly fill in text with the keyboard and it will be centered around the note. Type "Hel" on 
the keyboard and you get: 

• To go to the next note, press the tabulator key  on the keyboard. The cursor appears on the 

next note. To go back to the previous note, you may use the tabulator by holding down the SHIFT 
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key. You can also click directly on the head of the note to place the text entry cursor on that note. Fill 
in the lyrics as follows: 

To go from one note to the next, the Return key is also valid. Notice that it is also valid to go from one 
measure to the next.

We will now add a second verse just below the first. Click on the first note. The cursor blinks to the right of 
the "Hel" text. With the keyboard, use the key with the down arrow. The cursor blinks now below the first 
syllable:

The principle of lyrics introduction remains the same, but you move on the second line. Complete the score 
as follows:

You can similarly introduce up to eight different verses on the same note. To go from one line to the other, 
use the up and down arrow keys. Complete the measures as follows:

The left and right arrows may also be used to move from one note to the other.

To modify or erase a syllable, click on the note and use the up and down arrow keys to bring the cursor on 
the correct line. The cursor blinks and you can erase with the erase key and correct the text. Therefore, the 
lyrics tool must be of course selected.

When you move a note, the horizontal position of the associated syllables is automatically adjusted. It also 
happens when you justify a measure or if you widen it. When you erase a note, the associated lyrics are also 
erased.

Connecting or extending syllables

When adding lyrics, 2 characters have a particular role: the minus sign (-) and the underscore sign (_). The 
first is used to connect two syllables of a word and the second allows to create an extension of a syllable that 
must be held for example during several notes.

We will start by connecting all the syllables belonging to a word. Place the blinking cursor on the first line of 
the first syllable and type the minus sign (-). A small line is added between the two syllables:
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Its position is automatically adjusted between the two syllables. Notice that you may add this sign at the time 
you introduce the lyrics. If you wish to remove this sign on a syllable, type it again and it will disappear. 
Using the arrow keys, complete the score so that the syllables are connected as follows:

• For the 3 syllables attached to the tied F note, we will create an extension. Place the cursor on the 
first line of this note and type the underscore sign (_) on the keyboard. A small line appears, starting 
from the bottom of the syllable: 

• Do the same with the 2 other syllables attached to this note. 

• On the Main Palette, select the  tool. This tool is used to modify the length of an extension. Click 
and drag it, starting from the right end of the line and it will lengthen or shorten by following your 
movement. Lengthen the extension of the first syllable: 

• Now lengthen the two others to get: 

Adjusting the position of lyrics lines - Note names

Having filled the text, you may adjust the position of the text lines, and this independently for the 8 verses.

• On the main palette, select the  tool. This tool is used to move the position of a line. Place the 
arrow of the mouse cursor on the first syllable of the first note. Click and drag downwards. The 
syllables located below move together. When you release the mouse button, the positions are 
readjusted in the full score: 

The lines located below the moving line are always moved together.

• Drag now the second line lower, to obtain: 
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This tool lets you adjust the vertical position of the text lines.

In the two preceding examples, the position of the line was modified in the full score. It is sometimes useful 
to adjust this position only for one staff, only for one measure or even only for one note. Here is how to 
proceed:

• By holding down the SHIFT key, move the third syllable of the first note downwards. Only the 
syllables of the concerned measure are moved: 

• By holding down the Control key while moving, you can move the syllables of one staff without 
affecting the other systems of the score. 

• By holding down the SHIFT and Control keys together, move the fourth syllable of the first note 
downwards. Only this syllable is affected: 

It is also possible to globally adjust the position of lyrics. To do this:

• Select the target measures 

• In the Edit menu, select the Adjust lyrics... item. The following dialog appears: 

• You may select the lines to adjust. The reference for adjustment can be the first syllable of the 
selected measures. The other lyrics will be aligned on the first. Or you may ask to set the default 
height. 

This function is usefull when you have worked the various voices, when you want to equalize them all.

In the same Edit menu, you will find an item with the title Note names to lyrics. It will automatically place 
the note names (C, D,...) into the corresponding lyrics. For chords, several lyrics lines will be used.
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The lyrics fast encoding window

• In the Windows menu, select the Lyrics item. The following dialog box appears: 

This dialog box allows to encode or to modify the lyrics in a text area for a whole verse. The encoding rule is 
that each space, minus sign or line return correspond to a passage to the next note. The absence of a syllable 
for a note is represented by a star (*).

The underline symbol ( _ ) may used to create a space inside the text of a lyric, which is useful if you need to 
place several lyrics under the same note. By writing for instance "Ta_te_ti" in the text area, the three lyrics 
will be associated to the same note and on the score you will see "Ta te ti" under the corresponding note.

If you use the equal symbol ( = ) at the end of a lyric (for instance "Ta="), it specifies that the lyric will be 
drawn with an extension sign (the length of which can be adjusted with the previously explained tool). If you 
want to use the equal sign itself within a syllable, precede it with the '\' character.

The minus sign '-' is considered as a syllable separator and forces the text to continue on the next note. 
However, if you want this sign to appear within the text of a single note, you may precede it by the '\' 
character. The text "Give\-us" will be considered as a one note text and will be displayed as "Give-us" under 
a single note in the score.

The Line menu selects the line on which you work and the Staff menu selects the staff (here there is only 
one). Select successively lines 2, 3, 4 and 5. You see the lyrics introduced previously. The fifth line is 
presented as follows:

There is one star per note. Replace this text to have:

Notice that when you modify the text, the first two menus become disabled. Click the Apply button to 
validate the modifications of the current line. These menus are enabled again.

In the upper right corner of the dialog, two buttons are used to select the colour and the characters font used 
for the current text line and staff. These values can be different for each of the 8 text lines and for each staff 
of the score.

If you click OK, the score contains an added text line:

272



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

This dialog box is advised for the encoding of lyrics. It lets you easily shift the lyrics of one or more 
syllables. Moreover, with the Windows copy/paste functions, you can easily duplicate a whole verse from 
one line to another.

Since version 3.5.3, two buttons "+" and "-" are used to zoom in and out, so as to edit the text with an 
adequate size.

You can also specify the script in the font selection dialog box, which is the set of characters used to display 
text, like Hebrew, Greek or Arabic.

Since version 3.6, you can also select the center, left or right alignment of lyrics with the popup menu next to 
the "+" and "-" buttons.

The chords library
• Consulting the library 
• Modifying the symbols 
• Modifying the library 

Consulting the library

Pizzicato contains a chords library. As we have learned, a chord is a set of notes played simultaneously. 
Conventions exist to represent chords in the form of numbers and letters.

In a general way a chord will be written as follows:

Note Chord / Bass
where:

• Note is the note name, with or without an accidental, for example C# 
• Chord is the abbreviation of the chord type 
• Bass is optional and is the name of the note (with an optional accidental) played by the bass (i.e. the 

lowest note). This note may or may not belong to the chord. 

The most common abbreviations are available in the Pizzicato chords library. In the Options menu, select the 
Chords library item. The following dialog box appears: 
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According to the Pizzicato version, some elements are not present.

The chord types list is located on the left. For now, the first line is selected. The chord notes list (located in 
the center of the dialog box) displays how the chord is built, by taking the C note as the root note.

This first chord is a particular case. It is the Major chord. Its abbreviation is empty, in other words it is the 
chord by default. A chord may be called C and it means the three notes C, E and G. If you speak about an F 
chord it means Major F and contains the F, A and C notes. To better understand how chords are structured, 
see for example the lesson about composition.

Click for example on the chord named min b5. The notes which constitute it appear on the right : C, flat E 
and flat G.

You can thus examine each chord. The notes are visualized each time in relation to the C notes.

In the top right corner, a multiple choice determines how notes will be named. You may select the French 
denomination (Do, Re, Mi, Fa, Sol, La, Si, Do) or the international name by letters C, D, E, F, G, A and B. If 
you change this choice, you must click OK to validate. From there on, Pizzicato will display note names 
using that preference.

Another option, named Notation, is by default on Standard. The two other choices are used in the case of the 
C, D, F,... notation, to use the german and semi-german notation convention. When selecting German, the 
"B" will be displayed as "H" and the "Bb" will be displayed as "B". When selecting Semi-German, the "B" 
will be displayed as "H" and the "Bb" will be displayed as "Bb".

Two check boxes may be used to save the space used by a chord on the score, by replacing "Maj" by "M" 
and "min" by "m". They are checked by default.

Modifying the symbols

In the right part of the dialog box, a series of items determine how chords symbols are placed and drawn.

• Vertical position determines the height at which the default chord symbol is placed. It is a negative 
distance, compared to the upper line of the staff. Its normal value is -24 (-12 before Pizzicato 3.2). 

• Horizontal justification offers three choices: Left, Center or Right. It affects the position of the chord 
regarding the beat of the measure associated with it. 

• The Symbol button lets you modify the structure of the default symbol chord. The following dialog 
box appears: 
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If you wish to modify this symbol, see the lesson explaining the drawing tools. The 
modifications you can make must only concern the colour or the position of the objects. The 
objects above should never be removed nor exchanged. To proceed otherwise would cause a bad 
chord display. The six graphic objects display the chord symbol in the format explained at the 
beginning of this lesson. The third object is the type of the chord, i.e. the name which appears in 
the library list.

• The Font button fixes the characters font used to draw the text of the chords symbols. 

These adjustments are valid for all chords of the list.

However, it is possible to personalize the drawing of one particular chord. Click for example on the chord 
named Maj7 (# 5). Notice that the Default symbol check box is not checked. It means that the name of the 
chord (here Maj7 (# 5)) will be replaced by a personalized picture for this chord. Click on the Symbol…
button just to the right and the following drawing appears:

It is constructed by two text blocks. The first is a triangle resulting from the Pizzicato musical font and the 
other is a simple text line containing (# 5). In the score, a chord of this type built on the C # note, with a flat 
E at the bass would thus be represented as follows:

Modifying the library

You can modify the library by adding new chords to it.

• Click on the Add a chord button. A new chord appears. It is named Chord. The text box entitled 
Chord name is used to modify this name. 

• Check the box entitled Note 2. The menu located just to the right becomes active and allows you to 
select a note. Click on this menu and select the Flat E item. 

By clicking the Note 3 box, you can then add a third note to the chord, and so on.

To modify an existing chord, select it on the left list. Its notes appear and you can modify, add or remove 
notes.

The Down and Up buttons let you to modify the order of the list.

• Select the chord named Chord and click three times on the Down button then on the Up button. 
Observe the chord position. 

• Now erase this chord by selecting it and by clicking on the Delete chord button. It disappears from 
the list. 

We advise you to keep most of the existing chords, so as to keep a compatibility with the following versions 
of Pizzicato. On the other hand, do not hesitate to complete the library by adding other chords or alternatives 
to the original chords.

The chord tool
• Adding, moving and erasing chords on the score 
• Adjusting chords globally 
• Converting chords into notes 
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Adding, moving and erasing chords on the score

We have seen that Pizzicato offers a chord library. To add chords in the score, use the chord tool : .

Create a new document with Pizzicato and select this tool in the main palette. Place the mouse as follows:

Click. The chord selection dialog box appears:

You may entirely characterize the chord you want. Let us examine the various parts:

• The first line selects the note on which the chord will be built: C, D,… B. The flat or the sharp can be 
selected by clicking on the adequate icon. 

• The table right below selects the type of chord. It contains each type of chord corresponding to the 
chords library as previously explained. The last one is "+++" and is only available in Pizzicato 
Professional. It can be used to define a customized chord. 

• The Bass check box activates what is called an alternate bass: it is the lower note which will be 
played by the bass. This note may or may not belong to the chord. To specify the bass, select a note 
to the right, with an optional sharp or flat. 

• Progressively with your selection (note, chord, bass), the complete name of the chord appears in the 
text box entitled Chord name. You can also enter the chord directly here. The following shortcuts can 
be used: "j" for "Maj" and "p" for "#". 

• The lower frame specifies the time position in the measure when the chord becomes effective. A 
menu selects the beat of the measure and a text box adds a fraction of a beat (in unit - a quarter note 
equals 480 units). 

• On the right, a guitar chord diagram is shown. See the guitar tools lesson for more information about 
it. 

Click OK. The score becomes:

The chord was added in the score. Click to the right of this chord. We will add a Maj7 F chord with a C bass. 
In the dialog box, select the following:

276



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

Be sure that the starting beat is well the third beat (in the bottom of the dialog box) then click OK. The score 
becomes:

To modify a chord, double-click on it. The definition dialog box lets you modify it. By activating the 
reference marks (shortcut ":"), the chords are surrounded by a red rectangle used to visualize their sharp:

Using the chord tool, complete the score to have:

You can slightly move a chord in the measure, horizontally or vertically. The horizontal displacement is 
active for all chords, so that they all remain at the same height. If you move a chord by holding down the 
Control and/or SHIFT keys, you obtain the following behaviours:

• SHIFT: only the chords belonging to the same measure are moved 
• Control: only the chords belonging to the same staff are moved 
• SHIFT and Control: only the clicked chord is moved. 

To erase a chord, place the mouse on it and use the erase key.

Adjusting chords globally

Once all chords are placed, it can be interesting to adjust them globally. Activate the selection tool  and 
select the first staff to have:
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In the Edit menu, select Chords then Adjust chord symbols. The following dialog box appears: 

You may select the type of adjustment. Click OK. In this example, no notes are present in the staff. When 
notes are present, this adjustment function aligns the chords with the notes.

Converting chords into notes

When you have a series of chords on the staff, Pizzicato can transform them into notes in the measures.

Select the first staff as above. In the Edit menu, select Chords… then Convert chords into notes… The 
following dialog box appears: 

The various options determine how Pizzicato will generate the notes:

• The range fixes the limits within which notes will be added. The two menus respectively give the 
highest and lowest note. 

• Just below, select the notes which can be generated, among all the intervals of the chord. The All and 
None buttons allow to select or disable all notes at once. 

• The frame entitled Generated rhythms determines the rhythmic values to use. The first choice keeps 
the same chord during its full duration. In other words, the chord is started only at the beginning of 
the chord and is hold until the next chord. The second choice specifies a regular duration. The chord 
will be repeated with that rhythm value. The last choice is accessible only when a rhythmic cell exists 
within the document. In this case, you may generate the chords with any rhythmic pattern you can 
determine with the contents of the rhythmic cell. For more information, see the lesson on 
composition libraries - rhythmic cells. 

• The frame entitled Parameters regulates the duration of the notes. By default, it is 100%, each note is 
hold for its full duration. If you fix 50% and if the rhythmic duration of notes is the quarter note, then 
notes will be played as eighth notes alternated with eighth rests. Just below, you can select the 
maximum number of notes used to form the chords. The third parameter selects the minimal distance 
there will be between two notes of the same chord. 

Click OK. The score becomes:
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Now select the second staff to have:

Call the above dialog box again and select the various options as follows:

We want here a bass note generated for each beat. Click OK and listen to the result:

This function can be used to generate melodies which accompany a chord progression. You can combine all 
the options of the dialog box to generate accompaniments easily. We advise you to explore the multiple 
possibilities on yourself.

The chords progression window
• Fast encoding and visualization of chords 

Fast encoding and visualization of chords
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Pizzicato Professional provides a window with direct access to all chords of the score. It is used to quickly 
and visually encode a sequence of chords.

Start from a new document and select the Chords Progression… item in the Windows menu. The following 
dialog box appears:

The upper part represents the measures, numbered starting from 1. An horizontal scroll bar is used to move 
and visualize the following measures. Right to this bar, two buttons - and + respectively allow to see the 
measures smaller and larger and thus to see more or less measures at once.

To add a Major C chord during two beats, do the following:

• In the central part of the dialog, select a 2 beats duration. 
• Click on the Add button and the chords progression becomes: 

The C chord is selected (in black). It is the current position in the progression. Click again on Add and you 
get:

A second chord is added just to the right. Its duration is also two beats and it is now selected. The current 
position is advanced with each addition of a chord. The characteristics of the selected chord are displayed in 
the left part of the dialog box. Let us modify for example this chord in Maj7 F on a C bass. Do the following:

• Select the F note, just below the progression (entitled Root note) 
• In the chords table, select the Maj7 chord 
• Check the Bass box and select the C note right to it 
• Click the Modify button. The progression becomes: 

If you check the box Automatic update, the current progression chord directly changes when you change the 
note, the chord or the bass. For the rest of this lesson, keep it disabled.

Now add a 4 beats D chord:

• Click on the D note 
• Select the first type of chord in the table (empty box) 
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• Disable the Bass check box 
• Set the duration to 4 beats 
• Click on Add. The progression becomes: 

Add similarly a 4 beats G chord then a 2 beats G 7 chord. You get:

The duration of a chord can easily be modified. You can lengthen or shorten a chord by clicking and 
dragging its right border. Move for example the right side bar of the G chord and bring it to the second red 
reference mark of measure 3 (the red reference marks show beats in the measure). The progression becomes:

Notice that the chord located to the right (G 7) is automatically moved. It would be the same for all chords 
located to the right of the resized chord.

By clicking on a chord of the progression, it is selected. You can then modify it as previously explained.

To insert a 4 beats C chord before the D chord, proceed as follows:

• Click on the D chord to select it 
• Select the C, as well as the first type of chord in the table (empty box) 
• Select a 4 beats duration 
• Click on the Insert button. The chords which follow are shifted and the progression becomes: 

To remove a chord, select it and click on Delete. The chord disappears. If there are one or more chords 
follow it, they keep their positions, but if there is a chord preceding it, it is lengthened to fill the space of the 
deleted chord.

You can also add chords in text mode. We will for example add the F, C Min and G# 6 chords to the 
progression. Do the following:

• Click on the last chord (G 7) 
• In the text box entitled Chord name, type the F text 
• Click on the Add button (this button is the default button, it is also activated with the Enter or Return 

keys) 
• In the text box, type C Min then the Return key 
• In the text box, type G#6 then the Return key 

It is a fast method to introduce a progression of chords. The progression becomes:

Click OK. At this point, the score does not automatically display the chords symbols. You simply associated 
a chords progression to the score. You can use it thanks to the Chords… menu located in the Edit menu. 
With the selection tool, select the first staff of the score. In the Edit ... Chords… menu, select the Place 
chords symbols item. The score becomes:
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Pizzicato created and placed the chords symbols on the selected staff. Notice that the chords progression is 
associated to all staves of the score. You could have done the same with the second staff.

Once the chords are encoded, either with the chords progression window or with the chords tool, the result is 
the same. You can indifferently modify them by double-clicking an individual chord or by calling the 
window explained in this lesson. Similarly you can transform the chords into notes, as seen in the previous 
lesson.

The check box "Update symbols in the score" enables Pizzicato to check all the chord symbols and 
automatically update them after you validate this dialog.

The last three options concern the score arranger. They will be explained in the lesson on the score arranger.

On the right side of this dialog, you can see the guitar chord diagram appear when you select a chord. You 
can click the Fill in the diagrams to ask Pizzicato to find diagrams for each chord of the chord progression. 
When you click on the diagram box, you can select a diagram from the library. See also the lesson on guitar 
tools.

Chords analysis and search
• Analyze the chords of a score 
• Searching chords for a melody 

Analyze the chords of a score

Pizzicato lets you analyze the chords of a score, i.e. to discover the name and the type of the chords formed 
by the notes contained in the score. Open the Ex072 example. The following score appears:

With the selection tool, select these 4 measures for both staves. Select the Edit menu, then Chords… and 
Chords analysis… The following dialog box appears: 
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It lets you specify how Pizzicato will analyze the chords:

• The frame entitled Analysis determines the analysis duration. By default, it is the half note which 
means here that Pizzicato will analyze two chords per measure. The following choice, Every measure 
shows that there will be an analysis for each measure and one chord found for each. The next choice 
executes an analysis for each note of a given staff (for example a bass or a melody). 

• Three choices are available to determine the chords to use. The first choice gives you access to a 
dialog box used to individually select the chords to use. The second choice takes all the chords of the 
library into account. The third choice limits the chords to use according to the number of notes in the 
chords. By default, Pizzicato uses the chords having between 3 and 4 notes in the library. 

• The minimal chord similarity fixes the precision level used to generate the chords progression. The 
higher it is, the more Pizzicato will be precise and restrain the possible chords in the analysis. 

• The Staves included… button gives you access to a dialog box used to select the staves taken into 
account to analyze the chords. By default, the selected staves are activated, but you can modify them 
(for example to exclude a percussion staff). The Take bass into account box forces Pizzicato to use 
the bass if the chord is not in its fundamental position (alternated bass for the chord symbol). 

Click OK now. The following dialog appears: 

• At this step, Pizzicato made a first analysis and proposes you to select a tonality to be considered as 
central. In the first menu, select for example C Major. You are not obliged to select one of them. 

• The check box just below is used to automatically add the chords symbols on one of the staves. 
Check it. 

• You can also ask Pizzicato to generate the notes of the analyzed chords, in a given staff. We will use 
it further. 

• The lower frame gives you control on the possible results of analysis. In the previous dialog, we had 
fixed the precision level. All the chords of the library that satisfy this level compared to the contents 
of the analysis are correct potential candidates. For each one, a correspondence ratio is computed (in 
%). If Pizzicato finds only one possible chord for each analyzed cell, it will have globally only one 
progression satisfying the precision level. It may happen if you fix the analysis criteria in a very tight 
way (100 % of similarity and extremely limit the possible chords to use). In most cases, several 
chords will be possible for each measure or cell analysis. These possibilities multiply together to 
quickly generate many possible progressions. In our example, we have 4 measures with two cells of 
analysis per measure, that is to say a progression of 8 possible chords. If Pizzicato finds for example 
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three possibilities for each chord, that gives us 3x3x3x3x3x3x3x3 is 6561 possible progressions in 
theory! In practice Pizzicato stops with the first 999 possibilities. To decrease this number, you can 
force one or more common notes between two successive chords (menu at the bottom of the dialog). 
To know the number of possibilities, click on Calculate … In our case, you get 999. There are 
probably more, but Pizzicato stops there. The slider entitled Selection is used to select a progression 
among this set of possibilities. The first will normally be that nearest to the optimum and the others 
will be alternatives which nevertheless respect the required precision of similarity. Click OK and the 
score becomes: 

This first analysis being made, you can now easily modify it, either globally or by individual chord.

In the main palette, activate the chords tool or the arrow tool (shortcut ESC). With the mouse right button 
(Option-click on Macintosh), click on the first C chord. A menu appears:

Pizzicato displays a list of 5 chords which satisfy the precision level of similarity specified during the 
analysis. The chord currently used is checked. You can select another chord. They are classified per degree 
of similarity (% between brackets).

If you select the Tonal analysis item, you get the previous dialog and you may select another chord 
progression. This choice then affects all chords concerned by the analysis (here 4 complete measures). You 
may easily test several different progressions. Click on Tonal analysis… then Calculate… and select a 
random choice with the slider. Click OK. The chords progression changes.

Searching chords for a melody

In the above example, the musical contents of the score imposes already the color and the type of chord, 
even if some alternatives are possible, for example when Pizzicato proposes a 4 notes chord (we had 
accepted chords between 3 and 4 notes) whereas the cell contains only 3 of them. The same principle can be 
applied to find one chords progression starting with only one staff containing a melody or a bass. Open the 
Ex073 example and select the bass staff on 9 measures:
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In the Edit menu, select the Chords… item then Chords analysis… In the analysis dialog, fill the following 
options:

Click OK. In the next dialog, fill the following options:

Click OK. As you asked to convert the chords into notes on the first staff, the note conversion dialog box 
appears. Fill it to have:

Click OK. The score becomes:
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Listen to the result. You can now listen measure by measure and modify the selected chords, one by one or 
with a global analysis, exactly as previously. If you do not know very well how to create chords, this method 
gives you a first choice. You can listen to the sequences and by modifying the suggested chords, select those 
you prefer. As you proceed, the notes generated on the first staff are modified according to the selected 
chord. You can thus select the chords in an intuitive way thanks to the multiple choices of the preselected 
chords. Let us see an example with a melody.

Open the Ex074.piz example and do the following:

• Select the first staff 
• Select the chords analysis 
• Fix the similarity at 100% and disable Take bass into account 
• Click OK 
• Select the central scale in G Major 
• Activate Place chords symbols on staff 1 
• Activate Convert chords into notes on staff 2 
• Click OK then again OK. 
• Select all measures and justify them. The score becomes: 

Listen to the suggested chords. It is not the most common version… but it nevertheless does not seem too 
bad! You can now test other progressions, modify one or more chords until the arrangement feels good to 
you.

When you compose a melody, this tool helps you find the chords which would fit to accompany it. It is a 
composing tool.

The use of rhythmic voices and colors
• Rhythmic voices 
• Using rhythmic voices 
• Using colors 
• Making a note or a rest invisible 
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Rhythmic voices

A rhythmic voice is a sequence of notes and/or rests which fills the rhythmic duration of a measure. In a 4/4 
measure, here are 3 examples of rhythmic voices:

  

By adding the rhythmic values for each measure, you get each time 4 beats.

It happens that several rhythmic voices must be written on the same staff, such as for example:

The voice term comes from the vocal music, where each voice sings one melody. The above example 
contains 2 voices. The 4 quarter notes belong to voice 1 and the 2 half notes belong to voice 2.

Pizzicato handles up to 8 voices on the same staff. You may automatically or manually assign the belonging 
of notes and rests to voices and view them by colours. Let us see that with examples.

Using rhythmic voices

• Start Pizzicato. In the Options menu, select the Graphic options item. In the dialog box, select the 
Voice colour item in the Use of colours popup menu to get the following: 

This option asks Pizzicato to draw notes with the colour of the voice to which they belong. Click OK.

When you add notes with the automatic justification, Pizzicato automatically assigns the voices to notes and 
rests.

• Add a C quarter note on the staff. Pizzicato automatically assigns voice 1 to it, whose colour is red. 
The note is thus redrawn in red when you release the mouse. Add 3 quarter notes to have: 

Each note has the red colour to form the first rhythmic voice.

• Now add an E half note under the first C. The note appears in blue because it belongs to a second 
voice and is perfectly aligned with the first quarter note: 

• By adding a second half note just to the right, it appears in blue and is aligned below the third quarter 
note to complete the second voice. Add a whole note to the beginning of the measure. As the first two 
voices are complete, Pizzicato assigns the third voice to it and the note is drawn in green: 
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The use of colours lets you understand the automatic distribution of voices in the measure. It is only useful 
when you create complex measures with many different voices which imbricate the ones into the others. To 
encode notes and rests by rhythmic voices, see the lesson on the notes and rests introduction.

Using colors

When you click a note with right mouse button (ALT+Click on the Macintosh), the Edit note play... menu 
item can be selected. A dialog appears and let you select, among other things, the Custom color of the note. 
Clicking this color area opens a color palette with which you can modify the color. The same dialog can also 
be called by SHIFT clicking a note in the score.

In the Options menu, Graphism... item, there are four choices for the Use of colors:

• The default choice is Black color, which draws all notes and rests in black on the score. 

• The second choice is Voice color. In this case, notes are drawn in the colour of the rhythmic voice to 
which they belong. 

• The next choice, Track color, draws notes and rests in the colour associated with the staff. This 
colour may be selected in the instruments view. 

• The last choice is Color by scale/chord. This option is quite interesting to compose music. When the 
score has chords in it (encoded with the chord notation tool) the notes are then displayed in three 
colours: 

• Green: the note is part of the current chord. 
• Orange: the note is part of a scale deduced from the chord 
• Red: the note is not part of the chord neither of the scale 

Only the first choice (Black color) displays the possible custom colors defined for notes.

Some Pizzicato versions have an automatic color assignment function, based on the note name, the note 
frequency or the guitar fingering.

• Create a new score and add a few notes or open an existing score. Select all measures and go in the 
Edit menu to choose the Assign colors to notes... item. The following dialog appears: 

You can assign colors to notes in four different ways:

• From the note name - The leftmost color column lets you select the colors for each note 
name. Just click the color area and the color palette appears. Here, all C notes will be 
colored in light yellow. 
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• From the note pitch - The two central columns are used to assign the colors to the 12 note 
pitches of an octave. Here the principle is that each note frequency (within one octave) 
have a specific color. 

• From the fingering - In a guitar tablature, it is possible to assign the fingering to the 
notes. The last column is used to assign a corresponding color to each fingering. 

• Black color - Is used to reset all colors to black. 

Here is a possible result (based on the note names):

If the Save choosen colors checkbox is checked, your color selection will be saved for the next 
call to this dialog. You can then customize the color table for note names, note pitches and 
fingering.

Making a note or a rest invisible

• Select the  tool in the Main palette. 

It lets you to make a note or a rest invisible. The note or rest keeps its graphic position and is played but is 
not displayed in the score. This feature is mainly used to be able to hide rests when several rhythmic voices 
are introduced. Click on the note or rest and it becomes invisible. By clicking it again, it becomes visible 
again. Click on some notes of the measure to see it happen. In the Graphic options… dialog box (Options  
menu), you will find a check box allowing to see invisible symbols, in case you add an invisible note or rest 
which you cannot find any more…

The guitar tools
• Principles of fretted instruments 
• The guitar fretboard window 
• Tablatures 
• Using tablatures 
• Tablature parameters 
• Chords diagrams 
• The diagrams library 
• The tablatures library 

Principles of fretted instruments

There are numerous instruments that are based on frets, like the guitar, the banjo, the electric bass guitar, the 
mandoline,... They all use the same principle: the vibration speed of a tighten string may be changed by 
shortening the length of that string so that they can produce a scale of notes.

These instruments have a series of strings (usually 4 to 6), each tuned on a specific note. By pinching a 
string, it starts to vibrate and to produce the corresponding musical note. These vibrations are amplified by 
the body of the instrument or by microphones (as in electric guitars).
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By shortening the length with which the string can vibrate, the frequency (speed of vibration) increases, so 
the corresponding note sounds higher. So there is a series of bars, called frets, against which a string can be 
pushed with a finger, so that its free vibrating length is shortened and the corresponding note higher.

The series of notes produced when all strings are not pushed against a fret (this is called an open string), is 
called the open tuning of the instrument. For the standard guitar, the notes are respectively E, A, D, G, B and 
E. These are the notes produced when pinching one of the open strings.

If you push your finger so that the string is pressed against the first fret and if you pinch the same string with 
the other hand, the note produced is one half step (semi-tone) higher. The second fret will produce a note 
two half steps higher than the open string, and so on. For each string, you have a full chromatic scale that 
covers ordinarily one to two octaves. As the open string notes are based on different notes from different 
octaves, the full set of notes that can be played is ordinarily 2 to 4 octaves. Often, one given note can be 
produced by two or more strings pushed on different frets.

According to the physical distances of the frets, to the open tuning of the strings and to your ability, you can 
produce a chord by various combinations of strings and frets played together.

The guitar fretboard window

To illustrate these principles, you can start Pizzicato and open the Guitar fretboard... item of the Windows 
menu. The following window appears:

The strings are represented horizontally. The lowest string is the lower note. When you click on a string in 
the left black part, you hear the open string note and the name of the note appears as follows:

Clicking a string in the next column of the window will produce the note of a string pushed on the first fret. 
And so on for the second fret, the third fret,... Take some time and play on various strings and frets to see 
and hear which notes are produced. This window acts exactly like the piano keyboard window but for a 
guitarist. Here are some tips that you can use with this fretboard:

• You can click and hold down the mouse button while moving it around on the various strings and 
frets. The notes are played as you move on them.

• You can hold the CTRL key while playing on the fretboard so that the notes are held when you 
release the mouse button. It acts in a similar way as the piano sustain pedal, except that only one note 
of a given string can be held at a given time (so a maximum of six notes can be heard here). You can 
use this to test and try various chords. To release the playing notes, use the ESC key on the computer 
keyboard.

• You can use this window to enter the notes step by step on a staff, exactly as explained for the 
keyboard window.

• You can reach an option dialog by using the right mouse click (ALT+click on the Mac) inside the 
window. The following dialog box appears:
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 You can modify the graphic width of the frets by changing the first two numbers. The 
first one specifies the width of the first fret, in pixels (smallest graphic point on a screen). 
By increasing the second number, you shorten the following frets.

 The Instrument menu is used to select the fretted instrument you want the fretboard to 
simulate. By default it is the standard guitar, but you have a selection of about 240 
instruments.

 Checking the Display note names will display the names of every note on the full 
fretboard. It can be useful to explore the fretboard if you are a beginner.

 Checking the Display equivalent notes will display all equivalent notes of the notes you 
play on the fretboard. If you play one note, this will help you to locate the other ways you 
can play that same note on other strings.

Tablatures

The way notes are written on a 5 lines staff is quite alien to the physical position of the fingers on the guitar 
strings. So a more convenient way to write music for the guitar has been developed: the tablature. Basically, 
we use one line of the staff for each guitar string. For the standard guitar, we get a 6 lines staff. The bottom 
line is the lowest note. There is no sense using a G or F clef, so we use a special (TAB) symbol, showing 
that the staff should be interpreted as a tablature. Often, the lines of a tablature are more spaced than for a 
normal staff. The vertical bar lines can be used to separate measures, as in a normal staff. Here is an 
example:

You should notice that in this representation, the left to right direction represents time going on, as in a 
normal staff. You should not confuse the bar lines with frets (as these are also vertical lines).

On a tablature, notes can only be placed on a line, not between lines. Indeed, we have to keep in mind this 
unique association of each line staff with a guitar string. If we specify a string by placing a note on the staff, 
there is still one information missing: on what fret should we press a finger to get that note? This is solved 
by placing the fret number in place of a standard note head. Here is an example:

The "0" number means that the string is played open (with the string not pushed against a fret). Number "1" 
means that the string is pushed on fret 1 and so on. You can notice that rhythmic notation may also be used, 
as in a normal score. We can use rests and others symbols specific to the guitar or not.
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Using tablatures

Let us open a tablature template. Go in the File menu, Open template... and select a template with a guitar 
tablature. Here is one example:

Open the Notes and rests palette in the Tools menu and select the quarter note tool . Add four notes on 
the four first lines of the tablature, in the first measure, so as to have:

The same principle may be applied with the other rhythmic values as well as with rests. The main difference 
with a normal staff is that the note head is always a number, so there may be in some case some confusion 
whether a note head is a quarter note or an half note, but most of the time the layout of the measure will 
solve this confusion.

There are three ways to change the fret number assigned to a note:

• You can select the sharp or flat tool and click on the notehead. A sharp increases the note by a 
semitone, thus it increases the fret number by one. The flat decreases the note and so decreases the 
fret number. You may also use their shortcuts, which are the '+' and '-' keys of the computer 
keyboard. To apply the shortcut, move the mouse so that the cursor points on the notehead and hit the 
shortcut on the keyboard. 

• You can use the contextual menu of the notehead with a right-click on the notehead and a menu gives 
you a list of fret numbers from 0 to 32. You can then select a number directly. 

• Or you can with the same contextual menu open the Edit note play... dialog box and change the 
corresponding fret popup menu directly. 

You can move a note on the tablature and you will observe that Pizzicato will try to adapt the fret number so 
as to keep the same note pitch. For instance, if you move the note from line 1 to line 2, Pizzicato will keep 
the same fret number, as it is not possible to play the lower note on a higher string. But if you move it back 
on the first line, Pizzicato will change the fret number to 5, which is how to play the same note as the second 
open string but by using the first string.

Most of the graphic symbols may be placed on a tablature in the same way as with a normal staff (dynamics, 
tempo change, accents, tuplets, chords,...). Using these principles, fill in the tablature to display:
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By using the note contextual menu (right click on the notehead), you can also check the two following 
options:

They will respectively give the following results:

The Fingering menu lets you specify which finger is used for that note. Presently, this information is not 
displayed automatically on the tablature but may be used to color the notes according to the fingering.

You can of course play the tablature as any other staff. You can change the assigned sound, volume, reverb 
and all other effects by using the instruments window (in the Windows menu).

In the Tools menu, you will find a tool palette with several symbols that can be used specifically for the 
guitar. You can use them as explained in the lesson about graphic and MIDI symbols.

Tablature parameters

You can modify some tablature features or you can change a normal staff to a tablature and vice versa.

• In the File menu, select a template with a guitar staff (not a tablature). Add a second staff under it, 
with a right-click in the first measure and select Measures and staves... then Add one staff below. 

• Double-click in front of the second staff (with the cursor tool active; to activate it, use the ESC 
shortcut on the computer keyboard) and a dialog appears showing the staff characteristics as we have 
seen it in another lesson (Characteristics of staves). The frame entitled Tablature in this dialog is 
used specifically for the fretted instruments using tablatures: 

With the first popup menu, you can select the type of instrument you want. The first available 
choice when you click it is the standard guitar with 6 strings, tuned on E1,A1,D2,G2,B2 and E3. 

• Select the Guitar in that first menu. 

In the guitar world, you will often find scores that have both normal and tablature notations. The 
score has two staves, one is a tablature and the other a normal staff. The melody or chords are 
written in both staves so that guitar players and other instrument players alike can read the score. 
With Pizzicato, this can be created very easily as follows.

In the above dialog; the menu entitled Associate with: provides a way to associate a normal staff 
to a tablature staff. By default, no association is done. The other choices are Upper staff or 
Lower staff.

• Select the Upper staff choice in that menu. This means that any note that will be added or moved in 
the tablature staff will be automatically transcribed in the normal staff associated with it (here it is the 
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upper staff). In the other way around, any modification done in the normal staff will also be 
transcribed in the tablature. 

This can help you to write a melody or some chords in normal music notation and have it 
automatically translated into tablature notation. Or, if you do not know normal notation very well 
and can use a tablature, you get the normal notation automatically when you write the notes in 
the tablature.

As there may be more than one way to play a given note with a guitar, the normal to tablature 
translation only suggests one possibility. You can then move the note to another string if you 
want. But when you add a note on the tablature, there is only one note corresponding to the 
normal notation, so in that direction, the translation is always correct. The only trouble can be the 
transcription of accidentals, but the problem is the same as with a keyboard (is it a F# or a Gb ?).

• Click OK and try to enter some notes on the normal staff and then also on the tablature staff. You will 
notice the automatic translation from one to the other. 

You should be aware that when you ask Pizzicato to play the score, both staves will be played, 
so you may want to mute one of them by unchecking the P (for Play) check box of the 
Instruments window.

Using tablatures, you can also copy/paste measures from/to a normal staff and the conversion 
will also be executed by Pizzicato.

• Double-click once again in front of the tablature staff so as to reach the above dialog again. The 
following part of the dialog contains various features that can be used in combination with a tablature 
(but also for any other staff): 

• The stem direction of the notes of any staff can be Forced down, Forced up, or 
Automatic. Notice that on a tablature, all stem ends are set to the same height. 

• You can hide/show the stems and/or beams of the notes. When using both standard and 
tablature notations, you often find scores where only the fret numbers are displayed on 
the tablature, without any rhythm, as the rhythmic aspect is just above it in the normal 
staff. You can do that by hiding both stems and beams. 

• For the same reason, the time signature is often omitted in the tablature. By default, 
Pizzicato hides the time signature. 

• You can show guitar diagrams associated to any chord symbol you add. This aspect is 
explained later in this lesson. 

Notice that when you specify a tablature instrument in this dialog, Pizzicato automatically sets 
the staff size to 150% so as to have a standard tablature size. You may change that number if you 
want to (in Pizzicato Professional only). The same remark is valid for thelines number of the 
staff, which is automatically set to the strings number of the chosen fretted instrument.

Chords diagrams

We have seen that Pizzicato has a specific tool to add chord symbols above the measures of a staff. For 
guitarists, each chord symbol may also be displayed as a standard fretboard diagram, showing how the 
fingers 
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should be placed on the frets to play the chord. In Pizzicato we call this a chord diagram. Here is an 
example:

Here is a description of its various elements:

• The vertical lines represent the strings, the left line being the lower pitch string. 
• The horizontal lines represent the frets. The second line (starting from top to bottom) is normally the 

first useable fret but the presence of the number "3" to the left indicates that it is the third fret. When 
there is no number, it means that it is the first fret. This number is used to avoid drawing many empty 
lines above the diagram when a chord is played far from the first fret. The next frets are the 
consecutive horizontal lines. 

• A plain circle on a string and between two horizontal lines shows the position of a finger. This finger 
must press the string against the corresponding fret. 

• An empty circle above a string means that the corresponding string must be played open, i.e. without 
pushing the string against a fret. 

• A cross above a string means that the string should not be played. 

So to play a chord, the corresponding finger (from the left hand) must be placed according to the diagram, 
and the right hand must pinch all strings except the ones with a cross sign above it.

We will now see how to place chords diagrams in a score. Do the following.

• Create a new document with the File, New item. 

• To enable the display of chord diagrams with normal chord symbols, double-click in front of the staff 
that will receive the chords symbols and check the Show chords diagrams box, then click OK. 

• Select the chord symbol tool  in the main palette and click above the first measure. The chord 
selection dialog box appears and you can change the chord characteristics as you want. While you 
change the chord specifications, Pizzicato searches the chord diagram library to find a matching 
diagram and displays it to the right: 
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The chord specficiation parameters have been explained in a previous lesson, so please refer to 
the lesson entitled The chord tool. When Pizzicato does not find a corresponding diagram, it 
displays an empty diagram or a big cross.

As there are often several ways to play a given chord on the guitar, Pizzicato suggests only the 
first one that is present in its library.

• Click in the middle of the diagram. This opens the chord diagram library, where you can select 
another chord diagram to associate with the chord symbol: 

• To select another diagram, you can click on it. You may also change the chord type in the left column 
or the root note on the right part. Pizzicato displays the chord diagrams that are available in its 
library. 

• With advanced versions of Pizzicato, you can customize the library by adding diagrams or by asking 
Pizzicato to generate new diagrams based on specific criterias. To do this, uncheck the Locked check 
box and refer to the next section of this lesson that explains how to do it. 

• Click on OK and OK again. The chord symbol and the diagram appear on the staff: 

You can move the chord symbol by clicking on it (not on the chord diagram; the chord diagram will always 
be drawn just below the chord symbol) as explained in the chord symbol lesson.

In a similar way, you can use the chords progression window to enter and view chords and their diagrams 
(Windows menu).
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The diagrams library

You can customize the default library of chord diagrams. This is done when you select a chord diagram as 
explained above (and by unchecking the Locked box). But you can also reach this dialog in the Options 
menu, by selecting the Chords diagrams library... item:

This library is organized by instruments, by chords and by notes:

• The top menu entitled Instrument is by default the standard guitar. The Pizzicato library contains 
diagrams for this instrument only, but as you will see, we can build a library for any other instrument 
in a few clicks. By changing this menu, you can work the diagrams for other instruments. 

• The list to the left contains all chords that are present in the chord library of Pizzicato (remember that 
in the Professional version you can customize that library too). To see the diagrams that correspond 
to a given chord, select the chord by clicking on it in the list. 

• The list to the right gives the twelve root notes for a chord. By selecting a note, you see the 
corresponding diagram(s) in the middle panel. 

So a set of diagrams can exist for each combination of an instrument, a chord type and a note. The 
corresponding diagram(s) are displayed in the middle part of the window. You can see up to six diagrams 
together, but if there are more available, a vertical scroll bar appears so that you can scroll down to see the 
other ones.

The current diagram is displayed with a thicker border, as you can see here for the first diagram. The 
diagrams are numbered at the upper left corner from one to the total number of diagrams available for that 
chord.

A set of five small icons are visible in each diagram. When you click on them, you can produce the 
following actions:

• Clicking the small left arrow will move the diagram to the left (not possible for the first diagram) so 
that you can change the order of diagrams when more than one are available. You should know that 
the first diagram for a given chord and note will be the one selected by default by Pizzicato. 

• Clicking the small right arrow will move the diagram to the right (not possible for the last diagram). 
With these two arrows, you can reorganize the library. 

• The "+" on white will create a new empty diagram after the current diagram. 
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• The "+" on yellow will duplicate the current diagram after the current diagram, so that you have a 
new diagram that is a copy of the current diagram. 

• The "x" will remove the diagram. 

If there is no diagram in the table, you can add a first empty diagram by clicking on the "+" button available 
to the right (left to the Generate... button).

When a diagram is selected (thick border), you can change the number of frets displayed with the menu 
entitled Number of displayed frets and you can define the first fret (the number that is placed to the left of the 
diagram) by using the menu entitled First fret. Both are just above the diagram table.

The Edit zoom slider helps you to zoom in and out inside that window so that the diagram can be bigger or 
small to edit it.

The Display zoom is a factor that will influence the size of the diagrams when they will be displayed in the 
score. A value of 100 gives a correct size, but you can customize it as you want.

Here is how to edit a diagram:

• By clicking on a string (vertical lines), between two horizontal lines, you can switch on/off a plain 
circle. Of course, there can be only one plain circle on a given string. 

• By clicking just above a string, you first get an empty circle (which means an open string). Clicking 
again gives you a cross (which means the string must not be played). Clicking again removes the 
cross. 

• Sometimes, the number of the finger to use is also displayed, just below the string. If you click just 
below a string, you first get a "T" (for Thumb), then 1, 2, 3, 4 for the four other fingers. Clicking 
again removes the fingering. 

• Another special case is the bar chord. It is produced by pushing the finger flat on several strings at a 
given fret. It is often written as a long bar covering the corresponding strings. You can display it by 
first putting a plain circle on the corresponding first string and then click on the corresponding last 
string while holding down the CTRL key of the keyboard. Here is for instance what you get when 
you do that for the four middle strings on the first fret: 

• You can remove that bar by clicking on its left part. 

Pizzicato offers you a powerful way to create a full library of chords diagrams automatically. Click the 
Generate... button and the following dialog appears:
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The idea is to ask Pizzicato to automatically generate chords diagrams by giving precise specifications. Here 
are the various possible specifications.

• The first set of three choices gives the scope of the diagram generation. Pizzicato can generate only 
the diagrams of the current selected note. Pizzicato can generate them only for the current chord (but 
for all notes). Or Pizzicato can generate diagrams for the current instrument (for all chords and all 
notes of the current instrument). 

• The two popup menus under the title First fret from ... to ... let you define on which frets a chord 
diagram may be built. If you set it for instance to 1 and 4, Pizzicato will only generate diagrams 
where the first fret is 1, 2, 3 or 4. 

• The next popup menu gives the number of frets that can be used to create a chord diagram. Pizzicato 
will only create diagrams where the chord is stretched on a maximum of frets given by this menu. 

• The next menu is used to specify the number of notes (including the open strings) that the diagram 
should contain. Six on a standard guitar would mean that all 6 strings should be played together. 

• The next menu specifies how much strings can be used with a finger (which means how many strings 
not open will be playing). For example, by limiting it to two strings, you could select possible chords 
that are quite easy to play, as they only need two fingers from the left hand. 

• The first check box specifies that no muted (= not played) string should be present between played 
strings. This makes the chord notes group in one block and it is more easy to play with the right hand. 

• The next check box only accepts muted (not played) strings on one side of the strings. 
• The next check box forces Pizzicato to allow only diagrams where all the notes of a chord are present 

at least on one string. 
• The next one forces the root note of the chord to be the lowest (the bass note). This gives the natural 

position of a chord. 
• The next check box is used to avoid a small interval to be used in lower notes, because it tends to 

render the chord too confused. 
• By checking the last check box, Pizzicato will remove all existing diagrams prior to the creation of 

new diagrams, at least for the notes and chords for which diagrams will be generated. 

You can then easily recreate the full library by specifying your preferences in this dialog and then by 
clicking Create. If you ask to create diagrams for all notes and all chords, it may take some time, depending 
of the speed of your computer and the above selection of choices.

When you click on OK in the library window, the library is then saved. If you make changes and then click 
Cancel, the changes are not saved and Pizzicato loads again the library that was present before you opened 
that dialog. So you can try generating libraries of diagrams and if you are not satisfied with them, just click 
Cancel.

The tablatures library
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There are many instruments that are based on strings and frets. With Pizzicato, you have a library of about 
240 predefined fretted instruments. You can access that library in the Options menu, with the Tablatures  
library... item. The following dialog appears:

The guitar instruments are first in the list, as they will be the most commonly used. Then, the other 
instruments are ordered by name. To select an instrument in the library, click on it in the list. The right part 
of the window displays the following information about the instrument and you can modify this information:

• The name of the instrument, as it will appear whenever you need to select a fretted instrument in 
Pizzicato. 

• The number of strings of the instrument 
• The number of frets of the instrument 
• From 1 to 16 notes, determining the tuning of each string. String number 1 is the highest pitch and 

the following go down in pitch. By clicking on a note button, you have a keyboard that let you 
specify the note associated with that string. 

• Just next to the note button, you will find a popup menu that can be used in special cases where a 
string has one or more missing fret, compared to the other strings. 

You can add, duplicate or remove instruments with the New, Duplicate, Delete buttons and sort them with 
the Up / Down buttons.

Two other controls will influence the way Pizzicato translates a normal staff to a tablature staff (this is 
global and not specific to one instrument):

• The first one is the Tablature preparation popup menu, which can be set to Shortest move (Pizzicato 
optimizes the distance between two consecutive notes so as to minimize the move), to Stay on same 
string (Pizzicato tries to stay on the same string if possible) or to Closest to fret number 0...20 (in this 
case, Pizzicato tries to place notes as close as possible to a given fret position). 

• The Keep manual moves helps Pizzicato to remember manual changes that you could have done to a 
tablature when Pizzicato has to translate that measure again. 

Graphic options and automatisms
• Graphic options 
• Automatisms 

Graphic options
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A dialog box is used to define a series of graphic parameters which influence the display of the score on the 
printer or on the screen.

• Start Pizzicato and select the Graphic options... item in the Options menu. The graphic options dialog 
box appears: 

• The first 6 text boxes determine the thickness of various lines as the note stem, the staff lines… The 
values must be expressed in tenth of millimeter and are used during the printing of the score. These 
values are reduced or increased in ratio when you change the reduction/enlargement percentage for 
printing (Pizzicato Professional only). 

• A text box lets you specify the maximum angle to use for the position of the notes beams. A 25 
degrees angle for example will give a maximum slope corresponding to: 

A 10 degrees angle would give as a maximum:

By selecting a 0 degree angle, you can force Pizzicato to draw all beams horizontally. This 
option may be useful when the score is printed on a printer with a low resolution (dot-matrix 
printer) because it eliminates the bad effect obtained with oblique lines.

• The 16 check boxes located below enable the visibility of the 8 rhythmic voices on the printer and on 
the screen. In 99 % of the cases, all boxes should remain checked. By disabling one of the boxes, the 
corresponding voice will become invisible in the score, on the printer and/or on the screen. It 
nevertheless remains present and one can listen to it with the synthesizer. 

• The first menu located just below is entitled Use of colours and proposes four choices. The default 
choice is Black colour, which draws all notes and rests in black on the score. The second choice is 
Voice colour. In this case, notes are drawn in the colour of the rhythmic voice to which they belong. 
The next choice, Track colour, draws notes and rests in the colour associated with the staff. This 
colour may be selected in the instruments view. The last choice is Colour by scale/chord. This option 
is quite interesting to compose music. When the score has chords in it (encoded with the chord 
notation tool) the notes are then displayed in three colours:
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 Green: the note is part of the current chord. 
 Orange: the note is part of a scale deduced from the chord 
 Red: the note is not part of the chord neither of the scale 

• The next menu is used to change the colour of various score elements. Select one of them with the 
menu: 

and click on the button just right in front of it. A dialog box is displayed to associate a colour 
with the selected element. You may change the colour of clefs, measures, etc in order to 
personalize your score or to create non standard scores. Regarding the lyrics colors, the 
modification will be effective on all staves of all scores of the document.

• The next menu is used to change the font used for various text elements. Select an item of this menu: 

and click on the button right in front of it. A dialog box appears to select a font, a size and a 
style. This font will be used to draw the selected elements in the score. Regarding the lyrics 
fonts, the modification will be effective on all staves of all scores of the document.

• Just below, a check box lets you see the invisible notes, rests and symbols. You can then find any 
item that is hidden in the score. This option is valid only on the screen because invisible symbols will 
not be printed on paper. 

• The Print with colours box specifies that colours must be printed. You of course need to have a 
colour printer or a black and white printer with gray levels; otherwise this option will have no effect. 

• The default character set may be used to specify which script will be used by default in text blocks. 
The default is Occidental, but you can for instance set it to Hebrew, Greek or Arabic. 

Click OK to close the dialog box.

Automatisms

In the Options menu, select the Automatisms... item. The following dialog box appears:
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The higher part of this dialog box specifies the distances between the various elements. These distances are 
represented by sliders and can vary between 0 and 12. To modify them, click on the cursor and drag it.

When you modify these values, the graphic result is directly visible in the upper area. Here is an example 
where all values are 0 (elements are the tightest):

and here is an example where all distances are set to 12 (elements are the most distant):

The four boxes of the Automatic positioning of frame enable or disable the automatic positioning of:

• accidentals in a chord, 
• courtesy key signatures 
• courtesy time signatures 
• naturals in key signatures, when the key signature changes 

The options specified here affect the current document.

Reading and writing Midi files
• The Midi file 
• Exporting a Midi file 
• Importing a Midi file 

The Midi file

A MIDI file is a file which contains Midi information organized to form a full piece of music. It contains one 
or more time sequences of MIDI instructions which describe when and how the notes of the score must be 
played. Other information specify which instruments play, volumes, various controllers and other MIDI 
messages.
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The MIDI file is a universal format of musical data exchange between various devices and computers. 
Pizzicato, as most musical software, reads and writes MIDI files (except Pizzicato Light, which does not 
read them). This is used to exchange music documents between Pizzicato and other musical software by 
going through the MIDI format.

You need to understand very well that the musical contents of a MIDI file contains only the start, the 
duration, the force and the pitch of each played note. It is a succession of instructions like this:

• press key n° 62 with a velocity of 105, 
• wait one second, 
• release key n° 62, 
• press key n° 64 with a velocity of 78, 
• wait 0.2 second, 
• press key n° 67 with a velocity of 78, 
• etc. 

It is the equivalent of information sent by your musical keyboard to Pizzicato when you record a score in 
real time.

The graphic aspect of the score is not included in a MIDI file. Let us take a simple example to explain this 
difference. Let us consider the 3 following measures:

  
The display is quite different for each but when they are played, these 3 measures are strictly identical. The 
MIDI files will be the same for the three measures.

When you save a Midi file, you lose all information concerning the graphic aspect of the score. Only the data 
strictly necessary to play the score are recorded.

For this reason, the writing and reading of MIDI files is useful only when you must exchange files with 
another software. You will also find MIDI files libraries in the trade and on the Internet, and you can read 
them in Pizzicato.

By default, when you open a MIDI file, Pizzicato will first associate the notes in the tracks with each staff of 
the document. Then it will automatically transcribe the notes and display the score. If you do not want to 
automatically transcribe a MIDI file into notes, use the Options menu, Additional options... item and disable 
the corresponding check box. In such a case, to see the notes in the measures, you need to transcribe the 
tracks in musical notation: select all measures and use the Transcribe item in the Edit menu.

Three formats exist for a MIDI file. Format 0 contains only one track with all notes together. Format 1 
contains one or more tracks grouping all notes of a staff. Format 2 is rather rare and contains several 
independent sequences. Pizzicato reads and writes formats 0 and 1.

Exporting a Midi file

• Start Pizzicato and open the Ex061 document. It contains the first 3 measures of a Bach score: 

Listen to it and observe the way in which notes are graphically displayed. We will save it in a MIDI file. In 
the following section, we will open the MIDI file to transform it back into a score.

• In the File menu, select the Export MIDI file… item. The following dialog box appears: 

304



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

Three choices lets you select between the full 0 format (with the notes), the 0 format with only tempo 
information (quite rare), or the full 1 format. The advised choice (and also the default choice) is format 1. 
Click Export. Pizzicato asks you a file name. Fill in Test and click Save. Pizzicato saves the MIDI file and 
the export is finished.

Starting with Pizzicato 3.5.3, you can select the staves that are exported to the MIDI file, with the "J" 
checkbox that you find in the instruments window. This checkbox specifies which instrument is played and 
also exported in MIDI.

Importing a Midi file

• In the File menu, select the Import MIDI file… item. Pizzicato asks you to select a MIDI file. Select 
the Test.mid file and click Open. The following dialog box appears: 

The four central options are only available in the more advanced versions of Pizzicato. Here are 
the options:

• The check box Transcribe the measures in music notation automatically transforms the 
content of the MIDI tracks of the file into standard music notation in the measures. 

• The check box Create specific percussion staves asks Pizzicato to create separate one or 
several line(s) percussion staves for each percussion instrument. The notation is then 
much easier to read and to edit. 

• The check box Find corresponding instruments in Pizzicato libraries makes the 
correspondance between the instruments found in the MIDI file and the Pizzicato 
standard instrument libraries.This is useful to establish the right key, the range,...of the 
instrument. 

• The check box Sort staves with instruments order, following is used to select a template 
of instrument order and to use it to sort the instruments found in the MIDI file. The 
standard template is a sorting compromise that may be used for most instrumental 
ensembles. You may create new templates with the Options menu, and the Instruments  
order... item. 

• The check box Remove empty staves asks Pizzicato to remove the staves that do not 
content any note so as to have a smaller score. It is indeed common that MIDI files 
contain empty staves, some with only text comments in it. 
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• The check box Assign virtual instruments will associate a virtual instrument to each staff, 
from the Papelmedia library included in Pizzicato. 

• The check box Manual adjustment will call the audio/Midi/Score window, so as to 
customize the measures and beats. See the lesson about this window. 

• Click now on the Import button and the operation starts. As soon as it is finished, Pizzicato displays 
the contents of the tracks in music notation. It is the translation of what was found in the MIDI file. 
You get a score that looks like this: 

In this precise case, the main difference with the original score is the way in which the beams and the stems 
of notes are presented. This kind of information is not stored in a MIDI file and Pizzicato simply recreates 
them from scratch.

When you import a MIDI file and use the transcription, Pizzicato takes into account the parameters 
contained in the transcription options dialog box, exactly as explained in the lesson about transcription. You 

can then save the result using the Save item in the File menu.

Remarks :

• When you import a type 0 MIDI file (i.e. where all tracks are mixed on one track), Pizzicato 
separates the various instruments automatically in order to place them on different tracks. This 
separation is done on the basis of the MIDI channel. 

• When importing a MIDI file, the instruments view is automatically filled with the data found at the 
beginning of the MIDI file, according to the synthesizer installed in your Midi configuration. This 
lets you easily modify the instruments used as well as the MIDI controllers like volume, balance… 
The MIDI channels are also assigned according to the contents of the track. 

• If the MIDI file contains more tracks than your Pizzicato version can handle, a dialog asks you to 
select the tracks you want to import. 

MusicXML, NIFF and PDF files
• What is a MusicXML file ? 
• Import a MusicXML or NIFF file in Pizzicato 
• Export a score in MusicXML 
• Export to PDF 

What is a MusicXML file ?

We have seen that a MIDI file contains all information to reproduce the playing of a score. On the other 
hand, the MIDI file does not contain any information about the graphism of a score, its page layout, the 
number of measures per system, the exact layout of the contents of measures,… Two music softwares 
exchanging MIDI files thus lose all graphic information in the transfer. The problem of creating a more 
general interchange file format for a score thus arose. The NIFF file format was the first solution proposed 
by the collaboration of several music software publishers, but it was unable to impose itself on the market. 
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Later, the MusicXML file format appeared and it has now been largely adopted by music software to 
exchange music scores.

NIFF is the abbreviation of Notation Interchange File Format. This format theoretically allows the exchange 
of scores between various music softwares. With version 3.0, Pizzicato can read the contents of such a file 
and adapt it to the Pizzicato format so you can use the score with Pizzicato.

MusicXML is based on the XML standard of information exchange and since version 3.3, Pizzicato 
Professional and Notation can import and export MusicXML files to echange music scores with other music 
notation software. The other Pizzicato versions can only export in MusicXML. For compatibility, Pizzicato 
Professional and Notation still import NIFF files, but wherever possible you should use the MusicXML file 
format, as it is more efficient.

A music scanning software allows to scan a printed score and to recognize many of the musical symbols 
with the purpose of being able to edit, transpose and modify a score that only exists on paper. It is the 
equivalent of an OCR software (Optical Character Recognition) but for music. Such a software exports its 
results in NIFF or MusicXML format, readable by many music software.

With version 3 of Pizzicato, you can henceforth use this possibility via a scanning software. To prepare the 
MusicXML (or NIFF) file import function, we have bought and tested two scanning softwares: SharpEye 
(from Visiv) and SmartScore, Songbook Edition (from Musitek). Regarding the recognition quality level, we 
found out that SharpEye is more subtle and generally recognizes more than SmartScore. Regarding the user 
interface, SharpEye is more rudimentary. But since Pizzicato lets you make the corrections in the recognized 
score, this aspect is negligible and we thus advise the use of SharpEye in addition to Pizzicato. With regard 
to SharpEye, there is currently no Mac version, as opposed to SmartScore. So the Mac users do not have the 
choice. Other software exist to scan music score, you can discover them on the Internet.

You may download an evaluation version of SharpEye on the site of the editor:

http://www.visiv.co.uk/dload.htm 

Once installed, this version may be used freely during one month. You can thus carry out your tests and 
import them in Pizzicato during one month. Download version 2, which is more complete and effective.

With regard to SmartScore, you may download the demonstration versions on the site of the editor:

http://www.musitek.com/downloads.html 

The demonstration versions of SmartScore may be used with no time limit, but without saving the results. 
You can thus test the recognition of your scores but you will not be able to export them in MusicXML or 
NIFF files and to import them in Pizzicato as long as you don't buy the product.

Import a MusicXML or NIFF file in Pizzicato

The MusicXML file importation is done through the menu File, Import a Music XML file... An open dialog 
lets you select the file with the ".XML" extension. Once the file is selected, click on Open... The score 
appears in the score edit window. With it, you can import music scores that were created with Finale, 
Sibelius or many other software that can export their music scores into MusicXML files. Notice that 
Pizzicato uses the MusicXML 2.0 version, but it can import MusicXML files 1.0 and 1.1 also.

The NIFF file importation is done through the menu File, Import NIFF file... An open dialog lets you select 
the file with the ".NIF" extension. Once the file is selected, click on Open... and the following dialog box 
appears:
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With this dialog you may select some automatic actions that make it more easy to adapt the file to the 
Pizzicato format and avoid some additional treatments of the score:

• An option allows to horizontally align systems on the page, within the margins of the Pizzicato page. 
It avoids the inequalities due to scanning or to a badly framed score for instance. 

• An option allows to adapt the dimensions of the Pizzicato page as well as the value of printing zoom 
according to the contents of the page. It thus allows to adapt the printing zoom according to the size 
of the original page, taking into account the possible scale factor introduced by scanning. 

• The next option allows to fix the note beams so that Pizzicato does not automatically adjust them in 
the event of modification or justification of the score. The notes remain grouped in the way they are 
in the original score. 

• The next option does the same regarding the note stem direction: the original direction is maintained. 
These four options are checked by default. 

• The following option allows to import the name displayed in front of the staves. It is unchecked by 
default because this name is often not found in a NIFF file coming from the two above mentioned 
softwares or when it is, a generic name is provided and useless to import. 

• The last option allows to justify the contents of each measure after the file importation. 

It should be stated that currently there seems to be no music software that recognizes the content of a printed 
score perfectly, with a 100 % result (except of course for simple scores). As soon as the score becomes 
somewhat more complex, a certain percentage of the symbols are no more recognized and thus are missing 
in the score imported in Pizzicato. The missing symbols are very random. They can be a note right in the 
middle of a series of recognized notes, an accidental, a nuance symbol, a clef, a time signature,...anything 
possible.

The two above mentioned scanning softwares contain tools to correct these missing symbols and to add 
symbols on a graphic level. The advantage is that they display the original scanned score in parallel, which 
allows to review the score and compare it to the original to correct the errors.

Once the score has been imported in Pizzicato, you can use all the Pizzicato tools to modify it, transpose it, 
add accompaniment to it…

Export a score in MusicXML

Since version 3.3, all Pizzicato versions can export a music score to the MusicXML file format so that it can 
be used in other music software or for any other reason. You can then send your scores to friends working 
with other music software so that they can listen to them and modify them.

To export your score into MusicXML, open the score view and choose Export in MusicXML... in the File 
menu. A dialog asks you for the name of the file to create, which will automatically have the ".XML" 
extension. Click on Save and the file will be created. Notice that Pizzicato creates a version 2.0 MusicXML 
file, which is the most recent version of the MusicXML format at the time of the release of Pizzicato 3.3.
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Export to PDF

A PDF file is a document that anybody can read, print, put on an Internet site or transfer by email, on Mac, 
Windows and Linux. It is a standardized graphic file format.

Since release 3.5.2, Pizzicato can directly export a score to a PDF file. Anybody can then see it or print it, 
without the need to have Pizzicato.

Most computers have Acrobat Reader installed on them. This is the software that is responsible to display 
and print PDF files. If you do not have it, you can download it for free on Adobe'site at 
http://www.adobe.com/products/reader 

To create a PDF file with Pizzicato 3.5.2, open the score and go in the File menu, then choose Export, then 
Export to PDF. Give a name and a location to your file and validate. The PDF file will be created from the 
pages of the score.

Contextual menus and MIDI data 
modification

• Contextual menu of a note 
• Contextual menu of a measures selection 
• Modification of MIDI data 

Contextual menu of a note

By clicking on a note (or a rest) with the mouse right button (Alt-click on Mac), a popup menu gives access 
to various operations to do with that note. Open the Ex077 document: 

With the mouse right button, click on the dotted quarter note . The following menu appears:

• The Edit note play… item brings the following dialog box: 
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The first three boxes are activated only when the note was played on the MIDI keyboard, i.e. 
when it was recorded in real time or when it comes from the transcription of a MIDI file. This 
dialog box lets you modify the playing parameters. When a note is introduced with the mouse, 
the three boxes are disabled. In such a case, Pizzicato considers that the velocity of the note is 
specified in the instrument view or possibly modified by symbols. It is similar for the MIDI 
duration and start. This dialog box lets you modify or remove information of velocity, duration 
and start associated with this specific note.

Velocity is expressed between 1 and 127 and corresponds to a complete scale of available 
nuances in a synthesizer.

MIDI duration is expressed as a percentage of the graphic value. A quarter note with a 100 % 
value will thus be played as a quarter note. Quarter note with a 50 % value will be played with 
the duration of an eighth note.

MIDI start is also expressed as a percentage and specifies an advance or a delay, by a value 
proportional to its duration.

If the score was recorded in real time or comes from a MIDI file, you can thus modify a specific 
note to give it a force (velocity), a duration or a different MIDI start.

If the score was encoded with the mouse, modifying the parameters of a note will personalize the 
performance. You may then amplify a specific note, lengthen a duration or shift a start back… It 
gives you a better control on how the score is played.

The Justification frame influences the way in which automatic justification acts on the note. By 
default, this is managed by the tools of Pizzicato, but this dialog box lets you visualize these 
adjustments.

When the Manual stem direction box is checked, it means that you have used the stem direction 
tool on this note. From there on, Pizzicato remembers the state of the stem with the note. When 
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Pizzicato justifies the measures, it remembers it and takes it into account. If you disable this box 
for a note, the stem will again be automatically managed by Pizzicato at the next justification, 
because the manual modification will have been forgotten.

The same principle applies for the way in which Pizzicato connects beams for several notes. 
When a note is introduced, the choice by default is Automatic beam. When you modify beams 
manually, this change is memorized so that Pizzicato can take it into account at the next measure 
justification.

The Draw the note on frame is only present in advanced versions of Pizzicato and may be used 
to change the staff on which the note is drawn with the purpose to realize cross-staff beaming. 
See the lesson on cross staff beaming.

The Grace note frame is also only present in advanced versions of Pizzicato. It is used to manage 
grace notes. See the lesson on grace notes.

The Tablature frame is related to the guitar tools. Se the lesson on the guitar tools.

The Custom color box is used to specify the color used to display the note and its stem.

The Do not play the note attack check box removes the MIDI message sent to the sound card to 
start the note. It is useful for instance in the case of a repeat when a note is hold across the repeat 
bar. At the second passage, the note is already playing, so the note should not be started again 
but should be stopped at its end (otherwise the note will play forever).

The Do not release the note (hold the note) check box keeps the note playing until the end of the 
score. The MIDI message to stop the note is not sent. You may use this for special effects or to 
send a MIDI Note ON message without a MIDI Note OFF.

• The Change to... item introduces a second menu: 

By selecting one of the suggested values, you can thus change a note into a rest or vice versa, 
and also modify the note or rest value. To get the same result, you could erase the note and add 
another note value.

• For the notes or rests with one or more dots, the Delete dot item lets you easily remove a dot. 

• The Change note head... item is present only in advanced versions of Pizzicato and is used to change 
the note head symbol (triangle, square, cross,...) 

• The Add a grace note... item is present only in advanced versions of Pizzicato and lets you add grace 
notes to a main note. See the lesson on grace notes. 

Contextual menu of a measures selection

When one or more measures are selected, the Edit menu contains a series of choices to treat the selected 
measures. These choices are also available by clicking in the score with the mouse right button (Option-click 
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on Mac). Select for example measure 1 and click with the right button. Take care not clicking on a note or a 
rest, in which case you get the note contextual dialog box. The contextual menu of measures appears:

The various items of this menu are explained separately in the various lessons of this manual. They are the 
same as their equivalents of the Edit menu.

Modification of MIDI data

Pizzicato lets you to add, remove or modify various MIDI information influencing the score performance. It 
gives you a better control on the performance of the score by a synthesizer. These MIDI data are stored 
either in each note separately or in the MIDI track associated with the staff.

To reach these modifications, select one or more measures on one or more staves and then select the Data 
modification... item in the Edit menu (or using the contextual menu of measures). The data modification 
dialog box appears:

The left multiple choice specifies the type of data to modify and the right multiple choice specifies how the 
data will be modified. Let us first see the types of modifiable data:

• Velocity: the playing force of a note (equivalent of the hitting force on a piano) 
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• Volume: the general amplitude of notes 
• Tempo: the performance speed of notes 
• Modulation: an effect producing a vibration in notes 
• MIDI controller: allows the activation of various effects according to the synthesizer you use. The 

number of the MIDI controller must be specified in the text box entitled Controller number. 
• Note duration: determines the playing duration of notes compared to their graphic values 
• Note start: determines the effective start of notes compared to their graphic values 
• Pitch Bend: an effect which increases or decreases the pitch of notes by very small steps 
• Program change: it is the number which determines the choice of the instrument played by the 

synthesizer 
• Swing: an effect which moves the central reference of the measure beat forwards or backwards and 

especially used for jazz performance 
• Measure width: this choice lets you determine the graphic width of the selected measures 

Once the type of data has been specified, select the way to modify them:

• Set value to: set a constant value for the data 
• Set value to (%): the existing data for the selected measures will simply be modified by the 

percentage 
• Randomize to (%): the existing data are made random proportionally to the percentage 
• Progression from / to: a data progression is created between the two values on the given measures 
• Progression from / to (%): a data progression is created between the two values, but expressed as a 

percentage of the existing values 
• Delete data: the possibly existing data are removed 
• Add: Pizzicato adds a constant value to the existing data 
• Subtract: Pizzicato subtracts a constant value from the existing data 
• Lower limit to: Pizzicato increases the existing data so that they are higher or equal to this value. The 

data already higher or equal are not modified. 
• Higher limit to: Pizzicato decreases the existing data so that they are lower or equal to this value. The 

data already lower or equal are not modified. 

Most combinations are allowed between the types of data and the modifications. Some combinations are 
incompatible (for example, it is not possible to remove the width of a measure, it does not make sense 
because a measure must always have a graphic width).

By clicking OK, the selected measures are affected by the operation.

The musical effects view
• Musical effects 
• The musical effects view 
• Modifying the symbol effects 
• Creating free musical effects 

Musical effects

Pizzicato lets you color the score playing by various musical effects transmitted to the sound card or to the 
synthetizer in the form of MIDI messages. The main musical effects are :

• Velocity: it is the hitting force of the notes on a musical keyboard. The velocity directly influences 
the strenghth of the note. The nuance symbols use the velocity to produce a Piano or Forte for 
instance. Be aware that a synthetizer may also slightly influence the sound according to the velocity. 
A piano key hit very softly and amplified by loudspeakers would indeed not have the same sound 
color that a key hit forcefully, even if the two sounds finally reach you with the same force. The 
velocity is thus successfully used by good synthetizers to increase the realism of a sound. Notice that 
the velocity only acts when a note is hit. Once the note has been started, you can no more influence 
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velocity. The velocity information is part of the MIDI message that plays the note. By using a 
crescendo in velocity, it will work well on a series of double eighth notes, but if you execute a 
crescendo in velocity on a whole note, the effect will not be heard because as soon as the whole note 
starts, the velocity can no more be changed during its 4 beats. 

• Volume : it is the amplification level of the generated sound. It acts as if you change the volume 
button of your HI-FI system. This adjustment can be done separately for each instrument, as most of 
the other adjustments. As opposed to velocity, volume can be adjusted at any time. You can thus 
execute a volume crescendo on continuous notes without problem (whole notes for instance). The 
sound force resulting from a note is thus a combination of velocity and volume. You should keep that 
in mind at any time. 

• Tempo: it determines the speed at which measures are played. It can be modified at any time, but it 
acts on all staves at the same time. 

• Duration: it is a parameter introduced by Pizzicato because it is not directly expressed by a MIDI 
message. In Pizzicato, it is a parameter which influences the playing of notes written in the score. A 
value of 100 % implies that the note is played with its standard duration (quarter note, eighth note...). 
A value of 50% reduces the standard duration to half of its normal value. With it, you can create a 
detached play or a Staccato passage. 

• The start: in a similar way, this parameter lets you slightly shift the start time of all notes, to create a 
delay or a light advance of an instrument compared to the others. 

• The MIDI controllers: they are numerous and they each activate a specific effect on the playing. 
Volume is a MIDI controller. The other main MIDI controllers are the balance (stereophonic position 
in space), the modulation (a vibrato added on a note), the reverberation level, the chorus level, the 
piano pedal, the portamento (type of glissando). 

• The pitch bend : an effect used to modify the pitch of the note around its normal pitch. It can be 
used to create realistic Glissando, quarter tones, special effects... 

In Pizzicato, there are two sources for these effects and it is important to differentiate them well.

The first source of musical effects are the settings of the instrument view and the set of symbols placed on 
the score. By fixing for example volumes of the instruments in the instruments view, you determine the 
starting volume of the score. Then, if you place symbols of crescendo and decrescendo to influence the 
volume (blue symbols) in the staves, Pizzicato changes the volume following your directives. The MIDI 
messages are generated by Pizzicato when Pizzicato prepares the measure play and finds symbols 
influencing the volume. If you modify a crescendo, these MIDI effects are removed and automatically 
computed again.

The second source of musical effects are the MIDI tracks associated with measures. Each measure has a 
MIDI track containing the MIDI information associated to the measure, informations which are sent to the 
synthetizer during the playing of this measure. The effects produced by the data modification function are 
actually added to these MIDI tracks. It is the same when you import a MIDI file and that this file contains 
MIDI effects. These effects are imported in the measures track. It acts in the same way when you record the 
notes in real time.

These two sources of effects are independent and thus cumulate during the playing. According to your 
preferences, you can use both. But sometimes it is useful to be able to select explicitly the effects source and 
disable the other. For example, the velocity of the notes introduced with the keyboard in real time are stored 
in the MIDI tracks. If you add nuances, Pizzicato has several possibilities to play the music score: does it 
have to respect your original performance, to use the nuances which it finds in the score or to combine both ? 
Pizzicato Version 2 suggested a combined solution (which is always possible). Version 3 allows to 
disable/activate the play of the various effects for a given score. To specify the effects to play, click in the 
"..." button of a score, near the recorder. In the dialog box that appears, click the Effect play... button. The 
following dialog box appears :
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For each musical effect, you can enable or disable the MIDI source and/or the symbols source. Four buttons 
let you check all boxes or none. Then you can validate by clicking on OK. These choices apply to all the 
staves in the score.

The musical effects view

A special view has been designed to visualize and modify these effects: the musical effects view.

• Open the Ex079 example. The score displays: 

• Start by listening to the score. You will notice that Pizzicato executes the various symbols. Open the 
musical effects view, via the Windows, Musical effects... menu (shortcut : CTRL+E or apple+E on 
Mac). The following window appears: 
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This view lets you visualize and modify the way in which a musical effect evolves in a staff. If 
needed, you can open several views in order to visualize several effects or staves at the same 
time.

• The H- and H+ buttons let you adjust the value of the horizontal zoom. Click for example on H+ and 
you get: 

• If you modify the size of the window, the central zone increases or decreases, which lets you change 
the vertical display zoom. The first menu of the toolbar lets you select the staff for which an effect is 
visualized. Here it is staff number one that is selected. The three following tools allow you to change 
the effects, we will study them further. 

• The two following buttons,  and  are active by default.. The first one, when it is active, lets you 
visualize and modify the musical effect related to the MIDI tracks. The second one, when it is active, 
lets you visualize and modify the musical effect associated to the score symbols. Disable for example 
the second , you get: 

This score does not contain effects in the MIDI track but effects produced by the symbols.

• The following six buttons let you select the viewed effect among volume, velocity, tempo, duration, 
modulation (vibrato) and reverberation. The next menu contains the list of all effects and thus allows 
you to select the others. Click on the Tem button and reactivate the  button. You now view the 
variation of tempo produced by the Accel ... and Rit... score symbols: 
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The M and S check boxes let you enable or disable the playing of the current effect coming from 
the measures track (M) and/or the effects coming from the score symbols (S). The "..." button 
opens the same dialog box previously seen to enable/disable each effect action from the tracks or 
from the symbols.

The main part of the window contains the following areas:

• Just below the toolbar, a band shows the measure numbers. 
• The central band displays the evolution of the selected musical effect. The continuous 

color band shows that the effect is maintained at a value and the vertical coloured lines 
indicate the specific moments where the value of the effect is modified and sent to the 
synthetizer during the play. 

• The lower band contains an horizontal line to represent each note played in this staff. It 
gives an idea of the melodic line played in the staff, in order to establish the link with the 
effect curve and to adjust it more easily. 

Modifying the symbol effects

This view lets to visually adjust the effect produced by a score symbol.

• Display the velocity of staff 3: 

• This staff contains 3 symbols: a nuance (Piano), a crescendo and a decrescendo. A small red square 
corresponds to each symbol and shows the value specified by the symbol. You can move these small 
red squares vertically with the mouse in order to modify this effect and you can directly observe the 
impact on the effect. The first symbol is at the beginning of the first measure. It determines the 
starting velocity. Then, the crescendo increases the velocity, starting from the value specified by the 
first nuance symbol. Finally, the decrescendo decreases the velocity, starting from the value reached 
at the end of the previous crescendo. The symbols are thus interdependent. As an example, we will 
increase the contrast by playing the notes less strong at the beginning, then increasing and decreasing 
more. Lower the first red square to get: 

• You will notice that the whole effect has been decreased. It is normal because the two following 
symbols have an action relative to the value that exists at their beginning. Set the second red square 
higher and lower the third to get: 
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The curves are automatically adapted. In the case of velocity, the vertical lines show the 
theoretical curve, because the velocity is only sent in MIDI at the time when a note starts.

Creating free musical effects

The effects view lets you also view and add effects in the tracks associated to measures. Three tools are 
available.

• Click on , representing a straight line, and display the volume of the first staff: 

• This tool lets you draw a straight line progression by using the mouse. In the first measure, click and 
hold the mouse button in the left lower part and drag the mouse to draw a straight line while going up 
and to the right. When you release the mouse button, the progression of the effect is created: 

• In the effect selection menu, select the Pitch bend and display staff 2. There is no effect in it yet. 
Activate the pencil  tool and trace a curve with the mouse to get: 
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Listen to the effect obtained on the chords in the third measure. The pitch bend produces an 
effect of glissando during the chord. For the pitch bend, the central value is actually the normal 
frequency of the note. By going up or down around the central pitch, the frequency of the played 
notes follows the movement in a continuous way.

• The third tool is the eraser . It lets you remove the effects placed in a MIDI track. Click on this 
tool. Click and drag the mouse through the central part of the curve drawn here above and you get for 
example: 

During the erased area, the value of the pitch bend remains the same, because it is not modified 
by a vertical line. This value is represented by the clear color rectangular block. If you do a zoom 
on the dark area, you will notice that it is made of very tight vertical lines. For the pitch bend, the 
MIDI values sent are indeed tight, because the effect of glissando must be as regular as possible 
to avoid the stepping effect which would occur in the form of frequency discontinuities.

The few examples given here cover the main part of the functionalities of this view. By combining the 
various effects with the symbols and with the drawing tools, you can practically execute all the sound effects 
provided by your synthetizer or sound card and obtain a very living and dynamic score performance.

The graphic editor
• The graphic note editor view 
• The use of colours 
• Composing drum patterns 

The graphic note editor view

The graphic editor view is used to modify the contents of the measures in a graphical way. The basic 
principle is the same as for the piano roll view, but here you can modify the notes. 

• To study this view, open the example document Ex083. Remember that the example documents are 
available with the File menu, Open... item, then in DataEN and Examples. Open the score. It contains 
the following notes: 
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• In the Windows menu, select the Graphic editor... item. The following window opens: 

• Dispose the two windows (score and graphic) so that you can see the content of both at the same time 
(resize and move the windows). 

Each staff (instrument) has an horizontal corresponding section in the graphic editor. The sections are 
separated by a colour bar with the colour of the instrument in the left part and with a gray colour through all 
the measures. The name of the instruments is displayed on the left of the bar. In the gray bar, the number of 
the measures are displayed (1, 2, ...).

On the left side of the window, between the title bars with the instrument name, you have for each 
instrument a series of lines, splitting the area into notes. The note names are written in the line. By default 
each instrument displays the equivalent of one octave.

In the middel of the window, the notes are displayed as a little coloured round rectangle. The colour is also 
the colour of the instrument. Each measure is vertically separated into columns. Each column corresponds 
here to the duration of a 16th note. 4 columns represent one quarter note as you may see in the second 
instrument when compared to the original score. The beginning and end of a note are represented graphically 
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by its position inside the columns and its pitch is represented by its vertical position, according to the name 
of the note as displayed on the left.

Here are the possible operation you can do on that window:

• The "H-", "H+", "V-" and "V+" buttons in the tool bar are respectively used to change the zoom 
display horizontally (H) and vertically (V) so as to fit the display with a specific part you want to 
edit. Try to play with them to see the effect. 

• The standard recorder and loop buttons are present as in the other views. You can start/stop playing 
the score. Notice that as Pizzicato plays the score, a vertical bar shows the progress and will also 
automatically scroll when the score contains more measures than can be displayed in the window. 
Play this score to see how this works. 

• The next menu displays 16th note which is the grid definition for duration. Each column corresponds 
to a 16th note duration. You may change this menu to display any other duration you want. This will 
determine the smallest duration you can manipulate with this view. The two numbers that follow 
display "1 1". They are multiplication and division factors that are applied on the grid duration. If you 
place for instance "3 2" with the menu set to Eighth note, the displays will become: 

There is now an 8th note triplet duration for each column. Go back to the previous setup (16th 
and 1 - 1).

• On the bottom left corner, the first measure number is displayed as well as the total number of 
measures in the score. On the bottom right side, the note name and exact time position in the measure 
are displayed, for the location of the mouse cursor. 

• If you click with the right mouse button (Alt+click on Mac) inside this window, a menu item is 
available to call the following dialog, used to select which staves of the score are displayed in the 
graphic editor: 
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By default, all staves are visible.

• To add a note, you must click inside the square (column+line) where the note should begin, drag to 
the right and release the mouse button inside the square where the note should end. A new bar is 
added and the corresponding note in the score is added also. For instance, add a G3 note in the 
Piccolo instrument, starting at beat 2 of the first measure and ending on the second beat of the second 
measure. You should have the following: 

Notice that the note has been added also in the score.

• To delete a note, click on it while holding down the CTRL key. The note disappears. 

• To move a note, click on it and drag it to another position, inside the measure or in another measure, 
at the same pitch or to another pitch. 

• To hear a note, just click on it without moving it. 

• To change the duration of a note, click on its last square while holding down the SHIFT key and drag 
it to the right (longer duration) or to the left (shorter duration) then release the mouse button. Any of 
the above changes affects the score. Try these various operations with the example score to see the 
effects. 

• When you click in the yellow column, you hear the note of the corresponding pitch with the 
corresponding instrument. 

• You can change all the pitches in one shot, by clicking and dragging the note name (on the left) while 
holding down the CTRL key. All notes with that pitch will be transposed to the note in which you 
release the mouse button. Try for instance to move the E3 notes of the Pizzicato strings to the G3 
note. Notice the change in the score view. 
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One point of caution. Whenever you make a change in this view, Pizzicato changes what is needed in the 
MIDI track of the instruments and then transcribes the result in the score measure. This transcription 
function may somehow change the presentation of a measure if the measure was manually adjusted for some 
reason.

There are three other important actions that you need to know about this view.

• For any instrument, you can shift the range of the visible note pitches, just by clicking in the note 
name area and dragging it up or down. Try for instance to see the notes that are lower than C3 in the 
Pizzicato strings area. 

• You may increase the size of any visible note areas, by clicking and dragging up or down the 
horizontal gray border between instruments. Try to lower the gray border between the Piccolo and 
the Pizzicato strings. 

• The standard scroll bars left and below the main area are used as in the other views: the horizontal 
scroll bar moves from one measure to another, the vertical scroll bar lets you see lower or higher. 

 

The use of colours

With this view, there is a very interesting application to help you to compose a melody or secondary voices 
when you already have a chord progression associated to the score. 

• Close the previous score and open the Ex084 example file. 

• In the Options menu, select the Graphic options... item. In the middle of the dialog box, change the 
Use of colours to Colour by scale/chord and click on OK. The score displays as follows: 

• The notes are all displayed in green, as they are all part of the current chord. Modify the first measure 
by changing the notes as follows, moving them with the mouse: 

• Notice that the colours of the notes change automatically. The coulour rule is the following: 

• Any note that is part or the current chord is displayed in green. 
• Any note that is not part of the current chord but that is part of the most probable scale 

associated with the chord is displayed in orange. 
• All other notes are displayed in red. They are neither part of the chord nor of the 

associated scale. 
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• The same principle applies to the graphic editor view. In the Windows menu, select the Graphic  
editor item. The following is then displayed: 

The colours of the bars representing the notes are also drawn in green/orange/red so as to easily 
see what note fits which chord. This is even more clear than in the score, because here, the 
background of the grid is also coloured for each note of the full range of pitches. You can then 
easily locate the green and orange areas so as to place the notes in them. You may use the 
following general principles:

• The main notes, the ones with the longest duration and or the notes placed on the main 
beats of the measure should be green. 

• The short duration notes, the transition notes between the green notes should be orange. 
• If you use red notes, use them sparingly. They should be very short or acting as a 

transition between green and orange notes. 

This tool is very useful if you do not know by root or instinctively which note is in which chord 
or scale. You may create or arrange your melody by using these simple principles.

You should know that when the Use of colors choice is set to Black color in the Graphic options... item of 
the Options menu, it is then possible to assign custom colors to notes. This can be done with a right click on 
the note, then selecting the Edit note play... A Custom color box lets you change the color of that particular 
note. It is also possible to assign colors to the notes of a selection of measures, by selecting Assign colors to  
notes... in the Edit menu, that brings the following dialog:

The colors can be assigned to notes in four ways:

• Using the note name, which means that all C notes (including C# and Cb) will have the same color: 
the one specified in the first column. To modify one of the colors, just click on it. 
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• Using the note pitch for the 12 semi tones, as given by the second and third columns. 
• Using the fingering assigned to notes. The color is specified by the fourth column. The fingering of a 

note may be specified by the contextual menu of that note when it is placed inside a tablature. The 
fingering also appears in the edit note play dialog, also reacheable through the note contextual menu. 

• Using black color, so as to reset all notes colors to normal (black). 

As you can modify the default colors, the Save choosen colors box, if checked, will save your color 
preferences so that they appear the same next time you call that dialog.

Composing drum patterns

With Pizzicato Professional and its special staves for percussion instruments, the graphic note editor 
becomes an ideal tool to design or modify drum patterns. 

• Open the Ex085 example file. Its score displays the following: 

• Open the graphic editor view. You have now: 

You will notice that the note name area now displays the names of the corresponding percussion 
instruments. By clicking in the yellow squares, you hear each instrument. You can play this 
measure in loop to hear how it sounds. While Pizzicato is playing it, you may delete, add or 
change notes. The drum patterns you hear changes accordingly as well as the score you see in the 
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score window. This principle may of course be applied to compose for any instrument (piano 
repeated patterns, bass patterns,...) but in the case of percussion instruments, it is particularly 
interactive and intuitive.

The global view
• How to open the global view? 
• The main header bar 
• The staff header bar 

 

How to open the global view?

The global view is not a new window. It is located inside the score view. It is an extension of the linear 
mode used to display the staves. The idea behind this new view is to have access to the most important tools 
existing in several different Pizzicato windows. By having these music controls and tools all inside the same 
window, you can compose music much easier, as you do not need to open and close several different 
windows, each time adjusting their positions to accomodate your screen and see what you need to display.

To open the global view, just open the normal score view. On the score window tool bar, you can select the 
Global item in the Linear/Page/Global menu.

• Open the Ex092 document in the DataEN / Examples directory. You should see the score window in 
linear mode. In the Linear popup menu, select the Global item. The inner part of the window displays 
the global view: 

In this lesson, we will explain the various parts of this window. You will notice that most of these parts 
duplicate the functions of another Pizzicato window or tool. So in explaining the various parts, we will make 
a summary of these functions and refer you to the lessons that give more details about them. The real 
contribution of this window is to assemble in one view most of the practical tools you need to compose 
music efficiently. It tries to offer you the best of the Pizzicato tools in one single window.
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The main header bar

The main header bar is the upper part of the content of the window. It is located just below the main tool bar 
of the score window:

• Click on the  button. The global view will have a new area to display the chords progression 
associated to the score: 

Each chord is displayed with 3 icons. You can modify and manipulate the chords in several 
ways:

• By clicking on the upper icon ("?"), you can edit the chord with the standard chord 
selection dialog of Pizzicato. You can learn how to use this dialog in the lesson entitled 
The Chord Tool. 

• The second icon ("+") is used to add a chord after the current chord (the one on which 
you click this icon). The same chord dialog box appears and you can specify a chord that 
will be inserted after this chord. All the following chords are shifted to the right. 

• The third icon ("X") will remove the current chord. All the following chords are shifted to 
the left. 

• By moving the mouse over the separation line between two consecutive chords, the 
cursor will display a double-arrow. If you click and drag the mouse, the limit of the 
chords will move. This is the way to shift chords and change their duration. All following 
chords are shifted accordingly. 

• You can add a chord by clicking on an area with no chord. 

If you click again on the same  button, this chord area is hidden. You can display it or hide it 
according to the work you are doing in your composition. You will note that any change made 
with this tool will directly affect the chord symbols displayed inside the score itself.

You can also double-click the  button. This will open the chords progression window, as 
explained in the lesson entitled The chords progression window.

In Pizzicato Professional and Composition, you can also drag and drop an harmonic space from 
the library into the chords area. It will then be possible to select chords according to the rules of 
the harmonic space. With a right-click you can then select another chord that respects the rules to 
follow the previous chord. See the lesson on Harmonic spaces in the manual for all details 
(Pizzicato Professional and Composition only).

Regarding harmonic spaces, once you have added an harmonic space into the chord area, you 
can edit it with a CTRL+click on the  button (the harmonic space editor window appears) or 
delete it with a SHIFT + click on the same button.

You can resize this area vertically by clicking and moving the gray bar just below this area.
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• Whenever you add or manipulate chords, Pizzicato associates a scale to each chord. Click the  
button to display the associated scales and you will see the following (keep the chords area also 
visible): 

These scales are assigned automatically, but with this global view, you can select which one to 
use by right-clicking on one of the scales. Pizzicato will list the main scales that fit the chord and 
you can then select it from the menu. These scales influence the coloring of notes and also 
several Pizzicato Professional and Composition tools.

In Pizzicato Professional and Composition Pro, you can also drag chords and scales from the 
music composition libraries (Conductor view) and drop them respectively in the chords and scale 
areas. You can double-click a scale in the scale area and change its root note.

• Hide the chords and scales areas and click now on the  button. An additional area is displayed. It is 
the marker and measure number area: 

The measure numbers help you to locate measures. The upper gray lane above it may contain 
customized markers, with a name and a color. Double-click in that lane, around the beginning of 
measure 2. The following dialog appears:

Fill it with the text "Introduction" and select a green color in the small white square. Then click 
OK. The marker is displayed:

You can add markers with a double-click. If you right-click an existing marker, a contextual 
menu proposes to modify it (text and color) or delete it. You can also drag the left border of a 
marker to shift it in time.

Markers help you to locate various parts of your composition.

• Hide the marker area and click now on the  button. An additional area is displayed. It is now 
empty, but this is where you can add audio tracks that will be played together with the score: 
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The following operations may be performed inside this audio track area:

• Right-clicking and selecting of the Add an audio track... menu item. The audio file 
selection dialog appears, as explained in the lesson about The audio tracks. The audio 
tracks appear for instance like this when you have added one or more to the score: 

Only Pizzicato Professional and Composition Pro can have more than one audio track.

• Right-clicking on an existing audio file and selecting the Remove audio track menu item 
will remove it from the score (but the corresponding WAV file on disk is not deleted). 

• Right-clicking on an existing audio file and selecting the Edit audio track... menu item, or 
simply double-clicking an audio track will open the audio editor window as explained in 
the lesson entitled The audio editor. 

• Right-clicking on an existing audio file and selecting the Audio track properties... menu 
item will open the audio track selection dialog, similar to the one used to add a new audio 
track. 

• You can move an audio track left or right to shift its starting point in time in relation to 
the measures. Just click and move the track with the mouse. 

• If you click on the  button to display the audio tracks while holding down the CTRL 
key, Pizzicato will display the content of the audio tracks. 

• The  button is a shortcut to note coloring according to the current scales and chords. When 
switched on, all notes of the score will be displayed in green if they are part of the current chord, in 
orange if they are part of the scale or in red otherwise. 

• Click on the  button. You will see a dialog with the list of all instruments. By default in the global 
view, all instrument staves are visible. In the above example, you have 4 staves. With this dialog, you 
can decide which staff is visible in the global view: 

329



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

Here is a summary of how to use this dialog:

• Double clicking a line in one list will move it to the other list. 
• The All button will put all staves in the visible staves list. 
• The None button will put all staves in the invisible staves list. 
• Using the ">>>" and "<<<" button will move the selected line from one list to the other. 

When you validate the dialog, only the staves displayed in the right list will be displayed in the 
global view. This is used to decide for instance to display only the strings of an orchestral score 
when you want to work on them separately.

• The two icons  are used in relation to the musical effects areas, as we will see them further in 
this lesson. They enable respectively the display of effects from the MIDI tracks and/or from the 
graphic symbols added in the score (nuances, crescendo,...). See the lesson on the musical effects  
view. 

• The  icon is used to call the instruments view, in the configuration where you can define the MIDI 
instruments. It is a shortcut to calling the Edit menu, Instruments item, and choosing the Instruments 
configuration. 

• The  series of icons is used as a set of 10 memories. By default, the 
first memory is active. 

This means that the aspect of the global view, as you choose which areas to display, is stored in 
this first memory. This includes the chords, scales and audio tracks areas as well as the selection 
of visible staves. This also includes all the setup of what is displayed within each staff, as we 
will explain further in this lesson. All this setup is stored in the current memory.

A memory setup is by default displaying all staves and nothing else. Once you have setup the 
global view to display for instance the chords and audio tracks, the brass and percussion staves 
of your orchestral composition, you may then click on the second memory button. This resets the 
global view to its default setup. You can then use the second memory for instance to work the 
woodwinds. Then you select memory setup 3 and prepare it for instance to see all volume 
effects, for each staff.

While working your music composition, you can switch between those three prepared 
configurations, just by using the above memory buttons.
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• The  icon is used to display the graphic editor and the effects lanes in two different ways. The first 
one (by default) is to align the graphic editor and the effects on the beats as they are in the music 
notation of the measures. Here is an example: 

The advantage is that everything is aligned horizontally. The beginning of the dotted half note is 
aligned with the beginning of the graphic line that represents it. Same for the 16th notes. The 
inconvenient is that the scale of the graphic editor is very different from beat to beat and it makes 
it harder to enter music using the graphic editor, as the width of each beat varies greatly to follow 
the music notation.

By activating the  icon, Pizzicato disconnects the two scales and the graphic editor displays a 
fixed and regular scale:

The inconvenient is that the graphic lines are no more aligned with music notation. You can 
switch from one option to the other, according to the type of work you are doing. Usually, the 
second choice is more efficient to enter music with the graphic editor.

• The next three menus  determines the precision and the Tuplet ratio (for 

instance for a triplet, it is 3 / 2). used in the graphic editor. They correspond to the options that are 
available in the graphic editor. 

• The last menu is used to enable the score arranger (Pizzicato Professional and Composition only). It 
will be explained in the lesson on the score arranger. 

The staff header bar

Once you have decided which instruments to display, the rest of the global view will display a tool bar for 
each instrument. This tool bar is the following:
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Some of these buttons are only visible in the advanced versions of Pizzicato.

• By default, the  icon is active. It means that the staff of the instrument is displayed in music 
notation, just below the tool bar. In this music notation area, you can use every Pizzicato tool that can 
be used in the linear or page view (except the page setup tools). You can enter the notes and edit your 
music in this area. 

You can resize that area vertically by moving the lower separation gray bar. You can also zoom 
in and out to increase the precision level. All other areas will zoom in and out accordingly. By 
resizing an area while holding down the CTRL key, all other notation areas will be affected in 
the same way.

You can hide the staff and work only with other areas, as we will see below.

If you click on this icon while holding down the CTRL key, the modification (hiding or showing 
the staff) is applied to all visible instruments. You can quickly hide or show every staves.

• You can double-click the name of the instrument, on the left part of the toolbar. A dialog is displayed 
so that you can edit the instrument name as well as a short name that will be displayed in front of the 
second and following systems in page mode. 

• By clicking on the name, you assign the MIDI echo to that staff, which means that any note played 
on a MIDI keyboard connected to the computer, will be played by the instrument of this staff. The 
staff that has the MIDI echo is marked by a small red square on the top left corner of the notation 
area, when the reference marks tool is activated (shortcut is ":"). 

• By double clicking the background color of the above tool bar (between buttons or to the far right, 
after the buttons), you can select the color assigned to that instrument (here it is blue). 

• Click on the  icon. Zoom in at 150 %. The graphical note editor is displayed for that instrument: 

Basically, it is the same as the one described in the lesson on the graphic editor. When notes are 
present in the staff, this editor will look like this:
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Here is a summary of the operations you can do with it:

• To add a note, click and drag the mouse to the right to extend the duration. The default 
definition is the 16th note. When releasing the mouse button, you will see the note 
translated into music notation on the staff. 

• To move a note, click it and drag it to its new position, whether in the same measure or 
another measure of the same staff. 

• To remove a note, click on it while holding down the CTRL key. 

• To lengthen a given note, click on it while holding the SHIFT key and move the mouse to 
adjust its duration, then release the mouse button. 

• By clicking and dragging inside the first blue column (the color is in fact the color 
associated to the instrument; it is here blue, but in other staves it may be a different 
color), you can hear the notes played by the instrument, as a reference to the ear. Note 
that in the case of percussion instruments, the note name is replaced by the name of the 
percussion instrument. This view is very useful to design drum patterns, as you may do 
the above operation while Pizzicato plays the score in loop so that you hear the resulting 
rhythm. 

• By cliking and moving the left column vertically (the one with the note names), you can 
move the visible range of the notes, so as to cover any note areas. You can also resize the 
graphic editor view vertically, by moving the gray separation bar below the main area. 

• If you hold down the CTRL key and then click and move vertically on a given note name, 
you can move all these notes appearing in the staff to another note. In other words, if you 
click on the C3 note name while holding down the CTRL key and then move it to the 
level of C3#, all C3 notes of that staff will be transposed to C3# notes in the measures. 
This is also easy to change a percussion instrument to another one. 

• By activating the selection tool on the main palette, you can click and drag to draw a 
rectangle and select notes. You can then move this rectangle horizontally (shifts the notes 
in time) or vertically (transposes the notes) or both. You can achieve an Edit, Copy then 
draw another rectangle and do a Edit, Paste to it. You can also delete notes this way. You 
can draw more than one selection rectangle by using the SHIFT key to add a selection to 
the existing one. 

If you click on the  icon while holding down the CTRL key, the modification (hiding or 
showing the graphic view) is applied to all visible instruments.
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• Hide the graphic editor now and click on the first  icon to display the first effect area. By default, 
this effect displays the velocity of the notes. Add a few notes in the score to have for instance: 

Basically, it is very similar to the musical effect view. Here is a summary on how it works.

• If you double click on the  icon, a dialog lets you select the effect you want to edit. By 
double-clicking the icon while holding down the CTRL key, the effect selection will be 
applied to all visible instruments. 

• You may have up to five effects displayed in the global view, for each instrument. By 
clicking one of the 5 icons, you hide/show that effect. If you click it while holding 
down the CTRL key, you hide/show that effect for all visible instruments. 

• To modify the effect curve or to add a curve, just draw freely inside the area. 

• If you click and drag inside the area while holding down the CTRL key, you draw a line 
that will create the controller content when you release it. 

• If you click and drag inside the area while holding down the SHIFT key, you delete any 
controller present on that section. 

• You can do the same as the three above operations, but with the right mouse button. In 
this case, you draw a curve not only in the current instrument, but also in all other same 
controllers for all visible instruments. This is particularly easy to create a full orchestral 
crescendo, with the volume controller areas. 

• You can also resize the effect area vertically, using the separation gray bar below it. 

• To set a precise vertical value when you draw a curve, you can use the up and down 
arrows of the computer keyboards. From there on, you can continue to draw and the 
vertical value stays the same. This is cancelled when you release the mouse button. 

• Similarly, to set a value to its default value, you can hold down the SHIFT key while you 
are drawing. But push that SHIFT key only after clicking with the mouse, otherwise you 
remove the values, as explained here above. 

• Hide the effect editor now and click on the  icon to display the slider area: 

These sliders are represented as graphic areas. You can click in them and adjust the value of the 
green area to fix the value of the slider. These sliders and values are all duplicates of the 
instrument view. When they are displayed here, you can have an easy access to adjust these 
values.
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If you click on the  icon while holding down the CTRL key, the modification (hiding or 
showing the sliders) is applied to all visible instruments.

• Hide the slider area now and click on the  icon to display the virtual instruments. This area is by 
default gray if no virtual instruments are associated to the score, but when some instruments are 
present, it looks like this: 

You may drag and drop virtual instruments from the Pizzicato (Professional and Composition) 
music libraries to that area and you can double-click them to edit them. With the Beginner 
version, you can only see the associated instrument. You can assign virtual instruments to the 
staves with the Edit, Assign virtual instruments to staves... icon.

In the Professional and Composition versions, you can also move the limit between two virtual 
instruments, simply by dragging the limit with the mouse.

If you click on the  icon while holding down the CTRL key, the modification (hiding or 
showing the virtual instruments) is applied to all visible instruments.

• The  icon simply calls the dialog of the characteristics of a staff. You can adjust the measure 
numbers, the staff lines, the brackets, the guitar tablature and many other specifications. See the 
lesson on the staves characteristics. 

• The following icons 

 
are duplicates of some useful columns of the instruments view. Here is a list of their meanings (from 
left to right): 

• Play - Only the enabled instruments are played back by Pizzicato. You can mute an 
instrument by disabling it here. 

• Solo - An easy way to hear only one instrument. Whenever there is at least one Solo 
instrument active, Pizzicato will only play these instruments and mute all others. 

• V1 - V2 - V3 - Play or Mute the first three rhythmic voices of the staff. 
• Transp. - This is a popup menu to select a transposition value that will be used (in half 

tones) to play back the score by Pizzicato. This can be used with transposing instruments 
written in their own tonality. 

• Perc. [only in advanced versions] - Calls the percussion map dialog, as explained in the 
instruments view lesson. 

• RTP - Real Time Playing. When active, this option will force Pizzicato to compute and 
play the associated virtual instruments in real time. This may require much more 
processor power to play the instruments. 

• The next three menus are used to select the sound of the instrument. You can select the 
synthesizer, the familly and the instrument. 

• The next menu shows the MIDI channel. You can select it as Automatic (by default), in 
which case Pizzicato will determine the channel itself, or you can select a given channel 
for a more advanced control of MIDI. 

• Automatic [Only Pizzicato Professional and Composition] - This is the arranger mode 
assigned to this instrument when the score arranger is active. See the lesson on the score 
arranger. 

• Arrange [Only Pizzicato Professional and Composition] - This option is also related to 
the score arranger. When it displays Arrange, the arranger may modify this instrument. If 
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you click on it, a red cross is displayed and the arranger will never touch the notes of this 
staff. 

Composition libraries (1)
• What are the composition libraries ? 
• Elements of the composition libraries 
• Composing with the libraries 

What are the composition libraries ?

The principle of the composition libraries is probably the main innovation introduced by Pizzicato. It is a 
musical building set. It offers you a tool for composition assistance. It enables the beginner to approach 
composition and the professional to accelerate his work, to test and discover new musical combinations 
easily.

This lesson and the five next lessons present the composition help system as it was developped for Pizzicato 
1 and 2. Pizzicato version 3 introduces another set of tools related to music composition, that are more easy 
to use and more intuitive. You can discover them in the composition help lessons.

To follow these lessons correctly, check that the windows management mode is will set to Free, in the 
Windows, Windows management menu item. These old library system is indeed not well adapted to the new 
document and windows manager. Also open the example files directly from the File, Open... menu item and 
not through the document manager. They can be found in the DataEN / Examples folder.

The idea is very simple. It consists in breaking up music into basic elements and combining them in a 
construction that may become very sophisticated.

It is always possible to break up a piece of music into a set of elements belonging to the 4 following 
categories:

• Rhythms 
• Notes 
• Sounds 
• Performance 

The rhythmic aspect specifies how the events proceed in time and one compared to the other. In the score 
writing, they are represented by rhythmic values (quarter notes, eighth notes…).

The notes creates the melodies and the chords of a piece. In musical notation, notes are located by their 
vertical position on the staff.

Sounds are represented by the instruments playing the notes and rhythms. The choice of instruments or 
synthetic sounds influences the sound result of the musical work.

Finally, a whole series of indications may be written on the score in order to specify how the piece must be 
played: nuances, accents, tempo variations, as well as all effects which can modify sound (reverberation, 
balance, glissando, performance, durations of notes…). We will group all this under performance. These 
indications can be written explicitly on the score or sometimes implicitly added by the musician in order to 
add his personal feeling to the music.

When composing with Pizzicato, the first two aspects (notes and rhythms) can be dealt with by the 
composition libraries. 

Sounds are selected with the instruments view and the performance is modified by the various symbols 
available in the Tools palettes and by the various MIDI parameters of the instruments view. The conductor 
of this set of tools is of course you, the composer!

The composition libraries offer you a tool to combine the basic notes and rhythms and build a musical score. 
By selecting the instruments and adding performance symbols, you can really compose a musical work. This 
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lesson and the following will mainly insist on the combinations of rhythms and notes, these elements 
forming the basic structure of a musical score.

Elements of the composition libraries

Four basic elements have been chosen to combine rhythms and notes. These elements are the rhythm, the 
melody, the theme and the chord. These elements form the construction blocks of the composition libraries. 
Here is a precise definition:

• The rhythm 

It is a succession of conventional rhythmic values (quarter note, eighth notes…) to play (for the 
notes) or not to play (for the rests) one after the other. The rhythm may contain only one 
rhythmic value or several of identical or different values. The sum of the durations of each value 
represents the total duration of the rhythm. In the definition of a rhythm, notes pitches are not 
taken into account. Here some examples of rhythms:

1 quarter note + 1 quarter rest = a 2 quarter notes duration:

1 quarter note + 2 eighth notes + 1 quarter note + 4 16th notes = a 4 quarter notes duration:

1 16th note + 1 eighth note + 1 16th note + 1 quarter rest = a 2 quarter notes duration:

1 half note + 1 dotted quarter note + 2 16th notes + 1 eighth rest + 1 dotted eighth note = a 21 
16th notes duration:

• The melody 

It is a succession of notes to play one after the other. The melody can contain only one note or a 
several notes. Each note is represented by its pitch on the staff, possibly modified by an 
accidental. In the definition of a melody, the rhythmic values is not taken into account. Here are 
some examples of melodies:

One note melody (A):

8 notes melody (C, D, E, F, G, F, E, D):
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3 notes melody (C, E, B flat):

• The theme 

Like the melody, it is a succession of notes to play one after the other. But this time a rhythmic 
value is associated with each note and there can be rests between notes. It is a combination of a 
rhythm and a melody. This association forms a fixed construction block. The association 
between notes and rhythms is unique and will always be done in the same manner. The theme 
may comprise only one note or several notes. Each note is represented by its rhythmic value and 
its pitch on the staff, possibly modified by an accidental. Here are some examples of themes:

7 notes theme:

5 notes and 2 rests theme:

• The chord 

It is a set of notes played at the same time. The definition of a chord may contain one or several 
notes. Each note is represented by its pitch on the staff, possibly modified by an accidental. The 
various notes are written one above the other to indicate that they are played simultaneously. No 
rhythmic value is associated with the definition of a chord. The lower note is regarded as the root 
note of the chord. Here are two examples of chords:

4 notes chord (G 7):

6 notes chord (C Major):
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Composing with the libraries

Pizzicato lets you create elements of the 4 types above to form composition libraries. They then contain the 
basic blocks to create a piece of music. Several composition libraries are provided as examples. You can find 
them in the DataEN / Music directory.

To compose with libraries, the first step is thus to have or to build a library with a certain number of 
rhythms, melodies, themes and chords. On the screen, these 4 elements are visible in the main view, in the 
form of icons. The type of element represented by the icon is indicated by the first letter: R for the rhythm, 
M for the melody, T for the theme and C for the chord.

• Start Pizzicato and close the default document. Check that the windows management mode is set on 
Free in the Windows, Windows management menu item. Then open the Ex062 document in the 
DataEN / Examples directory, through the File, Open... menu item. The main view appears as 
follows: 

You will find two elements of each type. With each element, there is an associated name drawn under the 
icon, in order to recognize them.

• To see the contents of an element, double-click its icon. Open for example the Melody 1 icon. The 
element is displayed in a new score view: 

As we will see in the next lesson, melodies are represented with all notes in quarter notes values.

• Close this melody and open rhythm 1. You get: 
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• Do the same with the other elements to see what they contain. Close the library elements and open 
the Score 1 in the left corner of the main view. The piece contains only one measure. In this measure, 
we will combine Rhythm 1 and Melody 1. Each one of them contains 6 values. 

• We will first drag the rhythmic element into the measure of the score. Click on Rhythm 1 and drag it 
in the direction of the measure. A rectangle of the same size follows your movement. Continue to 
drag up to the moment when the arrow of the mouse cursor is inside the measure: 

• At this time, release the mouse. The measure is redrawn and contains one whole rest. When you add 
an element in a measure, Pizzicato calculates the contents of this measure, compared to the elements 
which are already there. We will see further that you need at least one element with rhythmic values 
and one element with notes to give a visible combination. 

• Do the same with Melody 1: drag it into the measure. At this time, Pizzicato calculates the measure. 
As there are now rhythmic values and notes, they are combined with each other and the measure 
becomes: 

• The first note of Melody 1 (C) has been combined with the first rhythmic value of Rhythm 1 (quarter 
note). The second note of Melody 1 (E) was combined with the second rhythmic value of Rhythm 1 
(16th note) and so on for each note and rhythm. 

• Select the Measure Attributes... in the Edit menu. The following dialog box appears: 

• It is used to specify how the score measures are displayed in the score view. Up to now, we have 
always worked with the first option, displaying the notes contained in the measure. Click now on the 
third choice, View attached libraries. Click OK and the measure is redrawn as follows: 

You see the two elements that we have dragged in the measure. They are represented by small blocks with 
the type letter (R, M, C or T) followed by the name of the element. This display option lets you quickly 
visualize the library elements associated to the measures.

• Call again the above dialog box and click on the second choice, Graphical view of the notes. Click 
OK and the measure is redrawn to display the notes in the form of small lines with different heights, 
in a similar way to the piano roll view: 

In the above dialog, notice the Only for selected measures check box. When it is not checked, the measure 
display option is valid for the full score. If you select (with the selection tool) a set of measures and then 
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check this box, only the selected measures will be affected by the operation. This lets you for example 
display one staff with the notes and another with the library contents.

We will see in the next lessons how to create new elements and to combine them together in a lot of 
possibilities.

Composition libraries (2)
• Creation of a rhythmic cell 
• Creation of a melodic cell 
• Measures calculation method 

Creation of a rhythmic cell

We will learn how you can create melodies and rhythms. We will then study in more details how Pizzicato 
generates measures when you add library elements in them.

• Start with a new document. Open the main view, in the Windows menu. In the Edit menu, select the 
New element… item and then New rhythm… The following dialog box appears: 

It is used to define the rhythm characteristics. The upper area of the dialog lets you select between a 
rhythmic cell and a rhythmic cells combination. For the moment, let us take the default choice, rhythmic cell. 

• Give a name to this rhythm by typing it with the keyboard: Rhythm 1. Click OK. In the score view 
that appears, add the following rhythmic values on the single line, using the note entry tools: 

• Close this view now. The left side of the main view contains an additional icon named Rhythm 1: 

When you add a library element, Pizzicato places it on the left most and highest location possible, while 
avoiding superimposing it with other elements, and this in the visible part of the main view. You can then 
move them as you wish, for example if you want to group them by types, contents…

With a double-click on an element, you can again visualize and modify the contents of this element, as we 
had done in the preceding lesson.
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If you hold down the Control key and double-click an element, the dialog box of the element characteristics 
appears and you can modify them.

These three remarks are valid for the 4 types of elements (rhythms, melodies, themes and chords).

While holding down the Control key, double-click the Rhythm 1 element. Here is a detailed explanation of 
the various options:

• Multiply duration by 

When you check this box, the rhythmic values are multiplied by the number you place in the text 
box just to the right. If you fill in for example "2", all quarter notes will double their value and 
will be replaced by half notes. The eighth notes will be replaced by quarter notes. This number 
must be greater or equal to 1. This option lets you multiply the duration of a rhythmic sequence. 
Notice that the rhythmic values are modified only when you use them in the score. If you 
double-click the icon to see the rhythm, they will not have been changed.

• Divide duration by 

When you check this box, the rhythmic values are divided by the number you place in the text 
box just to the right. If you fill in for example "2", all quarter notes will become eighth notes and 
eighth notes will be replaced by 16th notes. This number must be greater or equal to 1. This 
option lets you divide the duration of a rhythmic sequence. You can use both multiplication and 
division at the same time. For example, if your rhythm contains eighth notes and you multiply by 
2 and divide by 3, you get eighth notes triplets.

• Repeat result X times 

This option is used to repeat the full rhythmic cell several times. If you check this box and fill in 
"3" in the associated text box, the rhythmic cell will be played 3 times in sequence. If you fill in 
"1", it will be played only once. If you want to repeat this rhythmic cell ad infinitum, you can 
check this box and fill in "0" in the text box. This element will act as an unlimited generator of 
repetitive rhythm.

• Invert time direction 

This option will force Pizzicato to use the rhythmic cell backwards. It will start with the last 
value and finish with the first.

• Limit total duration to 

This option limits the total duration of the rhythmic cell to a multiple of a standard rhythm value. 
Check the box, select the basic value (whole note, quarter note…) and to fill in the total in the 
text box. When you introduce the values of a rhythm or when you modify them by double-
clicking on the element, the score view always uses a 4/4 measure by default. If you want for 
example to create a rhythm which contains only one quarter note, Pizzicato automatically 
completes the measure with 3 rests so that the 4/4 measure is complete. In this case, your rhythm 
will thus have 4 beats as total duration, including three rests that you did not really want. In that 
case, check the Limit total duration to box, fill in "1" in the text box and select the quarter notes 
in the popup menu. The total duration of the rhythm will thus be limited to one quarter note, 
although the measure is completed by rests. When using an element, Pizzicato takes only the 
limited duration into account. This option is valid also if you use the ad infinitum repetition. The 
effect of this option is then to limit the infinity of the rhythms to a specific total duration. If you 
wish for example to work with quarter notes during 16 measures, you can create a 4 quarter 
notes cell, repeat it ad infinitum and limit the duration to 16 whole notes. We will see that this 
option will be very useful when we will use the rhythmic combinations.

Click OK.
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Creation of a melodic cell

• In the Edit menu, select the New element… item, then New melody… The following dialog box 
appears: 

• Here also we have the possibility to select between a Melodic cell or a Melodic cells combination. 
For the moment keep the first choice, fill in the name Melody 1 and click OK. 

• In the score view, fill in the following measure: 

In fact, the rhythmic value of notes does not matter in the definition of a melody. You could have entered 
these 5 notes as 16th notes or quarter notes… On the other hand, as the score view proposes you a 4/4 
measure by default, if you had introduced the 5 notes as quarter notes, it would have been necessary to add 
one measure to place the fifth quarter note. Notice that it is possible to place chords in the melody, with the 
chords tool. Close this score view. The Melody 1 icon is now to the right of Rhythm 1:

• Double-click on Melody 1.The melody became: 

When Pizzicato displays a melody, it always uses quarter notes. The way in which you introduced it does not 
matter. It creates the necessary number of measures to display the complete melody. Close this score view.

To call the melody characteristics dialog box, hold down the Control key and double-click the Melody 1 
icon. Here is a detailed explanation of the various options:

• Do not transpose 

We will see in a future lesson that adding a melody and a chord in the same measure, Pizzicato 
will modify the melody to adapt it to the chord. If you do not wish this melody to be transposed 
with a chords progression, check this option and the transposition will not occur on this melody.

• Do not arrange 
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This option is similar to the above one. When a chord is added with a melody in the same 
measure, Pizzicato will modify the notes of the melody so that the melody is only formed by the 
chord notes. If you check this box, Pizzicato will not modify the melody according to the chords.

• Invert time direction 

The notes of the melody will be used in the revert order, starting with the last and finishing with 
the first.

• Repeat melody X times 

This option repeats the whole melody several times. If you check this box and enter "5" the text 
box, the melody will be played 5 times. By setting it to "0", the melody will be repeated ad 
infinitum and the melody cell will act as an unlimited source of notes.

• Limit to X notes 

By checking this box and by specifying the number of notes in the text box, the melody will be 
limited in length. If you create for example a 2 notes melody and repeat it ad infinitum, you can 
for example limit the number of notes of the melody to 25 notes.

• Repeat notes X times 

This option repeats each note a precise number of times. If your melody contains a C note and a 
D note and if you repeat the notes 3 times, the resulting melody will be (C, C, C, D, D, D). The 
repetition is thus executed for each note, as opposed to the option which repeats the full melody 
several times. You can of course use both options at the same time.

Click OK.

Measures calculation method

When you add library elements in a measure, Pizzicato follows precise rules to calculate the score notes 
from them. We will explain them using examples.

• In the score, place a treble clef at the second staff, so as to get: 

• Drag Rhythm 1 in the first staff first measure. The score is redrawn with whole rests on each measure: 

When you add a new element in a measure, Pizzicato automatically calculates all concerned staves. So as to 
have notes in the measure, you need at least the presence of an element with notes (melody, theme or chord) 
and an element with rhythmic values (rhythm or theme). Otherwise, the measure is completed with rests. As 
for the moment there is only one rhythm and no notes, there are only rests in the measures.

• Now drag Melody 1 in the first staff first measure. The score appears: 
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The guiding principle is that when a melody and a rhythm are present together, Pizzicato associates the first 
note pitch of the melody to the first rhythmic value of the rhythm to form the first note of the measure. Then 
Pizzicato associates the second note pitch of the melody to the second rhythmic value of the rhythm to form 
the second note of the measure. And so on, until there is no more notes in the melody or no more rhythmic 
values in the rhythm. In other words, if the melody contains 5 notes and if the rhythm contains 8 rhythmic 
values, only the first 5 rhythmic values are associated to the 5 notes. The 3 last rhythmic values will not be 
used, because they do not have corresponding notes.

In our example, Rhythm 1 and Melody 1 contain both 5 elements. After these 5 elements are combined, there 
is neither rhythmic values nor notes pitches and the following measures are completed with rests.

What you need to fully understand is that this association procedure of notes pitches and rhythmic values is 
not limited at all to only one measure. The calculation of the libraries associated with a measure is done 
starting from this measure and continues through all following measures, until there is no more rhythmic 
values or no more notes pitches.

Now create a new melody that you call Melody 2. Check the Repeat melody box and fill in "0" in the 
corresponding text box. This melody will thus be repeated ad infinitum. Fill in the 2 following notes in the 
score view:

Close this view.

• Drag Melody 2 and Rhythm 1 in measure 1, staff 2. The score becomes: 

The C and D notes were repeated until there was no more rhythmic values to associate with them. 
Potentially, there remains an infinite quantity of notes to associate (C-D repetition ad infinitum) but 
Pizzicato stopped for lack of rhythm values (rhythm 1 contains only 5 values).

• Drag Rhythm 1 in measure 3 of staff 2. The score becomes: 

What happened? Being short of rhythmic values in the first measure, Pizzicato nevertheless kept its infinite 
C and D notes reserve. When getting to measure 3, there is a new rhythm, of which the 5 rhythmic values are 
extracted to associate to the notes reserve. The result is thus 5 additional notes associated with the values of 
Rhythm 1.

• Open the dialog box of the Rhythm 1 characteristics (double-click with the Control key). Check the 
Divide duration by option and fill in "2" in the associated text box. Click OK. The modification in the 
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score is not automatically executed when you modify an element. In the Edit menu, select the 
Generate score item. The score becomes: 

The contents of the measures was updated by taking into account the modifications made to the Rhythm 1 
element. This happened for all measures containing the Rhythm 1 element. When you drag an element 
(rhythm, melody, chord or theme) into a measure, this element remains related to the main view. When you 
add an element 15 times in various measures, it is not a copy which is placed, but well a reference to this 
element. A modification made to this element is then reflected everywhere it appears in the score, but only 
when you ask Pizzicato to generate the score (i.e. it erases and calculates all measures of the score again).

• Open the dialog box of the Melody 2 characteristics. Check the Repeat notes option and fill in "3" in 
the associated text box. Click OK and ask Pizzicato to generate the score (as above). The score 
becomes: 

The notes of Melody 2 have all been repeated 3 times. On staff 2, the sequence of notes is indeed:

C-C-C-D-D-D-C-C-C-D

which corresponds to the 2 series of 5 rhythmic values placed in staff 2.

To view the elements placed in the measures of the score, select the Measure attributes item in the Edit  
menu. Check the View attached libraries box and click OK. The score shows you now the elements that you 
dragged into the measures during this lesson:

Exercises
Before doing the exercise, do not hesitate to read again these first two lessons over the composition libraries. 
Each option of the dialog boxes has an importance. Before continuing, be really sure to understand each 
concept and each example of these 2 lessons, because the next lessons will be based on these concepts.

• Start from a new document and create a melody which you name M1. Use the Repeat melody option 
4 times. Click OK and add the following notes: 

• Create a new rhythm, name it R1 and check the Repeat result option 4 times. Fill in the following 
rhythmic values: 

346



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

• In the score, drag R1 and M1 in the first measure. The score should look like this: 

The melody and the rhythm were indeed repeated 4 times as required.

Composition libraries (3)
• Creation of a theme 
• Creation of a chord 
• Combining a chord, a rhythm and a melody 

Creation of a theme

We will learn how to create a theme and a chord. We will then see how to combine a chord and a rhythm, 
with or without a melody.

• Start with a new document. Open the main view and in the Edit menu, select the New element… then 
New theme… item. The following dialog box appears: 

A theme is a direct association of notes and rhythmic values. This is why you find here a combination of the 
options relating to the notes and to the rhythmic values. You can multiply and/or divide the duration of the 
rhythmic values, repeat the theme several times (0 to repeat it ad infinitum), repeat the notes several times, 
reverse the theme direction (play it backwards), limit the total duration of the theme to a quarter note, half-
note multiple,... When the theme is used with a chord, it is possible to arrange it and/or to transpose it 
according to the chord.

• Check the Do not arrange option. At the end of this lesson, we will see in detail what these two last 
options mean. In the name text box, fill in Theme 1. Check and complete the Repeat result option 3 
times. Click OK. In the score view that appears, fill in the following theme: 
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Close this view. In the main view, an icon placed next to the right of Score 1 represents the new theme:

Drag Theme 1 on the first measure. The score becomes:

As the theme contains notes and rhythmic values, Pizzicato could complete the measures. The theme is 
repeated 3 times, as we required. As it contains only a total duration of 3 quarter notes and because it was 
placed in a 4/4 measure, the repetitions of the theme are done in sequence and overlap from one measure to 
another.

Close the score view.

Creation of a chord

• In the Edit menu, select the New element… then New chord… item. The following dialog box 
appears: 

It is used to define the characteristics of the chord. It is possible to create a chord or a chords progression. 
We will consider the chords progression in a future lesson. An option prevents the chord transposition and 
another allows to repeat the result (the chord) several times or ad infinitum (value "0" in the text box). The 
two options of the middle of the dialog box only concern the chords progressions and will be seen further. 
The last text box adds a fixed transposition to the chord, in half tones. A negative number transposes down, 
while a positive number transposes up.

• Name this element G Major. Click OK. In the score view that appears, place the following chord: 

Notice that you can place these three notes as you want it, because Pizzicato takes only the notes pitches into 
account. You could have introduced them as this:
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The order of notes is not taken into account for the chord. By closing the score view, the main view displays 
an additional icon representing the G Major chord: 

• Create a new rhythm and name it Rhythm 1. Check the option to repeat the result 3 times. In the score 
view, fill in the following rhythmic values: 

Close this score view.

• In the Edit menu, select the New element… then New score items. It appears next to the Rhythm 1: 

• Open this score and add 2 measures. Then drag Rhythm 1 and G Major into the first measure. The 
score becomes: 

The principle of combination of a rhythm and a chord is different from the combination of rhythm and 
melody. As soon as a chord is present, it remains valid up to the following chord or to the end of the score if 
there is no more chord. In our case, only one chord was present and it is thus valid in the three measures. The 
rhythm is used 3 times. Each rhythmic value is associated with the chord.

Combining a chord, a rhythm and a melody

Until now we placed only two different elements in the same measure. Our Score 2 contains already a 
rhythm and a chord. We will add a simple melody to it.

• Create a new melody and name it Melody 1. Select the option to repeat it 4 times. Also click the Do 
not arrange option. Click OK and fill in the following notes: 

• Close this window and drag Melody 1 in the first measure. The score becomes: 

When you place a chord, a rhythm and a melody in the same measure, Pizzicato modifies the melody 
(following the transpose and/or arrange options) according to the chord and then associates the resulting 
notes to the rhythmic values of the rhythm. When melody 1 was created, we checked Do not arrange. 
Pizzicato thus transposed the notes without arranging them according to the G major chord. Let us see this in 
more detail.

If one does not prevent it explicitly by checking the option Do not transpose in the characteristics of the 
melody, Pizzicato automatically transposes the melody according to the lower note of the chord.
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When you introduce a melody, Pizzicato automatically considers that it is written in the C Major tonality. 
The interval used for the transposition is the interval which separates the lower note of the chord and the C 
note. In our case, the lower note of the chord is a G. Melody 1 was thus transposed from C Major to G major. 
To respect the melody, the B notes were transformed into F #.

• Open the dialog box of Melody 1 characteristics (double-click + Control key). Uncheck the Do not  
arrange option and check the Do not transpose option. Click OK and select the Generate score item 
in the Edit menu. The score becomes: 

The arrange operation simply consists of taking each note of the melody and replacing it with the nearest 
note belonging to the chord. For example, the C of the melody does not belong to the G Major chord. 
Pizzicato thus found the note which is closest to C in the chord, i.e. B. The G of the melody belongs to the 
chord and so stay the same. It is also the case with the B note. The melody is thus arranged to correspond to 
the chord notes.

• Open the dialog box of Melody 1 characteristics and uncheck the Do not transpose option. Click OK 
and generate the score. You get: 

Pizzicato first transposes the melody and then arranges it to make it correspond to the G major chord notes. 
The transposition alone gives us the notes G, D and F #. When you arrange these three notes according to the 
G major chord, only F # does not belong to the chord. This note is thus transformed into a G note, which is 
the nearest note belonging to the chord.

• Open the dialog box of Melody 1 characteristics and check the Do not arrange and Do not transpose 
options. Click OK and generate the score, which then becomes: 

When you prevent both transposition and arrangement, Pizzicato does not modify the notes of the melody. It 
is as if the chord did not exist, because the notes of the melody are simply combined with the rhythmic 
values of the rhythm, without taking the chord into account.

Exercises
Here is an example you can create as an exercise.

• With a new document, create the following chords and name them respectively C Major, F Major 
and G Major: 

  

• Create a theme and name it Theme 1. Choose to repeat it 4 times. Check the Do not transpose option. 
Click OK and fill in the following notes: 

• Drag Theme 1 in the first measure. Drag then C Major into measure 1 and measure 4. Then drag F 
Major into measure 2 and G major into measure 3. The score finally becomes: 

350



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

The theme was arranged to correspond with the notes of the 4 chords placed in the measure. Listen to the 
sound result.

Composition libraries (4)
• Creation of a melody folder 
• Options of a melody folder 
• Multiplying combinations 

Creation of a melody folder

In this lesson, we will learn about combinations, also called folders. It is possible to create rhythms, 
melodies, themes and chords folders. The basic principles of a folder are similar all elements. We will start 
by studying in detail the melody folder.

A folder is an object which can contain several elements of the same type. In a melody folder, you can place 
one or more melody cells such as we defined them in the preceding lessons. It is then possible to assign 
options which will be valid for all melodies in a melody folder.

• Start Pizzicato, close the default document and open the DataEN / Examples / Ex063.piz example. 
The main view displays the following icons: 

Eighth note is a rhythm that contains only one eighth note, repeated ad infinitum. The 7 melodies are 
elements containing each one only one note, indicated by the name of the element. For example, double-
click on the melody named G. Its contents is:

Close this view.

• In the Edit menu, select the New element… then New melody… item. In the higher part of the dialog 
box, check the second choice, Combinations of melodic cells. Name this element C scale. Click OK. 
A new icon appears, it has a different form than the others: 

It represents a small bag, a folder that may contain melodies. For the moment, it is empty, because we placed 
nothing in it.

• We will drag one by one the 7 melodies in it. While holding down the Control key, click on the C 
icon and drag it in the direction of this folder. A rectangle follows your movement. When the mouse 
cursor arrow is inside the folder, release the mouse. At this time, the C melody disappears from the 
main view. It is in the C scale folder. 
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• Do the same operation with the 6 other melodies while taking care to place them in order from left to 
right. If necessary, you can move the folder to bring it closer to the melodies, according to the size of 
your screen. 

• When all melodies have been moved, double-click on the C scale folder. The following window 
appears: 

It displays the icons contained in the folder. The window title shows the folder name. Horizontal and vertical 
scroll bars are used to move in the window, when there are too many elements inside. You can also use the 
zoom box. Close this window with the closing box.

A melody folder can be used in the same manner as a melody cell. It can be placed in a measure and be 
associated with a rhythm. Double-click on Score 1 and place the Eight note element in the score first 
measure. Then drag the C scale in it. The score becomes:

The rhythmic values (eighth notes ad infinitum) were associated with the 7 melodies of one note each, in the 
order in which they were placed in the folder.

Options of a melody folder

We will see in practice what are the effects of the options located in the dialog box of the characteristics of 
the melody folder.

• By holding down the Control key, double-click the folder. Select the Repeat melody option 3 times. 
Click OK and generate the score (Edit menu , Generate score item). The score becomes: 

The 7 melodies were sequenced 3 times.

The Do not transpose and Do not arrange options are exactly the same as for the definition of a melody or a 
theme. They have an influence only when a chord combines with the melody folder in the same measure. 
When they are checked, they prevent Pizzicato from transposing or arranging the melody cells located in the 
folder, even if these options are not checked in the individual melodies.

• Open the dialog box of the C scale characteristics. Select the Limit to 16 notes option. Click OK and 
generate the score to get: 

The number of notes extracted from the folder was limited to 16, filling exactly two 4/4 measures with 
eighth notes.

• Open the same dialog box again. A menu shows in the higher part that the melody cells are Ordered. 
Pizzicato thus uses them in the order in which the melodies were placed in the folder. Modify this 
menu by selecting the Inverted item. Click OK and generate the score: 
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The sequence of the melodies contained in the C scale was used in the opposite order.

• Open it again but select the Random item of this menu. By calculating the score again, you get for 
example: 

The result is a random mixture (notes randomly selected by Pizzicato) of the 7 melodies of one note each. 
Notice that you will probably not get the notes here above. When you select the Random option in a folder, 
each time Pizzicato calculates it, a different result is generated.

The number of notes is limited to 16 notes, as indicated in the options. As soon as a random option is 
selected, the folder becomes an ad infinitum generator, which randomly generates elements among those in 
the folder. If you wish a limited number of random melodies, you must then select the Limit to X notes  
option.

• Open again the dialog box of the C scale characteristics. Click on the More options... button. The 
following dialog box appears: 

It can be used to define some arrangement options for the melodies. It is also available for the themes 
folders.

The higher part fixes the notes range that will be generated in the score. Menus let you select the note and 
the octave, lower and higher.

The 4 following menus select two lower and upper split points. When a generated note exceeds the upper 
split point, it is automatically transcribed on the upper staff. Similarly, when the generated note go lower 
than the lower split point, it automatically goes to the lower staff. These options allow for example to split 
the right and left hands for the piano.

The following slider determines the notes arrangement rate on a chord. When the Do not arrange option of 
the preceding dialog box is not checked, the percentage applies to the notes arrangement. By default, it is 
fixed at 100 %, which means that all notes will be arranged in relation to the chord. By placing for example 
50 %, only half of the notes will be arranged, this in a random way, the other notes being not modified.

The following text box limits the repetition of the same note. A value of 0 makes this option inactive. By 
placing for example "2", Pizzicato will remove notes automatically if the same note is repeated more than 
twice in a random way. By placing "1", you are sure never to have twice the same note in sequence.

The last menu selects what should be done if a note exceeds the range specified above. The default choice is 
to transpose the note. It is also possible to remove the note. Click OK and again OK. 

353



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

• While holding down the SHIFT key, double-click on the C scale folder. The following dialog box 
appears: 

It shows the list of the elements contained in the folder. A text box shows the priority of the element selected 
in the list. The priority is used in combination with the random option of the other dialog box. The possible 
values vary from 0 to 15. The larger the priority, the more Pizzicato will select this element. We may then 
influence the chance of using an element. For instance, we want the 2 main notes C and G to appear in 
majority and the other notes to appear much less. Replace the 8 by 15. Then click the G and place a priority 
of 15 also. For all other elements, set a priority of "1", by clicking first on the line then by changing the 
number which appears in the text box. By default, all priorities were placed at 8 (middle priority). Click OK 
and generate the score. You get something like:

Calculate the score several times. The result will be each time different but the notes in majority will be C 
and G, i.e. the notes which have the highest priorities. One can state as a rule that a priority "15" note will be 
used 15 times more often (on average) than a priority "1" note.

• In the characteristics of the folder dialog box, select again the Ordered option in the menu. Click OK 
and open the other dialog box (with the SHIFT key and a double-click). Notice the Up and Down 
buttons. They are used to modify the order of the list elements. Click for example on D and then click 
three times on Down. D goes down by three positions and will be placed after the G. Click OK and 
generate the score. You get: 

The melodies are in sequence again, but the order was modified as required.

When you place library elements (rhythms, melodies, themes or chords) in a measure, they remain 
associated with the measure. When the contents is calculated starting from the libraries, Pizzicato first erases 
all notes and rests of the measure and then calculates and places the rhythmic notes and values, as we have 
seen before. Once this operation is done, the contents of the measures can be modified with every tools 
located in the Pizzicato palettes. You can modify the notes exactly as if they were introduced manually by 
you. With the composition libraries you can save time to compose because they help you quickly generate 
systematic accompaniments. You can then modify those to adapt some passages or details which disobey the 
rules introduced into the definitions of the library elements. After the modifications, be careful not to 
generate the score again, because Pizzicato will erase everything to start again from the original library 
elements.

Multiplying combinations
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Once a melody folder is created and one or more melodies have been introduced in it, this folder behaves 
itself like a melody. It can thus be placed in a measure but also in another melody folder. This other folder, 
also behaving like a melody, may itself be placed in another melody folder. Each folder can have different 
options and contain a great number of distinct elements combined in order, inverted order or in a random 
way with priorities. It is possible to build increasingly complex structures which generate very structured 
melodies directed for example towards jazz improvisation, arpeggio accompaniments, chromatic, pentatonic 
scales,... The only limit is imagination. We will further see that it is possible to do the same kind of 
constructions with rhythmic folders, themes and chords. A lot of possibilities is then offered to the composer 
to create composition libraries to his appreciation. The novice composer will be able to use the libraries 
provided with Pizzicato to make his first steps in composition. By combining these various libraries and by 
playing his choice ability on the multiple possible combinations, he will be able to execute his first 
compositions. Gradually, he will be able to build his own libraries, the further he will be acquainted to the 
various musical elements.

We now will execute an example containing a combination of 3 melody folders to generate a melody more 
specific than the above example.

• Close this document without saving the changes. Open the Ex064.piz example. A certain number of 
elements are in the main view. In the upper right part there is a group of 7 melodies (if needed, use 
the scroll bars to see them ): 

They are 7 melodies with the 7 notes of the C scale. We will place them in a folder, as for the above 
example.

• Create a new melody. In the upper part of the dialog box, select Combination of random melodic  
cells. We want to create an element which comprises only one note, but this note must be randomly 
selected among the 7 notes. Thus check the Limit to 1 note option. Name this element 1 note. Click 
OK. The following element appears in the main view: 

• Drag the 7 (C to B) elements in it, by holding down the Control key. 

• In the main view upper area, you may observe a group of 14 melodies: 

They represent groups of 2 related notes taken in the 7 notes of the C Major scale. Create a new random 
melody folder as above. Name it 2 notes. Select the Limit to 2 notes option. Click OK and drag one by one 
these 14 melodies into the new folder which appeared in the main view, with the Control key.

The 26 melodies located lower form groups of three related notes:
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• Create a new random melody folder as above. Name it 3 notes. Select the Limit to 3 notes option. 
Click OK and drag one by one these 26 melodies into the new folder which appeared in the main 
view, with the Control key. Then gather the remaining icons to the top of the main view. You must 
have the following icons: 

The folder named 1 note thus contains one note randomly taken among 7 notes. The folder named 2 notes  
contains a melody with 2 notes randomly taken among 14 melodies. The folder named 3 notes contains a 
melody of 3 notes randomly taken among 26 melodies. We will now create a new folder where we will 
successively place these 3 folders while observing the result on the score.

• Create a new melody. In the upper part of the dialog box, select Combination of ordered melodic  
cells. Name it Melody 1. Click OK and drag the 3 notes folder into the Melody 1 folder, but without 
the Control key, so as to keep it also in the main view. 

• Open Score 1 and place Melody 1 and Eighth note icons in the first measure. You will obtain a group 
of three notes taken randomly among the 26 melodies of 3 notes (not necessarily the same one as 
here, because the choice is random): 

Indeed, Melody 1 contains only one element, which is the 3 notes folder.

• Drag the 2 notes folder into Melody 1. Melody 1 now contains 2 ordered elements: 1 melody of 3 
notes (randomly among 26) and 1 melody of 2 notes (randomly among 14). Generate the score. You 
will thus get 5 notes. The first three are 3 related notes and the 2 following notes are related between 
them but not necessarily with the first three. Here is for example what you could get: 

Generate the score several times in order to see several examples of it.

• Drag 1 notes folder in Melody 1. Melody 1 now contains 3 ordered elements: 1 melody of 3 notes 
(randomly among 26), 1 melody of 2 notes (randomly among 14) and 1 melody of 1 note (randomly 
among 7). Generate the score. You will now get 6 notes. The last note is not necessarily related to the 
others because it is random. Here is an example: 
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• In the characteristics dialog box of Melody 1, check the Repeat melody option 0 times (ad infinitum). 
Click OK and generate the score again. Groups of 6 notes similar to the preceding group will be 
sequenced in the 4 measures to give a random sequence of which here is an example: 

Do not hesitate to read this lesson several times because it introduces essential concepts concerning the 
composition library. A good understanding of these concepts is needed so that you can use this musical 
construction system to the maximum of its possibilities.

Composition libraries (5)
• Creation of a rhythm folder 
• Creation of a theme folder 
• Creation of a chord progression 
• Arranging a melody on chords 

Creation of a rhythm folder

We continue the exploration of the libraries elements. Similarly to melodies, we will create folders to 
contain rhythms, themes and chords. The properties of these folders are similar to the melody folders 
options.

The idea is to be able to create an object which may contain several rhythmic cells which could be used 
orderly, backwards or in a random way. The options of the rhythmic folder modify the behavior of all 
included rhythmic cells.

• Open the Ex065.piz document. Here is the contents of the main view: 

Melody 1 is a random melody similar to the one we built in the last lesson. The 3 rhythms each contain the 
equivalence of one quarter note. The first is a quarter note, the second is made of 2 eighth notes and the third 
contains one eighth note and two 16th notes. We will create a rhythmic folder and place these 3 elements in 
it.

• In the Edit menu, select the New element… then New rhythm… item. In the upper part of the dialog 
box, check the Combination of rhythmic cells option. Name it R1. Click OK. The following element 
is added in the main view: 

In the previous lesson, we had dragged the melodies into the folder and they automatically disappeared from 
the main view. It is sometimes useful to avoid encumbering the view when many elements are present. If 
you wish to use an element several times, for example to drag it into several folders, it is possible to keep it 
present in the main view. Therefore you need to drag the element into the folder without holding down the 
Control key. Drag the 3 rhythms one by one (quarter note, eight note and 8'+2x16') into the R1 file. The 3 
rhythms stay visible. Double-click the R1 icon. The folder opens and displays its contents:
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Let us consider the options of a rhythmic folder. Close the folder and open its characteristics dialog box 
(double-click with the Control key). The options Multiply and Divide act as for the rhythmic cells. They 
possibly combine with the multiply/divide factors located in the elements placed in the folder.

In the case of an ordered or inverted sequence, all elements may be repeated several times using the Repeat 
result X times option. Zero is used to repeat ad infinitum.

The Limit total duration to X quarter notes option can be used to limit a random sequence to a multiple 
duration of a quarter note, an eighth note, an half note…

Close this dialog box by clicking OK.

Open Score 1 and drag R1 and Melody 1 in the first measure. The score becomes (not necessarily with the 
same note pitches, because the melody is random):

By using notes of the melody, Pizzicato picked the three rhythms placed in the R1 folder one after the other.

• Similarly, create a new rhythmic folder called R2. Take the Inverted order option. Click OK. Drag 
the 3 rhythms into R2 one by one. 

• In the Edit menu, select the Measure attributes item. Modify it to see the libraries and click OK. 
Measure 1 contains R1 and Melody 1: 

• Now drag R2 into measure 1. You will notice that R1 is now replaced by R2. The rule is that in same 
measure, there can only be one element of the same type (R, M, C or T). By placing a second element 
of the same type, the first is replaced by the new one. R2 thus replaced R1. Select the option to see 
the notes again. At the rhythmic level, the score looks like this: 

The rhythms were used in the inverted order, as required.

• Create another rhythmic folder named R3. Select the Random option. Check the Limit total duration 
to option and fill in "3" quarter notes. Click OK and drag the 3 rhythms one by one into this new 
folder (you must not necessarily keep these 3 elements in the main view, because we will not need 
them any more). Drag R3 into measure 1. The score becomes for example: 

Calculate the score several times (Edit menu, Generate score item). You will get each time a different result. 
It is a 3 beats random sequence, and each beat may be a quarter note, 2 eighth notes or an eighth note + two 
16th notes. The note pitches continue to follow the rules of the Melody 1 folder. Each random note is then 
combined with the random rhythmic value, which gives a result even more varied, considering the number 
of possible combinations.
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• We will now sequence R1, R2 and R3 in a random way. Create a rhythmic folder with the random 
option and name it R123. Click OK and drag R1, R2 and R3 in R123. Drag R123 into measure 1. The 
score becomes a random sequence of R1, R2 and R3 and here are two possible examples: 

• By modifying the options of R123, we influence the behavior of all folder elements. With the Control 
key, double-click to call the dialog box of the R123 icon characteristics. Fill in the Multiply durations 
by option with number "2". Click OK and generate the score. Here is an example illustrating the type 
of scores you may get: 

All durations of the rhythmic values were doubled.

• By holding down the SHIFT key, double-click on R123. As for a melody folder, you get a dialog box 
used to modify the order of the folder elements and to assign priorities (0 to 15) which are used to 
influence the chance when the random option is checked. Click OK. Close this document without 
saving the changes. 

Creation of a theme folder

The idea is to create an object which may contain several themes which could be used orderly, backwards or 
in a random way.

• Open the Ex066.piz document. Here is what it contains: 

They are 5 different themes each one containing 3 beats. Open them one by one to see what they contain, 
then close them.

• Create a new theme. Select the Theme combination - random and name it T12345. Click OK and drag 
the 5 themes T1, T2, T3, T4 and T5 in T12345. Open Score 1 and drag T12345 into measure 1. The 
score will contain a random succession of five themes each with 3 beats. Here is an example: 

The theme is a direct association of notes and rhythmic values. When using the random options, it lets you 
define an indissociable link between notes and rhythmic values. Conversely, if you define a theme by a 
melody and a rhythm, when several melodies and intricate rhythms exist, the rhythm/melody combination 
will be done randomly. All depends on the result you want to get. Sometimes it is simpler to define a theme, 
for example for percussion sequences where the same note is repeated with several different rhythmic 
values.

• Open the characteristics of T12345 dialog box. The effect of the various options acts now on all 
folder elements. You can multiply and/or divide the rhythmic values, repeat several times the 
sequence (0 to repeat it ad infinitum), limit the duration of the theme and select not to transpose 
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and/or not to arrange the theme when it is combined with chords. The theme combination can be 
ordered, inverted or in random sequence. The More options... button gives access to the same dialog 
box as in the case of the melody folder. Select the Divide duration option by "2". Click OK and 
generate the score. All durations of the rhythmic values are twice faster. Here is an example: 

Close the document without saving the changes.

Creation of a chord progression

In most music styles you find a succession of chords. A chord is a group of notes played simultaneously. It 
forms the base on which the various instruments "agree" to play (notice that in French, the words "Agree" 
and "Chords" have the same translation). At each moment of the score, when a chord is present, it 
coordinates the instruments. It is a significant point which contributes to the coherence of the whole sound 
result of a score. In most music styles, only one chord is present at one. They can very quickly be sequenced 
one after the other. One often calls this series of chords a chord progression. We will sometimes use this 
term to refer to a chord folder.

• Open the Ex067.piz document. Here is the contents of the main view: 

You find 7 chords in it. Open some of them to visualize them. The Quarter note icon represents a rhythmic 
value of one quarter note repeated ad infinitum. We will create several chords progressions of 2 chords.

• Create a new chord. In the upper part, select Chords progression - ordered. Name this element C-F. 
Click OK. Drag the CMaj icon into C-F. Do the same with the F Maj icon. You have now a 
progression of two chords: C and F major. 

• Similarly, create a progression of ordered chords named B-E and drag in it the B and E icons. 

• Create a progression of ordered chords named A-D and drag in it the A and D icons. 

• Finaly, create a progression of ordered chords named G-C and drag in it the GMaj and CMaj icons. 
You must now have the following elements on the screen : 

We will now create a chords progression with these 4 progressions randomly sequenced.

• Create a random chords progression named A1. Place the 4 other progressions in it. Open Score 1 and 
place A1 and Quarter note in measure 1. The score gives you a random series of 2 chords groups. 
Each chord was associated with a quarter note. Here is an example of the scores that you will get: 

Two by two, you obtain chords sequences among the 4 defined. Let us see now how to define a random 
series of chords among the 7 chords defined.
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• Create a progression of random chords named A2. Place the 7 chords in it. Place A2 in measure 1. 
The score gives you a random series of chords. Here is an example: 

The difference with the preceding example is that the random selection is now done among the 7 chords and 
no more among the 4 groups of 2 chords. It is by exploiting the creation of various groups and 
random/ordered options that one manages to create chords progressions directed towards a specific music or 
harmonization style.

Music being the art of organizing sounds, it is obvious that a purely random sequence of some notes, chords 
or rhythms will not make an art work, because the random term precisely means that it is not organized! By 
composing with libraries and by using the random options, the purpose is to channel the chance to organize 
it according to your own taste so as to make an art work of it. In other words, Pizzicato provides you raw 
material and it is you, the composer, who organizes this material to form something which expresses your 
art. For a sculptor, the raw material is found in nature in a state of disorder and it is the sculptor who 
executes his art by organizing this raw material.

Close this document without saving the changes.

Arranging a melody on chords

We will now see how to use a chord progression in relation to a melody.

• Open the Ex068.piz document. Here is its contents: 

Melody 1 is a random melody and R1 a random rhythm. Half note is a rhythmic value of one half note 
repeated ad infinitum. Then, on the right you have 5 different chords found in the C major scale.

• Create a progression of ordered chords and name it A1. Drag in it in the correct order the icons MajC, 
MajF, MinA, MinD, MajG and MajC. Nothing indeed prevents you from dragging two or more times 
the same chord - here MajG - in the same folder (also valid for the other types of folders). We now 
have a succession of 6 chords on which we will work. 

• Open Score 1 and drag A1 and Half note into the second staff, first measure. You get: 

Each chord is associated to one half note. The chords are followed in the order they were dragged in the 
folder.

• In the dialog box of the Melody 1 characteristics, check the Do not transpose box. Then drag Melody 
1 and R1 into the first staff, first measure. The score displays a random melody: 
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Notice that there is not yet a link between the melody and the chords. The link is made only when the chords 
and the melody are in the same measure. For the moment, by viewing the libraries, you have:

The two staves are developed independently one of the other.

• Drag A1 into the first staff, first measure. By going back to the visualization of notes, you get 
something like this: 

There are only 6 chords in the progression. As the rhythmic values are faster than the half notes of the 
second staff, the 6 chords were used much more quickly (one by rhythmic value), and thus not at the same 
time as the second staff. From the 7th rhythmic value, Pizzicato continued to use the last chord, i.e. Major C. 
The two staves are thus not in synchronization with each other. We need a means to synchronize the 
progression of chords for all staves, otherwise it will be impossible to create a musical work of several 
staves.

We will associate a duration to the chords located in the A1 file. Open the dialog box of the A1 
characteristics. Select the Durations associated in multiples of half notes option. Click OK and generate the 
score several times. You will obtain scores as this one:

Each chord now has a two beat duration, for both staves, because it is the same progression used in both. The 
notes of the melody were arranged and use only notes of the current chord.

• By holding down the SHIFT key, double-click the A1 icon. The following dialog box appears: 
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As for the other types of folders, you can modify the order of the elements and assign to them priorities (0 to 
15) to influence the chance when a random option is selected. Below the priority box, there is a text box 
named Duration. The unit of the chord duration is here the half note, as previously set. The number present 
in the Duration box shows the number of half notes during which the chord will be played, for each chord of 
the list. By default, these values are all set to "1". If a chord lasts for example a whole note in a 4 beats 
measure, fill in "2" in the text box associated with this chord. It will then be used for a duration of 2 half 
notes.

When you create a piece of music with a chords progression, you need to specify at the beginning the 
maximum rate chords will be able to change. If some chords are used only for a duration of an eighth note, it 
is the eighth note which must be selected as the duration unit. Specify it in the dialog box of the chords 
progression characteristics. Then, in the above dialog box, specify for each chord the number of eighth notes 
during which a chord will last.

Composition libraries(6)
• Erasing, duplicating and moving elements 
• Library options 
• Libraries in the sequencer view 
• Copying libraries between two documents 
• Summary - example of libraries 
• Conclusions 

Erasing, duplicating and moving elements

In this lesson, we will complete our knowledge of the composition libraries with various tips and advices 
used to handle the libraries.

• Open the Ex069.piz document. To erase an element (rhythm, melody, theme, chord or folder), place 
the mouse cursor arrow on the icon of the element and use the erase key. Erase the Maj C element 
and a dialog box appears to ask for confirmation. Click Yes. The Maj C element disappears. 

When this dialog box appears, it means that the element is not used in a folder. By answering Yes, you erase 
this element of the document permanently. If this element is included within a folder in the document, it 
would disappear without confirmation, because it is always possible to recover it in the folder where it is 
used, as we will see a little further. The confirmation is a safety, in order not to erase an important element.

• When you erase a folder, the elements in it are automatically put back in the main view, providing 
that they are not used elsewhere. Erase the Melody 1 icon and confirm by clicking Yes. This icon 

363



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

disappears, but the 3 folders that were inside it appear again in the main view. They were extracted 
from the folder. 

What you need to understand is that an element placed in several files remains in fact one single element. 
The copies you make by dragging it into various folders are references to the original. When you modify one 
of them, the original is modified and consequently all its references are also modified. When you erase this 
element somewhere and that it is also located in other files, it is simply a reference which is erased, the 
original remaining present as long as other references exist. It is only when you erase the last reference to 
this element that the original is erased and in this case, Pizzicato asks you a confirmation.

It can be useful to duplicate an element so that it becomes independent of its original. For example when you 
create a library containing several complex but slightly different elements. You create one of them, then you 
duplicate and modify it without changing the first. Here is the method to duplicate an element. First of all, 
this element must be located in the main view. We will for example duplicate the F Maj icon.

• While holding down the SHIFT key and the Control key, drag MajF towards a free location of the 
main view. A rectangle follows your movement. When you release, you get a second element bearing 
the same name. 

Nothing indeed prevents from having two elements bearing the same name. You can then modify the 
duplicate, change its name and its contents without affecting the original. From this moment, the duplicate 
behaves in its turn as an original and can be placed in several folders. A remark is important regarding the 
duplication a folder. Only the folder duplicate will be independent of its original. If the copied folder 
contains for example 3 elements, these elements will remain references to the original elements. In other 
words, if you modify an element located in the copied folder, the modification will also apply to the element 
located inside the original folder and vice versa.

• Open the main palette and select the  tool. It is the library tool. Its shortcut is the lower case letter 
"L (l)". With it, you can move and erase library elements directly inside measures in the score view. 
Close this Ex069.piz document (without saving) and open it again in order to recover its original 
contents. Open the score view and select the option allowing to visualize the libraries in the 
measures. Drag Melody 1 and R1 into measure 1. You should now see measures like this: 

• By holding down the control key, move the Melody 1 element by taking it directly in staff 1, measure 
1 and drag it downwards until it is in the second staff, first measure: 

• Release it. It is moved from the starting measure to the destination measure: 

• When you do the same operation without holding down the control key, the element is copied to the 
destination measure while remaining present in the starting measure. Drag Melody 1 from measure 1 
(staff 2) into measure 2 (staff 2). You get: 
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• To erase an element in a measure, place the mouse cursor arrow on the element of the measure and 
use the erase key. Erase for example Melody 1 from measure 2 (staff 2). It disappears from the 
measure. 

Notice that the library tool is also available via the arrow tool.

• Open the Melody 1 folder. Its contents displays 3 other folders which are not in the main view. By 
holding down the control key, drag the 1 note folder towards a free main view location and release it. 
This is the way to extract an element from a folder. Without the control key, drag the 2 notes element 
out of the folder towards the main view. It is placed in it but remains present in the folder. As we 
have already seen several times, the control key is used to drag an element without keeping it in the 
source element. 

• Double-click the 3 notes elements inside the folder to open it. You can thus open and modify 
elements inside a folder. Double-click on the D-F element located in the 3 notes folder. The score 
view lets you modify or simply visualize its contents. Close this view. 

• You can also erase elements located in a folder. Place the mouse cursor arrow on the C-E element 
and use the erase key. Pizzicato asks you to confirm, because this element is not used elsewhere and 
it is thus the last reference to it. Click Yes. It disappears from the folder. 

Since Pizzicato 3.1, when right-clicking (Alt-click on Mac) on a library item in the main view, a contextual 
menu gives you access to the various windows already described and to the removal of the item. By right-
clicking in the main view background, another menu lets you add an item or a score.

Library options 

In the Options menu , select the Libraries... item. The following dialog box appears:

• The first option so that you can place a chord progression in the first staff of the score and use it for 
all other staves. As it is usually the case, all instruments of a score use the same chord progression. 
This option, not checked by default, is used to centralize the chord progression. Moreover, as soon as 
you place a chord element in staff 1, all measures of other staves are automatically generated to take 
the changes into account. 

• The second option generates the results of libraries in musical notation. By default this option is 
checked. Each time you generate the score, Pizzicato calculates the contents of the libraries and 
transforms them into musical notation in the measures of the score. This step of musical transcription 
is what takes the most time in calculation. If musical notation is not necessary for you, you can 
simply uncheck this option. The result of libraries will be placed in the tracks of the sequencer and 
you will be able to listen to them and visualize them in the piano roll or sequencer view. You will 
save calculation time. You can for example remove this option during your tests, if only the sound 
result counts. Then, if you wish, you activate this option again and calculate the score again to see the 
result in musical notation. 
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• The last option, checked by default, calculates automatically the contents of measures when you 
place a new element in a measure. It avoids you each time selecting the Generate score menu. 
Moreover, only the concerned staves are computed. It can be useful to disable this option when you 
work on a rather big document. If you wish for example to use libraries to create an orchestra score 
with 25 instruments and 120 measures, it is sure that the calculation of the full score could take a 
rather long time. To build the score, you will perhaps have to drag 50 or 100 library elements into the 
score, which would imply that with each addition Pizzicato would start again a part of the 
calculation. In this case, you can initially disable the automatic calculation, place all the elements in 
the score and then select the Generate score menu to do the calculation only once. 

Notice that before selecting the Generate score menu, you can make a selection of measures and staves with 
the selection tool. In this case, only the selected measures and staves will be recomputed.

• Click OK. 

Libraries in the sequencer view

• Close the score view, the library elements and the main view (without saving). Open the Ex069.piz  
document again. Open the sequencer view. Click twice on the horizontal zoom (H+ button) and once 
on the vertical zoom (V+ button). The measures appear now as follows: 

• Drag successively Melody 1 and R1 into measure 1 of the first track. The measures become for 
example: 

The result of calculation is displayed in a graphic form. Notice that to get this result, you may disable the 
option transcribing in musical notation. It helps you to save time.

• In the Options menu, select the Sequencer item. In the dialog box, check the Library view choice in 
the Display type area. Click OK. The sequencer view is now displayed like this: 

The operations we did in the score (erase, drag or drag with the control key) may also be done in the 
sequencer view.

Copying libraries between two documents

Just as it is possible to do with a score, you can drag a library elements from one document to another. This 
lets you use the libraries located in the documents of the Libraries directory, available when you open a 
document.
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• Close the sequencer view. While leaving this document opened, create a new document (File menu , 
New item). Open the main view and close the score. Move the two main views to organize your 
screen as follows: 

Notice that you can open up to 10 documents simultaneously.

• Drag the CMaj icon towards the main view of the other document. It is automatically copied in it. In 
the case of a copy between different documents, it is an independent copy. If you modify the original 
after, this modification will not affect the copy and vice versa. 

• Drag the Melody 1 icon into the other document. In the case of a folder copy between different 
documents, all the elements contained in the folder are also copied so as to avoid dependence 
relations with the original document. 

Notice that you cannot directly drag an element of the first document into a measure of the second 
document. It is always necessary to go through the main view of the destination document. First drag the 
element into the main view of the second document, then drag this copy into the measure of the second 
document. In other words, only the elements of the document main view can be used in a musical score of 
this document.

• Now drag R1 into the second document and close the first document without saving the changes. The 
following elements are visible in the main view of the document: 

• Open score 1 and drag Melody 1 and R1 into the first measure. 

You took elements of a document and used them in another. This process is the basic idea of the 
composition libraries, even if this example is a little too simple. You have basic libraries provided with 
Pizzicato. You create yourself your own libraries in a thousand different manners. Progressively while 
working, the contents of your composition libraries increase. Moreover, these libraries are marked by your 
composition style and allow you to reinforce the coherence of your work. Simply by dragging some 
elements, as we did here, you can access complex structures of libraries (representing hours or whole days of 
work) which you developed before. You can for example prepare accompaniment structures for the main 
families of orchestra as well as standard diagrams of orchestral effects, overall chords under various families 
of instruments. After that, each time you want to place a chord or an effect using for example 20 different 
instruments at the same time, you will just have to open the library, drag the element and possibly change the 
chord. In other words, you spend 15 seconds to complete a work of copy which would easily need ten 
minutes. Pizzicato helps you to do the tiresome and noncreative work.

Moreover, this method lets you test many possibilities very quickly. If you hesitate about the position of the 
chord in your orchestra score and you have for example a library with 10 different positions, you just need to 
drag them one after the other and directly listen to the sound effect with the synthesizer. In a few minutes 
you hear the 10 possible choices and you can make your choice. If you would have to modify the score each 
time to test the 10 cases, you would perhaps spend one hour or you would simply reject this work and 
choose a position without listening to the others. By using the composition libraries, this kind of work 
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becomes easily possible and allows you to compose more quickly by leaving tiresome and unpleasing work 
to Pizzicato.

Close this document now, without saving the changes.

Summary - example of libraries

Here is an example showing how to create a complete arrangement with several instruments. It is a bossa-
nova music style.

• Open the Ex070.piz document. The main view displays the following elements: 

• Open the Bossa Nova score. It consists of 6 staves: a soloist instrument, a piano, a bass and 3 
percussion instruments: 

The library elements comprise:

• a chord progression with the chords of a well-known bossa-nova, "Desafinado", 
• a folder containing 3 different themes for the bass, 
• a folder containing 3 rhythms for the piano, 
• three themes for the percussion instruments, 
• a random melody and a random rhythm for the soloist. 

Examine the contents of each one in order to understand the basic materials of our Bossa Nova.

• Place the library elements as follows, possibly by asking the visualization of the libraries in the 
measures: 
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• Select again the notes visualization. Here is an example of what you will get (as several options are 
random, it will not be exactly the same): 

• Listen to the result. It will sound correctly only if you have a synthesizer or a polyphonic and 
multitimbral sound card compatible with the GM (General Midi) standard system. 

We have placed the chords progression in the first staff and it influences the full score. For the percussion 
themes, the options Do not transpose and Do not arrange are checked to prevent the chords of staff 1 to 
modify them.

The piano plays a random rhythmic taken among 3 different rhythmics and based on the staff 1 chords. The 
bass plays a random theme taken among a series of 3. The notes are arranged and transposed according to 
the staff 1 chords. The soloist instrument plays a random melody which is arranged on the chords 
progression.

By opening the dialog box of the Progression icon with the SHIFT key, you will be able to see the chord list 
and the duration associated with each one of them.

A last significant remark. If you do not place chords in the libraries, Pizzicato will not arrange the themes 
and melodies. But if the Chord progression window contains chords, Pizzicato will use them to arrange the 
melodies and themes. In some way, it could be easier to write or modify a chord progression with this 
special window.

Conclusions

These 6 lessons review the theoretical characteristics of the library composition system. All essential 
information are in them. To exploit all possible combinations of this system to your advantage, there is 
nevertheless something missing which is not acquired by the reading of a manual: the practice of it.
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A good understanding of the theory exposed in these 6 lessons is necessary. Then you will have to make 
your own tests and experiments so as to start thinking in terms of musical libraries. This manual contains 
some lessons about the use of the musical libraries. They show you how to exploit the provided original 
libraries, using examples and practical exercises. They give you an approach of composition which allows 
the beginner to make his first steps in musical creation. The professional composer will find in them a 
progressive way allowing him to gradually acquire the practice of the musical libraries. 

We highly advise you to study and make the exercises of these lessons. Whether a beginner or a professional 
of composition, you will end up being able to think with the libraries and they will then become a very 
powerful tool for your composition work.

When you have more practice of the library use, we advise you to read these 6 lessons again. Areas of 
shades will probably be cleared up on concepts which perhaps seemed too theoretical or too abstract to you 
at first reading.

Editing a synthesizer
• Access to synthesizers configurations 

Access to synthesizers configurations

A set of configurations, each one representing a synthesizer of the market, is provided with Pizzicato. It can 
be useful to personalize a synthesizer, for example if you modify the sound setup in it. If your synthesizer is 
not in the provided original list, you can create a new configuration and introduce in it all parameters and 
characteristics of your synthesizer. 

You can reach it by opening the Select synthesizer dialog box.

• In the Options menu, select the Synthesizer... item to get the dialog box: 

As we have already studied, this dialog box allows you to select the synthesizer associated with a Midi port. 
The first four buttons are used to modify and complete the list. We will make a copy of the Sc-55 synthesizer 
in order to be able to make modifications in this lesson.

• Select the Sc-55 line in the list, by going down with the scroll bar, because the contents of the list 
contains nearly 95 synthesizers. Then click in the Copy synthesizer... button. The following dialog 
box appears: 
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A synthesizer has a full name and a short name. Fill in for example Test in the two text boxes and click 
Create. Pizzicato copies Sc-55 and calls it Test. The configuration dialog box appears :

The dialog box is divided into 4 distinct areas which we will study by order of importance.

• The first purpose of a synthesizer is to be able to produce sounds. From one brand or a model to 
another, the manufacturers provide large varieties of different sounds. Each sound has a name and a 
number used to identify it and to select it on the front device panel. When you work with a computer, 
the software helps you to directly select a sound using a menu. Pizzicato can select sounds of your 
synthesizer via messages sent to it via the MIDI cable. All this is also valid for the sound cards found 
in a PC. 

By using the instruments view, the user has two menus to select a sound. The first selects the family of the 
instrument (for example Strings) and the second allows to select one of the sounds belonging to the selected 
family (for example Cello).

The middle list contains the families of instruments defined for this particular synthesizer. By selecting a 
family of this list (by simply clicking on its name), the instruments defined in it appear in the list next to the 
right. In order to understand how to modify these lists, we will create a new family and add an instrument in 
it.

• Click on the New button located below the list of families. You get: 

A new line is added at the end of the list. The text box located just below lets you fill in the name of the new 
family. Type Test family on the keyboard. As you type it in, the text appears in the list. In Pizzicato, each 
family has an identification number, shown here by a number (24) called ID (Identifier). When you create a 
family, Pizzicato automatically assigns the next available number. You can modify it by using the text box 
which contains it. If you create a synthesizer from scratch, we advise you to keep families and identifiers 
used by other synthesizers, so as to ensure a compatibility with future versions of Pizzicato.

• The instruments list of this new family is now empty. To add an instrument, click on the New button 
located below the instruments list, at the bottom of the dialog box. You get: 
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• Type Test instrument on the keyboard, it is the instrument name. The elements located below the list 
represent the characteristics used by Pizzicato to select it on your synthesizer. 

The main sounds available on a synthesizer are represented by a number from 1 to 128 (or sometimes from 0 
to 127 according to the manufacturer). You should find the list with the correspondence between names and 
numbers in the synthesizer manual. This number must be placed in the text box entitled "N°". By creating an 
instrument, this number is set at 1 by default.

At the beginning of the MIDI system, 128 different sounds largely met the needs of synthesizers. With the 
evolution of the technical power, the current synthesizers always offer more sounds and the limit of 128 
different sounds is almost always exceeded. The Midi message directly selecting a sound only accesses 128 
different sounds. To go beyond this limit of 128, manufacturers use various additional messages allowing to 
divide the sounds into various Sound banks. Specific Midi messages (sometimes peculiar to each 
manufacturer) select a sound bank. One can thereafter select a sound in this bank by sending a number from 
1 to 128. The sound bank to which the instrument belongs may be selected in the menu labeled Bk. 
Combined with the number (N°), Pizzicato can use this information to select the sound chosen by the user.

The 16 boxes located below show the possibility of using this sound on the 16 Midi channels of the 
synthesizer. When Pizzicato automatically allots the Midi channels, these boxes specifies to it which 
channels can used for this sound. The Midi channel 10 is often allocated to the percussions sets. By defining 
an instrument which is not a percussions set, uncheck channel 10. If you define an instrument corresponding 
to a percussions set, check channel 10 and disable all others, so that it will force Pizzicato to use channel 10 
when the user selects a percussion set.

So as to be able to convert a score written for different synthesizers, an identifier is associated with each 
sound. It is shown in the text box entitled ID. "0" means that the conversion must not be done. IDs from 1 to 
128 correspond to the standard GM (General Midi) sounds. When Pizzicato loads a score written for a 
synthesizer and different from your current selected synthesizer, it automatically converts the numbers of the 
sounds so that they correspond to the same instruments. This operation is done only if the identifiers are 
present in the configurations of the concerned synthesizers. If you want to use this aspect, you just need to 
associate each instrument to an ID corresponding to the number of the equivalent instrument in the GM 
system.

By following the method described above, you can thus add families. To add an instrument, select the family 
and then add it in the next list.

To erase an instrument, click to select it and then click the Delete button located under the instruments list. 
The instrument disappears from the list.

Similarly, to erase a family, select it on the list of families and click the Delete button located under this list. 
The family is erased and the instruments in it are not visible any more. They are not erased thought, because 
if you recreate a family with the same identifier as the erased family, the instruments will come back there 
when you select this family on the list.

372



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________
The left list is used to define the Midi controllers to which the synthesizer can answer. The selection 
principle is the same as for families and instruments. By clicking on a line, the associated characteristics are 
displayed in the text boxes located below the list.

• Click the New button located under the controllers list. You get: 

Midi controllers are messages which can be received by the synthesizer and modify various aspects of 
sound. There are 128 possible controllers but only the significance of a small number of them is really 
determined. To find a full list of them, please consult a specialized book. Also consult the configurations of 
synthesizers provided with Pizzicato.

A section of a synthesizer manual usually shows which Midi controllers it can answer. It is the Midi 
Implementation Chart which is often at the end of the manual. With it we have encoded the provided 
configurations. For example, we will add the sound reverberation controller which bears number 91.

• Fill in the title of the controller on the keyboard: Reverberation. Replace the number right below by 
91 in the text box. The following area, entitled Values indicates if it is a continuous type of controller 
(128 possible values) or an active/inactive type (2 possible values, as for example a pedal connected 
to the keyboard which can either be pressed or released). The reverberation level can be modified 
between 0 and 127. Specify 128 in it. The following text box is the default value. Fill in a value of 40 
which will thus be the reverberation level initially chosen. 

To erase a Midi controller, select its line and click the Delete button located under the controllers list.

In the left lower part of the dialog box, you find the full name, the short name and the manufacturer. Four 
buttons give you access to 4 different dialog boxes: Miscellaneous, Percussions, Messages and Banks.

• Click on Miscellaneous. The following dialog box appears: 

The text box entitled Multitimbral up to… parts specifies the number of different sounds the 
synthesizer can generate simultaneously.

The Polyphonic up to ... voices specifies the maximum number of notes which can be played 
simultaneously, all sounds together.
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A multiple choice specifies if the classification of sounds is expressed from 1 to 128 (Roland, 
Yamaha, Korg) or from 0 to 127 (Proteus for example). The numbers introduced by creating the 
instruments must correspond to the choice selected here.

The central part of the dialog box contains 6 lines of check boxes. For each line, the 16 columns 
correspond to the 16 Midi channels of your synthesizer.

• The fourth line is entitled Input (orig.). It shows the Midi channels from which your 
synthesizer can receive information. Usually, the 16 channels are used, but it depends on 
the synthesizers. The oldest ones sometimes receive only one channel at the same time 
(Dx-7 of Yamaha). The others must then be disabled. 

• The first line (entitled Input) is at first the same as the fourth. You can modify it to 
personalize your Midi configuration. Here is a possible example of use. Let us take the 
case where you connect two synthesizer (A and B for example) on the same Midi output 
of your MIDI interface. At the origin, A and B can both receive 16 Midi channels. As it is 
the same Midi cable, if you send notes on channel 1, both synthesizers will play them, 
which is not necessarily what you want. The solution consists in disabling channels 1 to 8 
on B and channels 9 to 16 on A. For that, consult the manual of your synthesizer, because 
it changes from one model to another. Then, you must tell Pizzicato that it can only use 
channels 1 to 8 for synthesizer A. In the first line of the above dialog box, disable 
channels 9 to 16. Similarly, in the configuration dialog box of synthesizer B, disable 
boxes 1 to 8 of the first line. When you select an instrument belonging to A, Pizzicato 
will only use the first 8 channels and there will be no more possible confusions. 

• Line 5 relates to the Midi output of the synthesizer. The active boxes are the channels 
which can emit in Midi. 

• Line 2 is the same one and can be modified by the user. 

• The same principle is applicable for lines 6 and 3, which specify if the synthesizer sends 
each Midi channel in echo via its Thru output. Lines 2,3,5 and 6 are not used by the 
current version of Pizzicato and are planned for possible future extensions. 

The lower part of the dialog box determines the metronome characteristics and the Midi channel 
can be selected. The notes and their velocity can be specified by text boxes, as well for the start 
of a measure as for beats which divide the measure. Note 60 corresponds to the treble clef low C. 
Click OK.

• Click on the Percussions button. The following dialog box appears: 

This dialog box is used to define percussion sets contained in the synthesizer. Most synthesizers 
propose one or more sonorities representing for each note of the keyboard a percussion 
instrument. It is also the case for some special effects like laughs, steps, rain, applause… Midi 
channel 10 is often reserved for these percussion configurations. When several are present, it is 
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necessary to send a program change message (1 to 128, as for the instruments) which selects the 
desired configuration.

The instruments representing these percussions must be encoded as others and must be classified 
exclusively in the Percussions - Kits family (ID = 21).

For each configuration, the detail of each keyboard note should be located in the synthesizer 
manual and can be entered using the above dialog box.

Click Add. You get:

A new line is added below the selected line. Type for example Bongo-1 on the keyboard. It is the 
name of the instrument. Three text boxes are associated to this instrument. The first gives the 
number of the note which activates it on the keyboard. Its value can be between 0 and 127, 60 
corresponding to the treble clef low C. This value is normally specified in the percussion 
instruments list of your synthesizer manual. The number located below is the number of the 
percussion configuration. It corresponds to the number (from 0 to 127) used to select this 
configuration in Midi. The following number is an identifier which is used by Pizzicato to do an 
automatic conversion of percussions when you load a score composed with a synthesizer 
different from your current selected one. "0" means that no conversion is done. The numbers 
from 1 to 128 correspond to the GM configuration. When you create a percussion instrument, 
associate with it the number of the equivalent GM note and add "1" to it.

To erase a percussion instrument, select it on the list and click Delete.

Click OK.

• Click on the Messages button. The following dialog box appears: 

It is used to define special messages (also called exclusive messages) which can be sent to the 
synthesizer. The use of the exclusive Midi messages requires a very good understanding of your 
synthesizer, of the Midi system and hexadecimal notation (counting system which uses figures 0 
to 9 and letters from A to F). Some information which follows is thus intended to the specialists, 
because the complete explanations would leave the framework of this course. If you wish to look 
further into these aspects, consult a specialized book on MIDI. The use of the exclusive Midi 
messages gives you access to all internal features of your synthesizer.

375



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

To create a new message, click Add and give it a name. You have 24 bytes maximum to structure 
the message. They must be specified by two hexadecimal digits. Some codes are used to 
parameterize the message. When you send one of these messages, the parameters are then 
replaced by the values given with the message (there can be 4 parameters, see the instruments 
view and its column "ms"). Here are the codes you can use:

• - P: this code replaces a parameter of a value between 0 and 15 (0-F). When the 
parameter is replaced, it is placed in the least significant bits of the Midi byte. The 
resulting value in fact is added with the preceding byte to form a byte of the Midi 
message. 

• P: it is the same but when the parameter is replaced, it is placed in the most significant 
bits of the Midi byte. The resulting value in fact is added with the preceding byte to form 
a byte of the Midi message. 

• PP: this code places the value of a parameter in the Midi message. It can take the values 
from 00 to FF. 

• CS: this code calculates the Check Sum for the Roland exclusive messages. 

• - C: this code places the MIDI channel number (0-F) in the least significant bits of the 
preceding byte. The Midi channel is the one set by the instruments view. 

• C: this code places the MIDI channel number (0-F) in the most significant bits of the 
preceding byte. The Midi channel is the one set by the instruments view. 

To consult or modify a message, click it in the list. Its contents is then displayed in the 24 text 
boxes. To erase it, use Delete button.

• Click OK to close this dialog box. Click now in Banks... button. The following dialog box appears: 

It allows you to create/delete/modify sound banks. Each bank defined in the list contains a name, 
an identifier and 24 bytes (to the maximum) used to define the Midi message associated with the 
sound bank. The principle is similar to the preceding dialog box. The bytes must be defined in 
hexadecimal and the following codes is used to insert Midi channel in the message:

• - M inserts the Midi channel in the least significant bits. 
• M inserts the Midi channel in the most significant bits. 

When Pizzicato needs to select a sound bank, it sends this message on the Midi channel 
associated with the concerned staff. This message depends on your synthesizer and it is normally 
found in the Midi characteristics of its manual.

• Click OK to go back to the main dialog box of a synthesizer. Click once again OK. The list now 
displays the name of a new synthesizer called Test: 
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If you wish to consult or modify another synthesizer, select it in the list and click Synthesizer setup… You 
will get the same dialog box as above. If you wish to look further into this aspect of Pizzicato, we suggest 
you consulting several different synthesizers in order to see how they were encoded.

The button Create a synthesizer… initializes a new synthesizer in which all lists of instruments, families, 
percussions,... are empty. If you wish to encode new synthesizers, we advise you to start with the synthesizer 
called Modele-1 in the list and to click Copy synthesizer by giving it a new name. Modele-1 contains already 
the main standard Midi controllers as well as the families with their identifiers.

• To erase a synthesizer, select it in the list and click Delete synthesizer… Pizzicato asks confirmation 
and it disappears from the list. Select synthesizer Test and delete it. 

• Click Cancel selection in order to keep the synthesizer which was installed before this lesson. You go 
back to the dialog box of synthesizer selection on Midi ports. Notice that 4 buttons located to the 
right of each line gives a direct access to the configuration of the synthesizer. Click OK. 

Configuring the instruments view
• Why modifying the instruments view? 
• The instruments view configuration dialog box 

Why modifying the instruments view?

In this lesson, we will learn how to personalize the aspect of the instruments view. We had seen that it has 
several aspects that one can reach via his configurations menu. 

The objective here is to be able to establish a new configuration which will be added to the others and which 
will cuts your preference in your work with Pizzicato. Perhaps the way in which we presented this window 
will not be optimal for you, because as soon as one starts to know a software, one works according to his 
own practices.

Perhaps a user would like to have a display which shows at the same time the name, the synthesizer , the 
instruments family, the instrument and the sound volume, the whole in a unique display. The continuation of 
this lesson explains you how to execute that.

The instruments view configuration dialog box

• Start Pizzicato and open the instruments view. In the Options menu, select the Instruments… item. 
The following dialog box appears: 
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The left list shows the names of the existing configurations. According to the Pizzicato version you have, 
there may be others than the one visible here above. The first is selected. To the right, you have the list of the 
elements contained in the selected configuration, in the order where they appear. To see the contents of 
another configuration, click on its name in the left list and the contents appears in other list.

• Select the first line and click the Add button located right under the first list. You get: 

A new configuration appears after the selected one. The text box below the list is used to give it a name. 
Replace the three dashes with My configuration. The right list is empty because this new configuration does 
not yet any element to display.

• Click the Add button located under the right list. An element is added to it: 

It is a Short name , i.e. it lets you see or modify the short name of a staff. It is usually the first element in a 
configuration, used to locate the staves.

• We would like to have the name of the synthesizer associated with the staff. Click a second time the 
Add button under the second. An identical element is added to it. To the right, a menu is entitled Item 
type. It is used to select one of the items to display in the instruments view. Click on this menu and 
select the Synthesizer item. 

• The menu below is entitled Displayed by. It is used to select the type of graphic area used to visualize 
the selected item: slider, text box, menu, switch box or colour. According to the item, one or more 
choices will be possible. The synthesizer, for example, can be visualized only by a menu. If you 
select another choice, it will automatically return to Menu. 
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• We want to have two columns representing the family and the instrument. Click Add and select the 
Instruments family item. Click again Add and select the Instrument item. These two elements can be 
represented only by menus. 

• To finish this personal configuration, we would like to have a volume slider. Click Add and select the 
Midi controller item. The volume is a Midi controller who bears number 7 (see the lesson about the 
Midi system). The text box named Parameter is used for this precise case. Fill in number "7" in it. 
Select a Slider display. 

The controllers can also be visualized with a text box or a menu.

Our configuration is ready. Click OK. In the instruments view, click on the top left icon and select the My 
configuration item which was added in it. You can then contemplate the configuration just created:

• Go back to the Instruments item in the Options menu. Click on My configuration. You have two 
buttons named Up and Down. They are used to modify the elements of the list. By selecting a line of 
this list and by clicking for example on Down, this line goes one down position and the element 
which occupied this location goes up. To place the slider right next to the short name, click the last 
line of the list (Midi controller) and press 3 times on Up. Click OK and the instruments view 
becomes: 

• Open again the Instruments item in the Options menu. Select My configuration. By clicking on the 
Delete button located under the second list, you erase the item selected in the list. To erase a 
configuration, select it in the left list and click the Delete button located under this list. The whole 
configuration disappears. 

Erase My configuration in order to return to the situation you had before this lesson. Click OK to confirm the 
operation.

You are now able create your instruments view displays. Observe your working method and create one or 
more personal configurations which contain an effective setup of these elements.
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Editing graphic and Midi symbols (1)
• Graphic and Midi symbols 
• Tools palettes 
• Creating a new palette 
• Importing the tools created with a previous version of Pizzicato 

Graphic and Midi symbols

In this lesson and the following, we approach one of the most advanced aspects of Pizzicato: the 
modification and the creation of graphic and Midi symbols by the user himself. Let us start by reminding the 
general philosophy of graphic and Midi symbols.

In musical notation, there is a whole series of graphic symbols that can be placed on the score. They are used 
to specify how notes must be played. They can influence the force with which they are played, the speed of a 
score and other aspects. When the performer reads the score, he or she sees these symbols and modifies his 
(her) performance according to them.

In the Tools menu, you have a great choice of symbols which you can place on the score. If Pizzicato would 
be limited to display and print a score, the graphic aspect would be sufficient. But Pizzicato can also take the 
control of your synthesizer or sound card and play the score. It is thus needed to describe the significance of 
each symbol so that the resulting sound effect can be produced when the score is played.

The score plays on your synthesizer through the Midi system. When Pizzicato finds a symbol in the score, it 
needs a Midi description of the sound effect to create. The symbols located in the tools palettes may thus 
contain Midi information, therefore we use the graphic and MIDI symbol expression.

Because of the new possibilities offered by the modern synthesizers (reverberation, incorporated sound 
effects…), new types of symbols allow to produce these effects. Some symbols could not be performed by 
the musician, as for example a symbol which increases the reverberation or modifies the sound panoramic.

Let us notice that you can create a symbol which is only graphic and which does not influence the 
performance. Conversely, you can create a symbol which is graphically invisible on the score but which 
produces a sound effect in Midi.

You will find most of the current symbols in the original tool palettes, as well as a large variety of symbols 
to control the synthesizer sound effects.

Most of the users will find in the current symbols all they need to create their scores with sound effects. 
They can largely exploit and in multiple manners the provided original symbols.

The most creative and adventurous users will however find limits to these symbols. They will want to be 
able to create new symbols or to modify the existing ones so that they are better suited to their creativity. 
The system explained in this lesson and the following will help them to create the most various symbols, as 
well on the graphic level of the score as in the Midi universe.

Tools palettes

• Start Pizzicato and open the Main Palette. Notice first that a palette can be resized. Its original form 
is the following: 
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If you move the right bottom corner of this window, Pizzicato progressively adjusts the shape of the palette. 
By dragging this corner to the top and to the right, you will be able to get respectively:

  

You can adjust them to make your screen more user-friendly. The shape of the palette is memorized with its 
position when you close it. When you open the palette again, it keeps its position and form.

• With the right mouse button (Option-click on Mac), click on one of the tools. A menu appears: 

The upper part is addressed to the palette while the lower part relates to the tool you clicked. Select the 
Palette properties item. The following dialog box appears:

The palette title can be modified. This title appears in the title bar of the window, but also in the Tools menu.

Just below, a popup menu select the tool size of this palette. Eight standard sizes are provided. Click OK.

The choice Delete this palette… is used to erase this palette completely. A dialog box asks you to confirm . 
Do not erase this palette, because it contains the main working tools. If you do a wrong operation on 
palettes, just reinstall the program and the original palettes will be restored.

The tools contained in the Main palettes and the Notes and rests contain the Pizzicato working tools. The 
graphic and MIDI symbols are in the following pallets.

• Open the Main symbols palette. This palette has larger boxes. It contains the most common symbols 
found in a score. With the right mouse button, click one of this palette tools. The following menu 
appears: 

An additional menu is present in the graphic and Midi symbols: Edit tool… It is with it that you can modify 
and create new symbols and determine all their characteristics. The basic tools of Pizzicato (notes, rests, 
keys, measure tools…) have a fixed behavior in Pizzicato and do not contain this menu item.

Creating a new palette

The Tools menu contains all the original palettes provided with Pizzicato. You can create new palettes to add 
at the end of this menu. For this lesson and the following, we will create a new palette to illustrate what you 
can do with these palettes and tools.
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• In the Tools menu, select the New palette item. A small empty palette appears: 

• With the right mouse button, click this palette and select the Palette properties... item. The following 
dialog box appears: 

• Modify its name to Test palette and click OK. 

Consult the Tools menu and you will see that this pallet has been added at the end of the list. It does not 
contain any tool yet, although its size is ready for one tool.

You can move and duplicate tools from one palette to another. This lets you create a personal palette 
grouping the tools you use the most. To do that, hold down the CTRL key (Control) and click for example 
on the arrow tool from the main palette and drag it towards the palette you just created. When you release 
this tool on the new palette, the following dialog box appears:

Three actions are possible:

• Move tool: allows you to insert the tool in another palette. The tool is put in the new palette but it 
disappears from the original palette. 

• Duplicate tool: in this case, the tool is copied in the new palette while remaining available in the 
original palette. In the case of a graphic symbol, the tool is really duplicated. You can then modify 
the new symbol without modifying the original one. Remember this difference. When you wish to 
modify a symbol of the original library, (for example to create a Forte symbol a little more loudly 
than the original), we advise you to duplicate the tool and to modify the duplicate in order not to 
modify the original. Modifying an original symbol implies that all documents previously created with 
Pizzicato will be affected if they use this symbol. Respecting the original symbols establish a 
standard format for a future version of Pizzicato, which will enable the exchange of documents and 
create libraries of compatible Pizzicato documents. 

• Delete tool: you can erase a tool. In this case, the tool disappears from the original palette and it is 
lost. 

Click on the second choice. The new pallet is now displayed as follows:

• Similarly, respectively drag the following tools, from the main palette to the new palette (while 
holding down the CTRL key): 

   
• Then, drag the following tools, from the symbols palette to the new palette: 
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The new palette looks like this now:

The exact order of the tools depends on the location where you dragged the tools into the palette. When you 
drag a new tool, it replaces the one on which you put it and shifts the other. The positioning order of the 
tools in the palette is done as follows:

• The first tool is the one located at the top left position 
• The following is the one located just below 
• When there is no more place below, one starts again a new column just to the right 

Modify the shape of the pallet to obtain for example:

If you wish to modify the order of the tools in a palette, take a tool and drag it to its new position. Take for 
example the  tool and drag it to the top left corner. In the dialog box which appears, keep the Move tool  
option. You get:

The other tools were shifted according to the rules stated above.

We can now create and remove palettes, move/delete and duplicate tools. We will see in the next lessons 
how to create and modify graphic tools, as well as all their characteristics (graphics, MIDI aspects, keyboard 
shortcut,…).

Importing the tools created with a previous version of Pizzicato

For the users of a previous Pizzicato version, if you created your personal symbols, you may import them in 
Pizzicato 3. To do this, select the Import tools... item of the Options menu. A file open dialog appears. Go to 
the folder of the old Pizzicato version and open the Misc or DataEN / prefs folder. A file named Tool.def 
appears. Click on it and then click on Open. Then it asks you to open a file named Tool.pal. Pizzicato 
imports the symbols and palettes you had created.

Editing graphic and Midi symbols (2)
• Creating a new tool - Assigning a keyboard shortcut 
• Bitmap graphic editor 

Creating a new tool - Assigning a keyboard shortcut

• Start Pizzicato and select the palette named Test palette in the Tools menu, which we created in the 
previous lesson: 
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• With the right mouse button, click inside the palette and select the New tool… item. The following 
dialog box appears: 

• Name it Symbol 1. 

When you create a new symbol, Pizzicato automatically creates an identifier for it. It is a number used to 
refer to the symbol in the Pizzicato symbol library. The symbols created by the user have a number between 
4000 and 5999. The original provided symbols have a number between 2000 and 2999. The internal tools of 
Pizzicato have a number between 1 and 999.

As we explained when we studied the various tools, a shortcut can be used to activate a tool or a symbol on a 
palette. It is here that these shortcuts can be defined. Each tool or symbol may contain one or two shortcuts. 
The two text boxes entitled Shortcut 1 and Shortcut 2 are used to specify the ASCII code (it is a common 
language for the coding of characters) of the computer keyboard key. Here is a table of the codes with the 
corresponding characters you can use in these text boxes:

32 Space 48 0 64 @ 80 P 96 ' 112 p
33 ! 49 1 65 A 81 Q 97 a 113 q
34 " 50 2 66 B 82 R 98 b 114 r
35 # 51 3 67 C 83 S 99 c 115 s
36 $ 52 4 68 D 84 T 100 d 116 t
37 % 53 5 69 E 85 U 101 e 117 u
38 & 54 6 70 F 86 V 102 f 118 v
39 ' 55 7 71 G 87 W 103 g 119 w
40 ( 56 8 72 H 88 X 104 h 120 x
41 ) 57 9 73 I 89 Y 105 i 121 y
42 * 58 : 74 J 90 Z 106 j 122 z
43 + 59 ; 75 K 91 [ 107 k 123 {
44 , 60 < 76 L 92 \ 108 l 124 |
45 - 61 = 77 M 93 ] 109 m 125 }
46 . 62 > 78 N 94 ^ 110 n 126 ~
47 / 63 ? 79 O 95 _ 111 o   

By placing for example the number "78" in one of the text boxes, your tool will be activated using the capital 
letter N. 

For keyboards with the 12 function keys, the following codes are also valid, according to the key pressed, 
with the Control key, the SHIFT key or both:

Key alone + Control + SHIFT + Control + SHIFT
241 F1 225 F1 209 F1 193 F1
242 F2 226 F2 210 F2 194 F2
243 F3 227 F3 211 F3 195 F3
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244 F4 228 F4 212 F4 196 F4
245 F5 229 F5 213 F5 197 F5
246 F6 230 F6 214 F6 198 F6
247 F7 231 F7 215 F7 199 F7
248 F8 232 F8 216 F8 200 F8
249 F9 233 F9 217 F9 201 F9
250 F10 234 F10 218 F10 202 F10
251 F11 235 F11 219 F11 203 F11
252 F12 236 F12 220 F12 204 F12

By placing the code "215", you need to hold the SHIFT key and to press on the keyboard F7 key to activate 
the shortcut. Take care that the F10 key is not always available (Windows uses it as a system key to access 
menus) and will not necessarily work correctly as a shortcut.

• In the first text box, fill in the code "122", which corresponds to lower case letter "z". It will be the 
shortcut of our Symbol 1. 

The menu located just below is entitled Shortcut working method. It is used to specify how shortcuts will 
influence the tool or the symbol. Four modes are available:

• Disabled: it is the default choice. The shortcuts are disabled and will influence neither the palettes 
nor the score. 

• Activate palette: in this case, the use of the shortcut will activate the tool or the symbol in its palette. 
It is as if the user had clicked to select the tool. 

• Acts without palette activation: the tool or the symbol is not selected on the palette but the shortcut 
acts directly in the score, at the location of the mouse cursor. 

• Act and activate palette: the tool or the symbol is selected on the palette and the shortcut acts directly 
in the score, at the location of the mouse cursor. 

Select the Activate palette item.

The Icon type menu selects or create the drawing that will represent the tool or the symbol on the palette. For 
a graphic symbol, the drawing in the palette is not necessarily the same as the one that will appear on the 
score. In general it is the same but when the score symbol is rather large, it is possible to represent it in a 
simplified form on the palette. This menu selects the drawing which will represent the symbol on the palette. 
Three choices are available:

• Implicit: for a Pizzicato basic tool, the internal icon of Pizzicato is used. For a graphic symbol, this 
choice indicates that the symbol will be represented by the same drawing than on the score. 

• Bitmap: allows to draw the icon dot per dot. 

• Vectorial: allows to draw the icon as a combination of forms, lines and texts. 

Click OK. The palette becomes:

To call this dialog box again, click on the tool (the selected tool in black here above) with the right mouse 
button (Option-click on Mac), then select the Tool properties… item.

With this dialog box, you have access to all shortcuts of the original tools and symbols. You can modify 
them as you want but when you read a lesson, take it into account because the manual is based on the 
standard shortcuts. Take care not to modify the shortcuts of the notes and rests, because they are subject of a 
special treatment in Pizzicato.
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We will create a picture to represent this symbol on the palette. In the Icon type menu, select the Bitmap 
item. Call the graphic editor by clicking in the Edit... button. Let us see now how to use it.

Bitmap graphic editor

The screen displays this window:

 
A bitmap drawing is defined by the colour of each one of its dots, laid out in lines and columns. The 
dimension of the icons in our palette had been fixed at 20 x 40. We thus have a drawing formed by 20 lines 
of 40 dots. The central grid represents this drawing in zoom. The upper part contains two drawing tools and 
16 colours. The selected tool is the cursor (top left corner).

Two colours can be activated among the 16, the drawing colour and the background colour. A double square 
shows the selected colors:

Initially, the drawing colour is black (internal square) and the background colour is white (external square). 
By clicking in one of the 16 colours, you modify the drawing colour and update the internal square to show 
that it is active. By clicking on one of the colours by holding down the SHIFT key, you select the 
background colour.

When you click in one of the grid little squares, Pizzicato colours this square with the drawing colour, but 
only if this square does not contain this colour yet. With black as drawing colour, click on several 
consecutive squares. They become black:

If you click in a square which has already the selected drawing colour, the square is coloured with the 
background and thus becomes white again in our case. You can then easily correct the drawing.

Notice the small line that appears just to the right of the colours palette. It is normal size picture. As the all 
grid was white, it was impossible to see it until now.

If you wish to colour several consecutive squares, it is not necessary to click each time. You can click the 
first square, hold down the mouse button and move the mouse on all the squares you want. It is the same 
principle as a pencil. You press and you drag it. When you want to stop the line, you simply release the 
mouse. Do the following drawing by applying this principle:
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On the right side of the colours, you can observe the drawing in its real size:

Let us notice that when you make a line by clicking and dragging, it is the first clicked square that 
determines the colour used for the full line. If you click on white (or another colour than the drawing colour), 
all the line will be coloured in black (drawing colour). If you click on black (drawing colour), all the line 
will be coloured in white (background colour).

A second tool is used to quickly fill a rectangle in the drawing. Click on the tool:

Click in the red colour, then place the mouse cursor like this:

 
Click and drag to the right and slightly down. A rectangle is coloured by following your movement. Release 
the mouse to have the following rectangle:

Close this window. You can also close it using the return key (on Mac, this window has no closing box, 
use the return key to close it). Click OK and use the ESC key to disable the symbol. The test palette now 
contains our symbol, represented by the drawing we just made:

Moreover, by typing lower case letter "z", this symbol is selected on the palette.

Editing graphic and Midi symbols (3)
• Creation of a symbol for the score 
• The vectorial editor 

Creation of a symbol for the score

In the previous lesson, we reserved a place for a new symbol named Symbol 1. We created its icon using a 
bitmap drawing to represent it in the palette.

The symbol that will appear in the score and bears identifier 4511 does not exist yet, even if an icon displays 
it in the palette. We will create the symbol and define its graphic aspect for the score.
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• Open the Test palette. Double-click our new symbol: 

As it is the first call of this symbol definition, Pizzicato initializes the symbol and gives it the same name we 
had defined in the palette. The dialog box of this symbol definition appears:

You can also reach it by clicking on the tool with the right mouse button and by selecting the Edit tool… 
item

It is now necessary to create a drawing for it so that it can be placed in the score. By default, the type of 
graphic is Vectorial as shown by the Type menu. We will take this opportunity to learn in detail the use of 
the vectorial editor. Vectorial drawings are defined by a set of simple graphic objects (lines, rectangles, 
circles…) combined to form a symbol. Text areas can be added in it with a selection of style, size and font. 
The various objects can be coloured.

Notice that the vectorial editor, just as the bitmap editor, allows to define the picture of a symbol on the 
score (like here) as well as its graphic aspect on the palette (as in the preceding lesson). In both cases, you 
may select the bitmap or vectorial type in the menu.

Click the Create/modify... button.

The vectorial editor

The screen show the vectorial editor:

The vectorial drawing is empty for the moment. Its boundary is delimited by a gray square on the left of the 
empty area. For the example, we will increase a little bit the window and the limits of this symbol. On Mac, 
the window is automatically increased.

On Windows, using the mouse, drag the lower border of the window to get:
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By clicking and dragging the little gray square located inside the bottom right corner of the bigger gray 
square, widen the square to get the following size:

In the upper part of the window, 14 tools are used to create and modify graphic objects. Just besides there is 
a double square representing the drawing and background colours, followed by the 16 colours selection, as 
in the bitmap editor. The cursor tool is selected. Click on the tool next to its right. It is used to add a 
rectangle.

• Place the mouse in the upper left part of the gray rectangle. Click and drag to the right and down, 
then release to have: 

A rectangle is drawn using the drawing colour. Four little black squares are visible at the corners of the 
rectangle. They show that this object is selected. When an object is selected, you can modify its 
characteristics. By clicking and dragging one of the black squares, you can change the rectangle size. By 
clicking on another colour, you can modify its colour.

• Click now on the tool located just to the right of the rectangle tool. It is used to draw circles and 
ellipses. Right to the first object, click and drag to the right and down, to get the following ellipse: 

Once again, the object is surrounded by four little black squares showing that the ellipse is selected. You can 
also change its colour and modify its size.
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• Select the tool next to the right of the ellipse/circle tool. It is used to draw a polygon, i.e. an object 
formed with connected lines. Place the mouse like this: 

• Click and release the button. Apparently nothing happened. Move the mouse to the right and a little 
up. A line appears and connects the original point to the cursor of the mouse and follows your 
movement. Click at the following location: 

• Once again move the mouse to the right and down. The first line is now fixed and another line 
follows your movement starting from the last point. Click at the following place: 

• Continue in the same way to get the following drawing: 

Polygons must always be closed. To finish a polygon, you need to click again on the starting point. At that 
moment, it is complete and the little black squares appear at each corner of the polygon to show that it is 
selected. By clicking and dragging one of these black squares, you move only that point and the two 
connected lines are redrawn. For example, move the point on the right and bring it a little higher and to the 
right:

• Click on the next tool. It is used to draw a single line. Place the cursor like this: 

390



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

• Click and drag to the bottom and to the right, then release: 

When a line is selected, two black squares are drawn at the extremities. You can change its colour and move 
the extremities.

To select an object, first activate the cursor tool by clicking on it or by typing ESC with the keyboard. For a 
rectangle or an ellipse, click inside. For the polygon or the line, click on a corner or an extremity. The object 
is then selected.

Only one object may be selected at a time. When you select another object, the first is automatically 
unselected. Select one by one the four objects of the picture. To unselect an object, click where there is no 
object.

• To erase an object, first select it and then use the erase key on the keyboard. Select the rectangle and 
erase it. 

• Select the line. Click on the  tool. 

The following dialog box appears:

You can modify the thickness of the line, in tenth of a millimeter. Fill in "10" and click OK. The drawing 
becomes:

The line thickness is now fixed at 10 x 0.1 mm, as well as for the new objects you can create. Select the 
ellipse and click the thickness of lines tool. Fill in a value of "20" and click OK. The drawing becomes:
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To move a rectangle or an ellipse, click inside the object and drag it. It follows your movement and by 
releasing it, it is fixed at its new position. Move the ellipse by bringing it to the left to get:

A polygon cannot be moved at once, you need to move each points separately.

To move a line, you must first ensure that it is not selected and then click and drag one of its extremities. 
The full line moves.

If you click an extremity while the line is already selected, only this point will move, the other remaining 
motionless. Move the line to bring it in the upper right corner of the drawing:

• Select successively each object and erase them all. 

Below the tools we used to add a rectangle, an ellipse and a polygon, you will find 3 tools allowing to draw 
these same objects coloured inside with the background colour.

• Click on the red for the drawing colour. Click with the SHIFT key in the yellow colour to specify the 
background. Select the full rectangle  tool. Draw a rectangle as before, to get this: 

The red colour is used for the border, with a thickness of 20 because it is the last selected value in the 
thickness dialog box. The inside of the rectangle is coloured with the background colour. As long as the 
object is selected, you can also modify the background.

• Unselect the object with the ESC key. Select the dark blue for the drawing colour and the light gray 
for the background. Activate the full ellipse tool and draw an ellipse next to the rectangle. 

Unselect the object with the ESC key. Select the purple for the drawing colour and the light green for the 
background. Activate the full polygon tool and draw a polygon to get:

These three objects are placed one besides the other. Now move the rectangle to the right and to the bottom, 
to get:
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A part of the rectangle is hidden by the two other objects. In a vectorial drawing, there is an order which 
determines what object is above or behind. When you add an object, it is automatically placed in front of all 
others. The rectangle was the first to be added, with the result that the two new objects were placed above it. 
The four following tools are used to modify the order of appearance of objects:

To use them, first select the object of which you want to modify the display order and click one of these 
tools. The first (-) puts the object one step behind. The object is exchanged with the object that was just 
behind it. The next one (+) puts the object one step forwards. The tool (- -) place the object behind all the 
others and the tool (+ +) places it in front of all others.

Select the rectangle and click on the (+) tool. The drawing becomes:

The rectangle went from the third position to the second position and is thus in front of the ellipse but still 
hidden by the polygon. By pressing again on the (+) tool, the rectangle goes to the foreground:

If you now click on the (--) tool, it will go again behind the two other objects.

We now need to place a small ellipse inside the red and yellow rectangle. Select the full ellipse tool. If you 
try to directly draw the ellipse in the rectangle, you simply will move the rectangle because you click inside 
an object. It should first be drawn where there is no object and then be dragged inside the rectangle to finally 
get:

• The tool with letter A is used to add a text. Select the black colour, click on this text tool and click 
here: 
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The following dialog box appears:

• Fill in the text This is a strange symbol in the text box. It can only contain one line. Click OK and the 
drawing becomes: 

The text was placed in the drawing. It is selected by 4 black squares. You can modify it by double-clicking 
it. This brings the above dialog box again. By clicking in a colour, you can modify its colour. By clicking 
and dragging this text, you can move it. You can make it go in front or behind with the 4 tools seen above.

When a text is selected, you can modify the size, the style and the font by double-clicking the tool A. Do it 
and select the Times New Roman font, a size of 14 and the Bold style. By clicking OK and selecting the red 
colour, you get:

By using the Pizzicato fonts, you may use the musical symbols contained in it. Each key of the keyboard 
corresponds to a musical symbol. It is necessary to introduce the characters in the text area and they will 
appear in musical form in the drawing. Select a sufficiently large size of character, such as for example 36. 
Here is the equivalence for the main symbols, classified by categories:

• Clefs: 

• Note heads: 
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• Rests: 

• Accidentals: 

• Various: 

Let us place for example a large blue treble clef in our drawing. Click here:

In the text area, type the "&" key and click OK. For the moment it is still the "&" symbol that appears in the 
text. Double-click on tool A. Select the Pizzicato font, in Normal style, with a size of 48. Click OK. Click 
now in the blue colour and the drawing becomes:
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A gray frame surrounds the symbols. It can be resized by clicking and dragging the small gray square 
located in its bottom right corner. This frame shows the area in which the user will be able to move the 
symbol in the score. When you activate the reference marks tool in the score, this frame appears in red 
around the symbol.

You may also notice a little gray square in the top left corner of this frame. This square is in fact the 
superposition of 3 different squares.

• Click and drag this little square to the right: 

• A vertical line follows your movement. Click and drag down the little gray square located in the top 
left corner: 

An horizontal line follows your movement. The intersection between the two lines you dragged represents 
the origin of the symbol. When you click on the score, this origin point will be placed at the location of the 
mouse, where you clicked. When you create a symbol, its origin is placed by default on the top left corner of 
the frame.

There is still a gray square on the top left corner. It is used to increase or decrease the frame size. Click and 
drag it a little to the left and upwards. When releasing, you get:

The left corner was put back at the origin, but the drawing was shifted to the right and downwards. The 
result is thus a larger frame. You can use this to modify the location of the frame top left corner in relation to 
the drawing.
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• Close this window using its closing box or the return key (on Mac, this window has no closing box, 
use the return key to close it). Click OK in the dialog box. In the score view, click in the middle of 
the measure. Your symbol being selected on the palette, it appears on the score: 

The symbol created in this example is obviously rather special, but it nevertheless shows how to use the 
vectorial editor tools in order to create any symbol.

By examining the symbols of the provided library of Pizzicato, you can understand how they were built. 
They are constructed either by a bitmap drawing, a vectorial drawing or by a curve (we will see that in the 
following lesson).

Editing graphic and Midi symbols (4)
• Creation of a curve 
• The graphic side of symbols 
• Examples of symbols 

Creation of a curve

Start Pizzicato and open the Test Palette. Double-click on our original symbol. We will transform this 
symbol into a curve. In the Type menu, select the Curve item. Click in the Create/Modify button. The curve 
editor appears:

 
The curve contains 3 points marked by 3 small black squares. Click and drag for example the middle one. 
The two extreme points remain motionless and the curve follows your movement:

Release it and the curve is stabilized.

• Bring the right side point a little closer and move the middle point to get: 
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The shape of this curve will be visible on the score when you add the symbol. Then you will be able to adapt 
it in the score. The modifications will remain local and will not influence the original symbol.

The intersection of the two red lines indicates the origin of the curve. It simulates the location where you 
click in the score to place the symbol. In the above example, the location clicked in the score will correspond 
to the left point of the curve.

Close this window with its closing box or the Enter (Return) key (on Mac, this window has no closing box, 
use the return key to close it).

The graphic side of symbols

Pizzicato displays the symbol definition dialog box :

The central part is separated in two areas. The left part treats the horizontal positioning of the symbol and the 
right part the vertical positioning. Let us start with the horizontal part.

• The Mode menu selects the horizontal positioning mode of the symbol. 

The default choice is Proportional to measure. When you click on the score to add the symbol, it 
sticks to the measure. By widening the measure, the symbol will move proportionally.

If you take the Relative to measure choice, the symbol will be fixed in relation to the top left 
corner of the measure. By widening the measure, the symbol will not move in relation to this 
corner.

Finally the third choice is Relative to a note. In this case, by clicking on a note or a rest, the 
horizontal position of the symbol is fixed in relation to this note or rest and it will move with it. 
If this option is selected and if you add the symbol in the measure without clicking on a note, it 
will be associated to the measure.

• The following text box is entitled Position and has a value of "0" by default. By placing a value 
different than zero, you can shift the horizontal position of the symbol when you add it on the score. 
By placing for example "10", when you click on the score, the symbol will be placed 10 pixels to the 
right of the location where you clicked. A negative number would correspond to a shift to the left. 
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• If you want the symbol to be horizontally moveable on the score, the Moveable box located just to 
the right must be checked. An accent placed on a note for example may be fixed horizontally, in 
relation to the note, by unchecking this option. 

• The next text box is used to place an horizontal oblique shift, in percentage. The effect of this shift 
moves the lower border of its frame of X % distance in relation to its horizontal size. Here is for 
example the effect of 25 % horizontal oblique shift on a rectangle drawn with the polygon tool: 

Only lines and polygons are really distorted by an oblique shift. The other objects are simply 
resized to hold within the new frame.

• If you check the Variable box, the user will be able to modify this shift as explained in the lesson on 
the positioning of symbols. 

• The last text box is entitled Scale. By default, it is fixed at 100 %, which adds the symbol on the 
score with horizontal dimension exactly as the original drawing. By placing a different value, you can 
increase or decrease the horizontal scale of the symbol. For example, you can draw a symbol twice 
larger in the vectorial editor (so that the drawing is easier and more precise) and decrease it on a 50 
% scale for the score. 

• The menu located right besides is fixed by default. The user will not be able to modify the scale. If 
you select the Proportional item, he will be able to widen or narrow this symbol horizontally. The 
Multiple choice is used to multiply the symbol in the horizontal direction. If you place for example a 
symbol as this one in the vectorial editor or bitmap: 

and if you activate the Multiple choice, the user will be able to stretch this symbol horizontally 
and will get the following symbol:

• The right side of the dialog box contains the same options for the vertical position of the symbol. 
Only the positioning mode is different. 

The default vertical mode is Relative to measure. The position is based on the measure and 
moves with it. By selecting Relative to a note, the symbol will move vertically with the note. The 
last choice is Relative to a stem. This associates the symbol position with the end of the note 
stem on which you clicked to add the symbol. If you lengthen the stem, the symbol will move to 
keep the same position in relation to the stem.

• Three check boxes are located in the upper left part of the dialog. 

The first is entitled Outside measure. By checking this box, it becomes impossible to 
superimpose the symbol inside the 5 lines of the staff. By clicking to add the symbol, it is 
automatically shifted upwards or downwards so that the symbol frame remains outside of the 
measure.

The following box is called Only between lines. By checking it, Pizzicato shifts the vertical 
position of the symbol so that its origin always corresponds with the middle of a space between 
lines of the measure. This is useful for example for the dot is placed above or below a note. If 
this box was not checked for this symbol, the dot could appear on the line of a staff, which would 
make it much less visible.
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The third box is called Dependent of stems direction. Normally, when you reverse the direction 
of the note stem with which a symbol is associated, the symbol does not move and thus remains 
fixed in relation to the head of the note. By checking this box, the symbol will automatically 
follow and swap up/down with the inversion of the stem.

• Next to the identifier of the symbol, a menu displays Unique. It means that this symbol is not related 
to the definition of another symbol. This menu contains two other choices, Stem up and Stem down. If 
the first is activated, this symbol is only valid when the stem of the associated note is directed 
upwards. The symbol must be associated with a second symbol which is only valid when the stem is 
directed downwards. The text box just below specifies the identifier of the associated symbol. 

This system is used to create symbols that are different according to the stem direction, for 
example the dot placed above or below a note. The second symbol should not necessarily be 
placed in a palette. To create this second symbol, you need to set an identifier not yet in use in 
the Associated Symbol text box. If you just created the symbol, simply add "1" to the identifier of 
the symbol.

In our example, select Stem up and place the identifier +1 (here thus 4512) in the text box right 
below. Click OK. To reach the definition of the associated symbol, double-click on the original 
symbol (in the palette) by holding down the control key. A copy of the symbol is created and you 
get the definition dialog box of the symmetrical symbol. Notice that the menu shows Stem down, 
the symbol carries identifier 4512 and is associated to the identifier 4511. These two symbols are 
now independent on the definition level. Modifying the drawing of one will not modify the other.

When you add one of these symbols on a note, Pizzicato automatically selects the one which 
corresponds to the stem direction and when you reverse this direction, the symbols are swapped.

• A check box entitled MIDI Play activates a sound effect via the Midi system. We will study it in the 
next lesson. 

• Just below there is a menu labeled Chord. The default choice is Upper note. The other possible 
choice is Lower note. When you add the symbol on an chord, this menu shows to which note of the 
chord the symbol will be associated. 

• In the lower part of the dialog, a box labeled Invisible Symbol makes the symbol invisible on the 
score. This is for example useful when you simply want to create a sound effect or to fix a volume, 
without displaying this symbol on the printed score. 

• Another check box specifies if the symbol must influence the measure justification of notes and rests. 
If it is checked, Pizzicato will reserve an horizontal space for this symbol when placed in front of or 
behind a note. 

• The check box labeled Include in extracted parts determines if the symbol must be copied on all 
extracted parts when you extract parts from the orchestra score. It is for example the case of the 
tempo symbols that are placed on the first staff of the orchestra score, but which will be found in 
each separate part also. 

Examples of symbols

In order to illustrate the theory, we will now examine some symbols of the Pizzicato library. By closing the 
dialog boxes, take care to click on Cancel, in order not to modify one of the original symbols.

• If not done yet, close the symbol definition dialog box. Open the Main Symbols palette and double-
click on the symbol: 

It is formed by a vectorial drawing. If you edit the drawing, you will see that it consists of 2 text areas 
containing an "m" and a "f" in the Pizzicato font. The option Outside of measure is checked, because this 
symbol is always placed outside of a measure. Horizontally, it can be attached to a note. A position of -15 

400



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________
places it on the left of the clicked note and it is moveable, i.e. the user can move it with the mouse. 
Vertically, it is fixed compared to measure. If you move a note vertically, the symbol will not move. Click 
Cancel.

• Double-click on the symbol: 

Its vectorial drawing is formed by two oblique lines. Here, the vertical oblique shift is variable, letting the 
user to incline the symbol to get the following examples:

The horizontal and vertical scales are proportional, so as to increase or decrease this symbol in both 
directions, to get the following examples:

• Click Cancel and open the following symbol: 

The horizontal and vertical positions of this symbol are fixed in relation to a note. The symbol is not 
moveable, Pizzicato places it automatically at the specified location, in relation to the note.

The symbol is placed only between the lines of the staff (or between the imaginary additional lines) in such a 
way that it is not hidden by a line. The stem direction influences its positioning. A symbol is associated to it 
for the opposite direction of the stem.

• Click Cancel and open the following symbol: 

Its vertical scale is multiplicative and has a default value of 300 %. The user can thus stretch or narrow the 
height of this symbol.

• Click Cancel. Open the Graphic symbols palette and double click on the following symbol: 

Its vectorial drawing consists of three lines and a text area with number "1" and a dot. Its position is fixed in 
relation to the measure. Its horizontal scale is proportional. Pizzicato always places it outside the measure.

This terminates the review of the graphic side of symbols. Have fun to create some original symbols and to 
add them in the score. Also consult the other symbols of the Pizzicato library. Some of them will give you 
ideas on the possible uses of symbols creation.

Editing graphic and Midi symbols (5)
• Midi effects on the score performance 
• Examples of Midi effects 

Midi effects on the score performance

We now approach the other side of symbols. One or more Midi effects may be associated with a symbol so 
as to produce a sound effect when Pizzicato find this symbol in the score.

• Start Pizzicato and open our Test palette. Double-click on the created symbol. Activate the MIDI 
Play option and click the Define play… button. You get the play effect definition dialog box: 
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This dialog box defines how the symbol will influence the score performance.

• The first menu is entitled Type of effect. It is used to specify the sound effect produced by the symbol. 
By opening this menu, you get the following choices: 

• The Tempo influences the speed with which the score is played. A symbol will be able to 
modify the tempo at a given time of the score. 

• The Velocity represents the force with which notes are played on the keyboard. A symbol 
can modify this force, for example to accentuate a note. 

• By selecting the MIDI Controller item, you can directly influence some parameters of 
your synthesizer, like the sound volume, the reverberation, the panoramic… at least if 
your synthesizer answers to these messages. To select the controller number to use 
(between 0 and 127), fill it in the text box labeled Parameter. 

• The Instrument-patch item changes the instrument playing. The symbol sends an 
instrument number to the synthesizer. 

• Poly / Mono After touch are used to simulate an effect executed with some musical 
keyboards. After a key is pressed, it is possible to press or release the pressure of this key 
to produce a sound effect. Such a symbol placed on the score can thus simulate this 
pressure on the key. The poly is a total pressure which affects all notes while the mono 
only affects the pressed key. 

• The Pitch Bend simulates the adjustment lever often present beside the musical keyboard. 
It influences the pitch of the sound in a continuous way. A symbol can thus simulate this 
effect on the score. 

• The Transposition can be modified by a symbol. Notes are shifted up or down. 
• The Note duration and the Start of notes can be influenced by a symbol. 
• The Note sequence in a symbol adds new notes in the measure. It is used for example to 

create trills. 
• The Midi data can be used to transmit any Midi message. 

Keep the Tempo choice for the type of effect.

• The choice entitled Change is used to select between Unique and Multiple. It specifies the duration in 
which the effect will be active. 

By selecting Unique, the change is instantaneously done. In this case, the single value must be 
specified in the text box entitled Value. By placing for example "120" with the Tempo effect, 
when Pizzicato finds this symbol in the score, it will at once modify the tempo to 120. By 
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placing "100" for a reverberation controller, the level of reverberation will be set to 100 when the 
symbol is played.

By selecting Multiple, the change can be done over a specific duration. This duration can be 
specified by a multiple choice labeled Duration and with 3 text boxes. By selecting a Fixed 
duration, you can specify this duration in the text boxes as a number of measures, beats (quarter 
note) and beat units (480 units = 1 quarter note). In this case the duration of the effect is very 
precise. By selecting Proportional to graphic, the duration of the effect is calculated 
proportionally to the graphic width of the symbol in relation to the measure. Thus a symbol 
which extends itself on half the measure width would last half of the measure duration. This 
method is less precise than the fixed duration.

Fill in the duration so that it last one measure.

• In the Multiple case, one value is not enough to specify the full effect. You need to specify how the 
effect value will progress within its duration. Click on the multiple choice and then on the 
Progression/content button. The progression dialog box appears: 

The horizontal axis is graduated between 0 and 100 % and represents the total duration of the 
effect as it was previously specified. The vertical axis is graduated from -100 to 100 units of 
tempo. The vertical scale depends in fact on the type of effect.

Close this dialog box (on Mac, this window has no closing box, use the return key to close it). 
Notice that the Relative values box is checked. It means that the value shown will be added to the 
value already present in the score. This is why the graph above goes from -100 to +100, in order 
to either decrease or increase the tempo. The effect of this box is also valid for a Unique value. 
Thus, if you place a unique value of -20 and if you place this symbol on the score, Pizzicato will 
slow down by 20 units of tempo. If the tempo was playing 100 quarter notes per minute, it will 
thus slow down to 80 quarter notes per minute. The effect relates thus to the value existing 
before the symbol. The principle is the same for the other effects like volume, etc.

• Now disable the Relative values check box and click on the Progression/content button again. The 
dialog box becomes: 
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The vertical axis displays the possible values of the tempo between 40 and 240. In this case, 
Pizzicato will not take into account the preceding value of the tempo and will use the values 
specified here.

The red line specifies the value of the tempo throughout its progression. The value of the tempo 
is represented by a small black square that you can move. Click and drag this value upwards to 
bring it to 60:

To get more precision, you can zoom to increase the window size. The red line follows the value.

• The progression may consist of several points connected by lines. Locate the mouse cursor in the 
middle of the graph and double-click. A new point is created and the progression becomes: 

The added point may also be moved by clicking and dragging it with the mouse. Add another 
point to get:
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When Pizzicato finds this symbol in the score, it first sets the tempo to 60 and accelerates up to 
157. It then slows down to get to the tempo of 108 and keeps this tempo from there on. The time 
during which this progression occurs depends on the duration specified in the first dialog box.

To erase a point of the progression, click on this point while holding down the control key. Erase 
the second point and close this window.

• In the lower part of the dialog box you will find the Local change option. By checking this box, the 
modifications produced by the symbol will only have a local effect. The preceding value of the effect 
will automatically be set back as soon as the progression is finished. In our example, if the tempo was 
100 before this symbol, it will be set back to 100 as soon as the progression is finished. 

• In the upper part of the dialog box you will find a menu labeled Start. It is used to determine the 
precise moment when the progression or the unique effect will be triggered. 

The first choice, Position in measure, fixes the start of the effect proportionally to the graphic 
position of the symbol in the measure. This positioning mode is rather inaccurate because the 
graphic distribution is not always proportional to the time distribution in a measure.

The following choice, Attached note, is very precise when the symbol is associated with a note 
or a rest. The start of the effect occurs exactly when the note is played.

The third choice, Start of measure, fixes the start of the effect exactly at the beginning of the 
measure.

The choice depends on the precision to which the effect must be played as well as on the 
importance of a synchronization with a note.

• The upper right part of the dialog box contains the following elements: 

You can cumulate up to 5 independent Midi effects, activated by the same symbol. The numbers 
"1 / 5" show that it is the first effect that is presented in this dialog box. Check the Other effect  
box now and click the Select... button. The text area now displays "2 / 5" and the other elements 
of the dialog box take their default values again. This dialog box displays the second effect that 
you can specify. It can be of a different type and may have durations and starts different from the 
first effect.

To add a third effect, check the Other effect box again and click on the Select... button. The text 
displays "3 / 5" and the dialog box may be used to introduce the values of the third effect. You 
can continue like this to cumulate 5 effects.
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Once an effect is defined, you can return to the previous by clicking OK. The number decreases 
for example from 3/5 to 2/5 and the values of effect 2 are displayed in the dialog box. By 
clicking again OK, you come back to 1/5. Clicking once more would close the dialog box.

• In the menu labeled Type of effect, select the Midi data item. This type of effect does not contain any 
duration, value or progression. By clicking on the Progression/content button, you get a dialog box to 
specify its contents: 

The text box is used to introduce Midi data which will be transmitted to the synthesizer. This 
kind of action is addressed to the Midi specialists. The data must be introduced in hexadecimal 
form and separated by a comma or a line break. Here is an example:

9A, 5F, 40, 8A, 5F, 40
Click OK to confirm the data and close the dialog box.

• Another effect requires some explanations. Select the Note sequence item in the type of effect menu. 
Click then on the Progression/content button. Here is the dialog box which appears to specify a 
sequence of notes: 

The upper part defines one or more notes. This aspect is rather difficult to understand, be ready! 
Each note is defined by 4 parameters: Start, Duration, Pitch and Velocity. The string "1/1" shows 
that the displayed parameters are those of note number 1 and that there is a total of one note.

Two buttons are used to add a new note or to erase the current note. Two other buttons let you 
visualize the next note or the previous note.

When Pizzicato plays the score, a note sequence will be played to replace the note to which the 
symbol is attached.

By default, the pitches and velocities define the notes relative to the note to which the symbol is 
attached. The option can be disabled for the pitches or the velocities thanks to the check boxes 
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located in the lower part of the dialog box. When relative, a pitch of "0" means the same pitch 
than the associated note, +2 means 2 half tones higher and -2 means 2 half tones lower than the 
reference note.

The pitches can be extracted from a chord, if the symbol is associated with a chord in the score. 
To achieve that, check the Chord notes box. This feature is used to create chords played in 
arpeggios.

The start of the first note relates to the associated note. The other starts of the notes always relate 
to the beginning of the previous note. They are expressed in units of 480th of a quarter note.

The durations are expressed in the same units. When a duration is negative, it means that it 
relates to the duration of the reference note.

In the lower part, four text boxes give additional indications on the way in which these notes will 
be played.

The first box specifies Unrepeated notes. It is the number of notes that will be played only once.

The second box specifies Repeated notes. The number specified here is the total of the notes that 
will be repeated, the third box specifying the number of repetitions to do. If the sequence has 5 
notes and that you set 2, 2 and 10 in these 3 text boxes, it means that the first two notes will be 
played once, the two next notes will be repeated 10 times and that the last note will be played 
once to finish the sequence. By placing "0" as the number of repetition, Pizzicato will repeat the 
notes so as to fill the full duration of the associated note. This system is used to create trills and 
rolls of various kind.

The fourth box modifies the time scale. 100 % corresponds to the values indicated in the start 
and duration boxes for each note. By increasing this percentage, you multiply its durations, so as 
to loosen or tighten a trill. This parameter can be modified locally, so as to adapt a trill in each 
particular case.

Examples of Midi effects

After the theoretical side, we will consult several examples of the original symbols library, by focusing the 
attention on the most significant points.

• Close the dialog box by clicking OK and click twice on Cancel. Open the Main Symbols palette. 
Double-click on the symbol: 

and click the Define play... button. This symbol acts on the velocity, i.e. on the hitting force of 
notes. The effect is produced on the exact start of the note associated with the symbol. Its value 
is unique and it sets the velocity to 96. The relative option is not checked, it is thus the real 
velocity value. The local option is not checked, the velocity of 96 is thus valid from this moment 
up to the next change. Click twice on Cancel.

• Double-click the symbol: 

and click on Define play... button. The effect used is also the velocity. It starts when the 
associated note is played. It is a multiple change which extends over the symbol length. Click on 
Progression/content. The following progression defines the evolution of the effect over its 
overall duration:

407



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

It gradually adds 30 units of velocity to the value present at this point in the score, because the 
Relative values option is checked. The Local change option being disabled, the velocity value 
will be increased by 30 units throughout the symbol and will keep the same value up to the next 
change. Close this dialog box and click twice on Cancel.

• Double-click the symbol: 

and click on Define play... button. This symbol affects the notes duration. The effect is taken into 
account at the beginning of the note and lasts 10 units (i.e. sufficiently to include the note start). 
The duration of the note is fixed at 50 % of its normal value. As the effect is only local, the notes 
that follow will not be affected. Click twice on Cancel.

• Double-click the symbol: 

and click the Define play button... It affects the transposition by adding +12 half tones to the 
current value (the Relative values option is checked). This transposition remains valid from then 
because the change is not local. The effect is taken into account when the note is played. Click 
twice Cancel.

• Double-click the symbol: 

and click the Define play... button. It locally affects the duration of notes by setting durations to 
100 %. It occurs for a duration proportional to its graphic width in the measure, starting from the 
associated note. Click twice Cancel.

• Open the Other symbols palette and double-click the symbol: 

and click the Define play... button. It simulates the piano pedal. It is the Midi controller 64 which 
allows to command this effect on a synthesizer. This number (64) is thus specified as the 
parameter of the controller. The duration is proportional to its graphic width. It is multiple, the 
progression goes to +127 (pressed pedal) at the beginning and goes down to 0 (released pedal) 
just at the end. Click twice Cancel.

• Open the Ornamentations palette and double-click the symbol: 

Then click the Define play... button. The effect uses a sequence of notes. Click 
Progression/content. Two notes are defined (use the buttons Previous and Next to reach them):
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The pitches and the velocities are relative to the associated note. The first note starts at the 
beginning of the effect and lasts 60 units (= 32nd note). As its pitch is -1, this note is located one 
half tone lower than the associated note. The following note begins 60 units after the start of the 
first (it thus starts when the first notes stops). Its pitch is 0, i.e. the pitch of the associated note. 
Its duration is negative, which means that it is the duration of the original note minus 60 units.

In the lower part of the dialog box, the first area specifies that the 2 notes are played only once 
(not repeated). The global effect of this symbol is thus to replace the associated note by a short 
note one half tone lower followed by a note which lasts the rest of the original duration with the 
original pitch. Click three times on Cancel.

• Double-click the symbol: 

and click on the Define play... button. Click Progression/content. It is another example using the 
sequence of notes, this time with a repetition. Two notes are defined:

Each note has the duration of a 32nd note. The first is one half tone higher than the associated 
note. There are no unrepeated notes and the 2 notes are repeated. As the number of the 
repetitions is 0, Pizzicato will repeat these notes to fill the duration of the original associated 
note. The produced effect is thus a trill between the original note and the note located one half 
tone higher. The time scale is 100 % per default and can be modified locally. Click three times 
Cancel.

• In the Main Symbols palette, double-click the symbol: 

and click the Define play... button. Click Progression/content. The Chord notes option is 
checked. 10 notes are defined with decreasing durations and starts shifted by 30 units (64th 
note). This case constitutes an exception which is used only for this particular symbol. The 
pitches of notes are taken on the notes of the chord with which this symbol must be associated. 
This chord can contain a maximum of 10 notes. If less notes are available, the values defined in 
excess in this dialog box are without effect.

The effect of this symbol is to play the notes of the chord in arpeggio, by shifting the notes 
successively and by reducing their durations proportionally so that they stop at the same time. In 
this precise case, the starts of notes are given in relation to the associated chord and the duration 
of a note is equal to the duration of the chord minus the start of the note. Click three times 
Cancel.
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We advise you to consult other symbols, until the moment you can easily understand how they are defined. 
Do not hesitate to read again the lessons about the edition of symbols. Also use these symbols in simple 
measures in order to hear the result produced with the synthesizer. This aspect of Pizzicato is used to 
considerably enrich the performance of a score played by the computer. It requires a good theoretical and 
practical understanding of these lessons. By reading them several times and by making your own 
experiments, you will master them.

To erase the Test palette created for these lessons, open this palette and with the right mouse button, click 
inside it. Select the Delete this palette…item. Click Yes to validate.

Modifying a symbol locally
• Local modifications 
• Examples of local modifications 

Local modifications

When you use a symbol in the score, it will often be useful to slightly modify the associated sound effect. By 
placing for example a mezzo forte (MF), it is useful to influence it according to the sound used on your 
synthesizer.

Many symbols require the possibility to modify their value without affecting the original symbol (as for 
example the exact moment where the effect starts, the duration of a crescendo or an accelerando, the value of 
a volume…).

Pizzicato automatically associates local parameters for each instance of a symbol in the score. You can 
modify these parameters via the local parameters dialog box.

• Start Pizzicato, open the score view and the Main Symbols palette. Select the following symbol: 

and add it on the score to get:

• By holding down the control key, click on the symbol in the score. The following dialog box appears: 

This dialog box is used to modify the value of the velocity associated with this instance of the 
symbol. The library symbol is not affected. A similar dialog box appears according to the type of 
MIDI effect (tempo, transposition…)

• Click the Full editor... button. The local parameters dialog box appears: 
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This dialog box contains all local parameters that can be modified. In 99 % of the cases, the 
simplified dialog box is sufficient. This full dialog box groups a series of parameters from the 
symbol definition dialog boxes. Most parameters only concern the Midi effects. By opening it 
the first time on a symbol, it contains the original values which define the Midi performance. 
You can then modify these values to moderate a Midi effect, to modify it or cancel it.

If you close and open again this dialog box on the same symbol, you will see that your 
modifications are memorized. By placing another symbol of the same type and by calling this 
dialog box, you will observe again the original values of the parameters. The local values are 
separately associated with each instance of the symbol.

When Pizzicato finds a symbol, it first searches if local values are associated with it. If not, it 
will take the original values in standard library.

• You can also open this dialog box when you add the symbol. Hold down the control key while 
adding the symbol. 

The upper part contains 12 text boxes used to modify the graphic aspect.

The first two specify the horizontal and vertical position of the original symbol, in relation to the 
top left corner of the measure. These parameters are adapted if you move the symbol with the 
mouse, but you can also modify the position of the symbol by changing these values.

Just below, you find the horizontal and vertical scales. You can modify them with a better 
precision than with the mouse.

Below you find the text boxes to specify the horizontal and vertical oblique shifts.

The six text boxes located on the right modify the coordinates of a curve, only if the symbol is a 
curve.

A check box makes a symbol invisible. The other elements relate to the Midi play.

The first menu is labeled Effect and changes the effect of the symbol. You can change the type, but it you 
need to keep types compatible. The exceptions are the note sequences and the Midi data, which cannot be 
exchanged with other effects.

The next menu modifies the start of the effect. The 3 choices are Position in measure (proportional to the 
graphic position of the symbol), Attached note (exactly when the associated note starts) or Start of measure 
(the first beat of the measure).

The Duration may be Fixed or Proportional. If the choice is Fixed, the 3 text boxes just below define this 
duration in measures, beats and units (480 units is equivalent to one quarter note). The Proportional choice 
determines the duration in proportion to the graphic width of the symbol compared to the measure. The 
choice selected in the original symbol does not matter, you can modify it here and adapt the duration of the 
effect to this particular symbol.
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To the right, Change specifies if the symbol is a unique or multiple value. The Parameter text box is used to 
specify the number of the Midi controller, only if the type of the effect is a controller.

When the value is unique, it is specified in the Unique value text box. This box is probably used the most for 
local changes. Most of the time, a local change is done to adjust the main value of the effect, like the tempo, 
the velocity, the volume…

The Relative change check box specifies if the values (unique or multiple) are relative or not to the 
preceding value of the effect in the score.

The check box labeled Local change determines if the value is only local (and thus cancelled after the 
duration of the effect).

Six text boxes modify the values of a progression, only if the symbol contains a multiple change. The first 
three boxes are labeled V-1, V-2 and V-3. They are the first three values of the progression. The next ones, 
V-n-2, V-n-1 and V-n represent the three last progression values. Only the used values can be modified. If the 
progression contains only 2 values, only V-1 and V-2 will be used. By modifying these values, you can thus 
influence how the effect will vary with time throughout its duration.

The left lower part of this dialog box only relates to the note sequences. The time scale and the number of 
repetitions can be directly modified here. The main use of this is to adapt the speed of a trill compared to the 
tempo or simply to the musical context in which it is used.

The first three pitches of notes (which are practically always relative pitches in relation to the value of the 
associated note) can be modified directly. It is useful to define the type of a trill (1/2 tone higher, lower, 1 
tone higher or lower…) or the value of an appoggiatura.

All parameters found here are in fact of parameters which are in the symbol definition dialog boxes. Let us 
review some common cases of local modifications.

Examples of local modifications

• Open the Ex071 example. Open the score view and activate the reference marks tool. You get: 

• Call the local parameter dialog box for the accent located on the first note. It locally influences the 
velocity of this note by adding 30 units to it. You can modify this value to increase or decrease the 
accentuation of the note. Click OK. 

• Call the dialog box for the next symbol. This double forte imposes a velocity of 96 on all notes that 
follow. According to the context and the instrument, it could be necessary to change this value. Click 
OK. 

• Do the same with the dot located on the next note. The effect is to reduce the duration of the note to 
50 % of its normal value. This value can be modified if you find it too short or too long, according to 
the instrument, to the context and to the desired effect. Click OK. 

• The next symbol is a slur. This symbol locally set the duration to 100 % of the note values. You can 
modify it according to the context. You can also adjust the duration of this symbol by selecting a 
fixed duration and by indicating for example 3 beats, to be sure that the second note is also included 
(because it begins 2 beats later) and so that the third note is not included in it (it begins 4 beats after 
the start of the symbol). Click OK. 

• The next symbol proposes a relative progression of velocity between 0 and 30 over a duration of a 
full measure. You can modify the intensity of the progression by changing the value "30". In this 
precise case, with the full dialog box you can change the type of effect to act on the sound volume 
(controller 7) instead of the velocity. The number "7" must then be specified as parameter and the 
type of the effect must be MIDI Controller. The velocity is only used at the time of the attack of a 
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note, with the result that the crescendo would not be effective. By exploiting volume, you can really 
create a progressive increase of the sound volume. Click OK. 

Learning the musical keyboard
• How to learn the keyboard with Pizzicato? 
• Organizing the screen 
• Progressive exercises generator 
• Listening to the exercise and learning how to play it 
• Fingering 
• Sounds 
• Learning progression 
• Learning to play with an accompaniment 

How to learn the keyboard with Pizzicato?

In this lesson, we will see how to use Pizzicato various tools and windows to learn playing the musical 
keyboard. The purpose is to learn how to read a musical score with progressive exercises on the level of 
rhythms and notes.

To learn how to play a musical score with the keyboard, we will use the following aspects of Pizzicato:

• The score view to display the score, 
• The keyboard window to visualize how to play the notes, 
• The recorder to set the tempo and to activate the metronome, 
• The instruments view to determine the sound to use, 
• Musical libraries to generate exercises and accompaniments. 

You must well understand the handling of the first four aspects. For the musical libraries, we advise you to 
read the Composition libraries (1) lesson to have at least an outline of what they are. If later you wish to 
personalize the exercises and really understand what happens in this lesson, we highly advise you to read all 
lessons about musical composition libraries.

You must also understand the content of the main music lessons, in particular the lessons speaking about 
notes, rhythms and the musical keyboard layout.

The keyboard learning exercises will be done each time with the following steps:

A. You lay out the Pizzicato screen so as to see the score, the keyboard and the recorder. You select the 
sound to play. 

B. Using the musical libraries, you select notes and rhythms for a given difficulty level. Pizzicato 
generates the corresponding exercises. 

C. You ask Pizzicato to play the exercise in order to see and hear the correct way to play it. 
D. You play it at the same time than Pizzicato, by observing the score and the keyboard window and by 

listening and observe if your version is the same as the Pizzicato version. You correct your 
performance by comparing and adjusting. Once this exercise is under control, you come back to point 
B with another exercise. 

The regular practice of these steps will increase your ability to play a musical score. The rest of this lesson 
will explain you each step in detail.

Organizing the screen

Several documents are prepared for keyboard learning. They are located in the Music folder, in the DataEN 
folder.
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Start Pizzicato and close the default document. Check that the Windows, Windows management option is 
well set on Free. Then open the Keyboard learning 44.piz document, located in the Music folder, inside the 
DataEN folder. It is a set of melodies and rhythms written for a 4/4 measure. The main view appears as 
follows:

The element of the top left corner is a musical score that comprise 12 4/4 measures. The folders with an "M" 
contain random melodies, classified from 1 to 15 per increasing difficulty. By going from Melodies 1 to 
Melodies 15, the notes are more and more dispersed and it increases the difficulty of reading. The chromatic  
melodies folder (by half tones) is even more difficult, because it also contains the accidental notes (keyboard 
black keys). The folders with an "R" contain rhythms of an increasing difficulty. They are numbered from 1 
to 20. When the number is followed by a +, it means that the folder contains several different rhythms.

Double-click on the element named Exercise. Disable the document manager or resize the window to see all 
measures. The score displays 12 measures:

It is in this window that you will be able to place melodies and rhythms in order to generate the exercises.

Open the keyboard window, using the Window menu. In the Options menu, select the Keyboard item. In the 
dialog box that appears, check (if it is not already done) the Fixed key width box and fill in value "8". Click 
OK.

According to the size of your screen, organize the windows to easily reach each one. Here is for example 
how to organize the screen:
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With that screen, you can easily view the score and the keyboard keys. You also have an easy control of the 
metronome, the tempo (via the "..." button of the recorder) and the START and STOP recorder keys.

In the Windows menu, select the Instruments item:

The Family and Instrument columns let you select the sound with which you will play. By default for a GM 
synthesizer, the flute (woodwind family) is selected. You can modify this choice if you want. We highly 
advise you to use a sound that can be maintained as long as you keep the key pressed (organ, woodwind, 
brass…). It is not the case for the piano, guitar or percussion sounds because these sounds stop themselves 
after some time, even if you hold the key pressed. By following this advice, you will better hear the exact 
duration of the notes of the exercise. Close the instruments view now.

Progressive exercises generator

The measures of the score are for the moment empty. To create an exercise, you just need to drag a melody 
and a rhythm in the first measure. Click and drag Melodies 1 into the first measure of the score. Then do the 
same with the rhythm 4/4-1. At this time, Pizzicato calculates the exercise combining these two elements 
and you get for example:

As the notes are randomly selected, you will not necessarily get the same result. Your first exercise is thus 
ready. You can generate other exercises of the same difficulty by dragging again the same rhythm into the 
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first measure of the score. Each time, Pizzicato will calculate a new exercise based on the two elements 
which you dragged into the first measure.

To change the type of rhythm, drag the desired rhythmic element into the first measure. Pizzicato 
automatically removes the previous rhythm and calculates a new exercise with the new rhythm. Drag for 
example the 4/4-7 element into the first measure. The score will display for example:

The same principle is valid to change the difficulty of the melody: drag the new melody into the first 
measure.

An additional factor may be used to vary the difficulty of the melody. By default, the notes are generated in 
a random way between the low C and the high C of the treble clef, i.e. eight different notes at the same time. 
If you do not have any notion of score reading, it would be wiser to start with only the first four notes C, D, 
E and F. The following adjustment may be done to modify the exercise range, i.e. the lowest and the highest 
notes of the exercise.

By holding down the Ctrl key, double-click the Melodies 1 element. In the dialog box that appears, click the 
button labeled More options… A part of the dialog box contains the following parameters:

By modifying for example the upper note to F 3, the notes generated in Melodies 1 will be limited between 
C3 and F3. This adjustment is specific to each melody, it will thus be necessary to do it each time you 
change the melody. It can also be used to increase the playing range. Once you control the 8 first notes, you 
will be able to widen the exercises upwards and/or downwards. With this, you can delimit the notes which 
will be used in the exercises. Click twice OK.

For the rhythms, you can also increase the difficulty. Once you control the exercises with the suggested 
rhythms, you will be able to do them again by dividing their duration by 2 or even by 4. You will then obtain 
eighth notes and 16th notes in the exercises.

To do that, double-click for example on the 4/4-1 icon by holding down the Ctrl key. In the dialog box that 
appears, the following area is used to activate the division of the durations and to select for example a value 
of 2 or 4:

Do this only when you perfectly handle the exercises. Click for the moment on Cancel.

Listening to the exercise and learning how to play it

Now that you can generate an exercise according to the rhythms, melodies and range difficulties, you need to 
listen to it and to learn how to play it. Let us see this in practice for a very simple exercise.

• Modify the range of Melodies 1 as indicated here above, in order to have notes between C 3 (lower 
note) and F 3 (higher note). 

• Drag the 4/4-1 rhythm in the first measure. 
• Drag Melodies 1 in the first measure. You get your first exercise which contains a whole note every 

two measures. The notes are limited to the required ranger (4 notes). 
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• See that the score windows, recorder and keyboard are well visible. 
• Activate the metronome ("..." button on the recorder). In the Options... menu, select the MIDI Play 

Options... item and to the right of Metronome measure, select Before playing. Click on OK. This 
forces Pizzicato to play an empty measure before starting the exercise. You can thus easily forecast 
the first beat to play. 

• With the space bar, ask Pizzicato to play the exercise. You hear 4 metronome clicks (because it is a 
4/4 measure) and then the exercise starts. A small black triangle follows the playing measure and the 
playing note is coloured in red during its time length. You can hear the notes and see them appear on 
the keys of the keyboard window. The first step of the exercise consists in locating in a passive way 
all what happens: 

 Which note is played on the score? 
 To what musical keyboard key does this note correspond 

? 
 How long is it played? 

• Make the exercise play as many times as necessary so that you can easily forecast what happens at 
every moment. The metronome clicks help you to locate and count the beats. Do not go further 
before fully controlling this step. 

• Now you will play with Pizzicato. With the space bar, start the exercise. Play the notes on your 
musical keyboard at the same time as Pizzicato does. If you do not have a musical keyboard, you can 
use the corresponding keys of the computer keyboard (see the lesson about the window keyboard). 

• Play the exercise as many times as necessary. Your goal is to play each note at the correct time and 
with a correct duration. Compare your play with the one of Pizzicato and correct according to what 
you hear. For this, check if the moment during which you hold the key corresponds well to the 
colouring of the note, and if the pressed keyboard key on the screen is the same as the one played by 
Pizzicato. 

• Be sure to understand why each note is played at such a time and with such a duration. If you do not 
understand why Pizzicato plays the notes like it does, read again the lessons about music, because 
something was not understood correctly about this subject. 

• Once this exercise is under control, you can go to the next one. Drag another melody, another 
rhythm, or the same ones to have an exercise of the same difficulty level. The continuation of this 
lesson will give you the advised progression of difficulty (range, melodies, rhythms, tempo). 

Fingering

It is the art to correctly select the fingers to use when playing the notes of a score. All the exercises can be 
done as well with the right hand as the left hand, but use only one hand for all notes of the same exercise. 
Study each exercise with the right hand and then with the left hand (or the reverse if you are left-handed). 
You will notice that some exercises will appear more difficult with one hand than with the other. Here are 
some basic rules to select your fingering:

 The fingers are numbered from 1 (the inch or thumb) to 5 (the auricular or little finger) for both 
hands. In a study score, it is common to see these numbers placed just above the notes to specify to 
the student which fingering technique he must use. 

 The purpose of the fingering technique is to be able to play a piece as easily as possible, with 
precision, flexibility and speed. It is a practice to use from the beginning. By playing a score very 
slowly, it may seem easier to you to play with only one finger. Nevertheless you will not be able to 
tie two notes correctly because it always takes a certain time to raise the finger, to move it and to 
press the other key. Take directly the good practice, even when you play very slowly: use all your 
fingers. 

 As far as possible, avoid any useless motion of the hand. If you must play the 5 notes from C to G, 
use fingers 1,2,3,4 and 5 (right hand) or 5,4,3,2 and 1 (left hand). Thus take care to use your fingers 
in a natural way according to their position in front of the notes and move your hand only when 
necessary. 

417



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

 When you must play more than 5 consecutive notes (a scale for example), the hand needs to be 
moved. To keep a continuity between the notes, one uses the passage of the inch (1) or the major (3) 
during the scale. Here is for example how to play the C scale with the right hand: 

C(1) D(2) E(3) F(1) G(2) A(3) B(4) C(5)

 The inch (1) causes the moving of the hand. By going down, the fingering technique remains the 
same and it is the major (3) which causes the moving of the hand. For the left hand, the fingering 
technique becomes: 

C(5) D(4) E(3) F(2) G(1) A(3) B(2) C(1)

 For series of longer notes, you can also make a passage of the fourth finger to get for example: 

1 2 3 1 2 3 4 1 2 3 1 2 3 4…

 When the notes are not related any more (for example C, E, G), keep the same principle: minimize 
the motions and use the fingers in the most natural way compared to their position. Here is an 
example for the right hand: 

C(1) E(2) G(3) C(5)

 You can also make a passage of the third or fourth finger for longer sequences: 

C(1) E(2) G(3) C(1) E(2) G(3) C(5)

 On the left hand, that would give: 

C(5) E(3) G(2) C(1)
C(5) E(3) G(2) C(1) E(3) G(2) C(1)

 To envisage the fingering techniques correctly, it is necessary to look at the notes being played a little 
in advance. The most obvious example is the scale. If you need to play only the first 5 notes, the most 
natural fingering technique is: 

C(1) D(2) E(3) F(4) G(5)

 But the fact that the progression continues further forces to modify the fingering technique to be able 
to play in a continuous way the 8 notes: 

C(1) D(2) E(3) F(1) G(2) A(3) B(4) C(5)

 For the exercises of the course, take care to play the notes in a tied way. When two notes follow each 
other (i.e. there is no rest between them), the first note must exactly stops when the next note starts, 
without leaving a vacuum between the two and without superimposing the sounds of the two notes. 
Therefore you must raise your finger at the same time as you press the next finger. Work slowly to 
develop that ability from the beginning. 

Sounds

In order to better distinguish the melody played by Pizzicato and the one you play, you can ask Pizzicato to 
play with another sound. This is only possible with Pizzicato Beginner or Professional. For this, do what 
follows.

• Add a second staff in the score view. 
• Open the instruments view. For the first line, select the sound with which Pizzicato will play. For the 

second line, select the sound with which you will play. Remove the cross in the two boxes of the AC 
(automatic channel) column. In the MC (MIDI Channel) column, select "2" for the first line and "1" 
for the second line. Close the instruments view. 

• Start the score and play at the same time. 

Another possibility (without making this) consists in playing the notes an octave higher. The exercise is the 
same but you play a whole octave higher (or lower) in order to better distinguish the notes you play from the 
notes Pizzicato plays.
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Learning progression

Here is the advised progression of study for the keyboard training. Use this progression well, with the 
following principles in mind:

• Apply each step explained in this lesson. 

• Do not go to a new exercise before you perfectly handle the current one. 

• If an exercise really seems too difficult to you, do the following steps: 

1. Decrease the playing speed (tempo) with the recorder, 
2. If it still does not work, return to the previous exercises, until the moment you can do 

them easily. Then come back to the more difficult exercise. 
3. If you need it, read the lessons about the musical theory again, because there can be 

something which you did not understand well and which prevents you from playing the 
exercises correctly. Use the glossary to be sure to understand all words of these lessons. 

• If exercises really seem too easy for your level (provided that you can play them without fault), do 
not hesitate to skip some exercises to increase the level of difficulty. To force yourself to make 
exercises for principle of doing them all whereas you master them can be discouraging, because one 
does not feel a progress. To keep it interesting, take care to adapt the difficulty level throughout your 
progression. 

Here is the list of the basic steps. Mark on paper each finished step. 

With the Keyboard exercises 44.piz (measure 4/4) file, do the following exercises:

• Range from C3 to F3 with Melodies 1; take a tempo of 60 to start and increase gradually to 100; use 
the following rhythms, in order from 1 to 20: 

1 - 2 - 3 - 4 - 5 - 6 - 7 - 8 - 9 - 10 - 11 - 12 - 13 - 14 - 15 - 16 - 17 - 18 - 19 - 20

• Range from C3 to C4 with Melodies 1; take a tempo of 60 to start and increase gradually to 100; use 
the following rhythms, in order from 1 to 20: 

1 - 2 - 3 - 4 - 5 - 6 - 7 - 8 - 9 - 10 - 11 - 12 - 13 - 14 - 15 - 16 - 17 - 18 - 19 - 20

• Range from C3 to C4 with rhythm 19; take a tempo of 60 to start and increase gradually to 100; use 
the following melodies, in order from 1 to 15: 

1 - 2 - 3 - 4 - 5 - 6 - 7 - 8 - 9 - 10 - 11 - 12 - 13 - 14 - 15

• Range from C3 to C4 with the chromatic melodies; take a tempo of 60 to start and increase gradually 
to 100; use the following rhythms, in order from 1 to 20: 

1 - 2 - 3 - 4 - 5 - 6 - 7 - 8 - 9 - 10 - 11 - 12 - 13 - 14 - 15 - 16 - 17 - 18 - 19 - 20

With the Keyboard exercises 34.piz (3/4 measure) file, do the following exercises:

• Range from C3 to C4 with melodies 1 to 15; take a tempo of 100; work with the following rhythms: 

1 - 2 - 3 - 4 - 5 - 6 - 7 - 8 - 9 - 10 - 11 - 12 - 13 - 14 - 15 - 16

• Range from C3 to C4 with the chromatic melodies; take a tempo of 100; work with the rhythms: 

16 - 15

With the Keyboard exercises 68.piz (measure 6/8) file, do the following exercises:

• Range from C3 to C4 with melodies 1 to 15; take a tempo of 40 and increase gradually up to 60 beats 
per minute; work with the following rhythms: 

1 - 2 - 3 - 4 - 5 - 6 - 7 - 8 - 9 - 10 - 11 - 12 - 13 - 14 - 15 - 16 - 17 - 18 - 19 - 20
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• Range from C3 to C4 with the chromatic melodies; take a tempo from 40 to 60; work with the 
rhythms: 

22 - 21

Here is the additional suggestions to increase the difficulties and the variety of the exercises:

 You can do the same exercises by dividing the duration of the rhythms by 2 and then by 4. You will 
obtain eighth notes and 16th notes and the rhythmic aspect will be more difficult. 

 You can extend the range of the playing notes. By placing it for example between C 3 and C 5, you 
will have a range of 2 octaves. If you lower the range (from C 2 to C4) you will get exercises with 
notes in bass clef and treble clef. 

 You can work each exercise with the right hand, the left hand or even the two hands at the same time 
(by playing the right hand for example an octave higher). 

 With a good understanding of the composition libraries operation, you will be able to give free course 
to your imagination. You will be able in particular to create scores with several staves (to work with 
both hands at the same time) and to add accompaniments with chords progressions. You will be able 
to learn how to play all generated exercises. 

Learning to play with an accompaniment

Only Pizzicato Professional 
will allow the following exercises. 

If you do not have that version, use 
the demonstration version to give it a try

Here is a series of exercises accompanied in various light music styles. You are not forced to finish all the 
other exercises to begin them. We nevertheless advise you to work some exercises from the beginning of the 
lesson, in order to understand the basic principles.

Pizzicato contains various styles of light music accompaniment (Disco, Reggae, Jazz, Rock, Funky…). To 
exploit these styles of accompaniment as well as possible, see the lessons about the composition libraries. 
We will see here the steps necessary to learn the keyboard by being accompanied by a small light music 
orchestra.

• Open the document corresponding to the style you wish to work. The styles are available in the File 
menu, in the Open a model item, Accompaniments sub-item. Open for example Jazz. The main view 
displays a whole series of icons which constitute the basic elements of the style. 

• By holding down the Ctrl key, double-click on the Example icon located in the top left corner. The 
sequencer view opens. 

• Drag the Melodies icon into the second measure of the sequencer view first track (Labeled Sol. for 
Soloist). 

• Do the same with one of the rhythm icons (folders with an "R"). 

• Click on the sequencer window to activate it, and in the Edit menu, select the Generate score item. 
Pizzicato then calculates the melody and the accompaniment. The notes of the melody are selected in 
a random way but they respect the chords progression associated with the style. 

• Open the scrolling view or the score view, the keyboard and the recorder windows and organize your 
screen as explained at the beginning of this lesson. 

• First listen to the melody with its accompaniment. Visualize the notes and the keyboard keys. Then 
try to play with Pizzicato. Correct yourself by listening to the version of Pizzicato. 

• When you control the exercise, you can either generate others of the same level, modify the rhythmic 
element or change the style (close all windows without saving and go back to the beginning). 

To work accompanied melodies, we advise you:
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 For the rhythmic aspect, work the rhythms folders by increasing difficulty (from 1 to 20). When you 
control these levels of difficulty, use a division by 2 or 4 of the rhythmic elements, as explained in 
the first part of this lesson. 

 To get a different melody of the same difficulty, select all measures and select the Generate score 
item in the Edit menu. Pizzicato computes another melody for you. 

 The notes of the random melodies have by default a range of one octave (from C3 to C4). You can 
decrease or increase these values as explained in this lesson. 

 Although these exercises with accompaniment are more pleasant than playing alone, do not neglect 
the exercises indicated at the beginning of this lesson. In a general way, the accompanied exercises 
are more difficult. The other exercises propose more continuous melodies, because the notes are not 
related to any chord. 

 Do not hesitate to decrease the tempo of some accompaniments. 
 When you control an exercise well, you can disable the play of the melody by Pizzicato (P column of 

the instruments view) and play it as a soloist with Pizzicato accompanying you. Then you can try to 
play other notes and to amuse yourself to improvise on the accompaniment. Listen to the notes which 
sound good and locate the moment where it happens. Compose your own melodies based on each 
accompaniment. 

If you modify the documents of the Music folder used for learning, you can easily get the originals back by 
reinstalling Pizzicato. Your other documents will remain present.

It is by a regular practice of this lesson exercises that you can manage to read scores. You will progressively 
feel progress with these exercises. Alternate the exercises alone and the accompanied exercises. Vary the 
styles of accompaniment and the types of rhythms. Good learning and have fun!

Composing music (1)
• Using the composition libraries 
• Contents of the Pizzicato libraries 

Using the composition libraries

This lesson and the following will help you to take the first steps in computer-assisted composition. You 
must have read and understood the lessons about the composition libraries and to have done the practical 
steps of these lessons. We will not explain here the practical details on how to handle the libraries. If you 
need it, read these lessons again.

Please note that this lesson and the following are based on the music composition libraries as designed in 
Pizzicato releases 1 and 2. A more user friendly and intuitive approach is now available in Pizzicato 3. You 
will find these lessons further in the manual (Composition tools).

The lessons about composition libraries explained the practical operations of the Pizzicato composition 
tools. It is, in short, a division of music into basic blocks constructed with rhythms, melodies, themes and 
chords. These elements can be used and combined in thousand and one ways.

Now we're going to examine the use of these tools to really start composing. The suggested examples and 
exercises form an approach to composition more than a very well structured composition course. They give 
you raw material to work and show a systematic method to help you structure this raw material as you like it.

Pizzicato is delivered with several documents containing construction blocks with which you will be able to 
work out your first exercises. These elements are there to help you to approach the use of libraries. We will 
start by analyzing the contents of these documents.
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Contents of the Pizzicato libraries

Start Pizzicato and open the Chords library - 1.piz document located in the Music folder, inside the DataEN 
folder. The main view appears as follows:

Each folder contains chords of a different type, i.e. of a different sound colour. Inside a folder, you find the 
same chord on each note of the scale. Double-click for example on the Major folder and you get a window 
displaying the following chords:

Double-click on the C Maj chord, a score view shows you the notes contained in it:

Close this score view and the chords folder. A chord is made of several notes. The way in which notes are 
distributed in the chord gives it a particular colour. There is a very easy way to locate the type of chord. 
Count the intervals (in half tones, i.e. in black and white keys of the musical keyboard) which separate the 
notes one from the other. Let us take the example above with the notes C, E and G. 4 half tones separate C 
from E. 3 half tones separate E from G. The combination (4,3) thus characterizes the Major chords. All 
chords located in the Major folder have this structure. The only difference between them is the starting note 
(here C). This starting note is called the fundamental or root note, because it is on this note that the chord is 
built.

Here is a table of the chords contained in this document, with the number of half tones separating each note 
from the other:

3 notes chords :

• Major = 4 + 3 
• minor = 3 + 4 
• B 5 = 4 + 2 
• # 5 = 4 + 4 
• Sus 4 = 5 + 2 
• Dim = 3 + 3 

4 notes chords :

• 6 = 4 + 3 + 2 
• min 6 = 3 + 4 + 2 
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• 7 = 4 + 3 + 3 
• Maj 7 = 4 + 3 + 4 
• min 7 = 3 + 4 + 3 
• min 7 B 5 = 3 + 3 + 4 
• 7 dim = 3 + 3 + 3 
• 7 sus 4 = 5 + 2 + 3 

5 notes chords :

• 9 = 4 + 3 + 3 + 4 
• Maj 9 = 4 + 3 + 4 + 3 
• min 9 = 3 + 4 + 3 + 4 
• 7 b 9 = 4 + 3 + 3 + 3 

By using all chords of this document, you already have a very large variety of sound effects. Each chord 
itself offers a sound colour, but the sequence of two chords also creates a sound effect which depends on the 
two chords. We will further see an exercise allowing to create chords sequences. For the moment, we will 
listen to the sound colour of each chord and will observe that they are quite different. For each chord folder, 
do the following:

 open the folder with a double-click, 
 open the score view by a double-click on the first chord of the folder, 
 with the space bar, play the chord several times, 
 close the score view and the folder. 

You can also listen to several chords of the same folder. You will notice that the sound colour is similar, but 
that the chords of the same folder have different pitches.

A chords progression forms the basis of a musical work. The chords of this document are classified by types. 
We will further see the Chords by tonality.piz document which contains a classification of chords by tonality 
rather than by types. We will use it for the composition exercises. As we have seen in the music course, a 
tonality is a context of notes used at a specific time in a musical piece. The set of white piano keys form a 
context called the C Major tonality. A musical passage written in C Major will primarily use the notes of this 
context. So that this passage keeps coherence, we will thus use chords that contain only the piano white 
keys.

Close this document and open the Chords library - 2.piz document. The main view appears as follows:

It contains a series of folders with less current chords, formed by 4 or 5 notes. Listen to them as you did with 
the previous document. Most of them have a very pronounced and expressive colour. They will be used 
especially to create contrasted and coloured sound effects. They are not appropriate for all uses.

Close this document and open the Chords library - 3.piz. The main view contains 20 chords progressions in 
the form of folders. They are the example progressions of the 20 Pizzicato accompaniment styles. Each 
folder bears the name of the accompaniment style from which it was extracted. You may use these 
progressions in your exercises and compositions. You can also modify them. Double-click on the folder 
Chords-Bossa. A window displays the chords which it contains:
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Close this window as well as the main view.

Now open the Melodies library.piz document. Its main view appears as follows:

Each folder contains melodies. In the library composition system, a melody is defined as one or several 
sequenced notes. Here is a description of the contents of these folders:

C 2-C 6 
They are melodies with only one note. Open this folder and you will find all notes corresponding 
to the blank keys of the musical keyboard, from C2 to C6. By double-clicking one of the 
melodies in the folder, you display the note. As for all folders of this document, in the options 
dialog box (opened with a double-click on the folder by holding down the CTRL key), notes are 
random. If you combine them with a rhythm, you will get very varied melodies (even too much) 
on a very broad range. We will see that to exploit them better, the range will have to be limited.

C 2-C 6 Chrom. 
Same as the previous folder, but it also contains the black keys (accidental notes) of the musical 
keyboard.

2 notes up
It is a series of 2 consecutive notes forming a melody going up. Double-click this folder. The 
first element is named C-D2. By double-clicking it, you can view these two notes in a score 
view. By using these melodies in your exercises, you will be able to notice that the resulting 
score will contain groups of 2 rising notes, distributed between C-2 and C-6.

2 notes down
It is the same principle, but with 2 consecutive notes forming a melody going down.
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3 notes up

It is a series of 3 consecutive notes forming a melody going up.

3 notes down
It is a series of 3 consecutive notes forming a melody going down.

4 notes up
It is a series of 4 consecutive notes forming a melody going up.

4 notes down
It is a series of 4 consecutive notes forming a melody going down.

Melodies 1 to 15
These melodies folders contain various mixtures of melodies which you find in the folders 
previously explained. Melodies 1 is a sequence of 4 notes going up or down. Melodies 15 are 
notes taken randomly. By passing from melodies 1 to melodies 15, the notes are gradually more 
and more dispersed.

All these folders constitute library melody elements which you will use for the exercises.

Close this document and open the Rhythms library 44.piz document. It contains rhythmic elements for a 4 
beats measure. Here is the main view:

The first 5 folders contain 4 beats duration rhythms, with whole notes (labeled with "1"), half notes (labeled 
with "2") and quarter notes (labeled with "4"). Inside each folder, the name of an element specifies the type 
of rhythm it contains. The number are used for the rhythmic values of notes (1,2,4) and when a number is 
prefixed with the "R" letter (for Rest) it is a rests (R1=whole rest, R2=half rest and to R4=quarter rest). The 
letter D is used for a dotted rhythmic value (D2= dotted half note= 3 beats). An element named for example 
4+R4+2 thus contains one quarter note, one quarter rest and one half note, which make a 4 beats measure. 
Consult the contents of each folder by opening and closing the folders and the elements in them.

The 5 folders located on the second line contain sequences of 4 beats organized so as to be able to create 
longer rhythmic sentences. As in the English language, music is often organized in sentences intersected 
with rests. The first two folders are beginning of sentences. The two following continue a sentence and the 
last finished a sentence. This classification of measures as pieces of sentences is rather subjective. It 
nevertheless helps to create diversified musical sentences. Consult the folders contents to have a practical 
idea of the classification. Some rhythmic elements are in several categories.
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The 16 folders located lower are rhythmic sentences of 1, 2, 3 and 4 times a "4/4" measures. Inside each one, 
you will find one or more of the previous files. They represent various combinations of musical sentences 
built with those.

The documents Rhythms library 34.piz and Rhythms library 68.piz contain the same kind of rhythmic models 
respectively adapted for 3/4 and 6/8 measures. The measures in 6/8 also contains eighth notes in rhythmic 
value (labeled with "8") and eighth rests (labeled with "R8").

By modifying the options of the rhythmic folders (in particular division and multiplication factors of the 
rhythmic values), you will easily be able to get different rhythms and different measures. By dividing for 
example by 2 the rhythmic values, 4/4 measures become 2/4 measures and instead of having a mixture of 
whole notes, half notes and quarter notes, you will get half notes, quarter notes and eighth notes. We will 
further see the practical applications in the exercises.

Close the document now. Among the elements which play a part in the composition of a musical work, there 
is of course the choice of the instruments which will perform it. Pizzicato contains several documents with 
soloists instruments and groups of prepared instruments, as well for classical music as for light music. These 
documents are available by the Open template item in the File menu and are classified under various sub 
directories.

Open the template named Orchestra instruments located in Orchestral sections. It contains most of the 
instruments of a symphonic orchestra, classified by families (woodwinds, strings, brass, percussions). It also 
contains various instruments as the organ, the piano, the guitar as well as soloists voices and a choir section. 
Sections of instruments are also prepared by families. Each score of this document contains only one 
measure. The full name, the short name, the sound reference to a GM standard synthesizer as well as the 
position in space (left-center-right) are preset. By using these templates, you can build an orchestra very 
quickly. Select the instruments in the desired order and Pizzicato builds a score containing all these 
instruments. We will explain this again in the exercises.

Close this document and open the various templates located in Orchestras. They contain several 
configurations of symphonic orchestras corresponding to various works of reference (symphonies 2 and 9 by 
Beethoven, 6 by Tchaikowsky, the Ravel Bolero, Rhapsody in Blue of Gershwin, The Planets - Holst). 
Examine the instruments which compose these various orchestras as well as the values associated with the 
instruments view.

Explore the Chamber Music category. It contains various small groups of chamber music ready for use.

Explore the Light Music category. It contains 20 groups of light music from the Pizzicato accompaniment 
styles. Each one of them contains in particular 5 staves for percussions. Pizzicato indeed provides a standard 
template for percussion encoding. Open each score and observe the various instruments which compose 
them.

Now explore the Percussion category. The sub-category named General MIDI template contain the staves of 
the standard template provided by Pizzicato. All styles of accompaniment are based on these templates. They 
require a compatible GM synthesizer so that the instruments correspond. You will find the details of the 
percussions instrument distribution on the hard paper guide delivered with Pizzicato.

This lesson reviewed the Pizzicato constructions blocks for rhythms, melodies, chords and instrumentations. 
The next lesson will explain the use of the Pizzicato accompaniment styles. These styles are entirely built on 
the principle of the musical libraries. They contain melodic and rhythmic elements specific to each style. 
Although these styles are oriented towards light music, they form a good approach of what can be done 
starting from the composition libraries. After analyzing these styles, we will do composition exercises based 
on the elements exposed in this lesson.

Composing music (2)
• Using the accompaniment styles 
• Structure of a style 
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sing the accompaniment styles

We will first learn how to use an accompaniment style. We will then study how a style is structured and how 
you can modify it or create a new style.

Pizzicato contains 20 documents with musical libraries oriented towards styles of light music:

• Bolero 
• Boogy 
• Bossa 
• Cha-cha 
• Country 
• Dance 
• Disco music 
• Funky 
• Hardrock 
• Jazz 
• Rap 
• Reggae 
• Rock'n'roll 
• Rockroll 
• Rumba 
• Samba 
• Slow number 
• Slowrock 
• Tango 
• Waltz 

They are available in the File menu , Open template… item in the Accompaniments sub-category. As an 
example for this lesson, we will work with the Rumba style. Open this document. Its main view appears as 
follows:

This structure is the same for all styles. Only the instruments and the library contents are different. The basic 
idea of an accompaniment style is as follows: each instrument of the group plays the rhythmic and melodic 
structures repeated in a regular way (on 1 or 2 measures or more). At every instant, the notes played by all 
instruments are coordinated by a chord progression which is the same for each instrument. This common 
chord progression leads all instruments in an harmonious way.

Let us take the simplest case to start. A chord progression is provided as an example for each style. By 
holding the Control key , double-click on the Example score. The sequencer view opens:
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This view displays the libraries contained in the measures. You will notice that the chords progression is 
present in the first measure of staff 1. For all styles, the selected option is that the chords progression is valid 
for all staves (see the Libraries... item in the Options menu). In the Edit menu, select the Generate score 
item. Pizzicato calculates the score by combining the musical libraries contained in the measures. Once the 
operation is finished, press the space bar to hear the sound result. Also open the score view of the Example  
score to view the generated notes. It is the easiest manner to use a style.

Let us see now how to create a chord progression and use it with a style. Close the score example views and 
open the Chords library - 1.piz document located in the Music folder. We will create the following 
progression: 

C Maj 7 - F Maj 7 - C min 7 - F min 7 - C Maj 7
In the document Chords library - 1.piz, select in the Edit menu the New element… then New chord… item. 
In the dialog box that appears, select the Chords progression option. Call it Test and check the Duration 
associated in multiples of Whole note box. Click OK.

Open the Test folder and to make the next handling easier, drag this Test window to the bottom right corner 
of the screen. Double-click on the Maj 7 icon. Its contents displays all seventh major chords:

Drag the CMaj 7 chord into the window of our Test folder. Do the same for the FMaj 7 chord. Close the Maj 
7 folder. The first two chords are placed. Open the Min 7 folder now and drag the Cmin 7 chord and then F 
min 7. Close this folder and copy again the CMaj 7 chord from the Maj 7 folder. Your Test folder becomes:

Close this folder and drag the main window to the bottom of the screen, so that the main Rumba window is 
still visible. Now drag the Test icon into the Rumba document main view. Close the Chords library - 1.piz  
document without saving the changes.
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This way of proceeding is recommended to create a new chord progression. Here is a step by step 
description:

 Open the Chords library - 1.piz , Chords library - 2.piz or Chords by tonality.piz document, 
 Create a new chord folder in this document, 
 Drag in it all the chords you need in the correct order, 
 Drag the resulting folder into the document where you will use it (here Rumba), 
 Close the original chords document without saving the changes. 

You can also use the 20 progressions which are in the Chords library - 3.piz document. Open this document 
to drag the chords progression in the working document and close Chords library - 3.piz.

Let us continue our example. By holding down the SHIFT key, double-click the Test folder of the Rumba 
window. The following dialog box appears:

As we have seen in the lessons about libraries, the text boxes labeled Duration allows to specify how much 
time the chord will be used. As we have chosen the whole note as the basic duration (during the creation of 
the chord folder), the duration associated with a chord specifies how long this chord will be heard. For the 
first, fill in "4" in the duration box. Click then on the second chord and fill in "2". For the others, fill each 
one of them with "2". Our progression will contain 4+2+2+2+2 whole notes, i.e. 12 "4/4" measures. Click 
OK.

The basic duration of a chord folder must be the shortest that will be used in the score. The longer chords are 
adjusted with the above dialog box, by specifying for each one of them how long it must be held.

Open the sequencer view of the Example score. Drag the Test folder into the first measure of track 1. Then 
generate the score. Listen to the sound result. You will note that after measure 12, the same chord is kept up 
to the end. As our progression contained only 12 measures, Pizzicato continues with the last chord. The 
Example score contains 20 measures and its structure is fixed. Let us see how to build a new score and how 
to structure it.

Close the sequencer view of the Example score and open the Template score. This score contains only one 
measure. Our chord sequence has a total duration of 12 measures.

Double-click on the first measure of track 1 and add 11 measures with the measures dialog box.

The instruments are prepared for the style, but the measures are empty. We will complete this score by 
dragging the rumba musical libraries in it. The main view contains 4 musical score : Intro, Rhythm, Break 
and End (blue icons, not to confuse with the yellow folders to the right, bearing the same names).

Intro contains library elements which form an introduction of the instruments. It is used at the beginning of a 
piece to form a transition to the main rhythm.

Rhythm contains the main repetitive rhythmic. It is this element which constitutes most of the score.

Break forms a break in the main rhythm. It is used for example between the verses or the chorus. It can also 
be used to break the monotony of a long passage with the same rhythm.

End is formed with one or two measures of conclusion for a score. It is a transition between the main 
rhythmic and the complete stop of the music. It is commonly used in the last measure.
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By combining these 4 elements in the score, you can structure the accompaniment so that it is well adapted 
to a melody and a chord progression. The main structure of a score could break up as follows:

• Intro + X times (Rhythm + Break) + End 

or 

• Intro + X times (Rhythm + Break) + Rhythm + End 

We will structure our 12 measures in the following way:

• Measures 1 and 2: Intro 
• Measures 3 and 4: Rhythm 
• Measures 5 and 6: Break 
• Measures 7 and 8: Rhythm 
• Measures 9 and 10: Break 
• Measures 11 and 12: End 

When you add an element in a measure, it remains valid until you add another one. In other words, if you 
add a rhythm in measure 1 only, this rhythm will be heard from there up to the end.

To add one of these 4 elements in the score, you need to drag the score (Intro, Rhythm, Break or End) on the 
first track (staff) of the sequencer view measure. Drag Intro into track 1 measure 1. The sequencer view 
becomes:

Do the same with the other elements and successively drag (in track 1):

 the Rhythm score on measure 3, 
 the Break score on measure 5 
 the Rhythm score on measure 7, 
 the Break score on measure 9, 
 the End score on measure 11. 

Drag the Test chords folder into track 1 measure 1. Generate the score and listen to the result. Open the score 
and observe the notes. The first staff is ready for a melody. You can record it with the sequencer or fill it 
directly on the score. You can also use the rhythms and melodies libraries to help you find a melody which 
sounds well on the chords. You can modify the distribution of the instruments, the bass, guitar or piano type.

Once the score is generated by Pizzicato, you can of course modify what you want in the score to 
personalize the percussion effects or the bass line, or to modify the position of a chord. You can thus use the 
accompaniments system to structure your score and then to personalize it with all the other tools of 
Pizzicato. At this time, you can erase the musical libraries: your score becomes independent and you can 
also print it.

When you compose in this manner starting from an accompaniment model, save your document under a new 
name (Save as... item in the File menu). In this manner, you will not lose the original accompaniments.

Structure of a style
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To use a style does not require a complete understanding of the musical libraries principles. On the other 
hand, if you wish to modify or create a style, you need to carefully read the lessons concerning the Pizzicato 
composition libraries. Let us see now what is the link between what we have just done and the musical 
libraries explained in the course.

Just beside the 4 basic scores (blue), you can observe 4 theme folders (yellow, with a capital letter T) bearing 
the same names. It is in these folders that the construction blocks of each instrument of the score are 
prepared. Double-click on the folder named Rhythm. Its contents appear:

Each instrument is inside a sub-folder. Double-click on the Guitar folder and its contents appear:

Double-click the Guitar 1 element and the contents of the measure appear:

It is here that you can modify the contents of what the guitar will play during the main rhythmic. The notes 
must be introduced as if it was a C major chord. When Pizzicato finds other chords, it will adapt the notes 
but will respect the rhythmic structure and the number of notes. Close the score. In this case, there are two 
elements. Open Guitar 2 to see what it contains then close it.

Open the options dialog box of Guitar 1 (double-click with the Control key). Notice that the total duration of 
the theme is limited to 4 quarter notes. Close this dialog box. Close the Guitar window. Open the Guitar  
folder options now:

It is an ordered combination which is repeated ad infinitum (repeat "0" times). The Guitar 1 and Guitar 2 
elements in this folder will thus be alternated during the rhythm. It will not be transposed. Pizzicato will thus 
simply adapt the contents to the closest notes of the current chord. Close this window.

Consult several other elements now in order to find what they contain.
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Close all windows other than the main view. We will see now how the Rhythm score is built. Double-click 
on this score (blue). The score view appears and shows you the libraries contained in the measures. The 
score (just like the 3 others) contains 1 measure and the same number of instruments as the template. The 
themes folders are placed by instrument in the measures. When you drag this score in the sequencer as we 
did, the contents of each instrument is copied in the destination measure. It is a very easy way to structure an 
accompaniment. Without that, it would be necessary to separately drag each folder into the correct measures 
of the score, for each instrument and each type (intro, rhythm, break and end). 

To build a new type, you need to create a score of only one measure and that contains the same number of 
staves as the template. Then create and place library elements (themes, rhythms, melodies) in the measure of 
each instrument. The new elements created can remain in the main view or be grouped in a new folder.

To modify a style, here are the points on which you can act:

 Directly modify the theme element of a measure contents. You can use the notes, chords and 
accidentals tools as explained in the course. 

 Add theme elements in the instruments folders. You need to select the New element… then New 
theme… item in the Edit menu and to complete them as explained in the course about the musical 
libraries. 

 Modify the elements and folder options. You can make them random, ordered, or inverted sequences. 
You can repeat the notes and the rhythms and use all characteristics of the composition libraries. 

 Modify the characteristics of the instruments with the instruments view associated with the Template  
score (volume, sound,…). 

 Add other scores to the 4 Intro, Rhythm, Break and End scores. You can for example create Rhythm 
A and Rhythm B scores which are alternatives of the style. You need each time to complete these 
scores with theme elements. 

Close the document without saving the changes. To create a style, you can either start from an existing style 
and modify its elements, or use the New style template located File menu, Open template, Accompaniments 
item. The structure is similar to the 20 accompaniment styles but the library elements are empty. We advise 
you the following steps to create a new style starting from this document:

 Decide which instruments will play and adapt the instruments view of the Template and Example  
scores. You can of course remove or add staves, but it will have to be done for each score of the 
document. You can create in this manner complete symphonic orchestra styles and create scores 
corresponding for example to chords or effects by families of instruments or melodic lines of 
accompaniment, arpeggios, etc. 

 Decide the time signature with which you will work (by default 4/4). Correct the musical scores 
accordingly. Also modify the duration of each library element (by default limited to 4 beats). 

 In the Rhythm folder, complete the musical elements of the main rhythm. Test them progressively by 
using the Rhythm score in the Template score. 

 Complete then the Intro, Break and End folders. Adjust what is necessary by testing the style with 
chords progressions and scores structures. 

 If you wish to add it to the 20 Pizzicato accompaniment templates, save this style in the 
Accompaniments folder in the Templates folder (Pizzicato main folder). It will then automatically 
appear in the templates available in the Open template item from the File menu. 

Composing music (3)
• What is a chord? 
• Tonality and chords 
• Sequencing chords 
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What is a chord?

The chord is the common element so that the various instruments play together in a harmonious way. We 
will learn in more details how they are created and how you can sequence them. This lesson does not claim 
to teach harmony but constitutes a set of principles you can use to understand and create chords 
progressions.

We can define a chord in a general way as a context of notes (2, 3, 4 or even more) heard simultaneously. 
The relations existing between these notes is what characterizes the sound colour of a chord (see the lesson 
on Composing music (1)).
By using this definition, any group of notes can be a chord. Nevertheless, if a chord must be harmonious, the 
notes in it must have related elements, otherwise the chord will sound like an aggregate of dispersed notes 
rather than a harmonious set of notes.

The common element must be found in how notes are transmitted from the instrument to your ears. We have 
seen that the sound is made of an air vibration. By playing two notes simultaneously, we thus have two 
different vibrations propagated to the auditor and interfering one with the other. By playing for example two 
C notes separated by an octave, the vibrations have a ratio of 2. By playing for example a C note and a G 
note, the vibrations are in a 3/2 ratio. C and E have approximately a 5/4 ratio, etc.

In addition, by listening to various chords and groups of notes, one can notice that some give a very 
harmonious impression while others are more unpleasant or more dissonant. Is there a rule to measure this 
degree of harmony? Yes, it is the degree of the mathematical relationship complexity between the sounds of 
a chord which determines the dissonance degree of this chord. In other words, the notes in a ratio of 2 will 
appear more "in agreement" that notes in a 15/13 ratio. This rule is empirical and is just a basic guide. The 
preferences of the composer, in connection with what he wants to express, will determine if he wants to use 
such or such chord in his composition, the concepts of harmony or discordance being themselves rather 
subjective.

Tonality and chords

You can conceive the musical keyboard as a series of 12 keys (7 white and 5 blacks) repeated several times. 
Music composition then consists in simply determining which notes will be played and how they will be 
linked in time. By taking the problem in this manner, the number of possibilities is so enormous that the 
beginner will be completely lost and will compose nothing at all. Thus let us use the principle of "divide to 
reign better" and divide the notes in contexts called Tonalities.

The simplest tonality is the C Major tonality. It is a subset of keyboard notes containing only the white keys. 
A piece of music (or part of it) written in C Major will use in theory only the white notes of the musical 
keyboard. All instruments of the score agree on a series of notes to use. It is the first way to divide notes in 
order to harmonize the relationship between the instruments. We thus lay down our first working rule:

In the series of all possible notes, let us select a subset of notes with which we will compose. 
This subset becomes our context of notes to use and is called the tonality.

The 12 major and minor tonalities (see the lesson on key signatures) form contexts of notes. We advise you 
to use them at the beginning, because these contexts are rather well codified from the chords point of view. 
Most classical music and light music is written by using almost exclusively these contexts. For this reason 
they sound very natural and familiar because it is what most people is accustomed to hear. You only need to 
open the radio to hear music based on tonalities. Nothing prevents you from defining new contexts of notes 
or laying down your working rules.

With a context of notes, we have notes the instruments can use in a musical passage. This passage can last 
one measure, 20 measures or even 200 measures, it is the composer who decides. Then it may change 
context for the next musical passage. This first division does not specify yet which notes will sound well 
together. Let us take the tonality of C Major. Our context of notes consists of the following notes:
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We displayed only the notes of one octave, but consider that all notes of the higher and lower octaves are 
also included (all white keys of the piano).

We have seen that the notes of the scale are numbered as degrees, based on the scale starting note (here C for 
the C major tonality). We use Roman numerals from I to VII and start again from I for the next.

Inside a tonality, there are still lots of possibilities. Experiment will show you that by playing only the white 
keys, it is difficult for a beginner to create multiple melodies which harmonize with each other (for example 
a bass and a song, the two hands of a piano…). Too much possibilities still exist and no directing rules exist. 
We will again divide the tonality into sub-groups of notes called chords.

A chord consists of 3 or 4 (or even more) notes heard simultaneously. They form sub-groups inside the 
tonality context. Let us start with the groups of three notes and build on each degree of the scale a chord 
formed by consecutive thirds (you take one note out of two using the white keys). We get the following 
chords:

The black keys are not distributed equally (there is no black key between each white key), thus the 
relationship between the notes of the chords are not the same on each degree of the scale. By analyzing the 
distribution of each chord, you will find 3 different types (see the Composing music (1)). By counting the 
intervals between the black and the white keys, you will get:

• Degrees I, IV and V: 4 + 3, it is a Major chord 
• Degrees II, III and VI: 3 + 4, it is a Minor chord 
• Degree VII: 3 + 3, it is a Diminished chord 

Our second rule of work will be stated as follows:

Inside a tonality (context of notes) and at every moment of the score, the instruments will 
play mainly the notes which belong to the same chord, this chord being selected among 
those of the tonality (degrees I to VII).

The two stated rules are based on the same principle: to select a set of notes among a larger number. The 
application of this principle is initially done for a context of notes (valid for a variable number of measures) 
and then inside this context itself to determine the combinations of simultaneous notes.

By laying down rules of composition, let us remember that those are there only to help you structure music. 
They should in no case become a constraint to respect in an absolute way. They do not constitute an end in 
themselves. They form a guide, a practical method which gives fast results to sort out possible sound 
combinations. If your inspiration specifies a sound combination you like and which communicates what you 
want, use it without hesitation, even if this combination does not respect the stated rules. This remains valid 
for all lessons about composition.

By establishing chords of 4 notes on the degrees of the scale, we get other sub-contexts of notes, these notes 
belonging to the main context of C Major:
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By analyzing the intervals separating the notes from each chord, you will find 4 types of chords:

• Degrees I and IV: 4 + 3 + 4, a chord of seventh major (Maj 7) 
• Degrees II, III and VI: 3 + 4 + 3, a chord of seventh minor (min 7) 
• Degree V: 4 + 3 + 3, a chord of seventh dominant (7) 
• Degree VII: 3 + 3 + 4, a chord of seventh sensible (min 7 B 5) 

With each major tonality there is an associated minor tonality. By taking the sixth degree (VI) of the major 
scale, you can build a new scale on this note. The minor scale associated with C Major is the scale built on A 
(degree VI of C Major) and is called A Minor. It contains the same context of notes but has other sound 
characteristics. Here is the A Minor scale:

The degrees are numbered starting from A. As you may notice, degrees VI and especially VII are sometimes 
raised in a minor scale. It is a characteristic specific to minor scales. These accidentals are especially found 
when a melody plays the scale upwards. By going down, the melody will again use the non accidental notes. 
This aspect contributes to give its colour to a minor scale. Besides that, we can see that the context of notes 
is the same than for C Major. It is possible to build chords in the same way than with the major scale. Those 
however will be distributed in a different way, because the intervals are laid out differently.

By working with a scale, all degrees do not have the same importance. Degree I is the most significant 
because it is the degree on which the scale is built. The next important degree is the V, because its speed of 
sound vibration is in a ratio of 3/2 in relation to the first degree. Then it is degree IV, which has a ratio of 
4/3. Then the degrees II, III, VI and VII with a ratio more and more distant from the first degree.

The relative importance of the scale degrees will influence the use of these degrees. The musical speech will 
be oriented mainly around the most significant degrees (I, V and IV). These degrees could be used as points 
of support for melody and rhythm. The less significant degrees will be used more like a transition. Again, 
these rules are more tendencies than immutable laws.

We now will do some practical exercises so that you can hear the sound result of chords.

We have seen that the Chords library - 1.piz and Chords library - 2.piz documents contain chords classified 
by types, with for each one of them the chords built on all white and black keys. As we explained, chords 
may be regarded as subdivisions of tonality. By composing a musical passage in a tonality, it would thus be 
more logical to classify chords by their membership to a tonality. It is what the Chords by tonality.piz  
document provides for 5 major tonalities and the 5 corresponding minor tonalities. Open this document in 
the Music folder (inside DataEN). Its main view appears as follows:

The 5 simplest tonalities were selected. The central column contains C Major (no accidentals on the key 
signature) and A Minor which is associated with it. The column on the left is F Major (1 flat on the key 
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signature) associated with D Minor. On the left, B flat Major (2 flats on the key signature) and G Minor. The 
fourth column contains G Major (1 sharp on the key signature) and E Minor. Lastly, the fifth column 
contains D Major (2 sharps on the key signature) and B Minor.

Each column contains 4 different folders. The first contains the chords with 3 notes built on the 7 degrees of 
the major scale. The following contains the chords of 4 notes built on the 7 degrees of the major scale. The 
two following are similar but built on the degrees of the minor scale.

For each tonality (5 major and 5 minor), you thus have two folders respectively containing the chords of 3 
and 4 notes.

Double-click on Score 1. The score view appears in the bottom of the screen. The first measure contains a 
rhythmic library element (invisible) of an ad infinitum repeated whole note. You just need to drag a chords 
folder so that the 7 measures are automatically filled with the chords of the 7 degrees of the scale.

Drag one of the folders into measure 1 and observe the notes which compose the chords. Listen to the sound 
result and use the keyboard window to visualize the keys. Do the same with the other folders and observe 
each time the following facts:

 The 7 chords are built on the notes of the 7 degrees of the scale, 
 Each chord consists of 3 or 4 superimposed notes. They form a succession of thirds. In other words, 

to form the chord, you take one note out of two in the scale, by starting on the first note which is 
called the chord fundamental or root note. All notes of the chord are thus either in a space between 
the lines or on a line (at least in the present case). You will find some chords laid out differently for 
the minor chords, but this is due to the way in which Pizzicato treats accidentals (C # = Db…). Do 
not take that into account for the example. 

Close the score and open the Score 2. Here is how the score appears:

Warning ! You now will start to compose !

The purpose of the following exercise is to show you in practice that by creating a melody with the notes of 
a chord, this melody always sounds harmoniously with the chord.

Do the following steps with several of the chords folders (major or minor, 3 or 4 sounds), until you can do it 
easily and understand what we explained just before.

 Select one of the folders and drag it into the first measure of the lower staff, named Chords. The 7 
chords corresponding to the selected tonality appear in the lower measures. 

 With half notes only and by using the notes encoding tools (tools palette), complete the 7 upper 
measures (2 half notes per measure). Use only the notes which belong to the chord located in the 
lower measure. You can also use notes which bear the same name. In other words, if the chord 
contains a lower C, you can either use this C or the upper one or even higher. This leaves you already 
a lot of choices. For the moment, select the notes as you want, so long as they belong to the chord 
located just below. 

 Listen to the sound result and notice that the notes of the melody give the impression to be in 
harmony with the chord that is played. 

 Erase the upper staff only and start again the exercise with quarter notes (4 per measure). Vary the 
notes and possibly modify them according to what you hear. You can also repeat notes. 

 Erase the upper staff and start again these steps with another folder. 
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Sequencing chords

In the course of a score, the instruments are coordinated by a chord progression. It is the main direction 
which guides them. The chords progression specifies how chords will follow each other and for how long 
each chord will be played.

By going from a chord to another, it is thus the notes context that changes (even if you remain in the same 
tonality). The melody will follow by taking its reference points on the chords.

The two preceding exercises used the scale degrees in the scale order. Here are some rules which can be used 
as a basis to establish more interesting chords progressions. We will use them with practical exercises.

• By composing a musical score, one of the essential points consists in doing a coherent work. In other 
words, you need to mould the raw musical matter and to channel it so that it forms an organized set 
rather than a chaos formed by various parts having nothing to do with each other. You need to create 
and to maintain links between each part of your composition (instruments, chords, melodies, 
rhythms, sound effects…). For the chords sequences, this rule becomes: 

Sequence chords having characteristics in common
This common characteristic can be for example:

 one or more notes shared by the two chords, 
 the chord type (major or minor), 
 the same tonality (C major, G major…). 

This common characteristic will help the transition between two successive chords and will give 
the impression to the auditor that these two chords are really made to be sequenced, even if the 
auditor cannot really explain where the link comes from.

To structure a musical work, it is a little like building a sentence. You have a great number of 
words and you must arrange them so that they form a direction which communicates what you 
want. To randomly place chords, without taking into account a note context and the links to 
connect them would be like building a sentence randomly by taking words in the dictionary. The 
sentence would not have any coherence.

• We have seen that all degrees of a scale do not have the same importance. Use the most significant 
degrees (I, V and IV) at the key points of a work, such as for example at the beginning and on the end 
point of the melodies (I and V), for the conclusion of the chorus and verses (especially I), on the 
melody support points (I, V and IV),… These degrees tend to confirm the tonality you are in. Use the 
other degrees (II, III, VI and VII) as bridges to go between the main degrees (pillars of the tonality). 

• Several sequences of degrees are very current and are abundantly used in almost all music styles. 
Each one of them satisfies at least two of the criteria given above. Here are some of them: 

V I   G => C in C Major
    E => A in A minor
    …
IV V I  F = > G = > C in C Major
    D = > E = > A in A minor
    …
II V I  D = > G = > C in C Major
    B = > E = > A in A minor
    …

VI IV V I A = > F = > G = > C in C 
Major

    F = > D = > E = > A in A minor
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    …

II IV V I D = > F = > G = > C in C 
Major

    B = > D = > E = > A in A minor
    …

These chords sequences are called cadences. They tend to affirm the tonality. Notice that most of 
the degrees used are important degrees of the scale.

• When you change tonality (this is called modulation), the same principle applies. Establish a link 
between the two chords which form the transition. By observing the contents of each tonality folder, 
you will be able to realize that some chords are found in several different tonalities. You can thus use 
them as transition. 

Let us take a simple example. You do a IV - V - I sequence in C Major, which gives chords built 
on F - G- C. To continue the progression, you can observe that the C Maj chord is also present in 
the tonality of G major where it is placed on degree IV. You can thus again start a cadence IV - 
V - I in G major, which would give :

 F G C D G
C Major tonality IV V I   
G Major tonality   IV V I

The chord built on C is the transition between the two tonalities.

You can use only one chord of a tonality and then directly return to the original tonality. One 
speaks about a chord "borrowed" from another tonality. You can also do a complete change and 
remain in the new tonality. It is called a modulation.

Nothing prevents you to go often from one tonality to the other. If you wish to affirm a tonality, 
you will have to use more than only one chord of it. For that, it is easier to use one of the 
cadences, the minimum being the transition V - I because it is the best to establish a tonality.

Let us make some exercises to create chords progressions.

• Here are the steps to create and listen to a new chord progression: 

 In the Edit menu, select the New element… New Chord…item. 
 Name it as you want and check the Chords progression choice as well as the check box 

Duration associated in multiples of whole notes. 
 Click OK and open this folder. 
 Open a folder that contains chords and drag some of them inside the new folder, in the 

desired order. If you need it, move the folder windows so that they are laid out in a 
practical way to work. 

 Close the folders and open the Score 1. Drag your new folder in measure 1. The chords 
appear. (Notice that if you placed less chords than the number of measures, the last 
measures will be filled with the last chord). 

 Use the space bar to listen to the result. 

• We will first work with only one tonality, which corresponds to the elements contained in only one 
folder. You will create chords progressions as specified above, by selecting a folder and by using 
only the elements of this tonality. Here are the directives for the first exercise: 

 Create progressions which contain from 4 to 7 chords, 
 Finish each progression with a V - I cadence, 
 Use only the 3 notes chords of a tonality, 
 Sequence only chords having 2 notes in common (except for the end V - I cadence). 
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Create between 5 to 10 folders of this kind, with various tonalities. Listen each time to the sound 
result and locate the passages which you find particularly harmonious. For this exercise and the 
next, we recommend to save these folders in a separate document. Therefore, you just need to:

 Create a new document with the New item of the File menu, 
 Drag one by one the chords folders in its main view, 
 Save this document. 

These chords progressions will be useful for the continuation of the exercises, when you will add 
melodies and rhythms to them.

In order to locate the chords which have notes in common, we advise you to print Score 1 on 
paper with the folder of the selected tonality chords.

• Do the same exercise with chords of 4 notes (4 to 7 chords finished by V - I, with two notes in 
common except for the V-I). 

• Same exercise, but this time you can mix 3 notes and 4 notes chords (coming from the same tonality). 

• We now will work with two tonalities. Add 5 measures to Score 1. Here are the directives: 

 Select the two tonalities you will sequence. The most natural and easy modulations are: 

 between the major tonality and the associated minor tonality, 
 between two successive columns (in this case the tonalities have only one 

note which differentiate them and thus 6 notes in common and several chords 
also). 

 Start the exercise with 4 to 6 chords of the first tonality. Place then from 4 to 
6 chords of the second tonality. 

 As well in the tonality as when changing tonality, sequence only chords having at least 2 
related notes. 

 You can use 3 and/or 4 notes chords. 
 Finish with a V- I cadence. 

• Same exercise, but you can use sequences where chords have at least one note in common. 

• Add 6 measures more to Score 1. You now will return to the starting tonality to have in the order: 

 4 to 6 measures with tonality 1 
 4 to 6 measures with tonality 2 
 4 to 6 measures with tonality 1. 

• Once you can easily create scores of some measures, you can lengthen the exercise freely and create 
16 or 32 chords progressions. You can go from one tonality to the other and use the 3 and 4 notes 
chords. Use and try out all the aspects seen in this lesson and give free access to your imagination. 

The exercises suggested here relate only to the aspect of sequencing various types of chords. We will see in 
the next lesson that you can modify the position of a chord, i.e. the way in which the notes of the chord are 
distributed. This possibility will help you create more pleasant progressions and to enrich the sound effects. 
Do not hesitate to spend time over these exercises because only intensive practice will bring you to better 
locate and use the most adequate sequences of chords to express what you want.

Composing music (4)
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• Melodies and rhythms 
• Generating melodies using libraries 
• Instrumentation and effects 
• General rules of composition 

Melodies and rhythms

In this lesson, we provide you exercises to stimulate inspiration by creating melodies, rhythms and 
instrumentations. We will use the chords progressions made during the previous lesson. You can also use 
progressions from the Chords library - 3.piz document located in the Music folder (in DataEN).

A melody is a succession of notes played by an instrument. A melody is often made by musical sentences 
alternated with rests. We often speak of a voice, by analogy with the singing human voice. With each note of 
a melody, a rhythmic value is associated and specifies the duration of the note.

Just as for a chord, a melody will use the notes of a tonality at a given time. When several voices are played 
together and with different notes, they form a chord. The notes of a chord can indeed be played by different 
instruments.

• Open the Chords by tonality.piz document as well as the document containing the chords 
progressions made during the preceding lesson. Drag Score 1 to 5 as well as the whole note rhythm 
into your document and then close the Chords by tonality.piz document. 

• Open the Score 1. Drag the Whole note rhythm in the first measure and do the same with one of your 
chords progressions based only on 3 notes chords. The chords appear in the measures. 

• You may notice that the chords notes are very close. It is called a tight position of a chord. You can 
move the notes down or up by one or more octaves in order to get a large chord position. Drag for 
example the middle note of the first chord one octave higher and listen to the result. The chord keeps 
the same type but seems more open, has a wider sound spectrum. 

• The Pizzicato original chords are all in a tight position. By creating chords progressions, the 3 or 4 
chord notes are abruptly moved all together to go from one chord to the other. It is called a parallel 
movement of voices. This movement is limited to the view point of the sound effects. As each voice 
does the same movement, it quickly becomes monotonous and annoying. The exercise which follows 
will help you improve the chords progressions so as to create several independent melodies formed 
by the notes of the chords. For each chords progression of your document, do the steps which follow: 

 Drag the chords folder into the Score 1, in measure 1. The chords appear in the measures. 

 Organize the chords notes so as to form melodies. The only modification you can make is 
to move one or more notes by one or two octaves up or down (it corresponds to a 
vertically motion of the note by 7 positions on the staff). Use the following rules to 
improve the progressions and to create melodies: 

1. Create melodies with a maximum of consecutive notes, i.e. melodies which 
go up or down by one position on the staff. A melody will often be made of 
consecutive notes alternating with more significant jumps. 

2. Give an independence to the 3 or 4 melodies. For that, prevent all voices from 
moving in the same direction. Use contrary movements, i.e. a voice which 
goes up while the other goes down. 

3. When a note is common between two successive chords, try to keep it within 
the same melody (for example the second note of the two chords). You can 
also tie them. 

4. Try to specially take care of the upper and lower melodies, because they are 
particularly well noticed. 

5. When using the V-I cadences, preferably use the fundamental note (i.e. the 
note on which the chord is built) in the lower melody. It tends to reinforce the 
sound effect. 
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6. Once you are satisfied with the result, you can create a new document and 
drag this score in it to save it. Then, start with another progression. Do that 
until you can do it easily, without having to search too long. 

• The following exercise consists in creating a melody on a separate staff. Open 
Score 2. For several chords progressions, do the following operations: 

 Drag a chord folder into the last staff, first measure. Drag also the whole note rhythm. 
The chords appear. 

 Using half notes or whole notes, create a melody based on the chords notes. Place these 
notes in the upper staff. Take all the advices given above to create melodies. Take care to 
separate the pitches from the two melodies, so that they are quite distinct while listening. 
Be guided by the sound result and correct so that you like it. 

• Same exercise, but this time using Score 3, which contains staves to create 2 simultaneous melodies. 
Take care to use different notes for the two melodies. You can use different rhythms (2 half noted for 
the first and a whole note for the other). Use only the chord notes. Once the 2 melodies are created, 
erase the bottom chords and listen to the result. 

• Same exercise, but with Score 4, which contains staves to create 3 melodies. Take care to distribute 
the notes between the melodies. Take care to separate the pitches from the various melodies (a lower 
melody, a middle one and an upper one). Once the exercise is finished with a progression, erase the 
chords and listen to the result. As there are three different voices, you will be able to hear the chord 
effect, but this time, it is distributed on 3 different instruments. 

• Same exercise, but with Score 5 which contains 4 staves for melodies. Use the 4 sounds chords 
progressions. 

• It usually happens that a melody uses other notes than those of the current chord. These notes are 
called passing notes. They give more freedom to the melodies by going from one note of the chord to 
the other. These notes are used as a transition and are not heard a very long time (eighth notes or 
quarter notes in our exercises). Do the previous exercises again but by using some passing notes. 
Especially place them on the second and the fourth beat of the measure and use quarter notes or 
eighth notes as rhythmic values. You will notice that they enrich the melody. 

• Do the four preceding exercises again by using different rhythms. Use rhythmic cells among: 

 4 quarter notes, 
 1 half note + 2 quarter notes, 
 1 dotted half note + 1 quarter note, 
 1 half note + 1 quarter note + 2 eighth notes, 
 3 quarter notes + 2 eighth notes, 
 2 quarter notes + 4 eighth notes. 

You can use passing notes. You can also imagine other rhythms and use them.

• Until now, we used one chord per measure. Remember that we had associated a whole note duration 
with the chords. Take one of the progressions and modify its options to associate it with one half 
note. Create then a rhythmic cell with a half note repeated ad infinitum and drag it into Score 5, on 
the last staff (first measure). The chords appear in half notes. By holding down the SHIFT key, 
double-click on the progression. You get the dialog box allowing to specify for each chord the 
duration in multiples of half notes. Modify some progressions in this manner. Use shorter durations 
for degrees II, III, VI and VII and longer durations for degrees I, V and IV. Then, you can do the 
preceding exercises again. 

Each element added to the exercise will give you more freedom of expression. One can imagine lots of 
exercises to develop the composition technique. The chords, the melodies, the rhythms or sonorities all can 
be used as a starting point for musical inspiration. There are often one or two elements which form the 
beginning of a musical idea. By singing some notes and you find that they sound very well. You encode this 
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small melody and try to find which rhythm could reinforce it, which chords could support it and which 
instruments could make it more expressive. Step by step, you work out the score, you structure it, you repeat 
several times the main theme with different instruments families and various accompaniments, you introduce 
secondary themes which are related to the main theme, etc. This is called the development of a musical idea. 
Most traditional repertory works are based on such developments of a starting idea.

Generating melodies using libraries

When you have a chord progression, you can find rhythms and melodies elements in the Melodies  
library.piz and Rhythms library 44.piz documents . Here are the steps to help you exploit them to compose 
musical scores and accompaniments:

• Determine a set of instruments to express yourself. It can be one or two instruments or even a whole 
symphonic orchestra. Start nevertheless with a small number of instruments. Create the score starting 
from the orchestra or light music templates and add the necessary measures. 

• Drag a chord progression into staff 1, measure 1. In the libraries options, specify that the chords 
progression is in the first staff. 

• For one instrument at a time, select rhythmic cells and drag them into the instrument measures. Add 
the melodies element. Generate the score if it is not automatic and listen to the sound result. Correct 
and modify the library elements in order to orient the style. 

• Take care to keep a good coherence between the instruments. All rules expressed in this lesson stay 
valid. You orient the musical libraries to get coherence. 

• Modify the options of the Pizzicato library elements. Create new elements. Try out many different 
possibilities and you will end up to discover very rich and pleasant structures. You will be able to 
find ideas of melodies and rhythms. Then, use what you learned in this lesson and the preceding one 
to develop the interesting elements. 

Instrumentation and effects

The choice of the instruments very much affects the sound result of a score. With the instruments view, you 
have a very easy tool to try sonorities. You can play a passage and test various sounds of instruments to 
locate the one which sounds best.

Also exploit an equilibrium of sound volumes. The instruments view provides a configuration where you can 
separately regulate volumes, balances (right/left position), reverberation as well as other effects. Use them to 
enrich the instrumentation.

Also use the nuances symbols (F, FF, p, MF, cresc., decresc…) to create intensity contrasts. Modify 
sometimes the tempo according to what you want to express. Use the various tools palette.

General rules of composition

Here are a series of practical tips that you can use to compose.

• Above all, your music must communicate something. That can be an emotion, an impression, an 
atmosphere, a hope, love, an idea, an object… It does not matter what it is, but it is you who 
communicates with your public, thanks to your music. Art is communication. If you do not have 
anything to communicate to your listener, then the composition will remain a simple theoretical 
exercise without any purpose. It is your communication which must remain the master and the 
composition techniques must be the servant. To do the opposite is to put the plough before the oxen. 
When your desire to communicate inspires a sound effect which transmits it to your satisfaction, use 
it, it does not matter how many rules this effect breaks. To this end, we advise you to practice the 
following exercise regularly: 

 Find or invent something to communicate. That can be almost anything. Take the most 
banal or most original ideas and write on paper in some sentences what you want to 
express. That can be "today is all right and the small birds are singing" or "my cat has just 
made a very elegant jump. I would like to express this jump in a musical form" or 
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"holidays on the beach, I will remember and express it in music". You can also take 
emotions and express them through a musical score. Take for example: apathy, sorrow, 
fear, anger, trouble, interest, enthusiasm, joy, serenity. You can also take two emotions 
(negative and positive) and compose a score which expresses a progressive transition 
between the two. There is an infinity of things which you can communicate with music. 
Also think about the public or the people to whom you would like to communicate this 
message. If you want to communicate something to young children, adults or teenagers, 
the implemented means of expression will be very different. So that your message goes 
through, you will need to take into account the reality of your public's way of life. 

 With your subject and your public well in mind, seek an element which expresses this 
message. It can be a rhythmic cell, one or more chords, a melody, an instrument sound,… 
To find it, no mathematical formula exists. You can stimulate your inspiration by 
thinking about the subject and by testing various rhythms, sonorities, melodies, chords or 
all combinations of these elements. 

 Be free especially do not destroy your ideas before even expressing them. A reasoning of 
the kind "Perhaps this rhythm will express this very well and…, oh no, nobody will 
understand it anyway and they will believe that I am hopeless in music and… bla, bla, 
bla" will only make you stop composition. 

 It is probably the most current barrier for a person who begins in art. The fear of being 
ridiculous, of looking clumsy or not "talented" prevents many people from starting out in 
art. Do not hesitate to express yourself, even in a clumsy way at the beginning. It is 
normal and you should not be expected to create an extraordinary work after the first 
hours of composition (though it could arrive, you are perhaps more talented than you 
think…). With practice and perseverance, you will manage to express what you want. 
Nobody never published the first composition exercises of Mozart, Bach or Ravel. They 
also made their beginnings (and they did not have a computer…). 

 As soon as you have one or more elements expressing your message, use them and 
develop them. If the element is a rhythm, find which melody could reinforce the effect of 
this rhythm, while keeping the expression of your message. Seek the chords which could 
support it well. Test and listen to various sonorities of instruments. Build in this manner 
your score. At the beginning, do not make it too long (8 to 16 measures). Gradually, you 
will be able to increase the length, because a long development of an idea requires 
practice and a good control of the composition techniques. Develop the starting idea by 
keeping in mind your message and your public, which will increase the coherence of the 
all. 

• Constantly keep the interest of your listener awake, by the addition of new ideas, developments and 
changes. You can transpose a melody, a chords progression. It is a change, but which remains 
coherent with the original melody. You can slow down or accelerate the same rhythm, create a dialog 
between instruments of different sonorities, create melodies or rhythms repetitions, extend, move or 
narrow the range of instruments, use percussions, synchronize or oppose melodies… The total 
number of effects is really enormous and you need to let you go and test. 

• Make a coherent work. It is what makes your music organized. You need to establish links between 
most elements. These links can be for example : 

 a chords progression which harmonizes the melodies, 
 similar, opposed or inverted rhythms, 
 similar, opposed or inverted melodies, 
 chords, rhythms or melodies repetitions, 
 a synchronization or an opposition of various rhythms, 
 sound effects (percussions, synthesizers sounds…), 
 rhythms, melodies and sonorities which answer each others, 
 contrasts of intensity, rhythms, melodies or chords. 
 etc. 
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These links establish a coherence and obtain the agreement of your listener, because he can in 
some way predict it and it helps him to understand your music and to receive your message. By 
understanding your music and receiving your message, the listener will be able to like and 
appreciate your music according to his tastes.

• Create contrasts in the sound effects. A very strong passage is better highlighted if it is surrounded by 
very soft passages. A fast passage contrasts better if it is preceded by a slow passage. A melody 
appears better if it is followed or preceded by a rest. You can still find many other examples of this 
kind. By creating contrasts, you maintain the interest of the listener and you can highlight elements in 
this manner. Take care that these contrasts have however a common link for the coherence of the 
score. 

• Balance the sound spectrum. If most of the instruments exploit the extent of the same octave, it is 
probable that the sound result will be rather muddled and the listener will not be able to distinguish 
the instruments. If you want to emphasize an instrument, take care that the other instruments do not 
play in the same range at the same time. Also contrast the sound spectrum of your instruments by 
creating answers between the instruments families and the different ranges. 

• At the beginning, voluntarily limit the number of elements in your compositions. Gradually, when 
you control some elements, add others. It is the idea behind this composition course exercises: start 
with little raw material, learn how to handle it and then increase the possibilities and be accustomed 
to them, etc. 

• By using the rhythms and melodies libraries, take care to personalize and sort out these elements so 
that they transmit your message. Do not expect the computer to do it for you. Composing is not 
simply to throw notes, rhythms and chords in a score. You need to organize these elements in a 
coherent set which transmits your message, and only you can do that. Good road and have fun! 

PS: Send us your compositions sometimes. We will be very happy to listen to what you composed with 
Pizzicato!

Composition tools - The smart link
• The composition tools 
• The smart link 
• The computed measure parameters 
• Note parameters 
• Rhythm parameters 
• Chords influence 
• Application example 
• Adding smart link templates 

 

The composition tools

This is the first lesson on the composition tools introduced by Pizzicato 3. It is an introduction to practical 
music composition tools.

The next lessons are reserved for Pizzicato Professional and Composition. They use the conductor view, 
which is only available in these versions. The conductor view is a musical desktop on which you can manage 
several scores, virtual music keyboards, instrument definitions and groups of scores that may be played 
together to build a music composition. It is a powerful setup to compose music, for light music, ethnic 
music, orchestral music, contemporary music or any other music style.
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The difference between notation software tools and composition tools is that the later will provide ways and 
means to help you to answer the questions regarding what rhythms, what notes, what chords will be used in 
the music. Those tools will help you to arrange, organize, develop and implement your musical ideas into 
full score music composition.

Don't think that the computer will compose for you. This would be silly because a computer is not able to 
create. It can only combine the data it has by following the instructions it receives, and this it does very well 
and fast. So YOU are the composer and Pizzicato is your helper to execute what YOU want him to do. If you 
try to find a push-this-button-and-get-a-nice-composition software, Pizzicato is not the software you need. 
So you will have to work, create and imagine!

The first version of the composition tools was implemented in Pizzicato version 1, in 1995. You may find 
this system in the lessons on Composition Libraries (1) to (6) in this manual. Pizzicato 3 has kept the same 
basic principle but has made a much more user friendly interface to use them. Also, several new concepts 
and tools have been added to the original version so as to make it even more powerful and easy to use.

The basic principle is that music can be broken down into the following simple items : rhythms, melodies, 
chords and effects. Any music composition could be constructed on those basic building blocks. Music 
becomes a construction game, using simple building blocks to create structures and assemble those 
structures into more complex structures and into music compositions.

The first step is explained in this lesson : the tool that lets you combine those items together to build a 
structure. It is the first level of construction. You will learn how rhythms, melodies and chords may be 
combined, as though they were bricks to assemble with mortar. This tool is called the smart link.

The smart link

The smart link lets you take rhythmic values found somewhere in a score, melodic values found anywhere 
else in the score, chords in even another set of measures and combine them all into one or more measures. 
For Pizzicato Professional and Composition, the three items (rhythm, melody and chord) may even come 
from different scores (but all inside the same document).

It is like a mixer you can feed with rhythms, melodies and chords. The resulting music is a set of measures 
called computed measures.

We have seen that a measure may have one or more versions and that at any time, only one version of the 
measure is visible and active. In addition to that, a measure may also have a special version called a 
computed version. By default, the computed version is not present, but the use of the smart link function will 
automatically add a computed version to the measures as needed.

Any measure may become a computed measure. It will then memorize the resulting computed content in the 
computed version of the measure, in addition to its normal content and versions (which will always remain 
untouched).

The important point to understand with a smart link is that the original source of rhythms, melodies and 
chords stay connected to the resulting computed measures. A change in any one of the source components 
may affect the computed measures. It is like a spreadsheet: a cell may be recomputed when another cell - to 
which it is related - is modified. Let us explain this with some examples.

• Open the example Ex080. It contains a simple scale that we will use as a simple melody example: 

• The smart link can be seen as similar to the paste function. You must first select and copy one or 
more measures and then smart link them on another set of measure (or on itself). Select the two 
above measures and copy them (Edit, Copy menu). Then select the third measure of the staff and 
choose the Edit, Smart link... menu. Its shortcut keyboard is CTRL + B (on Mac, apple key+B). The 
following dialog appears: 
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• This dialog contains several templates of smart links. These templates may be used very easily. Let 
us try the template named Exact copy x 2. This link creates two duplicates of the selected measures. 
Click this template and then click on Paste. The score becomes: 

• You can see that the melody has been copied two times, exactly duplicating the original melody and 
starting from the smart link target measure (the measure that was selected before calling the smart 
link dialog). You may also notice that the computed measures have their backgrounds colored. This 
is used to recognize that a measure is displaying its computed version in place of its current normal 
version. We will see a little further why two different colors are used. The original version of these 
four measures were empty. You can easily switch between normal and computed versions of the 
score by using the C check box located in the tool bar of the score : 

• Click two times on this check box and the score displays the normal versions for all measures. The 
computed measures are invisible but they still exist. Click again on this check box to see the 
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computed versions. This check box is checked when its last use was to display the computed 
versions. As you add other smart links into the score, or as you manage the parameters of the 
computed measures (as we will explain further), the score may display only some of the computed 
measures. This check box is then used to synchronize the display (all computed measures or all 
normal versions). When you ask to display the computed version for a measure that has no computed 
version (as the first two measures of the score), Pizzicato displays its normal version instead. 

• Now modify the first original measure to have: 

• As measures 3 to 6 are smart links (exact copies) of the first two measures, you may ask Pizzicato to 
update the computed versions of the score to take into account the changes made in the original 
measures. Select the Edit, Update smart links menu. Its shortcut is CTRL+R (apple key + R on Mac). 
The score now displays the updated computed measures: 

Notice that you may edit the computed measure content, but whenever you ask Pizzicato to 
update them, the change you made will be overwritten by the updated computed version. This 
simple melody could have been 16 measures long and be smart linked fifty times through all 
instruments of a full orchestral score. Pizzicato would have updated the full score from the 
changes you made in the original theme. Quite practical to test some changes in a score.

• Copy again the first two measures and smart link them into the first measure of staff 2. In the dialog, 
select Time flexible copy. Two parameters appear in the right part of the dialog. Fill in the Rhythm 
duration division text box with "2". All rhythm durations will be divided by 2. Click on Paste and the 
score becomes: 

The melody is now two times faster with the same notes. The smart link is not only a copy of the 
melody but also contains several transformation parameters that may affect the content of the 
measures. Here is a brief explanation of the various templates proposed in the smart link dialog 
box:

• The first four templates are copies of the original measures (1, 2, 3 and 4 times). 
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• The Multiple exact copy takes two parameters : the number of times the rhythms and the 
notes are duplicated. 

• We have seen the Time flexible copy that may be used to multiply/divide the rhythmic 
values. 

• The next 6 templates have fixed transposition values. They transpose the notes of the 
original measures. 

• The General transposition template lets you select the transposition interval, its type and 
an additional octave transposition. 

• The Copy with rhythm inversion takes the notes in the original order but the rhythms in 
the reverted order. 

• The Copy with note inversion takes the notes in the reverted order and the rhythm in the 
original order. This would give for our example: 

• The next template takes both rhythms and notes in the reverted order. 
• The Random copy randomizes the rhythms and notes to have a new melody based on the 

notes and rhythmic values found in the original melody. 
• The next template, General copy combining rhythms and/or notes contains several 

parameters to create a copy with multiple options. We will explain each parameter in the 
next chapter. 

• The next template gives you the opportunity to use a mirror copy based on notes and/or 
rhythms. One example with our melody would be the diatonic mirror copy based on the C 
note (mirror reference): 

• The next template lets you arrange the notes of a melody on chords. 
• The Coppy of rhythms only copies the rhythmic values of the source measures. Used 

alone, the resulting computed measure is empty, because a measure needs at least 
rhythms and notes to display something. It can be used in combination with the following 
template. 

• The Copy of notes only copies the note values of the source measures. Used in 
combination with the previous option, you may copy the rhythmic values of one measure 
and combine them with note values from another measure. We will see an example of 
this at the end of this lesson. 

• The next template lets you arrange and transpose notes based on a chord. 

The computed measure parameters

Behind the smart link function, there is a series of parameters attached to the target measure. They determine 
how the smart link must be computed. Each template found in the smart link dialog is in fact a predefined set 
of these parameters, with some of them being available in the right part of the dialog.
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Applying a smart link to a measure attaches all these parameters to the first target measure. Those 
parameters are available at any time from the measure itself. They may also be added to a measure without 
the application of the smart link dialog. To access these parameters, click with the right button on a measure 
(without selecting a measure) and choose the Smart link parameters... menu. The following dialog box 
appears:

These parameters are divided into three sections : notes, rhythms and chords. We will explain them by 
section in the rest of this lesson.

When you validate the dialog, the parameters are attached to the measure. If you click on Delete, the 
parameters are removed from the measure.

These parameters are attached to one measure, but they may affect several measures that follow it. When 
displaying the computed versions of the score, Pizzicato draws a different background color for the measures 
that contain computing parameters, as seen in the beginning of this lesson. You can then easily differentiate 
computed versions with computing parameters and computed versions which are only affected by the 
parameters of a previous measure.

There are basically three sources that are combined to create the computed measures. Each source is 
independantly extracted from same or different measures and recombined to form the computed measure. 
These sources are the notes, the rhythms and the chords.

As the three sources may contain several measures, the resulting notes may fill much more than the current 
measure. To the right of the dialog box, a parameter entitled Number of affected measures may limit the 
number of measures that will be affected by the computation. If this parameter is "1", then this measure will 
only affect its own computed version. If this parameter is "2", then it will also affect the next measure 
computed version, and so on.

Note parameters

The note parameters affect only the pitch of the note but not its rhytmic value.

• The first four menus determine the first source measure from which the notes will be extracted to 
create the computed version. In case of multiple scores inside the same document (Pizzicato 
Professional only), you may select the source score for notes. The second menu determines the 
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source staff inside the score and the third determines the measure number. With the last menu, you 
may select the version of the measure, if the measure contains more than one version. 

• The box entitled Number of measures used determines how many measures will be used as the source 
for notes. 

• The box entitled Number of notes used may be filled to limit the number of notes. If equal to zero, 
there will be no limit: all notes of the measures will be used. 

• The next box, entitled Limit the number of notes to may be used to limit the total number of notes 
generated in the resulting computed measures. When zero, no limit is imposed. 

• The box entitled Use each note ... time(s) may be used to use one note several times before going to 
the next note. If notes are C, D and F and this box contains 3, the sequence will be 
C,C,C,D,D,D,F,F,F. 

• The box entitled Use all notes ... time(s) determines how many times the all set of notes will be used. 
If notes are C, D and F and this box contains 3, the sequence will be C,D,F,C,D,F,C,D,F. The effect 
is not the same as the previous parameter. 

• The Sequence menu will determine the order in which notes are used. Three choices are possible: 
Ordered, Inverted and Random. In the last case, notes are picked up randomly in the set of notes to 
build the computed version of measures. 

• The Melodic mirror menu is used to create an effect similar to the use of an horizontal mirror: each 
note is reflected in this mirror and is replaced by the note which is at the same distance from the 
mirror but at the other side of it. The mirror reference note may be defined with the Select... button 
which displays a keyboard where you can click the reference note. The mirror may be Diatonic - 
which means that the interval is taken into account but not the real number of half tones - or 
chromatic - the notes are mirrored according to the number of half tones from the mirror. In the first 
case, the melody will easily fit in the same tonality but with chromatic mirror, the melody could have 
accidentals and change tonality. 

• The last three menus may define a transposition that can be applied to the notes. 

All these parameters may be used separately or may be combined. The resulting series of notes will then be 
combined to the resulting series of rhythmic values, as we will now explain.

Rhythm parameters

The rhythm parameters do not affect the pitch of notes but only their rhytmic values.

• The first four menus determine the first source measure from which the rhythmic values will be 
extracted to create the computed version. In case of multiple scores inside the same document 
(Pizzicato Professional only), you may select the source score for notes. The second menu determines 
the source staff inside the score and the third determines the measure number. With the last menu, 
you may select the version of the measure, if the measure contains more than one version. 

• The box entitled Number of measures used determines how many measures will be used as the source 
for rhythms. 

• The box entitled Number of rhythms used may be filled to limit the number of rhythmic values. If 
equal to zero, there will be no limit: all rhythmic values of the measures will be used. 

• The next box, entitled Limit the number of rhythms to may be used to limit the total number of 
rhythms generated in the resulting computed measures. When zero, no limit is imposed. 

• The box entitled Use each rhythm ... time(s) may be filled to use the same rhythmic value several 
times before going to the next one. If rhythms are 4 (Quarter note), 8 (8th note) and 16 (16th note) 
and if this box contains 3, the sequence of rhythmic values will be 4,4,4,8,8,8,16,16,16. 

• The box entitled Use all rhythms ... time(s) determines how many times the all set of rhythms will be 
used. If rhythms are 4 (Quarter note), 8 (8th note) and 16 (16th note) and if this box contains 3, the 
sequence of rhythmic values will be 4,8,16,4,8,16,4,8,16. 
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• The Sequence menu will determine the order in which rhythmic values are used. Three choices are 
possible: Ordered, Inverted and Random. In the last case, rhythmic values are picked up randomly in 
the set of values to build the computed version of measures. 

• Two text boxes let you multiply and/or divide the duration of all rhythmic values. This makes the 
melody slower of faster in relation to the main tempo of the score. 

• The Rhythmic mirror check box is used to create an effect similar to the note mirror. Here the choice 
is made between the standard rhythmic values: whole note, half note, quarter note,... A rhythmic 
value is selected as the reference value and all rhythmic values are mirrored against this value. For 
instance, if the reference is the quarter note, a whole note will become a 16th note and an half note 
will become an 8th note. 

All these parameters may be used separately or combined. The resulting series of rhythmic values will then 
be combined one by one to the resulting series of notes.

Chords influence

Additionally to the various parameters that affect the notes, the melody may also be adapted to fit a given 
chord progression.

• The first two menus determine the location of the chord progression. Remember that you may create 
a chord progression in any score (see the lesson on chord symbols and chord progressions). If the 
first menu is set on --- Current chord ---, the melody will be influenced by the chords present in the 
target measure. If you select another staff (Pizzicato Professional), you may then specify the first 
measure containing the chords you want to use. 

• The following text box specifies how many measures you want to include as a source for chords. 

• The Influence menu determines how notes will be modified to fit the chords. The default choice 
specifies No influence. The Arrange choice means that each note will be compared to the current 
chord. If the note is one of the chord notes, it is not changed. If the note is not included in the chord 
notes, then it is replaced by a note of the chord that is the closest to the original note. In this way, a 
melody will be arranged to fit the chord. The Transpose choice is different. The original note will be 
considered to be a note in relation to the C Maj chord. It will then be transposed in the current chord, 
in the same relative position. It is mainly used for bass instruments. As an example, if the sequence of 
note is C,D,G and if the chord is D Maj, then the notes will become D,E,A which in D Maj are 
degrees I, II and V like C,D,G are in C Maj. The next choice cumulates both effects. The Smart  
arranging choice is reserved for the score arranger and will be explained in a specific lesson. 

• The Minimal duration to arrange specifies a rhythmic value in units (1 quarter note equals 480 
units). If the original rhythmic value is less than this value, the note is left untouched. This option can 
be used to enable fast notes to be left untouched. Otherwise, an arranged melody would become too 
monotonous by using only the notes of the chords. 

Application example

As the above parameters may combine each one with the others and as the source measures may contain 
practically anything that can be written in music notation, the number of possibilites offered by this system 
are numerous. You will need to make your own experiments and use your imagination to be creative with it. 
Here is a detailed example of application where we will create a random melody, with some given notes and 
rhythms and we will arrange it based on a given chord progression.

• Open the Ex081 example document. The lower system contains the music material we will use, in 
measures 6 to 8: 
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For the main melody, we will randomly use the notes of measures 6 and 7 and the rhythm pattern 
of measure 8. We will structure our score on the upper system, considering the lower system as a 
scratch pad where we prepare the notes and rhythms we need.

• With the right mouse button, click on the first measure of the first system and select the Smart link  
parameters... menu. The computed measure parameters dialog box appears. 

• For the note parameters: 

• Select measure 6 / 8 as the first measure of the notes to use. 
• Set the Number of measures to use to "2" (we want to use measures 6 and 7, starting at 6). 
• Set the Sequence menu to Random because we want the notes of our melody to be made 

of randomly choosen notes from measures 6 and 7. 

• For the rhythm parameters: 

• Select the last measure 8 / 8 as the first measure of the rhythms to use. Measure 8 
contains the rhythm pattern we want our melody to use. 

• If we keep it like this, the rhythms will only be used one time. We want 4 measures so we 
set to "4" the Use all rhythms ... time(s) text box. 

• For the chords parameters: 

• There are 4 chords in this score. They start on measure 1. We need to use the chords on 4 
measures, so we put the Number of measures used to "4". 

• Set the Influence menu on Arrange which means that the notes will be adjusted so they 
are all part of the current chord. 

• Finally, as we need computed versions for 4 measures, we set the Number of affected measures to 
"4". Click on OK and the upper system staff becomes for instance: 

We say "for instance", because as the notes are randomly selected, the melody may look totally 
different on your computer. In fact, each time you ask Pizzicato to update the measures 
(CTRL/Apple key + R), a new melody is generated. Try it a few times. In all instances and 
according to the options we have selected, you will notice that:
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• The rhythm is always the same, it is based on the rhythmic content of measure 8. 
• The notes inside a measure are all contained in the chord mentioned just above the staff. 

This is because we asked the notes to be arranged on the chords. 

If needed you may call the computed measure parameters dialog to modify the selected options. 
It is attached to measure 1, which has a different color background compared to measures 2 to 4 
(those computed versions are the result of the parameters assigned to measure 1, but measures 2 
to 4 do not contain parameters).

We will now create the second staff content, based on measure 6, staff 2. This measure will be used 4 times 
and will be arranged on the chords.

• With the right mouse button, click on the measure 1 of staff 2 and select the Smart link parameters... 
menu. The computed measure parameters dialog box appears. 

• For the note parameters: 

• Select measure 6 / 8 as the first measure of the notes to use. 
• Set the Use all notes to "4" so as to cover 4 measures. 

• For the rhythm parameters: 

• Select measure 6 / 8 as the first measure of the rhythms to use. 
• Set the Use all rhythms to "4" so as to cover 4 measures. 

• For the chords parameters: 

• There are 4 chords in this score. They start on measure 1. We need to use the chords on 4 
measures, so we put the Number of measures used to "4". 

• Set the Influence menu on Arrange which means that the notes will be adjusted so they 
are all part of the current chord. 

• Finally, as we need computed versions for 4 measures, we set the Number of affected measures to 
"4". Click on OK and the upper system staff becomes: 

As no random option was selected, the second staff is unequivocally determined.

We will now create the third staff content, based on measure 6, staff 3. This measure will be used 4 times 
and will use the chords.

• With the right mouse button, click on the measure 1 of staff 3 and select the Smart link parameters... 
menu. The computed measure parameters dialog box appears again. 

• For the note parameters: 

• Select measure 6 / 8 as the first measure of the notes to use. 
• Set the Use all notes to "4" so as to cover 4 measures. 

• For the rhythm parameters: 

• Select measure 6 / 8 as the first measure of the rhythms to use. 
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• Set the Use all rhythms to "4" so as to cover 4 measures. 

• For the chords parameters: 

• Set the Number of measures used to "4". 
• Set the Influence menu on Arrange. 

• Finally, set the Number of affected measures to "4". Click on OK and the upper system staff 
becomes: 

• You may now do the same for the last staff. Use measure 6 of staff 4 as the source of the bass 
melody, but in the Influence menu, select Transpose and you will get: 

This example gives you one possible application. There are lots of possible combinations for the smart link 
function.

For Pizzicato Professional, this function may be combined to the features of the conductor view, which will 
give you a music destkop composition to create, arrange your musical compositions.

Two additional items have been added in the Edit menu since release 3.2 You can use them for the full score 
(if there is no selection) or for a selection of measures:

• Fix smart links - This menu copies the computed versions of the selected measures (or all measures if 
none are selected) into the original measures and then removes the computed versions. The result is 
that you have one normal score with the final computed version. 

• Remove smart links - This menu removes the parameters and computed versions of the score so that 
only the original measures are kept. 
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Adding smart link templates

In this lesson, we have first introduced the smart link dialog box, explaining a series of predefined functions. 
Then we have explained the various parameters that may affect the computed version of a measure.

A predifined function is a simplified set of prepared parameters, extracted from the full set of parameters. It 
offers an easy way to execute a specific functionality out of the full set of possibilites. You may add new 
templates to the list so that you can use them when working your music compositions. The following 
explanation is for the advanced user who wants to make a full use of this function.

• Call the smart link dialog, as we did in the beginning of this lesson (copy one measure and select the 
Edit, Smart link... menu). Select the Time flexible copy item. It has two visible parameters: 

• Click on the Modify... button. The following dialog appears: 

The right list contains all the parameters that will be used when this predefined function will be 
applied on a measure. By clicking on one of them, the parameters appears to the right and you 
may set its value. A check box also appears to enable/disable the modification of this parameter 
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when you use this template. The name of the template may be modified in the bottom right part 
of the dialog.

• Click on the Rhythm duration multiplication parameter. To the right, the next items appear: 

The default value is "1" and the parameter will appear so that you may modify it when calling 
the template.

• Click on Cancel, select the Copy of notes template and click on Modify... The dialog now displays: 

In this case, only a part of the parameters are used. The left list parameters are left untouched in 
the target measure, so that you may combine this smart link with another one (Copy of rhythms 
for instance). This means that you may apply multiple smart links on the same target measure, 
providing that they do not transfer the same parameters. If they transfer the same parameter, the 
last applied smart link parameter will overwrite the first and will be used. Click on Cancel.

You may explore the various templates and see what default parameters they use.

To create a new template, click on Add and the dialog appears. Decide which parameters must be used (use 
the middle buttons to transfer parameters from one list to the other), their default values and if they may be 
modified when calling the smart link function. Give a name to your template and click on OK. You may also 
select an existing template and click on Duplicate. A template is created that duplicates the current template. 
You may then change its name and modify it.

Composition tools - The conductor view
• The conductor view 
• Using the conductor view 
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• Playing and grouping scores 

The conductor view

The conductor view has been designed to be your music composition desktop. As you may have several 
scores in a music document (Pizzicato Professional only), there must be a tool to organize and manage them 
and to play them easily and in many combinations. This tool is the conductor view.

To work with the conductor view and so that the lessons happen as they should, we strongly advise you to 
switch on the menu option found in Windows, Windows management, Based on the conductor view. This 
mode is oriented around the conductor view and the examples and applications of the following lessons will 
behave the way they should. The other two modes have a different way to handle the windows behaviour.

• Start Pizzicato or close any open document and choose File, New. Pizzicato opens the conductor 
view. If you did not modify the windows management option as explained here above, you may open 
the conductor view by using the Windows, Conductor... menu. The following window appears: 

This window is divided in two parts:

• The left part is the document manager and its configurations. You can get a full 
explanation in the lesson about the document manager. Its various configuration contain 
items representing instruments, music libraries and virtual keyboards as well as other 
musical objects that may be used to compose music. Each one of them will help you to 
compose and will be the subject of a specific lesson. 

• In the main part of the window, you have a time scaled view of all the scores present in 
the document. This area is where you will add, remove, play and manipulate music 
scores. Its predecessor was the main view (still available). However, the conductor view 
has much more features to make your work more easy and it adds the time dimension of 
the scores. 

This view has some particularities compared to other views :

• There is only one conductor view for each open document. 

• When you open several conductor views (from different documents), they will resize themselves 
automatically to cover your screen so that you have an overall view of the open documents and their 
content. 
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The rest of this lesson will explain how to use the main area of the conductor view.

• The large orange rectangle represents one score named Score 1. Double-click inside this rectangle. 
The score appears above the conductor view. You will notice that a view that is called from the 
conductor view will always stay on top of it. As the conductor view covers the full screen, if it was 
not so the score view would go behind the conductor view whenever you would use the conductor 
view again. Close this score view now. 

• With the right mouse, click on the orange rectangle. A context menu appears with several items: 

• The first 8 items may be used to open a view of the score from which you call this menu. 
The first one calls the score view, which has the same effect as a double-click. 

• The Play options... item calls the play options dialog box associated with the score. It is 
the same dialog that is called from the score view with the "..." button. You may change 
the tempo, the measures to play, the metronome,... 

• The Change name... item lets you change the name of the score, which is here Score 1. 
The name of a score is displayed just on top of the orange rectangle. 

• The next item lets you duplicate a score inside the document. You get a new independent 
score which is an exact copy of the original. You may then modify it as you want without 
affecting the original score. 

• With the next item, you can create an alias of the score. An alias of a score looks like a 
copy of the score, but it has in fact the same content. It appears to be an independent 
score in the conductor view because you can move its rectangle without moving the 
original one. If you double-click it, you open in fact the original score. A score may have 
as many aliases as you want. The use of aliases will become more clear in the lesson on 
musical libraries. Basically, you will be able to organize a music composition by 
combining several scores and playing them together in the conductor view. If a score 
represents a percussion rhythmic pattern, you may need to use this score several times in 
your composition. If you duplicate the original score several times, the copies will be 
independent. If you decide to change the pattern, you will need to change them in each 
instance of the score. The other solution is to create one pattern and then make several 
aliases of it. The change in the original score will then be effective in each instance of its 
aliases. An alias score may be recognized by its name written in italic. 
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• The next menu item is used to delete the score. If the score is an alias, the alias disappear 
without confirmation, but if you delete an original score, Pizzicato ask for confirmation 
before deleting the score (this may not be undone). 

• The next 4 items gives you a fast way to add measures to a score without opening it. The 
measures are added to the end of the score. 

• The last menu item is used to add an audio track to the score. See the lesson on audio 
tracks later in the manual. 

The five icons that you notice on the upper left border of the orange rectangle are in fact 
shortcuts to the most useful of the above menu items. With a simple click on these icons, you 
can:

• Icon 1 (little note): open the score view 
• Icon 2 (sliders): open the instruments window with the sliders to control volume, 

reverberation,... 
• Icon 3 ("+" on white background): create a duplicate of the score 
• Icon 4 ("+" on yellow background): create an alias of the score 
• Icon 5 ("x"): delete the score with a confirmation. If you also hold down the CTRL key, 

the score is deleted without the need of a confirmation. 

Some of the above options can also be reached in the document manager. You can use both of them 
indifferently.

Let us apply this with some examples.

Using the conductor view

In the conductor view, a score is represented by a colored rectangle. The numbers in the upper part of the 
main area show the measure numbers of the score. Vertical lines separate the measures through the main 
area of the conductor view.

• Set the mouse position as follows: 

• Click with the right button and select the New score menu item. A new score appears: 
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It is called Score 2 and its name is written in black. The active score title is displayed in red. Up 
to now, there was only one score and by default it was the active score.

• Click on the Score 2 rectangle: 

• Its name becomes red, meaning that it is now the current score. The other score name is now in black. 
There may be only one score active in the conductor view. To set the active score, just click on it. 
You will also notice that the upper scale has moved. It is now displaying the measure numbers of 
Score 2. The new score has only one measure, but the scale continues after the last measure. 

• By clicking on a score and moving the mouse while holding down the mouse button, the score may 
be moved inside the conductor view. In this way, you may dispose them to organize your music 
document as you wish. 

• Double-click Score 2 and fill in the measure to have: 

• Close this window. Use the recorder displayed in the conductor view to play this score. A black 
triangle follows the position of the playing in the conductor view: 

When you use the recorder of the conductor view, it is the active score (with name in red) that is 
played.

• The H- and H+ buttons located to the left of the recorder may be used to horizontally zoom in and 
out. The main area shows more or less measures and lets you work more precisely or with an overall 
view of many measures. 

Playing and grouping scores

The conductor view lets you play a score by selecting it and using the recorder. But you may also group 
different scores and play them together. Here is a simple example to show you how this view will help you 
compose and create music like a construction set game.

• Close the previous document and open the Ex082 example. You can find it in the document manager, 
configuration 2, in the examples folder. Open the conductor view by double-clicking the green icon 
of the example, which contains 3 scores: 
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• Listen to each one of them, one after the other. Also double-click and close them one after the other 
to see the score they contain. Each one has a different color. In the lesson on instruments, we will see 
that each instrument has a color code used to classify them more easily. We will now assemble the 
scores so that they may combine to create a little piece of music. 

• A little bit below the first score, click the desktop background with the right mouse button. Select the 
menu item entitled New group of scores. In the next dialog, enter the name My composition and click 
on OK: 

This new block is a group of scores. It may have four coloured squares in its top part. We will 
explain them further in this lesson. The group is now empty and we will drag scores into it.

• With the mouse, drag the Acoustic bass score into My composition and release the mouse button 
when the conductor view displays the following: 

• Resize the group vertically by dragging its bottom right corner so as to have: 

• With the mouse, drag the Rock - Rhythm score to have: 
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• Do the same with the last score, so that the group will become: 

• Notice that the group has been resized horizontally so that it can contain the last score. The title of 
the group is displayed in red to show that it is the active group. Click on the START button of the 
recorder. The full score group plays, showing the progression of the group and of the individual 
scores with moving triangles: 

• You may ask a group to play in an infinite loop. Click the group (not in a score, but in the blue part of 
it) with the right mouse button and select the Play in loop menu. If you display the menu again, you 
will see that this menu item is now checked: 
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• Start playing the group again. At the end of it, Pizzicato goes back to the beginning. To stop it, use 
the STOP button of the recorder or the space bar of the keyboard. 

• We would like to use the Arpeggio 2 score two times. With the right mouse button, click on it and 
select the Play options... menu. The lower part of the dialog displays parameters that influence the 
playing of the score inside a group (Special play parameters) : 

• In the third text box, enter "2" so that this score will be used two times. Close this dialog. The group 
now displays: 

The group has been resized automatically. You can see that the Arpeggio 2 score now displays 4 
measures. But there is in fact only 2 measures in the score (if you double-click it, the score view 
only shows 2 measures). The real measures are displayed in the original color and the 
additionnal measures are displayed in a lighter color to show the full duration of the score, taking 
into account the number of loops of the score.

Notice that if you drag the bottom right corner of the group while holding down the SHIFT key, 
any score that was reaching the right border of the group will be automatically multiplied to fit 
the new size of the group.

• You may also graphically determine how much times a score will be played. Click and drag to the 
right the bottom right corner of the Acoustic bass score, up to the moment it fills the entire group: 

• Play the group. If you now want to use the Rock - Rhythm score in the last measure, without filling 
measures 2 and 3, we can not just extend the score. There are two ways to do this. You may duplicate 
the score if you want to modify it in any way. The duplicated score will be completely independent of 
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the original score. Or you may create an alias of the score, in which case any change made to the 
original score will be automatically applied to the alias. Let us create an alias of this score, by 
clicking the score with the right mouse button and selecting Create an alias or by clicking on the "+" 
icon on yellow background. The group becomes: 

• You can now move this alias to position it at the fourth measure. The vertical position is not 
important, except for the presentation of the group. The alias is shown in the same color, but its name 
is written in italic: 

• You may notice that the score automatically adjust itself to the closest half beat, so that there will be 
no errors in positionning it. You may cancel this automatic grid by holding down the CTRL key 
while you drag the score (but the first click should be done without the CTRL key, because this has 
another meaning that will be explained in another lesson). Play the group again. In the playing 
parameters dialog box, there is also the time multiplication and division factors. Scores inside a group 
automatically play with the same tempo, but if the time factors are modified for one score, this score 
will then play using those factors. Call the dialog on the original Rock - Rhythm score and set the 
multiplication factor to "3" and the division factor to "2". Close the dialog. The group is now: 
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• The original score has been scaled to show its real duration with regard to the other scores. Play the 
group. You will hear that the measure rhythm is stretched in a 3/2 ratio. In this case, the effect is not 
especially wonderful. But it could be used to fit a free piano solo into a specific duration. You may 
also adjust this time factor manually by dragging the bottom right part of the score while holding 
down the SHIFT key. Stretch this score to cover two and a half measure. Notice that here also a grid 
adjusts the length of the score to the closest half beat. You may avoid this by holding down the 
CTRL key while moving. The group becomes: 

• In the play options dialog, a menu lets you select how versions of the measures will be played (the 
measures need to have more than one version for this). A group may be moved on the desktop, 
exactly as you move a score. The scores contained in it will move with it. When the group is active or 
when one of its scores is active, the upper scale displays the measure numbers of this group. They are 
based on the measures visible on the highest score of the group. When a group or one of its score is 
active, you can see a green arrow showing the beginning of it in the upper scale. This arrow has a 
vertical line attached to it. It shows the location at which the playing of the group will start. You can 
set this green arrow by clicking with the left mouse button inside the scale area. Click for instance at 
the beginning of measure 4, inside the white band showing the measure numbers. The conductor 
view displays: 

• Play the group. It will start at that point and will then loop again to that point when it reaches the end. 
The end point is by default the end of the group, but you may set a red arrow to determine another 
end point. Click with the right mouse button inside the measure number area, on the third beat of the 
fourth measure. Play the group and you will see that the loop is played between the green and red 
arrows: 
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You may change the position of the arrows while the group is playing. To remove the stop 
arrow, click it outside the group limits.

• The upper left border of the blue area may contain up to 4 coloured squares. The first and third are 
reserved for the real time arranger. We will come back to it in a specific lesson. The second square is 
active in red by default. It maintains the score group active all the time, even if you manipulate scores 
inside it. In such a way, by using the shortcut to play (space bar) it is always the full group that will 
play and not just the last selected score. By disabling this box (by clicking on it), it becomes gray and 
then by clicking on one of the score, it becomes red and active so that you can play just that score 
without the rest of the group. The green box is used to create a single full score that contains every 
individual score of the group. It is then quite useful to finalize the full arrangement. To use it, just 
click on the green box and drag to a free area of the music desktop and a new socre will be create at 
that place. You get for instance: 

We have explained here how to use the conductor view to arrange and dispose a music composition. Even if 
the example is very simple, it shows the mechanics of it. In the next lessons, we will explain the use of 
instruments, of the music generators and other music objects and also the use of music libraries in 
combination with what we have seen here. Be sure you understand this lesson before continuing to the next 
one.

Composition tools - Instruments
• Instruments 
• Using the instruments 
• Managing the musical objects 
• The instrument colors 

 

Instruments

The combination of rhythms, notes and chords will eventually be played by instruments, so it is useful to be 
able to manage and select instruments easily in a score. Up to now, this was done by using the instruments 
view, combined with the selection of a synthesizer driver. This is still in use, but with the conductor view, a 
series of functionalities have been added to ease the process of selecting instruments and creating new 
scores.

• Start Pizzicato and select configuration 3 of the document manager. You can observe the following: 
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This is called a tree. It starts from the upper item entitled Libraries which contains here one 
document named Instruments and templates and two folders named Music libraries and My 
library. The document is open and contains several sub-folders and one item named Template 1  
measure 4/4. It is a hierarchical musical object structure. In this lesson, we will explore the 
document entitled Instruments and templates.

• Some elements have a "+" sign just in front of them. This means that the element contains items 
and/or sub-folders. To explore it, click on the "+" sign and the element opens and displays its content. 

• When an element is open, it displays a "-" sign in front of it. You may click on this "-" sign to close it 
and hide its content when you are finished with it. The Basic instruments folder contains a series of 
sub-folders, each one grouping individual instruments of one family. Open the Strings sub-folder. It 
displays: 

• Each instrument is represented by a colored square, followed by its name. Here in the strings we have 
for instance the violin. Double click this instrument. The instrument specification dialog box opens, 
displaying all the parameters of this instrument: 
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This dialog defines all the specifications related to this instrument. Let us see this in details.

• The upper part of the dialog defines the normal range of the instrument. This is the set of 
notes that may be normally played by the instrument. The limits may be set by using the 
two sliders, which display the MIDI note number and the name of the note followed by 
the octave number (C 3 being the middle C of the piano keyboard). You may also left-
click the upper keyboard while holding down the CTRL key to set the lower note and 
right-click + CTRL to set the upper note. 

• In the General specifications, you may specify the title (label) used to display the 
instrument inside its folder and also the full name and short name used in the score. You 
may determine in which family the instrument should be classified as well as a note 
transposition value and an octave transposition (for transposing instruments only). 

• In the Notation specifications, you may decide what is the default clef to use with this 
instrument (click on the clef symbol to change it). By clicking inside the color box, the 
color selection dialog box lets you choose a color associated to the instrument. See 
further the color convention that has been used in this instrument library. You may also 
specify how many staves the instrument needs to be written and the number of staff lines 
needed (by default 5, except for percussion instruments). 

• The MIDI specifications define some of the MIDI parameters associated to the 
instrument. The default volume is defined, as well as the default position of the 
instrument in the left to right space of an orchestra (Pan slider, for Panoramic). Here for 
instance the violins are located to the left of the orchestra. The original synthesizer driver 
name from Pizzicato is specified, as well as the General MIDI equivalence if it exists. 
The instrument patch and bank controls may also be specified as well as the reference of 
the source synthesizer. The set of MIDI channels that may be used by the instrument may 
be selected from 1 to 16. These are more technical data related to MIDI and most users 
will not need to touch them because they are provided as a library in Pizzicato. 

• The frame labeled Synthesizer and sound used determines what sound of which installed 
synthesizer of your own MIDI setup will be used. This part may automatically adapted 
for the all library, as we will see further in this lesson. 
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• Click on Cancel and open the folder entitled Percussions. Open the folder named Individual  
instruments. It contains all individual standard General MIDI percussion instruments. Double click 
the instrument named Bass tom 1. You can see that there is only one note selected, which is the MIDI 
note to which the instrument is associated in General MIDI. Click now on the Percussion map...  
button. The following dialog appears: 

The upper keyboard is used to specify the original General MIDI note, i.e. the note that must be 
sent to the synthesizer in order to hear that instrument. The second keyboard is used to specify 
the note pitch that will be used on the staff when the note is written in music notation. If the note 
may be played using any written note, then no note specification must be defined in the second 
keyboard. This is done by clicking on the keyboard while holding down the SHIFT and CTRL 
key. The name is specified as well as the standard note head that should be used for this 
instrument. You may add/delete percussion instrument specifications with the Add and Delete 
button. They are added in the left list. Click on one of them to set its specifications.

• Click on Cancel and again on Cancel. Close the Individual instruments folder. Double click the 
instrument entitled GM - Toms and click on Percussion map... The same dialog appears, but here all 
tom instruments are defined on one staff, each one with its note pitch and written pitch specifications. 
Click on Cancel in both dialogs. 

You should know that this instrument library is not part of the document you have opened. It is saved in a 
specific document, inside the Pizzicato, DataEN, Libraries sub-folder. If you make any change in this 
library, it is automatically saved by Pizzicato. If at any time you want to go back to the original library, just 
reinstall the program, without uninstalling it. The original library will come back.

You should now explore the various instruments found in these folders, to orient yourself where to find what 
instrument. If you open instruments to see how they are defined, close the dialog with Cancel so that you 
will not modify the original library.

Using the instruments

For Pizzicato Notation, which does not contain the conductor view, the only way to use instruments is to 
drag them inside a score. For Pizzicato Professional and Composition, you can also drag them on the 
conductor view. Both cases are treated here.

There are several ways to use the instruments in combination with the conductor view. This section will 
explain how to do it.
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• The first obvious way to use an instrument is to drag it and drop it on the musical desktop (right part 
of the conductor view). Drag for instance the Violon instrument on the desktop. When you release the 
mouse button, a new score appears: 

If you open this score, you have:

The score contains one measure, with the name and correct clef, the number of staves and 
lines,... If you explore its associated instrument view settings, you will see that they have been 
initialized with the specifications of the instrument as seen before. This is an easy way to create a 
score with a given instrument and to add it to the musical desktop.

• Close the score view. You may also drag an instrument and drop it on an existing score rectangle on 
the desktop. The result of this action is that the instrument is added to the already existing 
instruments of the score. For instance, drag and drop the Double bass instrument on the Violin score 
rectangle. The rectangle becomes: 

The rectangle is now displaying two colors. In fact a score rectangle will display horizontal areas 
with the colors of the instruments it contains. The score is now:

• You may also drag an instrument directly inside an open score view. In this way, you can decide 
where the instrument will be inserted, depending on where you drop the instrument. If you drop it 
between two staves, it will be inserted between the two staves. If you drop it above the upper staff, it 
will be inserted on the first position. If you drop it below the lower staff, it will be appended at the 
bottom of the score. Use this function to add an Oboe at the top of this score, an English horn 
between the violin and the double bass, then a clarinet below all other staves. Use the Woodwinds 
sub-folder to find them. The score becomes: 
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and the conductor view displays:

• You may also drag an instrument on an existing staff, inside a score view. In this case, the instrument 
specifications are simply copied into the staff. No staff is added. The content of the measures is not 
modified. Drag for instance a Horn (in the Brass sub-folder) on the third staff (English horn). Its 
name is changed and the sound will be modified when the score is played. This is an easy way to 
change the sound assignement of a score. You should otherwise open the instrument view, select the 
synthesizer, select the family, select the instrument, change the color and / or the MIDI transposition 
value, the name,... All this is done in one operation in the conductor view. You may even do it while 
the score is playing. 

• In a similar but more limited way, you may drag and drop an instrument on a score rectangle of the 
conductor view while holding down the CTRL key. The dragged instrument will replace the 
specification of the first staff of the score. This has the same effect of opening the score, dragging 
and dropping the instrument on the first staff and closing the score view. It is a shortcut to the full 
operation. 

• Close the Basic instruments folder and open the folder named Sections and ensembles: 
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The sub-folders found there contain a set of hierarchical folders that define instrument sections 
and ensembles. The idea is that a folder that contains instruments and/or other sub-folders may 
be dragged on the musical desktop to create a score template with all those instruments. For 
instance, open the Synphonic Orchestras and drag and drop the sub-folder named Bolero (Ravel). 
Open the score and you will see the full orchestral score template, ready to be used. You will 
notice that the brackets are placed for instruments that are found in sub-folders of the dragged 
folder. This operation (drag and drop of a folder) may be done on an existing score rectangle on 
the musical desktop but not inside an open score view.

We suggest you to explore the various sub-folders inside Sections and ensembles. They contain 
several templates that can be used to build your scores and compositions.

Managing the musical objects

By musical objects, we mean instruments, folders, documents, virtual keyboards and other musical objects 
that will be explained in the following lessons. These various elements may be present inside a folder.

We have seen that a document may contain a hierarchical structure of musical objects. This structure is not 
static: you may modify it and add new musical objects. This structure is in fact located inside the Pizzicato,  
DataEN, Libraries sub-folder. This folder contains sub-folders and Pizzicato documents that are 
automatically added to the tree when you start Pizzicato. A modification done in this structure is 
automatically saved in the appropriate document located inside the Libraries directory. This is also 
explained in the document manager.

Compared to the previous versions of Pizzicato that did not contain the document manager, version 3.5 may 
use several configurations in the document manager. You can find all the documents of the library in 
configuration 3, Libraries. But generally, configurations 3, 4 and 5 display more specific areas of the 
libraries, which makes it easier to navigate through the library, because you do not need to search through 
the same tree for many different interesting locations. Here are the specifications of configurations 3, 4 and 
5:

• Configuration 3 - The first area displays the instruments you can use to build a score. The second 
area gives an access to virtual audio instruments, which will be explained in another lesson. 

• Configuration 4 - The first area displays the harmonic spaces and the chords progressions. The 
second area contains rhythmic structures for individual instruments, that can be used to build custom 
rhythms. The last one contains styles and prepared structures. 

• Configuration 5 - The first area displays musical vectors. The second area is an effect library that can 
be applied to a score. The third contains audio ressources. 

You may add configurations and/or modify the original configurations. See the document manager on how 
to do it.

By adding a new document in a folder, you may add a new node in the tree. We will do this in order for you 
to have the possibility to organize and modify a structure without touching to the original library. Here is 
how to do it.

• The folder named My library is there so that you can create documents and structures without 
touching to the original library. 

• In configuration 3, click on the My library folder with the right mouse button and select the menu 
item New document. Give it the name Tests and validate the dialog. Click on the "+" sign that 
appeared in front of My library and then on the "+" sign in front of Tests. The tree displays: 
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The Tests document may now be used to make some experiences without disturbing the original 
library.

You will find one score in the Tests document as there is at least one score in a document. Now, in addition 
to one or more scores, a document may contain a structure of musical objects, the same kind as the structure 
we have seen so far. So you may also add musical objects in the documents you open. By default, a 
document does not contain any musical object.

This tree behaves exactly as explained here above. The musical objects that you create in it will be saved 
with the document. It is an easy way to transfer musical objects to somebody else if you want to exchange 
them. The same will hold true for the musical libraries, as we will explain in a further lesson.

• Click with the right mouse button on the green icon of the Tests document. In the contextual menu 
that appears, select New folder... A dialog asks you to specify the name of the folder. Fill it with My 
folder and click on OK. The tree becomes: 

• Click on My folder with the right mouse button. Select the New instrument... item. The instrument 
definition dialog box appears, with a default instrument. Give it a title, My instrument and click on 
OK. Open the folder. The tree now displays: 

• The creation of a new virtual keyboard will be explained in the lesson on virtual keyboards. The 
same is true for the music generators, harmonic spaces and other musical objects that will be the 
subjects of specific lessons. By clicking with the right mouse button on My Folder, select the Import 
a synthesizer... item. The following dialog appears: 
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This dialog lets you select a synthesizer driver. From this driver, Pizzicato will extract all 
instruments and will create a structure with one folder for each instrument familly. It will also 
extract the percussion instruments. If your synthesizer is included in this list, you may then 
import it so you can use its instruments exactly as we have explained in this lesson. Select for 
instance the GS synthesizer, which corresponds to several Roland synthesizers. Click on Select  
synthesizer. Open the new GS - Instruments folder by clicking on its "+" sign. The tree becomes:

• When you click with the right button on a folder or an instrument, the Delete menu item is available 
to delete it. 

• You may drag a folder or a music object from one folder into another. Several possibilities exist: 

1. If you drag an object from one document to another document (which means that the 
source and target folders are not in the same Pizzicato document), the object and its 
content are copied to the destination folder (the original object is left untouched). 

2. If you drag an object inside a document, the object and its content is simply transfered to 
the target folder. 

3. If you drag an object inside a document while holding down the CTRL key, the object 
and its content are duplicated. You have an exact and independent copy of the original 
objects. 

4. If you drag an object inside a document while holding down the SHIFT key, aliases of the 
object and its content are created. The reference is copied to the target folder as a link to 
the original objects. In this case, the real object is unique and references to it may be 
placed anywhere in the musical objects. An object that has more than one reference to it 
is marked with a "+" just before its name (this "+" must not to be mistaken with the "+" in 
front of a folder). 

• When you right click on an instrument or on a folder that contains instruments, an additional menu 
item is available. It is called Assign a synthesizer and contains at least 2 choices. 

The first choice is None which means that all instruments of the folder will be assigned to no 
particular synthesizer. The other choices depend on your MIDI setup. It is the list of all MIDI 
output ports. When you call this menu, Pizzicato will assign this MIDI port to the instrument you 
clicked, or to all instruments that can be found inside the folder you clicked.
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If you have several synthesizers, you may use this function to assign its MIDI output port to a 
folder containing its instruments. In this way, when you drag the instruments, they will be 
assigned the correct synthesizer in the instruments view of the score. This function will also try 
to match the sound of the target synthesizer with the original sound included in the instrument. 
For this to work, the General Midi equivalences must be present in the synthesizer driver, which 
is not the case for every driver.

• The folder named My library corresponds to a Windows directory (or a Mac folder). It may contain 

sub-folders and Pizzicato documents may be created in them. The icon of a document is green with a 
little score in it. Inside a document, you can find/create scores and groups of scores. You can also 
create folders and sub-folders that may contain musical objects you can use to compose music. We 
will explain this in further details in the following lessons. 

The instrument colors

The color system used for instruments is that a color has been assigned to each instrument family. Inside a 
family, the same color is used with a scale of brightness from dark (lower pitch) to very bright (higher pitch). 
This system is only an approximation and does not establish an exact matching between a sound pitch and a 
color. It is an arbitrary scale and is only used as a clue to know which instruments are present in a score 
when observed in the conductor view. The family colors are :

 Strings
 Guitar, picked strings and piano
 Woodwind and blown instruments

 Organ, synthetic sounds and 
effects

 Brass
 Percussion
 Voices
 Bass

Composition tools - Harmonic spaces
• Basic principle 
• Using the real time arranger 
• Editing an harmonic space 

Basic principle

An harmonic space is a set of chord progressions that may be sequenced and that give a specific atmosphere 
or style to a music. It can be very simple or may contain several chords sequences and types. Its basic 
purpose is to orient the composer in an intuitive way, by being able to select a final chord progression to use 
in a music composition. It is used in association with a score group - an object that you can find inside the 
main area of the conductor view. By using an harmonic space inside a score group, you may select the 
chords and hear the effects they have with the real time arranger of Pizzicato. The scores placed inside the 
group will take the sound colour of chords you select in real time. This is an easy and powerful way to create 
a chord progression, because you hear it and choose it just from you feeling, without any needed knowledge 
of chord theory. It is an intuitive approach to design a chord progression.

We will first see how we can use an harmonic space with the real time arranger.
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Using the real time arranger

You will find some simple harmonic spaces in configuration 3 of the document manager, in Libraries /  
Instruments and templates / Harmonic spaces. We will use for instance the first, C Major - 3 notes chords + 
dominant 7th.

• Start Pizzicato on a new document and go to connfiguration 3 of the document manager and drag the 
node C Major - 3 notes chords + dominant 7th and drop it in the main area of the conductor view. 
You 

can then observe the following group that has been automatically created: 

• You could also have reached the same result by creating a group of scores (contextual menu inside 
the conductor view) and by dragging the C Major - 3 notes chords + dominant 7th node into it. 
Resize the group by clicking and dragging its bottom right corner, so as to display: 

You can observe the various chord progressions "C - D min", "C - E min",... with their assigned 
colours. The rule of such an harmonic space is that after a C, you can have the chords as 
displayed here above. After a D min, you may have such and such chords, ... This is a simple 
example, as other harmonic spaces may have other rules.

• As we have not yet selected the chord with which we want to start, Pizzicato shows you all the 
possible starting sequences. On each chord, you will see a little OK button. It is used to validate the 
chord to use. Click on the first C chord OK button and the group becomes: 

The first chord is now fixed as C and Pizzicato suggests 7 chords that can be sequences after the 
C chord
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• Click on the OK button of the F chord and the group becomes: 

• Click on the next G chord, then on the C chord. The group becomes: 

Notice that the group is automatically resized when you add chords to the progression. On each 
chord of the progression, there are now 4 icons that you can use to:

• "?" : click on this icon to change the chord, by calling the chord selection dialog box. 
• "+" : click on this icon to add a new chord after the current chord, with the help of the 

chord selection dialog box. 
• "x" : click on this icon to delete the current chord from the progression. The following 

chords are shifted to the left accordingly. 
• "<=" : click on this icon to remove all chords from the progression, starting with the 

current chord. The next suggestion of Pizzicato is then displayed on that location so you 
can re-orient the chord progression from this point on. 

You will notice that each chord is now assigned to a duration of one 4/4 measure. You may 
move the border between two chords by dragging the mouse over the border and click it to move 
it to the left (shorter duration for that chord) or to the right (longer duration).

Up to now, this is only visual, but here comes the interesting point.

• In configuration 4 of the document manager, third area, locate the following node, by expanding the 
nodes as necessary: 

• Drag and drop the above Rhythm (selected in blue) inside the score group and position it as follows: 
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• Its content is one 4/4 measure of a country style rhythm, written in C Major. Expand the length of it 
as explained in the conductor view lesson : drag its bottom right corner to the right so as to have: 

• Now listen to the group by using the yellow triangle of the conductor toolbar. You will hear the four 
measures change with the chords present in the group. This is the real time arranger that plays the 
score and arrange it to fit the chords you have selected. 

We will now see how you can intuitively design a chord progression.

• First, click on the "<=" icon of the first chord, so as to delete the chord progression. Click on the OK 
button of the first C chord and resize the group and the rhythm so as to have the following 
presentation: 

• Right-click on the blue background and select the Play in loop menu item. Start the playing and the 
score will now play in loop the same rhythm again and again. Here is how you can select your chord 
progression in real time. 

• Double-click in the middle of the yellow C chord. A little coloured circle appears: 
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It is the fixed point for the real time arranger. When this circle is not present, the score is played 
with the chord present in the corresponding measure. But when you set this fixed point, Pizzicato 
continues playing the score with the chord being located at the fixed point (here C). You may 
now click in any of the chords suggested by Pizzicato and you will hear the change of tone in the 
rhythm. Try and click on each one of them. When you find one transition you like, just click on 
the OK button of that chord and the chord is added to the progression, as explained above. 
Pizzicato shows you then the next suggestions for possible chords in that harmonic space. This 
space represents here the 3 notes chords of the C major scale, as well as the dominant 7th chord, 
quite common in use.

When you click inside the circle, it disappears and the real time arranger continue to play the 
score with the existing chord progression. You may also disable the real time arranger by 
clicking inside the little yellow square present at the top of the group.

Warning - do not forget to delete this fixed point after you have used it, because otherwise 
Pizzicato will play all your score with that fixed point, even from other documents and they may 
sound strange to you because Pizzicato arranges them all in the fixed point chord.

Once you have found the chord progression you like, you may do two things with that group:

• You can drag the little green square on top of the group and drop it outside the group. Pizzicato will 
create a full score of the group, including the arranged notes with the chords. 

• You can similarly drag and drop the little blue square and the score will only contain the chord 
progression. You can drag that chord progression in a document inside your My library folder to use 
it on other occasions. It is then part of your library. 

You will find in the Pizzicato libraries numerous harmonic spaces. They are located in the Music libraries,  
Harmonic spaces folder and they are classified according to the types of chords (thirds, sevenths and others), 
by common notes and degrees to sequence. You can find them in the first area of configuration 4 of the 
document manager.

Editing an harmonic space

Here is how to create a custom harmonic space or edit an existing harmonic space.

• Open a new document and open the conductor view. In the document manager, configuration 1, 
right-click the document icon and select the New harmonic space menu item. The following dialog 
appears: 
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• You can change the name of this harmonic space in the text box in the right upper corner. 

• The first list is a list that will contain the possible chord sequences. Click on the Add button. A new 
line appears in the list. Then click on the Add a chord... button. The chord selection dialog box 
appears: 

• Click on OK to select the default C major chord. The second list shows the C chord. Add a new chord 
in that list and select the F chord. This "C + F" sequence is a possible chord sequence in this 
harmonic space. 

• Click again the above Add button and add the sequence of "D min + F". Notice that a colour is 
automatically associated with the root note of the chord. The colour may be changed if you want to 
test another colour/chord convention. They will appear in the groups of scores with these selected 
colours. 

• Using the same principle, create the two following chord sequences : "F + G" and "G + C". The left 
list should now appear as follows: 
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The number "=0" is in fact a value that you can assign to that specific sequence. It can be 
assigned by selecting the line in the list and then changing the value with the upper slider in the 
right part of the dialog. It is presently not used by Pizzicato but this number, if assigned, should 
represent the relative quality or importance of that specific chord progression in the harmonic 
space you design.

• The upper Delete button is used to delete one of the selected sequence of chords. The Up and Down 
buttons at the top of the dialog are used to change the order of the selected chord sequence so you can 
sort the list as you want. 

• The Modify chord... lets you change the chord selected in the second list. The Delete chord removes 
the selected chord of the second list and the Up and Down buttons may be used to sort the list of 
chords of the selected chord progression. By clicking on the colour square, you may select the colour 
associated to that chord. 

• If you check the Play the selected chord box, you will hear the selected chord with a string sound and 
you can adjust the sound volume with the slider just below it. 

• The Transpose... button lets you transpose all chords defined in the harmonic space. 

• The Structure... button is used to construct an harmonic space automatically, following a set of 
specifications that you decide. The following dialog appears: 

Here are the specifications that you can give and that will determine the possible chords 
sequences that the harmonic space will contain:

• To the left, a double list is used to specify which chords can be used. You can select a 
chord and move it from one list to the other with the four middle buttons. 

• The central table determines in which scales the chords can be used. It defines the 
harmonic context of the chords. The twelve notes can be used, in combination with the 
major scale and the three minor scales. 

• In the upper part of the third frame, you can select how many common notes can be 
accepted between two sequenced chords. 

• Just below, a menu is used to display the possible sequences of degrees inside the same 
scale or between two different scales. In each case, a table of 7 times 7 checkboxes is 
used to specify which degree sequences are possible. 
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• If you click on Create, Pizzicato removes any existing chords sequences in the harmonic 
space and then build all possible chords sequences that satisfy the given specifications. 
So as to conntinue with the above example, click now on Cancel. 

• Click on the OK button. 

Composition tools - Dragging and 
dropping scores

• Basic principles 
• A practical example 
• The musical objects and their icons 
• Creating, deleting and editing the musical objects 
• Using the objects in a document 
• The drag and drop options 

Basic principles

The "dragging and dropping" of musical scores is the basic principle of the new Pizzicato library system. 
With it, you will be able to build full music compositions very fast. It gives you the power to test and try 
music combinations very efficiently. Let us define precisely the drag and drop operation inside Pizzicato. It 
is the operation consisting of the 3 following steps:

1. You click on a musical object with the left button of the mouse and you hold the button down 
2. You move the mouse to another specific location, while still holding down its left button. It is the 

"drag" operation. As you move the object, the mouse cursor may take two aspects. The first is a 
multidirection arrow which means that the current location of the mouse may accept the dropping of 
the object. The other is the sign of "no parking" for street cars and shows that the current mouse 
location may not accept the kind of object you are dragging. In that case, if you release the mouse 
button, no operation is performed. 

3. You release the mouse button, which is the "drop" operation. 

According to the exact type of the object, the result is commonly one of the following:

• The original object is moved to the new location. 
• The original object is copied to the new location. 
• The original object is used or referenced in some way by the target object (the target object is the one 

located at the destination, where you release the mouse button and the source object is the object you 
are dragging). 

This lesson will explain which object can be dragged and where they can be dropped. Let us first create a 
little score by using these principles, so that you can have a better insight of what we mean by composing 
music by dragging and dropping scores and musical objects.

A practical example

• Open a new document and open the conductor view. In configuration 3 of the document manager, 
expand the Music libraries node so that it displays the following: 
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• To make a reference to a node of the library (and this is valid for the rest of these lessons), we will 
refer for instance to the above selected node by giving its full path, like this : 

Music libraries / Patterns by instruments / Individual instruments / Rhythms and arpeggios / Arpeggios in  
eigth notes / Arpeggio 1

• Point the mouse cursor on the first icon of the selected node, which is a double note with stems in 
opposite directions. This icon represents a music score. You will immediately see its content 
displayed in a floating window, as an easy way to explore the library. Just drag the mouse (without 
clicking) over the various score icons and the display of the contents of these scores is temporarily 
displayed. 

• As music is mainly a question of hearing and not so much seeing, you may click on any score icon 
and the score is played in loop so that you can easily get an idea of its musical content. The loop 
playing continues until you keep the mouse cursor inside the score icon and stops whenever the 
mouse cursor leaves that area. 

• Do some experimentation and have a look and hear the content of the above score icons. 

• Now drag the above selected icon and drop it into the main area of the conductor view. You get: 

This score is now part of your current document. It has been copied into the document and may 
now be modified without any effect on the original library.

• Open the score view by clicking on the first icon (one note icon) and the score is displayed: 

A score has been created with a simple drag and drop and contains an arpeggio played on the 
piano. We can now continue to build that little score by adding other contents in it, with the same 
principle. The next operation is an important one, and has some specific features associated with 
it.

• Click on the Arpeggio 3 node and drag it slowly over the beginning of the above piano score, and 
release it when the mouse cursor is to the right of the full measure, so as to add it after the end of the 
existing measure. While doing so, you will notice a red temporary display in a floating window, 
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showing you the potential location where the content would be added if you release the mouse 
button: 

You will notice that the time position is displayed on the closest beat of the measure. If you hold 
down the SHIFT key, you may increase the precision to one 16th note (the unit changes : 120 = 1 
x 16th note, 240 = 2 x 16th note, 360 = 3 x 16th note).

The new arpeggio score has been added at the end of the first one and the score now displays:

• This operation may also be done on any beat of the measure. For instance add two empty measures 
after the two above measures. You can use the measure & staves tool or with the contextual menu, 
right-click on the last measure and select Measures and staves, Add one measure after... Do it twice 
so as to have two empty measures. 

• Now drag the Arpeggio 4 node of the library and drop it when the red display shows Measure = 3 -  
Beat = 3 - Unit = 0. To do that, just drag over the third measure and drop it on beat 3. The score 
becomes: 

You should be careful to drop the score between the limits of the upper and lower lines of the 
staff, otherwise Pizzicato will create a new staff above or below the current staff, to place the 
contents of the score you drop.

• We will now add a string quartet basic accompaniment to this little arpeggio melody. Find the 
following node in the library: 

Music libraries / Prepared structures / String quartet / 8th notes staccato / Violin+Alto+Cello+Ctb
and drag and drop it on the first beat of the first measure, but below the piano staff. The 4 string 
staves are then added to your score:
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• Repeat this action again, but drop it on the second violin measure and hold down the CTRL key 
while releasing the mouse button. The following dialog appears before the operation is executed: 

Several options may be specified to further determine how the drop operation should be 
executed. For now, we just want this score copied three times instead of one time, so in the text 
box entitled Use all rhythms fill in "3" and click on OK. The score becomes:
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You will notice that the scores of the libraries are written in the C Major tonality. We can now 
drag and drop a chord progression inside this score. Locate the following node in the library:

Music libraries / Chord progressions / Measure 4-4 / C Major - 3 notes chords / 4 measures - 2  
chords/measure / 

C Major / 1 - 100 / 28/41

This chord progression contains two chords per measures. Drag and drop it on top of the first 
staff, on measure 1 beat 1. The score becomes:

At a first glance nothing has changed in the score, except that the chord symbols of the dropped 
chord progression have been added. In fact the score displays the C Major version of the score. 
To display the arranged version, click on the "C" (= Computed measures) check box in the 
toolbar of the score view, just to the right of the "..." button. The score now displays the 
following:
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The yellow background shows that it is the arranged score. This feature is part of the score 
arranger function, that gets automatically activated when you drag a chord progression inside the 
score. A specific lesson will explain the score arranger features.

• Now, lets us replace the first instrument by an oboe. Locate the following node in the top left tree: 

Instruments and templates / Basic instruments / Woodwind / Oboe
and drag and drop it on the first staff. Then play the score and you will hear that the instrument 
has been changed.

• Here is a last example. We would like to create a crescendo for the strings, starting from no volume 
and reaching a normal volume at the end of the 4 measures. Locate the following node of the library: 

Music libraries / Effects / Volume / Crescendo - 2 beats - from 0 % to... / 80 %

• Select the 4 measures on the 4 string staves (type "s" to activate the selection tool, then click on the 
first violin measure and then, while holding down the SHIFT key, click on the fourth measure of the 
Double bass). 

• Drag and drop the above node on the first measure of the violin. Then listen to the score and you will 
hear that the 4 strings play a crescendo through the 4 measures. 

By using this simple drag and drop function, and by learning to know the contents of the Pizzicato musical 
libraries, you have a powerful tool to test and try music combinations and apply effects, chords and 
instruments to your composition.

The musical objects and their icons

Here is the list of the icons you will find in the libraries and their meanings:

•  - A Pizzicato document. It can contain scores, folders, groups of scores, virtual keyboards, 
instruments, music generators, harmonic spaces and other musical objects. 

•  - A folder. There are two kinds of folders. The folders that correspond to Windows directories (or 
Mac folders) may contain only other folders, Pizzicato documents or Midi files, SoundFont files, 
STY files, musicXML files and NIF files. The folders that are inside a Pizzicato document may 
contain other folders, virtual keyboards, instruments, music generators, harmonic spaces and other 
musical objects. 

•  - A score. You can find a score either in a Pizzicato document or in a score group. A score is a set 
of staves and measures, with their contents and their instruments specifications. You can display and 
play a score. To the right of a score icon, you can find one or more of the following icons, each 
representing a specific aspect of music that will be used if you drag and drop the score in your 
composition: 

•  - The rhythmic values present in the score will be used 
•  - The note pitches present in the score will be used 
•  - The instrument specifications of the score will be used (clef, number of lines, 

transposition, associated sound,...) 
•  - The chords present in the score will be used 
•  - The effects present in the score will be used (volume, velocity, pitch bend, patches, 

tempo and other MIDI controllers) 

•  - A group of scores. It can only contain scores. You can have a group of score only in a Pizzicato 
document. 

•  - A coloured square is an instrument. It can be found in a Pizzicato document or inside folders of a 
Pizzicato document. 
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•  - A virtual keyboard (do not confuse it with the instrument aspect icon, which is only found to the 
right of a score icon). It can be found in a Pizzicato document or inside folders of a Pizzicato 
document. 

•  - An harmonic space. It can be found in a Pizzicato document or inside folders of a Pizzicato 
document. 

•  - The definition of a chord. It can be found in a Pizzicato document or inside the folders of a 
Pizzicato document. 

•  - The definition of a scale. It can be found in a Pizzicato document or inside the folders of a 
Pizzicato document. 

•  - A music generator. It can be found in a Pizzicato document or inside the folders of a Pizzicato 
document. A music generator may contain scores and folders, but the scores are displayed with a blue 
background (  ) because they are only potential scores, that are created on the fly when you try to 
use it. To the right of a music generator, you can find the same 5 icons found after a music score. 
They show you in one glance what you will find in the scores generated by it. 

•  - A music vector. It can be found in a Pizzicato document or inside the folders of a Pizzicato 
document. It is a musical object capable of generating a melodic structure that can be adapted to a 
chord or scale progression. It can be dragged and dropped inside the measure of a score and will then 
generate its notes in that score. 

•  - A virtual instrument. It is an audio synthesizer or sample reader that you can drag in a measure 
so that the notes are played with this instrument. 

•  - An audio WAV file. It can be edited with the audio window by double-clicking it. You can also 
drag it in a measure so that the sample is played with the notes. 

•  - A MID file. It can be imported into a Pizzicato score with its contextual menu (right click). 

•  - A musicXML file. It can be imported into a Pizzicato score with its contextual menu (right 
click). 

•  - A NIFF file. It can be imported into a Pizzicato score with its contextual menu (right click). 

•  - A STY file (Yamaha style). It can be imported into a Pizzicato score with its contextual menu 
(right click). 

•  - A SF2 file (SoundFont file). It can be imported as Pizzicato virtual instruments with its 
contextual menu (right click).). 

You should accustom yourself to the above icons because they are the symbols used inside the music 
libraries of Pizzicato.

Creating, deleting and editing the musical objects

If you click on a musical object with the right mouse button, a contextual menu appears. Depending on the 
object you click, you will find a menu item to:

• Add a new object in a folder 
• Remove an object 
• Rename an object 
• Modify the content of the object (often this is also achieved with a double-click on the object icon) 

You can also drag and drop most of the objects between various locations of the library, so as to create and 
organize new sections of the library, with the following general rules:

• You can drag a folder containing objects, or an object itself, into another folder, either within the 
same Pizzicato document or between different Pizzicato documents. If you do it within a Pizzicato 
document, the object is moved and if you want to duplicate it, you can drag and drop it while holding 
down the CTRL key. Between Pizzicato documents, the object or folder is copied 

• A group of score may be copied into another Pizzicato document. 
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• You can also drag and drop between the library (upper tree) and the current open document (lower 
tree), in both directions, but only from and to a Pizzicato document of the library. 

We suggest you to create all the libraries you want inside the prepared folder named My library. In this way, 
the original library is left untouched. It is indeed susceptible to be often improved by ARPEGE, so that in the 
next release you would not find the personal changes you did to the library. The My library folder will not be 
touche or modified by future versions, so you keep it even when you install a new Pizzicato release.

For a score object, you can specify which musical aspects are used when you drop it on another score or use 
it in a music generator. Right-click the score and select the Play options... menu item. In the lower part of the 
dialog, you will find 5 check boxes to specify if the score is used for Rhythms, notes, chords, instruments  
and/or effects. The corresponding icons will be displayed to the right of the score icon, to show which are 
active.

Using the objects in a document

Here is the list of operations you can do with the musical objects of the library:

•  or  - You can drag and drop a score:

 inside the main area of the conductor view. A copy of that score is added to your 
document. 

 on a given measure, inside a score editor. The contents of the dropped score will 
replace or be added to the visible score, starting at the measure and beat you 
specify by the mouse location. Only the aspects of music shown with the 5 above 
mentioned icons will be used. 

 after the last measure. Additional measures are added and the contents is copied 
into the score. 

 above, between or below staves or a staff. The contents will be added, creating 
new staves as necessary and copying the various aspects shown by the icons. 

•  - You can drag and drop an instrument:

 inside the main area of the conductor view. A new score is created, with the given 
instrument specifications. 

 on a score rectangle inside the conductor view. If you hold down the CTRL key 
also, the instrument replaces the first instrument of the score. Otherwise, the 
instrument is added on a new staff below the last instrument of the score. 

 inside a measure of the score view. The instrument replaces the one present on 
that staff. 

 above, between or below staves or a staff. The instrument is added, creating a new 
staff at that location. 

•  - You can drag and drop an harmonic space inside an existing group of score of the main area of 
the conductor view. Or you can drag and drop it directly on that main area and a group of score will 
be created. See the lesson on the harmonic spaces and the real time arranger for more information on 
this object. 

•  -  -  - You can drag and drop scales, chords and music vectors inside the measures of a score. 
See the lessons about the scales and chords and about the music vectors. 

•  - You can drag a virtual instrument directly into a measure to assign its sound to the notes that 
follow. You can also drag it in the conductor view, on a score rectangle or above, between or below a 
staff. In each case, a new staff is added, assigned to that sound. 

•  - You can drag an audio WAV file directly into a measure to assign this sample to the notes that 
follow. 

Here are some more drag and drop operations that may be useful:
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• When you have a selection of measures inside a score view, you may drag and drop it (clicking on 
the first selected measure and staff to drag it):

 inside the main area of the conductor view. A new score is created, with only the 
selected measures. 

 on any measure of any score view. The content is copied as a standard copy/paste 
operation. 

• When you have a selection of measures inside a score view, you may drag and drop it while holding 
down the SHIFT key (clicking on the first selected measure and staff to drag it) and this selection 
may be dropped exactly like a score (see above), including in the same score. The advantage to a 
standard copy/paste is that it may use the drag/drop dialog box and also that a measure can be copied 
across bar lines, which makes it a way to re-beam music in another time signature. In this way, you 
may also file a selection of measures into the library. 

The drag and drop options

If you hold down the CTRL key at the moment you release the mouse button to drop a score inside an open 
score view, a dialog appears to specify additional parameters that will influence the dropping of the score:

The five check boxes entitled:

• Transfer rhythms 
• Transfer notes 
• Transfer chords 
• Transfer the effects 
• Transfer the instruments 

are initialized according to the icons found to the right of the score icon. You can modify them, depending 
on what is really present inside that score. You may for instance prefer to copy only the notes and rhythms of 
a library score, while not touching to the instruments specifications of your composition and you can then 
uncheck the transfer of instruments.

The four first check boxes have additional options:

• Transfer rhythms

 Use all rhythms ... time(s) specifies how many times you want the full sequence of 
rhythms to be applied in the target score. 
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 Use each rhythm ... time(s) specifies how many times you want each rhythm to be 
used before using the next rhythm. 

 Sequence specifies if the rhythms will be used in the correct order, the reversed 
order or with a random order 

 Multiply / divide durations by is used to multiply and divide the durations of the 
original rhythms before applying them to the target score. 

• Transfer notes 

 Use all notes ... time(s) specifies how many times you want the full sequence 
of notes to be applied in the target score. Notice that this value will be 
modified automatically if you modify the equivalent value in the rhythm 
transfer options. This is indeed the more common option: if you want to play 
a sequence 3 times, you should play both rhythm and notes 3 times. This 
remark is valid for the two following options. 

 Use each note ... time(s) specifies how many times you want each note to be 
used before using the next note. 

 Sequence specifies if the notes will be used in the correct order, the reversed 
order or with a random order. 

• Transfer chords 

 Add the symbols specifies if you want the chord symbols to be added in the 
target staff, displaying the chords that are added. 

 Enable arranger specifies if the score arranger will be automatically activated 
when dropping a chord progression into the score. 

 Multiply / divide durations by is used to multiply and divide the durations of 
the original chords before applying them to the target score. 

• Transfer the effects 

 Use the effects ... time(s) specifies how many times you want the full 
sequence of effects to be applied in the target score. 

 Multiply / divide durations by is used to multiply and divide the time scale of 
the original effects before applying them to the target score. 

You may also add a label and a color to the block of measures that have been 
transfered. It helps to remember which block was copied. By default, the label is the 
name of the document, group and score.

To apply the drop operation, click on OK. You can also cancel the operation by using the Cancel button.

This lesson contains the most basic principles used to composition with libraries. Another lesson will soon 
explain you what you can find in the libraries. You should well understand the above operation, because they 
are the key to intuitive music composition with Pizzicato. Try each operation by yourself and read the lesson 
again. Then let your imagination work and you will find it quite powerful.

Composition tools - Music generators
• Basic principle 
• The musical structure 
• A structure inside a structure 
• Parameters of a score 
• The generated scores 
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Basic principle

The music generator is an object that can be created, modified and manipulated inside a document or in the 
library. Its purpose is to generate scores that can be used as building blocks in a music composition. The 
scores created are displayed like other scores, inside the node of the music generator and they may be seen, 
played and used by dragging and dropping them inside your composition. All kinds of criterias can be given 
to construct a music score generator and to influence the type of scores that will be generated. Let us start 
with a practical example.

• Open the Ex086 example in configuration 2, examples folder. You can see the following: 

The icon with some circles in it is the music generator icon. Its name is here Random notes. This 
generator has been designed to create 10 series of 7 random notes taken from the set [ C3 - D3 - 
E3 - F3 - G3 - A3 - B3] with each note being used only once in a given score.

• To see the generated scores, click on its "+" sign, in front of the icon. You get: 

• Use the method explained previously to see the content of each of these scores (drag the mouse over 
the blue background icons and see the content displayed in the main part of the conductor view; click 
on it to hear it play). You have for instance the first score: 

The exact content may be different on your computer, because the scores are generated on a 
random basis. But each score will have 7 notes, in random order, with each of the 7 notes being 
used only once.

As compared to the normal scores that are used in a document, the icon of these generated scores 
have the same icon (2 notes with opposite stem directions) but with a blue background to 
differentiate them. These scores are only potential scores and they are in fact generated "on the 
fly" when you drag and drop them or when you display them as above.

• Double-click on the music generator icon (or click with the right mouse button and select the 
Modify... menu item). The music generator definition dialog box appears: 
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This generator contains one musical structure represented by its main icon (top left) and it 
contains 7 scores, each one being a simple score with one specific note in it. The parameters you 
see on the right part of this window determine how the 7 scores will be used in that main musical 
structure. We will explain these parameters and the musical structures in the remainder of this 
lesson.

The musical structure

A music generator is built on two basic blocs. The musical structure and the score. A musical structure may 
contain one or more scores and/or other musical structures.

A musical structure is like a folder. It can contain other folders and also scores. But it also has properties that 
determine how its content will be combined.

The scores used in a musical structure are only links to existing scores in the library. As you will see in a 
future lesson, the basic library of Pizzicato contain notes, chords, rhythms and various combinations of them. 
They form the basic elements of music and they can then be used in music generators to build more 
sophisticated music materials.

To use a score from the library inside a music structure is quite easy: you just drag and drop it from the tree 
library into the structure as displayed here above. Indeed, this dialog is not modal. You do not need to close 
it to continue to work with Pizzicato. You may even open several music generators and drag and drop scores 
and musical structures from one to the other.

We will create a new music generator that has the following purpose: create all combinations of drum 
scores, each one having some patterns of bass drum, cymbal and snare drum.

• Close the music generator dialog. In the library, go inside the My library folder (in configuration 3). 
If the document named Tests is not in it (you should have created it in a previous lesson), then create 
it by clicking on the My library folder with the right mouse and select the New document... item. 
Name it Tests and expand its node (with the "+" sign in front of it). 
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• Right-click on the Tests document and select the New music generator... item. You get: 

• Double-click the music generator icon. An empty music structure is shown in the main part of the 
dialog: 

• When a music structure is selected (in blue), the corresponding parameters are displayed in the right 
part of the dialog. As this first music structure is the main structure (the one that will contain all 
others), the following parameters are displayed. They are applicable for the music generator itself and 
they will not appear for the sub-structures that we will create in a moment: 

Here are the explanations:

• The Calculate button may be used to generate the scores and update them in the library 
node, without the need to close this dialog box. This is useful to test the results of the 
music generator you are designing. 

• The Sorting menu is used to specify how the various scores will be presented. According 
to how it is designed, a music generator may generate thousands of scores in one shot. 
You can sort them in sub-folders of 100, by the number of notes that are generated in the 
score or with no sorting at all. With the second choice, it means that Pizzicato will for 
instance create a sub-folder that contains all the scores generated that contain only one 
note, a score for two notes, three notes,... 

• As the combinations may be innumerous, you may specify to Pizzicato that it has to stop 
after generating the Maximal number of results. If you keep this value equal to 0, 
Pizzicato will limit it to its internal capabilities as needed. 

• If there is any random choice inside one of the musical structures of this generator, and if 
the Random sequence base number is equal to 0, the results will each time be different, as 
the random number generator used internally will use the computer clock value to start 
the random sequence. If you specify a fixed number in that box, it will use it as its root, 
so that the random sequences will be the same each time. 

• The next two text boxes are used to specify the time signature used in the generated 
scores. 

For this example, we will leave these parameters to their default values.

• The following part of the dialog displays the parameters that are relevant to a musical structure: 
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Here are the explanations:

• The Name text box is used to specify a name to the musical structure. The name of the 
main musical structure is used as the name of the music generator. The name of an 
internal musical structure may be used to remind you what each sub-structure means in 
your design, but it is optional. 

• The next popup menu is very important. It will determine how the scores and sub-
structures placed inside this structure will be combined to create a musical content used 
in the generated scores. To figure out the following possibilities, just imagine that 7 
scores of one note each are put in this musical structure, as it was the case in the first 
example seen in this lesson. Here are the possible choices: 

 Full sequence: the items placed inside this musical structure are used in the 
exact order. 

 Inverted sequence: the items placed inside this musical structure are used in 
the reverse order. 

 Sequence of N item(s): the items are used as a sequence of N item(s). In this 
case and the following containing N, the value of N may be specified with an 
additional text box that appears below the popup menu when you select that 
option. Pizzicato will compute all possible sequences that contain N items. 

 Sequence of N item(s) w/o doubles: same, but the sequence may contain each 
item only once. 

 Random sequence of N item(s): N item(s) will be used, taken randomly 

 Random sequence of N item(s) w/o doubles: N item(s) will be used, taken 
randomly but each item may only be used once. 

 Simultaneous playing: In all the previous cases, the items were used in 
sequence, which means that they will be played one after the other. In this 
case, all items will be played simultaneously. 
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 Simultaneous playing of N items: In this case, N item(s) will be played 
simultaneously. Pizzicato will work out all possible combinations of N 
item(s). 

 Simultaneous playing of N random items: Same, but the set of N item(s) will 
be choosen in a random way. 

 Exact rhythmic combinations: All possible sequences of the rhythmic values 
of the items will be analysed and only the ones with the exact total duration 
will be used. The duration is the one specified below the Maximal total  
duration title in the above dialog (see further). 

 Exact rhythmic combinations w/o doubles: Same, but one item may only be 
used once in any combination. 

 N notes combinations: All possible sequences of the items will be analysed 
and only the ones with the exact total number of notes will be used. N is 
specified in the same way as above. 

 N notes combinations without doubles: Same, but each item may only be used 
once in a combination. 

• The Maximal number of staves will limit the number of staves put in the 
generated scores. This may affect the score if there is a Simultaneous playing 
option used. 

• Domino effect and Start and stop are respected are two options used in a very specific 
case. The purpose is to create sequences of items (chords or notes) based on elementary 
sequences. For instance, take some basic sequences of chords that are respectively [C - 
F], [F - G], [G - C], [C - G], [G - A],.. For each sequence, we create a sub-structure 
containing the two individual chords. For the main structure, we may check the Domino 
effect and use the Sequence of N item(s). The program will then try to find all possible 
combinations of these basic chord sequences and place them in such a way that the last 
chord of one sequence will always be followed by a sequence that begins with that same 
chord, like a domino game. The Start and stop are respected check box will force 
Pizzicato to start the sequence with the first sequence and end it with the last one. This 
principle may also be applied to create all kinds of melodies that start with one specific 
note and finish on another specific note. Pizzicato may then compute all possibilities of 
combinations of the basic melodic sequences that you should put in the main musical 
structure. This is quite experimental work for advanced users... don't worry! 

• In the Maximal total duration, you can specify the number of measures, beats and units 
(one quarter note is 480 units) used as a maximum for any results coming from that 
musical structure. If you keep it to 0, no maximum will be used. 

• The Use all items ... time(s) is used to specify that the all set of items will be used more 
than one time. After the last item is used, Pizzicato starts again with the first item. 

• The Use each item ... time(s) is used to specify that each individual item will be used 
more than one time. The first item will be used several times before the second item will 
be used. 

• The next two text boxes are used to multiply / divide the durations of the items. They are 
only applied to rhythmic values. 
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• The Time flow may be normal or inverted. In the last case, the results are played 
backwards. 

• Transposition : all notes and chords are transposed by so much half tones. When used on 
chords, positive values will be interpreted with sharps and negative values with flats (at 
least when there is an ambiguity like C# or Db). 

• For this example, select the Simultaneous playing in the popup menu, set the name to Drums and 
leave all other options as they are. The left part of the generator displays: 

The node is shown with its name and the type of combination that has been selected.

A structure inside a structure

In our example, we want all combinations of basic rhythmic patterns of three percussion instruments. That is 
why we selected the Simultaneous playing as in each combination, we need one pattern of each instrument, 
played at the same time. We will now create a new musical structure for each instrument.

• Right-click on the main node in the left part of the generator dialog box and select the New musical  
structure... menu item. The display becomes: 

• Click on the Full sequence node so that the parameters of this new musical structure will appear to 
the right. Select the Sequence of N item(s) and leave N to 1 by default. 

• We will now drag and drop some cymbal patterns inside this musical structure. Open the library 
folders on the left of the conductor view, so as to have: 
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• One after the other, drag the Cymbal 1, Cymbal 2,... Cymbal 9 scores ON the Sequence of 1 item(s) 
node inside the music generator. You will finally have: 

• Right-click on the main node of the generator dialog box and select the New musical structure... 
menu item again. Another musical structure is created. Click on that new node so that the parameters 
of this new musical structure will appear to the right. Select the Sequence of N item(s) and leave N to 
1 by default. Then drag the 8 first prepared patterns that you will find in the Snare drum library 
folder: 

• and put them ON the new node of the generator and you get: 

• You may now do the same with the third instrument. Create a new musical structure in the main node 
and drag the 9 first Bass drum patterns found in the Bass drum - Prepared patterns library folder. 
Your generator now contains the following structures: 
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Parameters of a score

• When you drag a score inside a structure, some parameters are also associated with it and apply for 
that score alone. Click on the first score of the generator, named Cymbal 1. The left part of the dialog 
displays the following: 

• The first parameters are exactly the same as explained for the musical structures, except that they 
only apply to that specific score. 

• The last 4 check boxes are used to specify which aspects of the score are used in this music 
generator. You may independently select to use the rhythmic values, the notes, the chords and/or the 
instruments specifications. The aspects that are selected will be used within the musical structure it is 
included in. 

Here are some other operations that you can use while working with the music generator:

• Right-click a score or a music-structure and a menu item lets you delete it. 

• You can drag a musical structure from its position to another musical structure, for instance to 
include it in it. The same holds true between two different music generator dialog boxes. You can 
then take a musical structure that you have created and use it in another context in another music 
generator. 

• When you navigate through the library, you can drag and drop scores inside a musical structure but 
you may also drag and drop a group of scores. If you hold down the CTRL key while doing this, 
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Pizzicato will automatically create another musical structure and copy all the scores that are in it. 
Otherwise, the scores of the group will be added to the target musical structure. 

• You can display and play a score from inside the music generator dialog box, just like you can in the 
library. Move the mouse over the score and click to hear it. 

Now let us see what is the practical result of our experimentation...

The generated scores

• Close the music generator dialog box. In the My library folder, inside the Tests document, you may 
see the following: 

• If you did it exactly as described until here, Pizzicato has generated 648 scores (= 9 x 8 x 9) of 
drums. All combinations have been created, that combine one of the cymbal patterns, one of the snare 
drum patterns and one of the bass drum patterns. You may now display them one by one if you want 
and hear them playing. Pizzicato has placed these scores in series of 100 in various sub-folders. If 
you find some that are interesting, you can drag and drop them in your library folder to use them later 
in a composition. Or you can just use them directly from that generator. 

• Be aware that the scores you drag inside the music generator are only references to the original 
scores. If you modify the original score and use the generator again, the resulting scores will follow 
the new content of the original scores. 

This example is quite simple and shows the power behind this kind of tool. With some more imagination, 
you will be able to create very interesting musical structures for oriented random melodies, rhythmic 
patterns, instrumental setups, chords progressions and many more combinations of all the basic music blocks 
available in the Pizzicato library. Don't forget that you can also create scores and use them in the music 
generators. Possibilities are innumerous. You just need to imagine and put it in practice with the composition 
tools of Pizzicato.

Composition tools - General scales and 
chords

• Scales and chords 
• Chords and scales library 
• Assigning chords and scales 

Scales and chords

In music composition, we can use any note of the piano keyboard to compose a piece of music. They include 
the white keys (C,D,E,F,G,A,B) but also the black keys (C#, D#, F#, G#, A# or their equivalent notation Db, 
Eb, Gb, Ab, Bb). Most of the western music culture is based on these twelve notes. Each note has its own 
frequency vibration (pitch). These twelve notes are repeated several times on the piano keyboard, using each 
time the same names for these notes. All notes having the same name have something that makes them 
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"similar". Indeed, a given C note has a vibration rate that is exactly the double of the first C note that is 
found to the left of it on the keyboard. Similarly, a given C note has also a vibration rate that is exactly half 
of the first C note that is found to the right of it on the keyboard.

The fact that several notes are linked by a factor of two in their vibration speed makes them very similar to 
the ear. Their vibrations are in physical harmony and the ear perceives it. This is why we use the same name 
for all these notes. To be more precise we often add the octave number to differentiate between notes, for 
instance C1, E2, F4, etc. C3 is the middle C of the piano keyboard (lower C in G key).

Experience shows that all these notes are not likely to sound in good harmony when they are used randomly. 
Only specific combinations of notes sound nice when played together. So various music theories have been 
developed to help the composer to select notes and decide which notes may be played together to achieve 
such or such an effect. Out of these numerous theories, we can find at least two ideas in common: the scale 
and the chord.

A scale is a subset of notes taken from the twelve notes of the piano keyboard. The most known scale is the 
scale formed by the white keys of the piano and it corresponds to the standard C scale (C,D,E,F,G,A,B,C). A 
scale is characterized by the sequence of intervals found between its consecutive notes. We count these 
intervals in semitones (half steps). A semitone is the sound interval that exists between any two consecutive 
notes on the piano keyboard (black and white keys mixed). So the C scale can be defined by the sequence of 
intervals [2,2,1,2,2,2,1]. This scale definition is the Major scale. You can find more details about this in The 
scale and the accidentals lesson.

Once we have a set of intervals defined, we can apply it so that the same scale may be constructed on other 
notes. For instance, the D Major scale would be D, E, F#, G, A, B, C#, D. 

Using the notes of a scale to create a melody is more likely to sound good than using random notes on the 
piano keyboard. So this tool named Scale can be used to select a set of notes to construct a melody. It is a 
sort of preselection of notes. Most western music is based exclusively on the major and minor scales built on 
the twelve notes of the piano keyboard, but there are numerous other scales, each one built on a given set of 
intervals.

A chord is a set of notes that can be played together (at the same time) and that produces a musical effect 
that can be used in a music composition. It is also a way of preselecting notes for the composer. The most 
common chords are often constructed by using one note out of two from a scale. We can have chords with 3, 
4, 5 notes or more. As an example, by taking the first three notes of the C Major scale (skipping one note out 
of two), we get the C Major chord [C, E, G]. So a chord is often associated to a scale and can be seen as a 
subset of the notes of a given scale, while the scale itself can be seen as a subset of all possible notes.

We may consider scales and chords as tools to help the composer to create music. Scales would be more 
oriented toward creating melodies while chords are more helpful to select the notes when several instruments 
play together. At any given point in a music composition, knowingly or not, the composer is using scales and 
chords. 

This lesson will explain you how you can use and/or create chords and scales and apply them to the score so 
as to influence the Pizzicato score arranger and the various other composition tools as the smart link and the 
musical vectors.

Chords and scales library

The Pizzicato composition library contains several scales and chords that you can use to compose music. 

• Start Pizzicato. The tree of configuration 3 displays more or less the following: 
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• Click on the "+" in front of the Scales folder. Do the same for the Common scales and Modal scales 
that appear and you get the following: 

Scales appear as an icon with four red notes on it. The first folder contains the most common 
scales as the Major and minor scales. The modal scales are in the next folder. More specific 
scales are sorted by the number of notes from 5 to 8 notes. The last two folders contain several 
miscellaneaous scales.

• You can double click on the name of a scale to display and/or edit the scale or you can click on it 
with the right mouse button (ALT+Click on the Mac) and select the Modify... menu item. In both 
cases, here is what you get for instance with the Major scale: 
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A scale is defined by its name and a series of notes. The existing scales of the library are based 
on the C note as the first note. You should always use the C note as the first note when you 
create a new scale, as we are defining here the structure of a scale, not a specific scale. Later in 
this lesson, we will see that you can apply that scale definition to any note.

You can add or remove a note to/from the scale, by checking/unchecking the last note number 
checkbox. Each note has the following attributes:

 The note name menu has all note definitions, including sharps and flats. You should keep 
the first note always equal to C. 

 You can assign a degree to each note of the scale. Degrees range from I to XX (20) so as 
to be able to create scales with up to 20 degrees (scales do not need to be one octave, you 
can indeed create very special scales ranging on three octaves for instance). 

 You can also assign a factor from 0 to 100%, giving the relative importance of that 
degree in relation to other degrees. This factor may be used by Pizzicato in other 
composition tools when a decision has to be taken regarding the selection of notes. 

• Click Cancel and click the "+" in front of the Chords folder and then expand the folders named Main 
Chords, Chords by Intervals. Inside Main chords, expand the folder named Third. The library 
displays the following (you may need to scroll down the library to see it): 
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Chords appear as an icon with A7 in red. The Main chords contain the most common chords and 
the Chords by intervals contain chords sorted by intervals and number of notes.

• You can double click on the name of a chord to display and/or edit the chord or you can click on it 
with the right mouse button (ALT+Click on the Mac) and select the Modify... menu item. In both 
cases, here is what you get for instance with the min chord: 

A chord is defined by its name and a series of notes. The chords are always based on the C note 
as the first note (which is called the Root note), as we are defining here the structure of a chord, 
not a specific chord. Later in this lesson, we will see that you can apply that chord definition to 
any root note.

You can add or remove a note to/from the chord, by checking/unchecking the last note number 
checkbox. The note name menu contains all note definitions, including sharps and flats. The first 
note is always C.

• Click Cancel. 
You can create scales and chords yourself. We recommend you to do that in the My library folder. Here is an 
example.

• Right-click the My Library folder and select New document... Give it a name, for instance My scales  
and chords. 

• Right-click that document and select New Folder... and name it My scales. 
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• Right-click My scales and select New scale... You can double-click that scale, change its name, 
define the notes and click OK. You get: 

You can organize folders, scales and chords in a similar way to create your own library that you can use to 
compose.

• There is another function that you can use to build a set of scales. Right-click the My scales and 
chords document and select the Build scales... item. The following dialog appears: 

You can specify which intervals(s) may be found in the scales and how many notes the scale 
must contain. You can give a name to the folder that will contain all possible scales that satisfy 
your choices. By default, the minor and major second intervals are selected, but you can use this 
dialog to create arbitrary scales using one or more given intervals.

• Make your selection and click OK. A new folder is created and it contains all the scales that combine 
these intervals. 

You may do the same with chords. The dialog is very similar and the program creates a folder of chords with 
all possible combinations of the specified intervals.

These automatic chords and scales building functions may be used by composers to explore specific interval 
combinations and easily deduce all the chords and scales using these intervals. This gives you raw materials 
that you can then use with the other Pizzicato composition tools.

Assigning chords and scales

We have seen that Pizzicato has a chord symbol tool with which you can specify chords symbols in the 
score. You have also the chords progression window that helps you to easily organize a sequence of chords 
in a score. These tools are still valid to enter chords and indeed should be used for standard chords as they 
are very easy to use.

You can also directly drag and drop a chord from the library into the score. Let us try this.

• Open the score by double-clicking the orange rectangle of the conductor window and move it so that 
you can still see the part of the library that contains chords. 
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• In the Chords folder, go into Main chords and then into Seventh. Click on the min7 chord and drag it 
over the first measure. While you move the mouse over the score, Pizzicato shows you in red letters 
the position in time (measure, beat and units) where the chord will be added. When you reach the 
position you want, just release the mouse button and the chord symbol is added, for instance on the 
first beat of the first measure: 

• By default, the root note is C and you can change it by double-clicking the chord symbol, so that the 
chord selection dialog box appears. 

Whenever you define a chord progression for a series of measures, Pizzicato automatically selects the scales 
that should go with the chords by some calculations using the 12 major and minor scales. These assigned 
scales may be displayed by using the reference marks tool (its shortcut is the ":" key on the computer 
keyboard).

• Add another chord, for instance A min (as above or with the chord symbol tool) and activate the 
reference marks (":"). The score becomes: 

You can see above each chord the scale that Pizzicato assigned to that chord. Of course there are many 
possibilities and according to the context, you may want to review or completely change the scales 
associated to the chords.

• In the Scales folder, open the Others (7 notes) folder. Click on the Oriental scale, drag it to the score 
and drop it on the first chord symbol. 

• Drag the Enigmatic scale and while holding down the CTRL key, drop it on the second chord symbol 
in the score. Pizzicato asks you to specify the scale tonic (the note on which the scale is constructed). 
Select for instance G. The score becomes: 

The scale you drag and drop will just replace the existing scale. By default, Pizzicato assigns the root note of 
the chord to the scale, but with the CTRL key you can select another tonic for that scale. By double-clicking 
the chord symbol while holding down the CTRL key, you can modify the tonic note of the scale.

With these simple features, you can design a chord progression and assign the scales that Pizzicato should 
use with other composition tools, mainly with the arranger and the music vectors. Indeed, while using these 
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tools, Pizzicato must often decide how to transform a melody to fit a given chord progression. In that case, 
melodies can be much better translated if Pizzicato knows what scale should be used within each chord of 
the progression. This lesson has explained to you how you can specify the chords and scales.

Composition tools - The score arranger
• Basic principle 
• Using the score arranger 
• The harmonic rules 
• The scales associated to the chords 

Basic principle

We have already explained the real time arranger, in association with the harmonic spaces. The real time 
arranger takes every note played by Pizzicato and before playing it, modifies the note so that it fits a given 
chord. The result is that the score is not the original one, but a very similar score, that fits perfectly the notes 
of the chord. This is called "arranging".

The real time arranger does this as notes come in. It does not have a way to forecast how long the note will 
play. It only knows when it starts. So the real time arranger is not subtil enough to predict for instance that a 
note will be very short and could then be interpreted as a passage note (transition note) that does not 
necessarily need to fit the chord perfectly. So melodies will have a tendancy to be distorted through the real 
time arranger.

The score arranger is not in that "fast working" frame of mind, and it may analyse the musical context a little 
bit further to create a better arrangement of the score. Moreover, it has a set of rules that may be modified to 
create more specific behaviours according to the type of music you write.

The score arranger uses the smart link function in a transparent way for the user. So it is very easy to use. 
You saw an example of it in the drag and drop lesson. We will see here how it works, how it is related to the 
chord progression and how you can use the rules or modify them.

The basic idea is that the score exists in two versions, the original score and the arranged score. The original 
score is the one you see when the measures have a white background and the arranged score is the one with a 
slightly yellow background. You can switch between both versions with the "C" check box (which means 
originally Computed measures in the lesson on smart links) that you can find in the tool bar of the score 
editor.

The arranged score is a copy of the original score, but modified by the chord progression according to a set 
of rules. Any modification done to the original score triggers the re-computing of the arranged score (at least 
the part that was modified).

Using the score arranger

• Start Pizzicato with a new document and open the conductor view. In configuration 3, locate the 
following score: 

Music libraries / Prepared styles / Fox-trot / Rhythm
and drag it on the music desktop (conductor main area). Open the score and drag again the same 
above item to the right of the second measure. You have now a score of 4 measures. This score is 
written in C.

• Open the chord progression dialog box (Windows menu, Chord progression... item). As explained in 
the chord progression lesson, add the 4 following chords so that the chord progression dialog looks 
like this: 
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• Now click the Arrange the score according to the chords check box. The check box entitled 
Recompute all is used to force Pizzicato to recompute the arrangement of the score. It is not needed 
here because it is the first use so Pizzicato will compute everything. The popup menu entitled 
Harmony used is the selection of the set of rules that will be used while arranging the score. Click on 
OK. The chord symbols have been added above the first staff. Now click on the C check box and the 
score will display the arranged version: 

You will notice that the percussion staves have been automatically excluded from being 
modified by the arranger.

• Open the Instruments view in the Windows menu. Select the configuration named MIDI Parameters 
(on the upper left triangle inside that window). The four following columns are related to the score 
arranger: 

 Arranger - This menu contains the following choices, that are used by the arranger to 
apply specific rules: 

• Automatic - The arranger estimates itself what kind of voice this staff 
represents. 

• Bass - The voice is a bass voice (monodic) 
• Melody - The voice is the melody (monodic) 
• Other voices - The voice is an middle voice, between melody and bass 

(monodic) 
• Chords - The voice may contain chords or polyphonic parts. 

The default value is Automatic, but you may modify it to influence the way the 
arranger works.
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 Fixed - When you check this box, the arranger will not modify this staff. However, it will 
take it into consideration to arrange the other voices, for instance when it tries to balance 
the notes of a chord. 

 Lower note - This is the lower range of the instrument and the arranger will avoid using 
notes lower than this one. If the score was designed with the instrument library, the range 
has been assigned for that instrument. Otherwise, the default range is the full MIDI range. 

 Upper note - This is the upper range of the instrument and the arranger will avoid using 
notes higher than this one. Same remark as above. 

• At any time you may modify the chords or the original version of the score and the arranger will 
again compute the arranged measures. 

Two additional menu items have been added in relation to the arranger (and also to the smart link function). 
These are in the Edit menu and you can use them for the full score or for a selection of measures:

• Fix smart links- This menu copies the arranged versions of the selected measures (or all measures if 
none are selected) into the original measures and then removes the arranged versions. It then disables 
the score arranger. The result is that you have one normal score with the final arrangement version. 

• Remove smart links - This menu removes the parameters and computed version of the score so that 
only the original measures are kept. You should also disable the arranger in the chord progression 
dialog box, otherwise the computed measures will be recreated whenever you modify the chords or 
the score. 

The harmonic rules

The score arranger uses a set of rules to arrange a score. Open the Harmony library... of the Options menu 
and the Harmony manager dialog appears. This dialog lists the available sets of rules in the bottom list 
(harmony list). When you click on one set of rule, you see the list of the rules in the upper list and when you 
select one rule, you can see its various options on the right part of the dialog. Click on the Standard set of 
rule. This is the set of rule used in the score arranger by default.
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The button below, entitled Add, Delete and Duplicate are used to manage the sets of rules. You can create a 
new set, remove a set or duplicate a set to modify it.

The first text line on the right is a comment on the rule, it can be modified. Then there is the type of the rule 
in a popup menu. Depending on the type of rule, you have For each rule you can specify the influence factor, 
which will moderate the use of the rule. If you set it to 100 %, then the rule should never been violated and if 
Pizzicato can't find a solution, the corresponding notes will be replaced by rests. Here are the descriptions of 
the various types of rules and their parameters.

• Range 

With this rule, you can determine the range of the voices. The default rule is to use the ranges of 
the various instruments, as defined in the instruments view. But you may also specify the upper 
and lower range here for the bass, melody or other voices. You may create more than one rule of 
this type to define all ranges.

• Intervals between voices 

With this rule, you can define the minimal and maximal intervals between the voices, in half 
tones.

• Balance of the notes of a chord 

This rule forces the arranger to use the various notes of a chord (if they are present in the current 
chord), according to the number of notes it has to arrange. Above this rule, there is the principle 
that the third and seventh intervals will be preferred to the 5th.

• Melodic intervals 

With this rule, you can orient the kind of melodic intervals that will be used by the arranger. You 
may define this for any voice. The rule is to give a list of half tones intervals, separated by 
commas and to specify if an interval may be lower or equal, greater or equal or not equal to the 
given list of intervals. As an example, if you do not want a false fifth to be used in any melodic 
voice, specify "6,-6" in the list and select May not be equal. The minus sign means a interval 6 
half tones down. As for the other rules, you may create several rules of the same types and 
different characteristics.

• Parallel and direct intervals 

You may specify here which parallel or direct intervals are forbidden. Specify between which 
voices and the list of forbidden intervals. By default, parallel and direct fifth and octaves are 
forbidden.

• Arranged range 

This rule gives the range interval up and down the original note (the note from the original score) 
around which the arranger may replace the note. For instance, if you set this to 2 and 2, the 
arranger will have only a margin of 2 half tones up or down the original note.

• One note movements 

When this rule exists, Pizzicato will favour one note movements over more wide movements.

• Opposed movements 

When this rule is present, Pizzicato will favour opposed movements of voices (one voice up, the 
other down).

• Low intervals 
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This rule helps you to avoid too lower intervals. The list must contain two numbers per intervals. 
The first number is the interval and the second the lower pitch (MIDI value) at which this 
interval may appear. You may have a list of more than one pair of interval/note, separated by 
commas. For instance the 7,36 value means that a fifth interval may not be placed lower than C1 
(MIDI value 36).

• Resolutions 

You may specify here the preferred direction of a given note (down or up), either as a reference 
to a chord or to the degree of the associated scale.

• False relations (chromatism between voices) 
The presence of this rule implies that Pizzicato will avoid false relations, i.e. chromatic 
movements between two voices, like C in one voice and after that C# in another voice.

• Various options 

This rule gives the value of three parameters. The first is the Chord anticipation duration given 
in units (480 units = one quarter note). This means that if a note is played that duration before a 
chord change occurs, that note will already use the next chord. 

The next parameter is the note duration limit under which a note will not need to fit the chord 
notes but only the associated scale notes. By adjusting this duration to the type of music you 
compose, you may avoid that continuous melodies become arpeggios too easily.

The last parameter is Use the closest note. This parameter forces all arrangements to use the 
closest note that fits the current chord or scale.

You should know that Pizzicato presently uses these rules only to go forward. The first chord is analysed and 
all possible arrangements are listed. Then these possibilities are evaluated according to the rules and the best 
compromise is used to write a solution in the score. This solution is the final one. Then Pizzicato goes to the 
next chord and do the same, taking into account the previous chord when necessary (resolution, parallel 
5th ,...) and once again finds all possible solutions and evaluates which one is the best compromise. If there 
is an impossible or bad solution, Pizzicato will presently not back up and modify the previous chord, but it 
will use the less worse case or none if a rule must be 100% verified.

You may try to define rules that are more or less adapted to a kind of music and in general make some 
experimentation with them. Notice that the arranger is not limited to a few voices and may also be applied to 
a full orchestra. This may take a bit longer for Pizzicato to arrange, because the number of combination are 
more numerous, but it should work correctly.

A practical application of the score arranger would be the following:

• You create a melody. Then you analyse the chords with the chord analysis tool of Pizzicato. The 
chord progression is then established. 

• In the instrument view, you fix your melody so that the arranger will not modify it. 
• You add one or several staves for accompaniments intruments and in each one you fill in a constant 

note (a whole note). 
• Then you enable the arranger and Pizzicato will suggest you the accompaniment voices that fit with 

the chords and with your melody. 

The scales associated to the chords

When Pizzicato arranges a score, it first makes an analysis of the scales that may best fit the chord 
progression. For this it uses the scale definitions that are defined when you choose the Scale library... item 
of the Options menu:
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You can define additional scales here. They will be used by the arranger. The left list is the existing scale 
list. When you select a scale, you may change the number of notes and the note pitches, the associated 
degree and also an importance factor, which stresses the main notes of the scale and is used to find which 
chord fits the best with it. The Delete and Add buttons are used respectively to delete and add a scale. By 
default, this dialog contains the most common scales and it is not necessary to define or modify the scales. 
Click Cancel.
 

Composition tools - The music vectors
• What is a music vector? 
• Practical examples 
• The structure of a music vector 
• The melodic part 
• The melodic wave 
• The rhythmic aspect 
• The velocity wave 
• Additional examples 
• The music vectors library 

What is a music vector?

The music vector is an experimental tool to help you to create melodies and multiple melodic parts in a very 
intuitive way. You do not even need to be able to read music notation to use these vectors.

You can add one or several music vectors in the measures of a score and they will act like music generators. 
They will generate notes and rhythms that you can see in the measures and hear when Pizzicato plays the 
score.

A music vector contains in itself the potential of creating notes and rhythms according to several 
specifications that you decide.

The music vectors must be combined with chords and scales progressions. Scales and chords have been 
described in a previous lesson. You could say that the raw melodic structure is created by the vectors and 
that it is then arranged according to the chords and scales.

A music vector gives the global direction and shape of a melodic part. It is then refined by Pizzicato to fit the 
scales and chords progression of your choice. The result is a powerful way to experiment with music 
composition.
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These vectors can be used as they are or you can create new original vectors and use them. The Pizzicato 
libraries contain thousands of these vectors and you can start using them without even knowing what their 
structure are in details. Using them is very simple. Creating them is a bit more complex but so much 
powerful for music experimentation and intuitive composition. So let us start with practical examples 
explaining how to use them.

Practical examples

To create music with vectors, you need the following:

• A set of vectors (Pizzicato has thousands of them ready for use) 
• A chord progression (Pizzicato has lots of them as well and also tools like the harmonic space to 

create chords progressions intuitively) 
• A set of staves and measures with instruments ready to play 

Let us start with a very simple case, to illustrate the principle.

• Open a template, in the File menu, selecting respectively Open template... >> Soloists >> Woodwinds 
>> Flute - 1 page and open the Conductor view in the Windows menu. Open the score view and 
move it so that you can see the score and the libraries. 

• In configuration 3, open the Music libraries folder, then Music vectors >> Melodic structures 1 -  
Soloists >> Melodic structures 2 and 4 measures >> 2 measures >> Sinusoïd. The tree displays: 

The music vectors are displayed with icons like this: .

• Drag and drop the vector named 001 into the first measure of the score. The score becomes: 

This vector contains a melodic shape that is similar to a full cycle of a sinusoïdal wave (up, top, 
down, bottom, up again). This is a raw shape and it does not fit with any chord or scale. It has 
not been refined with harmonic materials.

You will notice that the vector icon is now associated to that measure.

• Drag and drop the vector named 007 in the third measure. The score becomes: 
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Most sets of vectors are grouped by 50 different rhythmic patterns, numbered from 001 to 050. 
You will notice that the general shape of the two vectors are quite similar but the rhythmic 
content is quite different. We will now add a chord progression so that the melody will follow a 
more harmonious path.

• In the library tree, open the Chord progressions folder in the Music libraries folder, then open 
Measure 4-4 >> C Major - 3 notes chords >> 4 measures - 1 chord/measure >> C Major. 

• Drag and drop the sixth item of that list, "6", on the first mesure of the staff. In the Edit menu, select 
the item named Compute parametered measures (or CTRL + R as a shortcut or Cmd+R on the Mac). 
The score becomes: 

The shortcut CTRL (or Cmd) + R is needed to force Pizzicato to recompute the vectors so that 
they are adapted to the chords. Using this shortcut recomputes all the vectors of a score.

The melody has been adapted to the closest notes of the chords and scales. This is the basic 
principle of vectors combined with chords and scales. Remember that you can assign scales to 
the chords, as explained in the lesson on scales and chords.

Here is another example.

• Open a template, in the File menu, selecting respectively Open template... >> Orchestra >> 
Symphony 2 - Beethoven - 1 page and open the Conductor view in the Windows menu. Open the 
score view and move it so that you can see the score and the libraries. 

• Add the following chord progression in the first measure of the score: Music libraries >> Chord 
progressions >> Measure 4-4 >> Major tonalities - 3 notes chords >> 4 measures - 2 
chords/measure >> G Major (1 #) >> 1 - 100 >> 43/3. Activate the reference marks tool (shortcut 
":") to see the scales associated with the chords. 

• Drag and drop the following vector in the first measure of the first instrument (Flute): Music 
libraries >> Music vectors >> Melodic structures 4 - Quartet >> Intervals of 8 semitones >> 4 
measures >> Up+Down 1 octave >> 020. As the chords have been placed before adding a vector, the 
vector will be computed directly with the chords, so you do not need to force Pizzicato to recompute 
the measures as in the previous example. The score becomes: 
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• You can drag and drop a vector by clicking it directly from the score to duplicate it. Try it by 
dragging vector 020 from measure 1 of the flute to measure 2 of the Violins I staff. Listen to the 
result. 

• To delete a vector from the measure, move the mouse over its icon above the measure and use the 
delete key (or the backward key that deletes the last character). The vector and its notes disappear. By 
doing the same operation while holding down the SHIFT key, the vector is deleted but the generated 
notes stay in the measures. 

• When you add a vector in a measure that already has a vector in it, the old vector is removed before 
adding the new one. You can avoid this by holding down the CTRL key while you drop the vector in 
the measure. In that case, the second vector is added in the measure with the first one. 

Using the vectors is just a question of dragging and dropping icons in the score. It is very simple. There are 
numerous possibilities, even when you do not create your own vectors. You should now experiment this by 
yourself using the various chords progressions, vectors and instruments templates that you can find in the 
libraries.

The structure of a music vector

A music vector is made out of one or more melodic parts. A melodic part corresponds usually to a melody. 
A vector may contain several melodies that are assigned to a series of staves, as in the example shown above 
for the orchestral score.

A melodic part consists of:

• One rhythmic part. It will determine the rhythmic values of the notes generated by the melodic part. 
• One or several melodic waves. Their combination will determine the shape of the melodic part. 
• One or more optional velocity waves. A velocity wave will influence the sound volume of each note. 

A rhythmic part may contain one or more Rhythmic harmonics.

We can represent a general music vector as follows:

• Music vector
• Melodic part 1

• Rhythmic part
• Rhythmic harmonic 1 
• Rhythmic harmonic 2 
• ... 

• Melodic wave 1 
• Melodic wave 2 
• ... 
• Velocity wave 1 
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• Velocity wave 2 
• ... 

• Melodic part 2
• Rhythmic part

• Rhythmic harmonic 1 
• Rhythmic harmonic 2 
• ... 

• Melodic wave 1 
• Melodic wave 2 
• ... 
• Velocity wave 1 
• Velocity wave 2 
• ... 

• ... 
We will now explain each one of these elements in details. To do that, we will first create a new, empty 
vector.

• Right-click on the My Library folder and select New document... You can name it Vector. Right-click 
that document and select New vector. Then double-click the Musical vector icon. The following 
dialog appears: 

The left part represents the tree of the structure of the vector. This vector is presently empty, 
there are no melodic parts in it. The only icon shown displays the vector itself. This node of the 
tree is selected in blue.

The right part of the dialog displays the parameters of the selected node, which are here the 
parameters of the vector itself. Here is a description of each element.

 The Update button may be used if you edit directly a vector that is inside a measure of 
the score. You can indeed double-click a vector icon associated to a measure. When you 
modify the vector and click the update button, the measures are recomputed to show the 
resulting notes. 

 The Paste button is a very useful feature. You can copy the content of one or several 
measures and staves from an existing score (to do that, just select the measures and use 
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the Copy item of the Edit menu). Then you can use this Paste button and Pizzicato will 
automatically build this vector in such a way that this vector will generate the content of 
the original measures. You can for instance copy a few measures of a Mozart piece of 
music and create a vector from of it. You can then apply this vector to a new score in 
which you have designed a custom chord/scale progression and see what the Mozart 
measures sound like when applied to that progression. A lot of interesting manipulations 
of music can be done with that feature. You can extract the structure of an arrangement 
and apply it with different chords and instruments, in a few clicks. 

 The Auto check box is checked by default, which means that any modification of the 
vector will directly be applied to the measure associated to the vector (only if you edit the 
vector directly from a measure). Any modification you do will automatically activate 
theUpdate button. 

 With the Name textbox, you can change the name of the vector. 

 The Basic note item gives you the note on which the vector is based. All pitch references 
that will appear in the melodic waves of the vector will be expressed relative to this basic 
note. The Select... button displays a piano keyboard on which you can select another 
basic note. By changing this note, all melodies will be transposed accordingly. 

 The popup menu just below the basic note contains three choices. The first one is Always  
use that note. It means that the basic note will always be used as the reference note for the 
vector. The next choice is Root of the chord which means that the reference note will be 
the root notes of the chords present in the measures where the vector will be developed. 
The last choice is Root note of the scale which is the same but with reference to the root 
notes of the scales present in the measures. In the last two choices, it means that if a 
vector is applied for instance on 8 measures, each one having a different chord, the 
reference note will be changed for each measure. If the vector is a smooth curve going up 
accross 8 measures, there will be a discontinuity between each measures, as the root notes 
of each measure will be different. 

 The Amplitude value may be changed by a textbox or with the horizontal scroll bar just 
below it. The default value is 100 (%). By changing this value, you will increase the pitch 
range of the melodic waves included in that vector. 

 The Full period defines the global duration of a vector period. It is defined in terms of 
quarter notes and units (one quarter note is 480 units). The scroll bar below it helps you 
to change it with standard values but you can define the exact value with the two 
textboxes. This period defines the default period for all melodic waves. 

 The Number of periods specifies how many times the full period will be covered by the 
vector. A vector may be 200 measures long if needed, there is no specific limit to the size 
of the melody produced by a vector. 

 You can fix a Maximal duration to the total duration generated by this vector. By default, 
it is set to zero, which means that there is no limit. The value is defined in quarter notes 
and units. 

 The Random root value is set by default to 0. This means that when a melodic wave uses 
a random wave, the resulting vector will always be different, each time you recompute it. 
You can change this number to a non zero value, and the resulting vector will always be 
the same, even if apparently randomized. This helps you to keep the vector constant, but 
it can be used for experimental music as the score will change whenever you recompute 
it. 
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The selected line contains the name of the vector, the basic note and a summary of the main parameters.

The melodic part

A vector may have one or more melodic part. A melodic part is like a melody. It produces one melodic 
voice, one note at a time, with specific rhythmic values. You can add melodic parts to a vector.

• Right-click the main node in the left part of the dialog and select the New melodic part item. The 
dialog displays: 

• Select the second node (with the  icon), starting with Melody 100%... The right part of the dialog 
now displays the parameters of that melodic part: 

Here is a description of these parameters.

 The Transposition value is used to transpose this melodic voice up or down, relative to 
the basic note of the vector as defined in the vector parameters. You can then transpose 
each melodic voice with a different interval and produce a set of melodies playing 
together. 

 The Amplitude value is by default set to 100 (%) and influences the range of that specific 
melodic voice. 

 The Staff value gives the staff number, relative to the staff on which the music vector has 
been placed. A value of "1" means that this melodic part will be developed on the staff 
containing the vector. A value of "2" will place the melodic part on the next staff, and so 
on. 
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 The melodic part may start at any moment inside the measure. By default this Measure 
start parameter is set to 0. It is defined in quarter notes and units. By setting this offset 
value for instance to 2 quarter notes, the melodic part will start in the middle of a 4/4 
measure. With this parameter, you can shift the various melodic parts of a vector. 

 The Melodic reference is a more subtil parameter. The melodic waves of a melodic part 
combine themselves into a continuous curve. The resulting notes are computed on this 
curve. If the rhythmic part specifies for instance 4 quarter notes for the rhythms, Pizzicato 
must select four notes, each of a quarter note duration. Each quarter note duration must 
generate one note, but the continuous melodic curve may take various values during a 
quarter note (it may for instance start low and increase progressively higher at the end of 
the quarter note duration). So the question is: what is the reference point on which the 
pitch of the note will be computed? This menu gives three possible choices: Start of the  
curve, End of the curve or Mean curve value. So Pizzicato takes either the beginning 
value of the curve, the end value or the mean value computed over the duration of the 
note. Here is an example of a sinusoïdal wave and the resulting notes, in each case (start, 
end and mean values): 

 The next three choices are External notes, Scale notes and Chord notes. Each one has in 
fact two values that define a range of duration, expressed in units (480 units make a 
quarter note). A rhythmic part (which will be described in the next section) is always 
included in a melodic part and defines a series of durations for the notes that must be 
generated. If the duration of the note is included in the range defined by the Chord notes, 
the pitch of the note will be selected to be the closest pitch to the continuous curve but 
that is also part the the current chord (the chord that is present in the score at that point in 
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time). If the duration of the note is included in the range defined by the Scale notes, the 
pitch of the note will be selected to be the closest pitch to the continuous curve but that is 
also part of the current scale. If the duration of the note is included in the range defined 
by the External notes, the pitch of the note will be selected to be the closest pitch to the 
continuous curve with no attention to the scale or the chord. The basic idea behind this is 
that the longer the duration is, the best the note must sound (relative to the context of the 
other melodic parts). The best is to be part of the chord. The next best is to be part of the 
scale. So we find that long duration notes will be taken from the current chord, shorter 
notes will be taken from the current scale and very short notes may be used as they are. 
These values may be adjusted according to the context of the music you write. 

 The last menu entitled If no possible note, specifies what must be done if the note 
duration does not fit one of the three duration ranges. The default choice is Use original  
note, which uses the note closest to the curve and the other is Place a rest, which means 
that Pizzicato just skips that note and add a rest in the melody. 

The melodic wave

A melodic part may contain one or more melodic waves. A melodic wave is a simple wave form. It gives a 
specific shape to the melodic line. All melodic waves combine themselves to create the melodic part curve.

• Click on the melodic wave so that it is selected, in blue: 

On the right part, the dialog displays the parameters of the melodic wave:

Here is a description of these parameters.
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 The Wave form popup menu contains several shapes that can be used to form the melodic 
wave: 

 Constant: The curve is just an horizontal line, always the same note: 

• Sine wave: 

• Square: 

• Triangle: 

• Up: 
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• Down: 

• Pulse: 

• Free: you can draw a custom curve manually, freely (see below). 

• Random: the curve is just random noise and notes are picked up randomly. 

• The Pulse width value expresses in % (20 by default) the relative width of the pulse (see 
the Pulse shape above). 

• The Free curve has two buttons. With the Paste button, you can paste an existing melody 
so that Pizzicato will extract the shape of the existing melody and store it into the free 
curve memory. To do that, you must first select one or more measures in an existing 
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score and copy these measures (Edit menu, Copy item) then use this Paste button. The 
Edit... button opens a free curve editor: 

The Update button forces Pizzicato to compute the measure, so that you can see the 
notes generated by your free curve. For instance, it could be:

The pen icon is used to freely draw into that window and create a free curve. The 
next icon is used to draw a line (click, drag the line and release the mouse).

• The Transposition value is used to shift that curve up (positive) or down (negative). The 
effect is that the notes are transposed in the final curve. Notice that the transposition of all 
melodic waves are combined (added) to create a global transposition for that curve. 

• The Upper range and Lower range values are used to limit the curve in both directions 
(up and down). The value is expressed in semitones and the default range is 12, which 
means one octave. So by default, a wave will go up or down by one octave. Notice that 
this range may be modified by the Amplitude factors defined in the Melodic part and in 
the vector parameters. 

• The Wave phase is a number ranging from 0 to 360 degrees. It will shift the cycle of the 
wave so that its starting point is moved in time. Here is for example a sine wave with a 
phase of 90 degrees: 

• The following three values (Full period, Number of periods and Maximal duration) have 
exactly the same meaning as the equivalent values explained in the vector parameters. By 
default, they are set to zero, which means that this melodic wave will use the default 
parameters defined in the vector. By specifiying non-zero values here, this specific 
melodic wave will use them and ignore the vector parameters. In this case, changing the 
vector parameters later will no more influence the period and duration of this wave. 
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The rhythmic aspect

A melodic part has always one rhythmic part. The rhythmic part determines what rhythmic values will be 
assigned to the notes generated by that melodic part.

• Click on the rhythmic part to select it: 

The right part of the dialog now displays the rhythmic part parameters:

Here is a description of these parameters.

• The Rhythm construction mode menu gives three ways to build the rhythm. The first one 
is entitled Harmonics and is based on rhythmic harmonics. A rhythm is assembled by a 
series of single rhythmic values. Each value is defined by a rhythmic harmonic node that 
can be added to the rhythmic part. 

• Click on the Harmonic(1) node to select it: 

The right part of the dialog now displays the parameter of that rhythmic harmonic:
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Here is a description of these parameters, which define a single rhythmic harmonic. 
The final rhythm is the combination of all rhythmic harmonics. By harmonic, we 
mean something that is periodic and has a cycle, a duration, after which the rhythm is 
there again.

 The Frequency parameter defines how many rhythmic values will be included 
in one rhythmic cycle. If the period is one 4/4 measure and the frequency is 
"1", this rhythmic harmonic will generate one note per measure. 

 The Velocity parameter will determine the MIDI note velocity of this 
harmonic, between 1 and 127. It influences the sound amplitude of that note 
in the resulting melody. 

 The Delay value is the duration after which the note will be played, relative to 
the beginning of the cycle. It is defined in quarter notes and units. In a 4/4 
period, with a frequency "1" (one note per period), if the Delay is set to 2 
quarter notes, the note will be played on the third beat of the 4/4 measure. 

 The Duration value determines the duration of the generated note, in quarter 
notes and units. In a 4/4 period, with a frequency "1" (one note per period), a 
duration value of 3 quarter notes would create a dotted half note every 4/4 
period. 

There can be several rhytmic harmonics that combine to make any kind of rhythm. 
To add a new rhythmic harmonic, right-click on the Rhythmic part and select the 
New rhythmic harmonic item.

If you have an existing rhythm pattern, written in one or more measures, there is an 
easy way to translate it into a rhythmic part. Select these measures and copy them 
(Edit menu, Copy item). Then click the Paste button that is located just above the 
Rhythm construction mode menu, in the Rhythmic part parameters. Pizzicato remove 
the existing rhythmic harmonics and creates a set of new hamonics that will generate 
the same rhythm when applied as a vector.

• The second value of the Rhythm construction mode menu is Fragmentation. When you 
select this choice, four sliders called Levels of fragmentation appear below the other 
parameters: 

The principle of rhythmic fragmentation is to divide the main cycle (by default it is a 
4/4 measure) into four sections and to create all possible combinations of these 
sections. In the default case where the cycle is a 4/4 measure, no fragmentation 
would be a whole note. This is fragmentation number "0". A total fragmentation 
would be four quarter notes. The first slider specifies the fragmentation you want. 
"0" means no fragmentation (one whole note) and "32" means total fragmentation 
(four quarter notes). Intermediate values explore all possible fragmentations of a 
whole note. This is the first level of fragmentation.

The second level of fragmentation takes each duration generated by the first level of 
fragmentation and does exactly the same with that duration. For instance, if you 
define 32 for both first and second levels, the first level gives you four quarter notes 
and the second level divides each quarter note into four sections, so that we get a 
measure with sixteen 16th notes.
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The levels three and four apply the same principle and the note durations are less and 
less. Usually, with a one measure cycle, we can use the first two levels. When the 
cycle is longer, you can use more then two levels. However, you may do as you want 
if you want to experiment various special melodies.

• The last value of the Rhythm construction mode menu is Original rhythm. This means 
that Pizzicato will use the rhythm already present in the destination measure where the 
vector will be applied. You can for instance apply the vector on an existing melody and 
the rhythm of the melody will be used as it is. If no original rhythm is present inside the 
destination measure of the vector, quarter notes are used. 

• The Total duration value is expressed in quarter notes and units. The default value is 
zero, which means that the vector period duration is used. Otherwise, the specified value 
is used for the period duration of this rhythmic harmonic. 

• The Duration value specifies the duration of the note in %. When a quarter note should 
be generated, a value of 50 % would produce an eighth note. 

• The Use of rhythm menu has three values. The default one is Repeated, which means that 
the harmonic is repeated every cycle. The One time only value produces the rhythm only 
once. The Stretched value produces the rhythm only once, but will stretch the full rhythm 
over the total number of periods. It will just fit the timing of the rhythm to the duration of 
the vector. 

• The Monodic check box, when checked, will avoid several rhythmic harmonics to play at 
the same time (it is possible indeed that several harmonic be defined and generate 
rhythms crossing each others). So it makes the resulting rhythm monodic (one voice at a 
time). 

The velocity wave

One or more Velocity waves may be added to a melodic part. These waves will in fact influence the MIDI 
velocity of the generated notes.

• To add a new velocity wave, right-click on the melodic part and select the New velocity wave item. A 
new icon  appears. If you select this velocity wave, the right part of the dialog displays the 
corresponding parameters: 
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These parameters are exactly the same as the melodic wave, but the result here is to influence the MIDI 
velocity (sound amplitude) of the notes and not their pitches.

As you can add several velocity waves, their combination (addition) will produce a curve that will determine 
the velocity of each note in the melodic part.

Additional examples

The above descriptive theory may seem a bit abstract, so we will give a practical example of how you can 
experiment with music vectors.

• Create an new document in Pizzicato and open its conductor view. Right-click on the document 
(green icon, configuration 1) and select New vector... 

• In configuration 3, expand the Basic instruments node and select one instrument of your choice. We 
will take for instance the flute (in the Woodwind folder, Flutes subfolder). Drag the Flute icon to the 
right part of the window and double-click it to see the score. 

• With the measure tool (double-click the measure), add three measures. 

• In the Windows menu, open the Graphic editor... window. 

• Drag the Musical vector icon from the document into the first measure of the score. 

• Double-click the Musical vector icon that is now visible on the first measure. 

• Reorganize your screen so that you have the following layout: 

The purpose is to see the score that will display the resulting notes as you construct the vector structure. The 
graphic editor window will also display the notes visually and you will notice that the raw curve of the 
vector will also be displayed, which is interesting to watch as you design a melodic curve.

• Right-click on the selected vector node in the vector dialog and select New melodic part. 

• In the vector parameters, change the Amplitude to 50 %, the Full period to 8 quarter notes and the 
Number of periods to 2. 

The graphic view should now display (you may need to scroll or adjust the scale of that view):
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• Click on the Rhythmic harmonic and set its Frequency to 16 and its Duration to 0 quarter notes and 
240 units (which is an eighth note). The score now displays: 

The melodic curve follows an up and down shape and the rhythm is 16 notes per period (the period being 2 
measures). There are two periods. The amplitude being set to 50 %, we get approximately half an octave up 
and down from the central point. The central point is C3 by default.

• Select the vector parameters, change the Basic note to G3 and watch the transposition of the melody. 

As there is no scale or chord associated with the measure, the notes are selected as close as possible to the 
melody shape but they do not sound quite melodic.

• By going into the Scales folder, then the Others (7 notes), drag for instance the Oriental scale on the 
first measure and the Hongarian major in the third measure. Click the Update button of the vector 
dialog and the notes become: 

At any time you can listen to the score. You may even set the loop to 4 measures and hear it in loop. You 
can then have a direct feedback of the parameters modifications.

• Click on the melodic wave (called here Sine wave by default) and test all possible values of the Wave 
form menu. Watch the result and listen to it also. When you reach the Free choice, click on the Edit... 
button and draw an arbitrary curve, then click OK. Watch and listen to the resulting melody. While 
doing that, you can of course pick up other scales in the library and drag and drop them into the 
measures. Here is what we got for instance with a free curve: 

• Click on the Harmonic part and select the Fragmentation in the Rhythm construction mode. Set a 
fragmentation of 32 for the first level (first slider), but you may try other values to watch the 
influence. Try now several values of the second fragmentation level. Try also to modify the first level 
again. You will be able to make numerous rhythmic patterns. You can listen to them in loop to hear 
the sound result. Using the level three and four will give some peculiar results, but you can try and 
experiment them. Try also with other instruments, just by dragging an instrument from the library 
into the first measure. 
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You can also combine more curves together. For instance, let us make a vector that has a period of two beats 
but that goes slightly up on a four measure duration.

• To remove this melodic part, right-click on it (in the vector dialog) and select the Remove this  
melodic part. Then add a new melodic part to this vector (right-click and select New melodic part). 

• In the vector parameters, set the Full period to two quarter notes and the Number of periods to 8. 

• Click on the Rhythmic harmonic and set its Frequency to 8 and its Duration to 0 quarter notes and 
120 units (a sixteenth note). 

• Click on the Melody 100% node and drag the scroll bar completely to the left for the External notes. 
This forces notes shorter than the 32nd to be free but longer notes will always be adapted to fit the 
current scale. 

• Click on the Sine wave and set the Upper range and the Lower range to 4. 

• Right-click on the Melody 100% and select the New melodic wave item. The melody suddenly 
changes. Another sine wave has been added and contributes to the melodic shape. We will transform 
this melodic wave into a slowly rising curve over the 4 measures. While doing the following 
modifications, please notice all the various intermediate resulting melodies. You can experiment a lot 
by changing a few parameters. 

• Click on the new Sine wave node and change its Wave form to an Up curve and set its Full period to 
16 quarter notes. To increase the range, you can set its Upper range for instance to 24. The curves 
and notes become: 

There are numerous possibilities to create music vectors and combine them together and with scales and 
chords. Just try for yourself. Take each parameter and change it just to see and hear the effect.

You can also use and edit the existing vector library that goes with Pizzicato. You can explore them to see 
how they have been constructed and copy them to modify them. You can do that on a multi-instrument score 
and place different vectors in various instruments and measures and create music composition just like this.

Here are a few tips that you can use while working with vectors:

• You can drag and drop a vector from one measure to another. The vector is copied and becomes 
independant (if you edit the original, the copy does not change). 

• If you hold down the CTRL key while dragging and dropping a vector from one measure to another, 
you create an Alias of the vector. It is then displayed in italic green. An alias is a copy that changes 
with the original vector. The copy keeps a link to the original so that any modification of the original 
will affect all alias copies of that vector. You can use this if you work on a multipart score and if you 
want to experiment changes to a vector that must appear in several measures and instruments. 

• You can open two or more different vector dialog windows and you can drag and drop the various 
nodes (Rhythmic parts, melodic waves,...) between them. This can be useful when you have created a 
rhythmic part or a melodic part that you would like to use in another vector. 

The music vectors library

The music composition libraries of Pizzicato contains thousands of predefined music vectors. They are 
available in the Music vectors folder. Remember that to use a vector, the only thing to do is to drag and drop 
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it to a measure in any score. It will then generate the notes in that score, according to its specifications. The 
library is classified as follows:

• Arpeggios - Soloist: A series of arpeggio sequences by 1, 2 or 4 measures, with various note 
durations and ranges, with numerous curves. 

• Melodic structures 1 to 5: they contain melodic patterns for 1, 2, 3, 4 and 5 instruments, with various 
intervals between instruments, various ranges and rhythms, with a duration of 2 and 4 measures. 

• Miscellaneous: some examples of how one or more existing measures may be translated into a 
vector. You can then apply it to a score with chords and scales as an experiment. Notice that a full 
piece of music can be translated into a vector, with the Paste button as explained in this lesson. 

Composition tools - Virtual keyboards
• Virtual keyboards 

Virtual keyboards

The purpose of a virtual keyboard is to expand the playing possibilities of a single musical keyboard and to 
make it possible to play several instruments with only one keyboard. This principle is common in most 
synthesizers and is often called a performance. It is a preset of various sounds programmed on the keyboard 
and that may be used together in a performance.

A virtual keyboard is a musical object that may contain several instruments. It takes its input from a MIDI 
input port connected to a musical keyboard. If you do not have a musical keyboard connected to your 
computer, you may still use the virtual keyboard but it will be more limited, mainly because the mouse is not 
easily handled to play on a keyboard displayed on the screen.

To show how a virtual keyboard is build and used, we will create one as an example.

• Start Pizzicato and open the conductor view. Click on the green document icon (configuration 1) with 
the right mouse button and select the New virtual keyboard... menu item. The following window 
appears: 

This is the dialog definition of a virtual keyboard. All values are set to their default values. No 
instrument is defined yet. For our example, we would like to have one octave of acoustic bass 
instrument. To add it, we will find it in the basic instruments of the left upper tree of the 
conductor view and drag it on the keyboard.
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• Open the Basic instruments folder and then the Bass folder as explained in the previous lesson. Drag 
the Acoustic bass instrument and drop it in the middle of the above musical keyboard. The upper part 
of the window becomes: 

The instrument specifications of the acoustic bass instrument have been copied into the 
keyboard. The brown keys are the keys included in the standard bass instrument. You may play 
on this keyboard by clicking on it or by using your MIDI keyboard. Notice that when you play 
notes beyond the limits, no sound is played. The colored notes are the notes where the keyboard 
will answer for this instrument. If you want to drag another instrument but keep the same range, 
just drag it while holding down the CTRL key.

• As we do not want to have the full range, we will limit it to one octave. To limit it to the left, click on 
a key with the left button while holding down the CTRL key. To limit to the right, click with the right 
button while holding down the CTRL key. Try it a few times to understand how it works and then 
finalize by setting the following range for the bass: 

Here is the explanation for the various parts of this dialog.

• The Title text block lets you specify a name for this keyboard setup. Name it My keyboard. 

• The MIDI input menu gives you the list of MIDI input ports from which the notes will be sent to this 
keyboard. By default, it takes the first MIDI input port available in your MIDI setup. 

The above two parameters are global for all instruments of the keyboard (here above, there is only one 
instrument defined, we will add other instruments further). 

• The Instrument menu displays the name of the current instrument (the one for which parameters are 
displayed below this menu). With this menu, you may access one of them by selecting it. The "<" and 
">" buttons helps you go from one instrument to the other, without using the menu. 

• The New instrument and Delete instrument buttons lets you add/delete one instrument to/from this 
keyboard. 

• The Modify... button gives you access to the current instrument specifications exactly as explained in 
the lesson on instruments. You may modify it through this button. 

The following parameters are specific for each instrument defined in the virtual keyboard. They are 
displayed for the current instrument (as selected by the Instrument menu).

• The two Transposition menus may be used respectively to add a fixed transposition, in half tones 
(from -12 to +12 half tones) and an octave transposition (from -6 to +6 octaves). 

• The MIDI output menu specifies where the notes of this instrument must be sent. This menu contains 
the list of MIDI output ports available in your MIDI setup. 

• 5 sliders lets you fix the volume, the panoramic, the vibrato, the reverberation and the chorus levels 
for this instrument. 
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• Two text boxes lets you specify the limits of note velocities taken into account. If the incoming note 
is outside this range, the note will not be played. This may be useful if your keyboard transmits 
velocity. You may define for instance three levels of velocity and define three instruments that are 
progressively played when the input velocity increases. For instance, you may set the piano to answer 
to the full range of velocities (from 1 to 127). Then you may add a string instrument to play 
whenever the velocity comes between 64 and 127. Finally, you may add a brass instrument that will 
play only if the velocity is greater than 100. All three instruments may occupy the same range on the 
keyboard. You will then have a keyboard that will automatically add instruments to the orchestra as 
the velocity of your notes increases. 

• The MIDI input channels... button is used to specify on which MIDI channel the notes will be listen 
to. By default, all 16 channels are used. Sometimes, multiple keyboards devices sent the notes on 
different channels to specify the original keyboard where the note was hit. This dialog may then be 
used to determine on which keyboard the notes will be taken into account. 

• The velocity curve is a little bit more technical. When you play on a sensitive keyboard (a keyboard 
that sends the velocity information in MIDI), the harder your hit the key, the higher the velocity 
level. You may want to adjust this progressive curve by moving the two sliders at both sides of the 
velocity curve. By default, the curve is standard: velocities are transmitted as received. Here are two 
additional examples: 

• No influence of the incoming velocity: all notes are set for instance to a 
velocity value of 100. You may hit the keyboard very hard or very lightly, the 
resulting force of the note will be the same: 

• The full range of incoming velocities are adapted in a small range from 80 to 
110. It will attenuate the range of velocities you play: 

• The velocity / pitch curve is an additional factor that will influence the velocity of notes depending 
on their position on the keyboard. By default, the two sliders are set to 100 (%), which means that the 
input velocity will be transmitted at 100% of its value, as well to the left than to the right of the 
keyboard. If you increase the right slider to 200, for the same incoming velocity the notes will 
become stronger when going from the left to the right of the keyboard. The higher notes will be 
played at 200 % of their incoming velocity level. 

• Two check boxes enable/disable the incoming pedal and pitch bend MIDI messages. It may be useful 
to enable the pedal action on one of the instruments and not on another one. Same for the pitch bend 
wheel present on some MIDI keyboards. 
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• The Playing mode menu is by default on Normal. It means that notes will be played as they come in 
from the MIDI keyboard. If you set it on Hold, you may play a chord and release the keyboard and 
the chord will still be hold. Whenever you play another chord, the last one disappears and the new 
one is hold. This is used to play background chords or notes so that you may play it and then use your 
hands on another part of the keyboard while those notes are still playing. It is a sort of local pedal that 
is released whenever you play a new note on this keyboard range. 

• The Polyphony menu is set by default on No limit. All notes will be played. You may set the 
polyphony limit from 1 to 8 notes. Set on 1, Pizzicato will only play one note at a time. If a second 
note comes in, Pizzicato will first release the current note and then start the new note. 

Let us continue with our example. We now have a bass playing on the first octave of the keyboard. We will 
add on the same range a vibes note that will be played 3 octaves higher than the bass note. 

• Click on the New instrument button. In the Basic instruments folder, open the Percussion folder and 
then the Chromatic folder. Drag the Vibes instrument and drop it on the keyboard. The upper part of 
the window becomes: 

• Set the range on the same octave and add a +3 octaves transposition. Play some notes in the colored 
area. They are accompanied by the vibes. 

• Add another instrument with the same button. Open the Strings folder, then the Ensemble folder and 
drag the Strings (Ensemble) instrument on the keyboard. Set the range to have: 

• Set the Playing mode menu to Hold. Play a note or a chord inside the blue area and then release it. 
The note continues to play. An important remark must be made here: when using the Hold playing 
mode, the last note of the range (here the B3 note) is used to stop any playing note and is not used as 
a note itself. So if you now play the last note, the previous playing notes will stop. Without this, you 
would never been able to stop this part of the keyboard. 

• We will now add 2 percussion instruments: the bass drum and the cymbal. We will assign them to the 
next two notes just to the right of the strings. Add an new instrument. Open the Percussions folder, 
then the Individual instruments folder and drag the Bass drum instrument on the keyboard. Set its 
range to be one note: the C4 key, just to the right of the string range: 
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• Add a new instrument and drag the Ride cymb 1 instrument on the keyboard. Adjust the range to 
have: 

• We will now add a last instrument to cover the upper part of the keyboard. Add a new instrument. 
Open the Blown folder and drag the Harmonica instrument on the keyboard. Adjust the range to: 

Our example is now complete. You may click on the "-" button just below the keyboard, on the left. This 
button switches between the edit mode (where you can modify and add instruments as we did here) and the 
playing mode (in which you see all instrument ranges and can play with it). The virtual keyboard becomes:

Notice that you can open and use several virtual keyboards at the same time. The virtual keyboard is active 
as soon as it is open. When you close it, it does not play anymore. You can active it again with a double 
click on its icon, in this case inside your document.

You may now play with it and compose music!

Composition tools - The music libraries
• The musical libraries 
• A small example 
• The content of the libraries 

The musical libraries

The music library is not itself a new software function not yet explained in the previous lessons. It is a set of 
Pizzicato documents that contain music structures and objects that can be used to compose and to structure 
music.

In this lesson, we will cover what the present libraries contain. The content of the libraries is going to grow 
with the next versions of Pizzicato. While working with Pizzicato, you will also be able to create you own 
library. You may also share your personal library with other people by sending the Pizzicato files to them.

The music libraries is a set of Pizzicato documents located in the main Pizzicato directory, inside the 
Libraries folder, itself found in the DataEN folder. Any document you add or change in this folder or in any 
folder included in it will be referenced by Pizzicato the next time you launch it. You may create any 
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hierarchical set of folders and sub-folders inside the Libraries folder. But we recommend you to do that 
within the conductor view, as explained in the lesson on dragging and dropping elements of the libraries.

If you want somebody to share your personal libraries, just send him/her the content of this folder. To use it, 
(s)he needs to copy its content inside his(her) Libraries folder.

We are of course ready to receive pieces of your personal music libraries so that we can add them in the next 
release of Pizzicato.

The idea behind music libraries is not a set of finalized compositions to listen to. Valid elements of a library 
must be: a rhythmic pattern for one instrument or for any section of instruments (percussion, orchestra,...), 
melodic or rhythmic ideas or structures to develop, chords progressions, instrument combinations, a virtual 
keyboard setup, a music generator, an harmonic space or any combination of those elements. They may then 
be used by other Pizzicato users to compose and create their own finalized compositions. It is a set of 
musical construction blocks that anybody may then use to build his/her personal music compositions.

A small example

The techniques we will use here have been explained in the previous lessons on composition tools. They are 
assumed to be understood. If you encounter any difficulty in this lesson, please review the other composition 
tools lessons.

• Start Pizzicato with a new document and open the conductor view. We will now construct a small 
music composition to illustrate how you can use this library to start composing your own rhythms. 
Create a new group of scores by right clicking the desktop and selecting the appropriate menu item. 
Give it a name, for instance My composition: 

• Locate the following node of the library (configuration 3): 

Music libraries / Patterns by instruments / Percussions / Bass drum / Prepared patterns / Bass drum 4

• and drag and drop it inside the group so that you have: 

• Set the group option to play in loop. For this, right click the background of the group and check the 
Play in loop option. From now on, you may start the group and it will continue to play in loop while 
you are building it. Increase the vertical size of the group by dragging its lower right corner below 
(but do not enlarge it, otherwise the loop will become longer than the score it contains). 

• Drag the following node in your composition so that it now displays: 

Music libraries / Patterns by instruments / Percussions / Snare drum / Prepared patterns / Snare drum 1
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• Right at the beginning of the next loop, Pizzicato will include that new score in the playing. The 
rhythmic pattern gets build progressively. Do the same with the following nodes of the library, 
adding them below each others: 

Music libraries / Patterns by instruments / Percussions / Charleston / Prepared patterns / HiHat 8
Music libraries / Patterns by instruments / Percussions / Bongos & congas / Prepared patterns / Bongos & 

congas 8
Music libraries / Patterns by instruments / Percussions / Bongos & congas / Prepared patterns / Bongos & 

congas 8
Music libraries / Patterns by instruments / Percussions / Snare drums / Prepared patterns / Tambourine 6

Music libraries / Patterns by instruments / Individual instruments / Basses / Basses - 2 notes / Bass 12
Music libraries / Patterns by instruments / Individual instruments / Continuous pads / 1/2 - Large position / 

Wide strings 7 

Music libraries / Patterns by instruments / Individual instruments / Rhythms and arpeggios / Arpeggios in  
eight notes / Arpeggio 2 

• Your composition now plays everything together and looks like this: 

• This is the main rhythm pattern of our composition. We may now arrange it in a more interesting 
sequence. A music composition, to be of interest, will not start with the full ryhthm and maintain the 
same rhythm up to the end of the score. Some variation will occur, instruments will start playing 
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while others wait,... With the tools you have learned in the lesson about the conductor view, you 
should be able to transform the above one measure sequence into the following little piece of 
arrangement: 

To do it, you must create an alias of some of the scores and you must resize the scores so that 
they are played several times. You may of course try another arrangement for this composition. 

You should understand that the decisions we have taken here to select the various instruments 
and rhythm patterns are just arbitrary decisions. Taking other choices would have resulted in a 
completely different composition. With what you have learned here, you may now start to 
compose your rhythmic patterns by combining what you find in the libraries. You may also 
create new scores with different instruments and define yourself the content of the measures and 
use them in the composition.

You may vary the instruments of the above little composition, by selecting them from the Basic  
instruments folder of the library. For instance, in the Bass sub-folder, you will find several bass 
instruments:
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Remember that you can drag such an instrument and drop it on a score by holding down the 
CTRL key. The instrument will replace the instrument of the first staff of the score. If you do not 
hold the CTRL key, the instrument is added to the score, which is not here what we want. We 
just want an easy way to test various sounds for a given score.

Another easy way to test different scores with minimal handling is that you may drag a score of 
the library and, while holding the CTRL key, drop it on one of the scores inside the group. The 
new score will automatically replace the previous one so that you do not need to delete it first. 
Warning: if the original score has aliases in the composition, they will be deleted.

Also, when you work some portion of the full composition, don't forget to use the green and red 
arrows to specify the section of the composition you want to play or loop. It is quite easy to test 
various possible sounds or patterns when Pizzicato plays it in loop. You have an immediate 
feedback to decide whether you like it or not.

We will now examine the content of the present Pizzicato music libraries.

The content of the libraries

When you display configuration 3, the library is presented more or less as follows:

At the top, it contains one main document and two folders. Here is a summary of the content of the Pizzicato 
musical libraries as they exist in Pizzicato 3.5. The main folders are also displayed and available in 
configuration 3, 4 and 5. Explore them to see where they are.

• Instruments and templates 

 Basic instruments [you can reach this folder with the key shortcut 'i' inside the conductor 
view] 
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This folder contains all the basic instruments definitions. They are classified inside 
sub-folders, by families, like the pianos, strings, woodwinds, brass,... For transposing 
instruments, you will find that the instruments are first defined without transposition 
and then you find the various corresponding transposing instruments. For instance in 
the Brass sub-folder, you will find the Horn and then the Horn in F. While 
composing with a computer, you do not need to worry about the fact that some 
instruments are transposing instruments. It is only if your score needs to be played by 
real instrumentists that you will have to take that into account, in the final steps 
before printing the scores and the parts.

The Percussions sub-folder needs some more comments. You will find all the 
individual percussion instruments inside the Individual instruments folder, which is 
the standard General MIDI list of percussions. You will also find most common 
instruments in the Classified instruments folder. We recommand using these because 
they are classified in an more natural way and some use specific grouped 
combinations, like the Toms. There are 6 toms in standard General MIDI and in the 
classified instruments/Standard drums [you can reach this folder with the key 
shortcut 'b' inside the conductor view], you will find one combined instruments with 
the 6 toms on one 6-lines staff. Same for the Hi Hat instrument (foot+closed+open).

You will also find there the Solo percussions (series of toms, woodblocks,... on the 
full range of the keyboard) and Chromatic percussion instruments as the Timpani, 
Vibes, Xylophone,...

• In the Sections and ensembles folder, you will find several combinations of the basic 
instruments, classified as templates. You may use them by dragging and dropping a 
folder of instruments to the main conductor view and have the template score immediatly 
at disposal. 

• Synthesizers - This folder is initially empty. You may add your specific synthesizers so as 
to use their instruments in your scores. This is more useful when you have several 
synthesizers and you want a better control on which synthesizer will play which 
instrument. When there is only one synthesizer, Pizzicato will assign it correctly because 
there is no other choice. To add a synthesizer, right-click that folder and select the Import  
a synthesizer... menu item. Select the synthesizer and validate. A new set of instruments 
will be created, containing all the instrument references of the selected synthesizer. 

• Virtual keyboards - This folder contains at this time only two examples of virtual 
keyboards. To use them, see the lessons on virtual keyboards. 

• Harmonic spaces [you can reach this folder with the key shortcut 'h' inside the conductor 
view] - This folder contains a few simple examples of harmonic spaces. To use them, see 
the lessons on harmonic spaces. 

• Scales - You will find here numerous scales that you can use with the score arranger and 
the music vectors. See the lesson on scales and chords. 

• Chords - You will find here numerous chords that you can use with the score arranger 
and the music vectors. See the lesson on scales and chords. 

• Music libraries 

This folder contains the main part the Pizzicato music libraries. It is classified into the following 
main sub-folders.

 Audio - This folder contains all the audio WAV files used by the virtual instruments. You 
will find 4 sub-folders in it: 
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• Papelmedia - This folder contains the audio files used by the Papelmedia 
library, as it is included in Pizzicato. 

• Samples - These are files used as various samples in the virtual synthesizers. 

• SoundFonts - Whenever you import a SoundFont file in Pizzicato so as to use 
the sounds contained in it, Pizzicato creates here a folder to store the various 
wave forms used in that SoundFont file. 

• Wave Forms - The basic oscillators of the modular synthesizer use these wave 
forms to produce their output. 

 Basic libraries - In this folder you will find the most elementary pieces of 
music materials. They are classified as follows (alphabetical order): 

• Chords [you can reach this folder with the key shortcuts 'c' or 'a' inside the 
conductor view] - The chords are themselves classified into three folders.

 Chords by scale - You will find here two folders, one with 
the triads and one with the 7th chords. Inside each folder, 
there is one music generator for each scale, including in it 
the chords corresponding to the 7 degrees of the scale. 

 Main chords - You will find here the most common 
chords, like Maj, min, 7, dim,... Each group contains that 
kind of chord for every note. 

 Other chords - This folder is similar to the above folder 
and list less common chords, also for each possible note. 

• Notes - The scores of this document contain only one note. It is a library that 
contains all the notes of octaves 0 to 6, as separated scores. They may be used 
to construct music generators for instance, in combinations with rests and 
rhythms. 

• Rests - This document contains the main rest values, each inside one score. 
They may be used to construct music generators for instance, in combinations 
with rhythms and notes. 

• Rhythm sequences - This folder contains documents, each one designed for a 
specific time signature. Inside one of the documents, you will find one or 
more music generators. They contain combinations of some basic elementary 
rhythmic values, for instances "Half notes + Quarter notes + Eighth notes". 
Inside that generator, you will find a classification of all possible 
combinations that fit the duration of the measure time signature, classified by 
the number of rhythmic values used. This part of the library contains 
thousands of basic rhythmic combinations and may be a source of inspiration 
to find and use specific rhythmic patterns. 

• Rhythms - This document contains the main rhythmic values, each inside one 
score. They may be used to construct music generators for instance, in 
combinations with rests and notes. 

• Scales - You will find here a music generator for each scale, each containing 
the 7 notes of the scales. 
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 Chord progressions [you can reach this folder with the key shortcut 'p' inside 
the conductor view] - You will find here thousands of basic chords 
progressions, organized as follows: 

• Measure 3-4 

 A minor - 3 notes chords - This document contains progressions 
of 4, 8 and 12 chords (1 chord / measure). The first folder containt 
54 basic chords progressions each with 4 chords. The other two 
contains 1000 combinations of these 54 basic progressions. All 
these progressions are written starting in A minor. 

 C Major - 3 notes chords - Same as above, but for C major. 

 Major tonalities - 3 notes chords - Same as above, but for all 
other major tonalities. 

 Minor tonalities - 3 notes chords - Same as above, but for all 
other minor tonalities. 

• Measure 4-4 

This is a similar folder, but prepared for a 4/4 measure time signature 
instead of 3/4. Some folders have 2 chords per measure.

• Various progressions 

It contains 2 series of prepared chord progressions, one with triads and 
dominant and the other with 7th chords.

You can easily adapt the time signature while you drag and drop it, with the drag and 
drop dialog options regarding the time scale.

 Effects [you can reach this folder with the key shortcut 'e' inside the conductor view] - 
Here you will find the following effects that you can drag and drop on any measure or set 
of measures to apply the corresponding effect. When you drop it on one measure, it is 
applied at the target beat. If you apply it above or between staves, the effect applies to all 
staves. When you select a set of measures, it is applied on the selected staves and the 
effect is scaled to include the range of selected measures (for a crescendo or accelerando 
for instance). You can adjust the exact range with the time factors of the drag and drop 
dialog box. 

• Chorus - You can use fixed values from 0 to 100 % of chorus level. 

• Modulation - You can use fixed values from 0 to 100 % of modulation level. 

• Panoramic - You can set a fixed panoramic position or also move from one 
position to another. 

• Pitch bend - Various effects are prepared for 1, 2, 3 or 4 beats duration. They 
include up+down, up, down, oscillation and the suppression of the pitch bend 
effect. Most are available at 25, 50, 75 and 100 % of the pitch bend range 
(which can be 2 half tones or 12 half tones, depending on the pitch bend 
range parameter of the synthesizer). 
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• Reverberation - You can use fixed values from 0 to 100 % of reverberation 
level. 

• Tempo - You can use fixed values from 40 to 380 beats per minute or you can 
accelerate or slow down in a wide range of tempo. 

• Velocity maps - A velocity map is a set of 16th note each with a specific 
velocity level. When applying that velocity map on a score, the velocity is 
copied into the original notes of that scores (without touching the other 
specifications of the notes). You can see it as a set of various accents placed 
to give a "feeling" to the music. The groups are drawn with a graphic rough 
approximation of where the accents are. The best way to have an idea on its 
content is to click on the various velocity maps to hear where the accents are 
placed. Each map is available with various levels of velocity. 

• Velocity - You can use fixed values from 0 to 100 % of velocity level and you 
can create crescendo and decrescendo by multiples of 10 %. 

• Volume - You can use fixed values from 0 to 100 % of volume level and you 
can create crescendo and decrescendo by multiples of 10 %. 

 Harmonic spaces - You will find here numerous harmonic spaces classified 
by types of chords, common notes and degrees to sequence. See the lesson on 
harmonic spaces. 

 Melodies - You will find here thousands of sequences of notes and rhythms that you can 
use to design melodies. 

 Music vectors - You will find here thousands of music vectors ready for use. You can 
drag and drop a vector in a measure to see the notes. See the lesson about music vectors. 

 Patterns by instruments - You will find here basic musical materials written, each score 
has one measure and is written for one specific instrument. They are classified by 
instruments, by time signature and sometimes by the number of notes or pitches present 
in the measure. The best way to discover this library section is to go through it and play 
each one of them. 

 Prepared structures - You will find here some examples of string instruments 
combinations. 

 Prepared styles [you can reach this folder with the key shortcut 's' inside the conductor 
view] - You will find here 35 prepared styles ready to be used with the real time arranger 
and/or the score arranger. See also the lesson on how to use styles. 

 Virtual instruments - In this folder you will find all virtual instruments included in 
Pizzicato. They are presently classified in 5 groups: 

• Components - These are modular blocks that can be used while constructing a 
modular synthesizer. They are building blocks more than predefined sounds. 
You will find here envelopes, generators and various filters. See the lesson on 
the modular synthesizer for more information. 

• Papelmedia - SoundFont version - This Papelmedia library version keeps the 
original SoundFont format. It may sometimes have a better rendering for 
synthesized instruments, but needs more computing power to play in real time 
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or export an audio file. The SoundFont synthesizers is not editable by 
Pizzicato. 

• Papelmedia - This version of the Papelmedia library is in the form of an 
editable sample reader. It needs less computing power and its quality is as 
good as the above one. We encourage you to use this version of the library. 
Moreover, a series of improvements have been made in this version, 
compared to the original library. 

• Sampled sounds - You will find presently a series of original percussive 
effects, that you can use as a percussion map on the staff (each note of the 
staff corresponds to one percussive sound). 

• Synthesized sounds - You will find here a series of virtual instruments 
constructed with modular synthesis. You can modify them. See the lesson on 
modular synthesizers. 

• My library 

This folder is initially empty. You may create in it all the documents you want, keep track of 
your composition libraries and work with them as you want. We recommand to use this folder 
instead of modifying the original libraries, so that when there will be updates available of 
the original libraries, you can download them without losing your own library parts.

Composition tools - Using styles
• What is a style? 
• Using the Pizzicato styles 
• Interactive styles and chords exploration 
• Importing styles from the Internet 
• Extract the instrumental patterns 
• Summary 

What is a style?

Music is basically composed of notes and rhythms combined into innumerous possibilities. When you take 
some notes together, you have chords, which are little constructions done with notes. When you create a 
rhythmic pattern and some repeated melodic patterns played with specific instruments and chords, you have 
a style. So styles are a way to classify music.

A style is an association of several music characteristics that are specific to a mood, an atmosphere and that 
may then be recognized as having its own character and personality.

Practically, a style as used in most music software, arrangers and synthesizers is a set of predefined rhythmic 
patterns for percussion instruments and accompaniment instruments like the bass, piano, guitar,...

Each style has various patterns like an introduction, a main rhythmic pattern, a break or variation pattern and 
a final measure. You can assemble these building blocks into a full piece of music by disposing them one 
after the other and then by applying a chord progression to it that fits your melody.

In releases 1 and 2 of Pizzicato, we had created 20 styles with the first version of the library composition 
tools of Pizzicato. The way to use styles was quite complicated. We simplified it quite a bit with release 3.0, 
introducing the smart link function and the groups of scores, but there was still some specific and not so 
obvious operations to do to work with styles and chord progressions. It was still too complex. With the 
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release 3.2, we have improved this process to the simplest possible way. You drag and drop styles and chord 
progressions into a score and you hear the result.

Even if most of the needed tools have already been explained in the previous lessons, here is a practical 
summary of how you can work with styles in Pizzicato.

Using the Pizzicato styles

In the Pizzicato libraries, you will find a folder that contains 35 prepared styles. Each style has at least the 
following elements:

• Intro - An introduction measure which can be used as the first measure of the composition 
• Rhythm - The main rhythmic pattern, that is repeated in the main part of the composition 
• Break - A break, which is a variation of the main rhythm. It can be played for instance at the end of a 

section, as a transition to another section of the composition 
• End - A ending measure, which can be used as the last section of a composition. 

Depending on the style, each one of these building blocks may have one or several measures. Some styles 
may have more than one of each of these blocks.

• Open a new document and open the conductor view. Locate the following folder in the library 
(configuration 3 area 1 or configuration 4 area 3): 

Music libraries / Prepared styles

• Expand the node entitled Rock - 01 which displays the four above mentioned building blocks: 

• By moving the mouse over the score icons, you can see the scores of this style displayed temporarily 
in the main conductor view. You can click on one of them to hear it and it will play until you mouve 
the mouse outside of the icon. You can do that now for a few styles so that you have an idea of the 
various styles. 

Let us say that we want to create a rock composition based on that style. We will take a simple example of 
10 measures. This style has a one measure building block. We will create it directly inside a score. We could 
also do it in a group of score, as seen in a previous example. Both ways are possible.

• The composition will first start with an introduction measure, so drag and drop the above Rock - 01 -  
Intro score on the musical desktop on the right, and then open the new created score. You get the 
following: 
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• You can listen to this first measure. We will now add 3 measures of the main rhythm. Drag the icon 
of the Rhythm score to the right of the above measure and before releasing the mouse button, hold 
down the CTRL key. In the dialog that appears, type in "3" to use the full rhythm 3 times. Click OK 
and the score extends to 4 measures in total. Resize the score view as needed. 

• Now drag and drop the Break 1 score after the last measure. 

• Now add again 3 times the Rhythm score icon after the last measure (resize or scroll the score view as 
needed). 

• Then add the Break 2 and also the End, each time after the last measure. Listen to the result. 

• As everything is written in the C chord, it is a bit monotone. We may now add one of the numerous 
chord progressions of the Pizzicato libraries. But of course if you have found one yourself, you can 
also use it. We will see in the next section how to design a chord progression in an intuitive way. For 
the moment, locate the following node in the library (configuration 3 area 1 or configuration 4 area 
1): 

Music libraries / Basic libraries / Measure 4-4 / C Major - 3 notes chords / 12 measures - 2  
chords/measure / C Major / 1- 100
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• and drag any one of these numerous chord progressions and drop it on the first measure of the score. 
You will see that the chord symbols have been added. Click on the "C" check box of the tool bar to 
see the arranged score and listen to it. You may then drag another chord progresion on it or just 
modify this one as you please. Then listen to it again. It is as easy as that. 

This was a simple example, but you can in fact also mix various styles one after the other as well as use 
several little chord progressions (here we used a long 12 measure progression in one shot). Notice that you 
can also go in the basic chords library and drag and drop single chords at a time to replace a chord of the 
progression, or just to create your own chord progression. The possibilities are numerous.

Interactive styles and chords exploration

Until you know what composition or accompaniment you need, you may want to test and try a lot of them 
and also test and try chords. Here is the way to do that in an interactive way.

• Start with a new document and open the conductor view. Locate the following node of the library and 
drag and drop it on the musical desktop: 

Instruments and templates / Harmonic spaces / C Major - 3 notes chords + dominant 7th

• Resize the group so that you can see most of the chords of the harmonic space: 

• Now locate the style folder as above and select a style to start with. For instance, select the Rumba -  
01 style so that the Rhythm node is selected in blue: 
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• Click on the yellow triangle of the tool bar of the conductor view (or press the space bar) to play that 
blue selected node. You hear the rumba style play in loop. For the moment, it is played exactly as 
written, in C major. 

• Now that the playing has started, you can explore the library and select any score in blue by clicking 
on it. At the end of the current playing score, the next selected score will be played, still in loop. In 
this way you can just sequence any score of the library. 

• Now double-click on the F chord rectangle (orange coloured) in the group of the conductor view. A 
fixed arranging point is displayed at that location and you immediately hear that the current playing 
score is now playing using that chord. 

• You may now continue to explore both styles and chords. To change the current chord, just click on 
the new chord rectangle and to change the style pattern, just click on the one you want to hear next. 
You may continue doing so for hours if you want. 

• Once you are oriented in what you want, you can then apply the principle explained in the previous 
section to create your final score by dragging and dropping the style blocks one after the other in a 
score. For the chord progression, you may use the method explained in the lesson on harmonic spaces 
and the real time arranger. You may then create your chord progression inside the group (using the 
little OK buttons present in the chord rectangles) and drag it inside the final score to have it arranged 
by the score arranger. 

• If you create the chord progression inside the group, you may move the current fixed chord location 
by using the left and right arrows of the keyboard. In a similar way, you can use the up and down 
arrow keys to change the selected score in the style library. For instance by using the down key, you 
can play the break pattern and then using the up key, you can play the main rhythm again. 

• To stop playing, just use the space bar again or unselect the current node by clicking inside the tree or 
on a node that is not a score. 

Importing styles from the Internet

You may object that presently Pizzicato has only 35 styles. Here comes the next new function of Pizzicato. 
Pizzicato can import all style files that have the Yamaha style format. You can find literally thousands of 
style files on the Internet, some that you must pay for but a lot of them for free.

The style files that Pizzicato can import are basically any MIDI file with marker in them that separate the 
various sections of Intro, rhythm, break and end. The Yamaha style file format uses this so Pizzicato can 
import that kind of file. Notice that Pizzicato does not use the specific Yamaha information blocks that you 
find in such a file. It only uses the MIDI section of such a file. The corresponding file extension is "*.STY".

To find and download such files, just go on your preferred search engine page (for instance 
www.google.com ) and type any combination of the following keywords: "free Yamaha style files". You 
will find thousands of them. Download them and put them inside a directory of your hard disk (not inside 
Pizzicato yet). Then start Pizzicato and open the conductor view. In the My library folder, add a new sub-
folder (right-click the folder and select the New folder... menu item) where you will import the style files. 
Name it as you want, for instance "Imported styles". Then right-click on this folder and select either Import 
a style... or Import a folder of styles... and then select either one style file or the folder where you can have 
many style files. Pizzicato will then start working and import these files into your folder.
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After this operation is done (if you have download some hundreds of style files, it may take some time), you 
will see each style as a Pizzicato document, with a few scores in it that you can use exactly as explained in 
the previous section. Notice that some imported styles will not sound very nice until you also use the real 
time arranger on them.

Notice that you can also import MIDI files and folders of MIDI files inside the library. Right-click a folder 
of the library and you will see the corresponding menu items. 

Warning: be aware that the downloaded style or MIDI files may be copyrighted by their authors. According 
to the site where you download them, they may be available for private use only. Styles that you buy may 
have another type of licence. Consult the specific conditions of the site where you download them to know 
what you may or may not do with them. There are many free style and MIDI files that may be legally 
downloaded on the Internet but there are also sites that offer illegally "free" MIDI files to downloaded and 
by doing so, you act yourself illegally. So we can only invite you to act in an ethical way and only download 
the legally free MIDI or style files and respect the conditions stated on the site regarding the way you can 
use them (private or public use).

Extract the instrumental patterns

Composing by using styles only may become poor after a while. You are indeed only using pre-existing 
musical structures and you may feel a bit restrained regarding your freedom to compose music. This is 
where Pizzicato offers you the more elementary music blocks that you can find in the various Pizzicato 
libraries.

Here is another function that may be used to create a vast personal library of elementary instrumental 
patterns. The principle is that you may take one Pizzicato document or a folder that contains many Pizzicato 
documents and create a decomposition of all the scores included in them and then classify all these measures 
by instruments. The result is a new library folder or document, containing individual patterns classified by 
instruments. Imagine you have 100 midi files of various origins and styles (but please use only legally 
obtained MIDI files, see the above warning). You import those files in one shot inside a library folder. Then 
you apply this decomposition function to create, out of these 100 files, a library of individual instrumental 
patterns of one measure each. You have then a lot of raw music material to start building you own 
composition. This aspect is mainly useful for the accompaniment instruments like percussion, bass, piano,...

This process has been applied to decompose the 35 Pizzicato styles, and the results are included in the 
individual instruments of the libraries. They may then be used outside the context of a style, which is much 
more creative than only using style: you create your own style by assembling individual instruments.

The way to decompose Pizzicato documents is very simple. In the library, right-click a Pizzicato document 
or a folder that contains Pizzicato documents and select the menu item entitled Extract individual  
instruments patterns... The following dialog appears:
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• With the two list, you can select which instrument(s) you want to extract from the source 
document(s). Click on ">>>" to select them all. 

• You can split all staves into single measures or keep the staves untouched (only useful to decompose 
styles). 

• You can sort the results into one document with groups for each instrument or into a folder with 
documents for each instruments. 

• You can specify a maximum number of results per instrument and globally. 

• You can give a name to the destination folder or document. 

• In the name of the scores that are created, you may or may not include the name of the original 
measure, so that you could locate it easily in the original source document(s). 

• When you click on OK, Pizzicato starts to work. Depending on the number of documents you want to 
decompose, the process may take some time. When done, you have a new individual instrument 
pattern library to explore. 

Summary

In the last twelve lessons, including this one, we have learned to use the composition tools offered by 
Pizzicato 3. Compared to the tools of version 2 (which still exist), we believe that an important step has been 
done to improve the tools regarding the user friendliness. We hope that music composition will 
progressively be accessible to much more Pizzicato users. We will continue in that direction and we are open 
to any suggestion from you that may accelerate this process.

Be sure you have understood the basic principles explained here so far. If not, then we suggest you to read 
those lessons again while doing yourself what is explained in them. You may then start or continue to 
compose music.

The richness of possibilities lies in the multiple potential combinations of the various tools and music 
structures you can use or create. You are the composer. Pizzicato helps you by providing notation and 
composition tools. You express your feelings, emotions and ideas by composing, so you are the one who 
decides. Good luck and compose well!
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Composition tools - The graphic 
vectors

• Drawing a melodic curve 
• Assigning a rhythmic structure 
• Moving and transposing a melodic line 
• Vectorization of an existing melodic line 
• Applying a rhythmic density 
• Changing the velocity 

Drawing a melodic curve

In a previous lesson, we explained the music vector. Even if the music vector is quite powerful to represent a 
melody, it may seem too complex or esoteric to the musician, as its description speaks a language that is 
more mathematical than an intuitive musical language. With Pizzicato version 3.4, six intuitive tools help 
you to manipulate the music vectors in a much more natural way for a musician. You will find here the 
description of these new tools, as practical examples.

With this tool, you can draw a melodic shape on the staff and Pizzicato will find the notes that fit the chords 
already present.

• Open the Ex88.piz file in the DataEN / Examples directory. The score already contains a series of 
chords. This is an example, as you may change or define your own chords with the chord tools of 
Pizzicato. Select the  tool in the Composition palette. The score now presents itself like this: 

The green grid array is use as a reference mark. Vertical lines show the beat position in the 
measure and extended horizontal lines show where the ledger lines are outside the staff. They 
help you to orient the drawing of the melody.

• You will now draw a melody that goes from the first beat of the first measure and covers the four 
measures. Click at the beginning of the first vertical green line, in the first staff and hold down the 
mouse button. Then move the mouse slowly through the 4 measures. A red line shows you the 
melodic curve. You may go up and down freely. Just before releasing the mouse button, you may 
have something like this: 

• You can now release the mouse button. Pizzicato displays something like this: 
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What happened really? Pizzicato analysed the melodic curve according to its position inside the 
staff as well as to the chords present at each point of the curve. The closest note of the chord was 
selected in each case.

You will notice that the melodic line is automatically broken into quarter notes. This is beacuse 
no rhythmic pattern existed before you draw the melodic curve. If you enter a rhythmic pattern in 
the first staff before drawing the curve (the note pitch of the pattern does not matter, you may use 
all the same notes), the melodic curve would have been designed on that same rhythm. For 
instance, if the following rhythm was entered:

The melodic curve would then become something like this (the exact notes depends on the 
precise movements of the mouse during the drawing of the curve, so even if you try to 
approximate the same shape, you may not get exactly the same result):

In each case, you will notice that the staff also displays your original curve as a thin red line. 
You also see right at the beginning of the first measure, the icon of a music vector, as explained 
in a previous lesson. If you double-click that icon, you can edit the vector in a more 
mathematical way and you should then refer to the lesson on music vectors for more details. But 
this is not necessary at all, as the 6 tools described in the present lesson will let you handle these 
vectors much more intuitively.

• At any moment, you can redraw a part of the curve, to reshape the melody. The rhythmic form will 
stay the same. For instance, try to reshape the second measure, just by clicking at the beginning, 
drawing the shape you want up to the end of the measure and then releasing the mouse.You may start 
anywhere inside the existing curve and draw a small part or the entire melody again. To start 
drawing, you should not click on a note head, because this will be interpreted by Pizzicato as if you 
want to move the note itself. Pizzicato will move the notes accordingly. You may for instance change 
the melody to have: 

If you analyse the notes generated by Pizzicato, you will notice that some notes are not part of 
the chord. Click the  tool to display the note colors. The above melody will display like 
this:
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Green notes are part of the chords and orange notes are part of a scale that Pizzicato 
automatically assigned to that chord as the more probable scale. Red notes are chromatic notes, 
not part of the scale and chord.

When you draw a melodic curve on the staff, Pizzicato tries to find the closest note to the chord 
if the rhythmic duration of that note is longer than a dotted 8th note. If the duration is less than 
that but longer than a dotted 16th note, Pizzicato will select a note from the scale (this note may 
also be part of the chord). For a shorter duration, Pizzicato selects the closest chromatic note, 
whether or not part of the scale or chord. In that case, the note is displayed in red.

This is the default behaviour, but you can modify this by using the SHIFT and/or CONTROL 
keys while drawing the melodic curve. Here are the possible combinations.

• CONTROL key: if you keep this key down while drawing any section of the melodic 
curve, Pizzicato will only use notes from the chords. 

• SHIFT key: if you keep this key down while drawing any section of the melodic curve, 
Pizzicato will limit the notes to the scale (some of which may of course be also part of the 
chord). 

• CONTROL+SHIFT keys: if you keep these two keys down while drawing any section of 
the melodic curve, Pizzicato will take any closest note to the melodic line. 

While drawing the melodic curve, you may use these key combinations. Temporarily, Pizzicato 
draws the curve in green/orange/yellow to show what mode you are in (chord/scale/any note). 
These combinations are important to give shape to the melody. You can also use these 
combinations when you correct the existing curve.

When you draw one melodic curve, the duration and shape of that curve are represented by the vector icon. 
This means that this vector is still able to generate this melodic curve, on the existing chords or on any other 
chords if you change them. Whenever you ask Pizzicato to compute all vectors of the score (shortcut CTRL 
+ R or on Mac: Apple key + R), any change in chords and scales may modify the existing melodic lines.

• Try to change one or two chords of this progression (double-clic a chord symbol, with the arrow tool 
selected), then use the Edit, Update smart links and you will see the melodic curve modified. 

As a vector is a note generator, when you move the notes attached to a vector, the vector is in fact not 
modified. So when you recompute the vectors, all vector notes will be again computed and the custom 
changes will be deleted.

• At any time you can remove a vector, by pointing its icon with the mouse and by using the delete key 
(or backspace key). The vector as well as its notes are removed from the staff. 

• Once you have designed a melodic line and if you do want to keep it exactly the same in the future, 
you may remove the vector and keep the notes. To do that, point the vector icon, hold down the 
SHIFT key and use the delete key (or backspace key). The vector disappear but the notes are not 
removed. They are now normal notes and will never be changed automatically by Pizzicato. 

• You can have many vectors in the same staff or on any staff. They may even superimpose 
themselves. The only restriction is that to create a new vector, you must start outside an existing one, 
otherwise Pizzicato consider that you want to correct or lengthen the existing one. 

Please note that this is NOT a contrapuntal tool, as Pizzicato only selects the notes from the existing curve 
and the chord/scale present at that time. It does not take into account any rule of counterpoint. This can help 
you to design a melodic shape, but YOU are the composer !
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Assigning a rhythmic structure

The rhythmic vector tool  is used to adjust the rhythmic pattern of an existing vector.

• Open the Ex089.piz document, in the DataEN / Examples directory. Select the  tool on the 
Composition palette. This score is displayed: 

The first way to use this tool is to split an existing note into two notes. 

• Click the mouse exactly between the first two vertical green lines of measure one, so that the first 
beat is cut into two. This is a simple click, you may immediately release the mouse. You can click 
anywhere vertically, inside, above or below the staff as long as you avoid clicking on any note head. 
This cuts the first quarter note into two 8th notes: 

The precision level is by default half of the duration of one beat, so here it means an 8th note precision. If 
you hold down the CTRL key, you can increase this precision up to a 16th note.

The idea of cutting a note into two notes is that you must click between the horizontal position of that note 
and the horizontal position of the next note. The resulting note durations will be proportional to the position 
where you click and whether or not you hold down the CTRL key.

• For instance, hold down the CTRL key and click to 3/4 of the length of the first C quarter note in 
measure 1. You should have: 

Another way of using this tool is to group two or more existing notes into one note. To do that, you must 
click on the vertical line of the first note you want to group, hold down the mouse button, drag the mouse to 
the right up to the end of the duration of the last note you want to group, then release the mouse button.

• Click at the beginning of the above C quarter note, hold down the mouse button and drag the mouse 
so as to cover the duration of that note as well as the duration of the next note, then release the mouse 
button. You should now have: 

You may use this method even accross measure boundaries. The notes will be tied together. Each 
time the notes of the vector are computed again, so as to match as closest as possible to the 
original melodic shape. You will notice that the reference point of the note pitch is the starting 
point of the note. So if you make a note tied over three different chords, only the first chord will 
be taken into account to decide which note pitch must be choosen.

You can also use this tool to add a note duration at some point of the melodic shape where a rest 
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exists.

The last way to use this tool is to create rests in the melodic shape. You must click, hold down the SHIFT 
key, drag the mouse over the expected duration of the rest, then release the mouse button. A rest will be 
placed to cover that duration.

• To change the second 8th note (A) to a rest, hold down the SHIFT key, click at the beginning of that 
note, drag to the right, up to the end of that 8th note, then release. You should have: 

Here also, you can cover more than one note and that area will be filled with rests.

Moving and transposing a melodic line

The next tool is used to transpose, move or duplicate a melodic curve associated to a music vector.

• Open the Ex090.piz document from the DataEN / Examples directory. Select the  tool on the 
Composition palette. The following score appears: 

This is an existing melodic curve. You can see a big red spot on the first note of the melody. You 
can move this spot to another location. Moving it horizontally will just shift the melody to 
another time position. This may be in the same measure, another measure or even another staff. 
If you move it vertically, you will transpose the melody and Pizzicato will reshape it to the target 
note. So in fact this is not exactly transposition. The curve will be transposed exactly, but the 
closest notes to the curve will be computed by Pizzicato according to the chord, scale and mode 
of the melodic curve. The resulting melody will keep the general shape, but may have different 
intervals.

• Click the red spot, move it to the middle of measure 2, to a pitch that is a bit higher. The score 
becomes for instance: 

• If you hold down the CTRL key while dragging the melody, it will be duplicated, so that the original 
melody stays in the score. For instance, move the melody back to its original position. Then, while 
holding down the CTRL key, drag the melody to the 3rd measure, but in the second staff. You will 
have for instance: 
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This simple way of manipulating a melodic line may be very useful when composing an orchestral 
arrangement, as you may very quickly try and hear many variations, change chords (as they will influence 
the melodic shape) and reshape a part of the curve with the previously explained vector tools.

Vectorization of an existing melodic line

What if you already have an existing score with melodic lines, for instance imported in MIDI or written 
without using the vector tools? The next tool will transform an existing melodic line into a music vector. 
Once this is done, you can manipulate the melodic line with the other tools (move, transpose, reshape, adapt 
to other chords,...).

• Open the Ex091.piz document in the DataEN / Examples directory. Select the  tool in the 
Composition palette. The score contains one single melody, with no vector: 

Note: to display the notes in color, just select the  tool on the Composition palette.

• Click somewhere on the first beat of the first measure and drag to the right while holding down the 
mouse button, to enclose the melody. A red line follows the mouse. When you release the mouse 
button, Pizzicato creates a vector with the melody. The vector is created so that the notes will stay 
exactly the same. The original melody is not modified. The score becomes: 

You can create a vector for the complete melody or create several vectors to split a longer 
melody into various sections. You can then manipulate them with all other tools. This operation 
is called the Vectorization of a melody.

• If you hold down the CTRL key during the vectorization, the vector will be created in the context of 
the existing chords and scales, so that when you move or transpose the vector, the melody will be 
adapted to fit the chords and scales in the same way as in the original melody. 

Applying a rhythmic density

The  tool is an experimental tool to design the rhythmic density of an existing melodic shape. 
Rhythmic density is here defined as the number of notes per unit of time.

• Open the Ex090.piz document in the DataEN / Examples directory and select the  tool on the 
Composition palette. The score is displayed as follows: 
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You will notice 6 different color shades displayed vertically on the staff. They represent the 
rhythmic density levels. Each level is displayed covering the space of two lines of a staff. The 
following table shows the rhythmic correspondance (from dark to light, from top to bottomof the 
staff):

32nd notes
16th notes
8th notes
Quarter notes
Half notes
Whole notes

There is no relationship between these density levels and the notes displayed at a given time on 
the staff. This scale is only used as a reference to draw the rhythmic density with the mouse to 
influence the rhythmic dimension of the melodic line.

• Click in the quarter note range (for instance at the level of the G note, seond line of the staff) of the 
first measure, on the first vertical line and hold down the mouse. Move the mouse to draw the 
following curve (as an example) : 

• Release the mouse button and the score will become something like this (it may be a bit different, 
depending on the precision of the drawing): 

By drawing inside a density level, the corresponding sections of the melodic curve get assigned 
to that rhythmic value. You will notice that the density is not continuous. There are only 6 levels 
of density.

Combined with the vector drawing tool, this tool can help you to design a melodic curve. You can use it on 
the full range of a melodic line or just for a section of it.

Changing the velocity

This last vector tool is used to define the velocity associated with each note of the curve. You can of course 
establish velocity with the musical effects view, but if you define it inside the vector, any change or move of 
the vector will keep the original velocity curve. Velocity is a MIDI parameter that originally expresses the 
force with which a note is struck on a keyboard. The use of velocity has been extended to any instrument, 
meaning the force of the attack of a note. Its main influence is of course on the volume level of the sound, 
but it often also influences the sound quality and timbre.

• Open the Ex090.piz document from the DataEN / Examples directory and select the  tool on 
the Composition palette. The score is displayed as follows: 
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Each note is displayed with a vertical dark blue bar. They represent the velocity values of the 
notes, in a scale made of 12 staff line intervals. The values are in fact in the [1, 127] range. The 
above score displays a value of about 100 for each note.

• Using this tool is very easy. Click and drag horizontally, at the level of velocity you want. Whenever 
you go accross a note, this note will be assigned that level of velocity. Then release the mouse button. 
Try to draw a velocity curve on the score, you may for instance get: 

With this tool, you can influence the expression of the melodic curve you are designing.

The 6 tools explained here are music experimentation tools. If you have any idea or suggestion as how they 
could be improved or what new similar tools could be added, just tell us!

Audio tracks
• Audio or MIDI? 
• What is an audio track? 
• Adding an audio track 
• Multiple audio tracks 
• Audio setup 
• Using an ASIO driver 

Audio or MIDI?

Up to now, we have only used MIDI to manipulate music and hear the notes. Pizzicato plays the score by 
creating a series of MIDI events. The sound card of your computer or your external synthesizer uses those 
MIDI events and transforms them into a real sound that you can hear through the speakers. This working 
method is quite satisfactory in many cases. Most music information can be indeed represented by a sequence 
of MIDI events.

However, there are cases where MIDI can not be used. For instance, if you want to add your voice to a 
music arrangement, or if you want to play a real instrument and record the exact way it sounds, MIDI is of 
no use. In that case, the program must record and store the sound itself (or at least its mathematical 
representation).

As we have seen in a previous lesson (see the "Music notation" lesson), a sound is simply a vibration of air. 
It has four main qualities: the pitch, the amplitude, the timber and the duration. When an acoustic instrument 
plays, it vibrates at certain frequencies and transmits that vibration to the air around it. This vibration finally 
comes to your ear and you get the sensation of sound, with its various qualities.

To record sound, we need to measure the position of a particle of air, around its central position, so that we 
can thereafter reproduce the same vibration. For practical purpose, we can say that the zero value will 
represent the position of a particle of air when no sound travels through it. If the particle is pushed forward, 
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we can measure its displacement from its central position and write it down. Such a measure is called a 
sample.

As the vibrations of sound are quite fast, we must do so a lot of times per second. In fact, as the human ear 
can only perceive up to about 20 to 22 thousands vibrations per second, there is a mathematical principle that 
tells us that we must measure the air position at least two times that frequency, so that the sound is recorded 
and stored accurately. This is the reason why, on a music CD, the frequency has been fixed to 44100 
samples per second. This frequency is also called the sample rate and is expressed in Hertz (abbreviation Hz) 
which means "vibrations per second".

If we record a sound with a much lower sample rate, a part of its vibrations are lost when we reproduce it. 
Indeed, the information is missing in the record and the sound quality deteriorates. The most common 
example is a telephone line. In the beginning, they used an 8000 sample rate. As the human voice is not 
using the full spectrum of sound vibrations, the phone quality was enough to transmit an understandable 
conversation. But try to listen to a full symphony orchestra through a phone and you will hear that the sound 
quality is quite poor, indeed.

Another important parameter is the precision with which the position of an air particle is measured. You 
could measure on a scale that contains 10 positions or 10000 positions or more. If there are too few positions 
on the scale, there will be an approximation of the position. To give a comparison example, if you measure 
the dimensions of a room with a meter that do not have any centimeter graduations, you could then say the 
room is 3 meters or 4 meters, but you could not say exactly 3 meters and 23 centimeters. By transmitting the 
information that the room is 3 meters, it would not be exact and if an architect creating a big building would 
use that precision level, there is no doubt that the building would fall apart very soon. So the precision is 
quite important. For the CD quality, a scale has been set that goes from -32768 to +32767. The specificities 
of those numbers come from the binary system used to encode them. Indeed, 2 to the 16th power equal 
65536 so that there are so many possible values to a sample (65536 = 32768 negative values + 32767 
positive values + 1 value for zero). So we say that the quality of a CD is in 16 bits (a bit is a BInary digiT).

As a summary, we can say that an audio recording is a series of numbers that represent a sound and that may 
be used to recreate that sound at any moment through the speakers of a computer. In CD quality, one second 
of music is represented by 44100 times 2 numbers (because stereo is used, so there are two channels), each 
one of them being in the range from -32768 to +32767. When we put those numbers on a graph with time, 
we get a picture like this:

where the upper part is the left channel and the lower part is the right channel. Those curves represent in fact 
the position of an air particle when this sound is heard. Most software working with audio will represent 
sound as above.

What is an audio track?

An audio track is the representation of a sound for a specific duration. For instance, you could have a track 
of 4 seconds in duration. By playing this track, you will hear the sounds it contains.

Pizzicato lets you add one audio track (or several with Pizzicato Professional or Composition Pro) to a 
score. You can specify when the audio track begins, in relation to the score and Pizzicato will play it 
together with your score.

Each audio track is in fact represented by a wave file (".wav" extension on Windows). There are lots of 
existing audio file formats. Pizzicato works with WAVE files, as they are very common and can be used on 
Windows as well as on the Mac. You will find various software format converters on the Internet, so that 
you can use wave files and then convert them into or from mp3, aiff and many other audio formats.
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You should well understand that the audio information is stored in the wave file and not in the Pizzicato 
document. The Pizzicato document contains a reference to the wave file, so that it can play it at the same 
time than the score. If you want to send a Pizzicato score containing audio tracks to a friend, do not forget to 
send also the corresponding audio files. Existing audio files may be inserted in the score, but you can also 
create an empty audio file and record it yourself, with a microphone.

Adding an audio track

Depending on the Pizzicato version you have, you access or add an audio track differently. For most 
versions, do the following:

• Starting with a new document, select the Associated audio track... item from the Windows menu. The 
audio track selection dialog appears. 

For Pizzicato Professional or Composition, do the following:

• Starting with a new document, open the conductor view (Windows menu, Conductor...). 
• Right-click (Alt-click on Mac) on the main score represented by a large rectangle, and select the Add 

an audio track... item. The audio track selection dialog appears. 

The audio track selection dialog appears as follows:

This dialog lets you specify the associated audio wave file. You may either select an existing audio file or 
create a new one. We will first open an existing audio file.

• Click on the Select... button. A standard dialog box lets you open a wave file. If you do not have such 
files, you may download wave files from the Internet. On Windows you may also go in the Windows 
directory, in the Media sub-directory where you will find the various sounds used in Windows. For 
instance, we have here opened the file named "The Microsoft Sound.wav". The Quality and Duration 
frames now display the specification of the file: 

It is an 8 bits, mono, audio file, with a sample rate of 22050 samples per second and its duration 
is 6 seconds and 122 milliseconds.

• The left frame with the Start in score label specifies the starting point of this audio file in relation to 
the score. By default, it starts at measure 1, beat 1 with no additional delay. The Unit label specifies a 
number of units where one quarter note is the equivalent of 480 units. So if you want the file to start 
on the first half beat, you would specify 240 units. 

• In the lower part of the dialog, two sliders specify the volume with which the sound file will be 
played, for the left and right channels. 
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• Click on the OK button. For Pizzicato Light and Beginner, the audio editor appears. Just close that 
window for the moment. 

• You may add some notes on the score and Pizzicato will play both the score and the audio file that 
you just added. 

You may also create a new audio file and associate it with the score.

• Close this document without saving and create a new one. Then call the same dialog as above. 

• You may specify the quality and duration of the audio file you want to create. By default, the quality 
is the best (CD quality) and the duration is 10 seconds. Click on the Create... button. 

• A file dialog opens so that you can specify the file name and location. You may in fact create the 
audio file in any directory you want, not necessarily in the same directory as the Pizzicato file. A 
reference to that directory will be saved with the Pizzicato file. 

• This audio file is created with nothing in it but a silence of 10 seconds. We will be able to record it 
with the audio editor in the next lesson. 

The Delete button is used mainly for the Pizzicato versions with one audio track. Clicking on it just removes 
the reference to the audio file from the Pizzicato score. Notice that the audio file itself is not destroyed.

Multiple audio tracks

With Pizzicato Professional or Composition Pro, you may add several audio tracks to the same score. You 
may start the audio tracks at different position in the score. When an audio file has been added, it appears 
just below the score as a colored band, at the position where it will start to play and with the length showing 
its duration in relation to the score:

The little icon on the left bottom of the score rectangle shows that this score has associated audio tracks. 
Clicking on it switches between viewing the audio tracks below the score or not viewing them.

To add another track, just do exactly the same as explained above. In fact, you may add the same file more 
than once, at various positions in the score. When adding more tracks, the conductor view will display 
something like this:

For each track, you may specify the starting point in the score as well as the volume of the audio file. The 
starting point may also be adjusted by directly dragging the yellow bands horizontally. While doing so, there 
is a magnetic grid that positions the starting point at multiples of half a beat, so as to accurately place the 
audio file, but you may disable that magnetism by holding down the CTRL key.

When you click with the right mouse button (alt-click on Mac) on an audio track, three menu items appear:

560



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

• Edit audio track... is the equivalent of double-clicking the audio track and calls the audio editor. This 
audio editor is the subject of a specific lesson. 

• Audio track properties... calls the dialog that we have seen in this lesson. You can then change the 
file, create a new file or specify its volume. 

• Remove audio track just removes the track. The audio file itself is not destroyed. 

Audio setup

The audio setup should work correctly by default. You may access it in the Options menu, Audio setup...:

• Interface used: you may select the audio input/output used to play/record audio. By default, the 
standard input/output are used. 

• Sound quality: specifies in which sound quality the sound card will function when working in 
Pizzicato. 

• Audio manager setup: those parameters are technical parameters that Pizzicato uses to play and 
record audio. You should leave them as they are, except if you experiences difficulties like hearing 
the sound in a jerky way. On Mac, they are not available, because the audio manager works 
differently than in Windows. Pizzicato uses audio buffers in a cyclic way. These parameters specify 
the number of buffers, how many buffers are used together and the size of the buffers, both for output 
and input. 

If you experience a jerky sound, increase the size of the output buffer by steps of 100 until you hear a correct 
sound. Conversely, to experience the shortest delay possible between the coloring of the note and its sound, 
try to reduce the output buffer size by steps of 50 or 100. When you close this dialog, you may need to exit 
and restart Pizzicato for the changes to be taken into account.

The Default values button lets you reset the parameters to their default values.

If you experience a delay between the score (MIDI instruments) and the audio track, you must add the same 
delay to MIDI, so as to compensate. This is done by the MIDI play options... item of the Options menu. 
There is a slider named MIDI delay in milliseconds (correction for audio). Adjust its value so that MIDI and 
audio are played exactly togther.

The ASIO Setup... button will be explained in the next section.

Using an ASIO driver
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Since version 3.5.2, Pizzicato can work with an ASIO driver to handle audio. ASIO (Audio Stream 

Input/Output) is a standard protocol to manage a sound card efficiently. It can reduce the latency time, which 
is the delay between the moment that Pizzicato writes sound data to the card and the moment when you hear 
it. Many sound cards running on Windows have a latency time that creates a delay that is disturbing when 
you play on the MIDI keyboard and want to hear the Papelmedia sound library delivered with Pizzicato.

Some sound cards have their own ASIO drivers, but you can always download and install a universal ASIO 
driver called ASIO4ALL, which is free, on page: http://www.asio4all.com/ 

If you want to use the ASIO driver with Pizzicato (only on Windows), click the "ASIO setup..." button in the 
Audio setup dialog (Options menu).

The following dialog appears:

The menu entitled "Select ASIO driver to use" let you choose the driver to use, as you can indeed find 
several ASIO drivers installed on your computer. Try them all if necessary and check the one that is running 
fine with Pizzicato (in case of problems if Pizzicato won't start anymore, see the remark at the end of this 
section).

You have four other menus to select the left and right channels, for ouput and input.

The "ASIO control panel..." button calls a dialog that depends on the ASIO driver. This control panel is used 
to set up the driver according to the audio hardware you have. The default value should work, but for more 
details, see the documentation of the ASIO driver or sound card.

If you want to go back to a normal audio setup, without ASIO, click the Do not use the ASIO driver... button 
and it will display the normal audio setup dialog.

Confirm the ASIO setup by clicking on the OK button.

Warning: Installing and setting up an ASIO driver and making it work with Pizzicato is not always easy, 
according to the hardware and software you have. In case of problems, it may require technical skills to 
solve the situation. We cannot here enter into such setup complexities. We have described the basic 
procedure, that should work in most cases.

If after trying to setup ASIO with Pizzicato, Pizzicato won't start or crashes at startup, here is how to solve 
the situation. Just remove the following file:

My documents / Pizzicato 3.x / Prefs / Audio.dat

Then start Pizzicato and the default audio setup will be recreated (without ASIO).

Creating an audio file
• Export a score to an audio file 
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Export a score to an audio file

The idea is to create an audio wave file (extension ".wav") that contains exactly what you hear when you 
play the score in Pizzicato. You can then use that audio file to create a CD that can be played in any music 
CD 

player. Indeed, most CD burning software accept wave files to create an audio CD.

Since Pizzicato version 3.4, a quality sound bank (Papelmedia) is included in Pizzicato. It is now possible to 
create a WAV file using this library (or any virtual instrument from Pizzicato or from any external 
SoundFont file), without going through the specificities of the sometimes bad quality sound card 
synthesizers. If you use an external MIDI synthesizer or if you want to use the sounds of your sound card, 
you will need to record the audio file through the sound card, as explained later in this lesson.

Let us see how to export it with the virtual instruments.

• In the Examples sub-directory of the DataEN directory, open the Ex044.piz file. It is a short piece of 
music containing 4 measures. We will create an audio file from it. 

• In the File menu, select the Export audio file... item. A dialog appears so that you can give a name 
and a location to the wave file that will be created. By default, the name is set to either the name of 
the document or the name of the score if the document contains more then one score. Select the 
directory where you want the file to be created and validate. The following dialog appears: 

• The list on the left shows which staves will be exported (YES) or not exported (NO), as well as the 
STEREO or MONO selection for each instrument. To modify this list, click one line and change the 
Export in check box and the STEREO/MONO menu. The list is then updated. 

• Two options are available to export the score in audio. Create one file with all staves will produce 
one audio WAV file that includes all selected instruments. Create one file per staff will do just that. 
This is useful if you want to work your composition in a digital studio software to remix it, add effect 
or include it in a broader work. 

• Since version 3.6, you can also export the metronome by clicking the corresponding check box. 

• Click the Export button to create the file(s). In case of multiple files, the number and name of the 
instrument is appended to the main file name. Please note that you can select a set of measure and 
staves before calling this dialog and only these measures and staves will be exported. 
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As explained above, if the score contains staves with MIDI instrument assignement (mapped to the sound 
card or to an externazl synthesizer), these instruments will not be exported with the original MIDI instrument 
sound, but these sounds will be replaced automatically by the Papelmedia sound library included in 
Pizzicato. If you do not want that to happen, click the button Export while playing the score. In that case, the 
following dialog appears:

• In the upper frame, you may select the quality of the audio file. By default, it is set to the best quality. 
Note that the size of the file is directly related to the quality. The more quality the higher the file size. 
You may evaluate the size of the file (in bytes) with the following formula: 

 Stereo 16 bits : file size = 4 x (sample rate) x (duration of the file in seconds) 
 Stereo 8 bits : file size = 2 x (sample rate) x (duration of the file in seconds) 
 Mono 16 bits : file size = 2 x (sample rate) x (duration of the file in seconds) 
 Mono 8 bits : file size = 1 x (sample rate) x (duration of the file in seconds) 

The way Pizzicato will create the audio file is the following. When Pizzicato plays the score, it uses the 
sound card synthesizer or a software synthesizer to play the notes. The resulting sound is present at the 
output of the sound card and that is the sound you hear. This is also the sound that will be recorded in the 
audio file. 

So that Pizzicato has the possibility to access this sound channel on Windows XP or 2000, you should do the 
following:

• In the Start menu, select Programs, then Accessories, Entertainment, Volume control. The volume 
control window appears. 

• In its Options menu, select Properties. 
• In the frame entitled Adjust volume select Recording or Record. 
• In the list, see that the line "What you hear" or "Stereo Mix" or something similar is checked and 

click on OK. This input means exactly that: all sounds that come out of the speaker of the sound card 
will be recorded. 

• See that the Select check box is checked under the slider of the column named "What you hear" in the 
recording control window and that this slider has enough volume. 

• Go back to Pizzicato. This setup should normally not change after you have prepared it, but be aware 
that other programs may change it. If Pizzicato does not record sound as expected, check it again. 

So that Pizzicato has the possibility to access this sound channel on Windows Vista, you should do the 
following:

• In the Start menu, select Configuration panel, then Audio, Sound. In the window that appears, select 
the Recording tab. 

• With a right-click in the middle of the list of peripherals, select the item Display disabled devices. 
• In the list, double-click the item entitled "What you hear" or "Stereo Mix" or something similar. 
• In the General tab, check that the Use of device option is set to Use this device (active) or something 

similar. This input means that all sounds that come out of the speaker of the sound card will be 
recorded. 
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• In the Levels tab, see that enough volume is assigned to the slider. 
• Close that window and the following. 
• Go back to Pizzicato. This setup should normally not change after you have prepared it, but be aware 

that other programs may change it. If Pizzicato does not record sound as expected, check it again. 

On the Macintosh, it is a bit different because the user may not select "What you hear" as the recording 
input. There are two way to handle that difficulty. The first one is to use the microphone of the Mac. 
Pizzicato plays the score through QuickTime Instruments and the internal speaker of the Mac and Pizzicato 
records it with the microphone. The problem with that solution is that the sound quality will be less and that 
other sounds and noise that happen around your computer will also be recorded. The other solution is better 
but you need a cable to connect the sound output of the Mac to its sound input. In either case, do the 
following:

• Go to the System Preferences, in Sound 
• In the Input tab, select the input you need: the built-in microphone or external microphone if you 

want to use that method, or the line input if you have a cable to connect the audio output of the Mac 
to its line input. 

• Set the input volume to an adequate level. 
• Go back to Pizzicato. 

For both Windows and the Mac, when you click on the Play (test) button of the above dialog, Pizzicato plays 
the score. You should see the bar graphs showing the sound level in real time. You may increase the volume 
sliders if the bar graphs have a too low level. This will determine the volume recorded in the audio file. The 
bar graph should never reach the right part, because that means the sound is saturated at that point and this 
will produce a sound distortion in the audio file. The Stop button lets you stop the score. 

When you are ready, click on the Export button and Pizzicato starts playing the score while recording the 
sound result in the audio file. Let Pizzicato play it up to the end and you will then have the wave file created. 
If you click on Stop before the end, the file will only contain the part of the score that have been played up to 
then.

If you use an external synthesizer, you should be aware that its audio output will not be recorded in the file 
unless you connect it to an audio input of your sound card with a cable. Most sound cards have a line input 
where you can connect your synthesizer audio output. This line input should then be selected in the record 
volume control window as the source of recording.

On Macintosh, when you use QuickTime Instruments to generate the sounds, your computer must be fast 
enough; otherwise, QuickTime sometimes has a little interruption that spoils the recording of your score. To 
optimize the recording on Mac, you should:

• Close every other application than Pizzicato 
• Keep the volume of the above window exactly to 100 (you may however adjust the volume in the 

Sound System Preference panel) 
• Avoid the scrolling of the score while Pizzicato plays. You may disable the scrolling in the Options 

menu, Global options..., by unchecking the Scroll score window checkbox. 

If you select one or more measures with the selection tool and then choose to export in audio, only these 
selected measures will be exported in audio.
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The audio editor
• Accessing the audio editor 
• The various parts of the audio window 
• Specifying the file area to play 
• Selecting the working area 
• Modifying the selected area 
• Zooming 
• File operations 
• Recording an audio file 
• Modifying the wave directly 
• Miscellaneous options of the editor 

Accessing the audio editor

The Pizzicato audio editor window is a tool used to modify an audio file. Once you have added an audio 
track to a score, you may then edit the audio track with the audio editor.

You may also open and edit an audio file that is independant of a score by using the Open an audio file... 
item of the File menu.

With the Pizzicato versions with only one audio track, you may open the audio editor through the Associated  
audio track... item of the Windows menu. A dialog appears and when you click OK (providing you have 
specified an audio file), the audio editor appears. With Pizzicato Professional and Composition, you must go 
in the conductor view (Windows menu, Conductor... item) and double-click on the audio track you want to 
edit. The audio tracks associated to a score may be shown by clicking on the little icon on the left bottom of 
the rectangle representing the score:

In both cases, the audio editor window appears: 

If you do not have an audio wave file to use while exploring this window, we suggest that you create an 
audio file from one of your Pizzicato scores, as explained in the previous lesson. In this lesson we have taken 
the audio file generated from the Pizzicato example 44, as we did in the previous lesson. This lesson will 
explain all aspects of this window.
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The various parts of the audio window

The central part displays the sound wave itself. In this example, the file is stereo, so there are two sound 
waves displayed. The upper wave (in blue) is the left channel and the lower wave (in red) is the right 
channel. Please note that the display and background colors you see on your screen may be different, 
according to the graphic options chosen, but this does not affect the functionalities of the window areas.

Just above the sound waves, there is a graphic area that displays the time scale. By default, the scale is 
expressed in seconds, with 6 digits after the comma to specify a precision of one microsecond. You may 
change this scale to display the number of samples or a reference to the measures and beats of the score, with 
the popup menu that appears in the right part of the toolbar:

When the window is opened, the full range of the wave is displayed. In this example the audio file has a 
duration of about 7 seconds in full CD quality (44100 samples per seconds) which means that there are about 
300000 sample values displayed in one row. This is why the sound wave appears as a "thick block" and not 
as a nice curve moving up and down as we showed in the lesson on music notation.

The bottom part of the window shows information regarding the location over which you move the mouse 
inside the wave display area. The values displayed are respectively:

• Sample: this is the number of the sample. The first sample is sample number zero. Going from left to 
right, this number increases to show what sample the mouse is moving over. 

• Time: this is the time value, in seconds with a precision of one microsecond, that corresponds to the 
moment when the sample is playing, relative to the beginning of the file. 

• M-B-U: this means Measure-Beat-Unit. It may be used to see the related point in the associated 
score. This indication shows the measure number, the beat number of that measure and the fraction of 
the beat (480 units is one quarter note) that corresponds to the moment when this sample is playing. 

• Value: is the value of the sample pointed to by the mouse in the wave area. It is always expressed as 
if the file was in 16 bits definition. If the file is in 8 bits definition, a conversion takes place 
automatically. It is expressed between -32768 and +32767 and also as a percentage value (-100 % to 
100 %). 

Above the horizontal scroll bar, there is an area that always shows the full audio file, in three colored bands:

The middle band shows a small representation of the sound wave. The yellow graph on a dark gray 
background shows what part of the file is visible in the main area of the window. When the window is first 
opened, this is the full file. Let us see how you may zoom into the file and display any part of it.

• Click in the middle of the central band. The above area becomes for instance: 

A small gray line appears where you clicked, showing now in the main area the detailed graph of 
the sound wave, for instance:
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• If you want to see some portion of the file in the main area, you may click, hold down the mouse and 
drag it on a specific range in that middle band. When you release the mouse button, the gray area is 
shown in the middle band and the main area displays the corresponding part of the file. You have for 
instance: 

• You may also adjust the left and right border of that gray area. By clicking just on one border, you 
may adjust that border to enlarge or diminish that area. 

• When the gray area does not cover the full range of the file, the horizontal scroll bar just below it lets 
you move that area left and right, so that you can display any part of the audio wave. 

Specifying the file area to play

The lower band of that area (in green) specifies what part of the file will be played when you click on the 
yellow triangle in the icons under the title bar. By default it is the full file.

• Click on the yellow triangle tool and you should now hear the file playing. The blue square icon just 
to the left is the stop button and the double blue square to the right is the pause button (clicking on 
the pause stops the playing, clicking again proceeds to play). The red circle button will be used later 
to record sound into the file. 

• You may select the playing area by clicking in the green band, holding down the mouse, dragging it 
over the part of the file you want to hear and releasing the mouse button. Only that part is now 
displayed in green. If you click on the yellow triangle, you will hear just that part of the file: 

Notice that the corresponding green area is also displayed in the scale area. You may use the 
same process as above to select the playing area in the scale area. In both cases, you may also 
extend the green area by clicking on one of its border and by dragging it. Another way is to click 
outside the green area while holding down the SHIFT key of the computer keyboard. The green 
area is then extended up to that location. This is also valid to extend the gray area.

• The  icon is used to play the green area in loop. When it is enabled (just click on it to enable or 
disable it), if you play the file with the yellow triangle, that part of the file will be played endlessly, 
each time going back to the beginning of that part, until you either stop it or disable the loop button. 

• When you play a part of the file, you see a vertical line moving through this band, showing the 
position where that is played. This happens in the above area but also in the main area where the 
wave is displayed. As the main area does not necessarily show the full file, you only see the vertical 
line in the part of the file that is shown. If you want the main area to show at any time the place 
where the sound is playing, you may enable the  button, which forces Pizzicato to follow the 
playback graphically. 

Selecting the working area

When you want to modify the file, you must specify which part of the file you want to work on. This part is 
called the selection. Here is how to specify a selection in the file.

• In the upper area of the colored band (which is now blue), you may click, hold down the mouse 
button, drag over a part of the file and release the mouse button. The corresponding area becomes 
black. It is the selection: 
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The corresponding main area also becomes black, showing the part that is selected:

• You may select a part of the file directly in the main area, with the same process as above. You may 
in both cases move the edges of the selection or extend it by clicking outside the selected area while 
holding down the SHIFT key. 

There is a check box to the right of the toolbar which, when checked, automatically sets the playing area 
(green) equivalent to the selection whenever you modify the selection:

P=S means Play equal Selection.

Modifying the selected area

Once you have specified a selection, you may apply several modifications to that portion of the file. Most 
modifications are available through the use of a menu that appears when you click with the right mouse 
button on the main display area:

Here is a description of the various actions you can do with a selection.

• Cut - This is the standard operation that transfers the content of the selection in a temporary memory 
called the audio clipboard. The selection disappears from the audio file. This operation reduces the 
length of the file by the size of the selection. 

• Copy - This is the standard operation that transfers the content of the selection in a temporary 
memory called the audio clipboard, but does not remove the selection. The audio file is not affected 
by this operation. 

• Paste - The paste operation is only possible when the audio clipboard has some content in it, which is 
the case after a cut or copy operation. The content of the audio clipboard may come from the same 
file or from another audio window editor (Pizzicato Professional only). The content of the current 
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selection of the audio file will be replaced by the content of the audio clipboard. Note that the audio 
clipboard content is left untouched. 

• Multiple paste - Same as a paste, except that a dialog asks for the number of times you want to paste 
the clipboard into the file. If you answer "10", the content of the current selection will be replaced by 
ten times the content of the audio clipboard. 

• Mix - The mix operation is only possible when the audio clipboard has some content in it, which is 
the case after a cut or copy operation. The content of the audio clipboard may come from the same 
file or from another audio window editor (Pizzicato Professional only). The content of the audio 
clipboard will be mixed with the current file, starting at the beginning of the current selection. This 
means that the original sound from the file is still there and has been mixed with the audio clipboard. 
Note that the audio clipboard content is left untouched. 

• Multiple mix - Same as mix, except that a dialog asks for the number of times you want to mix the 
clipboard into the file. If you answer "10", the content of the audio clipboard will be mixed ten times 
with the current file, starting at the beginning of the current selection. 

• Silence on selection - This operation clears the sound present in the selection. The duration of the 
file stays the same, but the sound present in the selection is replaced by silence. 

• Remove selection - This operation removes the selection from the file. The file is then shortened. It 
is similar to the cut operation, except that the content of the selection is not copied into the audio 
clipboard. 

• Keep selection - This operation does just that: the parts of the file before and after the selection are 
removed and the file consists then of the content of the original selection. 

• Insert a silence - A dialog asks you to specify a duration, in milliseconds. If you click on OK, 
Pizzicato will insert a silence before the current selection. The selection is not removed. The file 
duration is increased by the amount of time you have added. 

• Modify selection... - The following dialog appears: 

The left frame lets you select the operation you want to perform on the selection. According to 
the operation, there are other items that appear in the dialog, as we will see here. When you click 
on the OK button, the effect is applied to the selection. The file duration is not modified with 
those operations.

• Modify volume - The volume of the selection will be modified according to the sliders 
displayed to the right. You may affect both left and right channels or only one of them by 
using the appropriate checkboxes. The values of the two upper sliders specify 
respectively the volume level applied at the beginning and at the end of the selection, for 
the left channel. The lower sliders are for the right channel. For instance, if you want to 
create a fade out effect (the sound disappears progressively), you can put the first slider to 
100 % and the second slider to 0 %. 
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• Set to silence - It is a short way of setting all volumes to zero, for either both channels or 
only one. 

• Normalize (maximum volume) - This operation will first compute the maximum 
volume that may be applied to the selection, avoiding any saturation of sound. It will then 
apply that volume to the selection, for the channels you select. The result is that the 
selection will have its maximal possible volume without saturation. 

• Switch channels (left and right) - This operation simply copies the left channel of the 
selection to the right channel and vice versa. 

• Invert time direction - This is a special effect that inverts the time of the selection for 
the selected channels. 

• Add echo - The following items appear in the dialog: 

An echo of a sound is the same sound delayed and heard again with less amplitude. 
This happens for instance when you are in a large hall or under a large bridge or if 
you speak loudly in front of a distant wall or a mountain: you hear your voice back 
with some little delay. The delay is as long as the distance that separates you from 
the wall or mountain. It is the time needed for the sound to go from you to the wall 
and back to you again after the reflection against the wall. This operation may be 
added here to the content of the selection. You may specify the delay in milliseconds 
(1000 milliseconds is one second), the number of successive sound reflections as 
well as the amplitude applied to the successive reflections. A check box is provided 
to alternate the echoes on both sound channels, giving the impression that the sound 
bounds between left and right.

• Add a wave - The following items appear in the dialog: 

This operation will add a simple note of music to the selection. The original content 
of the selection is still there, but a note has been added to it. The note duration will 
be the full size of the selection. The pitch (frequency) of the note may vary between 
two pitches expressed in Hz (Hertz means here sound vibrations per second). Those 
pitches may also be specified with the popup menus of the note names and octave 
numbers. Changing these popup values will compute the corresponding pitch in the 
text box above them. The timber (wave form) of the note may be selected between 6 
simple wave forms: the sine wave (which is the purest timber available: it contains 
no other harmonic frequencies than the main one), the triangular wave, the saw tooth 
wave, the square wave, the pulse wave in 25% and 10% (which is the length of the 
sound pulse inside a sound cycle). Each one gives a particular sound sensation that 
you should try for yourself. A more technical parameter is the phase of the added 
sound which may vary between 0 (no delay) and 360° (a full cycle of the wave). The 
volume sliders also apply so that you may vary the starting and ending amplitude of 
the note for both channels.
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• Change time scale... - The following dialog appears: 

With this operation, the selection will be stretched in time. The file duration will then be 
modified. The stretching factor may vary from a starting to an ending value. A value greater than 
100 % will extend the duration of the sound, while also lowering its frequencies. A value less 
than 100 % will shorten the sound while also increasing its frequencies. Applying this effect to a 
voice will for instance make it quite different. This may be used to create special effects, for 
instance a piece of music playing on an old phonograph and your finger pushing on it to slow it 
down. Or the effect of rewinding a record very fast. Just try it for yourself.

• Precise selection... - The following dialog appears: 

This operation does not affect the sound but merely helps you to adjust an existing selection 
precisely. For instance, if you want to concatenate two audio parts, you may select the first as 
explained before and copy it to another place. But if you want a precise result, without a 'click' 
sound in the transition between the two audio parts, you should specify the selection very 
accurately, so that the wave goes smoothly from one audio part to the other. This is mainly done 
by being sure that the last sample value of the first audio part is quite similar than the first 
sample value of the second audio part. Otherwise there will be a discontinuity that will result in a 
'click' effect. 

With this dialog, you have the possibility to adjust the starting and ending points of the selection:

• By specifying the number of the sample 
• By specifying the time position, in microseconds (1000000 microseconds is one second) 
• By specifying the measure, the beat and the fraction of the beat (one quarter note is 480 

units) in relation to the score. 

Moreover, you may ask Pizzicato to adjust that selection:

• To the closest zero crossing point (that means where the wave crosses the central line of 
the wave diagram you see on the screen, where the air particle is in its central position) 

• To the closest up zero crossing point (the wave crosses zero from below the central line 
to above the central line) 
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• To the closest down zero crossing point (the wave crosses zero from above the central 
line to below the central line) 

This is useful if you work with sound waves that you want to multiply for instance to make a 
note sound longer without touching its frequency. You may select a part of the wave and then 
apply the up zero crossing adjustment so that the selection is ready to be pasted a lot of times in 
sequence without any discontinuities.

Zooming

Here are some ways to better determine which part of the file you want to see.

When you specify the gray area as explained above, the length of that area determines the zoom that is used 
to display the audio information in the main area. You may also directly determine the zoom values, with the 
following toolbar items:

The first popup menu tells how much pixels will represent how much samples of the second popup menu. 
Remember that a pixel is the smallest graphical area that can be displayed on a computer screen. In the 
above case, there will be 5000 samples displayed on a screen width of 7 pixels.

You may select other values in the popup menus or use the "-" and "+" buttons to go step by step. Try some 
values and see how it looks like on the screen. 

When you click in the gray area without dragging, the zoom value is automatically set to 1/1, which means 
one sample per graphic pixel.

Another zoom is available in the left part of the toolbar:

This value may be increased up to 6400 % and lets you increase the vertical scale of sample representation. 
For instance, at 100 % you may see a soft sound like this:

Zooming to 1000 %, the wave will be displayed with more details:

When using a vertical zoom, the full range of the samples will be higher than the vertical size of the panel 
that displays the wave. To move up or down, use the vertical scrollbar to the right of the window.

At any time, by holding down the CTRL key, you may click and drag inside the wave display area and the 
mouse cursor takes the form of a hand and lets you move the wave left and right (and also up and down if 
the vertical zoom is greater than 100). This is an easy way to move in the wave slowly, so as to examine it.

File operations

When using the contextual menu of the wave display area (right-click or Alt-click on Mac), a menu is 
displayed with the operation that may be applied to files:
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Here is what you can do with this menu.

• New... - Creates a new audio file. A first dialog asks you to specify the name and the location of the 
file. Another dialog appears: 

You may select the audio quality that will be used in that file. Then another dialog appears: 

You may specify the duration of the file, either in samples, in seconds or to reach the end of a 
measure number of the current score. When you validate, the audio window displays the new 
file.

Note that this file is a new one. The previous audio file displayed was associated to the current 
score and stays associated with it, but this new file has not been automatically added to the score. 
If you want that file to play with the score, you must explicitly associate it to the score, as 
explained in the lesson about audio tracks.

• Open... - This loads an existing audio file into the audio editor. The above remark is also valid: the 
opened file is not automatically associated to the score. 

• Save - Save the changes to the file on disk. Unless you do that (or answer yes to the dialog asking to 
save the file when you close the window), the modifications you perform on the audio file are 
temporary. With a save, they become permanent. 

• Save as... - Save the file with another name. The original file still exists and stays associated with the 
score. The new file is not automatically associated with the score. 
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• Copy to file... - To use this menu, there must be a selection present. This operation copies the 
selection into a new file. Pizzicato asks you to specify the name and the location of the file. 

• Paste from file... - This operation will replace the current selection by the content of another audio 
file. Pizzicato asks you to select an existing audio file that will be pasted in the selection. 

• Mix from file... - This operation will mix the current file (starting at the beginning of the current 
selection) with the content of another audio file. Pizzicato asks you to select an existing audio file. 

• Set file duration... - This operation is used to modify the exact duration of the current file. Pizzicato 
asks you to specify the file duration: 

• Change file format... - This operation is used to modify the format of the audio file. Pizzicato warns 
you that the file will also be saved with that operation. Then Pizzicato asks you to specify the new 
format (quality) of the file: 

Recording an audio file

We have seen in a previous lesson how to create an audio wave file from any Pizzicato score. You may also 
record a new audio sequence and insert it into the existing file. You must first specify a selection and then 
the  icon is used to open the audio real time recording dialog. When you click this icon, you get the 
following dialog: 

• The two sliders let you specify the recording level. The bar graphs should now display any sound that 
is coming from the selected source of sound. 
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The sound source used for the recording is not selected in Pizzicato but in the Windows record 
volume control panel or in the Mac Sound panel in the System Preferences. To know how to 
select a source, see the lesson on exporting a score into a wave file. If you want to record your 
voice or an acoustic instrument through a microphone, you should then select the microphone 
and connect your microphone to the computer sound card.

• You may start recording by clicking the Record audio button. To stop it, use the STOP button. You 
may do that many times if you want. The last recording will be the one you can use. 

Notice that the score with which the original sound file is associated will be played while 
recording. This is useful for instance if you want to sing on a musical accompaniment that you 
made in the score. In that case, you should use a headphone to hear the music and sing in the 
microphone, so that the microphone does not also record the music you hear (which is useless 
because the music is already in the score and it would create a bad interference). The same 
principle is valid if you record an acoustic instrument.

• Once you are done with the recording, the lower part of the dialog lets you specify what you want to 
do with that record. You may: 

 Insert the recording before the selection 
 Replace the selection by the recording (the previous selection is then removed) 
 Insert the recording after the selection 
 Mix the recording with the content of the file, starting at the beginning of the selection 
 Open a new audio window with the recording. In that case, you may modify the recording 

(for instance remove some parts or silence,...) and then you may use the copy/paste 
function to include it in the file you are working on. 

Once you have selected the operation you want to do, click on OK and Pizzicato executes the 
action.

Modifying the wave directly

You may modify the wave directly with the three following tools, available in the toolbar:

• To use these tools, the sample zoom value must be equal to 1. You may use any pixel zoom value 
(from 1 to 16). 

• Go to the beginning of the audio file and click on the first tool above. This is the drawing pen. You 
may now draw directly into the wave display area with the mouse to modify the wave: 

With this tool, you may correct any irregularity you find in an audio file (a "scratch" from an old 
phonograph record,...).

• The next tool just sets any sample you touch to zero. 

• The last tool helps you to draw lines, for instance: 

• To disable a tool, just click on it again and it becomes inactive. 

576



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

Miscellaneous options of the editor

You can open the option dialog with the contextual menu when you right click (alt-click on Mac) in the main 
wave display area. Select the Options... item and the following dialog appears: 

You may select the number of undoable operations, between 2 and 15. You may also customize the various 
colors used when displaying the waves.

In the left part of the toolbar, you will find the following items:

• The L and R checkbox lets you respectively display the left and right channels. 

• The Sup. checkbox, when checked, will display the left and right channel superposed. You can then 
more easily compare both channels. 

• The next three items have been described above: they are used to change the vertical zoom. 

• The next three icons represent three ways of displaying the wave form, respectively: 

• Each sample is displayed as one dot:  

• The samples are connected together with a line:  

• The samples are displayed with a full vertical line starting from the central position: 

 

Note that to see the difference, the display zoom must be less or equal to 5 samples per pixels.

The spectral analyser
• What is an audio spectrum? 
• The spectral analysis window 
• Working on the harmonics of a sound 
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What is an audio spectrum?

Sound is just a vibration of the air or of the matter in which it propagates (water, wall,...). This vibration 
starts for instance in a music instrument when the player makes his instrument vibrate, by picking up a 
string, hitting a drum,... This vibration is then transmitted to the air around the instrument and it comes to the 
auditor's ear and gets registered as a sound impression to him.

So, to represent a sound signal, you need to measure the air pressure at specific regular intervals and 
memorize these values. This is what is done when you register a concert with a microphone and a digital 
recorder. By playing this sequence back into a loudspeaker, you can reproduce the exact sound that was 
recorded. Because of the frequency band to which the ear is sensible, to have a good reproduction quality, 
you must sample the sound signal 44100 times per second, with a sufficient precision level. This series of 
values is called the time representation of the sound. It gives the pressure value at any given time of a music 
concert. Here is how it appears for instance in the audio editor window of Pizzicato:

A mathematician called Joseph Fourier, established in the 19th century that such a signal could always be 
decomposed as a sum of sine and cosine waves of fixed frequencies and amplitudes. Practically, this means 
that the sound of a full orchestral symphony may be reduced to the sum of a series of simple sine waves with 
specific amplitudes and phases, with no variation in time for the full duration of the symphony. When you 
think about it, it is quite fascinating! But do not change a few of the frequencies or amplitudes, as the 
symphony may become an obscure sound confusion.

This way of representing a sound of a given time duration is called the frequency representation, or the 
frequency spectrum of the sound. In theory, you can switch back and forth between the time representation 
and the frequency spectrum representation and lose no information in the process (which means, keep the 
sound exactly the same). In practice, you can not make this process with an infinite number of frequencies, 
so you have to quantize the frequencies you will analyse and this precision may affect the sound result.

Pizzicato lets you analyse a portion of a sound signal to see what it represents in terms of frequency. You 
can then edit these frequencies (delete some, add some others, modify the spectrum, filter it,...) and then 
synthesize the signal back to the audio window. This is a way of experimenting sound design and 
manipulations. We will see now how to do that practically.

The spectral analysis window

When you select some portion of a sound in the audio window (see the lesson on the audio editor window), 
you can right click the background of the window and reach the contextual menu item Spectral analysis...

• Open a WAV sound file with the File, Open an audio file... menu item. You can open one of your 
own file or if you have a Pizzicato license (not in demo mode), you will find several audio files in the 
DataEN / Libraries / Music libraries / Audio / Papelmedia. Be sure however not to modify these 
files, as it may have an impact on the sounds generated by Pizzicato. To be sure, make a copy of one 
of these file and open it. 

• Select some portion of the file, for instance a segment of 1 or 2 seconds. Right click on the 
background of the window and select the contextual menu item Spectral analysis... The spectral 
analysis windows appears: 
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• Click the Analyse button and Pizzicato will now analyse the selected portion of the signal and display 
its frequencies. According to the duration of the signal and the frequency precision needed, this 
operation may take some time. A colored bar at the bottom of the window shows you the progress of 
the computation. Then Pizzicato will display the spectrum, for instance: 

• When you move the mouse over the window, you can see the exact frequency and amplitude pointed 
to by the mouse, at the bottom left of the window. 

• Just above the spectrum, you will see a scale with the frequencies. Below the window, you have a 
scroll bar so that you can see the rest of the spectrum (to the right). 

• To the left of the tool bar of the window, you can select an horizontal zoom value to see frequencies 
more precisely or on a larger spectrum. 

• The next 3 text boxes specify the frequency range and precision of the analysis. By default, the first 
frequency analysed is 20 Hz and the highest frequency is 4000 Hz. In that range, the step used is 1 
Hz. This means that the frequencies analysed will be [ 20 - 21 - 22 - 23 - ... 3998 - 3999 - 4000 Hz]. 
You may change these values and click again on Analyse to see a more precise spectrum. Be aware 
that the larger the range and the precision step, the longer the analysis will take. 

• This window may also be used for a special case. If you select one period of a sound in the audio 
window (which means a full up and down of a periodic sound like flute, violin,...), you can then use 
the Harmonics button and Pizzicato will analyse the harmonic values (integer multiples of the 
frequency of the note) and display them on the window. To select only one period of the sound, you 
should zoom in in the audio window so as to see the individual signal path, then select for instance 
from one zero value up to the next similar zero value of the signal. When zooming in, you will notice 
that most sounds have a repetitive pattern. You must then select the duration of just one such pattern. 

• The Synthesize button let you reverse the process. Pizzicato will create the signal again from the 
spectrum analysis to the audio window selection. Notice that you can change the selection before 
doing this, for instance to place the modified copy somewhere else in the audio file. The text box just 
to its right specifies the amplitude of the synthesized signal, by default 50 %. 

• You will find three tools that you can use to modify the spectrum: a pen, an eraser and a line drawing 
tool. Select one of these tools and use it inside the window to modify the spectrum. Be aware that a 
small change in the spectrum may create unexpected changes in the audio signal. You can easily 
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experiment with this. One application is for instance to filter some frequencies in a signal. Analyse 
the signal with sufficient precision, erase the frequency range you do not want, then synthesize the 
signal back. You can transform for instance voices very amusingly. 

• With a right click in the window, you can reach a contextual menu to save or load a spectrum as a 
file. This can be useful if you work some sound design and want to remodel its spectrum shape. You 
can save it and open it again later as a spectrum file. 

• You will find a menu called Amplitude on the tool bar. It contains 4 items that can be displayed: 
Cosine, Sine, Amplitude, Phase. We will not get here into the exact mathematical meaning of these 
graphs. Roughly, the signal can be represented as a sum of cosine and sine waves, OR, as amplitude 
and phase. The phase is the moment at the beginning of the signal, when a sine wave starts. Working 
on the amplitude is the most easy way to change the signal, but you may try to affect its phase also. 
Or you can try to work directly on the sines and cosines, but the result will probably much more 
random than just filtering. By changing the phase of a signal you can really distort the original signal. 
Try and see. 

• To design a new spectrum, select its range and precision and then click on the New button. The 
spectrum is then reset to zero and you can draw a new one. 

Working on the harmonics of a sound

You can design a new spectrum based on the harmonic series and then synthesize the corresponding sound.

• Create a new spectrum by clicking on the New button. Click on the Filter... button. The following 
dialog appears: 

By enabling the first check box, Pizzicato will apply a filter on the spectrum, based on the note 
you select in the above dialog (you can also enter any frequency). This filter will act to display 
and use only the integer multiples of the note frequency. For instance, if you have a note of 220 
Hz, Pizzicato will only enable the harmonics of this note, which are [220, 440, 660, 880,...].

The Inharmonic factor can be used to detune the all harmonic construction, as this number will 
be used to multiply frequencies. For instance, if you enter 1.1 for that value, the harmonic will 
become [220, 220+220*1.1=462, 462+220*1.1=704,...].

The Enlargment of harmonic peak will in fact extend slightly each harmonic. For instance, if the 
value is 1 and the precision is 1 Hz in the spectral window, there will be the presence of the 
above harmonics but for harmonic 440, there will also be 439 and 441 frequencies, etc...

By clicking OK, Pizzicato will filter out any frequency of the current spectrum that is not in 
these specifications. You can then use the pen, eraser and line drawing tools to design a spectrum 
and you will see that only the harmonics as specified in that dialog will appear. You can for 
instance draw a spectrum like this, around C1, with a peak enlargment of 4 :
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You can then synthesize it back in the audio window and hear how it sounds like. Then modify, 
synthesize and hear again. You may combine this kind of manipulation with the design of a 
virtual and modular synthesizer to create and modify samples of your own sounds.

The virtual instruments
• What is a virtual instrument? 
• Using the virtual instruments 
• The virtual instruments library 
• Importing SoundFont files 
• Tuning 

What is a virtual instrument?

Before version 3.4, Pizzicato was only able to play a music score through MIDI interfaces and synthesizers 
existing on the sound card or as component parts of Windows or Mac OS X. With that limitation, Pizzicato 
had no way of improving or modifying the final sound quality of the music. The principle of MIDI playing is 
to send a series of commands telling what instrument must play and what are the notes to play, but nothing is 
said about the sound quality. So the final result was completely dependent on the sound card or external 
synthesizer. The same Pizzicato score could sound very badly or very nicely, according to the sound card or 
the synthesizer you had.

This limitation is also true for all music software that are limited to MIDI playing. To achieve a sound 
quality that is independent of a sound card, a hardware synthesizer or a software synthesizer, a music 
software must create the sound itself of the instruments and send it directly to the sound card. This requires 
two things. The first is the ability to compute in real time or in advance, the resulting sound of several 
instruments playing together, including the correct pitch of notes, the envelopes, vibrato effects,... The 
second is to have a good quality sound library, consisting of samples of real instruments that have been 
recorded from live musicians. We are happy to announce that with version 3.4, Pizzicato now includes these 
two features.

Using virtual instruments requires much more processor power, memory and hard disk resources than 
playing MIDI. The sound library delivered with Pizzicato is the Papelmedia library (original site: 
http://www.papelmedia.de/english/index.htm ). ARPEGE has bought the rights to distribute the Papelmedia 
library with all versions of Pizzicato. When you install the sound libraries, you need about 1.2 GB (1200 
MB) on the hard disk.

According to the number of instruments playing together and the density of notes in the score, the processing 
power of a given computer may not be enough to play it all in real time. To avoid this problem, Pizzicato has 
a buffered playback function. This means that the sound of measures may be computed by Pizzicato in the 
background and stored in memory buffers. When Pizzicato plays the score, it plays the measures back from 
the buffers. You can in fact combine real time playing with buffered playing and select which instruments 
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play in real time or not. You can of course also combine these virtual instruments with standard MIDI 
instruments.

Even if your computer is slow and does not have too much memory, you will be able to create an audio 
WAV file with the quality of the sound library. In future versions of Pizzicato, we will work on the speed 
and optimization of the audio playback functions in real time, so that more and more computers will be able 
to play all instruments in real time.

A virtual instrument is a structure that can be used by Pizzicato to generate the sound of an instrument or any 
kind of sound (explosion, birds singing, or any real world sound sample or synthesized sound in fact). In 
Pizzicato Light and Beginner, you can only use the General MIDI instruments of the library. 

In Pizzicato Professional and Composition Pro, a virtual instrument is in fact a synthesis structure that can 
be created, modified, used, combined or imported from SoundFont files, as we will see in this lesson. The 
full editing features of a virtual instrument will be explained in another lesson, called Modular audio 
synthesis.

Using the virtual instruments

By default, a Pizzicato score does not contain any virtual instrument. Instruments are defined by default to 
use the sound card MIDI synthesizer.

• Open the Ex044.piz document from the DataEN / Examples directory. Play the score with the yellow 
triangle button. You will hear it play through the MIDI synthesizer of your sound card. The MIDI 
instrument selection is done with the instruments view, in the Windows menu. 

• To assign the virtual instrument, use the Edit, Assign virtual instruments to staves... menu item. 
Pizzicato loads the audio samples into memory. In the main palette (Tools menu), click the reference 
marks tool . The score is displayed with the reference marks: 

You can see the virtual instruments just above the first measure of the staves. They are 
represented by the  icon followed by the name of the instruments. They are visible when the 
reference marks tool is activated (its shortcut is ":").

• Play the score with the yellow triangle button. Pizzicato plays the score with the sounds from the 
included Papelmedia library. 

• If you now open the instrument view (Windows menu), you will notice that the Synthesizer, Family 
and Instrument columns are disabled. The MIDI commands to select the instrument is no more 
active, as the instruments are now virtual instruments assigned by Pizzicato. 

582



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

Since version 3.5.3, you can directly change an existing virtual instrument by changing the 
instrument selection in the instruments view.

To remove a virtual instrument from the score, point its icon with the mouse and use the delete 
key or the backspace key.

In Pizzicato Professional, we will see in the next section, a more advanced way to manipulate the 
virtual instruments in a score.

You can also assign a virtual instrument only to one or more staves. To do that, select the staves 
you want with the selection tool (see the lesson on selecting measures ) and then use the Edit, 
Assign virtual instruments to staves... menu item. If you do not select staves, all staves are 
assigned to virtual instruments.

• Click on the  button in the score window tool bar. The dialog that appears show a popup menu 
called Audio playing mode. This menu has three possible choices: 

• Audio playing per measure - In this mode, Pizzicato will prepare the playback sound and 
store it in a memory buffer. This preparation is done for each mesure of the full score. 
This mode may sometimes take a few seconds before the score starts to play, as Pizzicato 
must prepare at least the first measure before starting to play. While playing mesure 1, it 
already computes measure 2, and so on. In this mode, it is the preparation of the audio 
buffers that take much processor time. Playing the buffers does not take many processing 
power. 

• Real time audio play - In this mode, Pizzicato creates the sound in real time, as notes are 
played. When several instruments are played together with much notes, your computer 
processor may not be enough at some point to make the sound continuous. In case you 
hear a jerky or interrupted sound, you should use the first mode, with audio buffers per 
measure. You can also remove one or more virtual instruments and use their MIDI 
equivalence, that will not need so much power. 

• Play all in MIDI - In this mode, the virtual instruments are simply ignored. They are not 
deleted from the score, but Pizzicato plays all staves with the MIDI synthesizer. You can 
use this mode for instance when the sound is irregular with the real time mode or if 
Pizzicato is too slow while playing with audio buffers. This may for instance be the case 
for large orchestral scores. You can work them with MIDI and when the score is ready 
you can export it to a WAV audio file in good sound quality. 

When you have MIDI instruments and virtual instruments playing together in the same score, 
you may hear some timing difference between them. 

The most common case will be the MIDI instruments reacting faster than the virtual instruments. 
You can compensate this delay by the MIDI delay in milliseconds (correction for audio) slider 
that you will find in the Options, MIDI play option... menu item.

In case of the virtual instruments reacting faster than the MIDI instruments (this may happen if 
the MIDI instrument is also a software synthesizer, slower than Pizzicato), you can slow down 
the audio reaction time of Pizzicato by increasing slightly (by steps of 50 units for instance) the 
output buffer size text box that you can find in the Options, Audio setup... menu item.

• Open the instruments view, with the Windows, Instruments... menu item. Then select the MIDI 
parameters configuration (by clicking on the gray inverted triangle at the top left corner of that 
window). You will see the last column entitled Rtp, which means Real Time Playing. When you 
check that box, it forces the corresponding staff to always play its virtual instruments in real time, 
even if the memory buffered playback is selected as explained above. 
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• In the Options menu, select the Audio synthesizer volume... item. Pizzicato displays the audio 
synthesizer volume window: 

At any time, it displays the activity of the virtual instrument player. You can adjust the volume 
with the sliders. If the sound level is too high, the bargraph will show a red portion. This means 
that the sound experiences a distortion and you should then decrease the volume level, as the 
sound quality will be bad. The bottom bar shows how much work Pizzicato must still do to 
complete the buffers of the audio playback system. You can keep this window open if you want.

The virtual instruments library

In Pizzicato Professional and Composition, in addition to the features already explained above, you have full 
access to the music composition sound libraries through the conductor view. The principle is that you can 
select a virtual instrument from the library and drag it to the score. You can also duplicate instruments, edit 
them, create new ones or import them from SoundFont files found on the Internet.

• Open the Ex093.piz document in the DataEN / Examples directory. 

• In configuration 3, area 2, you will find the Virtual instruments folder: 

We will first explore the Papelmedia library, which is the default library Pizzicato uses when 
you assign instruments automatically.

• Open the Papelmedia icon. Then open the Woodwind icon. Several virtual instruments from that 
family are displayed: 
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• Click for instance the Flute instrument, drag it to the score and drop it right at the beginning of the 
first measure of the first staff. You must release the mouse inside the staff lines, not just above or 
below it. Then enable the reference mark tool  (shortcut ":") and the score will display the position 
of the virtual instrument: 

You can now listen to the score. The flute will be played by Pizzicato as an audio virtual 
instrument from the Papelmedia flute samples.

• You can now add a virtual instrument for each staff, for instance harp (from the plucked strings 
family) in the second staff and strings ensemble for the last staff. But you can also add virtual 
instruments at any time in the score, to change the sound playing the melody. For instance, you can 
drag a trumpet (from the brass family) to the third measure of the first staff. You whould now have: 

You can now listen to the score.

You can remove a virtual instrument just by pointing the mouse on it and by using the delete or 
backspace key.

Most sound card now provide some reverberation effects that can greatly improve the sound 
result. You should try it. Check your sound card help file and control panel to see how it can 
generate such an effect and how much effect gives the best result. This feature must be adjusted 
outside Pizzicato and is only related to your sound card.
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You will notice that there is another library tree called Papelmedia - SoundFont version. These sounds were 
imported from the original library as soundfont players. They can not be modified in Pizzicato. You can use 
them in place of other Papelmedia library. Some synthesized sounds may be played more accurately, but 
they will require more processing power. However, the differences will be minor. We suggest to use the 
Papelmedia folder, as all sounds have been reviewed and a few bugs fixed as compared to the original 
SoundFont library (looping problems, levels adjustments, some notes that were missing,...).

The Sampled Sounds originaly contains a percussion map with special percussive effects.

You can explore the Synthesized Sounds folder, as it contains many special sounds examples from what you 
can do with the modular synthesizer included in Pizzicato. Theses synthesizers will be treated in the lesson 
on Modular audio synthesis. Meanwhile, you can use them exactly as explained above to assign them to a 
staff to play the notes.

The Components folder may not be used as such. The items of this folder are components that can be 
assembled to create a synthesizer. You will find them useful in the Modular audio synthesis lesson.

You can double-click a virtual synthesizer icon directly from the score. Its editing window will display. You 
will find all details on this also in the lesson about the audio synthesizers.

Importing SoundFont files

A SoundFont file is a series of samples of one or more instruments. This file format is quite popular on the 
Internet, and you can find thousands of these files. You can buy SoundFont files, but you will also find lots 
of them for free. It opens Pizzicato and your music composition to a world of new sounds. 

When you download a SoundFont file, please read the licence contract. You will find a lot of files that were 
created by independent musicians for their own use and given freely for downloading by the Internet 
community. The licence may authorize you to use them in public records or not. It all depends on the author 
of the SoundFont, so you should refer to the site for this kind of information and respect the rules of 
copyrights.

A SoundFont file has the "sf2" extension. Here is how to import a SoundFont file. We will take an example 
from the site http://www.fox-gieg.com/rkhive/banks.html. In that page you will find a link entitled "Best  
Trumpet". Click that link and choose to save the file for instance on the desktop. The file is named 
besttrm.zip. Unzip this file and you will have a file named besttrm.sf2 on the desktop.

• In the library tree of the conductor view, right-click on the My library icon and select the Import a 
SoundFont file... menu item. A file open dialog box appears. Select the destkop and choose the 
besttrm.sf2 file. The following dialog appears: 

You have two options to import a SoundFont file. The first option imports the file as a 
SoundFont reader. The resulting sound may be more accurate but will need more processing 
power. Also, you will not be able to modify the sound parameters.

The second option imports the file as a series of samples and all their parameters. This format is 
specific to Pizzicato and you can then edit all sound parameters, as will be explained in the 
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lesson on audio synthesizers. This is the default choice, as most of the time there will be no 
difference with the SoundFont player and it will be less processor power consuming.

You can also ask to sort the banks and instruments inside the file. This is true by default, as it 
helps to find instruments in a file containing several sounds.

• Keep the default values and click Import. Pizzicato creates a document containing the virtual 
instruments found in the file. For the above example (you may use any SoundFont file), if you 
expand the document content, you will see the following: 

These virtual instruments may now be used as any others inside Pizzicato scores. You can drag 
and drop them inside a measure and Pizzicato will play the sound.

You should know that a virtual synthesizer is copied into a Pizzicato document, but the audio 
samples are NOT copied. When importing a SoundFont file, Pizzicato creates a sub-folder in the 
Audio / SoundFonts folder of the library and stores the audio samples there as WAV files. You 
can see this very easily in the library:

So if you send a score to a friend, you should also send him the SoundFont file so that he can 
import it and hear the same sounds as your original score. If you export the score to a WAV file, 
this is of course not needed, as the WAV file will contain the full sound created from the score.

You will notice that any WAV sound that is displayed in the library may be double-clicked. The 
audio editor window of Pizzicato is then opened. You can also select a file in the tree (by 
clicking on it) and then click the play button and you will hear the audio file play.

Tuning

As Pizzicato generates the sounds of virtual instruments, it has the control of the exact pitch (frequency) of 
each note. By default, the standard scale of frequency is used, as found on a piano. This is the equal 
temperament scale. Standard sound cards and synthesizers are all tuned on this base.

Contemporary music, baroque music, ethnic music or experimental music may need to use scales that are not 
tuned that way or that contain more or less steps than 12 per octave. Pizzicato Professional can help you to 
design such a scale and the score will be played accordingly.
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• Open the Ex093.piz document from the DataEN / Examples directory and assign the virtual 
instruments by using the Edit, Assign virtual instruments to staves... menu item. Then click the  
button on the score tool bar. Click the Tuning... button. The following dialog appears: 

The list displays all notes and their respective frequencies.

By default, the scale is computed automatically using the parameters displayed in the top right 
frame. Two parameters influence the tuning. The first one is the reference note and its frequency. 
Very often the A3 note is used as a reference to 440 Hz. You can change the tuning here. You 
may also select another note as a reference frequency. The second parameter is the number of 
division for an octave. The standard value is 12 half tones. If you set if for instance to 24, you 
will have a full quarter tone scale. Any change of these parameters will update the list of 
frequencies.

Using more or less than 12 steps per octave will create very special harmonies. You may be quite 
disappointed by trying to compose music with such a tuning, as most of the standard harmony 
rules do not apply anymore. You have to develop new approaches to find which notes will go 
together and build nice chords. This becomes very experimental. Note that the standard notation 
also will be disappointing, as the note names and position will still be the same, but the half steps 
will no more correspond. Composing music in such a case may be more easy by using the 
graphic note editor window and just ignore the note names.

If you disable the Automatic calculation frame, you can modify each frequency manually. To do 
so, click on one line of the list and you can change its frequency with the text box just below the 
list.

Once you have designed a scale (whether automatically or manually), you can give it a title and 
you can save it to disk with the Save this tuning... button, so that you can use it in other scores. 
Pizzicato asks for a file name and saves it. When you open another score, you can use the same 
dialog and click the Open a tuning... button so as to load the file previously saved. You will find 
a few prepared scales in the default folder. A tuning is specific to one score only and it is also 
saved within the Pizzicato document. If you send a score with a custom tuning to a friend, he 
will be able to hear it with the custom tuning.
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Please note that the tuning will NOT affect MIDI playback. Only virtual instruments will play 
according to the tuning you specify.

Modular audio synthesis
• Modular audio synthesis principles 
• Generators 
• Envelopes 
• Modulators and other operators 
• Filters 
• Audio samples reader 
• Tips and advices 

Modular audio synthesis principles

The principle of audio synthesis is to create a sound artificially. In the case of a software synthesizer, the 
computation of the sound is done by software. The audio signal is computed and sent to the sound card so 
that you can hear it.

There are several methods to synthesize a sound and you can virtually create any sound. You can try to 
synthesize existing sounds, to modify them or just create new, unexpected sounds completely freely. It opens 
the door to sound creativity, in the same way than music composition opens the door to music creativity.

The word modular means that the synthesizer can be built with construction blocks. You assemble 
elementary blocks, each one with a precise function, to create any combination you can imagine. To master 
this concept, you should know two things. The first is how you can combine elementary modules into more 
complex structures. And the second is a description of the role of each elementary module, so that you 
understand when and where to use them. Only then can you start combining them and constructing a sound 
with some insight of what you want and how to create it. So let us start with how to combine different 
modules.

• Start Pizzicato with a new document and open the conductor view (Windows, Conductor... menu 
item). In configuration 3, area 2, you will find the folder Virtual Instruments / Synthesized Sounds /  
Structures and sounds. You should see the following: 
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This part of the library contains several prepared synthesizers. As you can see, they are 
organized as a structured hierarchy of virtual instruments and folders.

• Open the folder entitled 1 - Single generator. Then open the Sine folder and double-click the first 
item, Sine E1. The modular synthesizer editor window opens and displays the structure of the 
synthesizer: 

This is a simple structure, composed of three basic modules. They are connected together by 
virtual cables. 
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A module may have outputs and/or inputs. An input is represented as a small green square  
on the left side of the module and an ouput as a small red square  on the right side of the 
module. You can connect an output to many inputs, but only one output may be connected to a 
given input.

To play the notes coming from the score and to send the audio signal to the sound card, this 
virtual synthesizer must be able to receive and send signals outside of itself. This is why a 

module must also contain input and output ports. An output port is displayed as  and 
represents an external connection to the outside of this virtual synthesizer, through which the 

signal resulting from the synthesizer will be sent. An input port is displayed as  and 
represents a signal coming from the outside of this virtual synthesizer. A MIDI input port is 

displayed as  and represents the influence of any MIDI parameter on the synthesizer. It 
can be the MIDI pitch of the note (which will determine the frequency of the note), the velocity, 
the volume, any MIDI controller, the pitch bend,... You may want these signals to influence the 
creation of the sound.

• If you have a MIDI keyboard connected to the computer, whenever you open such a synthesizer 
window, you can play notes on the keyboard and Pizzicato will compute the sound in real time. This 
is how you can easily test and try your sound while you are modifying the structure and its 
parameters. If you do not have an external keyboard, you can click on the Piano or Guitar button (on 
top of that window) to display the screen piano keyboard or guitar fretboard and you can click on the 
notes or frets to hear the synthesizer play. 

We will now learn how to add a module, a port and how to connect them together. Do not pay much 
attention for the moment to the meaning of the different modules. You should just understand how to 
connect them together. The rest of the lesson will go into much more detail about each and every module.

• Close that window. In configuration 1, right-click on your document's green icon and select the New 
virtual instrument menu item. A new virtual instrument is created. 

• Double-click that instrument. An empty synthesizer window appears. You can change its name in the 
text box on top of the window and you can add a description of your sound if you want, by using the 
Description... button. 

Adding a module or a port is done with a right-click of the mouse in the background of the 
window. A list of menu items appear. The position of the created module is at the location on 
which you right-click with the mouse, so you should first move the mouse where you want the 
module to appear.

As an exercise, we will construct a synthesizer with two modules, one input port and one output 
port. Then we will connect them together.

• Select the New MIDI parameter... item in the background menu. The following dialog appears: 
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You can select which MIDI parameter you want to influence the sound creation. We will here 
need the note item, which is almost at the bottom of the list (use the vertical scroll bar). Select it 
and click on OK. The MIDI input port is displayed, also showing the name of the parameter it 
represents (Note):

The Note MIDI parameter is used any time you want the sound to be in tune with the notes 
played on the keyboard or from the measures of a score. This is the most common case. But you 
would not need it for instance for natural noises as thunder, wind, special effects,... as this would 
not make sense playing a melody with such sounds.

Notice that you can move a port by clicking in its main square (here yellow) and moving the 
mouse. Release the mouse button when you want to fix its position.

• Select the Add a note generator menu item in the background menu. This module is a basic note 
generator. It has an input entitled Note where it should receive the MIDI note information coming 
from the Note MIDI parameter port we have just created. 

You can also move a module inside the window, by clicking in its background (but NOT in the 
gray or yellow sliders) and moving it. The graphic position of modules and ports will not affect 
the sound itself. The idea is that when you combine several modules, you may want to organize 
them graphically to have a clearer idea of how they are connected.

• Move the module and the port so that they are disposed this way: 
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• To connect an input to an output, you must: 

• Click on the small red square that represents the output of the input port, and hold the 
mouse button down 

• Drag the mouse inside the small green square that represents the input of the module. 
You will see a line moving with the mouse. 

• Release the mouse button to make the connection. The virtual audio cable is displayed. 

Do this now to connect the Note port to the Note input of the module. You should now have:

When you move a module inside the window, all connected ports will move with it. But you can 
still move the port independently.

• Select the Add a delay menu item in the background menu. Move it to the right of the first module 
and connect the Output of the first module to the Input of the second module. Select the New output... 
in the same menu, keep the default name in the dialog that appears and click OK. Move the output to 
the right of the second module and connect the module Output to the Output port. You should now 
have: 

You are now able to add and connect modules and ports. Here is a set of operations you will need while 
assembling modules together.

• To delete a module or a port, click on it with the right mouse button and the menu will display an 
option to remove this module or port. Any connection to it will be also removed. You can also point 
the module or port with the mouse and use the delete or backspace key. 

• To remove a connection, right-click on the destination green square of the cable and select the 
Remove this connection menu item. You can also point the destination green square with the mouse 
and use the delete or backspace key. 

• If you move a module while holding down the SHIFT key, all modules and ports that are connected 
to it, directly or indirectly, will move together. 

• If you move a module while holding down the CTRL key, all modules and ports will move together, 
whether connected or not. 

• If you click on a module while holding down the CTRL key and the SHIFT key, you will in fact 
duplicate the structure of modules connected to it. This can be used to easily reproduce an existing 
structure. 

• You can drag and drop a virtual instrument from the library, inside the content of an audio 
synthesizer window. You can then connect it to the structure you are working on. If you simply drag 
and drop it, it will appear as a single module with inputs and outputs. You can double-click it and see 
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what is in it and modify it. If you drag and drop it while holding down the CTRL key, the virtual 
synthesizer structure will be copied into the window with all its modules and ports visible. Using this 
feature, you can design virtual instruments or structures that you would like to use in other 
synthesizers and store them in a document in the My library folder. You can then use these building 
blocks to construct other synthesizers. 

• A virtual instrument should at least have one connected output if you want it something to play. If it 
has two outputs, they are considered being the left and right channels of a stereo output. If more 
outputs are present, they are not used while playing the instrument. 

• You will notice a menu called Polyphony on the tool bar of the window. This is the maximum 
number of notes that this synthesizer can play at once. The default value is 16, but you can increase it 
if more notes are needed. You can also set it to 1, which means only one note may be played at a 
time. 

• When you right-click a module, you will find a menu item entitled Reset this module. Each module 
may have parameter values that you can modify. This menu item will reset all the parameters of that 
module to their default values. 

Generators

The generator modules are used to create a sound. This sound may be a basic wave form or a sampled sound. 
Most generators may be modulated by another signal. This means that the sound it generates will be 
influenced by an input signal, coming for instance from another generator. In this section, we will examine 
all generator modules. You should have read the first section of this lesson, so that you know how to add, 
remove and connect modules in a virtual instrument.

Note generator
Create a new virtual synthesizer. In its editing window, add a MIDI input port (with Note 
parameter), an output port and a Note generator from the background menu. Connect them 
together so that you will have:

If you play some notes, you will hear a pure sine wave. It is the purest sound that you can hear, 
as it only have one frequency and no harmonic (an harmonic is a multiple of the original 
frequency of a sound). Any physical instrument will emit harmonics with its main frequency, 
and these harmonics, as well as their evolution in time, give it its unique sound color, also called 
the timbre. A sine wave is pure, but not very interesting, as it color is very poor. It is however 
used to create more complex sounds.

You may also hear a "click" sound effect when you start or release the note. This is because the 
sound is switched on and off with an abrupt transition. We will see in the later in this lesson how 
to smooth this by using enveloppes and amplitude modulators.

The module displays five parameters that can be modified.
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• The Frequency multiplier and divider may be used to do just that: multiply or divide the 
frequency by a given number. The ratio 1 / 1 is the exact note frequency of the note 
played on the keyboard. If you set it for instance to 2 / 1, you will hear the note with a 
doubled frequency, which means one octave higher in pitch. To change the value of a 
parameter, click inside the dark gray area just below the parameter name and drag the 
mouse to specify the desired parameter value. For instance, if you set the multiplier to 2, 
the module will display: 

The minimal value is displayed as a dark gray band, but any other value is colored in 
yellow proportionally.

Play a few notes and change these parameters at the same time. You will hear their 
effects on the sound.

• There are two Modulation inputs. The first one is used with slowly varying signals, so 
that the frequency of the ouput signal will vary slowly in relation to the output frequency. 
This is for instance the case with a vibrato effect. We will see an example below, with the 
Low frequency generator module. The second modulation input is called HF Modulation. 
HF means High Frequency. This input can be used to modulate the generator by a signal 
of the same order of frequency than the output signal itself. This is what is called FM-
Synthesis (FM = Frequency Modulation), a very well known method of generating 
sounds. 

• The Wave form parameter is used to select the basic wave form to use as an output. The 
default one is the sine wave. But if you click the gray area, a dialog will offer you a series 
of basic wave form that you can use. You should now try every wave form and play some 
notes with it. They are all simple sounds, but their color is different. The uper yellow 
rectangle of the module displays the graphic shape of the periodic wave. As their 
harmonic content is quite different, some wave form will appear much louder then others, 
for the same volume level. 

When you double-click in the background of the module (not in a dark or yellow parameter 
area), the following dialog appears:

The upper slider is used to detune the frequency slightly. It is most usefull when you use two or 
more generators and that you want to create a slow beat between them. The other three sliders 
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are used to create a volume level that depends on the note pitch (or from the note position on a 
piano keyboard). You can for instance create a sound signal that is louder in the lower part of the 
keyboard and that is progressively damped when the note pitch is higher. For this example, you 
can move the sliders this way:

The bottom slider is used to position the central point of the graph on the keyboard. 60 is the 
equivalent of the C3 note, the note below the staff in the G key. Try playing notes on a keyboard 
and hear their difference in volume.

We will now see how one module can modulate another module.

• Reset the default values of this module (right-click on it, Reset this module menu item). 
Add another Note generator and make the connectionsso that the window looks like this: 

The left note generator is called the modulator as it will influence the other generator. We say 
that the other generator is modulated by the first generator.

Now you can play a note and start increasing slowly the level of the HF Modulation parameter of 
the second module (the one to the right here above). You will hear the sound quality change. As 
a general rule, the more you modulate a sound the richer its timbre will become, meaning that 
there are more and more harmonics present at the output. It can be easily overdone, producing a 
sound that becomes aggressive. It all depends on the effect you want that sound to achieve.

Now you can also modify the frequency multiplier/divider of the modulator. Any parameter 
change that you do on the modulator will influence the timbre of the modulated generator. You 
can change both wave forms and frequency parameters. If you use the keyboard amplitude dialog 
seen above, you can create a modulation that depends on the keyboard range. One current use is 
to increase the modulator amplitude in the lower part of the keyboard and decrease it as the 
sound gets higher.

The modulation inputs of the modulator are not connected, so changing these modulation values 
will have no effect.
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With only two generators, you can already explore a lot of parameter combinations to create 
original sounds. This is however only the beginning... You should take some time to explore 
various values for these parameters. The more you understand how simple modules work, the 
better you will master more complex structures, as these basic principles apply for any 
combination of modules.

Free generator
A free generator generates one specific central frequency, whathever note is playing. It is more 
used to create special effects.

• Close the above virtual instrument window and create a new one. Set it up with a Free 
generator so that you have: 

Playing a note on the keyboard gives you one fixed frequency. You can adjust the frequency 
with the Basic frequency and Fine tune paramters. You can modulate it with an input signal and 
change its basic wave form.

Low frequency generator
This generator is the same as the Free generator, except that its frequency range is different. It is 
more intended to generate slow modulating signal. Add a Low frequency generator and connect 
it as follows:

This module defines the period rather than the frequency. The period is expressed in 
milliseconds (1000 milliseconds is 1 second). The default value is a cycle of one second, which 
is the time to go through one full wave form.

Play a note and increase slightly the modulation level of the free generator. You will notice the 
central frequency starting to fluctuate at the rhythm of the low frequency generator. You can 
change the basic period and wave form of the low frequency generator, as well as the central 
frequency, modulation level and wave form of the free generator. Take some time to explore 
combinations of these parameters.

White noise generator
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This module generates what is called a white noise. As the sun light contains in itself all the 
colors of the rainbow, the white noise contains any possible frequency of sound. Used alone, it is 
quite monotonous. It is often used in combination with filters and other generators, to introduce a 
random component in a sound.

• To hear how a white noise sounds like, close the above window and create a new virtual 
instrument with a white noise generator connected as follows: 

This module has two outputs for stereo. You can adjust its output level. Play a note 
and you will hear it.

Envelopes

An envelope is a relatively slow signal (compared to the speed of variation of an audible sound) that is 
intended to modulate another module. This modulation can influence frequency, amplitude or any other 
input of a module. Pizzicato offers two envelope generators.

Envelope

• Create a new virtual instrument. Add an envelop and a free note generator as well as a MIDI Velocity 
input port and connect them to have: 

An envelope is a one time signal. Its shape is displayed on top of the module. The following 
parameters are used to modify the shape of the envelope.

• Duration 1 is the duration in milliseconds in which the signal starts from zero and reaches 
its first peak. 

• Level 1 is the level of the first peak. 

• Duration 2 is the duration in milliseconds in which the signal leaves the first peak and 
reaches level 2. 

• Level 2 is the level reached after duration 2. 

• Duration 3 is the duration in milliseconds in which the signal leaves level 2 and reaches 
level 3. 
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• Level 3 is the level reached after duration 3. This level is then held until the note is 
released. 

• Duration 4 is the duration in milliseconds in which the signal leaves level 3 and reaches 
zero. 

Set the Modulation of the free generator to 100 %. The output of the envelope modulates the free 
generator frequency. Now try to modify the various envelope parameters, for instance:

While changing the various parameters, play some notes and hear the envelope influence on the 
pitch that is generated.

You can see that the Velocity input of the envelope has been connected to the velocity MIDI 
parameter. This will link the envelope output signal to the velocity of the note. Hitting the 
keyboard faster will produce an envelope with a higher amplitude.

Free envelope

• Remove the Envelope module here above and add a Free envelope module. Connect it to have: 

A free envelope shape can be drawn with the mouse. Double-click the free envelope module (in 
its blue background) and you will see the following window:
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You can freely draw with the pen tool or draw lines with the line tool that you see in the upper 
part of the window. The duration of the envelope is divided by 3 vertical bold lines, the last one 
being blue. The last quarter is in fact the part of the envelope that happens after the note is 
released. You can draw in the two sections.

When you play a note on the keyboard, the first three quarter of this envelope creates a signal at 
the output of the free envelope generator. At that point, if the note is still being held, the 
envelope keeps the value at the blue vertical line up to the time when you release the note. Then 
the last section of the envelope is generated.

Try to design an envelope with a free shape, as for instance:

When you close this window, the free envelope module displays the shape of the envelope:

Two parameters may be specified: the attack duration and the release duration. Both are 
expressed in milliseconds and represent the duration of the first and second sections of the free 
envelope. You can modify these value and play some notes on the keyboard. You can call the 
envelope shape window and modify it and then listen again to the resulting sound.
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Modulators and other operators

The following modules take one or more inputs and process them to create one or more output. They do not 
generate signals but are used to process and combine existing signals. They are building blocks to create 
more sophisticated virtual instruments.

The Amplitude Modulator
An amplitude modulator is used to apply an envelope to a signal. If the amplitude of a sine wave 
is suddenly increased from zero to maximum volume and if it is ended suddenly by setting the 
signal to zero, you will hear the note starting and ending with a "click" noise, which is not very 
natural. You can use an envelope to reshape the sine wave amplitude so that the sound appears 
and disappear smoothly.

• Create a new virtual instrument and set it up this way, by adding a note generator, an 
envelop and an amplitude modulator: 

If you play a note, you will hear that the "click" is no more present, as it was in the example 
given previously for the note generator.

An amplitude modulator has a modulation input. The input signal will act as a volume controller. 
This influence may be adjusted by the Modulation parameter.

You can also adjust the input and output values of the module. The first parameter is the number 
of inputs, from 1 to 16.

You can try to modify the parameters of the envelope, to hear the impact of the shape of the 
envelope.

The Delay
A delay is a module that will only delay the signal by some specified duration. It can be used as 
an echo. The module is displayed as:

The Delay value may be adjusted from 0 to 1000 ms (= 1 second).
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The Delay amplitude is the level of the ouput signal that has been delayed.

The Direct amplitude is the level of the input signal that is transmitted directly to the output, not 
being delayed. This is used so that the module can not only delay the signal, but also transmits 
the original signal itself.

The Loop amplitude is the level of the delayed signal that is sent back to the input again. This 
creates a multiple echo, as the first delayed signal will go back into the input, be delayed again 
and get to the output, then again fed back into the input, each time with a lower amplitude. You 
should not reach too close to 100 %, as the signal will then stay in the loop forever.

The Modulation input may be any slow signal, for instance from an envelope or a low frequency 
generator. It will modulate (modify) the delay value around the fixed value. This influence may 
be adjusted by the corresponding slider. By using a slow sine wave in a low frequency generator 
and by setting the delay very short, you can create a phaser effect. By increasing the modulation 
level, you can create a vibrato on any non-vibrato instrument.

The Operator
An operator is a mathematical function displayed as:

It will take two inputs to create one output. You can select the type of operation by clicking on 
the Type of operation parameter area and you can have a choice between Addition, Subtraction,  
Multiplication and Absolute value. The two input signals are combined with the selected 
mathematical operation and the result is available on the output.

The Sampler
This sampler is sometimes called the Sample and hold module. It is displayed this way:

The purpose is to sample (= take the value of) an input signal and to transfer it to the output and 
hold it there, even when the input signal continues to vary. This transfer is done each time that 
another signal (the threshold) reaches a certain level. This threshold level may be adjusted. By 
creating for instance the following setup, you have a random frequency generator:
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The Amplifier
An amplifier is used to mix several inputs together and to amplify or attenuate the resulting 
signal. It may have from 1 to 16 inputs:

Each input as well as the output, have an independent volume control.

The Multi Delay
This module is similar the single delay module, but it can generate a series of delays. It is an 
experimental module.

The Number of echoes can be defined.

The First delay specifies the shortest delay that will be used.

The Delays range establishes the range within which the other delays will be distributed. For 
instance, if the first delay is 100 ms and the range is 200 with a total delay of 3, the 3 delays will 
be respectively 100, 200, 300 ms.
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The amplitude of the various delayed signals may be scaled from First delay amplitude to Last  
delay amplitude.

A Random delay factor may be added. This will vary the above calculated delays in a random 
way.

The global echo signal level may be adjusted by the Echo level parameter.

The Feedback level defines how many of the output signal is sent back to the input, to create a 
looping echo.

Filters

A filter is a module that will amplify or attenuate some frequencies of the input signal more than others, 
resulting in a signal that has a different timbre or tone quality. It is used to modify an existing sound in very 
different ways. The way it will be changed depends of the frequency response curve of that filter. Pizzicato 
has a powerful filter design tool.

• To try the filter, create the following virtual instrument: 

A white noise is applied at the input and is filtered. A low frequency generator can modulate the 
filter. A filter has three parameters:

The Gain is the general volume level of the input signal to the output signal.

The Frequency is the reference frequency of the filter response.

The Modulation level is how the frequency of the filter will be modulated by the modulation 
input signal.

You can try to play a note and modify the frequency parameter. Then increase progressively the 
modulation level and hear how it influences the sound.

• Double-click on the filter background. The following dialog appears: 
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This dialog provides three methods to design a filter. Some aspects of this dialog require a solid 
mathematical background to really understand how this works. We will however not go into such 
details. If you really want to understand everything about filters, you will be able to find out a lot 
of information about digital filters and signal processing on the Internet. However, this is not 
needed to use this dialog in a practical way.

The first thing you have to know about this dialog is the frequency response curve. It is 
displayed in the upper part of the dialog. The horizontal axis represents the frequencies (low 
pitch to the left, high pitch to the right). You could also see it as a piano keyboard. If a signal 
(voice, music, any sound) is transmitted through a filter, the various component frequencies of 
that sound will be transmitted according to the amplitudes shown on the graph. The vertical scale 
represents how the signal will be amplified. A zero value (if the check box Amplitude in dB is 
active) means that the level will stay the same. A positive value means it will be amplified and a 
negative value means it will be attenuated. If you disable the Amplitude in dB check box, the 
amplitude will be expressed as a multiplying factor, 1.00 meaning same level, less than 1.00 
being attenuation and more than 1.00 being amplification.

Two sliders (vertical and horizontal next to the graph) may be used to zoom both scales in and 
out.

This graph really represents the specification or the identity card of the filter, as it defines the 
way frequencies will be treated.

The first way to use this dialog is to select one of the predefined filters in the Filter type frame. 
You have 6 simple different filters defined. A High pass filter is a filter that will let the higher 
frequencies go through it and will attenuate lower frequencies. A Low pass filter does the 
opposite, by letting the lower frequencies go through it and attenuating the higher frequencies. 
The Order of a filter is how much steep the curve will be (or the contrast between the high and 
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low frequency amplitudes). This is defined relative to the frequency that you can specify in the 
same frame. The gain may also be adjusted.

• Try to select the 6 types of filter and examine the curve. Click on OK to test the sound 
result and vary the frequency parameter from outside the filter. Hear the various effects of 
filtering out some frequencies. 

You will notice that when you select a type of filter, the 'a' and 'b' coefficients area change their 
values. These coefficients are in fact the mathematical equation of the filter curve. The second 
method to specify a filter is indeed to fix these parameters, if you find a filter equation from 
some other source. You can enter the coefficients freely if you select the "---" filter type. These 
coefficients are related to the following equation:

y[n] = b0 . x[n] + b1 . x[n-1] + ... + bM . x[n-M] - a1 . y[n-1] - a2 . y[n-2] - ... - aN . y[n-N]

where y[n] is the output signal sample value at time n and x[n] the input signal sample value. 
Basically, this equation gives the resulting sample output at any time, computed according to the 
input and to the previous input and output samples ([n-1] being sample before the current one, 
[n-2] the one before that one, etc.).

You can specify the values of that equation into the dialog. The first two upper text boxes 
specify how much a and b coefficients you use. Then you can click one value on the list and edit 
its value to the right of it. You can set b0 as an independent value.

The third way to design a filter (that will also result in determining these coefficients, but in a 
more intuitive way) is the design by Bode's diagram, as displayed in the lower right part of the 
dialog. Check the Use Bode's diagram box.

This is a mathematical representation of the frequency response of a filter. Again, a full 
explanation of this representation would go much beyond the scope of this manual. Here is what 
you should know about it to create a filter.

• The upper half circle (drawn in blue) represents the frequency values. The 0 frequency is 
to the right (at the intersection of the circle with the horizontal line). The frequency 
increases when you follow the circle in its upper part. At the top of the circle (where the 
circle crosses the vertical line), the frequency is 11025 Hz (cycles per second). And to the 
left, it reaches 22050 Hz. These values are related in fact to the sampling rate, which is 
here 44100 Hz. 

• You can add one or more poles and/or one or more zeroes. These are points that you can 
place and move inside the upper part of the diagram. Click on the New Pole button and 
the diagram is modified as follows: 

• The points are always added in symetric pairs. Only the upper one can be moved. You 
can now click and move the upper pole (represented by a small X). You will see the 
colors vary. The default green level color corresponds to a factor 1.0 in the transmission 

606



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

of the frequencies. Where the color gets lighter, the signal is attenuated and when it gets 
darker, it is amplified. 

• Theoretically, at the exact position of the pole, the frequency will be amplified infinitely. 
So you shoud not move a pole on the upper circle, because the filter would give an 
infinite amplitude (in practice however, as this is impossible, you will hear a big "Clank" 
and the filter won't answer anymore, which has very little musical value...!). 

• Remember that only the colors on the upper circle represent the amplitude level of the 
filter. What happens inside of the circle may be graphically nice, but it won't affect the 
frequency amplitude response. When you move a pole, you will see the upper graph 
updated, which represents the amplitude of the frequency response. You can orient 
yourself on colors and on the upper graph to design a filter. 

• To create a peak response for a specific frequency, you can approach a pole from the 
upper half circle. While moving the pole, you can see in gray the frequency (Hz) text box 
that displays the exact frequency of that pole. 

• Add a zero by clicking on the New zero button. Move it around. The frequency response 
at the exact position of the zero is to attenuate the frequency completely. You may then 
move a zero on the circle and it will completely attenuate the corresponding frequency. 

• By adding poles and zeros and moving them around, you can create a shape to the filter 
and you can try it. 

• You can delete the current pole or zero with the Delete button or delete them all with the 
Remove all button. 

Here is an example of the kind of diagram you can design:

As such a filter can have many poles and zeros, there is no more "one frequency" to specify. A 
filter designed with the Bode's diagram will have its external frequency parameter replaced by an 
evolutive parameter that will enable an external signal (envelope, low frequency generator) to 
move the poles and zeros inside the diagram. Here is how to define this behaviour. This is an 
advanced function, for users who really want to create some interesting sounds.

• Select one pole or zero that you would like to move with the evolutive parameter. 

• Check the Variable box. The slider just to the right can take 11 values. The "0" value is 
the central value. You can also go from -5 to +5. 

• Move the slider to position "-1". Now move the pole or zero to a new position. 
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• Move the slider to position "-"2 and define the position of the pole or zero. 

• Do the same for each position of the slider. You have defined 11 positions of that pole or 
zero, that specify the path of that pole or zero as the external evolutive parameter will 
vary. By moving the slider, you can now see that pole or zero moving through that path. 

• This may be done for other poles and/or zeroes. 

Once you have designed a filter, you can save its parameter to disk if you to load them back into another 
filter module later. To do that, use the Save filter... and Load filter... buttons. They will call the standard file 
save/open dialog boxes so that you can give/select a name for your filter.

Audio samples reader

In contrast to the generator modules that create a sound using a simple wave form, the following modules 
create sound by reading an existing audio WAV file. It can be a single file, played at a given frequency, or a 
set of files that represent a series of notes recorded on a real instrument. The audio and sample readers are 
described here.

The Audio Reader
This module generates a sound signal by reading a specific WAV file.

• Create a new virtual instrument with the following setup: 

The following parameters may be adjusted.

• The Playing speed is a factor to speed the playback up or down. 

• The Speed factor is similar. It multiplies the speed of the playback by an integer factor. 

• The Number of loops is 1 by default. This means that the file is played one time only. 
You can specify how many times the file should be read. If you set it to zero, it will loop 
endlessly. 

• The Modulation input is used to modulate the playback speed by another signal (for 
instance a low frequenccy generator, that would create a vibrato in the original sound 
file). 

• The Volume parameter specifies the volume of the output signal. 

608



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

• If you click on the the Audio file parameter (gray area), you can select the WAV file to be 
played. This may be a single instrument note, a full recorded file with all kinds of sounds, 
a speaking voice, a full symphony playing,... 

• The Play all parameter may be false or true. It true, when you play a note on the 
keyboard and release the note, if the sound file has not been played completely yet, it will 
continue to play. Otherwise, the playback will be interrupted when you release the key. 

Try to select an audio file and play some notes. Try to modify the various parameters to hear 
their effects. You will find wave file examples in the DataEN / Libraries / Music libraries /  
Audio / Samples, but you can of course use any of your own wave files.

The Sample Reader
This module is used as a simple sample player. You can define a series of WAV files each 
containing one single sample and assign it to a keyboard area. We will create here a simple 
example.

• Create a new virtual instrument with the following setup: 

The module receive the note pitch, the note velocity and can also be modulated, for instance to 
create a vibrato. The modulation can be adjusted and the output volume also. Two ouputs are 
available, for stereo sample playback.

• Double-click the module in its background. The following dialog appears: 

By default, no zone is defined. We will add one keyboard zone and assign it to a specific audio 
sample.

• Click on the New zone button. A new zone is defined, which covers in fact the full 
keyboard. You can set the starting note of the zone by CTRL + left-clicking a note on the 
keyboard and set the end note by CTRL + right-clicking on the keyboard. 

• The Velocity range frame is by default covering the full velocity range (from 1 to 127). 
This zone will be played back only if the incoming note has a velocity value in the 
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specified velocity range. This is used for instance when you want to assign a different 
sample file if the instrument play louder, as the timbre will often be different. 

• Click on the Select... button. This is the selection of the audio WAV file that will be 
played back. Enter respectively in the DataEN - Libraries - Music libraries - Audio -  
Papelmedia folder and select the file entitled "Crash Cymbal.wav" and click on Open. 

If you now click in the blue area of the keyboard, you will hear the sound of a cymbal. This is a 
sample that does not require to loop, as the sound is a percussive effect and has been recorded 
from start to end as a wave file. Other instruments may require what is called a loop. For 
instance, if a flute player plays a note, it can be held quite a long time. There is no need to record 
a 20 seconds long note as the size of a sound library would be very high. So we register for 
instance a 3 seconds note from a real flute player and we define two points in time where the 
loop start and ends.

In the middle of the dialog, you can define the first and last sample of the audio file that can be 
used, as well as the start and end point of the loop. If the loop points are both set to zero, 
Pizzicato will not loop.

Here is how it works. When Pizzicato plays a note, the duration of the note is not yet defined. 
Pizzicato starts playing the section of the file from the beginning to the start of the loop. Until 
you hold down the note on the keyboard, it will then loop through the start/end section of the 
loop. When you release the note, Pizzicato continue reading the file up to the end. So the flute 
note can be held for a longer time than the original sample file.

The Create... button is used to create a new sample file. You can give a name to the 
corresponding new audio file, which will be empty.

The Edit audio file... calls the Pizzicato audio editor window so that you can record the audio 
sample you want to use. If you define a loop before calling this dialog, you will see two vertical 
red lines in the audio file editor. They represent the sample start and end points. You can move 
them or manipulate them with the right-click menu items. Adjusting the loop of a sound is a very 
precise activity. To sound naturally, the loop points must be choosen very carefully, otherwise 
the sound playback will create an artificial beat that is particularly disturbing and not natural. It 
may require some work to find the exact points that render the sound natural.

The original frequency is modified by Pizzicato to match the note you play on the keyboard. To 
give Pizzicato its reference, you can specify which frequency corresponds to the original sample 
file. You can specify the frequency directly or by clicking the Note... button to select the original 
note on a keyboard. This reference will be used to modify the audio file playback speed so that 
the correct note is heard. If you check the Do not modify frequency box, Pizzicato will not 
change the original frequency at all and play it at its original speed. This is mainly useful for 
percussive effects.

The New note button is used to add a single note zone, placed to the right of the last note. It is an 
easy way to create a percussion map by adding a note and then specifying the sample files, one 
after the other.

With the Delete button, the current keyboard zone is simply deleted.

You can click on the Sort button to sort the keyboard zones in note/velocity order.

• Close that dialog by clicking on the OK button. 

If you want to see a practical example of this dialog, you can explore the Conductor view library 
into Music libraries / Virtual instruments / Sampled Sounds and double-click the Percussive 
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effects instrument. Then double-click the sample reader and you will see a series of percussion 
instruments, each one of them assigned to a sample file.

The Sample Reader/Editor
This module is similar to the above module, but it has more parameters to define how the sound 
will be played back. It can be created by importing a SoundFont file and choosing the Editable  
Sampler option in the import dialog box. You can of course also create this module as a new 
module and fill in all the sample files, loop points and parameters. The Papelmedia library 
included with Pizzicato is available in that form.

• Go in the conductor view tree library, in Music libraries / Virtual instruments /  
Papelmedia / Piano and double-click the Electric piano instrument. Then double-click 
the sample Reader/Editor module and the following dialog appears: 

This dialog is very similar to the sample reader dialog. Here is a description of the additional 
parameters.

The Original MIDI note is the MIDI value of the note as it was recorded in the sample file.

The Frequency correction is a corrective multiplying factor used to play the note. It can 
compensate for a tuning error, for a different original sampling rate than the one used by 
Pizzicato, or any other difference.

The MIDI scale influences the way half tones are interpreted. A value of 100 means that half 
tones are standard. This value is thus expressed in hundredth of a normal half tone. If you set it 
to 0, there will be no difference in frequencies when playing several notes, as these notes will be 
separated by 0 hundredth of an half tone. This parameter can be useful for percussion 
instruments or effects, where the frequency difference between consecutive notes must be 
reduced or cancelled.

The seven Envelop parameters are used to define an amplitude envelope to the sound. Delay is 
measured from the key being pushed to the moment the envelope will start to increase. Attack is 
the duration to reach the peak of the envelope. Hold 1 is the duration during which the peak is 
held. Decay 1 is the time to decrease the level down to the first decay level and Decay 2 is the 
time to decrease the level of the signal to zero when you release the key. Hold level 1 is the peak 
level (1.0 is the unit value) and Hold level 2 is the level reached after the first decay duration.
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The Pan value is 0 if the sound is central in the stereophonic space. A value of -500 sets it 
completely to the left and a value of +500 sets it completely to the right. Any intermediate value 
is possible to position the sound in stereo.

The Bank and Instrument numbers are only specified for information. They represent the bank 
and patch information normally sent in MIDI to select that sound.

These parameters are defined for each keyboard zone. Sampling a full instrument in quality may 
require a lot of work, but with this module, you can create a very natural playback of a lot of 
recorded instruments.

SoundFont reader
This module is created only when you import an external SoundFont file. You can not edit its 
parameters, except the filtering parameter. This last parameter may influence the final aspect of 
the sound in good or bad, so it is left to the user to modify.

Tips and advices

You will find here a few advanced tips and advices that you can use while designing a virtual synthesizer.

Drag and drop from the library
You will find predefined envelopes, generators and filters in the library. You can use them as 
building blocks while designing a synthesizer.

• In the conductor view library tree, find the Music libraries / Virtual instruments /  
Components / Envelopes / Natural envelopes folder. 

• You can drag and drop one of these envelopes inside a virtual instrument that you are 
building and the window will display the dropped module as a single block: 

• If you double-click that module, it will display its internal structure in a new window. 
You can indeed use a virtual instrument inside another virtual instrument, so as to create 
complex structures. 

• If you drag and drop a module from the library while holding down the CTRL key, the 
module will be explicitely added with all its component parts. 

• If you drag an envelope on an existing envelope, you will not create a new envelope but 
this operation will replace the parameters of the existing envelope by the parameters of 
the envelope you are dropping. 

• When you design a module that you would like to use in other synthesizers as a sub-
block, use the Param. button to specify which parameters will be displayed when the sub-
block will be used as a unique block. 

The memory combinations
This is an advanced experimentation tool. The idea is that when you create a synthesizer with 
several components in it, you may want to test various parameter combinations to find the one 
that are the most interesting. You may want for instance to try 3 or 4 different envelopes, various 
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levels of modulations, various frequency values for a filter,... For each sub-module, you can 
specify one or more memories. Let us use a practical example.

Create the following setup:

An small orange square is visible in the upper right corner of every module. When you left-click 
on it, the memory combination menu appears. Let us say that you want to hear all combinations 
of these modules for a set of values of the HF modulation of the second generator and the 
frequency divider of the first generator. Here is how to prepare this.

• Set the first value of the HF modulation and click the orange square and select the Add 
this state to memory menu item. Do the same for one or more other values of the same 
parameter. 

• Now set the first value of the frequency divider of the first module and select the Add this  
state to memory menu item. Do the same for one or more other values of the same 
parameter. 

With that menu, you can also replace a state in memory, remove a memory, remove all 
memories, recall a memory or edit the memory content as a text list (for each line, you can see 
the parameter values as a series of numbers that you can change).

When at least one module contains at least two memory states, you will see the upper part of the 
window display a number of combinations:

The grayed text box displays the total number of combinations that may be created by combining 
all the memories of the sub-modules. If you select several values for several parameters, this 
number can increase very much. You can now test these various combinations by clicking the "-" 
and "+" buttons or directly filling in the number of the combination you want to test. The sub-
modules will be set to their memory values and you can play a note to hear how that combination 
sounds like.

Apply an effect to a staff
You can create a virtual instrument module that have one input and one output (or two inputs and 
two outputs) and drag that module in front of a staff in a music score. This is a special case as 
this module will then process the sound signal coming from the virtual instruments of that staff. 
This can be used for instance for filtering, echoes or any other special effect. This module will be 
visible when the reference marks tool is enabled.
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 The audio/Midi/Score window
• The purpose of the audio/midi/score window 
• Audio conversion - Example 1 - Guitar 
• Audio conversion - Example 2 - Guitar 
• Audio conversion - Example 3 - Flute 
• Audio conversion - Example 4 - Piano 
• Audio conversion - Example 5 - Polyphony 
• Importing a MIDI file 
• Selection of an audio or MIDI section 
• Conversion parameters 

The purpose of the audio/midi/score window

The audio/midi/score window helps you to convert an audio file into a score and also helps you to transcribe 
a MIDI file or a free MIDI record (without metronome) to get a more precise result in music notation.

You can reach this window in multiple ways, according to the type of operation you want to perform.

To convert an existing audio WAV file into a score, you can:

• Call the File, Convert an audio file into a score... menu item. 

• Open the audio file with the i, Open an audio file... menu item or double-click on the audio file in the 
document manager, and then right-click in the content of the audio window and select the Convert  
into a score... item. 

• Right-click on the audio file in the document manager and select the Convert into a score... item. 

To record an audio file from a microphone and convert it into a score, or to play the MIDI keyboard freely 
without metronome and work out the score of it:

• While holding down the CTRL key, click on the red record button in the score  window. 

To convert a free MIDI file recorded without metronome, an additional option is available in the import 
MIDI file dialog box, entitled Manual adjustment. By checking this option, the MIDI file is open in the 
audio/midi/score window (but without the audio panel), which provides a more advanced tool to adjust the 
conversion into a score. The ways to open a MIDI file are multiple:

• With the File, Import MIDI file... menu item. 

• By double-clicking on a MIDI file in the document manager. 

• By right-clicking on a file in the document manager and then selecting the Create the score option. 

• By dragging a MIDI file into the main Pizzicato Window, from Windows explorer or the Finder (on 
Mac). 

This window offers you two different features that must be well understood and distinguished.

When you start from an audio WAV file (whether it already exists or you record it from a microphone), the 
first part of the work is to locate the notes played in that file.

Locating notes played in an audio file is a quite delicate task for a computer program. You must often help 
the software to make certain decisions and adjust the parameters of the conversion. It is sometimes needed to 
correct one note or adjust its exact duration. You can for instance specify where the notes start, which 
increases the general precision of the conversion. At this time, Pizzicato can handle a monodic melody (one 
note at a time) correctly. Even if Pizzicato has a polyphonic recognition tool, this tool is only helping you to 
transcribe, as an important part of the work must be done by you. We will see one example of it in this 
lesson.
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The second part of the work is to transcribe the notes found into a score, by taking into account the duration, 
rhythm and measures used, so that the score looks readable and logical. Here also, this window offers you a 
set of tools to define the measures and beats, but the splitting into several voices and staves as well.

To explain the features of this window, we will take several practical examples.

Audio conversion - Example 1 - Guitar

Let us start with a simple melody on the guitar.

• In configuration 2 of the document manager (blue buttons in the upper left part of Pizzicato), open 
the examples and right-click on the example entitled Ex094.wav, then select the Convert into a score 
menu item. The audio/midi/score window appears as follows: 

This window has the following areas (from top to bottom):

• The tool bar gives control over the main features of the window. 

• The display area of the audio file. Here you see the audio file that we just opened, which contains a 
short melody played on a real guitar. This area can be resized by moving up or down the gray bar just 
below it. 

• Just below this area is the audio transition area. It will display and/or help you to modify the 
moments when notes start and stop. 

• The MIDI area, where the notes found in the audio file will be displayed. You can also modify, add 
or delete notes in that area. The note names are displayed in the left part and this left part can be 
dragged up or down to display a different range of pitches. It can also be resized by moving up or 
down the gray bar just below it. 

• The area of measures and beats, where you can adjust the starting points of measures and the 
intermediate beats as well. 

• The last area displays the score in music notation. 

• Below the score, you can use a scroll bar to move to another part of the file, in case that the file needs 
more space to be displayed. 

Here is a description of the various controls of the tool bar:
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• A menu and two buttons are used to change the horizontal zoom. By zooming, you increase the 
precision of work. 

• Two check boxes enable/disable the playback of MIDI (the result of the conversion) and audio 
(original file). 

• The icon with two small notes may be dragged and dropped in a document of the document manager, 
at least for the Pizzicato versions that enable multiple scores in a document. The score dragged is the 
result of the conversion. 

• The two next buttons are Stop and Start playback (audio and/or MIDI) used to hear the content of the 
working areas. 

• The original staff only makes sense when you import a MIDI file and is used to specify which staff 
of this file you are working on in the MIDI area. For an imported audio file (as it is the case here), 
there is only one choice, Audio/Midi. 

• The Assign to menu is by default on Staff 1 - Voice 1, which means that the notes found in audio and 
the edited notes in the MIDI area, will be transcribed as the first rhythmic voice of the first staff. The 
last choice of this menu is Other... is used to add a new assignment: 

You can define either a second voice in the same staff or another staff. You can have up to 8 
combinations on up to 3 staves to transcribe the notes from an audio file or from a track of a 
MIDI file. A color can be used for each, so as to make the work more easy in the MIDI area.

• The color of the assignment can be changed also in the next control box. 

• The Display all staves check box is used to display all staves of the document in the lower part of the 
window. When it is not checked, only the staves resulting from the original staff of the MIDI file are 
displayed. In the case of an audio file, it is unused because there is only one audio track. 

• The Options... button displays the dialog with the audio/MIDI recognition parameters. We will go 
into more details on this later in this lesson. 

• The Direct Audio/Midi button starts a conversion. The conversion is done and the transition points 
are computed. 

• The Detect zones button starts an analysis of the transitions between notes. You can then modify 
them before proceeding with the conversion itself. 

• The Audio/Midi by zone starts a conversion that is based on the zones existing between the transitions 
of notes. 

• The Quantize... button displays the quantize dialog box of Pizzicato. When you validate, the MIDI 
result will be quantized, which means adjusted on beats and divisions of beats, so as to remove the 
imprecision of the audio or of the MIDI recording. This options also deletes the human interpretation 
of the music. But if the recording is not precise, this option improves the rhythmic aspect. 
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• The Keep exact timing check box is more subtle. When you adapt the measures and beats so that they 
generate a more logic and readable transcription in music notation, if the result is played with the 
same tempo value, the original performance will be transformed according to the new measures/beats 
setup. To compensate for this, by enabling this check box, Pizzicato will add tempo variations in such 
a way that the original performance will be restored. 

• The Validate... button saves the resulting score under a name you provide. The audio/midi/score 
window is then closed and the resulting score is opened in the score view of Pizzicato. 

We will examine an example of the two ways to handle an audio/Midi conversion.

• Listen to the melody, played somehow irregularly by a beginning guitarist (me..!). 

• Click the Direct Audio/Midi button. The following result appears: 

• Listen to the MIDI playback, by disabling the audio playback. 

Three notes have a wrong section in them (up one octave), at the time references 3, 7 and 11 (in 
seconds). Notice that the program displays the transition found, by red circles in the transition 
area and by corresponding vertical lines in the audio area. To improve the result, you can edit the 
transitions. Most of the time, the program will find more transitions than it should, so the most 
obvious correction is to delete the transitions that do not correspond to a note. To do that, simply 
double-click inside the circle of a transition.

• For instance, double-click on the transition located in the middle of the note of time reference 3. 
Pizzicato adapts the conversion of the resulting note and displays: 
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• The final transition of this note as well as the starting transition of the next note are wrongly 
estimated and the result is that instead of displaying a rest, Pizzicato finds a lower harmonic of the 
previous notes. Move the two transitions (by clicking and dragging the circles) so as to get this (you 
can zoom in to increase the precision): 

which removes the unwanted note in the MIDI area.

• For the note located between 7 and 8, delete the transition in the middle of these two notes. 

• Similarly for the final note, delete the two unnecessary notes to display: 

• In some cases, to have a smoother melody, you can clean up the unnecessary transitions. The 
important transitions are the ones that correspond to the real beginning of the note. For this example, 
you could get this: 
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To edit transitions, you can:

• Double-click an existing transition to delete it. 

• Move a transition by clicking and dragging it left or right. 

• Add a new transition by double-clicking where no transition exists. 

The next phase is to transcribe the notes into music notation in a way that is readable and logic. For the 
moment, we did not pay any attention to it and the staff displays the following in the score area:

The music seems confused, even if all notes and durations are present. This is because the notes are not 
synchronized (aligned) with measures and beats. This is where the measures and beats area takes its interest. 
It is located between the MIDI area and the score area. The starting points of the measures are displayed as 
blue rectangles (that also display the time signature) and the beats are displayed as blue circles. Here are the 
operation you can do in this area:

• Moving a measure by dragging its rectangle: the current measure and all the beats and starting points 
of the following measures moves accordingly. It is useful as you will often work from left to right to 
adjust the measures and beats. The beats of the previous measure are expanded or reduced 
accordingly. You can avoid these behavior as follows: by holding the SHIFT key, the previous 
measure is not modified and by holding the CTRL key, only that measure rectangle is moved. 

• To delete a measure or a beat, double-click it. 

• By double-clicking in a free area, a new beat is added. 

• By double-clicking in a free area while holding down the CTRL key, a new measure is added. The 
measure is determined by the number of beats defined in it. 

• By right-clicking a measure, you can change the type of measure between 1, 2, 4, 8, 16 or 32. To 
work in 6/8, select 8 and add 5 beats after it. If you hold down the CTRL key during this operation, 
all measures are affected by the change and if you hold down the SHIFT key, the current measure 
and the following measures are all affected. 

Here is how to adjust the score in a few clicks, based on the quarter note:

• Drag the first measure just in front of the first note. Be careful to place it just a bit before, otherwise 
the note is not taken into account and is replaced by a rest. The score displays the following: 

• Drag the second measure to the left, so that it contains the first four notes. The beats also move to 
display: 
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The first measure is now readable as four quarter notes, even if the intermediate beats are not 
exactly positioned (this is caused by the imprecision of the recording or conversion). If the 
notation was wrong because of that, you could simply move the beats to align to the MIDI notes.

• Do the same with the next two measures so as to display: 

• For the last measure, there are no more beats and measures, so add three beats and one measure and 
adjust them to get: 

Once the result is fine, you can click on the Validate... button and save it by giving it a name. Pizzicato 
opens it in the score editor and the audio/Midi/score conversion is finished.

Audio conversion - Example 2 - Guitar

The second method to convert an audio file is to start working on the transitions and only then convert to 
MIDI. The fact of specifying the transition helps the program as it can then consider that there is one one 
between each transition. Let us take another small guitar melody to demonstrate this method.

• In configuration 2 of the document manager, open the examples and right-click on the example 
entitled Ex095.wav and select the Convert into a score... menu item. The audio/Midi/score window 
opens. 

• Listen to the melody and then click on Detect zones. Pizzicato displays the following transitions that 
determines the zones: 

• Clean up the unnecessary transitions, then click on Audio/Midi by zone. This button computes the 
notes located in each zone. Listen to the MIDI playback. You get the following: 

• By adjusting the measures and beats as described in the previous example, you can easily get the 
following: 
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According to the audio record and the instrument, one or the other method will be better. Make some tests 
and use the more efficient one.

Audio conversion - Example 3 - Flute

If you want to directly record an audio file and convert it, you can do it by clicking on the record button  
located in the score window of Pizzicato. The audio/Midi/score window opens. Click then on the button  
located in the audio area (which is empty at the beginning). The audio record dialog opens to display:

Here is how it works:

• Click on Record audio to start recording. You can adjust the record level with the two sliders. The 
black bar graphs display the level of the signal in green. If there is not reaction on these bar graphs, 
check that the main Pizzicato audio input is well connected to the microphone or other input where 
the signal is available. Check this in the Options, Audio setup... menu item. 

• Once the audio record is done, click on Stop. 

• You can record again if you need it, the previous recording being automatically deleted if you start a 
new one. 

• The OK button validates the last record and inserts it into the audio zone. 

Here is an example of a flute audio record. It is example Ex096.wav that you can open as explained in the 
previous examples:
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Let us explain another method, more natural, that you can use to specify the transitions of the above signal. 
The idea is that you can record them in real time by clicking with the mouse. Listen to the melody many 
times. In the case you record the melody yourself it will be more easy, as you know the melody because you 
played it yourself. Then the procedure is the follow (you can do it several times until you are satisfied with 
it):

• Click on the  button that is located at the beginning of the transition area (just below the audio 
area). 

• The playback starts and each time you click inside the transition area, a new transition is added. Do 
this for each note as well as for the end of the last note. 

• Once this is done, transitions can be adjusted manually as previously explained. Here is what it could 
look like after a real time recording: 

An important remark must be done. Windows very often has a latency time for the audio sound card of a PC. 
This delay happens between the moment when Pizzicato sends the audio samples to Windows and the 
moment they are really played by the sound card. Because of this, even if you click right when you hear the 
note, the transition will necessarily be displayed a little bit after the real note in the audio area. On Mac, the 
latency time is very small and so does not really interfere. This delay also explains why you hear the audio 
and MIDI with a slight delay when you play them together. There are two methods to handle this problem.

The first is to shift all transitions slightly to the left so that they are aligned with most of the audio notes. 
You can do that by dragging a transition while holding down the CTRL key. If you hold the SHIFT key, 
only the current and following transitions will be moved.

The other method is to determine this delay by experience and compensate for it in the Options, Midi play 
options... dialog box, with the slider displaying MIDI delay in milliseconds (correction for audio).

• You can also use the same principle to record the measures and beats. Click on the  button in that 
area to start recording in real time and then click inside that area to record measures and beats. 

• Click with the left button for a measure and with the right button for the intermediate beats. 

• Adjust them manually if needed and you will get for instance: 
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In this case, the time signature is 2/4 (you could also transcribe it in 4/4) and the melody starts on an eighth 
note upbeat. So you must place a measure at the beginning and the next measure must start on the second 
note.

Notice that you can also record the MIDI from a MIDI keyboard directly in real time. You must use the  
button located in the MIDI area to start recording. Then you can use the tools to fit the recording into nice 
music notation on the staff.

Audio conversion - Example 4 - Piano

Let us take another example, to illustrate the possible correction in the MIDI area.

• Open the Ex097.wav example as explained before. Listen to the melody, click Detect zones and then 
audio/Midi by zone. You get the following: 

The MIDI area provides tools for the following operations, that will influence the resulting score in the score 
area (make some tests in the above example):

• To delete a note (represented by a thick red line), click it while holding down the CTRL key. 

• To move a note, click on it and drag it horizontally in time and/or vertically for transposition. 

• By clicking on a note while holding down the SHIFT key, you can increase or decrease its duration 
by shifting horizontally. 

• By clicking on a free location while holding down CTRL and SHIFT, you can add a new note and 
adjust its duration horizontally. 

After removing the unnecessary transitions and adjusting the measures and beats, the transcription of this 
melody will look like this:

623



Pizzicato 3.6 Pizzicato Professional User Manual – Page 
_________________________________________________________________________________________________________

Audio conversion - Example 5 - Polyphony

Here is a more delicate example, where Pizzicato can help you, but where an important part of the work 
must be done to transcribe a score correctly. We hope to improve this function in the future so that the 
manual part of the work will be reduced progressively.

• Open the example entitled Ex098.wav and listen to the audio track. 

• Click on the Options... button, change the Maximal polyphony value to 2 (by default it is 1, which 
means that only one note will be detected at a time), then validate by OK. 

• Click on the Detect zones button. Another way would be to record the transitions in real time. 

• Adjust the position of the transitions as best as you can, based on the peaks you see in the audio 
signal and then click on the Audio/Midi by zone button. You should get the following: 

• Listen to the MIDI result and you will hear that most notes are there but an important clearing work 
must still be done. Let us take this example to illustrate how to assign some of the notes to another 
rhythmic voice or staff. 

• In the Assign to menu, select the Other... item. In the following dialog box, select staff 2, voice 1. We 
need to separate the two hands of the piano recording into two staves. 

• To assign a note in the MIDI area to the selection of the Assign to menu, you can simply click the 
note with the right button. The note then takes the color of the assignment (here in blue). For 
instance, click the first four lower notes to the right, then click the Midi/Score button and you get: 
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• Another method is to click with the right mouse button and drag a rectangle to cover the notes you 
want to assign to another staff or voice. Do it for the next four notes, to the right of the blue notes. 

• A third method is to click with the right mouse, then press and hold the CTRL key and drag 
vertically, so as to cover a specific range for the whole area. Do it to assign all notes equal or lower 
than A3. 

• If you use the tools to correct the notes in the MIDI area, then adjust the measures and beats (you can 
record them in real time, it is faster), and by comparing to the audio version, you can reach the follow 
result (after quite some work): 
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Importing a MIDI file

The basic principle to import and edit MIDI files is similar to what has been explained here, except that there 
is no audio area.

• Right-click the example entitled Ex099.mid in the Examples folder of configuration 2 of the 
document manager, then select the Create the score menu item. In the following dialog box, check 
the Manual adjustment box, which forces the display of the audio/midi/score window, then click on 
Import. 

• Listen to the music (beginning of a Chopin's Prelude). 

• In the Original staff menu, there are two lines for Piano, representing the two hands of the piano. The 
melody is played with the right hand and the left hand plays a series of chords made out of 3 notes 
each. Select the second Piano line in the Original staff menu and the left hand is displayed in the 
MIDI area. Check Display all staves so that both staves are displayed in the score area. 

Let us use this example to show how you can separate voices. We will split the three notes of the chords into 
three separate staves.

• In the Assign to menu, select Other... and choose staff 2. 

• Select Other... again and choose staff 3. 

• Click on the Midi/Score button and the two new staves are displayed. 

• If you reduce the zoom value, the beginning of the score is displayed like this: 
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• To assign the central notes to the next staff, select Staff 2 - Voice 1 in the Assign to menu. Then draw 
rectangles with the right mouse button, to cover the central line of notes. They are then displayed in 
blue. 

• Do the same for the lower notes, by selection Staff 3 - Voice 1 in the menu and transfer the notes in 
the same way. 

• Click on the Midi/Score button. The window must then look like this: 
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Selection of an audio or MIDI section

In the MIDI and audio areas, you can also select an horizontal section. This is done by clicking and 
dragging. The selection is displayed with a light green background, in the audio area as well as in the MIDI 
area. The conversion operations as well as the playback and recording of audio, MIDI, transitions, measures 
and beats, will only be done inside that selection. To cancel the selection, simply click in the area.

When a selection is present, contextual menus are available with a right click:

• In the audio area, Delete content will replace the selected part of the signal with silence. This is 
useful to remove some noise or accidental note that should not be taken into account for the 
conversion. 

• In the MIDI area, Delete notes will delete all notes inside the selection. 

• In the audio and MIDI areas, Remove zone will remove the entire selected section. The section right 
to the selection will be moved close to the section before the selection. 

• In the audio area, Delete transitions will simply delete the transitions which are displayed in the 
selected zone. 

Conversion parameters

Clicking the Options... button opens the following dialog box:
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You will find here the various parameters that define the way an audio/Midi conversion is done. Some 
parameters may be quite complex to explain and are related to signal processing and to the harmonics of a 
note. We won't get too technical about it. Here is an explanation of the main parameters.

The upper part of the dialog is used to save different configurations of parameters. At the beginning, only 
one configuration exists, named Default values. You can duplicate it with the Duplicate button and then 
rename it. You can create several configurations and go from one to the other easily, at least for users who 
want to experiment with these parameters. In most cases, the first configuration will work properly. The 
Delete button deletes the current configuration and the Default values button is used to restore the default 
values of the parameters in the current configuration. The Label text box is where you can rename the 
configuration. Configurations are automatically saved when you close the dialog. The current configuration 
is displayed by the Setup menu and it will be used for the conversions.

• Frequency of reference A note (Hz): you can specify the exact frequency of the A note, which is by 
default 440 Hz. 

• Minimal note duration (milliseconds): by default, the notes shorter than 100 mSec (0.1 second) are 
ignored, as they are in most cases produced by the transitions of the signal. If you play a slow 
melody, you can even increase this value to improve the process. 

• Range: by default, notes are searched for in three octaves (from C in second space in F clef to C two 
ledger lines up in G clef). If your melody is contained in a smaller range, you can adjust the limits, 
which may improve the results. 

• Maximal polyphony: by default, the analysis is done for a monodic melody, that is, a melody with 
only one note at a time. In this case, two methods are possible and may give different results 
according to the instrument and record quality. When we search for several notes, only the method 
using spectral analysis may be used (the search is made on possible frequencies found in the signal). 
This method is consumes much processing power. While searching for only one note at a time, it is 
also possible to use the time analysis, where the period of the signal is analyzed and the frequency 
and note are derived. The value of the maximal polyphony is the maximum number of notes played 
together, that the program will search for. 

• Analysis frame: for the spectral analysis, the program starts with a section of 10 x 50 milliseconds 
(0.5 seconds) and find the frequencies present. Then the analysis is done again for each 50 
milliseconds to refine the real position of notes in that time frame. These durations may be changed 
here for experimentation. 

• Time smoothing: this is used to "smooth" the starting points of notes so that they are played more 
regularly. For instance, if you play continuous eighth or sixteenth notes, the program may not locate 
their starting points exactly each time, so that the result is played irregularly. This option partly 
solves this problem. 

• Harmonics parameters: these are internal parameters for the program, which influence the way notes 
are extracted from the set of frequencies found in the signal. As a note has several harmonics at 
multiples of its frequency, a possible error is that the program detects a note one octave too high or 
too low, because of the presence of harmonics. Here is a short description of each: 

• Harmonics taken into account: the program analyses the notes based on this number of 
harmonics. 

• Minimal volume to force an harmonic into use: below this level, the frequency is ignored. 

• Frequency range to force an harmonic into use: by reducing this value, the frequency 
range is reduced around the note and if outside that range, the frequency is ignored. 

• Limit of H1/H2 acceptable ratio: H1 and H2 are the detected levels for harmonics 1 and 
2. It may happen that an instrument plays a note which has a level of harmonic 2 greater 
than harmonic 1 (its fundamental frequency). A value of 20 % means that Pizzicato will 
take this phenomenon into account up to the situation where the level of harmonic 2 will 
be less than 5 times the level of harmonic 1. 
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• Volume to consider an harmonic as a possible note: if this level is reached, the frequency 
may be analyzed as a main note (harmonic 1). 

• Set velocity to: set the velocity of each note to the specified value (between 1 and 127). When this 
option is disabled, Pizzicato tries to determine the velocity of each note by computing the energy of 
the note. 

• Ignore rests under: a rest that is shorter than this value is ignored, which means that the previous note 
will be lengthened to fill this rest. 

A portion of the analysis work is related to detecting the presence of repeated notes or of the end of a note. 
The following parameters are used for that:

• Volume under which a note repeat becomes possible: if the level of a note decreases below this level, 
(compared to its maximal peak in the attack of the note), then a repeat (second attack of the note) 
may be searched for. 

• Increase of volume to trigger a note repetition: if the volume of a note increases by this value, after it 
dropped below the previous parameter, then the note is repeated. 

• Volume under which a note is terminated: if the note volume decreases below this value (compared 
to its first peak value), the note is terminated. 

By clicking on OK, the parameters are saved and the current configuration will be used for the next 
conversions.

The Convert button also saves the parameters and starts a new conversion.

The Cancel button restores the parameter configurations that were used before opening this dialog box.
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